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Overview of AFT Impulse
Welcome to AFT Impulse™ - a visual platform for modeling fluid transients in pipe networks! See 
what's new in this version.

AFT Impulse brings increased productivity to the pipe flow engineer by combining traditional ana-
lysis with an intuitive graphical user interface. By implementing a drag-and-drop method of pipe 
flow modeling, AFT Impulse simplifies the pipe network modeling process.

AFT Impulse can show both input data and analysis results in visual form, allowing rapid analysis 
of a model's validity. Identifying poor assumptions, catching typographical or modeling errors, 
and rerunning models are all accelerated because of AFT Impulse's graphical environment.

Whether your pipe system model will be used to evaluate and improve an existing system or to 
design a new one, AFT Impulse increases your productivity in the modeling process.

What Can AFT Impulse Do?

AFT Impulse can be used to model a wide variety of incompressible flow systems, including:

 l Open and closed (recirculating) systems
 l Network systems that branch or loop, with no limit on the number of loops
 l Systems with valve transients
 l Systems with pump transients
 l Systems with pressure or flow control valve transients
 l Systems with transient cavitation and liquid column separation
 l Systems with surge suppression devices such as accumulators, surge tanks and air 

valves
 l Systems with variable density and viscosity
 l Multiple design cases in a single model file (Scenario Manager)
 l Non-Newtonian fluid behavior

AFT Impulse's steady-state solution engine is based on standard techniques used for many 
years in industry. The Newton-Raphson method is used to solve the fundamental equations of 
pipe flow that govern mass and momentum balance. Solutions are obtained by iteration, and mat-
rix methods optimized for speed are employed to obtain convergence. Once a steady-state solu-
tion is obtained, AFT Impulse simulates the transient using the Method of Characteristics, the 
most widely used method for solving fluid transient problems.

Where to Start

The best place to start learning about AFT Impulse is to work through our example problems and 
video tutorials found in the Impulse Learning Resources.
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Add-on Module Capabilities

AFT Impulse has two add-on modules that extend modeling capabilities.

 l Pulsation Frequency Analysis (PFA) allows the engineer to study the pressure pulsation 
effects a positive displacement pump has on a system.

 l Predict resonant frequencies
 l Graphically show the frequency response of a system
 l Examine the pressure response of a system when a positive displacement pump is 

running at a resonant frequency
 l Ensure the pressure pulsation magnitudes comply with the API-674 standard

 l Settling Slurry (SSL) allows the engineer to perform waterhammer analysis while account-
ing for the complex property and system interactions associated with slurry flows.

 l Model homogeneous and pseudo-homogeneous slurry mixtures
 l Slurry pump performance de-rating

Who Can Use AFT Impulse

AFT Impulse assumes that the user possesses a good general knowledge of engineering pipe 
system hydraulics and has at least a basic understanding of the fluid transients and surge phe-
nomenon. Even the most advanced and easy-to-use software package cannot make up for a 
lack of fundamental knowledge on the part of the user.

Related Topics

New in Version 9 34
Impulse Learning Resources 54
Engineering Assumptions 20
Startup Window 55
FAQ - Frequently Asked Questions 52
Converting Models from Earlier Versions 810

Engineering Assumptions
AFT Impulse is based on the following fundamental fluid mechanics assumptions:

 l Liquid-phase flow only
 l Entire system is wet (100% liquid full)
 l AFT Impulse is not meant for analysis of two-phase flow

 l One-dimensional flow
 l Fluid properties remain constant during transient
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 l Non-condensable gas release and dissolution is negligible
 l Wavespeed remains constant
 l No chemical reactions
 l Fluid density is not affected by pressure waves in the system

 l Vapor pockets formed during transient cavitation in pipes are considered point-volumes 
at section boundaries and do not move

 l AFT Impulse is limited in its ability to model sustained cavitation and two-phase 
flow. The accuracy of results will be reduced when sustained two-phase flow con-
ditions exist. Small cavitation volumes over short durations are handled with good 
accuracy.

 l Additional assumptions exist for particular modeling components and features, discussed 
where relevant

Related Topics

Overview of AFT Impulse 19
New in Version 9 34
Impulse Learning Resources 54
Startup Window 55
FAQ - Frequently Asked Questions 52
Converting Models from Earlier Versions 810

New in Version 10
View the links below for key updates from past versions:

New in Version 9, New in Version 8, New in Version 7, New in Version 6

Workspace Layers

The Workspace Layers feature provides a powerful new tool for customizing and viewing model 
appearance, input data, and results - all in one place. The Workspace Layers toolset significantly 
enhances the model building process, providing unparalleled customization options. You can 
easily update pipe/junction size, color, display text, visibility, and more from a centralized loc-
ation on the Quick Access Panel. Workspace Layers surpass the capabilities of the previous 
Visual Report feature. With Layer Settings, you now have easy control over Color Mapping and 
the visibility of both Input and Output parameters. Any change you make to these settings will 
have an immediate impact on the model’s display, providing real-time feedback. The dynamic 
combination of unique Layers offers an incredibly flexible framework, allowing you to display pre-
cisely what you desire on the Workspace. You can easily toggle the visibility of individual layers 
on or off, and the state of all layers can be saved to a Layer Preset for future use.
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Figure 1: Workspace Layers can display input and output values superimposed over the model, 
show Color Maps, and control visibility of objects

Transient Checkpoints

Extend the length of an existing transient run without the need to re-run the entire simulation, or 
stop and continue a run from other points in the simulation. Transient Checkpoints enable you to 
save the state of a transient simulation at any given point and resume it later from that exact 
point. This functionality proves particularly useful in scenarios where you need to pause a sim-
ulation temporarily to provide access to another user or when unexpected interruptions, such as 
system updates, occur during the simulation. This feature also allows for the extension of a tran-
sient run. If you have ever experienced the frustration of waiting for results only to realize that 
you should have run the simulation for a slightly longer duration, this feature provides a solution. 
Instead of rerunning the entire simulation, you can simply extend an existing run by leveraging 
the automatically created Transient Checkpoints.

- 22 -
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Figure 2: The Transient Checkpoint panel within Analysis Setup

Retain Partial Transient Output

If the simulation is stopped - by the user or an error - show the transient results up to that point. 
Transient Output is now saved and viewable regardless of what caused the simulation to stop. 
This means that you can access and analyze the results up to the point where the simulation was 
interrupted, just like regular results. This eliminates a lot of guesswork involved in interpreting 
system behavior when it deviates from expectations, particularly when troubleshooting sim-
ulation errors. For instance, if a simulation encounters difficulties in converging on a pump solu-
tion due to factors like reverse flow or unexpectedly cavitation, the availability of partial output 
enables you to quickly identify these situations. You can then take appropriate corrective meas-
ures or provide our Support Team with detailed information to expedite problem resolution.
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Figure 3: Transient Output can be retained on errors or cancel

Improved Valve Properties Window

The new Valve Properties window greatly enhances clarity and usability when it comes to mod-
eling valves. The window now clearly distinguishes between different data sources such as User 
Specified, Characteristic, or Handbook, making it easier to understand the available options. The 
form has been streamlined to focus on the most essential data, providing a clear understanding 
of what is required to define a valve accurately. Valve Characteristics, represented by an Open 
Percent vs. Flow Coefficient table, have been brought front and center. While using a Char-
acteristic is optional, it is highly recommended as it ensures that the valve behavior aligns with 
real-world scenarios, particularly for valve transients. The process of selecting a pre-defined 
Characteristic Source has been simplified, which helps obtain more accurate values in case man-
ufacturer data is unavailable.
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Figure 4: Redesigned Valve Properties window

Streamlined Design Alerts

The Design Alert Manager has been reorganized to improve the process of creating and apply-
ing user-defined alerts. Now, you can effortlessly create or edit a Design Alert with just a few 
clicks. As you modify settings, you will immediately see the criteria you are applying, ensuring a 
transparent experience. We have also reduced the amount of text on the form, while ensuring 
grammatical clarity. These improvements aim to make it easier to understand the limits being 
placed on the design.
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Figure 5: Steamlined Design Alerts Manager

Other Notable Features

 l Counterweight Check Valve - Enhanced the Force Balance Swing Check to allow the 
inclusion of a counterweight and lever arm.
The Force Balance Swing Check Valve model has been enhanced with the ability to 
include the torque provided by a counterweight and lever arm. Additionally, you can now 
specify applied torque vs opening position, allowing modeling of situations such as a lin-
ear spring attached to the lever arm.

Figure 6: The Customize Icon window allows a custom image to be applied to any junction
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 l 4-Component Slurries - New 4-component slurry model for the SSL module, developed 
by leading industry experts, captures complex slurry regimes more accurately.

The 4-Component Slurry model introduces a division of slurry solids into four distinct groups, 
or components, based on the particle size distribution. Each component corresponds to a 
specific slurry behavior; Carrier Fluid, Pseudo-homogeneous, Heterogeneous, or Fully Strat-
ified. Unlike simpler models that account for only one or two slurry regimes, the Four Com-
ponent model greatly enhances modeling flexibility by automatically determining the effects 
contributed by each component regime. The model was developed by industry-leading 
experts and is respected for its accuracy in part because the individual components are 
based on well established sub models. The 4-Component Slurry model offers a com-
prehensive and advanced approach to slurry modeling, enabling more accurate and detailed 
analysis of slurry behavior in various particle size distributions.

Figure 7: The 4-Component Slurry Model considers combined effects from four slurry regimes

 l Custom Junction Icons - Use your own images for junction icons.
Utilize any image as a junction icon, simply by right-clicking on the Toolbox icon for the 
junction, selecting Add Image, and browsing to the image file. This functionality enables 
you to use standard P&ID icons or custom images to visually represent your equipment. 
By using recognizable icons, you can improve the clarity and comprehension of model res-
ults, especially for those who may not be familiar with the default AFT junction icons.

Figure 8: The Customize Icon window allows a custom image to be applied to any junction
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 l Isometric Freeform Drawing Mode - Draw on the isometric grid without forcing any par-
ticular pipe routing.
The Isometric drawing tools have been enhanced by adding a new Isometric Freeform 
drawing mode. This new drawing mode allows you to snap junction and pipe anchors to 
the Isometric grid, while having the flexibility to draw pipes that do not necessarily align 
with the isometric gridlines. This allows you to easily draw complex systems where not all 
piping follows a Cartesian direction.

Figure 9: Isometric Freeform drawing mode does not force pipes to follow gridlines

 l New Annotations - There are new shapes and a line tool, along with a more advanced 
Annotation editing panel.
New Annotation shapes and a line tool have been introduced to allow more flexible 
markup such as revision numbers or change requests. Editing of Annotations has been 
revamped with the introduction of a live-edit Quick Access Panel, which provides imme-
diate visual feedback of the changes you make, and simple global editing of all selected 
Annotations. The new edit panel also offers expanded functionality, providing you with 
more customization than was possible in the past.
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Figure 10: New Annotation options

 l Set Workspace Print Area - Show printing page borders on the Workspace and cus-
tomize the printing area.
The new Printer Page Layout tool offers a convenient and effortless way to adjust the 
printing area according to your preferences. With a clear and intuitive visual rep-
resentation, you can easily identify where page breaks will occur. Now, you can con-
fidently print a specific section or the entire model at your desired scale, eliminating the 
need for trial and error.
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Figure 11: The Printer Page Layout feature allows the user to set the Workspace print area

 l Customize Parameters Available to Graph from the Workspace - New User Options 
allow custom selection of any graph parameter on the right-click Workspace context 
menu.
Did you know you can easily graph results from the Workspace by right-clicking on a pipe 
or junction? This functionality has existed for a long time, but it was previously limited to a 
predefined set of parameters. Now, you can specify what graph types you would like to 
see in these menus to simplify your analysis process.

Figure 12: The right-click context menu for pipes on the Workspace can have the graphing para-
meter options modified
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Miscellaneous Improvements

 l Modeling Additions and Improvements
 l Laminar Corrections - Laminar corrections are now off by default, messages 

indicate if they were applied or are recommend, and output parameters indicate 
the correction strength.

 l Zero-Length Connectors - Zero-Length Connectors now behave like standard 
pipes for most features, including selection and graphing tools.

 l Fluid Libraries - New category for user-defined fluids, making it easier to find cus-
tom entries.

 l Control Valve Fully Open Cannot Regain Control - New special condition that 
keeps the control valve in a locked-open position during transients.

 l Simpler Force Definitions - Difference forces spanning more than 2 pipes no 
longer require the definition of a group.

 l Specify RPM to Evaluate in PFA Module - Directly specify an RPM to evaluate 
pulsation levels for, instead of only evaluated worst-case frequencies.

 l API 674 Limitations in PFA Module - API 674 outlines frequency-dependent 
pulsation limits - you can now check for violations graphically.

 l Importing of PCF, EPANET, GIS, and CEASAR II Models
 l Bend r/D - Import PCF bends with appropriate r/D values.
 l Speed Increase - Importing is up to 10x faster in some cases.
 l Defaults and Display - Better defaults and display options for imported models.
 l Pipe Materials - Improved ability to link AFT pipe materials to imported pipes.
 l CEASAR II Node Names - Display imported CAESAR II node names as junction 

names.
 l Behind the Scenes Improvements

 l Graphing Optimization - Significant improvements to backend graphing code 
which provides additional stability now and more capabilities in the future.

 l eLicense Access Improvements - Added a "heartbeat" functionality to eLi-
censes which improves security and the release of license seats not in use.

 l Output - Significant improvements to backend output code which provides addi-
tional stability now and more capabilities in the future.

 l Timed Recovery File - Automatically generate a backup of your unsaved model 
that can be used to recover unsaved work in the event of unexpected application 
closure. This is separate from the *.bak files which are only generated after saving 
a model.

 l New and Improved Output Parameters and Messages
 l Pump RPM - Report pump speed in RPM, in addition to percent.
 l Vapor Volume Percent Output Parameter - Report percentage of computation 

volume vaporized, in addition to the physical vapor volume.
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 l Deep Laminar Caution - Simple loss models do not account for exceptionally low 
laminar flow, this new message provides a caution if you enter this range.

 l POR/AOR in Pump Summary - Show the values for Preferred and Allowed 
Operating Ranges in the Pump Summary.

 l Event Messages in New Format - Events are now shown in a cleaner, col-
lapsible format similar to Warnings.

 l Tank Overflow and Drain Warnings - New messages to clearly indicate if a Tank 
has overflowed or drained during the transient.

Interface Improvements for Impulse 9
There were many improvements made to the interface in Impulse 9. These changes primarily 
involve consolidating inputs with the new Analysis Setup window, and updating the functionality 
of databases, which have been renamed as libraries.

Analysis Setup Sources in Impulse 8

 l Steady Solution Control: The Steady Solution Control parameters have primarily 
moved to the Steady Solution Control group. The Special Controls have moved to the 
Advanced Parameters panel under the Miscellaneous group

 l System Properties: The System Properties window has been split up into the Fluid 
Properties group and the Environmental Properties group. The System Properties 
icon is still available from the Analysis menu and toolbar to directly open the Fluid Prop-
erties panel. 

 l Section Pipes: The Section Pipes window has been moved to the Sectioning panel in 
the Pipe Sectioning and Output group.

 l Transient Control: The Transient Control parameters were distributed into multiple 
groups:

 l The settings from the Transient Solver Control tab were moved to the Transient 
Control group

 l The Pipe Station Output and Junction Output tabs which specified what output to 
save to file were moved into the Pipe Sectioning and Output group

 l The Force Output tab was moved to the Forces group
 l The Advanced transient control settings were moved to the Advanced Para-

meters panel in the Miscellaneous group
 l Checklist: The checklist which was shown in the Quick Access Panel has been replaced 

by the status icons in the Analysis Setup window. Red exclamation marks denote which 
inputs are incomplete

 l List Undefined Objects: The undefined objects list has been moved to the Pipes and 
Junctions group. The undefined objects list can also still be viewed next to the Work-
space by opening it from the View menu.
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 l Add-on Modules Activation: The activation window for add-on modules has moved to 
the Modules panel

 l Slurry Data (SSL Module Only): Settings have been moved to the Fluid Properties 
group

 l Pulsation Data (PFA module only): Settings have moved to the Pulsation Setup group 
and the Sectioning panel

Database Improvements

 l Databases have been renamed as libraries throughout the interface to better reflect their 
functionality

 l Connecting, creating, and transferring content between libraries can all be done from the 
Library Browser, rather than switching between tabs in the Database Manager to do this

 l Viewing the contents of libraries can also be done directly in the Library Browser, rather than 
opening a separate Browse Database Content window

 l Windows to edit and add components to libraries can all be accessed directly from the 
Library Manager rather than having to navigate solely through the Library menu
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New in Version 9

Analysis Setup

The Analysis Setup window consolidates windows for System Properties, Solution Control, Sec-
tion Pipes,  Transient Control, and Activate Modules all into one location. This allows users to 
activate and enable modules, specify fluids, change solution tolerances or iterations, and so on, 
all from a single window. For a list of windows that have merged into the Analysis Setup 

Libraries

The database feature interface was completely overhauled to improve workability. The new sys-
tem is called the Library Manager and significantly improves the ease and workability for users to 
browse and connect input information, now called libraries, into their model.
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Gas Accumulator Updates

The Gas Accumulator Properties window has been redesigned, and several new features have 
been added as follows:

 l The tank geometry for the gas accumulator can now be defined, allowing the liquid level in 
the gas accumulator to be tracked, and limiting the gas volume accordingly

 l Additional options for defining the steady state gas accumulator volume have been 
added, allowing the thermodynamics for the steady state to be defined separately from 
the transient
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Improved Organization of the Warnings in the Output

An improved display of the warnings and design alerts makes it easier to review and understand 
information in the following ways:

 l Critical Warnings, Warnings, and Cautions are color-coded and grouped by type  in col-
lapsible sections

 l Design Alerts are now shown on a separate tab in the General Section
 l Double-clicking messages will take user to the related pipe/junction in the Workspace
 l Warnings, Cautions, and Design Alerts are now displayed for all scenarios when using 

the Multi-scenario Output feature
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More Improvements

 l Pipes/Junctions
 l Pipes can be defined as zero-length connectors to connect two junctions which are 

directly flanged together
 l Several new junctions have been added including the Bend, Orifice, Screen, and 

Venturi junctions
 l Submerged pump can now be defined using surface pressure and pump depth
 l Valve transients can be defined as open percent vs time

 l Workspace and Interface
 l Pipes and Junctions can be set the Same as Parent directly from the Workspace
 l Custom Unit names can be defined in the Unit System section of the User Options 

window
 l Pipe/Junction notes can be searched in Select Special
 l Special Conditions can be directly changed from the toolbar for junctions that have 

multiple special condition options
 l Output and Reporting

 l Show the number of warnings and design alerts in the batch run window
 l Design alerts are grouped together in the General Output section
 l New output parameters are available for the Relief Valve junction

 l Miscellaneous

 l Herschel-Bulkley non-Newtonian viscosity model added for representing Power 
Law fluids which have an apparent yield stress

 l New run time messages are shown in the Solution Progress window to help users 
adjust their model to decrease run time for the simulation

 l List Junctions that have Special Conditions change in Solution Progress window
 l Silent Batch runs can be enabled to prevent notifications from appearing over 

other active windows

Related Topics

Overview of AFT Impulse 19
Impulse Learning Resources 54
Engineering Assumptions 20
Startup Window 55
FAQ - Frequently Asked Questions 52
Converting Models from Earlier Versions 810
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New in Version 8

Scenario Comparison Tool

 l Quickly get a comparison of different scenarios within a model file
 l Useful to double-check input results for old models, or for troubleshooting purposes
 l For a detailed description, see Scenario Comparison Overview

Multi-Scenario Graphing

 l Users can now create graphs of data from multiple scenarios in the Graph Results win-
dow

 l Transient Junction graphs can be created for any scenarios in a model, while Transient 
Pipe, Profile, and Force graphs can be created for scenarios with the same pipe sec-
tioning
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New Time-Varying Friction Model

 l An additional model for unsteady friction has been added to the Transient Control window 
 l The Brunone model adds an unsteady shear stress term which varies based on the velo-

city at the current time step. This addition allows Impulse to better account for the fric-
tional losses as fluid velocity changes during a transient.

Improved Pump Window and Four-Quadrant Data

 l Reconfigured selections for pump performance curve options to further clarify how dif-
ferent selections will behave

 l 'Automatically Selected' option for Four-Quadrant data sets to automatically choose a 
data set for a given pump based on Estimated Specific Speed

 l Four-Quadrant data sets clarified to reflect the quality of the data

Junction Specific Parameters in Visual Report

 l Output such as percent of BEP for a pump or the Cv of a control valve can now be dis-
played in the Visual Report
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Improvements to Force Set Capabilities

 l Export forces to AutoPIPE
 l Vectors for force sets can be defined using X-Y-Z unit vector information. This force set 

information can then be included with exported force data into a relevant pipe stress ana-
lysis software.

 l Force Sets can be defined directly from the workspace by selecting pipes and using the 
right-click menu.

Notes in Output

 l Notes can be added to cells in the Output to save observations and comments directly 
with the model file.

- 40 -



Overview of AFT Impulse

New Workspace Functionality

 l Multi-level Undo - Drawing, arranging, and moving objects in the Workspace now allows 
for multiple levels of undo. 

 l Magnifier Tool - The magnifier tool is available in both the Workspace and the Visual 
Report, and provides an enlarged view of sections of the model to make it easier to man-
age and navigate large models.

 l Automatic Junction Rotation - Impulse will automatically rotate junctions to visually 
align with neighboring pipes to speed-up model formatting 

 l Split Pipes by Intermediate Elevations - Pipes with intermediate elevations can be split 
with branches at the intermediate elevation points. See Combining and Splitting Pipes

 l Select Shortest Flow Path - The shortest path between two selected junctions can be 
found using this feature in the Edit menu

Diagnostics Window

 l Provides a list of features and settings which might cause issues as a starting point for 
model troubleshooting

 l See the Diagnostics Window topic for more information

- 41 -



Overview of AFT Impulse

More Improvements

 l Overall Performance
 l Improved intelligence on when a model needs to be saved and re-run to preserve 

the output
 l Faster model loading speed
 l Improved language refresh speed
 l New and updated themes

 l Workspace
 l The Undefined Objects Panel (launched from clicking "Define Pipes and Junc-

tions" in the Checklist) remains open when pipes/junctions are being edited
 l Double-clicking a junction allows more than one of that junction to be placed in the 

Workspace at a time
 l Snapping can be turned off for pipes when the isometric drawing mode is enabled

 l Output
 l Output parameters can now be filtered/searched for simpler selection

 l Visual Report
 l Visual Report Control has been redesigned to better filter parameters

 l Junctions
 l Updated Tee/Wye Properties window which clarifies the input and automatically 

defines the pipe arrangement according to the direction and orientation on the 
Workspace

 l Notes can be globally edited for junctions
 l Design Alerts

 l Design Alerts can be saved to and loaded from a file to quickly apply common 
Design Alerts to multiple models

 l Ability to import custom Fittings & Losses from a file

Related Topics

Overview of AFT Impulse 19
New in Version 9 34
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New in Version 7

New & Improved Microsoft Excel Integration

 l Improved keyword based method for importing model changes from an Excel Worksheet
 l Use the included template Worksheet to quickly and easily define model changes
 l Change multiple scenarios at once
 l For a detailed description see Importing From Excel

 l New feature for directly exporting specified Output data to new or existing Excel Work-
books.

 l Export only the data that is desired - no need to sort through unnecessary data
 l Specify exactly where the data will end up - insert data into a pre-formatted Work-

book
 l Automatically export after a model run
 l Export data from multiple scenarios with a batch run
 l For a detailed description see Exporting To Excel

New Isometric Drawing Mode

 l New Isometric Pipe Drawing Mode
 l Show and Snap to an isometric grid on the Workspace
 l View models in an intuitive "3D" layout, and easily build from existing isometric 

drawings
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NIST REFPROP Fluid Database Now Included

 l Over 150 fluids from the National Institute of Standards and Technology (NIST) Refer-
ence Fluid Thermodynamic and Transport Properties Database (REFPROP) Version 10

 l Select a NIST REFPROP fluid directly in System Properties
 l Use accurate and complete fluid information in your models without the need to loc-

ate and enter fluid properties manually

New Pump Features and Improved Pump Window

 l New Positive Displacement Pump Model
 l Clarifies the specification of Positive Displacement Pumps

 l New Pump as Turbine Model
 l Added options for Reverse Flow to Centrifugal Pump Model

 l Clarifies required data and model intention
 l For a detailed description see Pump Properties window
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 l Specify a centrifugal pump's Preferred Operating Region (POR) and Allowable Operating 
Region (AOR)

 l Quickly determine if a pump's behavior is acceptable
 l Automatically calculate a POR from ANSI/HI 9.6.3-2017 - Rotodynamic Pumps - 

Guideline For Operating Regions
 l For a detailed description see Pump Configuration > Configuration Data

 l Significant enhancements and clarity added to the Four Quadrant modeling capabilities of 
the pump

 l Added ability to model a pump trip for a VFD pump
 l See a full list of changes to the Pump Properties window here

New Multi-Condition Events

 l Create complex triggers for transient events
 l Only start a transient event when multiple conditions are met
 l Utilize logical conditions - AND, OR, and NOT - to capture the effects of complex 

control systems
 l For a detailed description see Multi-Condition Events
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Visual Report Animation

 l Revived visual report animation feature from AFT Impulse 1
 l Use color animation to show absolute values or values relative to the steady state
 l Static color map option to show maximum/minimum values from the transient data
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New Features for Valves

 l General
 l Pre-defined curves available for valve Cv vs open percent

 l Check Valves
 l Check valve closing velocity can be estimated using dimensional data for decel-

eration vs. maximum velocity to close chart
 l Ability to enter manufacturer data for deceleration vs. maximum velocity to close
 l New inertial model for translating nozzle/plug check valves
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 l Control Valves
 l Control Valve setting for Always Control (Never Fail) can be set to a default to off
 l Added Control Valve transient option to fail open or closed from current Cv value

 l Valve
 l Standard valve junction has the option to create Cv vs time transient from open % 

vs Cv data

Improved Startup Window

 l Improvements to the capability and usability of the Startup Window
 l Set modeling preferences including - active modules, working fluid, units, lan-

guage, 2D or Isometric drawing mode, and default pipe material
 l Displayed units can now be easily refined by selecting Common Units and 

Industry-Specific Units

New Integration with Common Piping Layout formats

 l Save modeling time by importing existing Piping Layouts from various neutral file types
 l Import CAESAR II Neutal Files (.cii)
 l Import Piping Component Files (.pcf)
 l Import and Export EPANET Files (.inp)
 l These common file formats are generated from many common engineering pro-

grams such as AutoCAD Plant 3D, SmartPlant, PDS, CadWorx, and many more.

- 48 -



Overview of AFT Impulse

Updated Standards

 l Output displays Applied Standards - standards that were used in calculation of model res-
ults

 l Relief Valve loss can be specified with Designation Size per API 526 - Flanged Steel Pres-
sure Relief Valves

 l Updates to Standards
 l Updated to HI/ANSI 12.1-12.6-2016 Rotodynamic (Centrifugal) Slurry Pumps for 

Nomenclature, Definitions, Applications, and Operation for use in Slurry De-rating
 l Updated to HI/ANSI 9.6.7-2015 Rotodynamic Pumps - Guideline for Effects of 

Liquid Viscosity on Performance for use in Viscosity Corrections
 l Updated MIT Equation for Crude Oil to latest version specified in Pipeline Rules of 

Thumb for use as an additional pressure loss model

More Improvements

 l General
 l Many new default Pipe Materials
 l Intermediate pipe elevations can now be entered as Length Along Pipe
 l Increased the loading speed for large models
 l Applying Design Alerts now shows Design Alert Violations in transient Output 

tables, and all time steps that violate the Design Alert are highlighted
 l Time delay option added for Air Valves
 l Added Buried Pipe model for calculating pipe wavespeed
 l Reservoir junction now has a finite tank option
 l New Force Set types for exit differential forces
 l Forces are calculated during the run for improved output display and graphing 

speed
 l Option available to add more rows to entry tables

 l Workspace
 l The Workspace background color can be changed based on the level of the cur-

rent scenario - additional levels have been added
 l Annotation background opacity can be changed
 l New keyboard shortcuts to zoom (CTRL + +/-) and pan (CTRL + arrow keys) the 

Workspace
 l Full Scenario Path Name can be copied to clipboard by right-clicking a scenario
 l Selection box visually indicates the behavior of the selection - select everything 

intersecting (right to left) or only objects completely inside (left to right)
 l Pipes with Fittings & Losses defined now display a special character next to their 

number (default of &)
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 l Output
 l Design Alerts can be created directly from the Output by right-clicking on a result - 

immediately select the appropriate object and parameter.
 l Data can be sorted by clicking on column heading
 l Output reports in portuguese

 l Graph Results
 l More parameters available on the Transient Junction tab, including parameters 

such as delta pressure/head
 l Model Data

 l Quickly locate a specific object on the Workspace by right-clicking the item in 
Model Data

 l Visual Report 
 l Reworked Display Option controls for Pipes and Junctions in Visual Report Control

Related Topics

Overview of AFT Impulse 19
New in Version 9 34

New in Version 6

General Interface

 l Improved tab interface and enhanced Quick Access Panel functionality
 l Improved search includes pipe and junction notes, names and numbers
 l Output reports in German and Chinese languages
 l Main menus are translated into available output languages

Graph Results

 l Multiple Graphs can be added to Graph Folders for easy generation and display
 l Multiple graph tabs on primary window Graph tab
 l Multiple parameters can be stacked on separate graphs using the same X-axis
 l Secondary Y-parameter  for most graph types
 l Multiple graphs tiled on same Graph tab
 l Multiple graphs can be animated at the same time 
 l New parameters such as Kv, Cv rate of change, valve position, liquid accumulator volume
 l Easy formatting of titles, axis labels, and plot lines 
 l Plot series lines can be turned on/off for quick inspection
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 l Graph controls now located on the Quick Access Panel for easy graph definition and 
changes

 l Animations can be saved in MP4 and QuickTime formats

Workspace

 l New paste preview mode allows the pipes and junctions to be placed desired and  will 
indicate interference with existing objects on the Workspace

 l GIS shape files can be imported to create a model
 l Text alignment options in annotations
 l Annotations can be layered on the Workspace

Junctions

 l New Turbine junction type
 l Two new Check Valve models, including an inertia-based Swing Check Valve model
 l Surge Anticipator valve capability added to the Relief Valve
 l Remote pressure sensing capability added to the Relief Valve
 l Improved clarity for data entry in the Surge Tank Property window
 l Automatic generation of Cv vs. Time using  equal percentage or linear profiles
 l New events based of Cv or Kv
 l Maximum pressure setting for Gas Accumulators simulates a relief valve
 l When the speed is set for a pump, both the original and modified pump curves are shown 

on the Pump Property window
 l Design Alerts can be applied to junctions

Pipes

 l Design Alerts are specified and named globally and applied to pipes
 l New Design Alerts available

Forces

 l New Force Summary report available in the output showing all applied force sets
 l New Design Alerts can be applied to Force Sets and shown in the Force Summary
 l New Force report in Model Data showing the input details
 l Force definitions can be imported from an Excel file
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Scenario Manager

 l Ability to create child scenarios without results saving duplication and load time
 l Scenario manager shows which scenarios have output

Output

 l Results Diagrams which graphically show data for pumps

Visual Report

 l Automatic Color Map generation

Related Topics

Overview of AFT Impulse 19
New in Version 9 34

FAQ - Frequently Asked Questions

Can AFT Impulse model transient cavitation?

Yes, AFT Impulse uses the Discrete Vapor Cavity Model or Discrete Gas Cavity Model.

Can AFT Impulse model gas transients?

No, AFT Impulse only models transients in liquid systems.

Can AFT Impulse model pump transients?

Yes. Pumps can be modeled as a prescribed speed transient or the speed can be calculated 
based on pump inertial characteristics.

Can AFT Impulse model transients cause by positive displacement 
pumps?

Yes, positive displacement pumps can be modeled as steady operation with periodic flow or dur-
ing startups and shutdowns.
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Can AFT Impulse model air (i.e., vacuum breaker) valves?

Yes, see the Air Valve junction topic.

Can AFT Impulse model pressure and flow control valves?

Yes, see the Control Valve junction topic.

Can pipes be modeled with varying elevation profiles?

Yes, users can assign an elevation profiles to individual pipes.

Can I specify maximum and minimum operating pressures?

Yes, AFT Impulse allows you to include these as "design alerts". Design alerts can be cross-plot-
ted against pressure profiles.

What fluid properties are available in AFT Impulse?

AFT Impulse offers a standard set of properties for common fluids in the AFT Standard Fluids lib-
rary. It also offers the NIST REFPROP library included with all AFT applications. Users can also 
utilize the optional Chempak data add-on which is a chemical property library of up to 700 fluids 
with mixing capability. Use the library as a stand-alone application with the Chempak Viewer or 
access the library from within Microsoft Excel with the Chempak Add-in.

Can AFT Impulse model non-newtonian fluid behavior or pulp and paper 
systems?

Yes, AFT Impulse offers Power Law and Bingham Plastic non-newtonian fluid models, and 
offers the Duffy method and Brecht & Heller for pulp and paper system modeling.

How does the steady-state solution capabilities in AFT Impulse differ 
from AFT Fathom?

The steady-state solver in AFT Impulse uses the same method as AFT Fathom. However, its pur-
pose is different. AFT Fathom is a general purpose steady-state modeling tool. On the other 
hand, AFT Impulse uses steady-state only as it relates to waterhammer. Thus some capabilities 
found in AFT Fathom do not exist or are more limited in AFT Impulse. The most important dif-
ferences are as follows: AFT Impulse does not model heat transfer. It does not have junctions for 
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static elements like elbows, orifices, heat exchangers, etc., although these can still be modeled 
in AFT Impulse but through other methods such as Additional Losses in pipes or as General 
Components. AFT Impulse does not offer polynomial resistance curves except for General Com-
ponents. AFT Impulse does not offer graphing of pump and system curves, which only have 
meaning for steady-state.

Does Impulse have the ability to model partially filled pipes?

Impulse can model partially filled pipes at the end of a flow path or run. This capability is primarily 
intended to handle the situation where a supply riser to a cooling tower or condenser, for 
example, partially drains when the system is not in operation.

Impulse Learning Resources

Online Resources

Additional resources can be found in the Learning Center on our website. Resources found there 
include:

 l Training Seminar information
 l Free Webinars
 l Flow Expert Package information
 l Case Studies
 l Video Tutorials
 l Tips & Tricks Blogs
 l Quick Start Guides

Online Quick Start Video Tutorial

The Quick Start video provides a short introduction to the interface of AFT Impulse, and works 
through a simple example model. 

 l Online Quick Start Video Tutorial Series

Beginner: Valve Closure Problem

This is a simple example model which is recommended as a starting point for brand new AFT 
product users. 

 l Beginner: Valve Closure Problem

- 54 -

https://www.aft.com/learning-center/learning-options
https://www.aft.com/products/impulse/video-tutorial-series


Overview of AFT Impulse

Walk Through Examples

This links to a variety of example problems for beginning to advanced users which showcase dif-
ferent features and applications of AFT Impulse. 

 l Walk Though Examples

Module Walk Though Examples

A list of examples using the add-on modules of AFT Impulse to solve a variety of problems.

 l Module Walk Through Examples

Related Topics

Overview of AFT Impulse 19
New in Version 9 34
Engineering Assumptions 20
Startup Window 55
FAQ - Frequently Asked Questions 52
Converting Models from Earlier Versions 810

Startup Window
The Startup Window is displayed when AFT Impulse is opened. This window allows the user to 
quickly access files and resources, as well as define a basic starting point for a new model.

 l Open a Model
 l My Files - AFT Impulse keeps a list of recently opened model files. The most 

recent files can be opened with a single click here.
 l Other Files - Browse to any other model file, or open the built-in Examples folder.

 l Start a New Model
 l Activate Modules - Any licensed Module can be activated immediately. Checking 

these boxes will search for an available license.
 l Select Working Fluid

 l I Will Select Fluid Later - No fluid will be defined, one will need to be 
defined in Analysis Setup on the Fluid panel before running the model.

 l Use ASME Water - Selects ASME Water to be used as the working fluid of 
the model which requires the definition of Pressure and Temperature.

 l Select A Recently Used Fluid - Allows the selection of a recently used 
fluid from the dropdown menu and also requires Temperature.

- 55 -



Overview of AFT Impulse

 l Modeling Preferences - Displays various settings for the application, such as spe-
cifying the units to use or which grid to use. These options can be modified later. 
Click the Modify button to reveal the following settings, as shown in Figure 2. Click 
the Remember My Preferences and Hide button to update the modeling pref-
erences for the model and to update the default settings for the application.

 l Units - US, Metric, or both sets of units with one as default can be dis-
played. Additionally, the displayed units can further be reduced to only show 
common units and those used by a certain industries.

 l Language - Select a language for the display of the Menus, Workspace Lay-
ers, Output, Graph Results, and the Startup Window.

 l 2D or Isometric Workspace - Set up the grid.
 l Default Pipe Material - Set the pipe material that is initially selected for 

new pipes.
 l Resources

 l Current Version - Open the AFT website to view the latest AFT Impulse release, 
or sign up for notifications of new releases via email.

 l Quick Start Guides - Provides links to various Learning Resources that are 
designed to help get a new user up and running with AFT Impulse as quickly as 
possible. The resources include the Quick Start Guide PDF, Examples, and video 
tutorials.

Figure 1: Startup Window in AFT Impulse
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Figure 2: Startup Window showing Modeling Preferences

Related Topics

Overview of AFT Impulse 19
New in Version 9 34
Impulse Learning Resources 54
Engineering Assumptions 20
FAQ - Frequently Asked Questions 52
Converting Models from Earlier Versions 810
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Overview of Fluid Transients
A system is steady-state if its properties - pressure, velocity, etc - do not change with time. Any 
disturbance to a steady-state system will cause these properties to change - this change is a 
fluid transient.

Note: Fluid transients and their effects are commonly referred to with the term waterhammer. 
While the term is most appropriate for water systems, waterhammer analysis applies to 
any liquid.

All fluid transients cause disturbances which propagate throughout the fluid as coupled pressure 
and velocity waves. This behavior is perhaps best explained with a conceptual example. Like 
any acoustical wave, these waves reflect, combine, and dissipate. This behavior can be 
extremely complex, even in relatively simple systems.

Slow acting system changes - such as a reservoir level that changes over the course of a day - 
can be accurately approximated with a series of steady-state simulations. There are still rapidly-
propagating transient pressures in the system, but their magnitude is generally small enough to 
be considered negligible.

Rapid changes can cause large transient pressures that propagate through the piping network. 
In extreme cases this causes catastrophic failure of piping and associated equipment. AFT 
Impulse is focused on analyzing rapid changes to the state of a fluid piping system and the res-
ulting transient behaviors via the Method of Characteristics.

Related Blogs

What Is Transient Analysis?

Conceptual Example
The wave mechanics of a fluid transient are not always clear at first glance. It is helpful to con-
sider a simplified example to understand the dynamic events following a single transient event.

In the example below, a rigid, frictionless pipe is connected to a fixed pressure upstream (a large 
reservoir, for example) and a valve downstream. The fluid is flowing at a steady velocity. The 
downstream valve is instantaneously closed, which instantaneously halts flow.

Phase 1: Initial Wave

When the valve is closed, the fluid immediately upstream no longer has anywhere to flow to and 
therefore must come to a complete stop. This stopped fluid acts like another closed surface for 
the fluid further upstream - stopping that fluid in turn. This is a wave which propagates upstream 
at a constant wavespeed. The wavespeed remains constant through all phases.

When the fluid is brought to a complete stop, the kinetic energy of the moving fluid is transferred 
into potential energy, raising the pressure of the fluid.

- 59 -

https://www.aft.com/support/product-tips/what-is-transient-analysis


Overview of Fluid Transients

The fluid properties at any given point do not change until the wave reaches that point. This 
means that the steady flow into the pipe remains unchanged, increasing the total amount of fluid 
in the pipe, until the wave reaches the reservoir.

Phase 1 - Initial Wave

Phase 2 - Reflected Wave

The upstream reservoir is considered a fixed pressure. Because the pressure at this point is 
unable to change, the high pressure transient wave is unable to be absorbed into the reservoir, 
and the wave is reflected completely.

The wave is now traveling downstream, reducing the high pressure back to the reservoir pres-
sure.

Lowering the pressure requires converting the stored potential energy back into kinetic energy. 
However, flow cannot proceed downstream. Instead, the fluid behind the wave travels upstream, 
discharging back into the reservoir. This magnitude of this velocity is the same as the original 
steady-state velocity.
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Phase 2 - Reflected Wave

Phase 3 - Negative Wave

When the wave from phase 2 reaches the closed valve, the entire pipe is at the original steady-
state pressure. However, the fluid in the entire pipe is now flowing in the reverse direction of 
steady-state.

When the reverse flow reaches the closed valve, there is no longer any fluid available to move 
and relieve the high pressure originally built up in phase 1. The flow is again completely halted at 
the valve. Like the upstream reservoir, the closed valve does not absorb the pressure wave and 
it is again completely reflected. However, the behavior is different due to the opposing flow dir-
ection.

This time, the flow velocity is brought from negative velocity to rest, instead of positive velocity to 
rest. This causes a negative pressure compensation. In effect, the fluid leaving the system 
begins drawing a vacuum at the closed valve.

The negative wave that results travels upstream at a pressure lower than the steady-state pres-
sure. This pressure drop is the same magnitude as the pressure rise in phase 1.

Note that fluid has been flowing out of the pipe and into the reservoir during the entirety of 
phases 2 and 3.

- 61 -



Overview of Fluid Transients

Phase 3 - Negative Wave

Phase 4 - Reflected Negative Wave

When the negative wave reaches the upstream reservoir, it is again completely reflected, bring-
ing the pressure back to the steady-state pressure.

To increase the pressure, fluid must flow back into the pipe. The fluid velocity and pressure 
behind the wave are back to the original steady-state magnitudes. However, the wave is trav-
eling in the opposite direction to phase 1.

Upon meeting the valve, the wave is again perfectly reflected. As before, the fluid is entirely hal-
ted, and the forward fluid momentum converted into a rise in pressure.

The behavior after this final reflection is identical to phase 1. In a frictionless pipe, and with per-
fect reflections, there is no mechanism to reduce the energy of the system - the wave reflects 
indefinitely, cycling through the four phases.
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Phase 4 - Reflected Negative Wave

Related Topics

Nomenclature 683

Related Blogs

What Is Transient Analysis?

Wavespeed and Communication Time

Wavespeed

The speed at which a wave propagates throughout a medium is termed the wavespeed. The 
wavespeed depends on the acoustical velocity of the fluid itself as well as the physical properties 
of the pipe and the method of support.

Acoustical velocity through the fluid is related to the bulk modulus of elasticity (K) and density (ρ) 
of the fluid.
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This wavespeed is the propagation speed in a fluid where there is no mechanism to impede the 
wave motion - for example, in an unbounded body of fluid or in a completely rigid pipe.

In piping systems, some of the energy in a pressure wave distorts the pipe itself, reducing the 
wavespeed. This depends on the pipe modulus of elasticity (E), the inner diameter (D), the wall 
thickness (e) and a constant (c1) which depends on pipe supports.

For more information, see Wavespeed - Detailed Discussion.

Also note that the wavespeed equation presented here is only valid for fluids with no solids 
present. If the SSL Module is being used to model settling slurries, the wavespeed is adjusted 
as is discussed in the Wavespeed Calculation for Slurries topic.

Communication Time

An important consideration in fluid transient studies is how long it takes a wave to propagate 
through the system.

The time it takes for a wave to travel from one end of a system to the other is simply the distance 
(L) divided by the wavespeed.

When a transient event occurs at one end of a pipe, the wave travels at the wavespeed to the 
other end of the pipe. However, this is not sufficient time to analyze the problem. While the dis-
turbance has propagated through the entire system, the point of transient initiation has not yet 
seen the result of the reflected wave. For the wave to both travel to the end of the pipe and back 
requires double the above time. This time is known as the Pipe Period or Communication Time.

Note: The Communication Time only accounts for half of the wave cycle (described in the 
Conceptual Example). This is how much time it takes for a disturbance to return to its 
starting point, but analyzing a system for only this amount of time neglects part of the 
transient cycle. Transient simulations should run for at least double the Pipe Period, or 
4L/a.
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Related Topics

Nomenclature 683

Related Blogs

A Story About Fluid Communication

Minor Wave Reflections
Every point of resistance to flow in a piping system is a source of wave reflections. Without any 
resistance in a system there would be no reflections or pressure loss.

It is beneficial to include all of the resistances in a system during a transient analysis, to capture 
the pressure losses that occur in both steady-state and transient conditions.

However, the magnitude of a reflection from a minor loss such as a locked open valve or an 
elbow is generally small enough to be ignored. Including every minor loss as a component 
requires numerous Pipe Sections, which has the potential to exponentially increase run time.

Rather than ignoring the component entirely, and thus ignoring the pressure loss, it is possible to 
effectively ignore only the minor reflection by lumping the loss of the component into a pipe. By 
increasing the overall resistance of a pipe, the additional pressure loss is accounted for and run 
times are significantly improved, with usually only minor changes in results.

Note: It can be difficult to tell what components can be lumped into pipe resistance, and what 
reflections are important. Generally, components that do not change position or beha-
vior during a transient, and have low steady-state pressure loss can be lumped. If it is 
not clear that a certain component has no significant reflection it is best to include this 
component in the analysis. Comparing analyses with a component explicitly modeled 
versus lumped gives an indication of the impact this simplification has.

AFT Impulse provides an easy way to lump these resistances with Fittings & Losses, by allowing 
the user to define common components directly "within" a pipe.

Automatically Combine Pipes

The Combine Pipes window is opened from the Section Pipes window and will automatically 
combine adjacent pipes of the same diameter separated by a static junction. When pipes are 
combined, all length, elevation, pipe K factors, intermediate junction loss, and visual segment 
data is preserved into the resulting pipe.

Related Topics

Nomenclature 683
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Pipe Sectioning - Introduction to Method of Characteristics
To run any transient simulation in AFT Impulse, the pipes in the model must first be sectioned - 
required for the Method of Characteristics solution approach utilized. A brief overview of the 
impact the Method of Characteristics has on the model is covered here - for a detailed discussion 
on the mathematics behind the method see: Method of Characteristics.

What is Sectioning?

The Method of Characteristics requires the entire system to be solved every time step. To accom-
plish this, every section must use a common time step. If the time steps were allowed to vary 
throughout the model, some portions of the system would be solved "ahead" of others, resulting 
in a time-distorted solution.

Furthermore, the Method of Characteristics requires that any information propagated from a 
given calculation point arrives at the neighboring calculation points after one time step. The 
method cannot allow information to be "lost" between time steps or calculation stations - the dis-
tance between calculation points is locked to the duration of a time step.

The time Δt it takes to travel from one point to another is determined by the linear distance Δx 
and wavespeed a between those points. We have defined this time to be the time step for the 
transient simulation.

Each section must be continuous and unchanging fluid path. In other words, the physical prop-
erties of the pipe cannot change within a single section. This means that every Pipe in the model 
must have a whole number of sections - otherwise the section would be interrupted by a Junc-
tion. In mathematical terms, a pipe of any length L must have N sections of length Δx:

In any system there will be a single controlling pipe. This is the pipe with the fewest sections, 
generally only one. As this pipe cannot have any fewer sections, the sectioning of the entire sys-
tem is effectively controlled by this pipe.

What happens if the system cannot be evenly divided? For example, consider a system of two 
pipes - each with identical wavespeed. One of the pipes is 20% longer than the other.
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Figure 1: Mismatch in pipe lengths

If we state that Pipe 1 - the controlling pipe - should have 1 section, Pipe 2 must have 1.2 sec-
tions to meet the time step restriction. However, this fails the whole number of sections require-
ment. One solution here is to find a common denominator that evenly divides both pipes. If we 
state that Pipe 1 has five sections, then Pipe 2 can be divided into six sections of the same 
length. But what if the common denominator is a very large number? Consider the below system.

Figure 2: Smaller mismatch in pipe lengths

If all three pipes were the exact same length, we only need one section in each pipe. Due to the 
length variation, Pipe 3 - the controlling pipe - would require 97 sections. This also means that 
the time step must be 97 times smaller! We have increased the number of calculation points by 
nearly a factor of 100 and the number of time steps required by the same factor. The small vari-
ation in length will cause the simulation to take nearly 100*100 = 10,000 times longer! Clearly, 
this is unacceptable for any practical purposes.

The solution is to allow some variance (ψ) into the system. The time step cannot be adjusted 
independently across sections. Instead, we can adjust the wavespeed in each pipe.

Again consider the three pipe example - if we decrease the wavespeed in Pipe 3 to 97% of its ori-
ginal value, and increase it in Pipe 2 to 101% of the original value, we can arrive back at our ideal 
situation - 1 section in each pipe. A 3% change in wavespeed can be considered negligible for 
any reasonable transient simulation - there are greater uncertainties than this in almost all stud-
ies.

Note that you can decrease the maximum variance further by adjusting the wavespeed in all 
three pipes. Above, we kept Pipe 1's wavespeed fixed - introducing the 3% variance in Pipe 3. If 
we vary the speed in Pipe 1 as well, we introduce some variance in Pipe 1, but we also make the 
Pipe 3 value smaller.

The standard allowance for variance in AFT Impulse is 10%. It is suggested to increase the num-
ber of sections in the controlling pipe until this value is under 10%. Some references such as 
Wylie accept up to 15% variance.
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Sectioning Effect on Run Time

Extremely long run times are often a result of a large number of sections. As discussed above, 
the run time is approximately proportional to the square of the number of sections.

Large numbers of sections are rarely required for accurate results. There are a few common 
methods for reducing the number of sections:

 1. Do not include minor sources of wave reflections as junctions.
 2. Limit the difference between the longest and shortest pipes in the model. A very short 

pipe must have at least one section. If there is a very short pipe (1 meter) and a very long 
pipe (10,000 meters) then the model must have a large number of sections (10,001 sec-
tions). If the short pipe cannot be lumped into its adjoining pipe, it is often an acceptable 
approximation to artificially lengthen the short pipe. This may increase the error in the 
short pipe, but experience shows that this error is usually negligible in a fluid transient con-
text. Increasing the very short pipe's length from 1 to 10 meters decreases the 
number of sections required by a factor of 10 - and therefore the runtime by a 
factor of 100.

 3. Do not include extremely long pipes unless the transient behavior in those pipes is being 
directly analyzed. Instead, consider using the Infinite Pipe feature.

Sectioning Effect on Accuracy

Because each pipe section is explicitly solved along the characteristic lines from the Method of 
Characteristics, breaking pipes into continuously smaller sections offers no improvement in 
accuracy.

That is, using twice the number of sections in a pipe will not yield a more accurate prediction. 
This is in contrast to other kinds of finite difference methods where more increments offers 
improved accuracy.

Related Topics

Nomenclature 683
Sectioning Panel 185
Sectioning Panel with PFA Module 187

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning
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Cavitation

What is Cavitation?             

Cavitation is a commonly observed phenomenon in liquid systems which occurs any time local 
pressure reaches the liquid’s vapor pressure. At vapor pressure, the liquid boils, and forms vapor 
pockets within the liquid. These vapor pockets grow while the system pressure remains at the 
vapor pressure, and will collapse when the local pressure increases above the vapor pressure.    

Cavitation is seen in many situations. An everyday example is boiling a pot of water. Raising the 
temperature of the water raises the vapor pressure of the water. Eventually, the water at the bot-
tom of the pot is heated enough that the vapor pressure is equal to atmospheric pressure, and 
the water begins to boil. Vapor pockets are formed, and as they rise to cooler regions of water 
where the vapor pressure is lower, they collapse.    

Another common example is cavitation at a pump impeller. Pressure in the liquid decreases as it 
approaches the impeller, and vapor pockets will form if the pressure at the impeller eye reaches 
the liquid’s vapor pressure. The vapor pockets move out away from the impeller eye, and col-
lapse as the pressure rises above the vapor pressure.    

A final example is cavitation downstream of a valve. Pressure downstream of this valve is initially 
above vapor pressure during normal operation. The valve is closed rapidly which generates a 
low-pressure wave and causes the downstream pressure to reach vapor pressure. A vapor void 
forms while the pressure is at vapor pressure. The low-pressure wave is reflected as a high-pres-
sure wave, returns to the valve, and collapses the vapor pocket.    

Transient Cavitation    

The three examples of cavitation above all represent situations where the liquid pressure 
reaches vapor pressure and cavitation will occur. However, Impulse only attempts to model situ-
ations similar to the final example, where pressure waves are generated by transient events in a 
system forming vapor voids. This type of cavitation is called transient cavitation.    

Transient cavitation can be particularly harmful to a system because the vapor void formed must 
eventually collapse when high pressures return. The liquid on each side of the vapor void will 
slam together causing large pressure surges, large transient forces, and potentially significant 
damage to a system. The pressure surge following a transient cavitation event can often be lar-
ger than the pressure rise predicted by the Joukowsky Equation for the system, meaning engin-
eers should always evaluate these events carefully.    

Any transient event can generate a pressure wave which results in transient cavitation. Some 
common events include:             

 l Pump trips      
 l Valve closures      
 l Pump startups      
 l Sudden changes in control valve position      
 l Constructive wave interference      
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Cavitation Modeling in Impulse    

AFT Impulse attempts to model transient cavitation in pipes using one of two cavitation models: 
the Discrete Vapor Cavity Model (DVCM) and Discrete Gas Cavity Model (DGCM). These mod-
els are described further on the Cavitation Models page. Both models are meant to capture lim-
ited, transient cavitation in pipes, and are not meant to capture cavitation inside a junction, or 
cavitation which exists for a sustained period of time. Impulse also does not allow simulations to 
proceed when cavitation is present in the steady-state solution.    

A fundamental assumption behind Impulse’s solution methodology is that all pipes are 100% 
liquid-full. Cavitation inherently violates this assumption because vapor is introduced to the sys-
tem. Users should always treat results with any amount of cavitation as uncertain results and 
carefully review all results.    

AFT Impulse reports cavitation in a system with two parameters: Vapor Volume and Percent 
Vapor Volume. The Vapor Volume reports the actual volume predicted by Impulse’s cavitation 
models. The Percent Vapor Volume reports the vapor volume as a percent of the pipe section 
volume.    

AFT Impulse also uses Percent Vapor Volume to trigger two different warning messages in the 
output. A Warning message is generated when the Percent Vapor Volume is greater than 10%, 
while a Critical Warning message is generated when the Percent Vapor Volume is greater than 
100%. Each of these warnings is meant to convey increasing uncertainty in the results to the 
user.    

Related Topics

Nomenclature 683
Transient Cavitation Panel 193
Transient Cavitation Models 707
Interpreting Cavitation Results 100

Related Blogs

How does AFT Impulse model cavitation?

Instantaneous Waterhammer Equation
With some exceptions, it is safe to calculate the maximum possible transient fluid pressure surge 
by using the instantaneous waterhammer equation.

Note: The instantaneous waterhammer equation is often credited to Joukowsky and referred 
to as the Joukowsky Equation.

Derived from the mass and momentum equations, this equation calculates the pressure change 
(ΔP) when instantly changing the flow velocity (ΔV) for a given density (ρ) and wavespeed (a):
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There are cases where this value can be exceeded - these are discussed below in the Excep-
tions section.

Example

Assume flow of water is instantaneously stopped by a valve closure.

ρ = 62 lbm/ft3

a = 4000 feet/sec

ΔV = 10 feet/sec

Psteady = 50 psig

Exceptions

 l Cavitation 
When a positive pressure surge occurs, it is always followed by negative pressure surge 
that drops the pressure. If the drop in pressure causes cavitation, then the pressure spike 
that occurs when the cavity collapses can cause the local pressure to exceed that pre-
dicted by the instantaneous waterhammer equation.
The potential to cavitate can be assessed by subtracting ΔP from the steady-state pres-
sure. If this value is lower than the fluid vapor pressure, then cavitation is possible.
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 l Pipe Size Changes
When using this equation, the case considered is usually a valve closure. It is frequently 
applied with the ΔV obtained based on the pipe diameter at the valve. However, if smaller 
diameter pipes exist upstream that carry the same flowrate, their ΔV will be larger 
because they have less area. This will result in a larger pressure surge in the smaller pipe.
To be safe, the equation needs to be applied to the pipe with the largest ΔV potential in 
the entire system.

 l Multiple Pressure Surge Sources
If there is potential for multiple elements to generate pressure surge at the same time, the 
surge pressures can interact and add together, thus exceeding the individual surge pres-
sures.

 l Line Pack
In long pipelines or shorter systems with high friction the drop in Hydraulic Grade Line 
may be higher than the initial pressure surge. In these cases, the flow does not come to a 
complete stop with the initial compression wave - some flow continues towards the closed 
valve at a lower velocity, compressing the fluid and therefore increasing the pressure. 
See Wylie (1993) for more information.

Derivation

Consider a 1 dimensional fluid flow where the local velocity has been disturbed a small amount 
(ΔV). This small disturbance causes small disturbances in pressure (ΔP) and density (Δρ), along 
with a wave that travels with speed a. This is represented in the below control volume.

Figure 1: A downstream change in velocity causes a change in density and pressure, which propag-
ates upstream as a wave.

First, we apply conservation of mass to the control volume above.

The left side of the equation, relating flow into and out of the control volume, reduces to:
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The right side of the equation, relating the change in mass within the control volume, reduces to:

The density is only changing in the area swept by the wave front (moving at speed a, against the 
fluid velocity) over the time step. Therefore, we only need to include the change in density over 
this volume, as the other terms would cancel out. The volume swept by the wave is:

reducing the above to:

equating the sides and canceling the common A term:

Next, applying conservation of momentum:

The forces involved are simply the pressures over the areas. Because the pipe is considered fric-
tionless for this method, the upstream and downstream pressures are equal.

The right hand side of the equation can be expanded into a time derivative and flux term:
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Where the time derivative term follows similar logic to the mass conservation, with the volume 
affected defined by the swept area of the wave:

The flux term is relatively straightforward:

Combining and simplifying:

The two boxed formulas, representing conservation of mass and momentum, can be combined 
and simplified to the instantaneous waterhammer equation:

Related Topics

Nomenclature 683

Related Blogs

Line Packing: Recovering the Irrecoverable
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Typical Approaches to Reducing Transient Pressures

General Considerations

Excessively high surge pressures can burst pipes and damage equipment. Low pressure surge 
can result in pipe collapse if the difference between internal and atmospheric pressure is high, 
cavitation and liquid column separation, and sub-atmospheric pressures unacceptable for drink-
ing water pipelines.

If we consider the simplified case of the instantaneous waterhammer equation, pressure change 
is directly proportional to the fluid's density, wavespeed, and change in velocity. Therefore, a 
reduction in pressure response requires a reduction in density, wavespeed or velocity change.

While lowering the fluid density does reduce the pressure response, it is not usually a practical 
solution.

Note: The below suggestions are some common ways to mitigate pressure surge. This page 
is not intended to cover all possible means of reducing pressure change.

Lowering the Wavespeed

If the wavespeed of the fluid can be lowered, the pressure response will also be lowered. There 
are a couple of ways that the effective wavespeed can be lowered:

 l Change the construction of the pipe to deform a greater amount under stress.
 l The simplest way to accomplish this is to use a more flexible pipe material.
 l It is also possible to do this by changing the pipe geometry. Under internal pres-

sure, any pipe will want to become circular. An already circular pipe cannot deform 
to become "more" circular, however a non-circular pipe (such as a rectangular 
duct) can deform more easily. This deformation action increases the effective 
elasticity (decreases E), decreasing the wavespeed.

 l Change how much the liquid deforms under stress.
 l Entrain gas in the liquid. In effect, this makes the bulk modulus of the liquid lower.

Lowering the Rate of Velocity Change

The other practical way to reduce transient pressures is to reduce the rate of velocity changes in 
the system. There are a few ways that this can be accomplished:

 l Slow down controlled equipment as much as possible.
 l Slow down the closure of valves. Making a valve closure as slow as possible will 

reduce the transient pressure response as much as possible.
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 l It is important to note here that the closure time of a valve does not pro-
portionally relate to the change in velocity at the valve except in special 
cases. An oversized valve may close almost all the way before any sig-
nificant pressure rise is seen. This is because there may be very little pres-
sure loss across the valve initially, leading to very small velocity change. 
The effective closure time may be significantly less than the entire actuation 
period. In cases like this the pressure response can often be dramatically 
improved by modifying the pressure loss vs. time characteristics of the clos-
ure, rather than the total closure time.

 l A speed controlled pump will cause fluid transients on speed change - slowing this 
speed change down reduces surge.

 l Any other similar change - variable flows, pressures, control setpoints, etc have a 
similar effect.

 l Reduce the speed at which components adjust to the system.
 l Control Valves that quickly change position in an attempt to maintain control can 

worsen a transient event. Limiting their opening and closing rates can lessen this.
 l Relief Valves that are poorly designed can open and close very quickly, again 

propagating pressure waves they should mitigate.
 l Check Valve slam can be problematic - and preventing it may require changing the 

system or other equipment.
 l Tripping or starting pumps causes significant pressure response. This rate can be 

reduced by increasing the inertia of the pump and driver assembly - making the 
pump take longer to stop or start.

 l Add equipment to mitigate high or low pressures.
 l If using this type of device, it is generally desirable to locate the device as close as 

possible to the cause of the transient. The practicality of the different options 
depend highly on the particular case of interest.

 l Relief Valves - Avoid excessive pressures by providing a means for fluid release. 
Inward relief valves can be used for low pressure situations.

 l Air Valves - Allowing ambient pressure gas into the pipe during low pressure surge 
raises the system pressure. Usually located at high elevation points along a 
pipeline.

 l Surge Tanks - Surge tanks can be an effective way to reduce surge pressures if 
the steady-state system pressures are relatively low. High steady-state pressures 
result in high hydraulic gradelines. Since the liquid level in a surge tank rises to the 
local hydraulic gradeline, they would have to be very tall if located in a high pres-
sure region.

 l Gas Accumulators - Gas accumulators can be effective in spreading out the wave 
front of a transient and thus reducing peak pressures. Gas accumulators change 
the frequency response of the system and can in fact amplify pressure surge if not 
sized and located properly.

 l Check Valves - Appropriately located check valves can reduce transient pressures 
in the system by preventing reverse flow.
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 l Parallel Valves - Rather than use one large valve to stop the flow, perhaps two or 
more valves can be used in parallel. The timing of the valve closures is staggered, 
thus allowing a portion of the flow to be stopped with each valve.

 l Modify the piping
 l Increasing the diameter of a pipe decreases velocity for the same flow. With a 

lower initial velocity, the maximum potential velocity change is reduced.
 l Appropriately placed bypass piping can reduce pressure responses.
 l As with any wave phenomenon, the system may have resonant effects at certain 

frequencies. Changing the length or configuration of certain pipes can reduce (or 
increase) the pressure response. Adding dead end pipes tuned to a certain fre-
quency is one method of accomplishing this.

The above and additional methods for surge reduction or discussed in detail in Swaffield et al. 
(1993, Chapter 6), Wylie et al. (1993, Chapter 10), and Chaudhry (1987, Chapter 10).

Related Topics

Nomenclature 683

Related Blogs

Raise the bar using Vacuum Breaker Valves

A Clever Way to Mitigate Waterhammer During a Valve Closure
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Transient Forces
This section focuses on imbalanced force calculations in AFT Impulse. Topics included discuss 
how Impulse calculates forces, what types of force sets can be defined, and how to configure 
force calculations in Impulse.

Contents

Defining Forces 79

Force Set Types 82

Exporting Force Data 83

Force Theory 84

Warnings For Pipe Force Calculations 88

Related Blogs

Q&A: Calculating Transient Forces for Pipe Stress Analysis

You Should Combine Your Pipes

Defining Forces
AFT Impulse includes the ability to calculate transient hydraulic forces, which occur when a tran-
sient pressure wave passes through a portion of the system.

Note: As AFT Impulse is only a hydraulic solver, only hydraulic forces are accounted for. AFT 
Impulse is not a pipe stress analyzer and as such does not have the ability to directly 
model piping supports or similar objects. Hydraulic force files can be generated for 
import into software designed for force analysis.

Defining Force Sets from Analysis Setup

In order to process force data, the locations where the forces are to be calculated must be 
defined. Force Sets can be defined from the Force Definitions panel of the Forces group in Ana-
lysis Setup.
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Figure 1: Force set data is defined on the Force Definitions panel in the Analysis Setup window

 l New - Add a new force set to the table.
 l Duplicate - Copy an existing force set.
 l Delete/Delete All - Remove the selected force set / remove all force sets.
 l Swap Nodes - The calculation will be the same, but the sign of the force will be reversed. 

This may be important for proper interpretation of results or for exporting data to other 
applications.

 l Set To End Length - Automatically set the selected length field to the pipe length.
 l Import from CSV - If force sets are defined in another application or by hand they can 

easily be imported with a comma separated value file. Click the Import from CSV button 
for an explanation on the required format.

 l Generate Force Names - Automatically changes the names for the selected force sets to 
"upstream junction name - downstream junction name" using the names from the con-
nected junctions on the workspace.

 l Point Force Ambient Pressure - If using a Point force set, the ambient pressure is 
required to calculate the force balance. This defaults to the Environmental Properties 
panel value, but can be changed here.

Each individual force set has a number of required parameters:

 l Force Type - There are several force set types available. They are described in detail in 
Force Set Types.

 l Force Set Name - A unique name for the force set.
 l Start Pipe - Where the first  node is located.
 l Length To Start Node - The length from the beginning of the pipe to where the force set 

starts.
 l Start Station (Actual Length) - Because calculations must be performed at calculation 

stations (nodes), the exact length entered in the previous field may not be a valid cal-
culation point. In this case, the nearest valid node will automatically be determined and 
displayed here. Keep in mind that the actual force set is between the two "Actual 
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Length" fields, and can be different than the entered values.
 l End Pipe- The second node (for difference types). Note that the selection must be valid 

for the specified force type. See Force Set Types.
 l Length To End Node - The length from the start of the pipe to the end node.
 l End Station (Actual Length) - As described above, the nearest calculation station to the 

entered length.
 l Exit Area - For Exit force types, an exit area is required.
 l Force Unit Vector Coordinates - Define unit vectors for your linear pipe to give the res-

ulting forces a three-dimensional direction. Impulse is still only a one-dimensional fluid 
modeling software, and specifying a unit vector will not change the force calculations. 
However, by defining the XYZ vector for a given force set, that data can be brought into 
other software for further analysis using the Export Force Data tool. These unit vectors 
should be defined based on the coordinate system in the force stress analyzing software 
that the force sets will be exported to.

Defining Force Sets from the Workspace

Force Sets for individual pipes can be defined directly from the Workspace by right-clicking on a 
selected pipe. Choose the Create Force Set With Selected Pipe... option to launch the Create 
Force Set window, shown below in Figure 2. If multiple pipes are selected, an individual Dif-
ference Force Set will be created for each pipe applying the specified settings for each.

Figure 2: Create Force Set window in the Workspace

Each force has several required and optional parameters:

 l Pipe Name - If the pipe has a name entered other than 'Pipe', the user can choose 
whether to include that pipe name or not in the Force Set name. 
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 l Force Set Name - Users can add a name for the Force Set to better organize and man-
age Force Sets in the model. 

 l Force Unit Vectors or Length - Define unit vectors for your linear pipe to give the res-
ulting forces a three-dimensional direction. Impulse still only a one-dimensional fluid mod-
eling software, and specifying a unit vector will not change the force calculations. 
However, by defining the XYZ vector for a given force set, that data can be brought into 
other software for further analysis using the Export Force Data tool. These unit vectors 
should be defined based on the coordinate system in the force stress analyzing software 
that the force sets will be exported to. 

 l Show Analysis Setup Force Definitions after Creation - If checked the user will be 
brought to the Force Definitions panel of the Analysis Setup window to view all Force Set 
information defined for that scenario.

Related Topics

Force Set Types 82
Exporting Force Data 83
Force Theory 84
Warnings For Pipe Force Calculations 88

Related Blogs

Q&A: Calculating Transient Forces for Pipe Stress Analysis

Five Fantastic New Features for Fast Fluid Transients: Impulse 8

You Should Combine Your Pipes

Force Set Types
There are several types of forces that can be defined for analysis with AFT Impulse:

 l Point - Point forces are simply the difference in pressure between the fluid and the ambi-
ent environment multiplied by the pipe area, which can be used for Dead End junctions.

 l Difference - Difference forces are defined between two nodes, or computation stations. 
These nodes should be located at 90 degree direction changes. There may be one or sev-
eral junctions between the elbows so long as the flow does not branch between the nodes 
and all components are axially aligned. An example of this is the hydraulic loading 
between two elbows along the length of a pipe. See Figure 1 below.

 l Difference Exit - Similar to the difference force set in that two nodes are required. 
However, the first node must be a 90 degree elbow, and the second node must be a loc-
ation where flow exits the system. A user defined exit area will be used at the exit node for 
calculating the force across the section. This is useful for modeling forces on exit valves, 
exit orifices, and relief valves.
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Note: Pipes are assumed to be rigid bodies and AFT Impulse does not account for the effect 
of pipe deflection on forces.

Figure 1: Schematic of the Difference force type

Related Topics

Defining Forces 79
Exporting Force Data 83
Force Theory 84
Warnings For Pipe Force Calculations 88

Exporting Force Data
The transient force data can be exported by selecting the Export Force File from the File menu 
while viewing the Output window.

CAESAR II, TRIFLEX,  ROHR2, and AutoPIPE Force Files can be selected.

The time frame of interest, quantity of data points, force balance components, and units can be 
customized. Note that the units for CAESAR II files may only be set to lbf or N as these are the 
only units accepted by CAESAR II.

Note: Force Set unit vectors can only be exported to CAESAR II (v12 and higher) and 
AutoPIPE. To export any Force Sets to AutoPIPE, users must have defined force unit 
vectors for each Force Set.
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Figure 1: Exporting force results to an AutoPIPE Force File

Related Topics
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SSL in Output 659

Force Theory
The force features in AFT Impulse are intended to calculate the imbalanced hydraulic loading on 
a series of pipes rather than the total forces on those same pipes. Thus, most systems will see 
steady state forces calculated as zero. However, systems such as an exit nozzle will see a non-
zero steady state force, since there is a hydraulic force imbalance across that valve even at a 
steady flow rate. 

It is also important to keep in mind that AFT Impulse is not a tool built for the analysis of pipe 
stress. In real systems, the configuration and location of supports, the deflection of pipes and 
components, and other effects of dynamic loading should be considered. All piping and com-
ponents in AFT Impulse are considered to be completely fixed in time and space, unless directed 
to change in a specified way, such as a valve closure. The forces that can be calculated by a 
hydraulic solver such as AFT Impulse are only imbalanced hydraulic forces - not forces or 
stresses in pipe walls or supports.

Considering the above, the calculations for forces proceed under the following assumptions:
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 l All piping and components are assumed to be completely rigid. No deflections or deform-
ations are considered. 

 l The force due to gravity is neglected.
 l The volume of any junctions (bends, valves, etc.) is considered negligible. This is con-

sistent with how junctions are modeled throughout AFT Impulse. 
 l All Difference Force sets comprise a pipe or set of pipes that are axially aligned between 

the beginning or ending nodes.
 l Friction effects are modeled using the steady-state Darcy-Weisbach equation throughout 

the entire simulation. 
 l The total force acting on the piping is assumed to be equal and opposite to the forces act-

ing on the fluid.

A complementary resource to this discussion is an AFT whitepaper titled Evaluating Dynamic 
Loads in Piping Systems Caused by Waterhammer, available on our website. 

Description of Force Calculations

An example case for a difference force set can be considered for a stretch of pipe at constant 
elevation with a valve in the middle. The nodes on either end of this Force Set are a pair of 
elbows, as depicted in Figure 1 below.

Figure 1: Simple force diagram for a fluid flow in a pipe

With flow through such a pipe, there are several forces acting on the fluid, including friction, pres-
sure, gravity (which AFT Impulse neglects for force set calculations), normal forces from the pipe 
to the fluid, and forces due to redirecting the flow through the elbow’s directional changes  (i.e., 
momentum changes). Only the forces which are axially aligned with the pipe will be considered. 
The forces upstream (1) and downstream (2) are strictly related to the static pressure and flow 
area at those points.

Using Newton’s second law, the momentum changes and forces can be related, and we can 
solve for the overall reaction force, Fx. Equation 1 below shows the complete force balance used 
by AFT Impulse. 
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(1)

Note that Figure 1 does not show an area change at the valve, as shown below in Figure 2. If 
upstream and downstream pipe areas are identical, the momentum terms for the junction will 
always cancel out – in steady and transient conditions. AFT Impulse will account for this 
momentum change when it exists.

Steady State

For steady flow the velocity through a pipe is constant. Thus, the momentum terms will cancel 
out, leaving us with Equation 2 below.

(2)

The force due to friction is equal to the pressure drop due to friction multiplied by the flow area. 

(3)

In steady state, the only source of pressure drop (at constant elevation) is friction. Therefore, the 
friction and pressure terms in Equation 2 cancel out, resulting in a net force of zero at steady 
state.

(4)
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Transient Conditions

What happens when we consider the above system in a transient case? We may have a large 
pressure wave propagate through this section of pipe, perhaps due to the instantaneous closure 
of a valve somewhere downstream:

Figure 2: Simple case during a fluid transient, with a pressure wave travelling upstream

Pressure and flow in the pipe are no longer at steady state, meaning we must calculate every 
component of Equation 1. Additionally, the force due to friction varies over the force set, since 
flow is no longer constant along the length of the pipe. To accurately account for the friction 
force, we must sum the force from each section.

(5)

The entire balance is calculated for a single time step, and must be repeated for every time step 
to determine the dynamic forces on the force set.

Force Components

In some fields, it is common practice to not include all terms of the force balance in calculations.
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The simplest method is to look only at the forces due to pressure and momentum changes 
across junctions. The sum of forces in this force balance will not be zero even at steady state, as 
the friction and total momentum balance terms are not included in the calculation. 

With AFT Impulse 7 and earlier, the option to ignore the friction and overall momentum terms 
was presented to users by default. Starting with AFT Impulse 8, those options were moved into 
the Advanced Parameters panel. Since those terms are often a significant part of a complete 
force balance, and are always real forces, it is strongly recommended to always include the 
momentum and friction force balance components, as they will give more accurate results. 

Related Topics

Defining Forces 79
Force Set Types 82
Exporting Force Data 83
Warnings For Pipe Force Calculations 88

Related Blogs

Q&A: Calculating Transient Forces for Pipe Stress Analysis

Warnings For Pipe Force Calculations
Warnings regarding pipe forces may be displayed in several locations:

 l Warnings tab of the Output
 l Forces tab of the Graph Results
 l Export Force File window

Transient Cavitation Modeling

Transient pipe forces calculated in Impulse attempt to capture the hydraulic loading on a series 
of pipes caused by a pressure wave moving through those pipes. Transient cavitation can cause 
significant pressure waves in a system while also adding inherent uncertainty to the results. 
These factors combine such that transient forces calculated while cavitation is present in an 
Impulse model are also uncertain and should be treated with caution. For more information, see 
the discussion on Interpreting Cavitation Results.

Variable Density

If the density is different between pipes due to using Variable Fluid Properties, AFT Impulse can-
not accurately account for the pressure differences that affect force calculations. The magnitude 
of the error introduced by variable densities across the length of a Force Set is proportional to the 
density differences.
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Interpreting Transient Results
This section discusses how to begin understanding complex transient results. Topics included 
discuss how to use the output animation features in the Graph Results and Visual Report win-
dows, and how to interpret and troubleshoot the model when transient cavitation or artificial tran-
sients occur.

Contents

Animating Graph Results 91

Animation Layers 96

Interpreting Cavitation Results 100

Troubleshooting Artificial Transients 107

Animating Graph Results
Animating the results of a transient run is an extremely powerful way to understand how a com-
plex system is behaving. While transient plots of fluid parameters over time at a given location 
are valuable and easy to interpret, they do not directly convey the most important aspect of a 
fluid transient event - how the pressure and flow waves propagate through a system and interact 
with one another. Animating the results of a transient simulation allows you to observe these 
effects directly. Animations can also be created for Multiple Scenarios. 

Creating an Animated Graph

Since animations display information along a flow path, only Profile type graphs may be anim-
ated.

- 91 -



Interpreting Transient Results

Figure 1: Options for animation under Profile type graphs in the Graph Results window

There are two ways to animate:

 l Animate Using Output - This option uses data saved to the transient output file. This 
option requires that the data for all stations in the path of interest was saved to the output 
file. This method is generally preferable as it is faster and allows the user to advance (or 
reverse) the animation to any given point. The only disadvantage of using Output for anim-
ation is that the required output files may be large.

 l Animate Using Solver - Instead of using saved data, this option re-runs the transient 
solver to generate the required data on the fly. This has the advantage of reducing output 
file size, but the animation must be displayed step-by-step and the transient calculation 
will be slower than reading from a file. For smaller models with graphs you do not intend to 
revisit, this may be acceptable. Generally, it is easier to save the data and use Animate 
Using Output. This option is not available for Multi-Scenario graphs. 

Using an Animated Graph

Once the animated graph is created, it will look much like a normal Profile graph, but a few com-
ponents have been added. 
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Figure 2: Components added to the Graph Results window when animating a Profile graph

The animation toolbar has several controls:

 l Play - Start the animation from the current time.
 l Record - Begin playing the animation from the current step, and when the playback is 

stopped, prompt the user to save an .mp4 video recording of the animation to file.
 l Stop - Halt the animation and reset the time to zero.
 l Pause - Pause the animation at the current time.
 l Time - The actual simulation time of the currently displayed data.
 l Step - The simulation step of the currently displayed data.
 l Time/Step slider - Seek for a certain point in the animation. If Animate Using Output was 

used, points later or earlier in the simulation can be navigated to directly.
 l Speed slider - Change the speed of the playback.
 l Default - Reset the speed to default.

By default, the graph will display the current values for the time step as well as the maximum and 
minimum profiles. These can be hidden or displayed in the graph Parameter selection area, like 
any other Profile graph. The Steady-State solution can be displayed, as well as applicable 
Design Alerts.

The Current Time box can be moved anywhere within the Graph area.
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Using Animations to Interpret Behavior

There are many ways that animations are helpful in interpreting behavior. Below, we consider 
again the simple case of an instantaneous closure.

Like normal Profile graphs, multiple parameters can be displayed and animated as a single 
Graph List Item. The images below show the relationship between pressure and flow (velocity) 
for this case.

Figure 3: Animation showing steady-state (time step zero) results
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Figure 4: The instant closure of the valve halts the flow, causing a large rise in pressure

Figure 5: The movement of the wave within the pipe can be directly visualized
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Animation Layers
Animating the results of a transient run is an extremely powerful way to understand how a com-
plex system is behaving. While transient plots of fluid parameters over time at a given location 
are valuable and easy to interpret, they do not directly convey the most important aspect of a 
fluid transient event - how the pressure and flow waves propagate through a system and interact 
with one another. Animating the results of a transient simulation allows you to observe these 
effects directly.

Unlike the Graph Results Animation feature, animated color maps provide the added benefit of 
being able to observe how waves propagate through branching paths and similar situations 
which are not restricted to one continuous flow path.

Saving Output for Animation

The Animation Layers feature works by referencing the output for each computational pipe sec-
tion in the animated pipes. In order to accomplish this, data for each pipe station being animated 
must be saved to the Output File. By default, Impulse will only save the data for the inlet and out-
let pipe stations. To change this the settings will need to be adjusted to save All Stations for the 
pipes being animated by, which can be done in the Output Pipe Stations panel in the Pipe Sec-
tioning and Output group.

Note: Saving data for all stations will slow down the model run time, and may require a very 
large output file. To save time, it is recommended  to save output only for the pipes 
which will be animated.

Creating an Animation

To enable animation in the Workspace, a Color Map/Animations layer must first be created using 
Workspace Layers. The Layer Type will then need to be set to "Animation" in the Color Map/An-
imation panel in the Layer Settings window.

When Animation is selected in Layer Settings, the following Animation Settings become avail-
able.
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 l Data Type
 l Absolute Values - This option directly uses the transient values for the pipes 

being animated. Impulse will then automatically generate evenly spaced values in 
between the absolute minimum and maximum which will be displayed on the color 
scale.

 l Relative Changes - This option displays the changes in the transient results rel-
ative to the steady state values in order to animate the delta throughout the run. 
Impulse will determine the maximum and minimum changes from the steady state, 
then automatically generate evenly spaced intervals between these values to dis-
play on the color scale.

 l Maximum Values - This option does not animate the data, but instead colors the 
pipes based on the maximum values during the transient for each of the pipe sta-
tions.

 l Minimum Values - This option does not animate the data, but instead colors the 
pipes based on the minimum values during the transient for each of the pipe sta-
tions.

 l Smooth colors between pipe sections - This choice sets the color gradient on the 
Workspace to be displayed as a smooth transition, rather than an abrupt transition in 
color.

 l Borders between pipe sections - This choice displays lines on the pipes to explicitly 
delineate the sections. This can only be enabled if the smooth colors option is disabled.

 l Pipe Thickness - This option adjusts the thickness of the colored animation pipes. The 
thickness of the original pipes can be adjusted in the Pipe Properties window on the 
Optional tab.

 l Junction Size - This option allows the size of the junctions on the Workspace window to 
be adjusted for the animated model. The junctions can also be set to 0% to automatically 
hide all junctions.

 l Use Lines for Junctions - This option allows the junctions to be represented as bold 
lines instead of symbols as an alternate method of displaying the junction locations.

 l Defaults - This button allows the user to reset the animation settings to the defaults.
 l Parameter - The parameter and units for the animation can be selected
 l Auto Scale - If this box is checked, Impulse will automatically choose the maximum and 

minimum values for the selected parameter to assign the color scale for animation. This 
box is checked by default. 

Note: With Auto Scale active, minimums and maximums will be adjusted as appropriate for 
the active scenario and are not fixed to the maximum and minimum values that were 
applicable at the time of creating the layer.

 l Use Inverted Scale - This option flips the minimum and maximum values on the color 
scale so that lower values are warmer colors and higher values are cooler colors.

 l Maximum - The maximum value for the color scale can be changed here if the Auto Scale 
box is unchecked.

 l Minimum - The minimum value for the color scale can be changed here if the Auto Scale 
box is unchecked.
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 l Reset Label Locations - This resets the location of pipe and junction labels to their 
default positions.

Animation settings are specific to each individual animation layer. While only one animation layer 
can be viewed at a time, many can be present in a model and can be toggled with visibility set-
tings or via Layer Presets. Animation layers are not scenario-specific, but can be linked by Layer 
Presets to scenarios to automatically display when loading those scenarios in the same fashion 
as other layer types.

Figure 1: The Layer Settings menu for creating an animated color map

Viewing Animation

Once the Layer Settings have been configured and the animation layer is toggled to visible, sev-
eral animation-specific components will appear, including the animation toolbar as shown below.

Figure 2: Components added to the Workspace window when an animation layer is visible
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The animation toolbar has several controls:

 l Play - Start the animation from the current time.
 l Record - Begin playing the animation from the current step, and when the playback is 

stopped, prompt the user to save an .mp4 video recording of the animation to file.
 l Stop - Halt the animation and reset the time to zero.
 l Pause - Pause the animation at the current time.
 l Time - The actual simulation time of the currently displayed data.
 l Step - The simulation step of the currently displayed data.

Note: Input can be typed directly into the Time or Step text boxes to quickly navigate to a 
desired time step or to the one nearest to a desired point in time.

 l Time/Step slider - Seek for a certain point in the animation. 
 l Speed slider - Change the speed of the playback.

The Current Time box and Scale can be moved anywhere within the Graph area.

Using Animations to Interpret Behavior

There are many ways that animations are helpful in interpreting behavior. Below, we consider 
the simple case of a valve closure. Rapid closure of a valve can potentially cause water hammer. 
Visualizing pressure changes over time allows an engineer to see how pressure waves propag-
ate through a system, including where they originate, their timing and magnitude, and how they 
reflect within the system. Animation Layers communicate this information more clearly than 
graphs and numbers alone, providing additional insights.

Figure 3: Movement of the wave within the pipe can be directly visualized
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Interpreting Cavitation Results
Transient Cavitation is one of the most complex physical phenomena which AFT Impulse tries to 
model. Impulse’s solution methodology assumes that all pipes are 100% liquid-full and does not 
model two-phase flow, yet cavitation inherently violates these assumptions. As such, potentially 
significant uncertainty is inherent to results from any system which sees transient cavitation, and 
the user must carefully analyze their results to determine how reliable those results are.

Determining reliability is neither straightforward nor easy. The below discussion attempts to give 
guidance on how to best approach the problem, but finding an exact answer is almost 
impossible. As with any complex engineering task, the engineer must use good judgment to 
draw meaningful conclusions.

What can Impulse model?

Some general descriptions are provided below, with more detailed specifics discussed in later 
sections.

Impulse can model transient cavitation with moderate confidence when, combined with engin-
eering judgment, the cavitation is:

 1. of limited spatial extent
 2. of limited duration such that it is not true sustained two-phase flow
 3. of limited size volumetrically with respect to the computing sections such that the 100% 

liquid-full section assumption is only violated to a small degree

Impulse cannot reliably model transient cavitation when it is:

 1. spatially extensive
 2. long-lived and/or persistent (true two-phase flow or repeated formation and collapse of 

vapor voids)
 3. locally large volumetrically with respect to the computing sections
 4. inside system components like pumps
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Percent Vapor Volume

A first indicator of how reliable results showing transient cavitation are, is how much vapor 
volume is predicted during cavitation relative to the size of the system. Impulse’s cavitation mod-
els are meant to capture limited amounts of transient cavitation, and as the vapor volume in the 
system increases, confidence in the results decreases.

Impulse reports on Percent Vapor Volume in the Transient Max/Min tables in the Output window. 
The pipe sectioning in Impulse results in computational stations (or nodes) throughout the pipe, 
each with its own vapor volume that is fixed in place to the one-dimensional station point. The 
Percent Vapor Volume parameter divides the vapor volume at each station by the section 
volume, and is reported as a percentage. In this case, the section volume extends from halfway 
to the downstream station to halfway to the upstream station (inlet/outlet stations will only have 
half the section volume).

Various Output Messages are shown when Percent Vapor Volume exceeds certain thresholds at 
any station:

 l Caution - greater than 0.1% but less than 10%
 l Warning - greater than 10% but less than 100%
 l Critical Warning - greater than 100%

These messages are meant to convey increasing uncertainty as Percent Vapor Volume 
increases. When vapor volume is small relative to the section volume, Impulse’s 100% liquid-full 
assumption is violated, but only to a small degree, and more confidence can be placed in the res-
ults. As vapor volume increases, it grows past what either DVCM or DGCM is meant to capture, 
and confidence in the results decreases. When calculated vapor volume exceeds the physical 
section volume, reported results are unreliable because the section is 0% liquid-full, and the 
engineer must take great care when analyzing these results.
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Figure 1: While observed cavitation occurs over a given pipe volume, AFT Impulse calculates vapor 
volumes at pipe stations

Numerical Noise

A second indicator of how reliable results showing cavitation are, is if mathematical noise is 
present in the cavitation results. Both cavitation models – DVCM and DGCM – perform complex 
calculations which are sensitive to small changes in neighboring computational stations.

There are many situations in which numerical noise can be present in the results. DVCM in par-
ticular can encounter the situation where multiple adjacent pipe stations are at or near vapor 
pressure, and pressure spikes generated by the formation and collapse of vapor cavities oscil-
late between the stations. These oscillations can grow in amplitude and generate significant 
noise in the system. An example of this sort of noise is shown in Figure 2 below.
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Figure 2: Numerical noise in the static pressure results for a pipe following the collapse of a vapor 
void

When cavitation results with numerical noise are present, the engineer must attempt to see past 
the noise and find the major system trends. A key approach is by comparing results from each 
cavitation models. In many cases, DGCM will give results with less noise than DVCM. If both 
models show similar system-level trends, greater confidence can be assigned to the results 
without noise.

DGCM generally produces less noise than DVCM, but in some situations, DGCM can also see 
results with numerical noise, particularly when complex junctions such as relief valves or pumps 
with four quadrant curves are used. Results from each cavitation model should still be compared 
to evaluate what the true system response is.

Other Confidence Indicators

Numerous other indicators to help the engineer assign confidence to cavitation results exist. Dis-
cussing all of them is not practical, so several further indicators are described here.

 1. Using DVCM vs. DGCM
Comparing results using DVCM and DGCM gives two independent sets of results to com-
pare. If both cavitation models give similar results, higher confidence can be assigned to 
those results. If each model gives different results, they should be treated with lower con-
fidence.

 2. Sectioning
The sectioning scheme used for a model impacts the assumption used for both DVCM 
and DGCM that the vapor volume is negligible compared to the liquid volume in each sec-
tion. Increasing the section count means there will be more computational stations within 
the same length of pipe. Therefore, as section count increases, the distance between 
each station decreases, and the corresponding section volume decreases. The same 
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vapor volume within a smaller section volume will represent a larger percentage of said 
pipe section, and affects the validity of the 100% liquid-full assumption applied by the fun-
damental equations between each computational station. If results are stable as section 
count is changed, higher confidence can be assigned to those results. If results are not 
stable as section count is changed, it indicates the assumptions behind Impulse and its 
cavitation models may be violated, and the results should be treated with lower con-
fidence.

 3. Vapor Void Formation and Collapse
Vapor void formation and collapse in a real system must behave realistically. The vapor 
voids must form and collapse in a continuous motion based on the presence of low-pres-
sure waves. Multiple bubbles are likely to form, but if those bubbles are captured by a dis-
crete model (like both DGCM and DVCM are), the model should show a single vapor void 
forming and collapsing rather than numerous voids with very short time spans.
If results show behavior consistent with expected physical behavior, higher confidence 
can be assigned to those results. If results show excessive noise or chaotic behavior, it 
indicates the cavitation model may not be giving a good representation of real results. Fig-
ures 3a and 3b below compare results which show behavior that is likely to be physically 
realistic compared to behavior that is likely to be numerical noise.

Figure 3a: Cavitation results showing smooth vapor void formation and collapse, adding con-
fidence to the results
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Figure 3b: Cavitation results showing noisy vapor void formation and collapse, limiting con-
fidence in the results

 4. Disabling Cavitation Modeling
The uncertainty inherent to cavitation modeling can make it difficult to determine the 
shape and magnitude of a low-pressure wave which causes cavitation. Disabling cavit-
ation modeling in Impulse can allow the engineer to better see the low-pressure wave in 
their system to determine the extent to which it is likely to cause cavitation and to determ-
ine if a subsequent high-pressure wave will form and violently collapse the vapor void.
Note that this step is only meant for troubleshooting purposes. AFT always recommends 
that cavitation modeling is enabled for transient simulations as all liquids have a vapor 
pressure and can experience cavitation.

Transient Forces

The transient forces calculated in AFT Impulse are intended to capture the imbalanced hydraulic 
loading on a series of pipes caused by a pressure wave moving through those pipes. In order to 
have confidence in the transient force results, we must also have confidence in the simulation’s 
pressure results.

Transient cavitation in a system inherently introduces uncertainty to the results. Specifically, it 
introduces uncertainty regarding the shape and timing of the pressure waves in the system. The 
magnitude of the transient forces calculated by Impulse is highly dependent on the shape and 
timing of those pressure waves, meaning that transient force results can have significant uncer-
tainty when cavitation is present in a simulation. A Warning message is presented in the Output 
to alert users of this uncertainty.

Engineers attempting to use transient force results for further analysis (e.g.: pipe stress analysis) 
when cavitation is present must carefully examine the cavitation results in their system to determ-
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ine the level of confidence they can place in those results. The engineer should then apply a con-
servative safety factor to the transient force results before performing further analysis.

Detailed Decision Tree

Interpreting transient cavitation results is complex and rarely straightforward given that each sys-
tem is unique and reacts to low pressures differently. The above discussion reflects that com-
plexity by numerous approaches the engineer can take.

Two papers published at the 2018 ASME Pressure Vessels and Piping Conference attempt to 
give a more rigorous decision tree to help guide the engineer as they work to evaluate cavitation 
results in their system and apply safety factors within the context of ASME B31.3 code. The full 
papers are too lengthy to include here, but a summary is presented below. Full versions of each 
paper are available on our website.

 

Cavitation Classifications

Simulation results with cavitation can be broken into four categories based on the extent of cavit-
ation:

 1. None - No cavitation present in the system
 2. Limited - Maximum vapor volume percent less than 10%
 3. Major - Maximum vapor volume percent between 10% and 100%
 4. Extreme - Maximum vapor volume percent greater than 100%

The Limited and Major categories are broken into further categories based on where cavitation 
occurs and the confidence assigned to the results.

 

Safety Factors for Pressure Results

Four levels of safety factors can be applied to maximum pressure results based on the extent of 
cavitation. These safety factors are used when the engineer is working to ensure the system 
pressures never exceed the rated pipe pressures.

 1. Small - 1.25:1 - Used when no cavitation is present
 2. Moderate - 1.5:1 - Used when limited cavitation is present and the engineer has higher 

confidence in the cavitation results
 3. Large - 2:1 - Used when major cavitation is present or when limited cavitation is present, 

but the engineer has low confidence in the cavitation results
 4. Very Large - 3:1 - Used when extreme cavitation is present, and the system cannot be 

mitigated to avoid cavitation

 

Safety Factors for Force Results

Three levels of safety factors can be applied to transient force results based on the extent of 
cavitation. These safety factors are used when the engineer is reporting transient force results 
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for further pipe stress analysis. The recommended safety factors for force results are generally 
higher than those recommended for pressure results given the greater uncertainty.

 1. Small - 1.25:1 - Used when no cavitation is present
 2. Large - 2:1 - Used when limited cavitation is present and the engineer has higher con-

fidence in the cavitation results
 3. Very Large - 3:1 - Used when major cavitation is present or when limited cavitation is 

present, but the engineer has low confidence in the cavitation results

Related Topics

Animating Graph Results 91
Animation Layers 96
Troubleshooting Artificial Transients 107
Cavitation 69
Transient Cavitation Panel 193
Transient Cavitation Models 707

Troubleshooting Artificial Transients
It is relatively clear how an Artificial Transient is detected, but diagnosing its source and fixing the 
problem can be much more complicated. The tools provided by AFT Impulse can help point you 
in the right direction. If the methods below are insufficient, contact the AFT Support Team with 
your model file for further analysis.

Ensure Stability of the Steady-State Results

As with any Impulse simulation, the scenario should first be run in steady-state by selecting the 
Steady Only option on the Simulation Mode/Duration panel of Analysis Setup. The steady-state 
results are used to initialize the transient simulation; therefore, it is important that the steady-
state simulation is running as expected. Any Output Messages (Critical Warnings, Warnings, or 
Cautions) or other convergence issues should be addressed prior to running the transient sim-
ulation.

Many Artificial Transients can be resolved by resetting the Steady Solution Control Tol-
erances to the Impulse defaults, or tightening both the Pressure and Flow Rate relative 
tolerances to 1E-6 or 1E-7.

Create a Troubleshooting Child Scenario

It is recommended to create a child scenario for troubleshooting purposes. Once the root cause 
and mitigation strategy of the Artificial Transient is determined, the child scenario can be deleted 
and the modifications can be re-applied to the original parent scenario.
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By default, Impulse will halt the transient solver if an Artificial Transient is detected. We will over-
ride this behavior and allow the transient solver to continue. The following settings are useful for 
the troubleshooting scenario:

 1. Disable the "Stop Run if Artificial Transient Detected" setting on the Artificial Tran-
sient Detection panel under the Miscellaneous group of Analysis Setup. This will allow the 
transient simulation to proceed despite the Artificial Transient being present.

 2. Disable all user-defined transients in the model. To properly understand the Artificial 
Transient, it is critical that all other user-defined transients in the model are disabled (i.e., 
valve closures, pump trips, etc). This can be achieved by opening the Properties window 
of each applicable junction, going to the Transient tab, and selecting the Ignore Transient 
Data option. Once all transients have been disabled, the Transient Data tab in the Junc-
tions section of the Model Data will report "Transient Special Condition set - transient data 
will be ignored" for each junction.

 3. Save transient output data for all pipe stations by opening the Output Pipe Stations 
panel under the Pipe Sectioning and Output group of Analysis Setup, select all pipes by 
clicking the All button, and click Change Selected Pipes To All Stations. This is required 
for making Animated Profile Graphs that visualize the Artificial Transient moving through 
the pipes. For large models, you can choose to only save all stations for the pipes that 
were listed in the Critical Warning messages, and perhaps several surrounding pipes to 
minimize the run time.

 4. Decrease the Stop Time to 0.2 seconds on the Simulation Mode/Duration panel under 
the Transient Control group of Analysis Setup. An Artificial Transient is an effect strictly 
related to the beginning of the simulation when the model switches from the steady-state 
to the transient solution methodology. When troubleshooting, it is not necessary or 
advised to run a long simulation. Shorten the Simulation Duration as much as possible to 
make running the model quick. In many cases only a handful of time steps are needed. 
The value of 0.2 seconds is arbitrary, but provides a balance of fast run time while still 
providing enough time steps to graph effectively for many models.

 5. Save all output time steps by ensuring that the Save Output To File setting is set to the 
"Every Time Step" option on the Simulation Mode/Duration panel. This is required for mak-
ing graphs that accurately depict the maximum and minimum magnitudes of the Artificial 
Transient.

Once the above modifications have been made, run the transient simulation which should now 
proceed past the Artificial Transient detection.

Look at the Output Messages

The Warnings tab may give information on the Artificial Transient(s). In Figure 1, we can see that 
the pressure is inconsistent at the exit of Pipes P1 and P2, and inconsistent at the inlet of Pipe 
P3. These 3 pipes connect to a branch junction. With this information alone, it may be possible to 
determine and solve the issue. The model inputs for any listed pipes and junctions should be 
reviewed.

In this case, the steady-state Tolerances were loosened from the default values, and the Solver 
was reporting about 1% error in the flow splits around this branch junction. Even though the 
steady-state solution was converging without errors, the tolerances were not tight enough for the 
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transient solution methodology. The solution in this case was to revert the relative tolerances for 
both Pressure and Flow Rate to the default Impulse values of 1E-5.

Figure 1: Artificial Transient Critical Warnings

Observe the Artificial Transients with Graph Animations

If the Output Messages do not provide enough information, then the most powerful tool for ana-
lysis of an Artificial Transient is the Animation of a Profile Graph. By animating the behavior it can 
be made clear where the event originates, as well as what kind of impact it has on the system. It 
is best to start by making graphs using the pipes listed in the Critical Warnings. It may also be 
useful to graph pipes near pumps, tees, branches, and control valves since there is often com-
plex behavior occurring at these locations.

Again, user transients should be disabled which means the simulation should remain at 
a constant steady-state throughout the transient simulation. This makes it easy to look for 
any deviations from the constant steady-state which will indicate an Artificial Transient. An imme-
diate red flag is if the Max/Min envelopes of the graph are different.
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Figure 2: A profile graph showing time step zero, representing the initial steady-state solution

Advancing the animation just one time step shows a change in the pressure and flow profile:
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Figure 3: The same profile graph showing the Artificial Transient on the first time step

In this case, the solution was to reset the Steady Solution Control Tolerances back to the 
Impulse default values.

Determine the Root Cause

In some cases the error percentages listed in the Critical Warnings may be negligible, or the mag-
nitudes of flow deviation from the steady-state in the Profile Graph Animations may be accept-
able. In these cases the "Ignore Flows Less Than" setting can be adjusted on the Artificial 
Transient Detection panel under the Miscellaneous group of Analysis Setup. Though it should be 
noted that any error amount will impact the transient results, and some effort should be put into 
resolving the Artificial Transient without modifying this setting if possible.

In many other cases the Artificial Transient will not be negligible.  In these cases the root cause of 
the Artificial Transient must be determined. This is often the most difficult step as there is no one 
potential cause. The best approach is to consider the Profile Graph Animation results as well as 
the engineering assumptions made by AFT Impulse and the various junctions. Check the input 
data for any connected pipes and junctions. Below are some example resolutions that our Sup-
port Team has seen:

 l Reset the Steady Solution Control Tolerances to the Impulse defaults
 l Tighten the Steady Solution Control Tolerances for both Pressure and Flow Rate to 1E-6 

or 1E-7
 l Resolve typos in the input data such as extra zeros or incorrect unit selections
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 l Select a different Four Quadrant Data Set which is better suited for the pump(s) used in 
the model

 l Switch the Tee/Wye Loss Model to Simple

Note: Do not forget to re-enable the "Stop Run if Artificial Transient Detected" setting once 
the troubleshooting is complete!

Related Topics

Artificial Transient Detection Panel 207
Artificial Transient - Initial pressure/flow conditions at Pipe X Station Y are not 
steady (Error = Z%) 748
Animating Graph Results 91
Animation Layers 96
Interpreting Cavitation Results 100

Related Blogs
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Fundamental Modeling Concepts
This section focuses on the critical concepts and theories that comprise the model building pro-
cess in AFT Impulse. Topics include discussions on the role of pipe and junction objects, descrip-
tions of how boundary conditions and flow direction are specified, and instructions on how to 
model closed systems.
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Features for Modeling Irrecoverable Losses 114

Reference Positive Flow Direction 115

Philosophy of Computer Modeling 116

Role of Pressure Junctions and How They Work 117

Open vs. Closed Systems 120

Curve Fitting 123

Stagnation vs. Static Pressure Boundaries 125

Pipes and Junctions
AFT Impulse employs two fundamental pipe system constructs: pipes and junctions. 

Pipes are conduits for one-dimensional liquid flow. Pressure drop due to friction occurs in pipes.

Junctions are connector points for pipes and are elements at which flow balances are made and 
where transients are initiated. Some junction types can only connect to one pipe; others can con-
nect with up to twenty-five.

In addition to balancing flow, junctions also influence the flow or pressure behavior of the sys-
tem. For example, a reservoir junction applies a constant pressure at a location, and the flow 
there is free to adjust in whatever manner is consistent with the governing equations. In contrast, 
an assigned flow junction applies a known flow rate at its location, allowing the pressure to adjust 
to that level dictated by the governing equations. The various junction types allow you to specify 
special kinds of transient behavior, irrecoverable pressure losses or fluid behavior. 

Junctions communicate with each other through the pipes connecting them. Each pipe must be 
connected to two junctions. There are no exceptions to this rule. 

A pipe differs from a junction in that it has a reference positive flow direction. To say a pipe has a 
flow rate of 1 lbm/sec is meaningless unless the flow direction is specified.

- 113 -



Fundamental Modeling Concepts

In general, you do not need to specify the actual flow direction in a pipe, because AFT Impulse 
sorts out the true physical flow directions of the system you define. For example, if you specify 
the reference positive flow direction from left to right, and the solution is in fact the opposite dir-
ection, then that information will be presented in the output as a negative flow rate. Inlet and out-
let conditions correspond to the reference positive flow direction, not the actual flow direction. 
However, for easier analysis of results, it can be helpful to ensure all pipes are configured so that 
they have positive flow in the steady state system. 

It is important to specify the proper flow direction for pipes which connect to junctions such as 
pumps or control valves. AFT Impulse uses the flow direction of the pipes to determine in which 
direction to increase or reduce pressure.

Related Topics

Features for Modeling Irrecoverable Losses 114
Reference Positive Flow Direction 115
Philosophy of Computer Modeling 116
Role of Pressure Junctions and How They Work 117
Open vs. Closed Systems 120
Curve Fitting 123
Stagnation vs. Static Pressure Boundaries 125

Features for Modeling Irrecoverable Losses
AFT Impulse works almost exclusively with the concept of the loss factor, also known as K factor 
or resistance factor. In some Properties windows, other popular methods for specifying loss 
information are provided where they are consistent with the loss factor method. For example, 
you will find Cv (flow coefficients) for valves. No provision has been made for the equivalent 
length approach to solving pressure drop problems. See the Junction Loss Models section for 
more information.

Related Topics

Pipes and Junctions 113
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Philosophy of Computer Modeling 116
Role of Pressure Junctions and How They Work 117
Open vs. Closed Systems 120
Curve Fitting 123
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Conventions for Specifying Basis Area 275
Pressure Drop in Pipes - Detailed Discussion 261
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Reference Positive Flow Direction

Reference Positive Flow Direction

Next to each pipe's ID number is an arrow that indicates the reference positive flow direction for 
the pipe. AFT Fathom assigns a flow direction corresponding to the direction in which the pipe is 
drawn. You can reverse the reference positive flow direction by choosing Reverse Direction from 
the Arrange menu or selecting the reverse direction button on the Toolbar. With exception to 
some junctions, the reference positive flow direction is used for reference purposes only and 
does not need to correspond with the real direction of flow calculated by the Solver (the part of 
AFT Impulse that applies the governing incompressible flow equations to obtain a solution to the 
pipe system). If the flow direction obtained by the Solver is opposite of the reference positive flow 
direction, then the output will show the flow rate as a negative number.

Note: The reference positive flow direction is important for pumps because the pipe directions 
will define which side is suction vs discharge. Furthermore, reverse flow through com-
ponents may result in a Caution message which may or may not be valid depending on 
the intended direction of flow.

Convention for Flow Entering and Exiting

Many of the junction types permit fluid flow to come into or pass out of the system in a prescribed 
manner. The most obvious of these is the Reservoir junction. Reservoirs maintain a constant 
pressure at a node, and the flow adjusts according to the governing equations. While in principle 
the fluid is stored or removed from the reservoir, AFT Impulse considers the fluid as coming into 
or going out of the system. The stored reservoir fluid is not part of the system.

The convention for defining inward or outward flow for the system or any AFT Impulse object is 
that flow in is positive (that is, the object/system gains the flow) and flow out is negative (the 
object/system loses the flow).

Related Topics

Pipes and Junctions 113
Features for Modeling Irrecoverable Losses 114
Philosophy of Computer Modeling 116
Role of Pressure Junctions and How They Work 117
Open vs. Closed Systems 120
Curve Fitting 123
Stagnation vs. Static Pressure Boundaries 125

- 115 -



Fundamental Modeling Concepts

Philosophy of Computer Modeling
Some might say that a "good" computer model is one that accurately predicts the response of a 
system; but this is only partly true. The practicing engineer generally must weigh the accuracy of 
the model against the risk, schedule, and/or budget involved. Through experience an engineer 
learns where to focus resources and when an answer is good enough to base important 
decisions on.

Although AFT Impulse is designed to speed up the modeling process, it should never be used as 
a "black box". Your model input and output should always be carefully reviewed.

To make the most effective use of AFT Impulse, you should follow these guidelines:

 l Be aware of what AFT Impulse can and cannot do and the assumptions it makes.
 l Learn and use the tools in AFT Impulse that are appropriate for the specific analysis you 

want to perform. Detailed and accurate answers demand detailed and accurate input. 
Quick and dirty answers require less detailed input.

 l Learn and use the tools in AFT Impulse that allow you to process information in the 
formats that mean the most to you. Because pipe flow applications vary so much within dif-
ferent industries, AFT Impulse is customizable for the way you want to do your pipe flow 
work. Understanding the tools will help you gain greater conceptual control over your pipe 
flow analyses and reduce modeling errors.

 l Check your input data. Use the features available in AFT Impulse to review your results 
for input errors. Pay attention to the information in the output report. Don't neglect warn-
ings in the output. Perform hand analysis checks of results.

 l Bound your problem. Instead of trying to calculate the exact resistance in a network, or 
the right loss factor for an orifice, use your judgment, guided by data, on how much vari-
ation might occur. By running your model at the upper and lower limits, you can obtain 
answers, for example, on the maximum and minimum possible pressure drops in the sys-
tem. If the results at the maximum and minimum are acceptable, your analysis is probably 
finished. If they are not acceptable, you can further refine the input model.

 l Recognize whether your problem is one of maximization or minimization. That is, recog-
nize whether the design goal is to minimize the flow rate, for example, or maximize the 
flow rate. Then make your assumptions conservative enough to provide high confidence 
that your design requirements are being satisfied.
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Role of Pressure Junctions and How They Work

Role of Pressure Junctions

In modeling a generalized pipe network, it is possible to construct models that do not have a 
unique solution. A common occurrence of this is when a model contains one or more sections 
which are completely bounded by known flow rates. The simplest example is the system shown 
in Figure 1. In AFT Impulse terms, the system has two assigned flow junctions.

Figure 1: Model with two assigned flows. This model does not have a unique solution

Obviously, the flow in the pipe is known. But what is the pressure at the inlet? At the outlet? It can-
not be determined because there is no reference pressure. The reference pressure is that pres-
sure from which other pressures in the system are derived. There can be more than one 
reference pressure, but there always has to be at least one.

The model in Figure 1 can be built with AFT Impulse and if you try and run this model, AFT 
Impulse will inform you that it cannot run it because of the lack of a reference pressure (Figure 2). 
In AFT Impulse there are several junctions that can act as a reference pressure including the 
reservoir, assigned pressure, valve (with the exit valve option), spray discharge, and pressure 
control valves.

When you try and run a model that has one or more sections completely bounded by known 
flows (or Flow Control Valves or Pumps operating in assigned flow mode), the Need Reference 
Pressure window (shown below) is displayed. This window informs you which junctions bound 
the sections where a reference pressure is needed to obtain a unique solution.

In multi-pipe systems there are a host of other possibilities that present themselves. All other con-
figuration possibilities which lack a reference pressure ultimately boil down to the same problem 
that exists in Figure 1.

See Role of Pressure Junctions - Detailed Discussion (Long) for more information.
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Figure 2: AFT Impulse message when you try to run a model without sufficient reference pressures

How Pressure Junctions Work

Pressure junctions (e.g., Reservoirs or Assigned Pressures) in AFT Impulse are an infinite 
source or sink of fluid. This means that they can draw or discharge as much fluid as is necessary 
to maintain the specified pressure. Some engineers have difficulty grasping this concept, and 
misuse pressure junctions in AFT Impulse. This section offers a physical example of how pres-
sure junctions work to clarify for those having difficulty with the concept.

Consider the physical pumping system shown in Figure 3. This system pumps water from Lake 
Ontario to Lake Huron. 

Figure 3: Physical pumping system to transfer water from shoreline supply tank (J1) to discharge 
tank (J2) at top of hill

An engineer is tasked with sizing the pump for this system. The engineer has an idea of the dis-
charge head needed for the pump, and so builds an AFT Impulse model as shown in Figure 4. 
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The Figure 4 model is attempting to represent the physical system in Figure 3, but it in fact rep-
resents the physical system in Figure 5.

Figure 4: Model to size pump attempting to represent system in Figure 3. It does not accurately rep-
resent Figure 3.

Figure 5: Physical system represented by model in Figure 4.

Why? Because the reservoir junction (J3), which is an infinite source of fluid, has been located 
between the pump (J2) and Lake Huron (J4). The J3 reservoir isolates Lake Ontario and the 
pump (J1 and J2) from Lake Huron (J4). The J3 reservoir is very much like placing Lake Erie 
between the supply and discharge piping. 

If the engineer changes the surface elevation in J3, it is like changing the surface elevation of 
Lake Erie. It will change the flow rate in the pipes, but no matter how high the water level of Lake 
Erie, it does not change the fact that the pumping system is isolated from Lake Huron. The flow 
rate in the piping from J4 to J3 is entirely dependent on the difference in surface elevations 
between J3 and J4, and is not influenced by the J2 pump in any way.

How then should the physical system in Figure 3 be modeled? It should be modeled as shown in 
Figure 6.
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Figure 6: Proper model of physical system shown in Figure 3.

If the goal is to size the pump at J2, the model in Figure 6 can be used with the pump modeled as 
a fixed flow pump.
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Related Blogs

Reference Pressure Needed: Where It Comes from and How to Address it

Open vs. Closed Systems

Model a Closed Loop System

A closed circulating system can easily be modeled with AFT Impulse by locating a Reservoir 
junction anywhere in the system and setting the pressure to the known pressure at that point. 
Inflow and outflow pipes will then need to be connected. The Reservoir junction merely acts as a 
reference pressure against which all other pressures in the system are compared. Because 
there are no other inlets or outlets to the system, then whatever is delivered by the Reservoir 
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junction to the system will also be received from the other pipes, thus achieving a net zero out-
flow rate for the system.

Balancing Mass

In order to model a closed system, only one pressure junction is used in the model. Typically this 
would be either a Reservoir or Assigned Pressure. Pressure type junctions are an infinite source 
of fluid and do not balance flow. How then can one be used to balance flow in a closed system? 

To answer this question, it is worth considering how AFT Impulse views a closed system model. 
AFT Impulse does not directly model closed systems, and in fact does not even realize a closed 
system is being modeled.

Consider the system shown in Figure 1. This is an open system. Fluid is taken from J1 and 
delivered to J4 and J5. Because AFT Impulse’s Steady-State solution engine solves for a mass 
balance in the system, all flow out of J1 must be delivered to J4 and J5. Because the flow is 
steady-state, no fluid can be stored in the system; what goes in must go out.

Figure 1: Open system - Flow out of J1 equals the sum of J4 and J5

Now consider the systems in Figure 2. The first system appears to be closed, while the second 
appears to be open. If the same boundary condition (i.e., surface elevation and pressure) is used 
for J1, J11 and J12 in the second system, to AFT Impulse it will appear as an identical system to 
the first system. The reason is that AFT Impulse takes the first system and applies the J1 reser-
voir pressure as a boundary condition to pipes P4, P9 and P10. The second system uses three 
reservoirs to apply boundary conditions to P4, P9 and P10. But if the reservoirs all have the 
same elevation and pressure, the boundary conditions are the same as J1 in the first system. 
Thus the same boundary condition is used for P4, P9 and P10 in both models, and they appear 
identical to AFT Impulse.

But how is the flow balanced at J1 in the first system? Looking at the first system, one sees that 
to obtain a system balance, whatever flows into P10 must come back through P4 and P9. 
Because there is overall system balance by the solver, it will give the appearance of a balanced 
flow at the pressure junction J1. If there is only one boundary (i.e., junction) where flow can enter 
or leave the pipe system, then no flow will enter or leave because there isn’t anywhere for it to 
go. Thus the net flow rate will be zero at J1 (i.e., it will be balanced). But recognize that AFT 
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Impulse is not applying a mass balance to J1 directly. It is merely the result of an overall system 
balance.  

Figure 2: The first system is closed, and the second open. In both systems the flow into P10 is the 
same as sum of P4 and P9. If the second system has the same conditions at J1, J11 and J12, the two 

system will appear identical to AFT Impulse.
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Curve Fitting
There are many places within the interface where the user may be asked to define how a prop-
erty changes in relation to another. Some examples include:

 l Pump Curves
 l Junction Resistance Curves
 l Custom Fluids
 l Pipe Physical Properties

These properties are entered in a tabular format, relating a particular property to one or several 
others. For example, see the below definition of a custom fluid:

Figure 1: Custom Fluid Definition

There are several parameters that control the behavior of the fluid and they are entered as they 
relate to temperature.

However, it is important to recognize that these values in particular are not directly used in the 
solution. Instead, the data is used to create a best-fit curve. This curve is then used in the solu-
tion process. This is an important step to take because there must be a continuous relationship 
between the independent variable (e.g. temperature) and the dependent variable (e.g. density). 
Even if the final solution was close to one of the defined points, the Solver needs continuous data 
to proceed.

There are some options for how the data is curve fit. First, there are two Curve Fit Types:
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 l Polynomial - The data is best fit to a polynomial of order 0,1,2,3, or 4. Note that a 0th 
order polynomial is a constant value, and a 1st order is a linear fit.

 l Interpolated X-Y Data - The data has a linear interpolation drawn between every data 
point.

One of the critical items to note with any curve fit is that you may not be operating close to one of 
your defined points if the data does not conform well to a polynomial relationship. For example, 
the above fluid has a rapidly decaying viscosity that does not follow a polynomial relationship. Fit-
ting the data to the standard 2nd order polynomial results in the following:

Figure 2: Using a Polynomial Curve Fit on Non-Polynomial Data

The viscosity relationship in the model will use the blue curve, and not the user-defined black 
points. Depending on the operating range of the system, this may significantly impact the results! 
For this data in particular, using the Interpolated X-Y Data option may be a better choice.

After data has been curve fit, the constants for the resulting curve are displayed in the lower-right 
of the associated window.
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Stagnation vs. Static Pressure Boundaries
With two exceptions (to be discussed), all pressure-type boundary conditions in AFT Impulse are 
stagnation. This works very well for things such as storage tanks, cooling ponds, lakes, etc., 
where the volume associated with a pressure is large and will not change (significantly) with 
time. These boundaries have no velocity associated with them, and using stagnation pressure is 
thus appropriate. These boundary conditions are most clearly rendered in AFT Impulse by use of 
a Reservoir junction. 

Consider the reservoir and connected pipe in Figure 1. When the liquid in a reservoir flows into 
connecting pipes, the static pressure immediately drops due to the increase in velocity.

It is tempting to say that because there is no velocity in the reservoir, then it does not matter 
whether the reservoir boundary pressure is considered as a static or stagnation pressure 
because they are equal. This is a misconception. The pressure boundary condition in an AFT 
Impulse model is applied at the exit of the reservoir, not within the reservoir itself. Inside the 
reservoir, the static and stagnation pressures are the same, but they are not the same at the exit 
- they differ by the amount of the dynamic pressure.

    
Figure 1: Pressure profile along horizontal pipe shown

The appropriateness of either stagnation or static pressure as a boundary condition depends on 
whether there is a velocity associated with the pressure that is specified. Is the pressure in a ves-
sel or large (lower velocity) header, or is it in a pipe somewhere in the middle of a system? If the 
first, stagnation is more appropriate; if the second, static.

Pressure boundary conditions with no velocity are more common across all piping industries, 
and are usually appropriate. However, this is not always the case.

When to use Static Pressure 

Now let's consider the application of a true static pressure boundary condition. A static boundary 
condition has a unique velocity associated with it. The Bernoulli equation, which in this integrated 
form applies only to incompressible flow, is given by:
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From this equation it is clear that application of the static pressure is not sufficient to specify loc-
ation 1. The velocity and elevation is also required.

In AFT Impulse, elevation data is entered for junctions. The pipes adopt the elevation of the junc-
tion to which they are connected.

But where does the velocity information for the Bernoulli equation come from? One might 
respond that it can be obtained from the flow rate. But this raises another question: what if the 
flow rate isn't known? Put another way, what if the flow rate is what we are solving for?

When the user supplies a stagnation pressure boundary condition, AFT Impulse can use Equation 6
 in the Network Solution Methodology topic. Here, no velocity information is required. A stag-
nation pressure boundary can thus be supplied to multiple pipes that might have different velo-
cities. That is why the same reservoir junction can connect with multiple pipes.

However, if the user specifies a static pressure as the boundary condition, to apply Equation 4 in 
the Network Solution Methodology topic, a unique velocity must be supplied. Thus, it is only pos-
sible to connect a static pressure to a single pipe with a unique velocity.

Important: A static pressure boundary has a unique velocity associated with it, and can thus 
connect to only one pipe.

Where would one find a static pressure boundary? The best example is when the boundary con-
dition is inside a pipe. A pipe system model can start and end anywhere it is convenient for the 
user. It may be convenient to not start the model at the physical boundary (such as a tank) but at 
a particular location in the pipe system. This could be, for example, at the location of a pressure 
measurement. Or it could be at the boundary of the pipe system for which your company is 
responsible, with another company responsible for what is on the other side of that boundary.

If one needs to model such a situation, the Assigned Pressure junction allows one to model 
either a static or stagnation pressure. The default stagnation pressure allows connection of up to 
25 pipes. If static pressure is chosen, only one connecting pipe is allowed.

Static Pressure at Pressure Control Valves

Another example of static pressure is at pressure control valves. For pressure control valves 
(i.e.,  PRV’s and PSV’s) the default control pressure is static pressure. The reason is that the 
measured pressure that provides feedback to the controller will typically be a static pressure 
measurement. You have the option of modeling pressure control valves as either static or stag-
nation pressure.

Related Topics

Pipes and Junctions 113
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Features for Modeling Irrecoverable Losses 114
Reference Positive Flow Direction 115
Philosophy of Computer Modeling 116
Role of Pressure Junctions and How They Work 117
Open vs. Closed Systems 120
Curve Fitting 123
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Analysis Setup Overview
Analysis Setup contains all of the settings which the user must define to run the model, including 
fluid properties, pipe and junction status, pipe sectioning, transient controls, force definitions, 
environmental properties, and other related options. Launch Analysis Setup from either the tool-
bar or the Analysis menu.

The controls in Analysis Setup are divided into different groups in the navigation pane on the left 
of the window (Figure 1). Each group has one or multiple items. Clicking on an item opens the 
panel for that item. 

A group is not fully defined until each item in that group is defined. Each group will have either a 
green check mark, indicating that all required items have been defined, or a red exclamation 
point, indicating that some or all of the required inputs are missing. Note that some groups will 
have a green checkmark by default, indicating that the required inputs have default settings 
already applied, or all inputs for that group are optional. Groups that are undefined will change to 
a green check mark when the required inputs for that group are entered, and the user navigates 
to a different panel. Note that none of the changes will be applied to the model until OK is selec-
ted. Clicking Cancel will discard all changes made in the window.

The groups in Analysis Setup are

 l Modules group
 l Fluid Properties group
 l Pipes and Junctions group
 l Pipe Sectioning and Output group
 l Transient Control group
 l Pulsation Setup group - (PFA Module only)
 l Forces group
 l Steady Solution Control group
 l Environmental Properties group
 l Miscellaneous group
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Figure 1: Default state of Analysis Setup in a blank model

Modules Group
AFT Impulse has two optional add-on modules which extend its modeling capabilities into other 
areas. The modules allow pulsation frequency and settling slurry modeling. The Modules panel 
withing the Modules group in Analysis Setup allows you to activate and enable either of the 
AFT Impulse add-on modules. An additional license to the base AFT Impulse license is required 
to use a module. These modules include:

 l PFA (Pulsation Frequency Analysis) - Helps identify and avoid resonant frequencies in 
systems, especially in those caused by positive displacement pumps.

 l SSL (Settling Slurries) - Models the effects of pumping fluids containing settling solids 
using the Wilson/GIW method.

Related Topics

Modules Panel 129
Add-on Modules 631

Modules Panel
The Modules Panel allows users to activate and enable the optional add-on modules and/or cost 
calculations. 

Activating a module checks out a license seat for the module.

Enabling a module turns on all functionality for the module. By default activating a module will 
also automatically enable the module for use. Disabling a module keeps the license seat 
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checked out but the module calculations are not applied to the model. Disabling a module may 
be desired for various reasons, as is discussed further for each module below.

Note:  A module specific license is required to activate the PFA or SSL add-on module. 

Figure 1: The default state of the Modules panel

PFA (Pulsation Frequency Analysis)

Activate the Pulsation Frequency Analysis (PFA)module by checking the box next to Activate 
PFA. Once activated,  enable it by selecting Use or disable it by selecting Ignore.  When the PFA 
module is activated, the Pulsation Setup group appears in the Analysis Setup. The Pulsation 
Setup group has two items: Pulse Setup and PD Pump Settings.

The PFA module can be enabled before or after a model is built. Pre-existing models built with 
the base AFT Impulse application  can have the PFA module activated.

Setting the PFA module to Ignore causes the PFA module to function like the base AFT Impulse 
application. One difference is that users are still able to enter pulsation data and it be retained in 
the model. If a model with PFA input is opened in the base AFT Impulse application that cannot 
access a license to PFA, this data will be lost. Table 1 relates the differences  between using 
AFT Impulse without the PFA module activated, using it with the PFA module activated but dis-
abled (Ignore mode), and using it with the PFA module activated and enabled. 

The PFA module  can also be toggled between Use and Ignore from the Analysis menu in the 
Pulsation Frequency Analysis option as shown in Figure 2. Use this feature to quickly toggle the 
PFA module between Use and Ignore without opening the Modules panel in Analysis Setup. 
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Table 1: AFT Impulse feature accessibility based on PFA activation and enablement

Feature PFA Not 
Activated

PFA Activated

PFA Dis-
abled PFA Enabled

Pulsation 
Setup group 
in Analysis 

Setup

Not Visible Visible Visible

Pulsation Fre-
quency Ana-

lysis in 
Analysis 

menu

Not Visible Visible Visible

Pulsation 
Setup 

in Analysis 
menu

Not Visible Visible Visible

Steady-State 
Pulsation Tol-
erance on Tol-
erance panel

Not Visible Not Visible Visible

Pulsation Set-
tings on Sec-
tioning panel                     

Not Visible Not Visible Visible

Frequency 
tab in Graph 

Control, 
Graph Res-
ults window

Not Visible Not Visible Visible
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Figure 2: Select Use from the Pulsation Frequency Analysis in the Analysis menu to perform pulsa-
tion analysis

SSL (Settling SLurry)

Activate the Settling Slurry (SSL) module by checking the box next to Activate SSL. Once activ-
ated,  enable it by selecting Settling or disable it by selecting Disable.  When the SSL module is 
activated, the four standard items in the Fluid Properties group are replaced with the SSL mod-
ule fluid properties items as shown in Table 2 below. These items are Carrier Fluid, Solids Defin-
ition, and Slurry Definition. Additionally, the Library menu will have a Solids Library option. These 
items are present while SSL is activated, regardless of whether SSL is enabled or disabled.

Table 2: Analysis Setup items in Fluid Properties group with and without SSL active

Without 
SSL Active With SSL Active

Activating the SSL module  can be done before or after a model is built. If activated after, then 
additional input will be required for solids data. Pre-existing models built with standard AFT 
Impulse can be opened with SSL and settling slurry data added. 

Settling slurry calculations can be turned off at any time by selecting Disable. The Disable mode 
causes the SSL module to function like standard AFT Impulse. If a model with SSL activated is 
opened in standard AFT Impulse without SSL activated, then the SSL data will be lost once the 
model is saved. Table 2 relates the differences between not using SSL and using it in Disable 
mode. The purpose of Disable mode is that it allows standard clear fluid calculations to be per-
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formed without deactivating SSL. Deactivating the SSL module will cause the loss of the slurry 
input data for the active scenario.

The SSL module can also be toggled between Settling and Disable from the Analysis menu in 
the Slurry option as shown in Figure 3. Use this feature to quickly toggle the SSL module 
between Settling and Disable without opening the Modules panel in Analysis Setup.

Table 3: AFT Impulse feature accessibility based on the SSL module activation and enablement

Features SSL Not 
Activated

SSL Activated

SSL Dis-
abled SSL Enabled

SSL items in 
Fluid Prop-
erties group

Not Visible Visible Visible

Slurry in Ana-
lysis menu Not Visible Visible Visible

Solids Library 
in Library 

menu
Not Visible Visible Visible

Flowrate spe-
cified in terms 

of slurry, 
solids or clear 
liquid in sev-
eral junctions

Not Visible Not Visible Visible

Slurry data in 
Output Not Visible Not Visible Visible

Initial Velocity 
Guess Ratio 

V/Vsm in 
Advanced 

Parameters 
panel

Not Visible Not Visible Visible
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Figure 3: Select Settling from the Slurry option in the Analysis menu to perform settling slurry cal-
culations when running the model

Related Topics

Modules Group 129
Add-on Modules 631

Fluid Properties Group
The Fluid Properties group in Analysis Setup gives you control over the fluid properties that influ-
ence your pipe system analysis.              

While there are a four panels available to input the fluid properties, only one panel is required to 
run the model. The rest of the panels offer optional input.

Note: If the SSL module is activated the panels in the Fluid Properties group will change to 
show the slurry panels. See SSL Module Fluid Properties for more information.

 l Fluid panel  - Required panel. Allows the user to define the fluid properties directly, or from 
one of the available fluid libraries.

 l Viscosity Model panel - Optional panel. Allows user to define a non-Newtonian viscosity 
model.

 l Variable Fluids panel - Optional panel. Allows user to select constant or variable fluid prop-
erties.

 l Laminar and Non-Newtonian Corrections panel - Optional panel. Allows the user to 
choose what correction factors to apply for laminar or non-Newtonian flow and to which 
objects the corrections should apply.

Related Blogs

Get More Flexible With Your Fluids
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Fluid Panel
The Fluid panel controls the properties of the fluid in the model. A default fluid is not selected - 
one must be defined to run any simulation unless one was previous defined on the Startup Win-
dow.

The first selection that must be made is what Fluids Library to use. The default selection of User 
Specified requires the manual definition of Density, Dynamic Viscosity, Bulk Modulus (optional 
for steady-state runs), and Vapor Pressure (optional if cavitation modeling is not required). The 
available Fluid Libraries are:

 l AFT Standard - Common fluids from various industry standard sources have been curve 
fit to optimize calculation speed. This fluid library offers the best balance between accur-
acy and computation time.

 l ASME Steam/Water - Properties are calculated via the Equations of State which were 
used to generate the classic steam/water tables in the IAPWS Industrial Formulation 
(1997).

 l NIST REFPROP - The Reference Fluid Thermodynamic and Transport Properties 
(REFPROP) Database is licensed from the National Institute of Standards and Tech-
nology (NIST) where properties for approximately 150 fluids are calculated via Equations 
of State. REFPROP supports user-specified fluid mixtures. For more info see the fol-
lowing sources: Program Summary, REFPROP FAQ, NIST Chemistry WebBook, NIST 
Chemical Name Search.

 l Chempak Fluid - Optional add-on for purchase which contains data for approximately 
700 fluids and supports user-specified fluid mixtures. Chempak is licensed from Madison 
Technical Software.

 l User Library Fluid - If the desired working fluid is not available via the other sources, cus-
tom fluid properties can be entered and saved to the User Library for repeated use in the 
future. Fluids can be created using the Fluid Libraries menu.

Select a library by clicking the radio button next to the name of the library. After selecting a lib-
rary, the Fluids Available in Library list is populated. One of the fluids can be selected and used 
with the Add To Model button.

Note: Fluids in the supercritical region will be treated as incompressible in Impulse. For 
increased accuracy, fluids above the critical point should be modeled in a transient com-
pressible flow solver such as AFT xStream.

AFT Standard Fluid Library

Common fluids from various industry standard sources have been curve fit to optimize cal-
culation speed. This fluid library offers the best balance between accuracy and computation 
time.

Generally, fluids in the AFT Standard library are assumed to have properties that only vary with 
temperature.

To add a fluid into your model, select it from the Fluids Available in Library list  and click the Add 
to Model button. The fluid will appear in the  Fluids in Current Model area. Once the fluid is added, 
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specify the temperature in the Fluid Properties area on the right to calculate values of density, 
dynamic viscosity, bulk modulus, and vapor pressure, as shown in Figure 1.

Figure 1: Fluid panel in Analysis Setup with the AFT Standard fluid library selected

ASME Steam/Water Library

Properties are calculated via the Equations of State which were used to generate the classic 
steam/water tables in the IAPWS Industrial Formulation 1997 for the Thermodynamic Properties 
of Water and Steam (ISPWS-IF97), see ASME Press in References.

After selecting ASME Steam/Water, "ASME '97 Water" is automatically added to in the Fluids in 
Current Model area. Enter a Pressure and Temperature to calculate the properties as shown in 
Figure 2.

Detailed fluid properties information from SteamCalc can be calculated using the AFT 
SteamCalc Viewer, which can be accessed from Tools > Fluid Property Viewers > SteamCalc. 
The SteamCalc Viewer will be launched as a separate application, which can then be used to cal-
culate fluid properties at various conditions.

For more information on AFT SteamCalc Viewer see the SteamCalc Help File.
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Figure 2: Fluid panel in Analysis Setup with the ASME Steam/Water fluid library selected

NIST REFPROP Library

The Reference Fluid Thermodynamic and Transport Properties (REFPROP) Database is 
licensed from the National Institute of Standards and Technology (NIST) where properties for 
approximately 150 fluids are calculated via Equations of State. The data comes from Version 10 
of the library. For more info see the following sources: Program Summary, REFPROP FAQ, 
NIST Chemistry WebBook, NIST Chemical Name Search.

Add a fluid from the Fluids Available in Library list by selecting it and clicking Add to Model.  
Select the Fluid Phase and enter both a Pressure and Temperature in the Fluid Properties area 
on the right, as shown in Figure 3.

Fluids from the NIST REFPROP library support fluid mixtures, but no chemical reactions are 
modeled as stated in the Engineering Assumptions.
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Figure 3: Fluid panel in Analysis Setup with the NIST REFPROP fluid library selected

Chempak Fluid Library

Optional add-on for purchase which contains data for approximately 700 fluids. Chempak is 
licensed from Madison Technical Software.

Fluids from the Chempak library  support fluid mixtures, but no chemical reactions are modeled 
as listed in the Engineering Assumptions.

Add a fluid from the Fluids Available in Library list by selecting it and clicking Add to Model.  Enter 
both a Pressure and Temperature in the Fluid Properties area on the right, as shown in Figure 4.

Information on the theory and calculation methods used in Chempak is given in the Chempak 
Technical Information topic.

Detailed fluid properties information from Chempak can be calculated using the AFT Chempak 
Viewer, which can be accessed from Tools > Fluid Property Viewers > Chempak. The Chempak 
Viewer will be launched as a separate application, which can then be used to calculate fluid prop-
erties at various conditions. A Chempak Data license is required to use the Chempak Viewer.

For more information on AFT Chempak Viewer see the Chempak Viewer Help File.
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Figure 4: Fluid panel in Analysis Setup with the Chempak fluid library selected

State Property Accuracy Options

The State Property Accuracy options are applicable only to Chempak fluids and  are located on 
the Fluid panel below the Fluids in Current Model area. 

The State Property Accuracy influences the number of elements used in curve fits for calculating 
property data. There are two accuracy options: Standard and High. You will usually want to start 
with standard accuracy, which is selected by default, and use high accuracy for final runs, 
depending on the importance and run time for the model. The high accuracy option will increase 
run time by about a factor of two.

When performing interpolations for properties, a 4 point or 16 point interpolation scheme can be 
used. The 4 point scheme implemented in AFT Impulse is the Standard Accuracy option. The 16 
point scheme is the high accuracy option. Use of the High accuracy option will roughly double 
the run times for models.

Related Topics

Creating Liquid Mixtures 140
Chempak temperature and or pressure is out of range for the following 753
Static pressure lower than vapor pressure at inlet outlet of pipe/junction X 759
Transient static pressure lower than vapor pressure at Pipe X Station Y 762
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Creating Liquid Mixtures
You have the option of creating a mixture of fluids with the NIST REFPROP or Chempak fluid lib-
raries.

To create a mixture, first select NIST REFPROP or Chempak Fluid on the Fluid panel in Analysis 
Setup. Once this has been selected, the option to Create New Mixture and Add button becomes 
available. Click this button, then locate and select the first fluid in the mixture you wish to specify 
(the Search button can be used to search for a name or synonym). Enter the mass or mole frac-
tion of the fluid in the mixture, and click Add Fluid to Mixture. Repeat this process for all fluids in 
the mixture as shown in Figure 1.

Note: The fraction basis of all mixtures is either mass or mole, and it is specified on the Fluid 
panel itself. If you would like to change the fraction basis for the mixture (from mass to 
mole or from mole to mass), click on the desired fraction basis located at the bottom of 
the Fluid panel below Fraction Basis for Mixture. Note that this option is only available 
after you specify the model fluid as a mixture.

Figure 1: The Create Mixture window (opened from the Fluid panel) allows you to create predefined 
mixtures for the model

To add the mixture to the Fluid panel, the Total Fraction for the table must equal 100%. To help 
achieve this, the Set as Remainder button can be used to add the remaining percentage to the 
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selected component in the table so that the fractions in the table will add up to 100%. Altern-
atively, the Ratio Fractions to Total button will scale up the fractions in the table so that they will 
add to 100%.

Components can be deleted from the table by using the Remove Component or Clear All Com-
ponents buttons.

Mixture data can be exported to a file which can then be imported into other AFT applications, or 
shared with other AFT application users by using the Export Mixture to File and Import Mixture 
from File buttons in this window.

Note: The NIST REFPROP fluid library is not able to calculate the mixing parameters for most 
mixtures containing water, helium, hydrogen, neon, carbon monoxide, fluorine, meth-
anol, or ethanol.

Related Topics

Fluid Panel 135

Viscosity Model Panel
AFT Impulse can model systems with Newtonian or non-Newtonian fluids. A Newtonian fluid is 
one where the fluid viscosity is fixed and independent of fluid velocity, while a non-Newtonian 
fluid is one where the fluid viscosity is variable and dependent on fluid velocity. Most industrial flu-
ids are Newtonian fluids, although there are important applications for non-Newtonian fluids. 

AFT Impulse offers seven viscosity models:

 l Newtonian
 l Duffy Method (Pulp and Paper Stock)
 l Brecht & Heller Method (Pulp and Paper Stock)
 l Power Law Model
 l Bingham Plastic Model
 l Herschel-Bulkley
 l Homogeneous Scale-up Method

Modeling non-Newtonian fluids is a complex task. A myriad of test equipment and theoretical 
models exist, and each have various names unique to an industry or application. This discussion 
along with other discussion related to non-Newtonian flow in Impulse seeks to help the reader 
understand what the viscosity model is meant for, how to use the model, and how the model cal-
culates hydraulic behavior in a system.

Frictional Losses

Each non-Newtonian fluid model adjusts the frictional losses in the system from the Newtonian 
fluid model. The equations and correlations used to determine pipe frictional losses are detailed 
on each model’s page. These methods to determine frictional losses replace the pipe friction 
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model specified in the Pipe Properties window. For pipe Fittings and junction-specific losses, all 
non-Newtonian models use the same method, as detailed on the Laminar and Non-Newtonian 
Corrections panel topic.  

Applicability in Transient Flow

AFT Impulse uses the same non-Newtonian models and correlations for both steady-state and 
transient flow. The applicability of these viscosity models to transient flow is uncertain. Studies 
suggest that the viscosity models available in Impulse remain valid in transient systems, but no 
definitive answer exists. Users should treat all transient non-Newtonian hydraulic results with 
caution.

Impulse models these non-Newtonian fluids in a transient system by recalculating friction factor 
or pressure loss information each time step as dictated by the settings on the Transient Friction 
panel. It is strongly recommended that transient systems with non-Newtonian fluids are modeled 
with the Time Varying – Simple model (selected by default for all models created in Impulse 8 or 
later). The Constant model will not capture the non-Newtonian behavior of the fluid as velocity 
changes. The Time Varying – Advanced (Unsteady Brunone) model has not been studied for 
use with non-Newtonian fluids.

Related Topics

Duffy Method (Pulp and Paper Stock) 142
Brecht & Heller Method (Pulp and Paper Stock) 145
Power Law Model 147
Bingham Plastic Model 150
Herschel-Bulkley Model 153
Homogeneous Scale-up Method 157
Using Rheological Data 161

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Duffy Method (Pulp and Paper Stock)
The Duffy method is a system developed by G.G. Duffy at the University of Auckland, New Zea-
land and formalized by the Technical Association of the Pulp and Paper Industry (TAPPI). The 
model uses correlations based on data obtained from laboratory flow loops and real-world pulp 
mill piping systems.

TAPPI states that the correlations behind this model do not necessarily provide the actual design 
value of friction loss. Instead, it provides a means to determine the minimum value of pipe friction 
loss an engineer can expect. Each system designer must determine and apply a safety factor as 
they deem necessary. 
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Impulse contains data on 20 different stock fluid selections that can be used with the Duffy 
method. The constants used for each stock fluid are displayed in the General Results section of 
the output. Additionally, the Vmax and Vwater terms, the dryness coefficient, and the Safety 
Factor can all be displayed in the Pipe Output. 

Note: The Duffy method is only valid for pulp consistencies between 2 and 6%.

Duffy Method Interface

The Viscosity Model panel appears as shown below in Figure 1 when the Duffy method is selec-
ted.

Figure 1: Viscosity Model interface for the Duffy method.

Users must select a type of pulp to model and define a pulp consistency. The user must also 
choose to correct the Duffy method parameters based on temperature automatically or via a 
user-specified correction. The constants used by Impulse are based on a pulp temperature of 35 
deg. C. The Automatic Based on Temperature will use the temperature specified in the Fluid 
panel (or the temperature in each pipe in the case of Variable Fluid Properties) to determine the 
pulp temperature.

There are 21 pulp types to choose from:

 l Bleached kraft pine dried and reslurried - PVC pipe
 l Bleached kraft pine dried and reslurried - SS pipe
 l Bleached straw - copper pipe
 l Bleached sulfite - copper pipe
 l Hardwood NSSC CSF = 620 - PVC pipe
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 l Kraft - copper pipe
 l Kraft birch dried and reslurried - PVC pipe
 l Long-fibered kraft dried and reslurried - PVC pipe
 l Long-fibered kraft never dried CSF = 260 - PVC pipe
 l Long-fibered kraft never dried CSF = 550 - PVC pipe
 l Long-fibered kraft never dried CSF = 650 - PVC pipe
 l Long-fibered kraft never dried CSF = 725 - PVC pipe
 l Long-fibered kraft never dried CSF = 725 - SS pipe
 l Newsprint broke CSF = 75 - PVC pipe
 l Refiner groundwood CSF = 150 - PVC pipe
 l Refiner groundwood (hardboard) - PVC pipe
 l Refiner groundwood (insulating board) - PVC pipe
 l Stone groundwood CSF = 114 - PVC pipe
 l Unbeaten aspen sulfite never dried - SS pipe
 l Unbleached straw - copper pipe
 l Unbleached sulfite - copper pipe

Theory and Correlations

AFT Impulse models frictional losses for the Duffy method using correlations taken from the 
TAPPI Generalized Method for Determining the Pipe Friction Loss of Flowing Pulp Suspensions. 

The maximum velocity (m/s) for the Duffy model is given by:

The velocity at which pulp effects are negligible and the frictional losses of the pulp mixture are 
the same as the frictional losses of pure water:

In the case where V 0 <Vmax:

Where:
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 l dH/L = head loss per length (m water/100 m pipe)
 l C = pulp consistency (% dryness)
 l D = inner pipe diameter (mm)
 l F = correction factor for temperature or pipe roughness (dimensionless)
 l K', K, σ, α, β, γ = constants depending on pulp type and pipe material (dimensionless)
 l V = actual pipe velocity, when Vmax > V (m/s)
 l V = Vmax, when Vwater > V > Vmax

When pipe velocity is larger than Vwater, standard pipe friction models are used, treating the 
pulp mixture as pure water. 

Related Topics

Viscosity Model Panel 141
Brecht & Heller Method (Pulp and Paper Stock) 145
Power Law Model 147
Bingham Plastic Model 150
Herschel-Bulkley Model 153
Homogeneous Scale-up Method 157

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Brecht & Heller Method (Pulp and Paper Stock)
The Brecht and Heller method is a system developed by Brecht and Heller at the University of 
Maine and formalized by the Technical Association of the Pulp and Paper Industry (TAPPI) and 
the Cameron Hydraulic Handbook. The model uses correlations based on data obtained from 
laboratory flow loops and real-world pulp mill piping systems.

This method is considered more conservative than the Duffy method, meaning the Brecht and 
Heller method will predict larger pressure losses in a system, all else constant.

Impulse contains data on 8 different stock fluid selections that can be used with the Brecht and 
Heller method. The constants used for each stock fluid are displayed in the General Results sec-
tion of the output. Additionally, the pseudo-Reynolds Number (Ré) and Friction Factor terms can 
be displayed in the Pipe Output. 

Brecht and Heller Method Interface

The Viscosity Model Panel appears as shown below in Figure 1 when the Brecht & Heller 
method is selected.
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Figure 1: Viscosity Model interface for the Brecht and Heller Method.

Users must select a type of pulp model and define a pulp consistency. There eight pulp types to 
choose from:

 l Bleached sulfite - SW, CSF = 560
 l Pre-steamed groundwood - SW, CSF = 200
 l Reclaimed fiber
 l Soda - HW
 l Stone groundwood - SW, CSF = 70
 l Unbleached kraft - SW, CSF 730
 l Unbleached sulfite - SW, CSF = 640
 l Unbleached, unrefined sulfite SW

Theory and Correlations

AFT Impulse models frictional losses for the Brecht and Heller method using correlations taken 
from the Cameron Hydraulic Handbook, pg 3-88. 

The pseudo-Reynolds number for the paper stock (Ré) is:

The pipe friction factor is:
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The friction loss in feet along the pipe is:

Where:

 l D = inner diameter (feet)
 l L = pipe length (feet)
 l V = average velocity (ft/s)
 l ρ = stock fluid density (lbm/ft3)
 l C = pulp consistency (% dryness)
 l K = friction factor constant, specific to pulp type (dimensionless)

Related Topics

Viscosity Model Panel 141
Duffy Method (Pulp and Paper Stock) 142
Power Law Model 147
Bingham Plastic Model 150
Herschel-Bulkley Model 153
Homogeneous Scale-up Method 157

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Power Law Model
The Power Law model for non-Newtonian fluids is one of the most common viscosity models 
used in hydraulic analysis. This model states that the shear stress required to shear a fluid at a 
given rate can be described by the following equation:
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Where τ is the shear stress, du/dy is the shear rate (or velocity gradient), and K and n are the 
Power Law constants. 

The Power Law model defines η, the apparent viscosity of the fluid as:

In the Power Law model, a value of n = 1 corresponds to a Newtonian fluid, while 0 < n < 1 is a 
Shear Thinning (pseudoplastic) fluid and n > 1 represents a Shear Thickening (dilatant) fluid. 

To employ this model, users must have values for k and n, or have rheological test data. 

Power Law Interface

The Viscosity Model panel  appears as shown below in Figure 1 when the Power Law model is 
selected. 

Figure 1: Viscosity Model interface for the Power Law model.
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Users must enter values for the Power Law constants, K and n. If the user has raw rheological 
test data instead, they can enter that directly using the Calculate from Rheological Data option.

Theory and Correlations

AFT Impulse models the frictional losses due to a Power Law fluid using correlations taken from 
Darby, pg. 166-167. Note that the original equations in Darby use the Fanning friction factor, 
while AFT software uses the Moody friction factor. The equations below have been modified 
from the original accordingly. 

Where:

The Reynolds number for power law fluid (Repl) is defined as:
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The critical Reynolds number for power law fluid (Replc) where laminar flow ceases is defined as:

The friction factor calculated using this correlation is then used to determine pressure loss fol-
lowing Equation 3 in the Network Solution Methodology topic. 

These correlations are valid across the full range of Reynolds number. The applicability of this 
method to highly turbulent flow is limited only by the test data used to determine the Power Law 
constants. 

Related Topics

Viscosity Model Panel 141
Duffy Method (Pulp and Paper Stock) 142
Brecht & Heller Method (Pulp and Paper Stock) 145
Bingham Plastic Model 150
Herschel-Bulkley Model 153
Homogeneous Scale-up Method 157
Using Rheological Data 161

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Bingham Plastic Model
The Bingham Plastic model for non-Newtonian fluids is one of the most common viscosity mod-
els used in hydraulic analysis. This model states that the shear rate resulting from a given shear 
stress applied to the fluid can be described with the following piecewise equation:
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Where du/dy is the shear rate (or velocity gradient), τ is the applied shear stress, τo is the yield 
stress, and μ∞ is the plastic viscosity or coefficient of rigidity.             

The Bingham Plastic model describes η, the apparent viscosity of the fluid as:             

The Bingham Plastic model uses a constant value for plastic viscosity, meaning a value for μ∞ of 
0 would result in a Newtonian fluid. Some fluids may see Bingham Pseudoplastic behavior, 
where shear stress and shear rate do not have a linear relationship. These fluids can be 
modeled using the Herschel-Bulkley viscosity model.

To employ this model, users must have values for τo and μ∞, or have rheological test data. 

Bingham Plastic Interface

The Viscosity Model Panel appears as shown below in Figure 1 when the Bingham Plastic model 
is selected.

Figure 1:  Viscosity Model interface for the Bingham Plastic model.

Users must enter values for the Bingham Plastic constants, μ∞ and τo. If the user has raw rhe-
ological test data instead, they can enter that directly using the Calculate from Rheological Data 
option instead. 
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Theory and Correlations

AFT Impulse models the frictional losses due to a Bingham Plastic fluid using correlations taken 
from Darby, pg. 168-169. Note that the original equations in Darby use the Fanning friction 
factor, while AFT software uses the Moody friction factor. The equations below have been mod-
ified from the original accordingly. 

Where:

The Reynolds number for a Bingham Plastic fluid is defined as:

The Hedstrom number for a Bingham Plastic fluid is defined as:
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The friction factor calculated using this correlation is then used to determine pressure loss fol-
lowing Equation 3 in the Network Solution Methodology topic. 

These correlations are valid across the full range of Reynolds number. The applicability of this 
method to highly turbulent flow is limited only by the test data used to determine the Bingham 
Plastic constants. 

Related Topics

Viscosity Model Panel 141
Duffy Method (Pulp and Paper Stock) 142
Brecht & Heller Method (Pulp and Paper Stock) 145
Power Law Model 147
Herschel-Bulkley Model 153
Homogeneous Scale-up Method 157
Using Rheological Data 161

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Herschel-Bulkley Model
The Herschel-Bulkley model for non-Newtonian fluids is one of the most common viscosity mod-
els used in hydraulic analysis. This model states that the shear rate resulting from a given shear 
stress applied to the fluid can be described with the following piecewise equation:

Where du/dy is the shear rate (or velocity gradient), τ is the applied shear stress, τo is the yield 
stress, K is the consistency coefficient, and n is the flow behavior index. 

The Herschel-Bulkley model describes describes η, the apparent viscosity of the fluid as:             
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In the Herschel-Bulkley model a value for τo of 0 and a value for n of 1 would result in a New-
tonian fluid. The Herschel-Bulkley model is equivalent to the Bingham Plastic model if n = 1, and 
is equivalent to the Power Law model if τo = 0.

To employ this model, users must have values for τo, K and n, or have rheological data.

Herschel-Bulkley Interface

The Viscosity Model panel  appears as shown below in Figure 1 when the Herschel-Bulkley 
model is selected.

Figure 1: Viscosity Model panel for the Herschel-Bulkley model

Users must enter values for the Herschel-Bulkley constants, K, n, and τo. If the user has raw rhe-
ological test data instead, they can enter that directly using the Calculate from Rheological Data 
option.

Theory and Correlations

AFT Fathom models the frictional losses due to a Herschel-Bulkley fluid using correlations as are 
summarized in Garcia & Steffe  (1986). Note that the original equations in the reference use the 
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Fanning friction factor, while AFT software uses the Moody friction factor.

The laminar flow friction factor is defined as

with

and ξo, the dimensionless unsheared plug radius:

 

The turbulent flow friction factor can be calculated as follows

where

Where He is the Hedstrom number for Herschel-Bulkley fluids and is defined as

Re is the Reynolds number for Herschel-Bulkley fluids, and is equivalent to the Reynolds num-
ber for Power Law fluids:
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The critical Reynolds number, which represents the transition from laminar to turbulent flow 
for Herschel-Bulkley fluids is defined as

Where n is the flow behavior index, Ψc is equivalent to Ψ with ξo = ξoc, and ξoc is defined impli-
citly as follows

The friction factor calculated using this correlation is then used to determine pressure loss fol-
lowing Equation 3 in the Network Solution Methodology topic. 

These correlations are valid across the full range of Reynolds number. The applicability of this 
method to highly turbulent flow is limited only by the test data used to determine the Herschel-
Bulkley constants. 

Related Topics

Viscosity Model Panel 141
Duffy Method (Pulp and Paper Stock) 142
Brecht & Heller Method (Pulp and Paper Stock) 145
Power Law Model 147
Bingham Plastic Model 150
Homogeneous Scale-up Method 157
Using Rheological Data 161

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network
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Homogeneous Scale-up Method
The Homogeneous Scale-up method for non-Newtonian fluids is based on the idea that test data 
for velocity and pressure drop along pipes of a given diameter can be scaled up to model the 
velocity and pressure drop for a pipe of a large size. 

This scale-up is similar to using the affinity laws to predict pump behavior. Instead of scaling pres-
sure rise and volumetric flowrate for a pump, the Homogeneous Scale-up method scales the fric-
tional gradient (jm) and mean velocity (Vm) for a pipe. 

To employ this method, users must have test data from the same Tube Flow Rheometer as is 
available when entering rheological data for the Power law, Bingham Plastic, and Herschel-
Bulkley models.

Homogeneous Scale-up Interface

The Viscosity Model panel  appears as shown below in Figure 1 when the Homogeneous Scale-
up method is selected. Click the Enter Scaled Data button to enter data.

Figure 1: Viscosity Model interface for the Homogeneous Scale-up method.

The Homogeneous Scale-up window is shown below in Figure 2. Here, the user must specify 
information about the pipe used to obtain the test data along with the test data itself. The flow 
data can be entered as mass flowrate, velocity, volumetric flowrate, or shear rate data as determ-
ined by a tube flow rheometer. The Head/Pressure data can be entered in terms of Head gradi-
ent, Pressure gradient, or shear stress data as determined by a tube flow rheometer. 

Each data point must also be marked as laminar or turbulent flow. 
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Figure 2: Homogeneous Scale-up Data entry window.

The user can also generate a graph of their data plotted against other viscosity models and lar-
ger scaled pipe sizes. This interface is shown in Figure 3 below. Note that generating a cross-
plot for the Power Law or Bingham Plastic models does not mean Impulse will use those models 
in the system. The cross-plot is intended only to give a visual comparison of the data. 
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Figure 3: Graphed data for the Homogeneous Scale-up method.

Theory and Correlations

The Homogeneous Scale-up methods are based on Chapter 3 of Wilson, et al, 2006, page 67. 

Laminar data scales as follows:

Turbulent data scales as follows:

- 159 -



Fundamental Modeling Concepts

Where: 

 l Data point 1 is the test data
 l Data point 2 is the larger system
 l τ is the shear stress at the pipe wall

 

The pressure drop calculated using these methods is then substituted into the network solution 
and iterated upon until a converged solution is available. 

These correlations are valid across the full range of Reynolds number. The applicability of this 
method to highly turbulent flow is limited only by the test data the user has available.

Related Topics

Viscosity Model Panel 141
Duffy Method (Pulp and Paper Stock) 142
Brecht & Heller Method (Pulp and Paper Stock) 145
Power Law Model 147
Bingham Plastic Model 150
Herschel-Bulkley Model 153
Using Rheological Data 161

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network
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Using Rheological Data
For the Power Law, Bingham Plastic and Herschel-Bulkley viscosity models, users are expected 
to define constants for each model. If the user already has these constants, they can be entered 
directly into the software. If the user only has the original rheological data, Impulse can calculate 
the viscosity model constants from that data. 

The interface used to enter this data and the processes Impulse employs to manipulate it are sim-
ilar for all of the viscosity models mentioned above. This page discusses rheological data only in 
the context of the Power Law model for simplicity. Unless specified otherwise, the content dis-
cussed here is applicable to all models. 

Calculate from Rheological Data Interface

The Calculate from Rheological Data option can be accessed from the Viscosity Model panel in 
Analysis Setup. Click the Calculate from Rheological Data radio button and click the Calculate 
Constants button as shown below in Figure 1. 

Figure 1: Power Law viscosity model using the Calculate from Rheological Data option. 

The Calculate Power Law Constants window will open  to enter rheological data. This window is 
shown below in Figure 2. In this window, users are asked to enter Shear Stress (τ) vs. Shear 
Rate data in units of pressure and inverse time, respectively. 

Two Raw Data Type options are presented above the table, Tube Flow Rheometer Data (8V/D) 
and Shear Rheometer Data (du/dy). These options refer to the experimental setup used to 
obtain the shear stress vs shear rate data entered in the table. Impulse version 8 and earlier 
assumed all entered data was the Tube Flow Rheometer Data (8V/D) type. Refer to the Types of 
Rheological Data section below for more information on which option to use.
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Note: For Herschel-Bulkley fluids only the Shear Rheometer Data option is available at this 
time. This is because the method employed in Impulse to convert from Tube Flow Rheo-
meter Data to Shear Rheometer Data has unknown accuracy for use with the Herschel-
Bulkley model.

Figure 2: Rheological data input form.

The user can click Generate Curve Fit Now to curve fit the data and obtain the viscosity model 
constants. Generating the curve fit will show the user a plot of their data along with the fitted con-
stants, as shown below. Clicking OK will transfer those constants to the Viscosity Model panel. 

- 162 -



Analysis Setup Overview

Figure 3: Curve fit rheological data and constants.

Types of Rheological Data

Two major types of rheological test data exist. Many names and potential test devices exist for 
each type. For the purposes of this discussion, we must pick a single name for each type. One 
experimental setup is a tube flow rheometer while the other is a rotational rheometer.

Tube Flow Rheometer

A tube flow rheometer system consists of a pipe of some diameter and length connected to a 
high pressure source and a low pressure source. Varying the high pressure source drives flow 
through the pipe at different velocities. This experimental setup allows the engineer to obtain 
data on the pressure gradient (pressure drop per length) along the pipe for a given velocity. The 
engineer could also obtain this type of rheological data by directly measuring pressure and velo-
city along a pipe in an existing facility.

This data is then manipulated into shear stress and shear rate data, respectively. Specifically, 
the tube flow rheometer gives shear rate data where the shear rate is the bulk shear rate of the 
fluid. The measured velocity is the bulk velocity of the fluid, meaning only bulk shear rate can be 
calculated. Bulk shear rate can be calculated from bulk velocity using the equation 8V/D.

This type of rheological data may be more common in industries considering slurry applications 
or when the process facility is already in operation and data is obtained via direct measurements 
of the system operations.
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Rotational Rheometer

A rotational rheometer system consists of a rotating device in contact with the fluid being studied. 
Common examples of this system include the cup and bob (couette) rheometer and the cone 
and plate rheometer. Varying the angular rate of the rotating device creates different shear rates 
in the fluid. This experimental setup allows the engineer to obtain data on the torque required to 
achieve a given angular rate of rotation.

This data is then manipulated into shear stress and shear rate data, respectively. Specifically, 
the rotational rheometer gives shear rate data where the shear rate is the wall shear rate of the 
fluid. The angular rate of rotation and equipment geometry are directly known, and thus the 
shear rate is calculated at the wall of the rotating device.

This type of rheological data is more common when data is obtained via small-scale, laboratory 
tests. If rheological data is presented with information about rate of rotation (RPM, revolutions 
per second, Hx, etc.), the data was likely obtained from a rotational rheometer.

Finally, modern rotational rheometers will commonly manipulate the directly measured torque 
and angular rate of rotation data for the engineer, returning the raw data along with shear stress 
or viscosity vs. shear rate data. Note that Impulse requires the user to define shear stress vs. 
shear rate data when entering rheological test data. If the user only has viscosity vs. shear rate 
data, they should curve fit the constants for the desired viscosity model manually.

Converting Between Types of Rheological Data

Although two types of rheological data exist, most viscosity models expect rotational rheometer 
data. Impulse employs the Rabinowitsch-Mooney technique to convert from tube flow rheometer 
data to rotational rheometer data when necessary.

The Rabinowitsch-Mooney technique can be applied to obtain rotational rheometer data from 
tube flow rheometer data as follows:

 1. Plot the tube flow rheometer data on a log-log scale.
 2. Determine the slope of the data. The slope is represented by n’. 
 3. Multiply the tube flow rheometer data by the value:

Impulse now has rheological data in the form of rotational rheometer (rheogram) data, which can 
be used to directly fit the viscosity model constants.

Related Topics

Viscosity Model Panel 141
Power Law Model 147
Bingham Plastic Model 150
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Herschel-Bulkley Model 153

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Variable Fluids Panel
AFT Impulse allows users to model constant or varying fluid properties.

 l Constant Fluid Properties - All fluid properties are the same for every pipe and are as 
specified in the Fluid panel. Note that non-newtonian viscosity models will still cause the 
viscosity to vary if the constant fluid properties option is selected.

 l Variable Fluid Properties - The values for density and viscosity in the Fluid panel are the 
default fluid properties for new pipes drawn on the Workspace, and you can then enter dif-
ferent fluid property values, if desired, for any pipe in the Fluid Properties tab of the Pipe 
Properties window. This does not mean that fluid properties can vary on their own in the 
model - they are constant in each pipe and must still be directly specified by the user.

Note: Fluid properties from one pipe don't propagate through the system. Each pipe 
will only use it's assigned fluid properties regardless of flow direction.

This option may be useful to model different pipes carrying different fluids, or to model 
changes in temperature across a component such as a heat exchanger. Impulse cannot 
perform heat transfer or dynamic mixing; however, fluid properties of pure components 
may be individually specified in upstream pipes, and the resulting mixture properties can 
be individually specified in downstream pipes. Or, cold fluid properties can be entered for 
pipes upstream of a heat exchanger, and hot fluid properties can be entered for pipes 
downstream of the heat exchanger.

Note: Transient Forces cannot be reliably calculated if the density changes between 
pipes that are included within the length of the Force Set due to Variable Fluid 
Properties. There may be Warnings For Force Calculations displayed within the 
interface.

Laminar and Non-Newtonian Corrections Panel
AFT Impulse uses the methods and correlations discussed for each viscosity model only to 
model frictional losses for pipes. Frictional losses due to pipe fittings or junction losses are 
modeled using the methods discussed on this page regardless of viscosity model.

It is generally believed that the pressure drop through valves, fittings, etc. derive from bulk fluid 
motion, wall separation, turbulence, etc. and hence are not affected by non-Newtonian fluid 
behavior in turbulent flow. Thus, pressure loss due to pipe fittings or junction-specific losses dur-
ing turbulent flow are modeled using the same methods employed for Newtonian flow. 
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During laminar flow, pipe fittings and junction losses may not be similar for both Newtonian and 
non-Newtonian fluids. AFT Impulse offers two options to model these losses during laminar flow. 
The correction options are:

 l Use Adjusted Turbulent K Factor Method (ATKF) - derived from the Crane hydraulic hand-
book (Crane 1988).

 l Also Apply in Turbulent Region
 l Use Improved Method

 l Use Non-Newtonian to Newtonian Pipe Friction Ratio Multiplier

 

Modifying Losses for Fittings and Junctions Interface

The options listed above to modify losses at fittings and junctions can be found on the Laminar 
and Non-Newtonian Corrections panel in the Fluids Properties group of the Analysis Setup, as 
shown in Figure 1 below. 

Figure 1: Options to modify fitting and junction losses in the Laminar and Non-Newtonian cor-
rections.

These corrections are off by default and "Apply Corrections" must be selected to access them. 
Users can select which correction method is applied and can select which junction types the loss 
model will be applied to. Fathom Default can be selected at any time to reset the selected junc-
tion types.
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Non-Newtonian to Newtonian Pipe Friction Ratio Multiplier

One approach to modeling losses associated with fittings and junction losses is to assume that 
the ratio of those losses in a non-Newtonian and Newtonian fluid is equivalent to the ratio of pipe 
friction in a non-Newtonian and Newtonian fluid. One can write: 

This approach uses the pipe friction at the adjacent upstream pipe and the uncorrected loss 
factor in a Newtonian fluid to model the losses associated with the fitting or junction for a non-
Newtonian fluid.

Related Topics

Adjusted Turbulent K Factor (ATKF) Method 167
Improved ATKF Method 170
Note about Laminar Corrections for Fittings 173

Related Blogs

Applying the Improved ATKF Method for Laminar and Non-Newtonian Flow

Adjusted Turbulent K Factor (ATKF) Method
Crane (1988) includes an equivalence between equivalent length methods and K factor on the 
nomograph chart on page A-30. This nomograph is based on theory as discussed below.

The basic law of pressure drop for friction factor is

(1)

For K factors the pressure drop is given by

(2)
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From equations 1 and 2 it can be seen that there is an equivalence between fL/D and K.

The equivalent length method works by adding to the physical length as follows:

(3)

Hence the pressure drop due to the methods can be related as follows:

(4)

An appropriate equivalent length can be determined from standard AFT Impulse K-factor data by 
looking at large Reynolds number and hence fully turbulent conditions

(5)

And finally a general K-factor which is based on equivalent length can be found in the following:

(6)

To apply the method, take the AFT Impulse K-factors (Kturb) and multiply them by the relevant 
pipe friction factor, f, at actual conditions (and Reynolds number) and divide them by the tur-
bulent friction factor, fturb, evaluated at very large Reynolds number. 

Improved ATKF Method

For the Improved ATKF method, the turbulent friction factor in Equation 6 is replaced with the tur-
bulent friction factor calculated for commercial steel at very large Reynolds numbers, which is 
about 0.023 for a roughness of 0.0018 in. This allows the adjusted K factor to be independent of 
pipe roughness in the laminar flow region so that it more closely mimics the expected behavior 
for the 3K method from Darby and the equivalent length method.
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Comparison of Equation 6 to Published Data 

A study was performed to evaluate how Equation 6 compares to published data, which is 
discussed in detail in the technical paper by Wood et. al, 2012.

A comparison for a 10 foot long, 2 inch in diameter pipe flowing water was performed with the fol-
lowing:

 1. No fittings in the pipe
 2. Fittings of 12 elbows of 1.5 r/D with a total K of 3.17 but no corrections (this is the way 

standard AFT Impulse works)
 3. Darby 3-K method for 12 elbows (see Darby, 2001, pp.209)
 4. Equivalent length of 12 elbows with Leq/D = 16 (see Darby, 2001, pp.209)

 5. Use Equivalent Length in Pipe Diameters (L/D) Derived From K-Factors, Eq. 6

Figure 1 shows the results on a log-log plot. One would not expect the first case to match the oth-
ers as no fittings were included. Hence the head gradient was less than the other cases. 
However Case 1 does illustrate how Case 2 works in the standard AFT Impulse. Case 2 agrees 
with Cases 3-5 at high Reynolds Number but agrees with Case 1 at low Reynolds number. This 
is a result of using turbulent, high Reynolds Number K factors for low Reynolds Number applic-
ations.

Cases 3, 4 and 5 all agree well throughout the entire range of Reynolds Numbers. There is some 
small discrepancy at high Reynolds Number which is merely a result of various reference dif-
ferences over the exact pressure loss through a 1.5 r/D elbow.

The conclusion from Figure 1 is that the Equation 4.6 method allows reliable adjustment of tur-
bulent pressure loss data for fittings and junctions to laminar applications.
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Figure 1: Log-log plot of dimensionless head gradient vs. Reynolds number for various fitting loss 

models

Related Topics

Laminar and Non-Newtonian Corrections Panel 165
Improved ATKF Method 170
Note about Laminar Corrections for Fittings 173

Related Blogs

Applying the Improved ATKF Method for Laminar and Non-Newtonian Flow

Improved ATKF Method
For commercial steel pipe and pipes with a similar roughness, it has been shown that the equi-
valent length, 3-K and Adjusted Turbulent K Factor (ATKF) methods will all produce similar res-
ults in the laminar flow region (see Adjusted Turbulent K Factor (ATKF) Method). 

However, this is not the case when the pipe roughness varies significantly from that of com-
mercial steel. At different roughness values the predicted head loss with the original ATKF 
method varies inversely with pipe roughness, so that smoother pipes will experience higher head 
loss in the laminar regime as is shown on  the left Figure 1. The 3-K method shows no depend-
ence on pipe roughness in the laminar regime, as is shown on the right in Figure 1. It would be 
expected that head loss in the laminar regime would behave as predicted by the 3-K method, 
based on the fact that the laminar friction factor is independent of pipe roughness.
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Figure 1: Head Gradient calculated with the original ATKF method (left) and 3-K method (right) at dif-
ferent roughness values. 

To remove the dependence on pipe roughness in the ATKF method, the Improved ATKF 
method uses a fixed turbulent friction factor value calculated for commercial steel pipe 
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(roughness 0.0018 in) at very large Reynolds numbers. The Improved ATKF method can be writ-
ten as follows, replacing f,turb with the reference turbulent friction factor, f,turb,ref :

With the Improved ATKF factor it can be seen that the head loss is no longer dependent on pipe 
roughness (Figure 2).

Figure 2: Head gradient calculated with the Improved ATKF method at different roughness values

Related Topics

Laminar and Non-Newtonian Corrections Panel 165
Adjusted Turbulent K Factor (ATKF) Method 167
Note about Laminar Corrections for Fittings 173

Related Blogs

Applying the Improved ATKF Method for Laminar and Non-Newtonian Flow

- 172 -

https://www.aft.com/support/product-tips/applying-the-atkf-method-for-laminar-and-non-newtonian-flow


Analysis Setup Overview

Note about Laminar Corrections for Fittings
There is ambiguity in the literature about how to calculate fitting pressure loss for fittings. Here is 
a quick summary of different views:

No Laminar Correction Required

Crane (1988) suggests no correction is required. On pages 2-8 through 2-11 Crane discusses 
this. Worked examples 4-7, 4-8 and 4-9 use this assumption. 

This assumption is the same as method 2 in the ATKF comparison section and Figure 1 (in the 
aforementioned topic), and is consistent with how AFT Impulse has always performed laminar 
calculations. This assumption is available by merely not applying the laminar methods discussed 
in this chapter.

Laminar Correction Is Required

Publications such as Darby (2001) discuss the necessity for laminar corrections for fitting K 
factors. On pages 209-214 “2-K” and “3-K” methods are discussed that purport to cover the 
entire range of Reynolds number.

Based on Equation 6 and Crane’s (1988) nomograph of page A-30 a laminar correction based 
on equivalent length methods can be applied. This gives similar pressure drop results as the 3-K 
method and is available through the Adjusted Turbulent K Factor method.

Low Reynolds Number Flow

In addition to the discussion above, there is a separate debate over whether flow at very low 
Reynolds numbers (less than 100) should be treated separately when determining if corrections 
are needed for fittings and losses. There are conflicting CFD studies and lab tests showing that 
corrections are needed, or are not needed. For additional details please see the below journal 
articles:

 l No corrections needed at low Re
 l Liou, R. J., et.al,  “Numerical Analysis of Steady Flow in a 90-deg Circular Section 

Bend”,  J. Eng. Mech., v. 114 (1988), p. 1871.
 l Berger, S. A., et.al, “Flow in Curved Pipes”, Ann. Rev. Fluid Mech., v. 15 (1983), p. 

461.
 l Corrections needed at low Re

 l Edwards, M. F., et.al,  “Head Losses in Pipe Fittings at Low Reynolds Numbers”, 
Chem. Eng. Res. Des., v. 63, (Jan 1985), p. 43.

 l Kittredge, C. P. and Rowley, D. S., “Resistance Coefficients for Laminar and Tur-
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bulent Flow Through One-Half-Inch Valves and Fittings”, Trans. ASME, v. 79, 
(Nov. 1957), p. 1759.

Related Topics

Laminar and Non-Newtonian Corrections Panel 165
Adjusted Turbulent K Factor (ATKF) Method 167
Improved ATKF Method 170

Related Blogs

Applying the Improved ATKF Method for Laminar and Non-Newtonian Flow

SSL Module Fluid Properties Group
(SSL Module Only) When the Settling Slurry (SSL) Module is activated on the Modules Panel, 
the items in the Fluid Properties Group change to allow slurry physical property calculation.

Engineers who are new to slurry calculations may not recognize some of the properties in the fol-
lowing panels. These properties all relate to the theory of slurry calculations, which is discussed 
in the Slurry Calculation Methods section.

 l Carrier Fluid Panel - Define the Carrier Fluid Properties
 l Solids Definition Panel - Define the Solids Specifications such as M (Stratification Ratio 

Exponent), Terminal Velocity Parameter, density, d50, and d85
 l Slurry Definition Panel - Define the Slurry Model and Slurry Properties

Related Topics

Carrier Fluid Panel 174
Solids Definition Panel 176
Slurry Definition Panel 179
SSL - Settling Slurry 641
SSL Nomenclature 651

Carrier Fluid Panel
(SSL Module Only) On the Carrier Fluid panel, users select and define the carrier fluid for the 
slurry. The available options are:

 l Basic (Water)
 l Advanced
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Basic (Water) Carrier Fluid

The Basic (Water) option uses the Water (liquid) fluid from the AFT Standard fluid library as the 
carrier fluid and treats all pipes as having constant slurry properties (Figure 1).

Specify the water temperature for the slurry property calculation.

Figure 1: Carrier Fluid panel with the Basic (Water) carrier fluid option selected

Advanced Carrier Fluid

The Advanced option  allows the user to specify any fluid as the carrier fluid, and will allow the 
slurry properties to vary among pipes.

The Carrier Fluid panel looks very similar to the Fluid panel when the SSL module is not activ-
ated. Specify the fluid, its temperature (and pressure in some cases), and fluid property variation 
on this panel. Users can access data from all fluid libraries. The User Specified Fluid option is dis-
abled because it is not saved in a library. Custom fluids should be saved to a library and selected 
using the User Library Fluid option.
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Figure 2: Carrier Fluid panel with the Advanced option selected

Related Topics

SSL Module Fluid Properties Group 174
Solids Definition Panel 176
Slurry Definition Panel 179
SSL - Settling Slurry 641
SSL Nomenclature 651

Solids Definition Panel
(SSL Module Only) On the Solids Definition panel, users define the Slurry Calculation Method 
and Solids Specifications. These inputs are the same for both the Basic (Water) and Advanced 
carrier fluid options.

Override options are provided for a number of parameters that allows users to modify data pulled 
from libraries should modeling requirements need this.
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Figure 1: Solids Definition Panel when Detailed Slurry Calculation Method and Calculated M are 
selected

Slurry Calculation Method    

There are three calculation methods available to model slurries. Each method requires different 
amounts of input data and uses different calculations. These calculations are described in the 
Slurry Calculation Methods section.    

 l Minimal Method - Used in the preliminarly design phase where only rough data is avail-
able. The solids density, sliding friction coefficient, and solids concentration are the only 
parameters needed. However, due to the minimal data used, the calculations should only 
be used for early stage approximations. This is a conservative method that assumes a 
fully-stratified sliding bed.      

 l Simplified Method - Additional information is required and gives a better solution. This 
method requires the solids density, d50 particle size, a user-specified M exponent, and 
the solids concentration. This method assumes heterogeneous flow withing suspended 
particles. The Simplified Method is a more accurate model than the Minimal method 
because it accounts for more slurry definition.      

 l Detailed Method - The default method, and the method which provides the most rigourous 
solution methodology. The solids density, d50 particle size, terminal velocity parameter, 
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and the solids concentration are required. Additionally, if the M exponent is calculated, the 
d85 particle size is required. As with the Simplified Method, this method also assumes het-
erogenous flow with suspended particles. 

Solids Specifications

In the Solids Specification area, select from the following options for solids:

 l No Solids Added - The model will run using the carrier fluid without any solids, no further 
input is required.

Note: The No Solids Added option is only compatible with the Newtonian Slurry Model 
option on the Slurry Definition panel. The other Slurry Models imply that solids 
are present in the fluid, therefore, the Slurry Definition panel will be undefined 
until the Solids Specifications is changed to one of the options below.

 l User Specified Solids Added - Define the solids using the Solid Properties fields.
 l From Library - use solids already defined in the Solids Library. Note no default solids lib-

rary is provided by AFT. Library items must first be defined in the Library Manager to be 
available here.

Solids Properties    

By selecting User Specified Solids Added, the Solids Properties fields become available to 
define the solids. Depending on the Slurry Calculation Method selected on the Slurry Model 
Panel, certain fields are required:

 l Minimal
 l Density

 l Simplified
 l User Specified M (Stratification Ratio Exponent)
 l Density
 l d50

 l Detailed
 l M (Stratification Ratio Exponent)
 l Terminal Velocity Parameter
 l Density
 l d50
 l d85 - if Calculated M (Stratification Ratio Exponent) is selected

The M (Stratification Ratio Exponent) is a parameter in the stratification ratio equation. The 
user can allow AFT Impulse to calculate M based on best available methods, or input M directly. 
The process of estimating M from recorded data is discussed elsewhere.
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The Terminal Velocity Parameter must be entered when using the Detailed calculation 
method. This can be entered as either a Shape Factor (K) or the ratio of the particle’s terminal 
velocity (Vt) to that of a sphere (Vts), designated as Vt / Vts (Xi). If a Shape Factor is entered, it is 
used in conjunction with the graph shown in Wilson (2006), on page 47, to obtain a value for Xi. 
Typical shape factors are given in Wilson, et al, 2006, on page 46 where K = 0.26 for sand.

In the lowest area, enter the required values for mean density of the solid particles, d50 (mass-
median particle diameter) and d85 (diameter for which 85% by mass of the particles are finer).

4-Component Slurry Model

The 4-Component Slurry Model requires a d100 and Particle Size Distribution.

Related Topics

SSL Module Fluid Properties Group 174
Carrier Fluid Panel 174
Slurry Definition Panel 179
SSL - Settling Slurry 641
SSL Nomenclature 651

Slurry Definition Panel
The Slurry Definition Panel allows input of solids concentration relative to the carrier fluid and 
estimation of bulk slurry properties, as shown in Figure 1.

Override options are provided for a number of parameters that allows users to modify data pulled 
from libraries should modeling requirements need this.
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Figure 1: Slurry Definition Panel when Detailed Slurry Calculation Method and User Specified Solids 
Added are selected

Slurry Calculation Method    

There are three calculation methods available to model slurries. Each method requires different 
amounts of input data and uses different calculations. These calculations are described in the 
Slurry Calculation Methods section.    

 l Minimal Method - Used in the preliminarly design phase where only rough data is avail-
able. The solids density, sliding friction coefficient, and solids concentration are the only 
parameters needed. However, due to the minimal data used, the calculations should only 
be used for early stage approximations. This is a conservative method that assumes a 
fully-stratified sliding bed.      

 l Simplified Method - Additional information is required and gives a better solution. This 
method requires the solids density, d50 particle size, a user-specified M exponent, and 
the solids concentration. This method assumes heterogeneous flow withing suspended 
particles. The Simplified Method is a more accurate model than the Minimal method 
because it accounts for more slurry definition.      

 l Detailed Method - The default method, and the method which provides the most rigourous 
solution methodology. The solids density, d50 particle size, terminal velocity parameter, 
and the solids concentration are required. Additionally, if the M exponent is calculated, the 
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d85 particle size is required. As with the Simplified Method, this method also assumes het-
erogenous flow with suspended particles. 

Slurry Definition

The Concentration Type is used to specify a value in the Amount Solids Added field. The 
available options for Concentration Type are:

 l Grams per Liter of Mixture
 l Volume Fraction
 l Mass Fraction
 l Solids Ratio (M-solids/M-liquid)

There are a few Slurry Model options to choose from. These options determine the calculations 
used in the Solver. 

 l Newtonian - Functionally disables most of the SSL module calculations and preserves 
only the viscosity properties of the fluid in the model.

Note: The No Solids Added option from the Solids Definition panel is only compatible 
with the Newtonian Slurry Model option. If you have already specified solids on 
the Solids Definition panel, you must select one of the other Slurry Models 
below.

 l Settling Slurry - Wilson, Addie, Clift - Default option, applies slurry calculations from 
Wilson.

 l 4-Component Model - GIW Industries Inc. - A more complex model that takes into con-
sideration the contribution of different size particles in the slurry flow.

The Sliding Friction Coefficient (μs) is the coefficient of mechanical sliding friction between 
the granular mass and the boundary - where the boundary is the where the motion takes place 
between the mass and a rigid boundary, i.e. the pipe wall. As  the Sliding Friction Coefficient 
increases, so does the friction and thereby the pressure drop through the pipe. This field is only 
available when the Minimal Slurry Calculation Method is selected at the top of the panel.

The Bed Concentration (Cvb) is an optional parameter and is only used to determine the actual 
settling velocity (Vs) shown in the output. These calculations are described in Wilson (1986) and 
are functions of the pipe diameter, particle size (d50), particle density and relative concentration. 
If no value is entered for this parameter then a default of 0.60 is used. The maximum value of 
these settling velocities (Vs) is denoted as Vsm and is the usual parameter of interest in design-
ing a system to avoid operating with a stationary bed. This field is only available when the Sim-
plified and Detailed Slurry Calculation Methods are specified at the top of the panel.

Deposition Velocity (Vsm)

The Deposition Velocity (Vsm) can be determined using one of the options below. This is useful 
when the calculation method yields a slightly different value than, say, test results.
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 l Nomograph - Equation Limited - This option is the default and uses the nomograph 
from Wilson (1986) page 111. The nomograph is noted to be conservatively high by 
Wilson, so an equation that calculates the max Vsm is used to limit the value of Vsm.
The results calculated from the nomograph will be checked against Equation 5.11 from 
Wilson (1986) as is shown below. If the value from the nomograph exceeds Vsm,max cal-
culated from Equation 5.11, then the Vsm,max from Equation 5.11 will be used instead.

Note: If the Vsm is calculated as a negative value using Equation 5.11 from Wilson then the 
Vsm will be displayed as 0 in the Output. If the Vsm is shown as 0, the inputs for the fluid 
and solid should be verified, and the user should consider calculating the Vsm using a 
separate method.

 l Equation Only - This option will cause the Vsm to be calculated solely using Equation 
5.11.

 l User Specified - This option allows the user to directly specify Vsm.

As Wilson describes there are times where operating at a velocity lower than Vsm is eco-
nomically attractive and is without a stationary bed. These cases include a system where the 
solid concentration at the desired operating point is very different than that at the Vsm conditions. 
Wilson points out that this is rarely the case, and so the use of Vs instead of Vsm should be done 
with caution.

Related Topics

SSL Module Fluid Properties Group 174
Carrier Fluid Panel 174
Solids Definition Panel 176
SSL - Settling Slurry 641
SSL Nomenclature 651

Pipes and Junctions Group
The Pipes and Junctions Group in Analysis Setup has one item: the Pipes and Junctions Panel. 
When the Pipes and Junctions group has a green checkmark next to its name, all pipes and junc-
tions are fully defined. When a red exclamation point is next to its name, there is at least one pipe 
or junction that is undefined. The model cannot run until all pipes and junctions are defined.

Related Topics
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Pipes and Junctions Panel 183

Pipes and Junctions Panel
The Pipes and Junctions panel within Analysis Setup displays the status of pipes and junctions 
within the model. 

Figure 1: Default state of the Pipes and Junctions panel

This panel is made up of three sections:

 l Undefined Pipes
 l Undefined Junctions
 l Undefined Properties

The Undefined Pipes and Undefined Junctions sections display the number and name of all 
pipes and junctions, respectively, that are not fully defined. If all pipes and junctions in the model 
are fully defined, the messages "All Pipes Are Defined" and "All Junctions Are Defined" will be 
displayed. Clicking on the undefined pipe or junction will display the undefined properties in the 
list below, as shown in Figure 2. All undefined data for all objects can be saved to the file or 
copied to the clipboard. Any undefined object's Properties window can be launched by double-
clicking the object's name in the list to finish defining the object.
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Figure 2: Pipes and Junctions panel with one pipe undefined and undefined properties displayed

Related Topics

Pipes and Junctions Group 182

Pipe Sectioning and Output Group
The Pipe Sectioning and Output Group in the Analysis Setup window has three items: the Sec-
tioning panel, Output Pipe Stations panel, and Output Junctions panel. These panels control the 
sectioning used for the transient solution, as well as what output is saved to the file for the pipes 
and junctions.

 l Sectioning panel - Required panel. The pipe sectioning used for the transient Method of 
Characteristics solution is defined here. Some settings on this panel will change when the 
PFA Module is activated and enabled.

 l Output Pipe Stations panel - Optional panel. This panel controls which pipe stations are 
saved to file.

 l Output Junctions panel - Optional panel. This panel controls what transient junction out-
put is saved to file, such as pump speed, valve Cv, etc. 

Related Topics

Transient Control Group 191
Junction Transient Data 287
Infinite Pipe 289
Waterhammer Assistant 500
Initiation of Transients 290
Multi-Condition Events 295
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Sectioning Panel
Before running a transient simulation, the pipes must be sectioned as described in Pipe Sec-
tioning - Introduction to Method of Characteristics. This forces a common time step, and forces 
the section length to be equal to the product of the pipe wavespeed and time step. The Sec-
tioning panel controls how the pipes are sectioned.

Sectioning is a required item in the Analysis Setup window when transient simulation is enabled.

Figure 1: The Sectioning panel

This window automates the selection of an appropriate sectioning scheme for a particular model.

Clicking Update Results analyzes the system based on the length and wavespeed of every pipe. 
The sectioning window automatically selects the lowest number of sections in the controlling 
pipe that will produce a Maximum Variance below the accepted amount. This accepted amount 
defaults to 10%, but can be changed as discussed below in Sectioning Options. The meaning of 
Variance is discussed in Pipe Sectioning - Introduction to Method of Characteristics.

The Selected Sectioning for Model area shows the effects of the currently selected sectioning on 
the controlling pipe, as well as the overall time step required.

Note: Be careful when selecting the number of sections. The run time required increases with 
the number of sections squared, so the number of sections should be minimized where 
possible. There is not a direct correlation between number of sections and accur-
acy of results. It is not good practice to increase the number of sections to obtain more 
accurate results. For large models it may be wise to accept additional variance for the 
decrease in run time, at least for preliminary runs.
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Sectioning Options

 l Search up to X sections in Controlling Pipe - the number of sectioning options to 
search up to can be defined here. This can help prevent unnecessary searching in large 
models, or allow additional sections in models where it is required.

 l Join Pipes/Junctions - The Join Pipes/Junctions utility is accessible here. Joining pipes 
can greatly reduce model run time in many cases. See Minor Wave Reflections.

 l Advanced Settings
 l Show Detailed Searching Options - This allows for searching a certain range. 

This is useful if you do not want to spend time searching for low numbers of sec-
tions when it is already known that these are unacceptable.

 l Maximum Allowable Variance - This has no effect on the model, it only affects 
which rows are deemed unacceptable (colored red) and which entry is auto-
matically selected.

 l Search Options
 l Bandwidth - How far away from the specified number of sections should be 

searched.
 l Increment - How many individual points should be tested. The searching 

algorithm will check all of the pipes for all combinations in a 2*Bandwidth 
range at Increment intervals. Small Increment and large Bandwidth could 
potentially find a better result at the cost of computational time.

 l Show Sectioning Details - This shows the resulting number of sections, variance, and 
other information about every pipe in the model for the selected sectioning.

Numbering Convention for Pipe Sectioning

Once a pipe is broken into sections, computation takes place where the sections join together. 
These are called pipe stations. The total number of stations in a pipe is equal to the number of 
sections plus 1. The station at the beginning of the pipe is numbered zero.

Figure 1: Computing Stations (blue) exist at the boundary of every section (green)
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To observe parameters at the inlet or outlet of a junction, view the station adjoining the junction. 
In the above example, the inlet to the valve is P1, Station 3 and the outlet is P2, Station 0.

Related Topics

Sectioning Panel with PFA Module 187
Pipe Sectioning - Introduction to Method of Characteristics 66

Sectioning Panel with PFA Module
(PFA module only) In AFT Impulse (with or without the PFA module), the pipes are sectioned in 
order to comply with the Method of Characteristics. You can read about pipe sectioning in the 
Method of Characteristics Pipe Sectioning topic. Essentially, the pipe with the smallest L/a value 
is the controlling pipe, and the maximum time step will be equal to Equation 1.

(1)

In the traditional AFT Impulse, the Sectioning panel will display from one section in the con-
trolling pipe (that is, the pipe with the least number of sections) to the specified number of sec-
tions in the controlling pipe.

However, in the PFA module, the pipe sectioning must be further refined to prevent any number 
of pipe sections in the controlling pipe that results in a time step larger than the Maximum Time 
Step Based on Cutoff Frequency, which is calculated using Equation 2.

(2)

Figure 1 shows the modified Sectioning panel that is used in the PFA module.
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Figure 1: Sectioning panel in the PFA Module

In Figure 1, this example shows that the when the controlling pipe has one section, the time step 
is still large enough for the Cutoff Frequency. However, if the Maximum Time Step Based on 
Cutoff Frequency was larger than the 0.001 seconds shown here,  the option for one section in 
the controlling pipe would not be shown. Note that the number of sections in the controlling pipe 
can drastically affect the model run times, so it is recommended to select the smallest amount of 
sections in the controlling pipe as possible.

A feature unique to the PFA module in the Sectioning panel is the ability to exclude certain pipes 
in the sectioning variance or modification calculations. This allows the user to use pipes to model 
dampeners or devices that are not strictly a pipe. To exclude certain pipes from the sectioning 
calculations, ensure that the box next to the pipe in the Sectioning panel is unselected. These 
pipes will still be sectioned based on time step.

The Pulsation Settings section of the Sectioning panel automatically calculates the Block Size 
based on Equation 3.

(3)

The Sectioning panel allows you to specify the Simulation Duration. The minimum required Sim-
ulation Duration is automatically calculated.
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Note: The Simulation Duration and Output File Setting inputs are located on the Simulation 
Mode/Duration panel when the PFA module is not activated.

Once the sectioning has been completed, click on the Show Pulsation Graphs icon on the bot-
tom of the Sectioning panel to see graphs of the Pulse, the FFT of the Pulse, the LPF of the 
Pulse, and the FFT of the LPF. Close out of the graphs, and then click OK to accept the pipe sec-
tioning.

When you exit the Sectioning panel after fully defining the sectioning, a message appears inform-
ing you that the PFA module will now place the forcing function onto the junction you selected as 
transient data. Click OK. You will notice that the forcing function has now been input in the spe-
cified junction Properties window on the Transient data tab.

Note: If the forcing function is being added to a pump junction the pump must be defined as a 
positive displacement pump with a steady flow rate. This requirement is in place to 
avoid artificial transients in the system.

Related Topics

Sectioning Panel 185
Pipe Sectioning - Introduction to Method of Characteristics 66
PFA - Pulsation Frequency Analysis 631
Pulse Setup Panel 196
PD Pump Settings Panel 197
Steady-State Pulsation Tolerance 640
PFA Pump RPM Evaluation 632
PFA Module Glossary 640
API 674 Evaluation 638

Output Pipe Stations Panel
The Output Pipe Stations panel allows specific calculation stations to be saved to the output file. 
Similar to only saving a subset of time steps, saving only certain stations reduces the amount of 
space required. This does not affect the results of the simulation.

For most purposes, saving only the Inlet and Outlet stations of each pipe is sufficient. There are 
several reasons to save more data than this:

 l If you are interested in the transient behavior at a specific point other than the inlet or out-
let, that point must be included. For example, an analysis of a long pipeline with the 
default options will not permit graphing the pressure over time at the center of the 
pipeline. Adding the appropriate station to the output file will allow this.

 l Related, a profile graph of a pipe with many sections will become more rep-
resentative of the simulation results if more points are available to plot.

 l Animating a profile plot from the output file requires that all of the stations in the pipes com-
posing the path are saved.
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To change the saved stations for multiple pipes at once, check the box next to the pipes to be 
changed, then change the update the dropdown box next to "Change Selected Pipes To" to the 
desired option, and click the "Change Selected Pipes To" button to make the change.

Figure 1: Output Pipe Stations panel

Related Topics

Animating Graph Results 91
Animation Layers 96
Graph Results Window 541

Output Junctions Panel
The Output Junctions panel allows additional parameters to be saved to the output file for some 
junctions. In general, most relevant data can be obtained from the connected pipes. However, 
certain data is not available directly from the pipes - for example, Spray Discharge outflow or 
Pump speed.

The output saved from the Output Junctions panel allows Transient Junction graphs to be cre-
ated for the listed parameters. By default all junction output will be saved except branch flow rate 
data. However, junction data can be excluded to reduce model run time and file size if the out-
puts for that junction are not required for analysis.

The Output Junctions panel for a model with Spray Discharge and Pump junction output being 
saved is shown below in Figure 1.
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Figure 1: Output Junctions panel

Related Topics

Graph Results Window 541
Graph Types 547

Transient Control Group
The Transient Control group in Analysis Setup allows the user to specify transient parameters 
such as the simulation duration, cavitation model, transient friction calculation method, and tran-
sient checkpoints. Only the Simulation Mode/Duration panel is required to run the model.

 l Simulation Mode/Duration panel - Required panel. Contains the controls for simulation 
type, simulation duration, and options to save less output to file.

 l Cavitation panel - Optional panel. Allows specification of the cavitation model used and 
relevant model parameters.

 l Transient Friction panel - Optional panel. Allows selection of the transient friction cal-
culation method.

 l Transient Checkpoints panel - Optional panel. Allows specification of when to create 
checkpoint files used to continue transient simulation.

Related Topics

Pipe Sectioning and Output Group 184
Junction Transient Data 287
Infinite Pipe 289
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Waterhammer Assistant 500
Initiation of Transients 290
Multi-Condition Events 295

Simulation Mode/Duration Panel
This panel contains settings that are required for a transient simulation, most of which affect the 
simulation itself.

Time Simulation

The Time Simulation section defines the type of analysis that will be performed, Steady Only or 
Transient.

Transient selected by default. A transient simulation always performs a steady-state analysis 
first, and then proceeds to the transient solution. It can be useful for both design and 
troubleshooting purposes to run the steady simulation on its own.

These options can also be toggled from the Analysis menu Time Simulation item.

Simulation Duration

As the name implies, this setting controls the duration of the simulation. The total number of time 
steps required for the specified interval is shown. Note that the Start Time can be a value other 
than zero. This does not mean that the solver is able to start mid-transient. This is only a ref-
erence value, and will affect events defined according to the simulation time. If no such events 
exist, only the specified duration will impact the overall output.

Save Output to File

 l Every Time Step - Default selection. Every Time Step is saved to the output file. For long 
simulations, a very large number of time steps may be required. This will correspondingly 
require a very large amount of data if this is selected.

 l Every X Time Steps - To reduce file size, only a subset of the data can be saved to file. 
This will not affect the solution, but will affect the presentation of results in Output and 
Graph Results. Generally, transient behavior is sufficiently linear that this does not affect 
the interpretation of the results. However, in some instances - especially when transient 
cavitation is present - this may "skip over" short duration spikes in pressure. Note that the 
maximum and minimum values reported in the Output tab are tracked throughout the sim-
ulation and remain valid regardless of this selection. Maximum and minimum lines on a 
profile graph may be affected, causing an apparent discrepancy.
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Transient Simulation Estimations

 l Estimated Output File Size - The size of the resulting output file can be accurately estim-
ated because it is known beforehand what data is being saved, for how many stations, 
and for how many time steps.

 l Estimated Run Time - The estimated time to run the model is much more difficult to 
estimate. This should be considered an extremely rough estimate - a better estimate can 
be obtained by beginning the transient simulation and observing how long it takes to 
reach 2% complete. The transient simulation process is generally quite linear with time, 
so a complete solution will take approximately 50 times longer than this.

Figure 1: Simulation Mode/Duration panel

Related Topics

Initiation of Transients 290

Transient Cavitation Panel
The Transient Cavitation panel contains settings for the transient cavitation models.    

Transient Cavitation modeling can be enabled or disabled using the check box next to Model 
Transient Cavitation. Transient cavitation modeling is enabled by default, and it is strongly 
recommended to keep it enabled. Some situations exist where it can be beneficial to disable 
cavitation modeling for troubleshooting purposes. When cavitation modeling is enabled, Impulse 
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will use the fluid’s vapor pressure and the selected cavitation model to capture transient cavit-
ation. When cavitation modeling is disabled, the Method of Characteristics solution will be 
allowed to calculate pressure below the fluid’s vapor pressure and even below absolute zero.   

Two cavitation models are available: the Discrete Vapor Cavity Model (DVCM) and the Discrete 
Gas Cavity Model (DGCM). DVCM is the default model due to the lower computational com-
plexity and simulation run time.   

DGCM is the more advanced model and contains several additional parameters which are all 
defined by default. The user can modify the DGCM parameters under the Advanced Cavitation 
Options if desired, but the default values are strongly recommended.   

Further detail regarding the transient cavitation models and inputs can be found on the Cavit-
ation Models theory page.   

Related Topics

Cavitation 69
Transient Cavitation Models 707
Interpreting Cavitation Results 100

Related Blogs

How does AFT Impulse model cavitation?

Transient Friction Panel
Impulse provides several options for modeling the pipe friction during the transient simulation:

 l Constant - The pipe frictional resistance (shear stress) obtained in the steady-state part 
of the simulation will be used as a constant in the transient part of the simulation

 l Time Varying - The pipe friction will differ for each pipe section because the flowrate (and 
hence Reynolds number) is varying along the pipe due to the fluid transient. Further, the 
resistance will vary with time as the flowrate changes.

 l Simple: A steady state approximation of the pipe frictional resistance (shear 
stress) will be calculated as the fluid velocity for each pipe station changes by more 
than 1%. In AFT Impulse 7 and earlier, this model was included as the "Use Vari-
able Pipe Resistance" option.

 l Advanced - Unsteady Brunone: This model uses the same calculation method 
as the Simple model described above, with the addition of an unsteady shear 
stress term which varies based on the velocity at the current time step. The 
unsteady term is calculated using an unsteady friction model commonly referred to 
as the "Brunone" model. This calculation is a more theoretical model than the 
Simple Time Varying model, and should be used with caution. See Adamkowski 
and Lewandowski (2006) for more information.
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Which Friction Model to Use

The three friction models available in AFT Impulse are each intended for different use cases. 

The Constant friction model is best used when flow in the simulation stays in the turbulent or 
highly turbulent regimes. Here, pipe friction is either weakly dependent on flowrate (turbulent 
flow) or independent of flowrate (highly turbulent flow in the Fully Rough zone of the Moody 
chart). As a result, the friction factors determined in the steady state system likely remain valid 
throughout the transient simulation. 

The Time Varying - Simple friction model is best used when zero or low flow is seen in some 
pipes either in the steady state system or in the transient simulation. This situation could arise 
when events like pump startups or valve closures are being modeled. Using the steady state fric-
tion factor throughout the transient simulation could lead to incorrect estimations of pressure 
drops in the system, especially when there is zero flow in a pipe during steady state. 

The Time Varying - Advanced friction model is best used when it is important to account for the 
effects that a change in velocity have on pipe friction. The Time Varying - Simple model assumes 
that each velocity pipe friction factors are calculated for is a 'steady state' velocity, and that a 
change in fluid velocity does not lead to any additional friction losses other than the friction factor 
changing. The Time Varying - Advanced model adds in an unsteady shear stress term that helps 
to account for velocity changing. In models that see flow in a pipe change direction, this term can 
have a large impact on the transient results. 

Note: Both Time Varying friction models require additional calculations and run time when 
compared to the Constant friction model. Experience suggests that the Time Varying - 
Simple model increases run time by 20% while the Time Varying - Advanced model  
increases run time by roughly a factor of three. 

Related Topics

Pressure Drop in Pipes - Detailed Discussion 261

Related Blogs

Five Fantastic New Features for Fast Fluid Transients: Impulse 8

When Should You Use Variable Pipe Resistance?

Pulsation Setup Group
(PFA module only) The Pulsation Setup group in Analysis Setup allows you to define the pulsa-
tion analysis parameters.

There are two panels which are required for frequency analysis with a PD pump.
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 l Pulse Setup panel - Required panel. The Pulse Setup panel allows the user to define prop-
erties of the pulse including the source, cutoff frequency, low-pass filtering, and mag-
nitude.

 l PD Pump Settings panel - Optional panel. This panel is only required if the pulsation 
source is specifed as a PD pump.

Pulse Setup Panel
(PFA module only) The Pulse Setup panel allows the user to define properties of the pulse 
including the source, cutoff frequency, low-pass filtering, and magnitude.

Pulse Properties

The Pulse Properties section allows you to specify the junction that will act as the source of the 
pulse, as well as the start time and magnitude of the pulse. By default, the magnitude of the 
pulse is twice the steady-state flow, but you have the option to define this magnitude as “User 
Specified”. This pulse will be assumed to last for two time steps and then return to steady-state 
flow. The pulse can only be applied to specific junctions, including a fixed flow pump or an 
assigned flow junction (these can be specified on a fixed steady mass flow or volumetric flow 
basis).

Cutoff Frequency

The PFA module will filter out content above the cut-off frequency (the expected maximum fre-
quency) while passing content below this frequency through. If the pulsation source has been 
modeled as a PD pump, the cutoff frequency will be calculated using Equation 1:

(1)

where:

 l n is the number of pump heads
 l N is the pump speed

Equation 1 is a typical rule-of-thumb that is somewhat arbitrary. As the analyst, you may have 
good reason to select a value different from this, so the option to define a User Specified Cutoff 
Frequency is also available.
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Low-Pass Filtering

Frequencies above the cutoff frequency are not of interest for pulsation analysis, so a low pass fil-
ter is applied to simplify the analysis.

The filter type is the filter used to calculate which signals to pass. The Chebyshev filter is the only 
filter available in the PFA module. The default low-pass filter settings should be sufficient for 
most analyses. These settings should not be changed without an understanding of digital signal 
processing, such as can be found in Vazquez et. al, 2012.

Pulsation Source

The pulsation source section allows you to specify what will be applying the pulsation. Most com-
monly, users model the pulsation caused by a PD pump. Specifying the Pulsation Source as a 
PD Pump and inputting the number of heads, the pump speed, and speed buffer will allow the 
PFA module to automatically calculate the cutoff frequency. The speed buffer default is 15%, 
and this accounts for modeling uncertainties. This buffer is customizable.

Modeling the pulsation source as Other is used if the pulsation results from something other than 
a pump, such as a valve that is chattering. If this option is used, the natural frequencies can be 
graphed, but other PD Pump specific features will not be available.

Related Topics

PD Pump Settings Panel 197
PFA - Pulsation Frequency Analysis 631
Sectioning Panel with PFA Module 187
Steady-State Pulsation Tolerance 640
PFA Pump RPM Evaluation 632
PFA Module Glossary 640
API 674 Evaluation 638

PD Pump Settings Panel
If a PD pump is the source of pulsation, the PD Pump Settings panel is required to calculate the 
pump flow forcing function which is used in the Pump Speed child scenarios.

The required pump properties are as follows:

 l Minimum Pump Speed - affects the lower range of pump speeds at user-selected fre-
quencies after the model has been run

 l Bore - diameter of PD pump bore
 l Stroke - pump stroke length
 l Rod Length - connecting rod length of pump slider crank
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 l Clearance - clearance ratio of cylinder expressed in volume units or percent of swept 
volume (dead volume/swept volume), also often referred to as Dead Volume in literature

 l Suction Pressure - average suction pressure
 l Discharge Pressure - average discharge pressure

Related Topics

Pulse Setup Panel 196
PFA - Pulsation Frequency Analysis 631
Sectioning Panel with PFA Module 187
Steady-State Pulsation Tolerance 640
PFA Pump RPM Evaluation 632
PFA Module Glossary 640
API 674 Evaluation 638

Forces Group
The Forces group in Analysis Setup has one item: the Forces panel. By default, the Forces 
group is fully defined and will have a green checkmark next to its name.

Force Definitions Panel
AFT Impulse includes the ability to calculate transient hydraulic forces, which occur when a tran-
sient pressure wave passes through a portion of the system.

Note: As AFT Impulse is only a hydraulic solver, only hydraulic forces are accounted for. AFT 
Impulse is not a pipe stress analyzer and as such does not have the ability to directly 
model piping supports or similar objects. Hydraulic force files can be generated for 
import into software designed for force analysis.

Defining Force Sets from Analysis Setup

In order to process force data, the locations where the forces are to be calculated must be 
defined. Force Sets can be defined from the Force Definitions panel of the Forces group in Ana-
lysis Setup.
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Figure 1: Force set data is defined on the Force Definitions panel in the Analysis Setup window

 l New - Add a new force set to the table.
 l Duplicate - Copy an existing force set.
 l Delete/Delete All - Remove the selected force set / remove all force sets.
 l Swap Nodes - The calculation will be the same, but the sign of the force will be reversed. 

This may be important for proper interpretation of results or for exporting data to other 
applications.

 l Set To End Length - Automatically set the selected length field to the pipe length.
 l Import from CSV - If force sets are defined in another application or by hand they can 

easily be imported with a comma separated value file. Click the Import from CSV button 
for an explanation on the required format.

 l Generate Force Names - Automatically changes the names for the selected force sets to 
"upstream junction name - downstream junction name" using the names from the con-
nected junctions on the workspace.

 l Point Force Ambient Pressure - If using a Point force set, the ambient pressure is 
required to calculate the force balance. This defaults to the Environmental Properties 
panel value, but can be changed here.

Each individual force set has a number of required parameters:

 l Force Type - There are several force set types available. They are described in detail in 
Force Set Types.

 l Force Set Name - A unique name for the force set.
 l Start Pipe - Where the first  node is located.
 l Length To Start Node - The length from the beginning of the pipe to where the force set 

starts.
 l Start Station (Actual Length) - Because calculations must be performed at calculation 

stations (nodes), the exact length entered in the previous field may not be a valid cal-
culation point. In this case, the nearest valid node will automatically be determined and 
displayed here. Keep in mind that the actual force set is between the two "Actual 
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Length" fields, and can be different than the entered values.
 l End Pipe- The second node (for difference types). Note that the selection must be valid 

for the specified force type. See Force Set Types.
 l Length To End Node - The length from the start of the pipe to the end node.
 l End Station (Actual Length) - As described above, the nearest calculation station to the 

entered length.
 l Exit Area - For Exit force types, an exit area is required.
 l Force Unit Vector Coordinates - Define unit vectors for your linear pipe to give the res-

ulting forces a three-dimensional direction. Impulse is still only a one-dimensional fluid 
modeling software, and specifying a unit vector will not change the force calculations. 
However, by defining the XYZ vector for a given force set, that data can be brought into 
other software for further analysis using the Export Force Data tool. These unit vectors 
should be defined based on the coordinate system in the force stress analyzing software 
that the force sets will be exported to.

Defining Force Sets from the Workspace

Force Sets for individual pipes can be defined directly from the Workspace by right-clicking on a 
selected pipe. Choose the Create Force Set With Selected Pipe... option to launch the Create 
Force Set window, shown below in Figure 2. If multiple pipes are selected, an individual Dif-
ference Force Set will be created for each pipe applying the specified settings for each.

Figure 2: Create Force Set window in the Workspace

Each force has several required and optional parameters:

 l Pipe Name - If the pipe has a name entered other than 'Pipe', the user can choose 
whether to include that pipe name or not in the Force Set name. 
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 l Force Set Name - Users can add a name for the Force Set to better organize and man-
age Force Sets in the model. 

 l Force Unit Vectors or Length - Define unit vectors for your linear pipe to give the res-
ulting forces a three-dimensional direction. Impulse still only a one-dimensional fluid mod-
eling software, and specifying a unit vector will not change the force calculations. 
However, by defining the XYZ vector for a given force set, that data can be brought into 
other software for further analysis using the Export Force Data tool. These unit vectors 
should be defined based on the coordinate system in the force stress analyzing software 
that the force sets will be exported to. 

 l Show Analysis Setup Force Definitions after Creation - If checked the user will be 
brought to the Force Definitions panel of the Analysis Setup window to view all Force Set 
information defined for that scenario.

Related Topics

Transient Forces 79

Steady Solution Control Group
The user has control over a number of parameters that influence numerical convergence of the 
steady state solution.

Note: These values should only be changed by experienced users or under advisement by 
AFT Support. Poorly defined Solution Control settings can cause the model to 
converge on an incorrect solution without warning messages.

 l Tolerance panel - The iterative tolerances that define convergence for the steady state 
solution can be defined on this panel.

 l Iterations panel - Additional iteration controls that can affect whether or not a model con-
verges for the steady state, or how quickly it will converge, can be defined here. Most set-
tings on this panel will not affect the final result.

Related Blogs

Having model convergence problems? Start here!

Tolerance Panel
An iterative approach is used to obtain pipe flow solutions. When approaching any analysis iter-
atively, a stopping point must be defined. The simplest approach is to stop after a certain number 
of iterations. However, this either results in uncertain results because the result is still changing, 
or wasted processing time because there are too many iterations.
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A solution is to use iterative tolerance. This tolerance is related to the change between iterations. 
When this change is smaller than the iterative tolerance, the solution is said to be converged. 
These settings are specified in the Tolerance panel.

Tolerance and Solution Accuracy

Iterative tolerance does not have any relationship to an engineering tolerance.

An engineering tolerance is a familiar term to most engineers - it is a permissible limit in variation 
of a parameter. A simple example is the length of a steel bar - an engineer might specify that this 
length must be 3 ± 0.01 meters. A steel bar manufactured by this specification is known to be 
within the engineering tolerance of the "true" or desired length. In other words, engineering tol-
erance describes an accuracy.

Iterative tolerances do not directly describe an accuracy. Convergence only means that the 
change between iterations was within the specified limit.

With sound iterative methods, and an appropriately specified iterative tolerance, the iterative 
solution will be close to the true solution. However, even with good settings, the iterative tol-
erance does not define how close the results are to the true solution.

If there is concern that the results may not be close enough to the true answer, the tolerances 
could be lowered and the results compared. If the results do not change appreciably, an appro-
priate tolerance was likely selected.

Avoiding False Convergence

It is important to keep the tolerance at least one order of magnitude smaller (two orders or more 
is recommended) than the relaxation. A false convergence can occur when the change from the 
old value to the new value is small enough to be within the tolerance because it is restricted by 
the relaxation. False convergence in the steady state can lead to artificial transients in the Tran-
sient Solver.

Absolute Tolerance

The absolute change method is generally more reliable for iterative solvers like the steady 
state solver for AFT Impulse because it is less sensitive to the magnitude of the solution, whether 
close to zero or very large. However, in principle, specifying absolute tolerance requires some 
knowledge of the final solution. If you specify mass flow convergence as sufficient when the flow 
no longer changes by 1 lbm/sec each iteration, then your solution will be compromised if the mag-
nitude is also near 1 lbm/sec. In this case it would be better to set the tolerance 3 or 4 orders of 
magnitude below the solution.
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Relative Tolerance

Relative tolerances, on the other hand, only check the relative change of the number. That is, 
each successive change is divided by the number itself. This removes the requirement to be 
knowledgeable about the steady state solution, but can give trouble for problems where one of 
the solutions is too close to zero (because the change is divided by a number close to zero, mak-
ing a very large number).

There are options for combining absolute and relative tolerance. You can tell AFT Impulse to 
assess convergence based on whether either an absolute or relative criteria is satisfied, or 
whether both absolute and relative criteria are satisfied.

Table 1 shows an example of how the four different criteria would be applied to a flow rate iter-
ations.

Table 1: Example of four tolerance methods for a mass flow rate example. Absolute tolerance = 
0.0005 lbm/s, Relative tolerance = 0.0001

Related Topics

Try Absolute Tolerance 796
Setting relaxation lower than relative pressure flow tolerance gives unreliable 
results 750

Related Blogs

Having model convergence problems? Start here!
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Iterations Panel

Relaxation

Relaxation slows iterative progress toward a solution reducing the destabilizing effect of non-lin-
ear systems. By default, the Solver implements an adaptive relaxation scheme that reduces the 
relaxation dynamically in response to highly non-linear features of the problem. Relaxation can 
be directly specified in the Iterations panel.

When applied to the flow solution, relaxation r is used as follows:

A relaxation of 1 is the same as no relaxation. Each iteration's prediction is used directly in the 
next iteration.

A relaxation of 0 is not allowed, as this would prevent the parameter from changing.

 l Flow Rate Relaxation - For highly non-linear systems, a flow rate relaxation of 0.1 is 
advised. Experience shows that using flow rate relaxation factors between 0.5 and 1 has 
limited usefulness. If a flow rate relaxation of 1 does not work, you should generally try 
flow rate relaxation parameters between 0.1 and 0.5. In more extreme cases, a flow rate 
relaxation factor smaller than 0.1 may be required.

 l Pressure Relaxation - Because of the nature of the matrix solver, experience indicates 
that if pressure relaxation is used, it should always be set to 0.5 or 1 to maintain stability.

Iteration Limit

 l Maximum Iterations - 50000 by default, sufficient for the vast majority of models. Most 
models converge in a relatively small number of iterations. This limit does not directly 
affect the solution.

 l Iteration Span for AutoDetect - If the Solver detects that no meaningful progress has 
been made to convergence within this many iterations, relaxation is automatically 
lowered. This also automatically adjusts tolerance.

Matrix Method

Network analysis requires solving complex matrices potentially thousands of times. Different 
methods may solve faster or slower, but have no bearing on results. The default method of Gaus-
sian Elimination is very robust and usually provides the fastest convergence.
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Iteration History

Iteration History shows a history of which pipe or junction is most out of tolerance, which is help-
ful for troubleshooting.

Related Topics

Lower the Flow Rate Relaxation 796
Review the Iteration History 797
Setting relaxation lower than relative pressure flow tolerance gives unreliable 
results 750
Solution Progress Window 499

Related Blogs

Having model convergence problems? Start here!

Environmental Properties Group
The Environmental Properties group in Analysis Setup has one item: Environmental Properties 
panel. By default, the Environmental Properties group is fully defined and will have a green 
checkmark next to its name.

Related Topics

Environmental Properties Panel 205

Environmental Properties Panel
The Environmental Properties panel, shown in Figure 1, controls the definition of the atmo-
spheric pressure, gravitational acceleration, and transition Reynolds number used to model the 
system.
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Figure 1: Default state of the Environmental Properties Panel

Environmental Properties

Specify the ambient pressure and gravitational acceleration values for the solver to use in the cal-
culations. By default, these values are 1 atm and 1 g, respectively.

Ambient Pressure

AFT Impulse uses a default atmospheric pressure of 1 standard earth atmosphere, or 14.696 
psia. This pressure is also used to convert absolute pressures to gauge pressures. Keep in mind 
that atmospheric pressure varies with altitude. A project at Sea Level should not have the same 
atmospheric pressure as a project at 8500 feet. Impulse can adjust the atmospheric pressure 
automatically using the Ambient Pressure vs. Elevation Table option. Users can input a pressure 
profile to adjust ambient pressure depending on a junction's elevation.

Gravitational Acceleration

The default for gravitational acceleration is 1 standard earth gravitational acceleration, or 32.174 
ft/s2. You can change this to a multiple of standard earth accelerations (that is, number of g's) 
according to the design environment for your system. In principle, the body force on a fluid sys-
tem does not have to be due to gravity.

If the Variable g feature in the Waterhammer section of User Options is enabled, users are also 
able to add a transient to the gravitational acceleration. This could be used for systems in rockets 
or on a centrifuge. 
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Transition Reynolds Number

AFT Impulse allows you to modify the transition Reynolds numbers. The default values are Reyn-
olds number less than 2300 is laminar and greater than 4000 is turbulent. In the transition zone a 
linear interpolation is assumed. This applies for friction factors.

Related Topics

Environmental Properties Group 205
Head loss, head rise, hydraulic gradeline, and energy gradeline output does not 
have meaning for zero g systems 764

Miscellaneous Group
The Miscellaneous group contains settings that are used infrequently. By default, the Mis-
cellaneous Group is fully defined, with a green checkmark next to its name, without any addi-
tional input from the user.

The Miscellaneous group has three panels:

 l Artificial Transient Detection panel - Contains controls to determine when an artificial tran-
sient has occurred and to help troubleshoot artificial transients

 l Threading panel - Allows the user to enable or disable threading for the transient solver
 l Advanced Parameters panel - Contains advanced parameters that can be used for 

troubleshooting purposes

Related Blogs

Are you for real? Understanding and Troubleshooting Artificial Transients in AFT Impulse

Artificial Transient Detection Panel
Artificial Transients are non-real fluid transients that occur when the steady-state results do not 
match the initial time step of the transient calculation. This mismatch will propagate an artificial 
wave through the system. If this Artificial Transient has significant magnitude and is not detec-
ted, it will interact with the real, physical transients being modeled and affect the results.

After the steady-state simulation has been completed, the results will be used as the initial con-
ditions for the Method of Characteristics solution. To check for an Artificial Transient, the Method 
of Characteristics solution is allowed to proceed a single time step without any user transients 
applied. Because the system should remain at steady-state without any imposed transients, the 
results after this "zero time step computation" should not change.
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The relative change in pressure and flow from steady-state to this "zero time step" is determined 
for each calculation station in the model. If any of these changes exceed the Artificial Transient 
Criteria, the simulation will be halted.

Figure 1: Halting of transient simulation when Artificial Transients are detected

Due to the nature of the changing calculation methods, it is possible that negligible differences 
between the two solutions will exist. While technically any difference no matter how small is an 
Artificial Transient, small differences are unavoidable in practice due to the differing solution 
methods. For this reason, the values are allowed to change within some tolerance. The Artificial 
Transient Detection panel provides several options to help troubleshoot and resolve artificial tran-
sients:

Note: See the Troubleshooting Artificial Transients topic for more information on how to 
change these settings appropriately.

Figure 2: Default Artificial Transient detection settings

 l Stop Run if Artificial Transient Detected - By default this option will be enabled, and 
Impulse will check for Artificial Transients and halt the transient solution if one is detected. 
This option to check for Artificial Transients can be disabled; however, the one and only 
reason for this option to be disabled is for troubleshooting the cause of an Artificial Tran-
sient. It should never be left disabled for non-troubleshooting simulations.

 l Artificial Transient Criteria (%) - The relative change that is considered small enough to 
ignore. For some models, it may be reasonable to increase this value. However, this 
depends in part on the nature of the Artificial Transient. In particular, it should be clear that 
allowing the Artificial Transient does not significantly impact the results before changing 
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this value.
 l Ignore Flows Less Than - Extremely small changes in flow can still be relatively high on 

a relative basis. For this reason, there may be Artificial Transients that meet the Artificial 
Transient Criteria but still have very little impact on the model. If this occurs in the model, 
small flows can be ignored in the detection, allowing the calculation to proceed. Again, 
when modifying this value it should be clear that the results are not significantly affected.

Related Topics

Troubleshooting Artificial Transients 107
Artificial Transient - Initial pressure/flow conditions at Pipe X Station Y are not 
steady (Error = Z%) 748

Related Blogs

Are you for real? Understanding and Troubleshooting Artificial Transients in AFT Impulse

Threading Panel
Threading is enabled by default to decrease the run time of Impulse models, but can be turned 
off here if desired. Threading does not affect results.

Advanced Parameters Panel
Advanced settings can be changed here. Users are strongly encouraged not to change these set-
tings from their defaults unless directed by AFT Support or for troubleshooting purposes.
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Working with Pipe and Junction Objects
This section focuses on interactions with the Pipe and Junction objects in the AFT Impulse work-
space. Topics include how to create pipes and junction objects, how to alter junctions already on 
the workspace, and how to ensure the inputs for objects are both correct and complete.    

Contents

Selecting and Finding Objects 211

Pipe Drawing Modes 216

Selecting and Finding Objects
AFT Impulse has a number of methods to assist in selecting multiple objects at once as well as 
finding objects for recall later. The contents of this section can be broken down into the two cat-
egories shown below. Follow the links to learn more.

 l Methods for selecting objects

 l Select Flow Path

 l Select Special

 l Groups

 l Methods for finding objects

 l Workspace Find

 l Workspace Search

 l Find from Model Data or Output

 l Jump Feature

 l Bookmarks

Related Topics

Working with Pipe and Junction Objects 211
Pipe Drawing Modes 216
Global Edit 223
Selecting Objects 212
Finding Objects 214
Groups 215
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Selecting Objects
A single left click on any object will select that object. Selecting multiple objects can be accom-
plished by:

 l Holding the shift or control key and left clicking on objects
 l Dragging the cursor over the objects, creating a selection area

 l Dragging left-to-right creates a selection area that will only select objects entirely 
bounded by the area

 l Dragging right-to-left creates a selection area that selects any objects completely 
or partially inside the area

 l Using Select All from the Edit Menu, right-clicking on Workspace to open context menu, 
or keyboard shortcut (Ctrl-A)

 l Using Select Last Selection from the Edit Menu or with F12 to reselect the previously 
selected objects

 l Using Select Flow Path
 l Using Select Special
 l By selecting a Group

Select Flow Path

A flow path is a sequence of pipes and junctions where there is no branching or flow sources or 
sinks.

The pipes and/or junctions in a flow path may all be easily selected by selecting a pipe on the 
Workspace then clicking the Select Flow Path item on the Edit menu, Toolbar, or the right-click 
context menu.

This feature is very useful in duplicating or deleting sequences of pipes and junctions. It can also 
be used to quickly define groups for graphing or for selected Output or Model Data listings.

Select Special

Select Special is a tool for selecting or deselecting objects based on certain criteria. It can be 
opened from all windows/menus that give you the option to choose what pipes and/or junctions 
are selected. These windows/menus include the Output Control window, the Model Data win-
dow, the Layer Settings window, the Select Graph Data window, the Edit menu, right clicking on 
the Workspace, or pressing F6 on the keyboard.

Once Select Special is open, all pipe names and numbers and junction names and numbers are 
shown in numerical order under Pipe Selections and Junction Selections, respectively. At the top 
of the Select Special window is the Selection Type option. This option allows you to choose what 
criteria you would like to use to select certain pipes and junctions. You can choose from the fol-
lowing criteria to select certain pipes and/or junctions.
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 l Selected on Workspace
 l Closed in Model
 l Special Conditions Set
 l Number Range
 l Junction Type
 l Pipe Input Properties
 l Zero-Length Connectors
 l Notes
 l Undefined Objects
 l User-Colored Pipes
 l Transient Data Exists
 l Groups
 l Pipe Output Properties (Only available when output is available)
 l Junction Output Properties (Only available when output is available)

Choosing certain Selection Types will prompt a second or sometimes third option below the 
Selection Type to allow you to further specify the type of pipe or junction you want. For example, 
selecting Junction Type in the Selection Type box will prompt the Junction Type box to appear. 
The Junction Type box will allow you to specify what type of junctions you would like to select. 

By default, the Selection Type is Selected on Workspace and any pipes or junctions selected on 
the Workspace are selected in the Select Special window with a black check mark next to the 
box corresponding to the pipe or junction. 

Once you have fully specified the Selection Type, you must click Select Pipes and/or Select Junc-
tions to automatically select the corresponding objects.

The selected pipes and junctions under Pipe Selections and Junction Selections do not auto-
matically become unselected when you switch from one Selection Type to another. Therefore, 
you must first choose Deselect Pipes and/or Deselect Junctions located above the Pipe Selec-
tions and Junction Selections boxes, respectively. For example, if you select all of the pipes on 
the Workspace prior to opening the Select Special window, all of the pipes will be selected in the 
Select Special window when you open it. If you then choose Junction Type as the Selection Type 
and then specify All Junctions as the Junction Type, all junctions will be selected under Junction 
Selections, but all pipes previously selected will also remain selected. In this example, if you 
would like only junctions to be selected with none of the selected pipes on the Workspace to be 
selected in the Select Special window, first click the Deselect Pipes button, which is located 
above the Pipe Selections list. 

Options to select all pipes/junctions, to deselect all pipes/junctions, and to invert the selected 
pipes/junctions are located below both Pipe Selections and Junction Selections boxes. Inverting 
the pipes/junctions deselects all currently selected pipes/junctions and selects all currently 
deselected pipes/junctions. This feature is helpful if you want to select all pipes/junctions that do 
not fit a certain criteria. For example, if you want to select all open objects in the model, you 
could specify Closed in Model in the Selection Type box, then click Select Pipes and Select Junc-
tions. All pipes and junctions that are closed in the model will be selected. Because you want to 
select all open pipes and junctions in the model but only the closed pipes and junctions are selec-
ted, you would simply click Invert below both the Pipe Selections and Junction Selections lists to 
deselect all closed pipes and junctions and select all open pipes and junctions.
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Related Topics

Selecting and Finding Objects 211
Finding Objects 214
Groups 215

Finding Objects

Workspace Find

The Find window utility helps you find a particular pipe or junction by its ID number and name. 
The Find utility becomes more useful for models that expand over multiple Workspace pages.

You can access the Find utility by selecting Find on the View menu, by clicking the button on the 
Toolbar, or by using the keyboard shortcut "Ctrl+F". After you double click on the pipe or junction 
you are searching for in the Find utility or when you click the Find button, the Workspace is 
moved so that the pipe or junction is located near the center of the screen. Additionally, the pipe 
or junction you are searching for is selected in the Selected Items color specified in the User 
Options window in the Tools menu. By default, this color is red.

Workspace Search

The Search window utility helps you search for a particular pipe or junction by its ID number, 
name, or notes you have inputted in the properties window. The Search utility becomes more 
useful for models that expand over multiple Workspace pages.

You can access the Search on the Common Toolbar. The search feature will list all objects 
related to your search term beneath itself in a list of search results. You can hover over each 
search results to see a preview of input and output (if the model has been run). Clicking on or 
pressing enter while the object is highlighted in the search results will select the object in the 
workspace and center the focus of the workspace on the object.

Find From Model Data or Output

Objects can be quickly located on the Workspace by right-clicking on a cell in Model Data or row 
header in Output and selecting "Find on Workspace..." the view will change to show the Work-
space, with the object of interest selected.

Jump Feature

By clicking the Jump button in a Properties window, you can move directly to another Properties 
window of another a pipe or junction that you specify. 

The Jump button is located in the upper right corner of the Properties window.
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Bookmarks

Use the Bookmark tools on the View menu to set Bookmarks and to display different book-
marked pipes or junctions.

Bookmarks can be added on the Workspace in relation to individual pipes or junctions. You can 
quickly navigate around the Workspace by moving from Bookmark to Bookmark.

Related Topics

Selecting and Finding Objects 211
Selecting Objects 212
Groups 215

Groups
Groups of pipes and junctions can be named for later recall. This is done using the Group tools 
on the Edit menu. The easiest way to create a named Group is as follows:

 1. First select the the pipes and junctions you want in the group
 2. Choose Groups -> Create from the Edit menu. 
 3. You will be prompted for a name for the group. Enter a meaningful name and click OK.
 4. The Group Manager then opens. The selection of pipes and junctions in the Group will 

match those currently selected on the Workspace. If you want to modify the selections 
once more, you can do it here. 

You can include Subgroups inside of your Groups. Subgroups are existing Groups. If a Group 
contains one or more Subgroups and the Group is selected on the Workspace, then all pipes and 
junctions in the Group and Subgroup(s) will be selected. Additionally, if you include a Subgroup 
in your Group and then later change the contents of the Subgroup, the Group that contains the 
Subgroup will also be changed.

After you have created a Group, you can then quickly reselect that Group of pipes or junctions on 
the Workspace by choosing Group -> Select from the Edit menu and choosing the name of the 
Group.

The Group Manager can be opened by choosing Group -> Manager from the Edit menu. The 
Group Manager allows you to modify, create, delete or rename Groups.

Another place that Groups can be selected from is in the Select Special window.

Related Topics

Selecting and Finding Objects 211
Selecting Objects 212
Finding Objects 214
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Pipe Drawing Modes
AFT Impulse has a selection of pipe drawing modes. To select or change a pipe drawing mode, 
navigate to Arrange -> Pipe Drawing Mode. These pipe drawing modes are:

 l 2D Freeform
 l 2D Orthogonal
 l Isometric

A second function called Snap to Grid is highly integrated with Pipe Drawing Modes and will 
alter how each pipe drawing mode works. To select or change a Snap to Grid option, navigate to 
Arrange -> Snap to Grid. The Snap to Grid options for the 2D modes are on and off. Snap to Grid 
options for Isometric are more extensive. These snap to grid options are:

 l Snap to Isometric Grid Lines
 l Snap to Grid Points
 l Do Not Snap

2D Freeform

This Pipe Drawing Mode allows placing pipes or junctions anywhere on the Workspace, with 
pipes at any angle. Snap to Grid can be turned on with this mode to force the junctions to be at 
grid intersection points.

Figure 1: 2D Freeform with Snap to Grid off

- 216 -



Working with Pipe and Junction Objects

Figure 2: 2D Freeform with Snap to Grid on

2D Orthogonal

The 2D Orthogonal Pipe Drawing Mode forces all pipes drawn in the model to be either hori-
zontal or vertical. Segments are automatically inserted into pipes to enforce drawing only along 
the horizontal and vertical directions.
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Figure 3: Model in 2D Orthogonal mode with Snap to Grid on

Orthogonal drawing can create some confusion for the user because segments from different 
pipes may overlap each other and hence become indistinguishable.

 l Use the Add/Remove Segments button to add new segments
 l Use a fine grid and the Snap to Grid features
 l If you have a junction with several connecting pipes that interfere, enlarge the junction to 

150% or 200% of normal size using the Workspace Layers

Isometric

When modeling, it may be convenient or desirable to demonstrate the three dimensional nature 
of a system. A typical 2D grid has two sets of grid lines representing the x and y axes. An iso-
metric grid has three sets of grid lines that are offset by 60°, representing the x, y, and z axes. It 
is ideal to set the grid type desired before building a model to avoid the pipe and junction loc-
ations from being rearranged in undesired ways. It is also very helpful to show the Grid (Arrange 
-> Show Grid) when building an isometric model.
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Figure 4: 2D (left) and isometric (right) grids

Drawing Pipes in Isometric Mode

How pipe drawing in isometric mode functions will change depending on the selected snap to 
grid option. When Snap to Isometric Grid Lines is selected, the pipes are automatically seg-
mented to lie on the grid lines as shown below. Dragging one of the handles on the pipe shows a 
preview line of where the pipe will be placed if adjustment needs to be made. The placement of 
the preview line can be cycled through all possibilities by pressing the arrow keys or by scrolling 
the mouse scroll wheel. Holding the alt key while dragging a pipe endpoint will automatically add 
a new segment to the pipe - the placement of the line can be controlled with the arrow keys or 
scroll wheel as before.
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Figure 5: Automatic layout of isometric pipes

The Snap to Grid Points option will force the end points of the pipes to snap to the points where 
the grid lines intersect without adding segments to it. This is akin to the 2D Freeform mode while 
Snap to Grid is on.

The Do Not Snap option will allow the end points of the pipes to placed anywhere within the 
Workspace.

- 220 -



Working with Pipe and Junction Objects

Placing Junctions

Placing junctions onto the Workspace follows the usual rules; however, the visual appearance of 
the icon is more complex than in an orthogonal grid. When icons are added after pipes are 
placed, AFT Impulse will rotate the icon automatically following the Workspace arrangement. 
When pipes are connected to icons already placed on the Workspace, right-click and select 
Auto-rotate Icon to adjust the icon. For manual control of icon appearance, right-click the junction 
and select Customize Icon to choose the desired appearance.

Note: The Rotate button in the Customize Icon window can be used to find the appropriate 
icon orientation.
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Figure 6: Icon rotations in isometric space

Related Topics

Working with Pipe and Junction Objects 211
Selecting and Finding Objects 211
Global Edit 223
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AFT Impulse has the powerful capability to apply input parameters across a wide range of 
objects. This can be done for pipes by using the Global Pipe Edit or across junctions of the same 
type by using the Global Junction Edit.

Related Topics

Working with Pipe and Junction Objects 211
Selecting and Finding Objects 211
Pipe Drawing Modes 216
Global Pipe Editing 223
Global Junction Editing 224

Related Blogs

Mass Modify your Model with Global Edit

Global Pipe Editing
The Global Pipe Edit window allows you to edit data for multiple pipes at the same time. A Guide 
is available at the top of the Global Edit window to walk you through the global edit process.

Here is how you use it:

 1. Open the Global Pipe Edit window from the Edit menu, or from the right-click menu on the 
Workspace.

 2. Select the pipes you want to edit from the Pipe list on the left (if pipes were selected in the 
Workspace, they will be automatically selected here)

 3. Click the Select Pipe Data button. This will open a template Pipe Properties Window in which 
you can enter the data you want to change on each of the selected pipes. Alternatively, if you 
want to copy the data from an existing pipe, you can choose "Existing Pipe", then select the 
desired pipe number and skip to step 5.

 4. Enter the pipe data you want to change and click the OK button in the Pipe Properties win-
dow.

 5. The Global Pipe Edit window now lists the parameters to change in a list on the right. Select 
the parameters you want to change. 

 6. Click the Apply Selections button.

Note: You cannot change some data, like the pipe ID number, using this global method.

Note: There is no undo for global pipe editing. Therefore, you cannot revert your changes 
once you have exited the Global Edit window. However, hitting Cancel on the Global 
Edit window will undo any changes that were just applied.
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Related Topics

Global Edit 223
Global Junction Editing 224

Related Blogs

Mass Modify your Model with Global Edit

Global Junction Editing
The Global Junction Edit window allows you to edit data for multiple junctions at the same time. A 
Guide is available at the top of the Global Edit window to walk you through the global edit pro-
cess, or the instructions are provided below in this topic.

Junction data falls into the following two broad categories: 

 l Common Data - data that applies to all junctions regardless of junction type; examples 
include elevation and initial pressure data. 

 l Junction Specific Data - data that applies only to certain junctions; examples include 
pump curves and number of heat exchanger tubes.

To open the Global Junction Edit window, browse to the Global Junction Edit option on the Edit 
menu. From there, choose the category of junction you want to edit. The available categories 
include those junctions selected on the Workspace, any junction type used in the model, and 
common junction data. Global Junction Edit can also be launched by right-clicking on the Work-
space.

Note: There is no undo for global junction editing. Therefore, you cannot revert your changes 
once you have exited the Global Edit window. However, hitting Cancel on the Global 
Edit window will undo any changes that were just applied.

Editing Common Junction Data

You can open the Global Junction Edit window for common data editing in two ways. First, you 
can choose Common Data from the Global Junction Edit menu selection on the Edit menu, or 
you can choose one of the other specific junction types on the menu and then choose the Com-
mon option for the Junction Template in the upper left.

Here is how to globally edit junction common data:

 1. Open the Global Junction Edit window.
 2. Select the Common option for Junction Template in the upper left.
 3. Select the junctions you want to edit from the Junction list on the left. Note that all junc-

tions in the model are shown, no matter what the junction type.
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 4. Click the Select Common Junction Data button. This will open the Common Junction Data 
Edit window in which you can enter the data you want to change on each of the selected 
junctions.

 5. Enter the junction data you want to change and click the OK button in the Junction Prop-
erties Window.

 6. The Global Junction Edit window now lists the parameters to change in a list on the right. 
Select the parameters you want to change. 

 7. Click the Apply Selections button.

Note: You cannot change some data, like the junction ID number, using this global method.

Editing Specific Junction Data

You can open the Global Junction Edit window for specific data editing in two ways. First, you 
can choose the junction type from the Global Junction Edit menu selection on the Edit menu, or 
you can choose Common Data on the menu and then choose the desired junction template, or 
Existing Junction data for the desired junction type.

Here is how to globally edit specific types of junctions:

 1. Open the Global Junction Edit window.
 2. Select the Junction Template option in the upper left. Alternatively, if you want to copy the 

data from an existing junction, you can choose "Existing Junction", then select the desired 
junction number and skip to step 6. 

 3. Select the type of junction you want to edit in the dropdown list in the upper left. Here 
Spray Discharge is selected.

 4. Click the Select Spray Discharge Data button (the button name will change based on the 
type of junction selected). This will open the appropriate junction Properties Window, in 
this case the Spray Discharge Properties Window. 

 5. Enter the junction data you want to change and click the OK button in the Spray Dis-
charge Properties Window (or whatever window type is displayed).

 6. The Global Junction Edit window now lists the parameters to change in a list on the right. 
Select the parameters you want to change. 

 7. Select the junctions you want to edit from the Junction list on the left. Note that only junc-
tions of type selected in the upper left are shown (Spray Discharge junctions in this case).

 8. Click the Apply Selections button.

Related Topics

Global Edit 223
Global Pipe Editing 223
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Related Blogs

Mass Modify your Model with Global Edit

Toolbox
The bundle of tools at the left of the Workspace window that allows you to create pipes and junc-
tions. The toolbox can be docked to the left, right, or floated within the workspace by clicking on 
the arrows on the top of the toolbox. 
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Figure 1: Toolbox items

Custom Junction Icons

Right-clicking a junction icon in the Toolbox will open the Customize Icon window. A different 
icon can be selected from the predefined assortment, or a custom image can be uploaded using 
the  Add Image button. This functionality enables you to use standard P&ID icons or custom 
images to visually represent your equipment. By using recognizable icons, you can improve the 
clarity and comprehension of model results, especially for those who may not be familiar with the 
default AFT junction icons.

Note: The Annotation Tool also supports triangle and cloud shapes which can be used in com-
bination with the Notes section on the Scenario tab of the Quick Access Panel to des-
ignate revisions of the model file, similar to a typical P&ID drawing.
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Figure 2: The Customize Icon window allows a custom image to be applied to any junction

Related Topics

Creating Pipes - the Pipe Drawing Tool 228
Creating Junctions 233
Keyboard Shortcuts for Workspace 519

Creating Pipes - the Pipe Drawing Tool
The tool in the upper left corner of the Toolbox is the Pipe Drawing tool. With this tool you can 
draw new pipes on the Workspace, starting and ending at any desired location. 

To draw a pipe, click the Pipe Drawing tool. The mouse pointer will change to a crosshair when 
you move it over the Workspace. Position the cursor at the pipe's starting point, hold down the 
left mouse button while dragging the cursor to the pipe end point, then release the mouse button. 

To draw multiple pipes, double click the Pipe Drawing tool. This will keep the tool engaged until 
you click the Pipe Drawing tool again or press the escape key.

The length of the line on the Workspace has no relationship to the physical length of the pipe. 
The Workspace pipe is merely an abstract representation of a pipe, however, each pipe drawn 
must have a visible length on the Workspace. If the pipe drawn does not have a visible length, 
AFT Impulse eliminates the line immediately after you release the mouse.

When a single pipe is selected, two squares (or more if the pipe is segmented), called handles, 
appear. When the cursor is placed over a pipe handle it changes to a crosshair and the pipe 
handle can be moved or stretched by dragging with the left mouse button.

Another way to create new pipes is to duplicate existing pipes with the Duplicate or the Copy and 
Paste features found on the Edit menu. When a new pipe is derived from a previous pipe, the 
new pipe retains the input associated with the original pipe.

Each pipe must be connected to two junctions. There are no exceptions to this rule.

- 228 -



Pipe ID Numbers

When a new pipe is created, it is assigned a default ID number. When the pipe is displayed on 
the Workspace, the ID number is preceded by the letter "P" to indicate that it is for a pipe. From 
the Pipe Properties Window, you can change the ID number to any desired number greater than 
zero and up to 99,999, but the number must be unique to the pipe and cannot be replicated in 
any other pipes in the model. The pipe number remains with the pipe in descendant scenarios in 
the Scenario Manager. An arrow near the ID number indicates the reference flow direction for 
the pipe. The reference positive flow direction can be reversed by choosing Reverse Direction 
from the Edit menu or by selecting the reverse direction button on the Toolbar. 

Tip:  The pipe or junction ID number text can be dragged to a new location to improve vis-
ibility. The new location is saved with the model. If you want the text of one or more 
pipes and/or junctions returned to the default location, select those pipes/junctions on 
the Workspace and choose Reset Label Locations from the Arrange menu. From this 
box, click the Reset Labels For Currently Selected Pipes and Junctions. If you want all 
pipe and junction text returned to the default locations, choose Reset Label Locations 
from the Reset Label Locations box on the Arrange menu.

Pipe Segments

A pipe can be segmented or "bent" into numerous sections. This only affects the visual rep-
resentation and does not affect the calculated results. It does not add an "elbow" to the model or 
the resulting pressure drop effects of an elbow. This feature is useful in graphically bending the 
pipe around another part of the model or graphically showing that there are embedded elbows as 
fittings & losses.

You can add a segment to a pipe in several ways. The easiest way to add a pipe segment is to 
first select the pipe, then click on the +/- image on the Add/Remove Segment icon from the Tool-
bar. A segment will automatically be added. One or more segments can be added by clicking on 
the down-facing arrow on the Add/Remove Segment icon from the Toolbar, and then choosing 
the number of segments to be added. Alternatively, you can first select the pipe, then select Pipe 
Segments in the Arrange menu. A dropdown list will appear that allows you to choose Add a Seg-
ment or Add Multiple Segments.

The easiest way to remove a segment is to first select the pipe, then click on the down-facing 
arrow on the Add/Remove Segment icon from the Toolbar. A drop down list will appear that will 
allow you to choose Remove Segment. If you wish to remove all segments, click Remove All 
Segments. Alternatively, you can first select the pipe from which you want to delete one or more 
segments, then select Pipe Segments in the Arrange menu. A dropdown list will appear that 
allows you to remove one or all segments by clicking on either Remove Segment if you want to 
remove one segment, or by clicking on Remove All Segments if you want to delete all segments.
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Keyboard Shortcuts

See the Keyboard Shortcuts for Workspace topic for more information on additional Pipe Draw-
ing Tool shortcuts.

Related Topics

Toolbox 226
Creating Junctions 233
Keyboard Shortcuts for Workspace 519
Pipes 247
Joining or Splitting Pipes 230
Connecting Objects 234
Moving Objects 235
Editing Objects 236
Defining Objects 237
Highlight Required Input 239
Inspecting Objects 240
Notes 242
Status 242

Joining or Splitting Pipes
When pipes are present in the Workspace, users can both combine and split up pipes. This can 
be done either to clean up the model visually or to further manipulate the model.

Joining Pipes

When multiple pipes are placed in the workspace separated by junctions without having other 
flowpaths splitting off, those pipes and intermediate junctions can be combined into a single 
pipe. The new pipe will have a total length equal to the sum of the combined pipe lengths, and 
any losses associated with the intermediate junctions will be summed and entered as additional 
Fittings & Losses. It will also have the elevation profile of the original pipes and junctions entered 
as Intermediate Pipe Elevations.

The pipes being combined must have the same material, size, type, friction model, and 
wavespeed to be combined. In addition, the pipes must be pointing in the same direction.

Joining pipes may cause some junction data to be lost such as special conditions, loss factors for 
reverse flow, and ignored transients.

To join pipes and junctions in the model, select the "Join Pipes/Junctions" option from the Edit 
menu. The Join Pipes window will be shown with more information on pipes that can be com-
bined in the model. The behavior of the Join Pipes/Junctions window will vary depending on if 
junctions are selected on the Workspace when the Join Pipes/Junctions option is selected.
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Note: For maintenance releases prior to November 2022 the Join Pipes/Junctions window did 
not exist. Instead pipes and junctions selected in the Workspace would be joined auto-
matically when the "Join Selected Pipes/Junctions" option was selected in the Edit 
menu.

 l If junctions are selected on the Workspace, the Join Pipes/Junctions window will open 
with only the selected junctions shown in the list.

 l If no junctions are selected on the Workspace, the Join Pipes/Junctions window will open 
with all junctions that can be combined shown in the list. Any junctions that can be com-
bined and won't cause a loss in data at that junction will be selected automatically.

Once the Join Pipe/Junctions window is opened the selections can be modified before joining 
the pipes. The options below the table can be enabled/disabled in order to filter the shown junc-
tions based on if they are selected on the workspace, if they will loose data when combined, or if 
they can't be combined.

If any junctions are selected that would loose data when combined, an additional button will 
appear near the bottom of the window that allows junctions that would have data loss to be 
deselected. It is recommended to select this button before joining the pipes/junctions unless you 
are certain the lost data is no longer required.

To join the pipes at the junctions selected in the Join Pipes/Junctions window, click the Join 
Selected Junction(s) button at the bottom of the window.

Splitting Pipes

An existing pipe in the workspace can be split into multiple pipes two different ways. First, hold-
ing the Shift key while placing a junction along the pipe will split the pipe in two and insert the 
selected junction.

Second, pipes with Intermediate Pipe Elevations can be split into separate pipes at any or all of 
those intermediate elevations. This can be done by selecting a pipe with Intermediate Pipe Elev-
ations and clicking Edit -> Split Pipe at Intermediate Elevations. A window will open to select 
which intermediate elevations to make into new junctions.

The pipe can be split at all intermediate elevations, or at selected locations by checking the box 
next to each elevation point the pipe should be split at. When the pipe is split, a branch will be cre-
ated for each of the selected elevation points. If desired, a name can be entered for each new 
branch in the New Junction Name column of the table. Any points not selected will be retained in 
the intermediate elevation table of the appropriate pipe in the Workspace.

Note: When splitting a pipe at intermediate elevations, the pipe in the Workspace must be 
long enough to place the necessary number of branches in the pipe before the split can 
be completed. If insufficient space is available, the user will be required to exit the Split 
Pipe at Intermediate Elevations window and rearrange the model to create space 
before Impulse can perform the split action.
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Figure 1: Split Pipe at Intermediate Elevations window

For pipes with a large number of intermediate elevations, it may be more convenient to define 
the split points in a spreadsheet. This can be done from the Edit Table button at the bottom of the 
window by selecting Export to File. This will export the table to a *.csv table which can be opened 
in Excel, as is shown in Figure 2.

The table can be updated by changing the "Split At" column value to Yes for each location that 
the pipe will be split at. Branch names can also be entered under "New Junction Name" column 
for the appropriate points. Note that it is important to not change any of the Length or Elevation 
columns in the *.csv file, as this will prevent the file from being imported. To import the file into 
Impulse, select "Import From File" from the Edit Table button, then browse to the updated *.csv 
file.
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Figure 2: Exported *.csv file for splitting a pipe at intermediate elevations
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Related Blogs

You Should Combine Your Pipes

Creating Junctions
Below the pipe drawing and the annotation tools on the Toolbox are junctions, which allow you to 
model a large variety of pipe system components. To add a junction to a model, drag the desired 
icon from the Toolbox and drop it anywhere on the Workspace. 

As you move the mouse pointer over the Toolbox, a tooltip identifies the type of junction under 
the mouse pointer. 

When you duplicate a junction using the Duplicate, Copy, or Paste features on the Edit menu, 
the new junction retains the input associated with the original junction.
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Junction ID Numbers

Junctions are shown on the Workspace with default ID numbers, which you can change in the 
Junction Properties Window. The letter "J" precedes the ID number to signify that it is for a junc-
tion. From the junction’s Properties window, you can change the ID number to any desired num-
ber greater than zero and up to 99,999, but the number must be unique to the junction and 
cannot be replicated in any other junctions in the model. The junction number remains with the 
junction in descendant scenarios as long as the junction type is not changed.

Identical ID numbers can be assigned to both a pipe and a junction because the "P" or "J" will dis-
tinguish the two.

Unlike pipes, junctions do not have reference positive flow directions. Junctions for which the 
flow direction is important (such as control valves) derive the flow direction from the flow dir-
ection of the connecting pipes.

Related Topics

Toolbox 226
Creating Pipes - the Pipe Drawing Tool 228
Keyboard Shortcuts for Workspace 519

Connecting Objects
During construction of a new model, objects can be placed anywhere on the Workspace. In order 
to assemble a model that is ready for analysis, you must connect the objects properly. 

Remember that connectivity only exists between junctions and pipes. There are no junctions that 
connect to junctions, and no pipes that connect to pipes. 

AFT Impulse will attempt to automatically connect pipes and junctions when they are moved. If 
Impulse cannot make the connection automatically, then the following three steps may be 
required to establish a connection between a junction and a pipe: 

 1. Graphically connect the objects on the Workspace. The pipe endpoint must terminate 
within the boundaries of a junction icon. 

 2. After the pipe is graphically connected to two junctions, double-click the pipe to open its 
Properties window, then click OK to accept the connected junctions as determined by 
AFT Impulse. It is most efficient to do this when you are entering the pipe's data in its Prop-
erties window.

 3. Open the Properties window of the corresponding junction and accept the pipe con-
nectivity determination. In most junctions, this pipe connectivity determination will be loc-
ated in the upper right hand corner of the Properties Window. In a few junctions, such as 
the Assign Pressure Junction and Reservoir Junction, the pipe connectivity will be shown 
under the tab containing Loss Coefficients. You can do this as you enter the junction's 
data in its Properties Window.

If the model seems to not be connected properly, you can also use the Extended Model Check 
feature on the View menu. 
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When you accept AFT Impulse's connectivity interpretation, the connection advances from a 
graphical connection to a model connection. 

The model connectivity you establish on the Workspace is retained only as long as you maintain 
the graphical objects in their current visual relationship to each other. If you move a pipe or a 
junction and break the graphical connection, AFT Impulse disconnects the two objects. 
However, if you move a group of connected objects, their model connectivity is maintained.

Related Topics

Pipes 247
Creating Pipes - the Pipe Drawing Tool 228
Joining or Splitting Pipes 230
Moving Objects 235
Editing Objects 236
Defining Objects 237
Highlight Required Input 239
Inspecting Objects 240
Notes 242
Status 242
Junctions 267
Morphing Junctions 237
Moving Pipe and Junction Labels 243

Moving Objects
Objects on the Workspace can be moved individually or as groups. Clicking a Workspace object 
selects it. Pipe objects change color when selected. Junction objects are outlined in red when 
selected. These colors are configurable in the Workspace section of User Options (Tools menu) 
.

To move an object, select it, drag it within the Workspace, and drop it in the desired location. 
When an object is dragged beyond the existing Workspace area, the Workspace is expanded 
accordingly.

A pipe object can be stretched by grabbing the handles (small red squares) at the pipe endpoints 
and moving an endpoint to a new location. To make these handles visible, select the pipe you 
want to move.

There are numerous ways to select a group of objects for movement or other operations.

To prevent accidental movement on the Workspace, lock the objects. A lock symbol appears 
next to locked pipes or junctions when an attempt is made to move the pipe or junction. The Lock 
feature is accessed from the Arrange Menu or the lock button on the Toolbar. To lock an object 
on the Workspace, select it and then activate the Lock feature either from the Arrange menu or 
from the lock button on the Toolbar. If you would like to lock multiple objects at the same time, 
ensure that all of the objects are selected prior to activating the Lock feature.
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Keyboard Modifiers

If you hold down the CTRL key when dragging a junction, the endpoints of any connected pipes 
are not moved with the junction, thus breaking the graphical connection.

Related Topics

Pipes 247
Creating Pipes - the Pipe Drawing Tool 228
Joining or Splitting Pipes 230
Connecting Objects 234
Editing Objects 236
Defining Objects 237
Highlight Required Input 239
Inspecting Objects 240
Notes 242
Status 242
Junctions 267
Morphing Junctions 237
Moving Pipe and Junction Labels 243

Editing Objects
The pipes and junctions you place on the Workspace can be edited with the editing commands 
from the Edit menu or the Toolbar. Objects can be cut, copied, pasted, duplicated, and deleted. 
These operations can be performed on individual objects or on groups. The Edit menu provides 
multiple levels of undo for editing operatings on objects in the workspace. Alternately you can 
use the Undo button on the Toolbar.

The Copy Graphics feature on the Edit menu will copy the specified Workspace objects to the 
Windows clipboard. This image can then be pasted into other Windows applications.

Related Topics

Pipes 247
Creating Pipes - the Pipe Drawing Tool 228
Joining or Splitting Pipes 230
Connecting Objects 234
Moving Objects 235
Defining Objects 237
Highlight Required Input 239
Inspecting Objects 240
Notes 242
Status 242
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Morphing Junctions 237
Moving Pipe and Junction Labels 243

Morphing Junctions
Occasionally you may want to change a junction's type in your model. You can do this by morph-
ing the old junction into a new one.

If you hold down CTRL key and select a junction from the Toolbox and drop it onto an existing 
Workspace junction, the old junction will morph into the new one. The junction type will change to 
the new junction type, and data that can be kept will be copied into the new junction.

Related Topics

Junctions 267
Connecting Objects 234
Moving Objects 235
Editing Objects 236
Defining Objects 237
Highlight Required Input 239
Inspecting Objects 240
Notes 242
Status 242
Moving Pipe and Junction Labels 243

Defining Objects
To specify the required property data for an object, open its Properties window. This can be done 
in six ways:             

 1. Double-click the object on the Workspace                     
 2. Select the object (by clicking on it once, or using the Selection Box) and press ENTER                     
 3. Select the object and click the Open Pipe/Jct Window icon on the Toolbar
 4. Double-click the left column of the appropriate table in the Model Data window (where the 

object ID number is shown)                     
 5. Jump from another Properties window                     
 6. Double-click the connected pipe or junction number in a Properties window                     

Parameters that functionally describe the pipe or junction are entered in the Properties window. 
Some parameters in the Properties windows are required and others are optional. The optional 
parameters offer you added control over your model and the ability to obtain specialized inform-
ation.

The highlight feature shows the required input in pipes and junctions.
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Undefined Objects Window

You can open the Undefined Objects window to view all undefined objects and the undefined 
properties. This is available on the View menu. 

Use Status Feature

Each pipe and junction Properties window has a Status tab. The Status tab shows what required 
information for the pipe or junction is missing.

Satisfying Connectivity Requirements

In addition to entering the required information for each object in the model, you must satisfy 
these connectivity requirements:

 l You must accept the connectivity information shown in each object's Properties window 
 l Each junction must have the appropriate number of pipes connected to it. For example, 

an area change junction must have exactly two connecting pipes, whereas a reservoir 
may have one to twenty-five connecting pipes. 

 l Pipes must always be connected to two junctions, one at each pipe endpoint.

Should you ever delete any of the required information in the Properties window or move a con-
nected object from its connection, the object's status reverts to undefined.

For example, say you place a check valve on the Workspace. A check valve requires inlet and 
outlet piping. AFT Impulse reflects this by requiring each check valve to be assigned an 
upstream pipe and a downstream pipe. Entering only the Valve model details and setting an elev-
ation is necessary but not sufficient information to define the check valve according to AFT 
Impulse's requirements. Once you have entered the check valve data and properly connected it, 
the check valve is defined.

Show Object Status

The Show Object Status feature helps you identify which objects on the Workspace are defined 
and which are not. This feature can be toggled on and off by selecting it from the View menu or 
by clicking the floodlight button on the Toolbar. 

Turning Show Object Status on displays the undefined junction and pipe ID numbers in the 
Undefined Color, which is red by default. The color can be changed through the User Options 
window on the Tools menu. Show Object Status helps you rapidly assess where your model 
requires additional information.

Leaving Show Object Status always toggled on is not recommended for large models, as it will 
slow the Workspace graphics response. When this feature is on, every Workspace graphical 
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operation you perform must be accompanied by a check of all pipe and junction connections. 
This check takes time, and could degrade your graphics performance. 

Related Topics

Pipes 247
Creating Pipes - the Pipe Drawing Tool 228
Joining or Splitting Pipes 230
Connecting Objects 234
Moving Objects 235
Editing Objects 236
Highlight Required Input 239
Inspecting Objects 240
Notes 242
Status 242
Junctions 267
Morphing Junctions 237
Moving Pipe and Junction Labels 243

Highlight Required Input
The highlight feature functions to identify required input data for the Properties Window for each 
pipe and junction. You can toggle the highlight feature on and off in the following ways:

 l From the Properties Window
 l Double-click anywhere in the Properties Window
 l Press the F2 function key

 l From the View Menu
 l Toggle the Highlight in Pipe and Jct Windows to Off

The highlighting feature may be especially useful when you are first learning to use AFT Impulse 
or when you are having difficulty obtaining a defined object status.

Related Topics

Pipes 247
Creating Pipes - the Pipe Drawing Tool 228
Joining or Splitting Pipes 230
Connecting Objects 234
Moving Objects 235
Editing Objects 236
Defining Objects 237
Inspecting Objects 240
Notes 242
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Status 242
Junctions 267
Morphing Junctions 237
Moving Pipe and Junction Labels 243

Inspecting Objects
The Inspection feature displays data associated with a Workspace object in read-only fashion 
via a pop-up overlay (see Figure 1). Inspecting is faster than opening the Properties window if 
you only want to review the data and no edits need to be made. Inspecting can be done directly 
from the Workspace and provides a quick summary of the parameters that appear on the Model 
Data Primary Window.

To inspect an object, position the mouse pointer on the object and hold down the right mouse but-
ton.

The Inspection feature is also available inside each pipe/junction's Properties window. This is 
useful if you want to check the input data of objects connected to the one you are viewing. The 
upstream/downstream pipes or junctions are listed, and holding the right mouse button on the lis-
ted ID number will open the associated inspection overlay.  For example, when working in an Ori-
fice Properties window, you may wish to quickly check the upstream and downstream pipe 
diameters previously defined. Holding down the right mouse button on each connected pipe ID 
number will show you that pipe's primary input parameters.

Judicious inspecting can save you time when assembling or debugging a model.

Note: Output data will be shown on the inspection overlay only if a valid Output File is present 
for the current scenario.
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Figure 1: Holding the right mouse button on a Workspace object displays the associated data

Related Topics

Pipes 247
Creating Pipes - the Pipe Drawing Tool 228
Joining or Splitting Pipes 230
Connecting Objects 234
Moving Objects 235
Editing Objects 236
Defining Objects 237
Highlight Required Input 239
Notes 242
Status 242
Junctions 267
Morphing Junctions 237
Moving Pipe and Junction Labels 243
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Notes
Each object can have notes associated with it. This is useful for listing assumptions, reference 
documents, drawings, measurements, etc.

Related Topics

Pipes 247
Creating Pipes - the Pipe Drawing Tool 228
Joining or Splitting Pipes 230
Connecting Objects 234
Moving Objects 235
Editing Objects 236
Defining Objects 237
Highlight Required Input 239
Inspecting Objects 240
Status 242
Junctions 267
Morphing Junctions 237
Moving Pipe and Junction Labels 243

Status
The status tab lists all undefined parameters that are required to define the pipe or junction.

Related Topics

Pipes 247
Creating Pipes - the Pipe Drawing Tool 228
Joining or Splitting Pipes 230
Connecting Objects 234
Moving Objects 235
Editing Objects 236
Defining Objects 237
Highlight Required Input 239
Inspecting Objects 240
Notes 242
Junctions 267
Morphing Junctions 237
Moving Pipe and Junction Labels 243
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Workspace Pan
The user can use Workspace Pan mode to move around, or pan, the model. If the Workspace 
has been enlarged beyond the default one screen size (Workspace scrollbars will be visible), 
then the Workspace can be panned by activating Workspace Pan mode. There are several ways 
to activate Workspace Pan Mode:

 l Click the Workspace Pan button (represented with a hand icon) on the toolbar
 l Select the Workspace Pan option in the View menu
 l If your mouse has a center button (a scroll wheel), hold the scroll wheel button down
 l Hold CTRL and use the arrow keys

Once in pan mode, the cursor will change to an open hand that can be used to grab and move a 
point in the Workspace. The Workspace can be panned by holding down the left mouse button (if 
the Workspace Pan mode has been activated using the Workspace Pan button on the toolbar or 
the Workspace Pan option has been selected in the View menu) and moving the mouse in the 
desired direction, or by holding down the mouse scroll wheel (if using the scroll wheel to keep 
Workspace Pan mode activated) and moving the mouse in the desired direction. 

To switch off the pan mode, click the mouse scroll wheel or the Workspace Pan button on the 
toolbar a second time. If Workspace Pan mode is maintained using the mouse scroll wheel, it will 
automatically turn off once you release the mouse scroll bar.

Related Topics

Moving Pipe and Junction Labels 243

Related Blogs

AFT Responds to 2020 Customer Survey Feedback

Moving Pipe and Junction Labels
Each pipe and junction on the Workspace also displays a label.  A label refers to any text asso-
ciated with an object - pipe numbers, names, flow rates, and so forth. The label will display a 
unique combination of defined display text items from each visible Workspace Layer.  This label 
can be dragged to improve model aesthetics. The relative location of the label to the object is 
linked so that if the object is moved, the label moves with it.

Returning Label to Default Location

To return the label to its default location, you can:
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 l Right-click the label for an individual object and choose Reset Label Location
 l Use Arrange -> Reset Label Locations and respond to the dialog
 l Click Reset Label Locations in the Label Control group of the Layer Settings window to 

reset all label locations

Related Topics

Junctions 267
Connecting Objects 234
Moving Objects 235
Editing Objects 236
Morphing Junctions 237
Defining Objects 237
Highlight Required Input 239
Inspecting Objects 240
Notes 242
Status 242
Workspace Pan 243

Special Conditions
Some junctions have Special Conditions which alter the normal state of the junction. For 
example, a valve can be closed, a pump turned off, or a relief valve opened.

The special conditions are set in one of three ways:

 l By selecting the junction(s) on the Workspace and choosing Special Conditions from the 
Edit menu

 l By selecting the junction(s) on the Workspace and clicking the Special Condition icon on 
the Toolbar

 l By opening the junction’s Properties window and clicking the appropriate condition on the 
Optional folder tab

The junctions which have special conditions set are shown using a special symbol before the ID 
number (an "X" by default). This symbol can be customized in the User Options.

When the special condition results in a section of the model being closed or "turned off", the 
pipes which will have zero flow are display as dotted lines. This indicates visually that they are 
cut off from flow; the junctions are outlined with a dotted line. The default dotted line can be 
changed in the User Options.

The user can specify Special Conditions for Control Valves to be either closed or fully open. Sim-
ilarly, pumps can be turned off and either allow flow through or stop the flow.
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Special Condition: Ignore

The Air Valve, Gas Accumulator, Liquid Accumulator, Surge Tank, Relief Valve and Weir junc-
tions have a unique kind of Special Condition called Ignore. This makes the steady-state and 
transient solvers ignore the presence of the junction. Thus not only is the data ignored, the junc-
tion itself is ignored. This is convenient when locating one of these devices by trial and error. 
Rather than having to delete the junction, it can be ignored.

As an example, assume that one is trying to find the best location for a gas accumulator. If one 
does this with a single gas accumulator junction, it will be required to run a case, view the results, 
then relocated the junction by changing the pipe lengths and rerunning. If one uses the Special 
Condition Ignore, one can place multiple gas accumulator junctions in the model and then set all 
of them except one to Ignore so that only one of the junctions is used at a time.

Related Topics

Optional Input for Pipes 255
Optional Input for Junctions 273
Turn Off Parts of the Model 797
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Pipes
This section focuses on specifying and modifying the Pipe object in the AFT Impulse Workspace. 
Topics include an overview of the Pipe Properties window, how to input pipe specification data, a 
description of the methodology used for heat exchange within pipes for AFT Impulse, and how to 
insert fittings and losses within the pipes.   

Contents   

Pipe Properties Window 247

Common Pipe Input Parameters 248

Pipe Model 250

Fittings & Losses 253

Fluid Properties for Pipes 255

Optional Input for Pipes 255

Add/Remove Pipe Segment 260

Reverse Pipe Direction 261

Pressure Drop in Pipes - Detailed Discussion 261

Pipe Properties Window
Each pipe on the Workspace has engineering information associated with it. Each pipe must 
have an ID number, a length, a diameter, a roughness specification, and two connecting junc-
tions. If the pipe is not purely cylindrical, additional geometry information is also required. 

The Pipe Properties Window allows the user to define all data for a pipe on the Workspace. An 
example on a fully defined Pipe Properties Window is shown below in Figure 1. The various Pipe 
inputs are discussed in the respective pipe pages listed in the Related Topics section below. 
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Figure 1: Fully Defined Pipe Properties Window

Related Topics

Pipes 247
Common Pipe Input Parameters 248
Pipe Model 250
Fittings & Losses 253
Fluid Properties for Pipes 255
Optional Input for Pipes 255
Add/Remove Pipe Segment 260
Reverse Pipe Direction 261
Pressure Drop in Pipes - Detailed Discussion 261
Pipe X length is shorter than the elevation change between Junction Y and Z 767

Related Blogs

Intermediate Elevations and Splitting Pipes

Common Pipe Input Parameters
The common input parameters are located above the tabs in the Pipe Properties Window.
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Number

Every pipe must have a unique ID number. When new pipes are created, a pipe number is auto-
matically allocated.

The pipe number can be changed by the user to any unique value greater than zero and less 
than 100,000. Pipe numbers are only identifiers and have no affect on the model behavior.

Name

A name can be assigned to each pipe for reference purposes. The default name is simply "Pipe”. 
Names do not need to be unique. The name can be shown on the Workspace and in the Output 
window.

Copy Data From Pipe...

The Copy Data From Pipe dropdown list allows you to copy all or some of an existing pipe’s prop-
erties to the current pipe. Selecting an existing pipe will prompt the user on what parameters 
should be changed. The Copy Previous button functions similarly, copying parameters from the 
previously edited pipe.

In child scenario, Copy Data From Pipe lists "Parent Pipe Data," allowing the user to copy all or 
some parameters from the parent pipe.

Connected junctions 

All pipe objects have a reference positive direction, as indicated on the Workspace by an arrow 
in the center of the pipe. The upstream and downstream junctions are identified with this dir-
ection. The connected junctions area displays these junctions. Every pipe must be connected to 
two junctions in order to be completely defined.

Related Topics

Pipes 247
Pipe Properties Window 247
Pipe Model 250
Fittings & Losses 253
Fluid Properties for Pipes 255
Optional Input for Pipes 255
Add/Remove Pipe Segment 260
Reverse Pipe Direction 261
Pressure Drop in Pipes - Detailed Discussion 261
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Pipe Model

Size

The size section of the Pipe Model tab specifies the pipe geometry.

 l Pipe Material
 l User Specified - If selected, the geometry of the pipe must be directly specified.
 l Library Material - Many common pipe materials are included in the standard Pipe 

Material Library. These and any other accessible library materials can be selected. 
When a library material is selected, the parameters defining the geometry cannot 
be modified.

 l Size - Select from a list of defined nominal sizes for the selected Pipe Material. Only avail-
able for library materials.

 l Type - Select from a list of defined types (classes/schedules) for the selected Pipe Mater-
ial. Only available for library materials.

 l ID Reduction (Scaling) - Reduction in hydraulic diameter due to scaling can be accoun-
ted for by entering a percent reduction in this field. Zero represents no reduction.

Length

The Length is defined as the distance between the two connecting junctions. This length has no 
relationship to the visual length of the pipe drawn on the Workspace.

Model As Zero-length Connector can be checked to turn the pipe into a lossless connection 
between two junctions, such as for two components that are directly welded together. Zero-
Length Connectors (ZLCs) are denoted by a red C icon next to the pipe name on the Workspace. 
Intermediate branching flow is not allowed between two ZLCs, and they can only be used in up to 
two sequential pipes.

ZLCs are hidden by default in the Model Data and Output. Generally the output for ZLCs is not of 
interest because they will have the same inlet and outlet properties.

You can enable ZLCs to be shown in the Model Data by opening the Model Data Control, going 
to the Show Selected Pipes/Junctions tab, and selecting the Show Zero-Length Connectors 
checkbox under the list of pipes. The same checkbox is present in the Output Control on the 
Show Pipes/Jcts tab. You will then need to click on the pipe numbers in the list to make them vis-
ible in the Model Data or Output, or you can use the All button to select all pipes in the model.

Due to the nature of the solution method for ZLCs, there are several configurations that are not 
allowed to be used. See below for a list of restricted options:

 l Junctions that can only be connected to one zero-length connector
 l Reservoir with Infinite Reservoir tank model and no loss factors defined on the 

Pipe Depth & Loss Coefficients tab
 l Assigned Pressure
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 l Tee/Wye with simple loss model
 l Spray Discharge
 l Branch with Flow Source/Sink defined on Optional tab and no loss factors on the 

Pipe Depth & Loss Coefficients tab
 l Junctions not allowed to be connected to zero-length connectors

 l Reservoir with Finite Open tank model
 l Check Valve with Force Balance valve model
 l Gas Accumulator
 l Surge Tank
 l Air Valve
 l Liquid Accumulator
 l Weir
 l Turbine
 l Tee/Wye with detailed loss model
 l Branch with loss factors on the Pipe Depth & Loss Coefficients tab
 l Reservoir with loss factors on the Pipe Depth & Loss Coefficients tab
 l Pumps with Four Quadrant Curve
 l Relief Valve with Internal or Inline Exit valve model
 l Volume Balance

Wavespeed

The wavespeed is the speed at which transient events propagate through the pipe. Typical val-
ues for the wavespeed are 2000-5000 ft/sec (700-1600 m/sec). This parameter depends on the 
liquid acoustic velocity and the pipe material and support. 

There are two options to determine a wavespeed for the pipe:

 l User Specified Wavespeed - If this option is selected the wall thickness, modulus of 
elasticity, poisson ratio, and pipe support fields will no longer be used and will be grayed 
out so that the user can enter their own wavespeed.

 l Calculated Wavespeed - This option will use information from the Fluid panel, the Pipe 
Material Library, and the chosen Pipe Support model to estimate the wavespeed for the 
user. 

The Pipe Support selection is made from the provided drop down list to obtain the constant c1. 
This constant is required for pipes in which the wavespeed is calculated. AFT Impulse provides 
nine common pipe support types from Wylie, et. al, 1993.

 l Thin-Walled - Piping in which the wall is relatively thin with respect to diameter so that 
D/e > 25, where D is diameter and e is thickness. Three types are available:
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 l Thin-Walled Anchored Upstream - Pipe anchored at its upstream end only.
 l Thin-Walled Anchored Throughout - Pipe anchored throughout against axial 

movement.
 l Thin-Walled With Expansion Joints - Pipe anchored with expansion joints 

throughout.
 l Thick-Walled - Piping in which the wall is relatively thick with respect to diameter so that 

D/e < 25, where D is diameter and e is thickness. Three types are available:
 l Thick-Walled Anchored Upstream - Pipe anchored at its upstream end only.
 l Thick-Walled Anchored Throughout - Pipe anchored throughout against axial 

movement.
 l Thick-Walled With Expansion Joints - Pipe anchored with expansion joints 

throughout.
 l Circular Tunnel (unlined) - Models a conduit through solid rock or concrete.
 l Circular Tunnel (lined) - Accounts for increase in wavespeed due to a steel liner in con-

tact with a solid rock or concrete tunnel. An additional input for the Rock Modulus of Rigid-
ity is required for this model.

 l Buried Pipe - Accounts for wavespeed in a buried pipeline. An additional input for the 
Soil Modulus of Rigidity is required for this model.

Friction Model

Multiple friction data sets can be compiled for each library pipe material. These different data 
sets are then made available in the Data Set drop down list. For AFT standard materials, the fric-
tion data set is generally "Standard."

The Friction Model can be modified for any individual pipe, and the default friction model can be 
set in Parameter Options. The Friction Model for a library material can be modified by selecting 
the User Specified radio button in Data Set, and must be directly specified for User Specified 
materials.

Theses models apply to Newtonian viscosity models. If a non-Newtonian model is selected in the 
Viscosity Model panel, the below friction models may not be used.

 l Absolute roughness (default) - Absolute average roughness height. Values of pipe 
roughness can be found in many pipe handbooks or from manufacturer's data.

 l Relative roughness - Relative roughness is the absolute roughness divided by the pipe 
diameter.

 l Hydraulically smooth - Hydraulically smooth implies that roughness is negligible. This is 
not the same as frictionless.

 l Hazen-Williams - A method using an empirical factor to relate flow and pressure drop, 
common in water distribution.

 l Explicit Friction Factor - friction factor for the pipe, you can enter the value explicitly.
 l Resistance - You can specify a pipe resistance in terms of head loss and volumetric flow 

rate. The pipe head loss will then be as follows: dH = RQ2.
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 l Frictionless - For troubleshooting purposes, it is occasionally useful to model a pipe as 
having no friction. There are limitations to where such a pipe can be located in your 
model.

 l MIT Equation - A model appropriate for crude oil.
 l Miller Turbulent - A model appropriate for light hydrocarbons.

For detailed information on how these Friction Models are defined, see Pressure Drop in Pipes - 
Detailed Discussion.

Related Topics

Pipes 247
Pipe Properties Window 247
Common Pipe Input Parameters 248
Fittings & Losses 253
Fluid Properties for Pipes 255
Optional Input for Pipes 255
Add/Remove Pipe Segment 260
Reverse Pipe Direction 261
Pressure Drop in Pipes - Detailed Discussion 261

Fittings & Losses
Fittings & Losses allows the user to define additional losses directly in a pipe. This is useful to 
account for pressure losses without modeling large numbers of elbows or similar fittings. To spe-
cify losses, open the Pipe Properties window, click the Fittings & Losses tab, then click Specify 
Fittings & Losses to open the Pipe Fittings & Losses window. An Additional K Factor loss can 
also be user specified.

Pipe Fittings & Losses

The Fittings & Losses library contains many standard loss values. Because many of these val-
ues are dependent on pipe diameter, a pipe diameter must be specified to open the Pipe Fittings 
& Losses window.

Losses are divided into several categories represented by tabs. To add fittings to the pipe, select 
the type, and adjust the quantity column next to the desired fitting.

After accepting the changes by clicking OK, a summary of the pipe's Fittings & Losses will be dis-
played in the Pipe Properties window.

Note: Area Change fittings do not change the size of the pipe, they only represent the loss 
factor based on the pipe diameter and the area ratio of the loss. When including area 
changes, notice the illustration of how the loss is defined, where Apipe is the area of the 
pipe and As is the area of the loss. These area changes are useful to model fittings 
between a pipe and another junction like a pump.
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Figure 1: Pipe Fittings & Losses window

Fittings & Losses Workspace Symbol

When a pipe has any loss value assigned through the Fittings & Losses tab, a symbol (default of 
&) is added before the pipe number.

Favorite Fittings & Losses

In the Pipe Fittings & Loses window, there is a column labeled Favorite for each of the loss types. 
Check the box for favorite to add it to the list of favorite fittings and losses. On the left side of the 
window there are several options to filter the list. For example, one may only want to see Crane 
fittings. In which case, Crane should be checked, and all others unchecked on the left hand side 
of the window. If a list of only favorite fittings is desired, check the box to "Show Favorites Only".

Related Topics

Pipes 247
Pipe Properties Window 247
Common Pipe Input Parameters 248
Pipe Model 250
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Fluid Properties for Pipes 255
Optional Input for Pipes 255
Add/Remove Pipe Segment 260
Reverse Pipe Direction 261
Pressure Drop in Pipes - Detailed Discussion 261
Fittings & Losses Library 672

Fluid Properties for Pipes
This folder tab is only visible when variable properties are being modeled. Variable property mod-
eling is enabled in the Analysis Setup window.

For models with variable fluid properties, you can assign different fluid properties to each pipe in 
the model. This is convenient for modeling systems that are subject to temperature variations 
and systems that have multiple fluids. The pipe fluid properties are displayed in the Pipe Prop-
erties window, and can be modified by selecting the Fluid Properties button. Besides varying the 
fluid properties, the viscosity model can varied from pipe to pipe. Thus, some pipes in the model 
can be modeled as Newtonian, with others as non-Newtonian.

Related Topics

Pipes 247
Pipe Properties Window 247
Common Pipe Input Parameters 248
Pipe Model 250
Fittings & Losses 253
Optional Input for Pipes 255
Add/Remove Pipe Segment 260
Reverse Pipe Direction 261
Pressure Drop in Pipes - Detailed Discussion 261

Optional Input for Pipes

Initial Flow Rate Guess

The Initial Flow Guess for a pipe can be specified. An appropriate initial guess can decrease the 
number of iterations required to arrive at a converged solution. This initial guess will only affect 
the steady-state solution process.

The Solver generates initial guesses on its own, which is usually sufficient to get the Solver going 
in the right direction so a converged solution results. If this is not the case, user defined guesses 
can help obtain a solution.
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Stagnant Region Steady-State Pressure

You can specify a reference pressure in a pipe that will be closed during steady-state which will 
be used for the transient simulation. Only specify one pressure per stagnant region or you will 
receive an error stating there is more than one stagnant pressure defined. A single stagnant pres-
sure will allow Impulse to calculate the pressures in the region with hydrostatic pressure dif-
ferences due to elevation change being taken into account.

Design Factors

A design factor can be used to add safety margins into the hydraulic analysis. For pipes, two 
design factors exist:

 l Pipe Friction: friction factor is multiplied by the design factor assigned to the pipe.
 l Pipe Fittings & Losses: total loss factor (K factor or Equivalent Lengths) is multiplied by 

the design factor assigned to the pipe.

Partially Full Pipe

Note: The Partially Full Pipe feature should be used with caution. Improper use will result in 
incorrect calculations or conclusions. Verify that all requirements below are met when 
using this feature.

The checkbox for "Pipe Can Be Partially Full Along Length" enables an input field for "Percent 
Full Initially" which defaults to a value of 100%. Normally, Impulse operates under the assump-
tion that all pipes are liquid full as stated in the Engineering Assumptions, and cannot model the 
filling or draining of the entire system. The Partially Full Pipe feature allows limited modeling of 
filling or draining of one individual pipe when connected to certain junctions.

Requirements & Assumptions:

 l Only applies to pipes that are connected to an Air Valve, Spray Discharge,  Valve spe-
cified as an Exit Valve with ambient conditions, or an Assigned Pressure boundary con-
dition specified with ambient conditions.

Note: Ensure that the steady-state pressure at the Air Valve is above the cracking pres-
sure, otherwise Impulse may report an artificial transient.

 l The pipe must be sloped with one end higher in elevation than the other.
 l The connected junction must be located at the high point. The pipe will drain from the end 

with the higher elevation.
 l Length refers to the axial length of the sloped pipe, and the liquid-gas interface is 

assumed to be perpendicular to the pipe wall. This feature does not model a radial per-
centage of pipe volume and is not intended to be used with horizontal pipes.
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 l The pipe cannot have intermediate elevations.
 l Application of the Partially Full Pipe cannot extend or chain to other down-

stream/upstream pipes in the system. The tracking of the liquid full percentage is only 
valid in the given pipe.

Overall,  selecting this feature implies that one end of the pipe is connected to a junction at its 
higher elevation endpoint which allows gas to flow in, thus allowing the pipe to drain. Sustained 
draining for a volume larger than the pipe will violate Impulse's liquid full assumption and the 
scope of the Partially Full Pipe feature.

Functionality:

 l Disabled - If the option is not enabled, the pipe will always be assumed to be liquid full.
 l Equal to 100% - If the option is selected, and the entry is 100%, it means the pipe is ini-

tially 100% full, but can drain if backflow occurs at the high elevation endpoint. This could 
occur after a pump trip for example.

 l Less than 100% - If the option is selected, and the entry is less than 100%, it means the 
pipe is initially partially full, and can drain or fill based on the transient simulation. This is 
only valid when the steady-state condition for the pipe is such that there is no flow, since if 
there were flow in that pipe during steady-state, the pipe would not be partially full.

Graphing:

Before running the model it is advised to update the Output Pipe Stations item in Analysis Setup 
to save All Stations for any Partially Full Pipes. When one of the pipes in the model has the Par-
tially Full Pipe feature enabled there will be an additional four graphing parameters available 
from the Transient Pipe graph type. Graphing any of the stations will produce the same graph 
since the Partially Full Pipe parameters inherently apply to the entire pipe and not just a single 
station.

 1. Liquid Distance Along Partially Full Pipe - axial distance of the liquid-gas interface
 2. Liquid Elevation in Partially Full Pipe - elevation of the liquid-gas interface based on 

the pipe slope and connected junction elevations
 3. Liquid Percent in Partially Full Pipe - percent of the pipe that is liquid full
 4. Liquid Station in Partially Full Pipe - the y-axis will show station numbers indicating 

which are considered liquid-full

Accuracy:

Modeling more sections in the Partially Full Pipe will result in better accuracy. At least two sec-
tions should be used, and more if possible. This is because Impulse will model each section in 
the pipe as either completely liquid full or empty. Therefore, more sections in the Partially Full 
Pipe will allow Impulse to more precisely determine the liquid level.

Parallel Pipes

A single pipe object can be specified as a number of parallel pipes. When multiple pipes are 
defined, the parameters in the Pipe Properties window represent only one of the parallel pipes.

- 257 -



Pipes

Intermediate Pipe Elevations

The inlet and exit elevations of a pipe are equal to the elevations of the upstream and down-
stream junctions. The pipe elevation is assumed to vary linearly between the junctions. In other 
words, the pipe is assumed to be perfectly straight.

Modeling a large number of elevation changes with straight pipes would require a large number 
of junctions, as shown below:

Figure 1: Accounting for elevation changes with many pipes and junctions

This is tedious and not required for overall hydraulic calculations - only the elevation change 
across a (fluid full) pipe is needed. However, intermediate pressure results along the pipe will be 
affected.

For example, Figure 1 shows elevation extremes both lower and higher than the elevations at 
the ends of the pipeline. Low points may exceed maximum allowable pressures, and high points 
could drop below vapor pressure. If this is modeled as a single straight pipe these issues would 
not be easily identified. In fact, if these pipes were replaced with a single pipe it would show no 
elevation change at all!

Instead of using a large number of pipes, these effects can be accounted for in a single pipe 
using intermediate pipe elevation feature.

With length defined, check Use Intermediate Pipe Elevations, choose the elevation units, the 
number of intermediate elevations (a 2 segment pipe has 1 intermediate elevation), and whether 
the entered values are Point to Point or Length Along Pipe.
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Figure 2: Intermediate Elevations - Identical Profiles defined with both methods

AFT Impulse will ensure the total length matches the length on the Pipe Model tab. It does so by 
fixing the length of the final section to the difference between the sum of the lengths in the table 
and the actual length entered by the user. The end elevation is also fixed by the downstream 
junction. If the user later modifies the downstream junction elevation, the pipe’s final elevation 
section will be automatically updated. The maximum number of rows available in this table can 
be changed in User Options.

After the intermediate elevations have been entered, a graph showing the data can be displayed. 
Below is the profile graph of the pipe described above.
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Figure 3: Intermediate Elevation Graph

Related Topics

Special Conditions 244
Optional Input for Junctions 273
Turn Off Parts of the Model 797
Pipes 247
Pipe Properties Window 247
Common Pipe Input Parameters 248
Pipe Model 250
Fittings & Losses 253
Fluid Properties for Pipes 255
Add/Remove Pipe Segment 260
Reverse Pipe Direction 261
Pressure Drop in Pipes - Detailed Discussion 261
Pipe X segment length Y is shorter than the elevation change 767
Make Initial Flow Rate Guesses for Pipes 796
Transfer Results to Initial Guesses 791

Add/Remove Pipe Segment
Visual segments can be added to pipes in the Workspace.

To add or remove segments, use the Arrange -> Pipe Segments submenu. These options are 
also available on the Workspace Toolbar.
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Note: These segments are useful for creating a clear layout of the system, but have no impact 
on the solution - a visual "bend" is not the same as adding a Branch junction.

Related Topics

Pipes 247
Pipe Properties Window 247
Common Pipe Input Parameters 248
Pipe Model 250
Fittings & Losses 253
Fluid Properties for Pipes 255
Optional Input for Pipes 255
Reverse Pipe Direction 261
Pressure Drop in Pipes - Detailed Discussion 261

Related Blogs

Intermediate Elevations and Splitting Pipes

Reverse Pipe Direction
Every pipe has a reference positive flow direction as indicated by its arrow. This direction can be 
easily reversed by selecting Reverse Direction from the Arrange menu or clicking the Reverse 
Direction button on the Workspace Toolbar.    

Related Topics

Pipes 247
Pipe Properties Window 247
Common Pipe Input Parameters 248
Pipe Model 250
Fittings & Losses 253
Fluid Properties for Pipes 255
Optional Input for Pipes 255
Add/Remove Pipe Segment 260
Pressure Drop in Pipes - Detailed Discussion 261

Pressure Drop in Pipes - Detailed Discussion
Depending on the viscosity model and pipe friction model selected, the calculation of pressure 
drop in a pipe differs.
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Darcy-Weisbach Loss Model

AFT Impulse utilizes the Darcy-Weisbach loss model to relate the Darcy Friction Factor, the pipe 
geometry, fluid density, and fluid velocity to pressure drop in the pipe. The Darcy Friction Factor 
differs from the Fanning Friction Factor by a factor of 4.

This model requires the calculation of a friction factor, as described below.

 l Roughness-Based Methods - This method calculates the friction factor based on the 
roughness of the pipe wall. Different equations are used based on flow regime - laminar 
flow uses the standard laminar relationship, while turbulent flow uses the implicit 
Colebrook-White equation. In the transition range between laminar and turbulent flow, a 
linearly interpolated value is used. The default transition Reynold's Numbers can be mod-
ified in Analysis Setup window.

 l Absolute Roughness (default) - The absolute average roughness height ε is spe-
cified directly.

 l Relative Roughness - The roughness is specified as a ratio ε/D.
 l Hydraulically Smooth - The ratio ε/D is set equal to zero.

 l Explicit Friction Factor - The friction factor to be used in the Darcy-Weisbach equation 
is specified directly

Frictionless

The pipe will not have any pressure drop across it. This is inherently unrealistic behavior, but 
can be useful for troubleshooting purposes.

Resistance

The pipe resistance relates head loss to volumetric flow rate. In equation form, the head loss is: 
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Using standard relationships, the friction pressure drop is related to volumetric and mass flow 
rate as follows:

Non-Newtonian Pressure Loss

The pressure loss behavior for Non-Newtonian fluids depends on the specific viscosity model 
selected in the Viscosity Model panel. See Non-Newtonian fluids for more information.

Hazen-Williams Method

AFT Impulse also offers the Hazen-Williams method of specifying irrecoverable loss information. 
The Solver converts the Hazen-Williams factor to a Darcy-Weisbach friction factor (Walski 1984, 
37). This allows a consistent solution approach to be used for all pipe system models, while 
retaining the flexibility of the two approaches to account for losses.

where V is in ft/s and D is in ft.

MIT Equation for Crude Oil

The MIT Equation is appropriate for crude oil and is given by the following equation (Pipe Line 
Rules of Thumb Handbook):
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where:

 l dP        = pressure drop (psi)
 l L        = length (miles)
 l f        = friction factor, MIT
 l Q        = volumetric flow rate (barrels/hour)
 l s        = specific gravity
 l d        = inside diameter (inches)
 l ν        = kinematic viscosity (centistokes)

The friction factor calculated by the MIT equations is not the same as the Darcy friction factor. 
Once the pressure drop (dP) in the pipe is determined, AFT Impulse uses the Darcy equation to 
back calculate the equivalent Darcy friction factor.

The MIT equation defines the lower bound for the laminar equation as r=0.1, but offers no explan-
ation as to the validity of calculations below this point. AFT Impulse continues to use the laminar 
flow equation for Reynolds numbers below 0.1.  The older version of the MIT equations did not 
have this lower limit, and the results from AFT Impulse 10 agree closely with values from the 
older equations at these lower Reynolds number values.

For Reynolds numbers in the Indeterminate flow regime, the value for the MIT friction factor is 
determined by linearly interpolating between the friction factors for the highest laminar Reynolds 
number and the lowest turbulent Reynolds number.

Miller Turbulent Method

The Miller Turbulent method is appropriate for light hydrocarbons and is given by the following 
equation (Pipe Line Rules of Thumb Handbook):
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where:

 l dP        = pressure drop (psi)
 l L        = length (miles)
 l Q        = volumetric flow rate (barrels/hour)
 l ρ        = density (lbm/ft3)
 l ρwater= density of water (62.3 lbm/ft3)
 l d        = diameter (inches)
 l μ        = dynamic viscosity (centipoise)

Design Factors

In each pipe you can specify a Design Factor for the pipe friction. This is a multiplier that is 
applied to the friction factor calculated with the preceding methods.

Related Topics

Features for Modeling Irrecoverable Losses 114
Conventions for Specifying Basis Area 275
Transient Friction Panel 194
Pipes 247
Pipe Properties Window 247
Common Pipe Input Parameters 248
Pipe Model 250
Fittings & Losses 253
Fluid Properties for Pipes 255
Optional Input for Pipes 255
Add/Remove Pipe Segment 260
Reverse Pipe Direction 261

SSL Module 
Settling Slurry Module
An optional add-on module to AFT 
Impulse which allows users to sim-
ulate settling slurries.
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This section focuses on the Junctions in the AFT Impulse workspace as well as the theories that 
govern the junctions. Topics included discuss the types of junctions that AFT Impulse provides, 
the required inputs for each junction, and theory topics that indicate how the inputs to the junc-
tion are used.

Contents

General Junction Information 267

Junction Loss Models 281

General Junction Information
The different types of junctions on the Toolbox offer a great degree of freedom in assembling a 
pipe network model. While there is some redundancy in capabilities between the junctions, each 
of the types of junctions offers specialized features to allow you to prepare a good conceptual 
model of the physical system of interest. Table 1 compares the features of the junction types.

There is a junction Properties window for each junction type. Each junction Properties window 
falls into one of two basic window formats, depending on the number of connecting pipes 
allowed for that junction type.

Note: AFT Impulse does not prevent negative flow through junctions. Should this occur, AFT 
Impulse will use the same loss factor or pressure drop data referenced to the defined 
upstream pipe, just as in forward flow. Because it is possible that the loss factor or pres-
sure drop data would not be the same for both flow directions, the flow solution could be 
misleading. For this reason it is important that you either properly define the pipe flow 
directions for junctions or pay close attention to the flow directions that result. AFT 
Impulse will not always give a warning for this, though it will for certain junctions.
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Table 1: Comparison of junction capabilities

Junction Type Connecting 
Pipes

Special Condi-
tions

Custom Library Window 
Format

Air Valve 1-2 Yes Yes 1

Area Change 2  Yes 1

Assigned Flow 1 Yes Yes 1

Assigned Pres-
sure*

1/1-25  Yes 1

Bend/Elbow 2  Yes 1

Branch 2-25 Yes Yes 2

Check Valve 2 Yes Yes 1

Control Valve 2 Yes Yes 1

Dead End 1   1

Gas Accu-
mulator

1-25 Yes Yes 2

General Com-
ponent

2 Yes Yes 1

Liquid Accu-
mulator

1-25 Yes Yes 2

Orifice 2  Yes 1

Pump 2 Yes Yes 1

Relief Valve 1-2 Yes Yes 1

Reservoir 1-25  Yes 2

Screen 2  Yes 1

Spray Dis-
charge

1-4 Yes Yes 2

Surge Tank 1-25 Yes Yes 2

Tee/Wye** 3   2

Turbine 2 Yes Yes 1

Valve 1-2 Yes Yes 1
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Venturi 2  Yes 1

Volume Bal-
ance

2   1

Weir 2 Yes Yes 1

*Assigned Pressure junction connects to only one pipe for static pressure, and up to 25 for stag-
nation

**Tee/Wye junctions have a unique format closer to Format #2 than Format #1

Related Topics

Two Window Formats 269
Common Junction Input Parameters 271
Optional Input for Junctions 273
Specifying Losses 274
Conventions for Specifying Basis Area 275
Reference Density 275
Equal Percentage Valves 277
Lumped Inertia Pipe with Orifice Waterhammer Theory 278

Two Window Formats

Format #1: Junctions With One or Two Connecting Pipes

The first basic window format is for junction types that allow only one or two connecting pipes 
(see Figure 1). While junctions do not have an explicitly defined flow direction like pipes do, 
those with one or two pipes adopt a direction from the connecting pipes. For these junction 
types, upstream and downstream pipes are recognized by AFT Impulse based on the reference 
positive flow direction of the connecting pipes. The upstream and downstream pipes are dis-
played separately near the top of the window.

In this first basic window type, it is  important to have the pipes' reference positive flow directions 
specified in the physically correct directions. A good example of this is a Pump junction. A pump 
will add pressure to the system, but it does so only in the direction of positive flow through the 
connecting pipes. The Pump junction interprets where to add the pressure based on the dir-
ections of the connecting pipes.

To inspect in this window format, position the mouse pointer over the connected pipe ID and hold 
down the right mouse button.
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Figure 1: Properties window format #1 (fixed connecting pipe display). 

Format #2: Junctions With More Than Two Connecting Pipes

The second basic window format for junction Properties windows is for junctions that allow more 
than two connecting pipes (see Figure 2). These junctions typically allow up to 25 connecting 
pipes; the exception is the Tee/Wye junction, which allows only three.

Because the number of pipes connected to a junction may vary, the second basic format uses a 
table sized according to the number of connecting pipes.

An example of this second window format is the Branch Properties window, shown in Figure 2, 
which has three connecting pipes. To determine AFT Impulse's interpretation of the model con-
nectivity for this second window format, you can review the contents of the table areas. 

K factors in the first column will be applied for flow into the pipe and out of the junction, while K 
factors in the second column will be applied for flow out of the pipe and into the junction. 
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Figure 2: Properties window format #2 (pipes displayed in a table). 

Related Topics

General Junction Information 267
Common Junction Input Parameters 271
Optional Input for Junctions 273
Specifying Losses 274
Conventions for Specifying Basis Area 275
Reference Density 275
Equal Percentage Valves 277
Lumped Inertia Pipe with Orifice Waterhammer Theory 278

Common Junction Input Parameters

Number

Every junction must have a unique ID number. When new junctions are created, a junction num-
ber is automatically allocated.

The junction number can be changed by the user to any unique integer value greater than zero 
and less than 100,000. Junction numbers are only identifiers and have no effect on the model 
behavior.
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Name

A name can be assigned to each pipe for reference purposes. Names do not need to be unique. 
The name can be shown on the Workspace and in the Output window.

Library List

A list of all available custom components. It displays components from any connected library.

Selecting a component from this list automatically retrieves the junction settings and populates 
the properties window. Changing the input manually will deselect the component in the list.

Copy Data From Jct

The Copy Data From Junction dropdown list allows you to copy all or some of an existing junc-
tion's properties to the current junction. Selecting an existing junction will prompt the user on 
what parameters should be changed.

In child scenarios, Copy Data From Junction lists "Parent Junction Data," allowing the user to 
copy all or some parameters from the parent junction.

Pipe Connectivity

The connected pipes are displayed. This is helpful to determine potential connection issues and 
easily identify which pipes are upstream and downstream of the junction.

Elevation

Every junction must have an elevation reference. This value is the centerline elevation of the con-
nected pipe(s).

If multiple pipes are connected to a single junction, there are multiple elevations that must be 
defined. By default, all connected pipe centerlines are assumed to be at the same elevation. A 
different inlet/outlet elevation can be specified by unchecking the "Same as Inlet" box.

For junctions with more than two pipe connections, these elevations can be specified in the Pipe 
Depth or Loss Coefficients tab, depending on the junction.

Elevations are used to account for pressure changes due to gravity. There can be a pressure 
changes due to elevation change in a pipe or a junction. Junction elevation changes will have no 
effect on the flow solution, but will offset the local static pressure by the hydrostatic pressure dif-
ference.

A default elevation can be specified in Parameter Options, automatically setting new junctions to 
the specified elevation.
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Jumping to Another Junction

Quickly move to the next junction. See Jump Feature in Finding Objects.

Related Topics

General Junction Information 267
Two Window Formats 269
Optional Input for Junctions 273
Specifying Losses 274
Conventions for Specifying Basis Area 275
Reference Density 275
Equal Percentage Valves 277
Lumped Inertia Pipe with Orifice Waterhammer Theory 278
Pipe X length is shorter than the elevation change between Junction Y and Z 767

Optional Input for Junctions

Initial Guesses

A user defined initial guess can be entered for pressure (or head) for most junctions. This is only 
an initial guess for the Solver - the solution will vary from this value, and the value has no effect 
on the end solution.

A good initial guess can be helpful to decrease the number of Steady-Solver iterations required.

Special Conditions

The Special Condition can be changed for some junctions. For example, a valve can be set to 
closed, preventing all flow. A symbol (default of "X") will be placed before the junction label indic-
ating that a special condition is applied.

Design Factor

A design factor can be used to add safety margins into the hydraulic analysis. For junctions, two 
types of design factors exist:

 l Pump Junctions: head rise at the pump is multiplied by the design factor assigned to the 
pump.

 l All other junctions: total loss factor is multiplied by the design factor assigned to the 
junction. 
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Note: The design factor for pumps has the opposite effect on a system that the design factor 
for other junction types has. A design factor of 1.1 for junctions with a pressure loss will 
give an extra 10% pressure drop at that junction, adding resistance to the system. A 
design factor of 1.1 for the pump junction will give an extra 10% pressure rise, effect-
ively modeling the pump as having extra capacity than expected. To add a 10% safety 
margin to the pump junction, a design factor of 0.9 should be used.    

Workspace Icon

The junction icon can be changed to better represent a specific junction type. This is accom-
plished by clicking the Change Icon button. Custom images can be added by clicking the Add 
Image button. The size of the junction can be changed via Workspace Layers.

Related Topics

Special Conditions 244
Optional Input for Pipes 255
Turn Off Parts of the Model 797
General Junction Information 267
Two Window Formats 269
Common Junction Input Parameters 271
Specifying Losses 274
Conventions for Specifying Basis Area 275
Reference Density 275
Equal Percentage Valves 277
Lumped Inertia Pipe with Orifice Waterhammer Theory 278
Make Initial Flow Rate Guesses for Pipes 796
Transfer Results to Initial Guesses 791

Specifying Losses
Losses can be specified in two ways. The most flexible way of including a loss factor in an AFT 
Impulse model is to associate it with a junction specifically defined for that type of loss. This 
allows you to define a loss as a function of a flow parameter such as Reynolds number or volu-
metric flow rate, or as a function of the area change ratio between the upstream and downstream 
pipes.

Secondly, you can include loss factors with pipes. When you specify Fittings & Losses in the 
Pipe Properties window, the loss is assumed to be distributed evenly along the pipe length, 
much like friction losses. For this reason a pipe-associated loss factor is referred to as a dis-
tributed loss. The losses at junctions, on the other hand, are point losses. When modeling for 
waterhammer, it is preferred that losses for all static components be included in pipes as Fittings 
& Losses. This reduces the number of pipes and model run time.

Related Topics
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General Junction Information 267
Two Window Formats 269
Common Junction Input Parameters 271
Optional Input for Junctions 273
Conventions for Specifying Basis Area 275
Reference Density 275
Equal Percentage Valves 277
Lumped Inertia Pipe with Orifice Waterhammer Theory 278

Conventions for Specifying Basis Area
Loss factors are area dependent. When specifying a loss factor at a junction, the base area is of 
critical importance. By default, AFT Impulse adheres to the following convention: whenever it 
makes sense physically, the basis area is always the upstream pipe flow area. However, this can 
be modified by the user. In most junction Properties windows (on the Loss Model tab), the basis 
area can be specified as the upstream pipe, downstream pipe, user specified area, or user spe-
cified diameter.             

However, some junction types, especially those that allow three or more connecting pipes, spe-
cify loss factors based on each connecting pipe flow area, whether upstream or downstream. An 
example of this is a Wye in which each of the connecting pipes has a different diameter. The idea 
of specifying a loss factor based on upstream flow area loses meaning because there may be 
more than one upstream pipe. In these cases the loss factor is referenced to the base area of the 
actual downstream pipe(s) where it connects to the junction. The types of junctions that do not 
always follow the upstream pipe area convention are the Tee/Wye, Branch, Reservoir, Assigned 
Pressure, and Assigned Flow. Other exceptions are Valves and Relief Valves specified as exit 
valves, and Orifices specified as an exit.

Related Topics

Features for Modeling Irrecoverable Losses 114
Pressure Drop in Pipes - Detailed Discussion 261
General Junction Information 267
Two Window Formats 269
Common Junction Input Parameters 271
Optional Input for Junctions 273
Specifying Losses 274
Reference Density 275
Equal Percentage Valves 277
Lumped Inertia Pipe with Orifice Waterhammer Theory 278

Reference Density
A relationship can be drawn for many components between flow energy and flow rate. This can 
be a decrease (e.g., a loss across a valve) or increase in energy (e.g. energy added by a pump). 
The specific parameter used to represent flow energy can vary depending on application. It can 
be given in terms of pressure change or head change, and there is a critical difference between 
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the two.             

Consider a centifugal turbomachine (a pump or radial compressor): Kinetic energy is imparted to 
the fluid by accelerating it along the radius of the impeller. If the rate of rotation is held constant, a 
denser fluid will have more energy imparted to it than a lighter weight fluid. This would give rise to 
higher pressures. In other words, the pressure change depends on the density of the fluid.             

Pump curves are generally provided in terms of head. This is convenient because head is a unit 
of specific energy - or energy per weight. Therefore, it does not vary with fluid density like pres-
sure does. The head added to a fluid by a pump at a fixed speed, for example, will be the same 
for water and liquid mercury.             

However, head relationships are not always available or meaningful. If a pressure vs flow rela-
tionship is used, a reference density must be specified. This is the fluid density used during test-
ing and creation of the curve.             

Figure 1: Visual comparison of Pressure Loss Curves for differing densities. Head curves would be 
identical for this component.

Affected Parameters

There are several parameters that are affected by the density of the fluid:

 l Pressure - As discussed above
 l Mass Flow - The mass term contains information about the density of the fluid
 l Power - More power is demanded by a pump to meet the head curve for a denser fluid. 

While head is independent of density and therefore often reported by manufacturers, 
power is not independent of density. Therefore, a proper specification sheet that includes 
power must also include the reference fluid density.
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Accounting for Reference Density

Pumps and any Resistance Curve allow for the specification of a reference density if one of the 
above parameters is selected. The selection appears below the curve fit area as shown in Figure 
2.

Figure 2: Reference Density Selection

There are three options:

 l No Correction (default) - This selection assumes that the component was tested with the 
fluid defined in the Fluid panel.

 l Water @STP - This selection assumes density of the test fluid - is that of water at stand-
ard temperature and pressure. If the System Property fluid differs, the entered curve will 
be corrected.                     

 l User Specified - This directly specifies the reference density. If the System Property fluid 
differs, the entered curve will be corrected.

Related Topics

General Junction Information 267
Two Window Formats 269
Common Junction Input Parameters 271
Optional Input for Junctions 273
Specifying Losses 274
Conventions for Specifying Basis Area 275
Equal Percentage Valves 277
Lumped Inertia Pipe with Orifice Waterhammer Theory 278

Equal Percentage Valves
Equal Percentage valves have a valve plug shaped so that each increment in valve percent open 
(lift) increases the flowrate by a certain percentage of the previous flow.

The relationship between valve lift and orifice size is not linear but logarithmic.

It is expressed mathematically as follows:
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where:

 l τ = valve rangeability (ratio of the maximum to minimum controllable flowrate)
 l H = valve percent open or lift (0 = closed; 1= fully open)
 l Cv,max = full open valve loss value

Related Topics

General Junction Information 267
Two Window Formats 269
Common Junction Input Parameters 271
Optional Input for Junctions 273
Specifying Losses 274
Conventions for Specifying Basis Area 275
Reference Density 275
Lumped Inertia Pipe with Orifice Waterhammer Theory 278

Lumped Inertia Pipe with Orifice Waterhammer Theory
Some junctions in AFT Impulse use a pipe as a connector for some elements, although it is not a 
complete element by itself. Such an element may also include an orifice as shown in Figure 1. 
These connector pipes are modeled as pipes with lumped inertia (Wylie, 1993), such that their 
losses are included with the junction calculations.              
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Figure 1: Lumped inertia with friction schematic

Summing forces acting on the lumped section, 2, 

or,

Now,
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Substituting terms and dividing by area A2

Taking average values over time, and denoting current time by a prime,

Collecting terms and simplifying 

where

(1)

(2)

If a connector pipe exists but no orifice then

- 280 -



Junctions

If an orifice exists but no connector pipe

If neither exist then 

Related Topics

General Junction Information 267
Two Window Formats 269
Common Junction Input Parameters 271
Optional Input for Junctions 273
Specifying Losses 274
Conventions for Specifying Basis Area 275
Reference Density 275
Equal Percentage Valves 277

Junction Loss Models
There are a number of loss models available in Impulse to account for frictional losses at the junc-
tions in the model. See the below topics for more information on how losses are calculated for 
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each of the available models.

Related Topics

K Factor Loss Model 282
Kv and Cv Loss Model 283
Resistance Curve Loss Model 284

K Factor Loss Model
AFT Impulse models K factor component losses according to the following equation:         

(1)

where K is commonly referred to as the loss factor.         

Table 1 lists the sources for the loss models used in AFT Impulse. The losses implemented dir-
ectly in the code were chosen on the basis of ease of use. Many loss factor types are functions of 
the flow, and thus too general to be easily incorporated.

Table 1: Loss model references

Junction Type References

Bend Crane 1988, A-29
Miller 1990, 207-209                         

Area Change Crane 1988, A-26
Idelchik 2007, 246 & 254                         

Orifice Idelchik 2007, 258-259 & 262

Screen Idelchik 2007, 598

Tee/Wye Idelchik 2007, Chapter 7
Miller 1990, 315-316 & 323                         

Valve Ingersoll-Rand 1970
Crane 1988, A-29                         

Crane (1988) offers good general purpose correlations for modeling irrecoverable losses in pipe 
systems.         

Another lesser known source of loss factor information is Idelchik's Handbook of Hydraulic 
Resistance (2007). This reference is indispensable for the engineer who must make detailed 
hydraulic assessments of pipe systems in which so-called minor losses play a significant role. 

- 282 -



Junctions

The reference is voluminous in scope and full of tables, charts and equations for calculating loss 
factors for almost any pipe arrangement.         

Miller's Internal Flow Systems (1990) is another reference offering good general purpose 
hydraulic data.         

Related Topics

Junction Loss Models 281
Kv and Cv Loss Model 283
Resistance Curve Loss Model 284

Kv and Cv Loss Model
AFT Impulse allows the user to enter valve coefficient data in terms of Kv or Cv. Conversions are 
handled seamlessly in the background. Kv is the metric equivalent to Cv. 

Manufacturer Testing in Standard Units

Cv (Coefficient of flow for Valves) is a single parameter which relates fluid density (given in units 
of specific gravity), pressure drop (in psi), and flow rate (in gallons per minute). 

One can get a better understanding of the role of Cv by setting the pressure drop (dP) and SG to 
1, in which case Cv is equal to flow in gallons per minute. Cv could be considered the flow capa-
city (in gpm) of a given fluid (i.e. a given SG) for a given pressure drop. Or, one may wish to cal-
culate the pressure drop through a valve, with a given Cv at a given flow rate. 

Manufacturer Testing in Metric Units

If the engineer is provided with valve data in metric units, they are also likely to be provided a 
value for Kv and not Cv.
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The only difference is the units used for Q and dP. Kv uses flow units of m3/hr and pressure drop 
units of bar.

If one wishes to calculate pressure drop through a valve, with a given Kv, at a given flow rate, the 
same relationship applies.

Related Topics

Junction Loss Models 281
K Factor Loss Model 282
Resistance Curve Loss Model 284

Resistance Curve Loss Model
The resistance curve loss model is available in many different junctions. It is useful when meas-
ured flow vs pressure loss data is available for a component.

Clicking Enter Curve Data will open a new window where the input can be entered into a table. 
Several options for the Flow Parameter are available using the dropdown in the column header, 
and the appropriate units can be selected. Pressure loss can be alternatively entered as a head 
value.

Fill As Quadratic (Using a Single Known Data Point)

It is not uncommon to obtain only a single data point from an equipment manufacturer. For 
example, the data might be 3 psid pressure drop at 1 lbm/sec. In this case, the known data point 
can be entered into the first row of the data table. Then, selecting Fill As Quadratic will 
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automatically insert another two data points to be used with a quadratic curve fit. The first data 
point will be zero pressure loss at zero flow which is physically realistic for a static component. 
Note that elevation differences within a junction are accounted for externally by the Solver. The 
last data point will be a quadratic extrapolation using the zero point and the originally provided 
data point. Clicking Generate Curve Fit Now will create the curve fit constants and complete the 
resistance curve definition.

This method is often a reasonable approach to define a static component because the pressure 
drop characteristics of most equipment follows the square law. As the flow rate increases, the 
pressure drop increases with the square of the flow rate. Defining the component with a curve fit 
provides a robust solution where the junction can still provide a reasonable pressure loss even if 
the flow rate in the model is changed. This also aids in numerical convergence when running a 
transient simulation.

In our example, an increase in the flow rate to 2 lbm/sec would result in a pressure drop of 12 
psid. Although this may not be exactly correct depending on the component, it is much better 
than assuming a flat 3 psid drop for all flow rates, which we know for certain is not correct.

Table 1: Example data points for pressure drop modeling using manufacturer data

Data Point Flow Rate
(lbm/sec)

Pressure 
Drop
(psid)

Comment

1 0 0
Always valid 
for passive 
equipment

2 1 3 Given by man-
ufacturer

3 2 12
Extrapolated 

assuming 
square law

Curve Fitting

Curve fitting can be performed via a polynomial or interpolated data. The Curve Fit Order can 
also be changed to achieve a better fit to the data, and the curve fit constants are displayed in a 
table.

Note: Unrealistic behavior could occur if the curve fit does not pass through the origin of the 
graph. This may negatively impact convergence when running transient simulations 
that have zero flow through the component at a point in time. See the Troubleshooting 
Resistance Curves topic for more information.
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Reference Density

Options to correct for a reference density are available when using mass or pressure para-
meters. This is useful for when the pressure loss data was measured with a different working 
fluid than what is used in the model. See the Reference Density topic for more information.

Related Topics

Junction Loss Models 281
K Factor Loss Model 282
Kv and Cv Loss Model 283
Troubleshooting Resistance Curves 793
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Defining Junction Transients
This section contains information related to defining transient behavior for junctions in Impulse. 
Topics include discussions on standard junction transient information, transient initiation options, 
the infinite pipe boundary condition, and the Waterhammer assistant. For information on overall 
transient simulation controls see the Pipe Sectioning and Output group and Transient Control 
group.

Contents

Related Blogs

And, Not, Or - Starting Transient Events with Complex Logic

Junction Transient Data
Many junction types have an area where active transient data can be specified. Active transient 
in this context means that the behavior of a component over time is being directly defined by the 
user. It is also possible for components to react passively during the simulation as well - for 
example, a relief valve opening under excess pressure.

Table 1: Junctions that support transient data

The active transient data is entered on the junction's Transient tab.
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Figure 1: Transient tab for a Valve

In most cases, transient data can be entered as absolute values or as a percentage of steady-
state, as defined by the first options in Transient Data.

The first data point always needs to match the steady-state value which is usually entered on the 
Loss Model tab. If, for example in Figure 1, the steady-state data for Cv of 1000 is changed to 
750, the transient data will also need to be changed. 

Note: If a junction does not have any active transient behavior, there is no need to enter any 
data on the Transient Data tab.

Repeat Transient

If the transient data is periodic, you can enter the data for one cycle of the period and then tick 
the check box for Repeat Transient. This will cause the one cycle of transient data to be repeated 
once it has reached the end. The repetition will continue until the end of the simulation.

Transient Special Condition

There are instances where you will only wish to use the defined transient data in certain cases or 
scenarios. Instead of deleting the transient data, specify the Transient Special Condition as 
Ignore Transient Data. The data will be left in the window for future use, but will not activate dur-
ing the run.

A third type of Transient Special Condition is available for Assigned Flow and Assigned Pressure 
junctions. This is the No Reflections (Infinite Pipe) option. In such a case, the flow or pressure is 
used only for steady-state calculations. During the transient the flow or pressure is not fixed, but 
varies in accordance with the concept that no transient reflections occur. All transient data at this 
junction will be ignored. For more information see Infinite Pipe.
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There are multiple ways that the data entered in Transient Data can be applied during the sim-
ulation. The default selection is Time for most junctions, meaning that the behavior vs simulation 
time is directly defined by the user.

It is also possible to initiate a transient based on a system event. This will execute the Transient 
Data when a user defined parameter reaches a certain setting. For example, a valve can be set 
to close only when a specific flow rate becomes too low.

See Initiating a Transient for detailed information.

Related Topics

Pipe Sectioning and Output Group 184
Transient Control Group 191
Infinite Pipe 289
Waterhammer Assistant 500
Initiation of Transients 290
Multi-Condition Events 295

Related Blogs

And, Not, Or - Starting Transient Events with Complex Logic

Infinite Pipe
Infinite pipe is a special feature enabled with a Transient Special Condition in the Assigned Flow 
and Assigned Pressure junctions. This feature prevents the junction from reflecting pressure 
waves.

This is useful in modeling the part of a pipe system which is so long that its communication time 
prevents wave reflection interactions with the rest of the system during the simulation. During 
steady-state the flow or pressure is fixed, but during transient flow both the pressure and flow 
change in a manner consistent with the fact that no waves are reflected.

The infinite pipe feature can significantly reduce model run time. Any pipe long enough that it 
does not reflect any waves during a meaningful simulation time will also require a large number 
of sections. This may dramatically increase the number of calculations required, even if the beha-
vior in that particular pipe is not of interest. Using an infinite pipe is a way of avoiding significant 
computations for the pipe but still maintaining its effect on the system.

Note: The connected pipe must have at least two sections.

The theory for an infinite pipe is given in Infinite Pipe Transient Theory.  (Wylie et al., 1993, pp. 
121-122)
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Example

Figure 1: Example application of infinite pipe

Gasoline flows from a refinery to a tank farm 30 miles away. We want to know what the effect of 
closing the storage tank valve will be on the tank farm equipment.

The wavespeed of gasoline in these pipes is about 3500 ft/s - meaning that the communication 
time in P1 is about 90 seconds. If the transient simulation is less than this time, there is no need 
to model the entire pipe. Furthermore, P101 will require at least one section as the controlling 
pipe - this means that P1 will require almost 800 sections.

Alternatively, we can model P1 as only 400 feet in length (infinite pipes must be long enough to 
contain 2 sections) and apply the infinite pipe feature. This reduces the total number of sec-
tions in the model to about 5. For the same time step, this would mean that the number of cal-
culations required is reduced by a factor of more than 100.

The results from the second run will be identical as long as the simulation time is less than the 
communication time of P1.

Related Topics

Pipe Sectioning and Output Group 184
Transient Control Group 191
Junction Transient Data 287
Waterhammer Assistant 500
Initiation of Transients 290
Multi-Condition Events 295
Assigned Flow 309
Assigned Pressure 311
Infinite Pipe Transient Theory 710

Initiation of Transients
In general, transients can be initiated according to a certain time or according to certain events 
that happen in the system. These two categories are referred to as time based and event based 
transients. This is defined in the Initiation of Transient area of a junction's transient tab.
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Figure 1: Type of transient initiation

It is helpful to consider the different time scales that are used when referring to the initiation of a 
transient, as shown in Figure 2.

Absolute and Simulation Time are often identical. The simulation Start Time is set in Simulation 
Mode/Duration panel to an Absolute Time of zero seconds by default, but it could be non-zero. In 
Figure 2, the Simulation Start Time is set to a value of 2 seconds – the entire Simulation Time 
timeline is shifted forward 2 seconds.

Event Time refers to the time data defined in Transient Data this could be equal to Simulation 
Time (and Absolute Time) depending on how the event is defined. For example, all three time 
bases will match for a pump trip event starting at the beginning of a simulation with Start Time 
equal to zero. However, the event may not start until a certain system condition is met and zero 
Event Time could be well into the simulation.

Figure 2: Time bases

Time

Time based transients modify a parameter directly according to Simulation Time.

For example, consider a valve closure transient. The valve starts to close at two seconds into the 
simulation, and the time it takes for the valve to close is one second. After that, the valve stays 
closed. To define this event with the Time option, the Start Time must be set to zero, and the 
Transient Data must look something like the data shown in Figure 3.
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Figure 3: Defining a valve closure at a specific time

Single Event

Single Event initiated transients do not begin until a certain condition is met.

To completely define an Event, four parameters are required:

 l Event Type - What parameter is being considered to initiate the transient. See Table 1 
below for a list of the possible Event Types.

 l Condition - The logical relationship between Event Type and Value (e.g. greater than, 
less than, etc)

 l Value - The specific magnitude of the Event Type parameter at Location
 l Location - Where in the model the Value should be observed

Given the same valve closure profile described in Figure 3, we can set the valve to remain open 
until (and if) the pressure at the inlet of P7 exceeds 100 psia. Note that the Transient Data is 
identical - but the initiation of the event may happen at a very different time.

Figure 4: Event definition
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Table 1: Event types

Dual Event Cyclic

The Dual Event options, as the names imply, require the definition of two events. The definition 
for each event follows the same structure as a Single Event.

Dual Event Cyclic will continue monitoring both triggering events throughout the simulation and 
will apply the corresponding transient data when the conditions are met.

To continue with the valve example, we can define our valve not only to open when a pressure is 
exceeded, we can tell it to close when the pressure drops below a certain setting.

Figure 5: Dual Event set up. Note that a Second Event requires additional data for the Second Tran-
sient
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Dual Event Sequential

Dual Event Sequential is nearly identical to Dual Event Cyclic. In fact, all of the required user 
input is the same.

The difference is that the two defined events are only applied once. That is – after the second 
event is complete, no more transients will be applied even if the conditions are met. One com-
mon situation where this is useful is tripping and restarting a pump in AFT Impulse. Pump trip-
ping is often a one-time event rather than a function of normal operation, so it may not be 
desirable to define this as a cyclic event.

Junctions With Inherent Event Logic

There are three junction types in AFT Impulse which have built-in, or inherent, event logic. These 
are the check valve, relief valve and air valve. The user does not need to specify the nature of the 
events, and in fact is not allowed to. 

The inherent event logic is very similar to the Dual Event Cyclic logic described previously.

 l Check valve - The check valve has two built-in events. The first is that it closes when 
backflow starts to occur. The second is that it reopens when sufficient pressure dif-
ferential occurs. If the user does not enter a closing or opening transient in the check 
valve window, these transients are assumed to be instantaneous.

 l Relief valve - The relief valve has two built-in events. The first is that it opens when the 
cracking pressure is reached. The second is that it closes again when the pressure falls 
back below the cracking pressure. If the user does not enter an opening or closing tran-
sient in the relief valve window, these transients are assumed to be instantaneous.

 l Air valve - The air valve is very similar to the relief valve, and has two built-in events. The 
first is that it opens when the set pressure is reached. The second is that it closes again 
when the pressure rises above the set pressure and all gas is expelled.

Related Topics

Pipe Sectioning and Output Group 184
Transient Control Group 191
Junction Transient Data 287
Infinite Pipe 289
Waterhammer Assistant 500
Multi-Condition Events 295
Simulation Mode/Duration Panel 192
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Multi-Condition Events
An available Event Type  is Multi-Condition. This feature allows starting a transient based on 
more than one parameter in the model.

For example, it may be desirable to open a valve when either of two pressures is exceeded.

To define a Multi-Condition Event, first select Multi-Condition as the Event Type from the junc-
tion's Transient tab.

Figure 1: Selecting Multi-Condition Event Type

Event Manager

Clicking Multi-Condition Event opens the Event Manager, where Simple Events and Multi-Condi-
tion Events can be defined.

The Event Manager defines events model-wide. That is, if the active scenario is changed, the 
same events will be accessible.
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Figure 2: The Event Manager

Simple Events

The Event Manager allows for the definition of Simple Events and Multi-Condition Events.

Simple Events are nearly identical to normal (non Multi-Condition) events defined in a Transient 
tab. They require a Parameter, Condition, Value, and Object as well as a unique Name.

Clicking "Create Simple Event..." adds a new Simple Event to the list with default values. These 
values should be updated with the desired values and applied with the Update button. Simple 
Events can be duplicated to help reduce repeated data entry.

Multi-Condition Events

Multi-Condition Events are a collection of other Events with a logical condition applied to them. 
When creating a new Multi-Condition Event, a prompt for a Name appears. After entering a 
name, an empty Multi-Condition is created with a default logical condition of AND. This logical 
condition can be:

 l AND - All of the Simple Event conditions must be met for the Multi-Condition Event to trig-
ger.
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 l NOT - The Multi-Condition Event triggers when none of the conditions evaluate to true.
 l OR - One or more of the Simple Event conditions must be met for the Multi-Condition 

Event to trigger.

Figure 3: Conditional logic for Multi-Condition Events

Any number of Simple Events can be added to a Multi-Condition Event as Sub-Events:

Figure 4: Multiple Events

Complex Multi-Condition Events

More complex events can be defined by adding one or several Multi-Condition Events as Sub-
Events to another Multi-Condition Event.

Figure 5: A Multi-Condition Event containing another Multi-Condition Event (trigger if Limit 3 AND 
(Limit 1 OR Limit 2))
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Using Multi-Condition Events

All Multi-Condition Events are listed in the junction's Initiation of Transient section. Only one 
Multi-Condition Event can be selected as the Initiating Event for any particular Transient Data.

Figure 6: The selected Multi-Condition Event controls the trigger of the Transient Data. Hovering 
over the Multi-Condition events here shows an expanded definition of the event.

Related Topics

Pipe Sectioning and Output Group 184
Transient Control Group 191
Junction Transient Data 287
Infinite Pipe 289
Waterhammer Assistant 500
Initiation of Transients 290

Related Blogs

And, Not, Or - Starting Transient Events with Complex Logic
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Air Valve
The Air Valve junction type (also called a vacuum breaker valve) requires either one or two con-
necting pipes, which can be specified on the bottom of the Valve Model tab. 

The Air Valve Properties window follows the first of the two basic Properties window formats, dis-
playing the connecting pipes in a fixed format. The flow direction through the junction is determ-
ined by the defined directions of the connecting pipes. The Air Valve offers protection for low 
pressure conditions. When the internal pressure drops below the cracking pressure (usually 
atmospheric), it opens to admit air (or whatever gas you specify). This keeps the pressure from 
dropping much below the atmospheric pressure. When the internal pressure rises above the 
atmospheric pressure, the air is discharged. To prevent large pressure spikes, the discharge 
flowrate is frequently kept lower than the incoming flowrate by using a smaller discharge flow 
area for outflow than inflow. 

An air valve junction can connect with one pipe or two by changing this setting at the bottom of 
the Valve Model tab. When connected to one pipe, the valve is located at the end of the pipe. 
When connected to two pipes, the valve is inline and allows air to flow in and out at that location. 
During steady-state an air valve with one connecting pipe acts as a dead end. If connected to 
two pipes, it acts as a lossless valve allowing liquid to flow between the two pipes.

Assumptions

 l Gas volume entering the system stays at the junction which is a one dimensional point in 
space, and does not propagate down the length of the pipes.

 l The Air Valve opens and closes instantaneously when the cracking conditions are met.
 l AFT Impulse does not model two-phase flow; therefore, as the gas volume increases, so 

does the uncertainty in the simulation results.

Valve Type

There are four valve types available. The required information for Full Open Orifice CdA and the 
intermediate orifice will vary based on the selected Valve Type as described below.

 l Vacuum Breaker and Gas Release - Default option. This valve type allows gas inflow 
when the pressure in the pipe drops below the cracking pressure, then allows gas outflow 
when the pressure in the pipe rises above the cracking pressure.

 l Vacuum Breaker - This valve type allows gas inflow when the pressure in the pipe drops 
below the cracking pressure, but does not allow for gas outflow.

 l Gas Release - This valve type allows gas outflow, but does not allow any gas inflow. This 
is mainly intended to be used to model a scenario where there is gas inside the pipe at the 
beginning of the simulation, which is allowed to exit the pipe during the transient. Note 
that Impulse cannot model gas pockets travelling through the pipes, so this case assumes 
the gas is directly at the air valve.

 l Vacuum Breaker and 2-Stage Gas Release - This valve type works the same as the 
vacuum breaker valve type when gas is flowing in, but has two orifice sizes when gas 
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flows out. Pressure difference or volumetric flowrate criteria specify which orifice to use. 
When the actual value is less than the specified value, the normal Outflow CdA is used. 
When the actual value is higher, the intermediate orifice CdA is used. The intermediate ori-
fice CdA values are typically much smaller than the normal outflow CdA.

Gas Properties

By default, Impulse chooses air as the gas entering/exiting the Air Valve junction, and provides 
standard information for air including molecular weight and Cp/Cv for isentropic flow. These val-
ues can be adjusted by choosing Other for the gas type.

The gas external pressure, external temperature, and initial gas mass are set to typical values 
for an air valve. The Initial Gas Mass should generally be zero, unless pairing the Air Valve with 
the Partially Full Pipe feature on the Optional tab of a connected pipe. In the case of a Partially 
Full Pipe, a manual calculation can be performed to find the gas mass of the empty portion of 
pipe, and the result can be input into the Air Valve to track the amount of time needed to expel 
the gas.

Inlet Cracking Conditions

By default the inlet cracking conditions will be set equal to the external gas pressure/temperature 
defined in the Gas Properties section. The cracking conditions can be user specified if that 
option is enabled in the Advanced Parameters panel.

A cracking delay can also be specified to account for physical limitations of the valve, or distance 
from the line if the valve is modeled inline.

Liquid Temperature

Since the temperature of the liquid in the air valve is used for air valve calculations, the option is 
given to either use the temperature that was entered in the Fluid panel in the Analysis Setup win-
dow, or to explicitly define the temperature of the liquid at the valve.

Special Conditions

The Air Valve offers the special condition to Ignore calculations for the vacuum valve, meaning 
that it will be treated like a lossless valve. For more information, see Special Conditions.

Graphing Air Valve Data

By default, the air volume and mass flowrate in the junction will be saved to the output file, and 
the parameters can be graphed or reviewed in the Output window. The options for saving output 
are located in the Output Junctions panel of the Pipe Sectioning and Output group.
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Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Air Valve Waterhammer Theory 301
Typical Approaches to Reducing Transient Pressures 75

Related Blogs

Raise the bar using Vacuum Breaker Valves

Air Valve Waterhammer Theory
An air valve (sometimes called a vacuum breaker valve) allows air to flow into the pipe during low 
pressure events, and expels the air when the pressure rises again. Typically the cracking pres-
sure is atmospheric. The theory is summarized in Wylie, et al., 1993, pp. 130-131, and detailed 
here.

There are four cases that can occur – two for inflow and two for outflow. The inflow can be sub-
sonic or sonic, as can the outflow. These make up the four cases. The flowrate equations are 
given as follows:

 l Sonic Inflow - 

 l Subsonic Inflow - 

 l Sonic Outflow - 
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 l Subsonic Outflow - 

where:

 l Pi        = pressure in the pipe at the junction node
 l Po        = atmospheric pressure
 l To        = atmospheric temperature
 l TL        = liquid temperature
 l Cd Ai        = flow area for inflow (discharge coefficient times inflow orifice area)
 l Cd Aout        = flow area for outflow (discharge coefficient times outflow orifice area)
 l R        = gas constant
 l g        = specific heat ratio cp/cv

Equation of State

Besides the compatibility equations 1 and 2 and , we need another equation to form a complete 
set. The ideal gas equation of state is used:

Substituting terms one obtains

Eliminating the volumetric flowrate using the mass flowrate obtains
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Using the Compatibility Equations to eliminate mass flowrate yields:

(1)

Now we can use the Flowrate equations for each of the four inflow and outflow cases to eliminate 

as follows:

Sonic Inflow 

The pressure at the junction can be solved directly from Equation 1 as follows:

where  is the sonic inflow which can be calculated from the Sonic Inflow Flowrate equa-
tion based completely on input data.

Subsonic Inflow

Equation 1 is modified using the Subsonic Inflow Flowrate equation and solved iteratively using 
Newton-Raphson. Defining Pr = Pi /Po obtains:

Defining terms for Newton-Raphson solution yields
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where the function F is solved for Pr.
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Subsonic Outflow

Equation 1 is modified using the Subsonic Inflow Flowrate equation and solved iteratively using 
Newton-Raphson. Defining Pr = Pi/Po obtains:

Defining terms for Newton-Raphson solution yields
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where the function F is solved for Pr.

Sonic Outflow

Using the Sonic Outflow equation from above, the pressure at the junction can be solved directly 
from Equation 1 as follows:

Related Topics

Nomenclature 683
Method of Characteristics 701
Air Valve 299

Related Blogs
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Area Change
The Area Change junction type must always have two connecting pipes. This junction type 
allows you to model the irrecoverable loss that occurs at the area transition between two pipes, 
whether expansion or contraction.             

The Area Change Properties window follows the first of the two basic Properties window formats, 
displaying the connecting pipes in a fixed format. A flow direction through the junction is adopted 
from the defined directions of the two connecting pipes.             
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The Area Change Properties window offers two standard types of area change losses: the Con-
ical Transition and the Abrupt Transition.             

The critical parameter that influences the magnitude of the area change loss is the area ratio 
between upstream and downstream pipes. Until you have input the information for the upstream 
and downstream pipes that allow for flow area determination, the standard Area Change junction 
loss factor is not calculated. For conical transition geometries, you also need to specify the con-
ical angle. This angle has a range of 0-180 degrees, with a 0 degree angle representing a trans-
ition taking place over an infinitely long length, and a 180 degree angle representing an abrupt 
transition.             

If the standard loss factors provided are inadequate for your application, you may specify your 
own custom loss factor referenced to the base area you specify.             

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Area Change Loss Model 307

Area Change Loss Model
Two standard area change loss geometries are available: the conical transition and the abrupt 
transition.

The conical expansion correlation (Crane, 1988, A-26) is    

The conical contraction correlation (Crane, 1988, A-26) is
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The abrupt expansion correlation (Idelchik, 2007, 246) is    

The abrupt contraction correlation (Idelchik, 2007, 254) is             

Note: While a 180 degree conical transition is the same as an abrupt transition, Crane's con-
ical contraction equation gives a different result at 180 degrees compared to Idelchik's 
abrupt contraction equation. Therefore, it is up to the user to determine which one to 
use. 

All K factor equations are provided here in terms of the upstream pipe. The K factor in terms of 
the downstream pipe can be found as follows:
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Assigned Flow
The Assigned Flow junction type allows you to connect one pipe and to input a known steady-
state and/or transient flowrate entering or leaving at a particular location. An irrecoverable loss 
can also be included.

The Assigned Flow Properties window follows the first of the two basic Properties window 
formats, displaying the connecting pipe information in a fixed format. Depending on whether you 
specify the junction as an inflow or outflow type, the required connecting pipe (upstream/inlet or 
downstream/outlet) will be enabled while the other pipe is disabled. Note that if the flow is spe-
cified as Inflow (to the system) then the reference positive flow direction of the connected pipe 
must be away from the junction (i.e. the junction is upstream of the pipe).

The Assigned Flow junction will automatically switch the inflow/outflow parameter based on the 
reference flow direction of the connected pipe.

The Assigned Flow junction type allows you to specify positive flow rates as volumetric or mass 
flow rates. Negative flow rates are not accepted for steady flow, although they are for transient 
flow. If, for example, you have an outflow type junction and your system is physically flowing in, 
you cannot assign a negative flow rate to the junction. You must reverse the connecting pipe flow 
direction to be consistent with the actual direction and change from an outflow type to an inflow 
type.

Transient Data

On the transient data tab a flowrate transient can be entered. A special feature is the ability to 
model a sinusoidal flowrate transient. Input for the amplitude and frequency is required. If data is 
present in the transient data table, the sinusoidal transient is summed with the data in the tran-
sient data table. 

A chopped sine wave takes the absolute value of the sine function. The end effect looks like 
doubling the frequency in the positive domain only, and having nothing in the negative domain.

A transient special condition also exist for assigned flow junctions. This is the No Reflections 
(Infinite Pipe) special condition.

For more information on transient data, including event transients, see Junction Transient Data.
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Special Conditions

You can set a Special Condition for an Assigned Flow junction, which will turn the flow off and 
make it act like a Dead End during steady-state.

Special Features for Steady Flow

If the steady-state flow is zero at the junction, there may be occasions where you want the 
Assigned Flow junction to act like a pressure junction during the steady-state calculation. This 
would occur, for instance, if a known flowrate profile, initially zero, exists at the junction, and 
there are no other suitable pressure junctions in the system. In such a case, the pressure is 
assigned on the Optional tab.

Usually this feature would be used in conjunction with a Special Condition on the junction where 
its flow was turned off during steady-state.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Assigned Flow Waterhammer Theory 310
SSL Flow Rates 652

SSL Module 
Settling Slurry Module
An optional add-on module to AFT 
Impulse which allows users to sim-
ulate settling slurries.

Assigned Flow Waterhammer Theory
With an assigned flow, the flow rate is known at the pipe inlet or outlet (Wylie et.al 1993, pp. 43). 
The unknown is then the pressure, which can be obtained by solving the appropriate com-
patibility equation. If the flow rate is known at the upstream end of the pipe, the negative com-
patibility equation is used.             

Conversely, if the pressure is known at the downstream end, the positive compatibility equation 
is used.
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If the known flow rate changes with time, then a current flow rate is obtained for the current time 
step and used in the equations.

Assigned Flow Vapor Cavitation Theory

When the calculated pressure at an Assigned Flow junction drops below vapor pressure, a vapor 
cavity forms at the junction.

Assuming the specified flow is an inflow, the vapor volume calculation is as follows:

The ṁup terms are known because they are specified terms for inflow junctions. For outflow junc-
tions the ṁdown terms are known. Similar to a pipe interior node, when the vapor volume is neg-
ative, the cavity collapses and the fluid pressure then rises above the vapor pressure.    

Related Topics

Nomenclature 683
Method of Characteristics 701
Assigned Flow 309

Assigned Pressure
The Assigned Pressure junction allows for the specification of a fixed boundary pressure. The 
Assigned Pressure window follows the second of the two basic Properties window formats. A 
table on the Loss Coefficients tab displays the connecting pipe information.

This junction is very similar to the Infinite Reservoir in that it fixes a pressure at a boundary. 
However, the Assigned Pressure allows the definition of either a static or stagnation pressure 
boundary, whereas Reservoirs are always stagnation pressure. Typically, any pressure gauge 
on a pipe will be reporting static pressure - it is important to select static pressure if this is the 
actual boundary in the real system. A Reservoir would be inappropriate to represent such a pip-
ing connection with non-zero flow.

If stagnation is selected, the Assigned Pressure accepts the connection of up to twenty-five 
pipes. Static selection limits the connection to one pipe.
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Transient Data

On the transient data tab a flowrate transient can be entered. A special feature is the ability to 
model a sinusoidal flowrate transient. Input for the amplitude and frequency is required. If data is 
present in the transient data table, the sinusoidal transient is summed with the data in the tran-
sient data table. 

A chopped sine wave takes the absolute value of the sine function. The end effect looks like 
doubling the frequency in the positive domain only, and having nothing in the negative domain.

A transient special condition also exist for assigned pressure junctions. This is the No Reflec-
tions (Infinite Pipe) special condition.

For more information on transient data, including event transients, see Junction Transient Data.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Assigned Pressure Waterhammer Theory 312
Role of Pressure Junctions and How They Work 117

Related Online Content

 l Static vs. Stagnation Pressure Video

Assigned Pressure Waterhammer Theory
With an assigned pressure, the pressure is known at the pipe endpoint. The unknown is then the 
flow rate, which can be obtained by solving the appropriate compatibility equation.

If the pressure is known at the upstream end of the pipe, the negative compatibility equation is 
used (Equation 2). 

Conversely, if the pressure is known at the downstream end, the positive compatibility equation 
is used (Equation 1).
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If the known pressure changes with time, then a current pressure is obtained for the current time 
step and used in the equations.

Assigned Pressure Vapor Cavitation Theory

Assigned Pressure junctions cannot reach vapor pressure because the pressure is specified and 
is therefore always above vapor pressure.

Related Topics

Nomenclature 683
Method of Characteristics 701
Assigned Pressure 311
Role of Pressure Junctions and How They Work 117

Bend
The Bend junction type must always have two connecting pipes. This junction type allows you to 
model the irrecoverable loss that occurs when the flow direction changes through a bend or 
elbow.    

The Bend Properties window follows the first of the two basic Properties Window formats, dis-
playing the connecting pipes in a fixed format. A flow direction through the junction is adopted 
from the defined directions of the two connecting pipes.    

The Bend Properties Window offers three standard types of bend losses: the Smooth Bend, the 
Standard Elbow (the standard short radius threaded elbow), and the Mitre Bend. The window 
shows a schematic of the selected geometry. Until you have input the information for the 
upstream pipe that allows flow area determination, the standard Bend junction loss factor is not 
calculated. For smooth radius bends, you also need to specify r/D, which is the radius of 
curvature over the pipe diameter. At r/D less than one the Reynolds number must be known to 
calculate the loss factor, and therefore cannot be displayed until output is available.    

For bends that are not at a 90-degree angle, you can enter the angle and the standard loss factor 
will be calculated.    

If the standard loss factors provided are inadequate for your application, you may specify a cus-
tom loss factor referenced to the upstream pipe flow area.    
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Note: In principle, the upstream and downstream pipe diameters should be the same. 
However, the Bend junction only uses the reference area specified under Basis Area for 
Loss Model, even if the physical flow is in the opposite direction. If you are working with 
a user-specified loss, your geometry may have different diameter pipes connecting to 
the elbow. In this case, you would purposely define different upstream and downstream 
pipe areas. However, you would still want to be careful that the custom loss factor you 
assign is referenced to the correct area that is specified in Basis Area for Loss Model.    

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Bend Loss Model 314

Bend Loss Model

90 Degree Bends

The three Bend loss correlations are all for turbulent Reynolds numbers (Crane 1988, A-29).             

The K-factors for a smooth flanged bend with r/D ≥ 1 are provided in Table 1.             

Table 1: K values for 90 degree smooth flanged bends with r/D > 1                 

The standard threaded elbow is given by             
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where fT is the turbulent friction factor given in Table 2.             

Table 2: Pipe friction factors used for Crane formulas             

The Mitre bend is given by             

Non-90 Degree Bends             

The two non-90 degree bend loss correlations are for turbulent Reynolds numbers (Crane 1988, 
A-29).             

A smooth flanged bend with r/D ≥ 1 is given by             

where n is the number of 90 degree bends, K is the loss factor for one 90 degree bend (Table 1), 
and fT is given by Table 2.             

The Mitre bend is given by Table 3.             

Table 3: K values for Mitre bends             
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Smooth Flanged Bends, r/D < 1             

The smooth flanged bend with r/D < 1 loss factor uses a correlation applicable for turbulent Reyn-
olds numbers (Miller 1990, 209)             

The loss coefficient is calculated based on Miller's class 2 bend model, which is sufficient for gen-
eral design purposes, and is given by             

C0 and Cf are assumed to be 1 for class 2 bends. K*b is given by the nomograph on page 207 of 
Miller.             

For r/D > 0.7 or K*b < 0.4, CRe is given by Miller Figure 9.3. Otherwise, CRe is given by the equa-
tion below.             

where the CRe for r/D = 1 is also found from Miller Figure 9.3.

Related Topics

K Factor Loss Model 282
Bend 313

Branch
The Branch junction allows up to twenty-five connecting pipes. The Branch junction is the most 
flexible junction type for building network models that have flow splits. Other significant features 
are the ability to impose a steady-state and/or transient flow source or sink at the junction and 
the ability to specify separate loss factors for each connecting pipe. The Branch junction must 
have at least two connecting pipes.
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The Branch Properties window follows the second of the two basic Properties window formats. 

A table on the Loss Coefficients tab displays the connecting pipe information. This table grows in 
size to accommodate up to twenty-five connecting pipes. For each connecting pipe, the pipe 
table lists the reference flow direction and up to two loss factors. The first loss factor is for phys-
ical flow out of the branch and into the pipe. The second is for physical flow into the branch and 
out of the pipe. The loss factors can be specified independently or left as zero. The distance of 
each connecting pipe (if any difference exists) from the elevation can be entered in the pipe 
table.

The Branch junction also offers you the option of specifying a flow source or sink at the junction 
in the Optional tab. According to AFT Impulse's convention, a source of flow into the system is 
defined as positive, while a flow out of the system (a sink) is defined as negative. 

Transient Data

On the transient data tab a transient source or sink flowrate can be entered. For more inform-
ation on transient data, including event transients, see Junction Transient Data.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Branch Waterhammer Theory 317

Branch Waterhammer Theory
At a branch, there can be multiple pipes (Wylie et.al 1993, pp. 51-53). An additional relationship 
is needed, and that relationship is the conservation of mass. The total mass flow in and out of the 
junction must sum to zero. In addition, the branch has a single pressure solution, Pj, and this solu-
tion is common to all in-flowing pipes. The compatibility equation is written for each junction. For 
the pipes flowing into the branch, the positive equation is used (Compatibility Equations, Equa-
tion 1)

where Pj  is the branch junction pressure, as yet unknown.
For the pipes flowing out of the branch, the negative equation is used (Compatibility Equations, 
Equation 2)
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Now, sum all of the pipe flow rates into the junction

(1)

where

(2)

(3)

In general, there may be a known flow into the branch (a flow sink) or into the branch (a flow 
source). Therefore rewrite Equation 1 as

Now solve for the junction pressure

(4)

With the pressure known, substitute back into the compatibility equations to obtain the flow rate 
into the branch coming from each connecting pipe.

The applied flow rate may vary with time.

Branch Vapor Cavitation Theory

When the calculated pressure at a Branch junction drops below vapor pressure, a vapor cavity 
forms at the junction.
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Assuming a flow source/sink is specified, the vapor volume calculation is as follows:

where ṁB is the branch source/sink term defined as positive flow into the branch. The ṁin terms 
are obtained from the positive compatibility equation, while the ṁout terms are obtained from the 
negative equation.    

Similar to a pipe interior node, when the vapor volume is negative, the cavity collapses and the 
fluid pressure then rises above the vapor pressure.             

Related Topics

Nomenclature 683
Method of Characteristics 701
Branch 316

Check Valve
The Check Valve junction type requires two connecting pipes. This junction type allows you to 
model the effect of a check valve which closes to prevent back flow. 

The Check Valve Properties window follows the first of the two basic Properties window formats, 
displaying the connecting pipes in a fixed format. The Check Valve junction does not have an 
explicit flow direction, but adopts a flow direction from the connecting pipes for calculating loss. 
The user can define the base area for the loss model, though the default is set to use the 
upstream flow area.

A check valve is a device that allows flow in only one direction. AFT Impulse assumes that the 
Check Valve is initially open (unless modeled as Closed on the Optional tab). If the flow solution 
indicates that the system hydraulics are insufficient to keep the check valve open based upon 
the check valve input, AFT Impulse closes the valve. The valve can close during the steady-state 
or transient portion of the simulation.

AFT Impulse allows you to model the check valve by entering a User Specified closing velocity, 
using valve performance data to Estimate from Fluid Deceleration, or with a Force Balance cal-
culation. Further details about each of these types of check valve are discussed below.

For all of these options the Loss Model for the open valve can be specified as a Cv, Kv or K factor 
by choosing an option on the Valve Model tab and entering the Full Open value.

User Specified

The User Specified option opens and closes based on user-defined values for velocity to close 
and a delta pressure to reopen. For steady-state analysis the valve is either fully open, or fully 
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closed. In a transient analysis, the valve opens and closes instantaneously.

The inputs are as follow:

 l Forward Velocity to Close Valve - By default this value is zero. Some valves are 
designed to start closing at some reverse velocity - you can specify that here as a neg-
ative value. Entering a positive value in this field would imply that the check valve closes 
while the flow is still continuing forward.

 l Delta Pressure/Head to Reopen - Frequently after a check valve closes, there is pres-
sure across the valve at which it will open again. You can specify that delta pressure here.

Estimate from Fluid Deceleration (no reopen)

This option attempts to predict the maximum reverse velocity at which the valve will close. This 
maximum velocity is based on experimental predictions involving fluid deceleration and various 
check valve types from  (pages 241-243). Once the fluid deceleration is determined, the chart for 
Maximum Reverse Velocity vs. Fluid Deceleration is used to determine the Forward Velocity to 
Close for the check valve. If the deceleration is above the range given in the chart for the specific 
valve type selected, the transient run will be terminated, and a different valve type must be selec-
ted. Once the check valve closes, it will not reopen.             

There are three options provided to choose the Valve Performance Data Type that will be used 
for the Maximum Reverse Velocity vs. Fluid Deceleration chart.

 l Non-dimensional - The non-dimensional data sets are provided from  and . If this option 
is chosen, the user must provide the Minimum Velocity Required to Fully Open Valve, 
which is then used to find the Dimensionless Maximum Reverse Velocity.                     

 l Dimensional - This option uses the original dimensional data from  and , eliminating the 
need to convert to dimensionless values. This option may not be appropriate if the valves 
being modelled are not similar to the valve sizes used to obtain the experimental data. 
The dimensional data from Thorley was obtained using several sizes: the Moving Ball and 
Swing types used DN 100 (approximately 4 inches), the Split Disc types used DN 200 
(approximately 8 inches), and the Nozzle types used DN 300 (approximately 12 inches). 
The Ballun data used a size of DN 200 (approximately 8 inches).

 l User Defined - If dimensional data is available for the Maximum Reverse Velocity vs. 
Fluid Deceleration from the manufacturer, this option allows the user to directly define the 
curve to be used.                     

The Deceleration Calculation Interval is an optional input which allows the user to specify the 
time interval used to calculate the fluid deceleration. See the Deceleration Calculation Interval 
section below for further explanation. The resultant deceleration values can be viewed in the Out-
put window.

Force Balance

Force Balance data can be used to model two valve types, Swing Check and Translating 
Nozzle/Plug valves. Both models are based on work published in .             
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Figure 1: Swing Check valve diagram and optional Counterweight diagram

The Swing Check Valve model uses a torque balance to estimate rate and position over time for 
a swing check valve. The inputs for the swing check valve are as follows (reference Figure 1):

 l Disk Properties
 l Distance to CG (L) - The distance from the pivot point to the disk assembly center 

of gravity.
 l Area (A) - The surface area of the disk.
 l Weight (submerged, W) - The submerged weight of the disk assembly. If you do 

not know this value for the check valve you are trying to model, refer to the Approx-
imating Submerged Weight for the Swing Check Valve section.

 l Inertia (I) - The moment of inertia of the disk about the pivot point. If you do not 
know this value for the check valve you are trying to model, refer to the Approx-
imating Disk Inertia for the Swing Check Valve section.

 l Mass of Displaced Fluid - By default, a mass of fluid equal to the mass of a sphere of 
fluid the same diameter as the valve disk is added to the valve inertia term. The user can 
specify a custom fluid mass to be included by choosing User Specified, or choose to neg-
lect the fluid mass entirely by choosing None.

 l Include Counterweight and Lever -
 l Distance to Lever CG (Lc) - The distance from the pivot point to the lever's center 

of gravity.
 l Lever Weight (Wc) - The weight of the lever.
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 l Lever Inertia (Ic) - The moment of inertia of the lever about the pivot point.
 l Lever Angle (β) - The angle of the lever relative to the disk assembly about the 

pivot point. A positive beta denotes an angle counter-clockwise from the disk 
assembly to the lever (see Figure 1 above).

 l Valve Loss vs. θ Data - The fully open (minimum) angle and the fully closed (maximum) 
angle of the disk must be defined, as shown in the diagram. Additionally the Cv vs. θ  data 
must be defined in the table. A warning will be given to the user if the data in the table is 
inconsistent with the specified fully open and fully closed angles, or with the specified fully 
open Cv.

 l Include Spring
 l Spring Constant (k) - The torsional spring stiffness, if a spring is present. The 

value is zero if there is no spring.
 l Spring Torque With Valve Closed (T) - The residual torque exerted by the spring 

when valve is fully closed. The value is zero if there is no spring torque when the 
valve is closed.

 l Custom Orientation - By default, the orientation will be assumed to be horizontal which 
is shown in parentheses when the box is unchecked. Enabling this box allows the user to 
either specify the valve orientation as vertical, or for a user specified angle as measured 
from horizontal.

Figure 2: Translating nozzle/plug check valve diagram

The translating disk/plug check valve inertia model is solved using the force balance equation, 
the valve equation, and the positive and negative characteristic equations. The inputs are as fol-
lows (reference Figure 2):

 l Nozzle/Plug Properties
 l Max Travel Length (L) - The distance the disk/plug travels from fully closed to 

fully open.
 l Area (A) - The cross-sectional surface area of the disk/plug perpendicular to the 

flow.
 l Weight (W) - The weight of the disk/plug assembly.

 l Mass of Displaced Fluid - By default, the displaced fluid mass will be calculated using 
the distance travelled by the nozzle/plug. The user can specify a custom fluid mass to be 
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included by choosing User Specified, or choose to neglect the fluid mass entirely by 
choosing None.

 l Valve Loss vs. Travel Length - Variation of valve Cv in terms of Travel Length to Fully 
Open.

 l Spring Properties
 l Spring Constant (k) - The linear spring stiffness, if a spring is present. The value 

is zero if there is no spring.
 l Spring Force with Valve Closed (F) - The residual force exerted by the spring 

when valve is fully closed. The value is zero if there is no spring force when the 
valve is closed. This is used to calculate Xs, the spring length at which the spring 
force is zero.

 l Custom Orientation - By default the orientation will be assumed to be horizontal, which 
is shown in parentheses when the box is unchecked. Enabling this box allows the user to 
either specify the valve orientation as vertical, or for a user specified angle as measured 
from horizontal.

Deceleration Calculation Interval

This optional input is only applicable when using the Estimate from Fluid Deceleration check 
valve model. AFT Impulse needs to use the fluid deceleration to calculate the velocity at which 
the check valve will close (and therefore the time step of closure). Due to certain transient beha-
vior in a model, the deceleration may vary over time. For example, see Figure 3 below where the 
slope of the blue line changes over time. However, the Valve Performance Data (either the afore-
mentioned Thorley/Ballun data or a user defined curve) will need a single deceleration value to 
calculate the fluid velocity at closure (Max Reverse Velocity). Therefore, Impulse will approx-
imate the deceleration using the slope of a linear line from the time of initial deceleration (point 1) 
to the time when reverse velocity starts (point 2), as seen in the black dashed line. The default 
deceleration calculation might not accurately predict the velocity at which the check valve closes 
due to the slope of the blue and black lines differing at point 2.

The Deceleration Calculation Interval allows the user to manually specify a value for the time 
interval over which the slope (deceleration) is calculated. This effectively moves point 1 to a dif-
ferent time step. Impulse will then use the slope of the red dashed line as the value for decel-
eration.  In this case shown in Figure 3, the default method likely provides a more conservative 
estimate because higher deceleration (steeper slope) would result in a larger Max Reverse Velo-
city, which then can result in a larger hydraulic force from check valve slam.

Note: This option is best used after you have already run the model, analyzed a Velocity vs 
Time graph, and determined that the deceleration (slope of the Velocity curve) differs 
significantly over time. In some cases using this setting may produce a less con-
servative estimate for a pressure/force spike (ex. pump trips), while other times it will 
produce a more conservative estimate (ex. valve closure elsewhere in the system 
where the effective closure time is short).
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Figure 3: Example graph demonstrating how Impulse approximates the fluid deceleration for the 
Estimate From Fluid Deceleration Check Valve Model

Approximating Disk Inertia for the Swing Check Valve

The swing check valve model requires the user to input the disk inertia and the submerged disk 
weight of the check valve disk. If you do not know these values for the check valve you are trying 
to model, you can use the following equations to approximate these.

To approximate the disk inertia:
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Figure 3: Approximate disk inertia

Where:

Approximating Submerged Weight for the Swing Check Valve

You can use Archimedes' Principle to approximate the submerged disk weight:
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Special Conditions

A check valve can have a Special Condition of None, Closed (stays closed or allowed to reopen 
in transient), or Open (stays open).

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Kv and Cv Loss Model 283
Check Valve Waterhammer Theory 326

Check Valve Waterhammer Theory

Fluid Velocity at Valve Closure

Because a Cv is known in the models using either a user specified or estimated fluid velocity, the 
waterhammer theory for these is identical to a regular valve, except that the check valve closes 
when reverse flow occurs.

For the "Estimate from Fluid Deceleration" check valve, the fluid deceleration is calculated from 
the initial steady-state fluid velocity, the time at which the fluid begins to decelerate, and the time 
and velocity when the fluid first reverses through the valve by default. If a Deceleration Cal-
culation Interval has been entered, this value will be subtracted from the time when reverse velo-
city begins to determine the time of initial deceleration (t,initial deceleration  = t,reverse - 
Deceleration Calculation Interval). The velocity at this time will then be used as the steady state 
velocity.

For the Non-dimensional performance data, see the equations below.

Where:

 l Vsteady         = Steady state fluid velocity
 l Vreverse         = Fluid Velocity upon reversal
 l tinitial deceleration         = Time at initiation of fluid deceleration
 l treverse         = Time at fluid velocity reversal
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 l Dpipe         = Diameter of upstream pipe
 l V0        = Minimum fluid velocity to fully open the valve

Where:

 l Vmax,reverse        = Maximum reverse velocity at which valve will close

The maximum velocity at which the valve will close is determined from the specified Maximum 
Reverse Velocity vs. Fluid Deceleration chart using the calculated fluid deceleration. As an 
example, see the chart in Figure 1.

Figure 1: Non-Dimensional Fluid Deceleration vs. Maximum Reverse Velocity Chart with data from 
Thorley 2004(T) and Ballun 2007(B). 

Force Balance (Swing Check Valve)

The swing check valve force balance model is solved using the torque balance equation, the 
valve equation, and the positive and negative characteristic equations.

From Wylie equation 6-42, neglecting friction torque and any torques exerted by external ballast 
or springs (torsion springs on the disk pivot are included):
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Where:

Tw         = Torque due to the submerged weight of the disk
Te         = Torque due to spring torque applied at the disk pivot point
Tp         = Torque due to hydrodynamic pressures on the disk 
I         = Moment of Inertia of the disk about the pivot point

         = Angular acceleration of the disk about the pivot point

Wylie equation 6-43 for Tw :

Where:

W         = submerged weight of the disk

L         = distance from the pivot point to the disk center of gravity

α        = Valve orientation angle (for inclined or vertical pipes)

From Wylie equation 6-44 for Te :

Where:

S         = torsional spring constant

θ         = angle of zero spring torque

θs         = current disk angle
From Wylie equation 6-46 for Tp:

Where:

ΔP         = pressure difference across valve, in psid

L        = distance from the pivot point to the disk center of gravity

A         = surface area of the disk

The valve equation (Equation 1) can be solved for ΔP as shown in Equation 2, which is sub-
stituted in Wylie 6-46:
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(1)

(2)

Wylie equation 6-42 combined with the above equations becomes:

Along with the valve equation and the compatibility equations (Equations 3 through 5):

(3)

(4)

(5)

These four equations can be solved for θ, ṁ, Pup, and Pdn.    

Force Balance (Translating Nozzle/Plug Valve)

Similar to the swing check valve, the translating nozzle/plug check valve force balance model is 
solved using the force balance equation, the valve equation, and the positive and negative char-
acteristic equations.

From Wylie equation 6-51, neglecting friction force, and any force exerted by external ballast or 
springs (linear springs on the disk/plug are included), the force balance on the disk/plug is given 
by:
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Where:

Fw         = Force due to the weight of the disk/plug
Fe         = Force due to spring applied to the disk/plug
Fp         = Force due to hydrodynamic pressures on the disk/plug 
M         = Mass of the disk/plug and the mass of fluid that is moved

        = linear acceleration of the disk/plug

Force due to the weight of the disk/plug is given by:

Where:

W         = Weight of the disk/plug

α        = Valve orientation angle (for inclined or vertical pipes)

The force due to spring applied to the disk/plug is given by:

k        = Linear spring constant

Xs         = Length of spring at zero force
X         = Current disk/plug position

The force due to hydrodynamic pressures on the disk/plug is given by:

Where:

ΔP         = pressure difference across valve, in psid

A         = cross-sectional area of the disk/plug

The valve equation, can be solved for ΔP as shown in the swing check valve section and sub-
stituted into the hydrodynamic force equation above:
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The mass of the disk/plug and the mass of the fluid that is moved is given by:

By substituting in the force equations and mass equation given above, Wylie equation 6-51 
becomes:             

Along with the valve equation and the compatibility equations shown above in equations 3-5 in 
the swing check valve section, with Cv expressed as a function of X, these four equations can be 
solved for X, ṁ, Pup, and Pdn.    

Check Valve Vapor Cavitation Theory

The check valve vapor cavitation model is identical to a regular valve for all three types of check 
valve models, except that it closes when reverse flow occurs.

Related Topics

Nomenclature 683
Method of Characteristics 701
Check Valve 319

Control Valve
Control Valve junctions are always internal to the system, with two connecting pipes. This junc-
tion type allows modeling of valves that offer special pressure or flow control characteristics at a 
location in the pipe system.

The Control Valve Properties window follows the first of the two basic Properties window 
formats, displaying the connecting pipes in a fixed format. The Control Valve junction does not 
have an explicit flow direction, but adopts a flow direction from the connecting pipes.
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Control Valve Types

You can model four types of Control Valves: Pressure Reducing Valves (PRV's), Pressure Sus-
taining Valves (PSV's), Flow Control Valves (FCV's), and Pressure Drop Control Valves 
(PDCV's). Loss information for a Control Valve is not required, because Control Valves are 
dynamic devices that change their geometry in response to the pipe system behavior. The loss 
that results is that required to maintain the control parameter. You can, however, specify the full 
open loss. This is the loss that will occur should the valve fail to a full open state.

 l A PRV is a device that controls the pressure in a pipe system. The PRV maintains a con-
stant control pressure downstream of the junction as long as the upstream pressure 
exceeds the control pressure. If the upstream pressure is lower than the control pressure, 
the ability to control pressure is lost.

 l A PSV is similar to a PRV in that it controls pressure in a pipe system. While the PRV 
maintains a constant downstream pressure, the PSV maintains a constant upstream 
pressure. If the downstream pressure rises higher than the control pressure, the ability to 
control pressure is lost.

 l An FCV is a device that maintains a constant flow rate in a pipe system. By setting the 
junction to an FCV type and entering a flow rate, the junction will limit the flow through the 
connecting pipes to be equal to the control flow rate. The FCV can lose its ability to con-
trol flow when the pressure drop across it becomes zero or backward flow begins.

 l A PDCV is a device that maintains a constant (stagnation) pressure drop. For this option, 
the valve is never allowed to not meet its setpoint. An indicator that an unrealistic pres-
sure drop has been demanded is a failure to obtain a converged solution.

PRV/PSV Static vs Stagnation Pressure

The control pressure for a PRV or PSV can be either static or stagnation (HGL or EGL for con-
trolled Head). The default selection is static (HGL), as this is the most frequent application in 
industry.

Loss When Fully Open

By default, the valve will be set to model the valve with no loss if it fails open. This can be 
changed by choosing a loss model on the Control Valve Model tab to use Cv,Kv, or a K factor 
(not applicable for PDCV valve types). When Cv, or Kv, is selected, the option becomes avail-
able to pull the value from an open percentage table on the Optional tab, and the option to apply 
an Opening/Closing Rate limit for the valve becomes available.
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Action if Setpoint Not Achievable

 l Always Control During Steady State - It is possible that a control valve cannot achieve 
a given set point. By default this option is off - this can be changed in the Parameters sec-
tion of User Options. For additional information, see Control Valve Setpoint  Not Achiev-
able.

 l Use Default Actions - The behavior of the control valve when it fails can be modified by 
unchecking this option. The default behaviors represent the normal behaviors for the 
standard valve types.

Opening/Closing Rate Limits

If the default options for "Action if Setpoint is Not Achievable" are being used and the loss When 
Fully open is defined in terms of Cv or Kv, the maximum valve opening and closing rate limits can 
be specified. Rate limits allow the modeling of valves that have some type of limiting device 
which prevents the valves from opening or closing too quickly. If, during the transient, the pres-
sures would cause the valve to open or close faster than the rates specified in the rate limits 
table, the valve's loss value will be set to the value dictated by the rate limits. If no rate limits are 
defined Impulse will assume that the valve will close or open instantly if it fails.

Transient Data

Control Valve transients provide two Transient Parameter options, Control Setpoint and Cv.

The Control Setpoint transient can be applied to adjust the control setting of the valve during 
the transient. For instance, a change in control pressure for a regulator valve can be modeled.

The Cv transient is intended to model a case where the control valve transitions to a static valve 
at a fixed Cv. For example, a control valve in a feedback loop for a pump may transition to a fixed 
open percentage when a certain pressure is reached at the pump discharge. Another case 
would be if a control valve were to be fully closed or fully opened in an emergency situation. 
Once a Cv vs. Time transient begins, the control valve will not be able to regain control.

If the valve Cv when controlling is within the defined Cv vs. Time data when the control valve tran-
sient begins, the control valve will begin at the corresponding point on the Transient graph and 
open/close from that point, rather than starting at the defined time zero. If the valve Cv when con-
trolling falls above or below the defined table, the valve will jump to the closest point in the table, 
then proceed with the defined transient. For example, consider a defined closing transient which 
goes from a Cv of 200 to 100 as shown in Figure 1. If the valve is controlling at a Cv of 150, the 
valve will begin in the middle of the line at Cv = 150, then decrease to 100 (green line). If the 
valve Cv is 300 when the valve is controlling, then at the beginning of the transient the valve Cv 
will jump from 300 to 200, then follow the defined table until it reaches 100 (red line). If the valve 
is controlling at Cv = 50, then the valve will jump to a Cv of 100 and remain at 100 (purple line).
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Figure 1: Example cases for Cv vs. Time defined for a closing valve

Control valve transients support single events. Thus the regulator pressure could be modified 
when some event occurred in the system.

For more information on transient data, including event transients, see the Junction Transient 
Data topic.

Open Percentage Table

The Optional tab allows data to be entered for special control valve characteristics. Specifically, 
the valve Cv and Flow Area can be Specified vs. the Open Percentage of the valve. This data 
does not affect AFT Impulse's flow solution. However, engineers frequently desire to know the 
valve's open percentage during operation to ensure it meets design requirements. The Valve 
Summary (in the Output window) always displays the valve Cv, and if data is specified for open 
percentage and flow area it will also display open percentage and flow area at the operating 
point.

AFT Impulse can assist in creating this Cv vs Open percent curve. This is accessible in the 
optional by by selecting "Edit Table" and then "Create Cv vs. Open Percent...". This then opens a 
window in which a user defined, linear, equal percentage, or Pre-defined curve can be defined 
and transferred to the Cv vs. Open Percentage table.

Special Conditions

Control Valves have the following Special Conditions:
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 l Closed - No flow is allowed through the Control Valve.
 l Fully Open - No Control (can regain control) - Starts in the Fully Open position and 

uses the Loss When Fully Open value from the Control Valve Model tab of the Properties 
window (or Control Setpoint for the PDCV valve type). Throughout the simulation, the 
Control Valve can regain control if applicable.

 l Fully Open - Never Control - Remains in the Fully Open position for the entire sim-
ulation and uses the Loss When Fully Open value from the Control Valve Model tab of the 
Properties window (or Control Setpoint for the PDCV valve type).

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Kv and Cv Loss Model 283

Control Valve Setpoint Not Achievable
It is possible that the control valve cannot achieve the specified control setpoint. There are sev-
eral actions the valve can take in such cases.

Always Control During Steady State

The Always Control During Steady State feature is turned off by default since this option is phys-
ically unrealistic, but it can be useful for troubleshooting purposes. The reason this option is phys-
ically unrealistic is that the valve can add pressure to maintain control, thus acting like a pump. If 
this occurs, the user is clearly warned in the output. The Always Control option is useful because 
it gives a clear indication to the user of how far away the valve is from being able to control in the 
steady state. The default option for setting the control valve to Always Control can be adjusted in 
the Parameters section of User Options.

For transient analyses, if the Always Control is used during the steady state and the valve cannot 
meet the setpoint, the transient analysis will terminate.

Flow Control Valves

For flow control valves, other options for valves which cannot achieve control are to have the 
valve Open Fully or Close. By default the valve fully opens. Once the control valve loses control 
in the steady state, whether open or closed, AFT Impulse will solve the model again, using the 
defined loss model if the valve is open.
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Pressure Control Valves

Pressure control valves are more complicated. These valves have two potential actions when 
control cannot be achieved. The first action is when the control cannot be achieved due to insuf-
ficient upstream pressure. The second is due to excessive downstream pressure. The default 
behavior for pressure reducing valves is to Open Fully due to insufficient upstream pressure, and 
close due to excessive downstream pressure. The defaults for pressure sustaining valves are 
the opposite. You can override the default behavior by clearing the Use Default Actions selection 
and specifying the desired actions.

AFT Impulse will determine if the valve can maintain control based on the Loss When Fully Open 
value. If this fully-open pressure drop is greater than the pressure drop which balances the sys-
tem, the control valve can't achieve its setpoint. In other words, the control valve can't open wide 
enough (becoming less restrictive) to achieve control, and will revert to using the Loss When 
Fully Open specified by the user. If you enter data in the Open Percentage table on the Optional 
tab, you can select to have the data taken directly from the table for the 100% open case. You 
can also choose to not have any losses associated with the valve in the full-open state by select-
ing None.    

It is possible for the valve to control properly during the steady-state, and then lose control during 
the transient part of the run. In fact, it can lose control and regain it repeatedly as long as a Cv vs. 
Time transient event is not triggered.

Related Topics

Control Valve 331

Control Valve Waterhammer Theory
We can use the methods for known flow or pressure to calculate the conditions at a control valve. 
AFT Impulse flow and pressure control valves allow the control setting to be changed with time. 
Whether constant or changing, the flow or pressure is known and can be used to solve the equa-
tions.

Flow Control Valves

With the known flowrate, one can substitute into Equation 1 and Equation 2 and solve for the 
upstream and downstream pressures, respectively, at the valve. These can then be compared to 
the Action if Setpoint not Achievable settings to see if loss of control occurs. For instance, if the 
upstream pressure was less than the downstream, that would indicate loss of control.             

Once the valve loses control, it acts like a regular valve. However, it is possible for the control 
valve to later regain control if the upstream pressure raises sufficiently.
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Pressure Control Valves

Pressure control can be specified on the upstream or downstream side of the valve. A discussion 
of one these control locations will apply to the other. Let's consider the downstream pressure con-
trol case – a Pressure Reducing Valve (PRV).

With the known pressure downstream, one can substitute the known pressure into Equation 2 
and solve for the flowrate through the valve. This flowrate can then be substituted into Equation 1 
to solve for the upstream pressure. The upstream pressure can then be compared to the control 
pressure and Action if Setpoint Not Achievable settings to see if loss of control occurs. For 
instance, if the upstream pressure was less than the control pressure, that would indicate loss of 
control.             

Once the valve loses control, it acts like a regular valve. However, it is possible for the control 
valve to later regain control if the upstream pressure raises sufficiently.

Pressure Drop Control Valves

The flow through a constant pressure drop is obtained by subtracting Equation 1 and Equation 2 
and solving for flowrate.             

Related Topics

Nomenclature 683
Method of Characteristics 701
Control Valve 331

Dead End
The Dead End junction must always have one connecting pipe. This junction type is one way to 
define flow in a pipe as truly zero.

In steady flow, dead ends have no flow and thus play no role in the hydraulic solution to the sys-
tem. However, in transient flow pipes that terminate in dead ends can have flow. Thus dead 
ended lines can and do influence the transient response of the system. Unless you know oth-
erwise for a specific system, dead ends should always be included in the model.

The Dead End Properties window follows the first of the two basic Properties window formats, 
displaying the connecting pipes in a fixed format. The only required information is the connecting 
pipe and the elevation.
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Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Dead End Waterhammer Theory 338

Dead End Waterhammer Theory
A dead end is similar to an assigned flow, except the flow rate is zero (Wylie et.al 1993, pp. 44). 
The unknown is then the pressure, which can be solved by calling the appropriate compatibility 
equation.If the dead end is at the upstream end of the pipe, the negative compatibility equation is 
used with zero flow.             

Conversely, if the dead end is at the downstream end, the positive compatibility equation is used  
with zero flow.             

Dead End Vapor Cavitation Theory

When the calculated pressure at a Dead End junction drops below vapor pressure, a vapor cav-
ity forms at the junction.

Assuming the dead end is at the end of a pipe, the vapor volume calculation is as follows:

since the ṁdownterms are always zero. For dead ends at the beginning of a pipe, the ṁup terms 
are zero. Similar to a pipe interior node, when the vapor volume is negative, the cavity collapses 
and the fluid pressure then rises above the vapor pressure.    

Related Topics
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Method of Characteristics 701
Dead End 337

Gas Accumulator
The Gas Accumulator junction allows up to twenty-five connecting pipes. This junction type is 
useful for modeling a gas volume designed as a surge protection device (Figure 1). The Gas 
Accumulator may be integral with the pipe system, separated by an orifice, or by a short con-
nector pipe. During steady flow the gas accumulator typically acts a loss-less branch junction, 
although it can be made to act like a pressure junction. This is discussed later in the gas accu-
mulator section.

The Gas Accumulator Properties window follows the second of the two basic Properties window 
formats. A table displays the connecting pipe information. The table grows in size to accom-
modate up to twenty-five connecting pipes.

Figure 1: Schematic of a gas accumulator

Tank Geometry

The tank geometry is an optional input which allows Impulse to account for variations in the liquid 
level within the gas accumulator.
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Th vertical and horizontal tank types are programmed to allow Impulse to calculate the tank 
volume, height, or diameter based on two provided dimensions. For non-cylindrical tanks the 
other geometry option can be selected, which requires the user to directly input Accumulated 
Volume vs Liquid Height data.

Cap type selections are available to define the geometry of the tank cap/head as are defined in 
Crookston 2011 (see References for link).

Initial Gas Pressure

The Gas Accumulator provides two options for determining the steady state pressure at the accu-
mulator.

 l Calculate From Steady State - This option treats the gas accumulator junction like a 
lossless branch junction during the steady state. The pressure at the inlet of the gas accu-
mulator is determined based on the steady state pressure in the connected pipes.

 l Known - This option fixes the gas pressure to the specified value. The gas accumulator 
junction then acts like an assigned pressure junction based on the defined gas pressure. 
If the tank geometry is defined the hydrostatic pressure from the liquid is also accounted 
for. The main purpose of this option is to model a pressurizer as is discussed further 
below in the Known Pressure for Steady Flow section.

Initial Gas Volume

The Gas Accumulator provides two options for determining the steady state gas volume in the 
accumulator.

 l Known Volume - This option will fix the gas volume during the steady state to the spe-
cified value.

 l  Calculate From Precharge Conditions - This option will determine the steady state gas 
volume using the provided precharge conditions. The thermodynamic calculations for the 
steady state can be treated as isothermal or nonisothermal as described below:

 l Isothermal - Impulse assumes that the temperature is constant, so PV = constant. 
The steady state volume can be determined directly using the precharge volume 
and pressure, and the steady state pressure.

 l Non-Isothermal - Impulse assumes that the gas is an ideal gas in the steady 
state, so PV/T = constant. The precharge temperature must be provided in addi-
tion to the pressure and volume. The steady state volume can then be calculated 
using the precharge conditions, the steady state pressure, and the steady state 
temperature. The steady state gas temperature is assumed to be equal to the 
liquid temperature in the gas accumulator. The User specified liquid temperature 
option may be required if the fluid specified in the Fluid panel did not have a spe-
cified temperature.
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Polytropic Constant in Transient

Regardless of the method used to calculate initial conditions the gas volume will change during 
the transient according to the thermodynamic law described in Gas Accumulator Waterhammer 
Theory. The law requires a polytropic constant to relate the pressure to the gas volume. An isen-
tropic process should use a polytropic constant equal to the specific heat ratio of the gas (for air it 
is 1.4). An isothermal process should use a polytropic constant of 1. Typically the process falls in 
between the two and an average polytropic constant can be assumed (for air the average is 1.2).

The gas in the accumulator is assumed to behave as an ideal gas.

Maximum and Minimum Gas Volumes

If the gas is constrained in some way to a maximum or minimum volume, this can be entered in 
the optional fields. If a maximum or minimum exists, AFT Impulse will not allow the gas volume to 
exceed this value. If no data is entered, the volume can grow as large or small as necessary, 
though the gas volume will still be constrained to be less than the tank volume if Tank Geometry 
information has been entered.

Interface with Pipe System

The Gas Accumulator can connect into the pipe system in three ways: it can be integral with the 
pipe, it can be separated by an orifice, or it can be connected by a short pipe.

These options are provided in the Flow Restrictor and Short Connector Pipe areas. If neither 
option is used, the accumulator is assumed to be attached directly to the pipe with no hydraulic 
loss.

 l Flow Restrictor -  The accumulator is assumed to be separated from the pipe system by 
an orifice, which causes a hydraulic loss as the liquid flows in and out of the accumulator. 
The loss is specified by entering a flow area and inflow/outflow discharge coefficient.

 l Short Connector Pipe - This pipe is considered to be short in relation to the other pipes 
in the system after they are sectioned. If the pipe is short, it can be assumed to react 
instantaneously with the accumulator. The short pipe accounts for liquid inertia and fric-
tion. If a connector pipe exists which cannot be considered short, it should be modeled as 
an actual AFT Impulse pipe.

The Flow Restrictor and Connector Pipe can both exist in the same accumulator. That is, a flow 
restrictor can be modeled at the top of a connector pipe, and the effect of both will be included. 
The loss model for the Flow Restrictor and Short Connector Pipe options is discussed in the 
Lumped Inertia Pipe with Orifice topic.
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Model Relief Valve

On the optional tab on the Gas Accumulator Properties window there is an additional option to 
model a relief valve on the gas accumulator. This option allows gas to be expelled from the accu-
mulator to prevent pressures from exceeding the relief pressure specified. The relief valve on a 
gas accumulator is one way and gas will not flow into the accumulator. Once all of the gas has 
been expelled or the minimum volume is met  the accumulator will essentially be a liquid full stag-
nant region and will not  have dynamic system behavior. In other words, once all of the gas is 
expelled from the gas accumulator it will behave as a loss-less branch if the accumulator is inline 
or as a dead end if the accumulator is at the end of a pipe.

Special Condition

The special condition for the Gas Accumulator on the optional tab allows the user to set Impulse 
to ignore the accumulator. See Special Conditions for more information.

Known Pressure in Steady Flow

As mentioned previously, the gas accumulator acts like a branch junction during steady flow. 
However, the user can specify that it behaves like a pressure junction by using the Known Initial 
Pressure option. Why would one want to do this? The most obvious case is where the gas accu-
mulator is modeling a pressurizer type of component in a closed system. A pressurizer is some-
times called an expansion tank or accumulator. The main purpose is to provide thermal 
expansion volume when the temperature of the process fluid changes. Sometimes these tanks 
are open to the atmosphere, in which case a Surge Tank would be a better choice than a gas 
accumulator. When a pressurizer is modeled as a gas accumulator, there will typically be no 
other pressure type junctions in the system. In fact, the pressurizer is the component which con-
trols the static pressure on the system during steady-state operations. However, during tran-
sients the pressure will change. Thus there is a need to allow a gas accumulator to act as a 
pressure junction during the steady-state, and then like a normal gas accumulator during the 
transient, as can be done with the Known Initial Pressure option. When the accumulator is a pres-
surizer during steady-state, it has zero net flow. The pressure entered will be the steady-state 
static system pressure. 

The gas accumulator junction can also be used with the Known Pressure in Steady Flow option  
to represent a closed tank with a known steady state pressure. In this case the steady state flow 
to the gas accumulator junction will be non-zero, and a caution will be given at run-time. 

Graphing Gas Accumulator data

You can track the gas volume, liquid volumetric and mass flowrate, gas pressure, and liquid 
height in the accumulator by selecting these options in the Output Junctions panel of the Pipe 
Sectioning and Output group. These parameters can be graphed or reviewed in the Output win-
dow.
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Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Gas Accumulator Waterhammer Theory 343
Lumped Inertia Pipe with Orifice Waterhammer Theory 278
Typical Approaches to Reducing Transient Pressures 75

Gas Accumulator Waterhammer Theory
A gas accumulator (shown in Figure 1) is an enclosed tank filled with gas and has a free surface. 
It is used as a surge suppressor (Wylie, et al., 1993, pp. 125-128).The flow balance on the accu-
mulator junction is similar to a branch junction, with the deficit equaling the flow out of the accu-
mulator, ṁA.

Similar to a branch, it can be shown that for all connecting pipes to the junction,

where SC and SB are given by Equations 2 and 3 from Branch Waterhammer Theory. The poten-
tial connector pipe and orifice effect is incorporated by the lumped inertia relationship as follows

where C1 and C2  are defined in conjunction with lumped inertia. Refer to Equations 1 and 2 
from the Lumped Inertia Pipe topic. The Δhliquid is the height of liquid in the accumulator from the 
bottom of the accumulator, and is assumed to be zero if the tank geometry is not defined.
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Figure 1: Gas accumulator schematic 

The gas volume and pressure in the accumulator can be related by the thermodynamic law

where n is the polytropic constant (1.4 for isentropic air, 1.0 for isothermal) and CA is a constant.
Therefore,

and

By substitution

or
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Combining equations and simplifying,

where

This is a non-linear equation that can be solved using Newton-Raphson iteration. Newton-Raph-
son has the following form:

where xi is the current value of x, xi+1 is the new value, F is the function of x to drive to zero, and 
F´ is the derivative.

In this case

When the value of ṁA,new has been found that causes F to equal zero, the equation will be sat-
isfied. To solve by Newton-Raphson the derivative of F is given by,
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where

By iteration, ṁA,new is calculated. This value can then be back-substituted to obtain the new junc-
tion pressure and new gas volume.

Gas Accumulator Vapor Cavitation Theory

Any short-lived vapor cavities that develop at a Gas Accumulator junction are assumed to have a 
negligible effect compared to the accumulator itself. Conceptually, vapor bubbles would rise by 
buoyancy to the accumulator surface and evaporate into the accumulator gas. Their effect on the 
system would thus be negligible compared to that of the accumulator gas. Therefore, vapor cavit-
ation is ignored at gas accumulators.

Related Topics

Nomenclature 683
Method of Characteristics 701
Gas Accumulator 339

General Component
The General Component junction type is internal to the system and requires two connecting 
pipes. This junction type allows you to model the irrecoverable loss that occurs through equip-
ment that may not be explicitly represented on the Toolbox and to specify loss factors as a func-
tion of a flow parameter.    

The General Component Properties window follows the first of the two basic Properties window 
formats, displaying the connecting pipes in a fixed format. The flow direction through the junction 
is determined by the defined directions of the connecting pipes.    

When you select Variable K-Factor or Resistance Curve, the General Component Properties 
Window makes additional features available. You can specify polynomial constants, fit a curve to 
available data, or use interpolated x-y data.    

When a variable loss is specified, AFT Impulse modifies the loss factor in the Solver to agree 
with the solution. You can choose any of the optional flow and pressure parameters provided, 
and you can specify the most convenient units.

No transient data can be entered for a General Component. From a transient point of view, the 
junction is a static element. For this reason the user should use General Components with cau-
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tion. Where possible all static element hydraulic losses should be entered into pipes and not junc-
tions.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Resistance Curve Loss Model 284
Troubleshooting Resistance Curves 793

Liquid Accumulator
The Liquid Accumulator junction allows up to twenty-five connecting pipes. This junction type is 
useful for modeling a liquid chamber that has more elasticity than the pipe itself. This may be a 
liquid-solid tank or a condenser box, for example.     

The Liquid Accumulator Properties window follows the second of the two basic Properties win-
dow formats. A table displays the connecting pipe information. The table grows in size to accom-
modate up to twenty-five connecting pipes.     

Initial Conditions and Elastic Process    

The relationship between liquid accumulator volume and pressure is assumed to be linear. The 
amount of volume change for a given amount of pressure change is given by the elasticity of the 
accumulator. Note that this value should include both the effect of the flexibility of the container 
and the effect from the compressibility of the fluid. This input will need to be obtained from test 
data or approximated based on mechanical correlations.    

The Initial Volume of the tank is a required input. This volume will change during the transient 
according to the linear law.    

Special Condition    

The special condition for the Liquid Accumulator on the Optional tab allows the user to set 
Impulse to ignore the accumulator. See Special Conditions for more information.    

Related Topics

Junctions 267
General Junction Information 267
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Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Liquid Accumulator Waterhammer Theory 348

Liquid Accumulator Waterhammer Theory
A liquid accumulator, also called a lumped capacitance, models a liquid- filled container in a sys-
tem (Wylie 1993, pp. 124-125). The interaction with the pipe system occurs as the container 
stretches and contracts in response to transient pressures. The liquid accumulator is similar to a 
branch, and thus the same equations are involved.    

where SC and SB are given by Equations 2 and 3 from Branch Waterhammer Theory. The rela-
tionship between accumulator pressure and volume is assumed to be linear,

where K’ is the effective bulk modulus of elasticity of the container, which describes the elastic 
effects of both the fluid and container, and has units of pressure. The change in volume can be 
related to flow rate as follows:

Therefore, 

Substituting and eliminating flow rate

- 348 -



Liquid Accumulator Vapor Cavitation Theory

When the calculated pressure at a Liquid Accumulator junction drops below vapor pressure, a 
vapor cavity forms at the junction.

The vapor volume calculation is as follows:

where ṁA is the accumulator flow out of the junction. The ṁin terms are obtained from the pos-
itive compatibility equation, while the ṁout terms are obtained from the negative equation.    

Similar to a pipe interior node, when the vapor volume is negative, the cavity collapses and the 
fluid pressure then rises above the vapor pressure.

Related Topics

Nomenclature 683
Method of Characteristics 701
Liquid Accumulator 347

Orifice
The Orifice junction type requires two connecting pipes, unless you specify it as an exit orifice, in 
which case only one connecting pipe is allowed. This junction type allows you to model the irre-
coverable loss that occurs through a plate-type flow restriction. It also allows you to specify loss 
factors as a function of a flow parameter and an orifice loss for pipes with an area change.

The Orifice Properties window follows the first of the two basic Properties Window formats, dis-
playing the connecting pipes in a fixed format. The Orifice junction does not have an explicit flow 
direction, but adopts a flow direction from the connecting pipes.

Orifices that are located at an exit are specified as exit orifices. These orifices require an asso-
ciated back pressure definition. Exit orifices can only be connected to a single upstream pipe. To 
specify an exit orifice, select the Exit Orifice checkbox, then specify the exit pressure/head.
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Orifice Types

AFT Impulse provides two standard orifice types: sharp-edged and rounded. These loss factors 
are calculated based on correlations. In addition to the standard orifices that AFT Impulse 
provides, you may enter your own custom orifice loss factor that is consistent with the applic-
ation.

For convenience, you can specify constant loss characteristics of an orifice as a discharge coef-
ficient (Cd) or as a loss factor (K). The standard orifice geometries include a functional depend-
ence on the upstream and downstream pipe areas, which may be different.

When you select Resistance Curve, the Orifice Properties Window makes additional features 
available. Using these new features, you can input orifice loss factors or pressure drops that vary 
with flow. To enter these factors, you can specify polynomial constants, fit a curve to available 
data, or use interpolated x-y data. When a variable loss is specified, AFT Impulse modifies the 
loss factor in the Solver (the part of AFT Impulse that applies the governing incompressible flow 
equations to obtain a solution to the pipe system) to agree with the solution. Here you can spe-
cify any of the available optional flow and pressure parameters using your preferred units.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Resistance Curve Loss Model 284
Troubleshooting Resistance Curves 793
Orifice Loss Model 350

Orifice Loss Model

Sharp-Edged Orifice with Identical Upstream and Downstream Diameters

The orifice loss factors are all for turbulent Reynolds numbers. The sharp-edged orifice shown in 
Figure 1, is given by the following (Idelchik 2007, 259):
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Figure 1: Sharp-edged orifice (in this case Aup = Adown)

Round-Edged Orifice with Different Upstream and Downstream Diameters

When the upstream and downstream pipe diameters are different for a round-edged orifice as 
shown in Figure 2, the round-edged orifice equation for different pipe areas is used and is given 
by the following (Idelchik 2007, 258)

where

 
Figure 2: Round-edged orifice with different upstream and downstream pipe areas

Round-Edged Orifice with Identical Upstream and Downstream Diameters

When the upstream and downstream pipe diameters are the same for a round-edged orifice as 
shown in Figure 3, the round-edged orifice equation for the same pipe areas is used and is 
given by the following (Idelchik 2007, 262)
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where

 

 
Figure 3: Round-edged orifice with the same upstream and downstream pipe areas

For other orifice configurations, see Chapter 4 of Idelchik's Handbook of Hydraulic Resistance 
(2007).             

Orifice Discharge Coefficient

The relationship between orifice CD and K is given by Crane A-20:

where β is the diameter ratio of the orifice diameter to the upstream pipe diameter, or

Related Topics
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K Factor Loss Model 282
Orifice 349

Pumps
The Pump junction allows you to model the pressure added to a system by a pump, and model 
many transient events involving pumps. Because all pumps are different, AFT Impulse does not 
provide any standard pump types. Pressure and flow data that describes the pump must be 
obtained from the manufacturer or from test data. To reduce repeated data entry, frequently-
used pumps can be added to the Junction library.

Common Input Information

Like all junctions, pump junctions require a junction number, junction name, and inlet and outlet 
elevations. Similar to other junctions, pumps can have Design Alerts and Notes applied to them. 
They require two connecting pipes, unless the Submerged Pump option is enabled. Note that the 
direction of the connected pipes define what side of the pump is suction and which is discharge.

Pump Model

This tab requires the selection and definition of what type of pump the junction represents. There 
are two models currently available:

 l Centrifugal (Rotodynamic) - Represents a typical centrifugal pump where the head 
added to the fluid is related to the flow through the pump via a pump curve.

 l Positive Displacement - Represents a steady state approximation of a positive dis-
placement pump. The flow is fixed to a constant value, and whatever head is necessary to 
obtain that flow will be supplied.

 l Pump As Turbine - Under reverse flow, centrifugal pumps can be made to generate 
power and act as a turbine. This option represents such a situation.  

Figure 1: Pump Models

Variable Speed

This tab allows the speed of the pump to vary either by a fixed amount, or dynamically. These 
options are only available for a centrifugal pump.
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 l Fixed Speed (%) - Directly modify the pump curve according to the Affinity Laws. The 
Pump Curve entered in Pump Configuration is always assumed to be the 100% speed 
curve.

 l Controlled Pump (Variable Speed) - Dynamically change the speed of the pump to 
meet a specified control setpoint. Instead of allowing the flow or head to vary with a fixed 
speed, the speed of the pump (and thus Pump Curve, according to the Affinity Laws) var-
ies to meet a fixed flow or head. If modeling a suction or discharge pressure, control can 
optionally be enforced only if the value is above/below the setpoint.

Slurry De-Rating

(SSL Module Only)             

Pump head degradation occurs when pumping solids. This is known as de-rating. This option is 
not available for the Pump as Turbine.

Transient

The pump junction allows several types of transients:

 l Without Inertia
 l None - Do not apply any transient, maintain the speed set throughout the tran-

sient, or modify the speed to meet the Variable Speed setpoint.
 l Speed vs. Time - Directly specify how the speed of the pump changes over time. 

This can be used to model startups, trips, or control transients.
 l With Inertia - Account for speed changes of a centrifugal pump impeller with an Inertial 

Model.
 l Startup - Along with the torque characteristics of the associated motor or driver, 

determine the speed change over time of the pump under an uncontrolled startup.
 l Trip - Determine the speed change of the pump under instantaneous loss of motor 

or driver torque, such as during a power failure.
 l PAT Transient

 l Full Load Rejection - Decouples the pump impeller from the motor and the PAT 
transitions from operating as a turbine to operating while decoupled. 

For more information on transient data, including event transients, see Junction Transient Data.

All of the transient options need to know when to start with Initiation of Transient and allow the 
definition of a Transient Special Condition.
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Figure 2: Pump Transients

Optional

There are several optional parameters that can be defined for a pump. Some of these are avail-
able to most junctions such as Initial Guesses, Display on Workspace, Design Factor, and Work-
space Icon.

Also present are several pump junction specific options:

 l Special Condition
 l None - The pump operates normally.
 l Pump Off No Flow - The pump is shut off and blocked. This is identical to a 

closed valve.
 l Pump Off With Flow Through - The pump is shut off but allows flow to continue 

through. This is identical to a lossless connection.
 l Number of Pumps at This Location - Several pumps can be represented by one pump 

junction. This simplifies the model by reducing the number of pipes and junctions present, 
as well as automatically calculating the resulting composite pump curve. This option is not 
available for the Pump as Turbine.

 l Use Viscosity Correction - Pump performance changes if the system fluid viscosity is 
different than the pump test fluid viscosity. Viscosity Corrections allow the user to account 
for these changes. This option is only available for the Centrifugal Pump model.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Affinity Laws 408
Submerged Pump 410
Pump Transients 412

- 355 -



Defining Junction Transients

Related Blogs

What Does “Head (HGL)” Mean for Submerged Pumps and Exit Pressures?

Centrifugal Pump Overview

Standard Pump Curve

A Standard Pump Curve is required to model a centrifugal pump. This is the typical Head or Pres-
sure vs. Flow information that will be available from any pump manufacturer. Certain features 
also require the definition of an NPSHR curve, and Power or Efficiency curves.

To enter these curves, click Enter Curve Data. Once this data has been defined, previews of the 
applied curves can be seen here.

Figure 1: Standard Pump Curve

Performance Curve Used in Simulation

This section allows users to specify whether their pump will operate on the Standard Pump 
Curve they have defined, or on a Four Quadrant Curve. If it is known that the pump will never 
experience reverse flow, the Standard Pump Curve is sufficient. However, if it is possible for 
reverse flow to occur, the user should use the Four Quadrant Curve option, as it is important to 
accurately account for effects outside the Normal Pumping Zone (positive head, flow, and 
speed). 
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If the Standard Pump Curve is chosen, the only required input is the pump curve data, and that 
curve will always be used in the transient simulation. If reverse flow is encountered during the 
transient simulation, a warning will be presented, and the model should be adjusted accordingly. 
Impulse will attempt to estimate the effects of reverse flow by applying the zero-flow (deadhead) 
value to the fluid, but this is a rough estimate, and the users should modify the pump junction to 
use a four-quadrant curve if the pump sees large or sustained reverse flows. 

If the Four Quadrant Curve is chosen, the user will be required to input the pump curve data, and 
select a Four Quadrant data set. To select a Four Quadrant data set, the user can either allow 
Impulse to Automatically Select the data set, or they can select a set manually. The Auto-
matically Selected option will chose a data set based on the estimated specific speed of the 
user's pump. 

When a Four Quadrant Curve is being used, the user has the option to allow Impulse to Prevent 
Reverse Rotation. This setting would reflect a physical device used to prevent the pump impeller 
from rotating in reverse, such as an impeller ratchet or similar. Reverse rotation can be pre-
vented independently of reverse flow - enabling only this option will still allow reverse flow, but 
the impeller will not change directions under sustained reverse flow.

Figure 2: Performance Curve and related options

Model Combined Check Valve and Pump

This option adds a simple check valve to the pump junction to limit the reverse flow. 

 l Forward Velocity to Close - The forward velocity under which the check valve closes. 
Once this velocity is reached during the simulation, the check valve will instantly close, 
preventing further flow. A check valve that closes under reverse flow requires a negative 
value to be entered for the Forward Velocity to Close. 

 l Delta Head/Pressure to Re-Open - The check valve can re-open during the simulation. 
In order to do so, it must have a corresponding pressure or head difference across it 
defined. A positive value here indicates that the upstream pressure must be higher than 
the downstream pressure.
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Note: The Combined Check Valve is limited in its ability to capture the potentially complex 
behavior of a check valve. Including the Check Valve within the Pump provides a con-
venient input method and also avoids modeling short pipes which lengthen the transient 
simulation. If the behavior of the check valve is critical to the system, it is recommended 
to use the Check Valve junction.

Figure 3: Model Combined Check Valve and Pump

Trimmed Impeller

These values allow representation of different impeller trims without the need to input new 
curves.

 l Ratio as Percent - This option assumes that the pump curve represents 100% trim. 
Entering different values adjusts the pump curve with the Affinity Laws.

 l Actual Impeller - Only available if Multiple Configurations are defined. In this case, a 
dimensional value for impeller size can be entered here.

Figure 4: Trimmed Impeller

Submerged Pump

Represents a pump with a fixed head or pressure at suction. See Submerged Pump.

Flow Directional Behavior

A visual representation of the modeled pump is presented in the lower right of the properties win-
dow. This provides immediate feedback on what the various options represent. In the pump 
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depicted in Figure 5, a Four Quadrant Curve is being used, modeled to prevent reverse rotation 
and have a check valve that closes at a negative forward velocity. 

Figure 5: Visual diagram of model

Related Topics

Centrifugal Pump Configuration 359
Multiple Configurations 364
Standard Pump Curve Waterhammer Theory 368
Viscosity Correction 395
Four Quadrant Model Overview 372

Related Blogs

Determine Your Pumps BEP and Know API-610's Recommendations

Centrifugal Pump Configuration
The pump configuration window is used to define the specific operation of a centrifugal pump. It 
is opened with the Enter Curve Data button from the Pump Properties Pump Model tab when 
Centrifugal is selected. 

Figure 1: Enter Curve Data
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Configuration Method

By default a pump is defined as a Simple configuration. This indicates that the pump junction can 
represent only one pump - defined by the curves in pump configuration.

If the Configuration Method is changed to Multiple, additional input becomes available on the 
right of the configuration window. This allows defining different operating speeds or impeller dia-
meters for this pump, along with those configuration's specific curves. See a detailed description 
in Multiple Configurations.

Pump Data

The first tab of the pump configuration controls the pump's most basic behavior - the pump 
curves. 

Figure 2: Pump Configuration Window

A Pump can have three curves defined:
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 l Flow vs. Head/Pressure - Required. This is what is commonly referred to as the "pump 
curve" and defines how much head a pump can add to a fluid at any given flowrate.

 l Flow vs. NPSHR - (Optional) The NPSHR varies with flow and can be specified for a 
pump. Without specifying this curve, it is impossible to determine if cavitation may exist 
within the pump.

Note: NPSHR calculations require a reference elevation, which is defined in the Pump Prop-
erties window. For most pumps, the NPSH Reference elevation is the centerline of the 
suction of the pump. However, this should be checked with the pump manufacturer to 
determine where the NPSH curve is referenced.

 l Flow vs. Efficiency/Power - (Optional) The efficiency or power curve can be used to cal-
culate the Best Efficiency Point (BEP), which is used for a variety of purposes. The defin-
ition of this curve also allows for the calculation of the actual power used or efficiency of 
the pump at it's operating point. Without this curve, pump efficiency is assumed to be 
100%.

After entering the raw values into the table, the data needs to be curve fit.

If Mass Flow, Pressure, or Power are used in the curve definitions, Reference Density becomes 
an additional required input.

Configuration Data

This tab controls some additional behavior or input for a pump junction. Entering or changing val-
ues on this tab is optional. 
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Figure 3: Configuration Data

 l Best Efficiency Point (BEP) - The Best Efficiency Point (BEP) by default is calculated 
from the entered efficiency or power curve. This is generally the preferred option as it best 
relates to the true meaning of BEP. A User Specified value can be entered if no efficiency 
or power curve is available, or if it is desired to force the BEP to a certain flow.

 l End Of Curve Flow Rate (optional) - This value is used to create a warning in the output 
if it is exceeded. It does not affect the solution - the model will behave identically however 
this value is defined.

 l NPSHR Affinity Exponent At Operating Speed - Pump curves - flow, head, and power 
- generally follow the affinity laws. However, NPSHR does not always follow a standard 
relationship. The default is to assume the NPSHR varies with the square of the operating 
speed. If this is not the case, the value can be adjusted here.
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 l Preferred Operating Region (POR) - % of BEP values falling outside of the defined 
range will generate a warning in the model output. This range can be taken from HI 9.6.3 
based on the specific speed of the pump, from ANSI/API 610 11th Edition, or can be 
defined by the user.                     

 l Allowable Operating Region (AOR) - Similarly, this flow range creates a warning in the 
output when the user specified flow range is not adhered to.

Graphs

The following tabs display the curves that have been fit to the given data. If multiple curves are 
defined, the Composite Graph tab becomes available. The other graph tabs show the individual 
curves, along with points representing the raw data. It is a good idea to check that these graphs 
to confirm the curve fit is reasonable for any potential operating region.

Figure 4: Composite Graph
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Related Topics

Centrifugal Pump Overview 356
Multiple Configurations 364
Standard Pump Curve Waterhammer Theory 368
Viscosity Correction 395
Four Quadrant Model Overview 372

Related Blogs

Determine Your Pumps BEP and Know API-610's Recommendations

Multiple Configurations
A single pump junction can contain information for multiple pump configurations - impeller trims 
and operating speeds. This is useful to compare different variations of a pump without needing to 
redefine a new pump junction for every case. The configuration of the pump can easily be 
changed without losing any information.

Defining Multiple Configurations

When opening the pump configuration, change the Configuration Method from Simple to Mul-
tiple. When doing so, an additional user input panel appears on the right hand side of the win-
dow.
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Figure 1: Multiple Configuration Method Selected

In order to make use of the multiple configuration feature, an RPM and Impeller Diameter under 
Configuration Information should be filled in. A Description can optionally be added. After modi-
fying any information that affects the definition of this configuration the Update Configuration box 
turns yellow:
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Figure 2: Update Configuration

Clicking Update Configuration Now adds the Configuration to the Pump Configurations listed in 
the top-right.
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Figure 3: Current Pump Configurations

To create an additional configuration, click Create.

Figure 4: Creating a new Configuration
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The pump curves must be created and curve fit, as with a single configuration pump. After com-
pleting this and clicking Update Configuration Now, the new configuration will be created and 
shown in the Pump Configurations area. Configurations can be edited by selecting them in this 
area

Figure 5: Editing a Configuration

Now that multiple configurations are available, they can be selected on the Pump Model tab:

Figure 6: Selection of a Configuration

Standard Pump Curve Waterhammer Theory
A pump head curve is a function of flow and speed.
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For any given fixed speed, the head curve is only a function of flow. The head curve can be dir-
ectly adjusted for speed using the affinity laws.

Considering the case where the head/flow curve follows a polynomial relationship, and including 
a speed ratio term s:

where

Converting volume flow to mass flow and head to pressure:

Because ρ, g, and the curve constants are constant throughout the simulation, they can be com-
bined and the equation simplified.

Solving for ΔP with Compatibility Equations 1 and 2 :             

and equating the two:
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For a fixed speed, the only unknown is mass flow. For quadratic curve fits (d and e are zero), this 
equation is solved analytically. For higher order curve fits, it is solved for with Newton-Raphson 
iteration. Upstream and downstream pressures can then be determined from the compatibility 
equations.

For variable speed pumps, another parameter must be considered fixed - for example, suction or 
discharge pressure. In these cases, the above equations can be arranged to solve for the speed 
required.

If the speed and flow can vary throughout the transient without any parameter being fixed - for 
example, during a pump trip or startup - further equations and data are required. See Inertial 
Models.

Flows Outside the Normal Pumping Zone

The Standard Pump Curve is only valid for the Normal Pumping Zone - positive speed, flow, and 
head. To model such situations without additional four quadrant data, assumptions must be 
made.

Behavior from negative speed is not considered as the characteristics can be significantly dif-
ferent. This leaves two situations not normally covered - reverse flow and flow past the pump 
maximum.

 l Reverse Flow - It is assumed that the head rise across the pump for all reverse flows is 
equivalent to the head rise at zero flow for the given curve at the given speed. This is a 
very rough estimate and will not be accurate for large or sustained flows, and a warning 
will be generated to this effect.

 l Flow Exceeding Maximum - At high flows for a given speed there will be a point where 
head is actually lost across a pump. The Standard Pump Curve does not account for this - 
instead, it is assumed that the head rise is zero.  

Submerged Pumps

If a Pump is defined as Submerged, the upstream pressure is known and fixed. The same pro-
cess as before can be used to solve for flow.

Vapor Cavitation Theory 

When the calculated pressure at the upstream side of a Pump junction drops below vapor pres-
sure, a vapor cavity forms on that side of the junction.

Usually vapor cavities form on the upstream side of the pump only, but in cases where there is 
reverse flow through the pump cavities can also form on the downstream side.
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When a vapor cavity forms upstream of a pump, the upstream pressure becomes fixed at the 
vapor pressure. The calculation then is similar to a submerged pump, which also flows from a 
fixed pressure. Similar to a pipe interior node, when the vapor volume is negative the cavity col-
lapses and the fluid pressure then rises above the vapor pressure.

Related Topics

Nomenclature 683
Method of Characteristics 701
Affinity Laws 408
Four Quadrant Model Overview 372
Compatibility Equations 706

Specific Speed
Specific speed is an index which can be used to characterize the behavior of a pump. Pumps of 
identical specific speed will, in general, have similar behavior at the rated conditions. It is import-
ant that specific speed be calculated for maximum impeller diameter, and at the pump's 
BEP, considering head per stage. It is possible to use this formula with a trimmed impeller, or 
at operating conditions away from BEP, but the number will no longer have the same meaning.

The dimensionless form of specific speed is defined as:

More commonly, a dimensional form is used. This equation is listed in both ANSI-HI 14.3.1.3.1-
2019 and API 610 11th Edition
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Note: Specific speeds using this definition are often presented as "dimensionless" numbers - 
but the value returned depends on the unit system used. In such cases it should be 
made clear what unit system is involved - for example NS = 4000 (gpm units) or NS = 
77.5 (metric units). There is a conversion factor of 51.6 between the two versions.

 l Ns                 = Specific speed
 l NRated        = Rotational speed in revolutions per minute
 l ωRated        = Rotational speed in radians per second
 l QRated        = Total pump flow rate in cubic meters per second (US gallons per minute)
 l HRated        = head per stage in meters (feet)

There are alternative methods used to calculate specific speed that include dividing the flow rate 
(Q) in the above equation by 2 if the impeller is of a double suction design. This will result in the 

calculated specific speed being less by a multiplying factor of , or approximately 0.707 
times less. Therefore the user is urged to take caution and determine how the manufacturer of 
their pump determined specific speed.

Relation to Pump Design

Specific speed is common in pump design - it conveys information about the type of pump or 
impeller that will be required. Low specific speeds represent radial machines - delivering high 
head at relatively low flow. High specific speeds represent axial flow devices - delivering high 
flow at low head. Mixed flow devices have an intermediate specific speed. With specific speed 
alone it is possible to make an estimate of the physical construction of a pump.

Four Quadrant Model Overview

Four Quadrants of Operation

To accurately model a pump undergoing reverse flow or speed, or pumps past the runout flow, 
test data for those regions must be available. In certain cases rough approximations can be 
made without this data, but as with any model, good results require good data that reflect the 
actual characteristics.

Turbomachines can operate at any flow or speed, positive or negative. The speed-flow plane 
thus creates four quadrants - hence the name Four Quadrant.
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Figure 1: The speed-flow plane, showing the four possible quadrants of operation.

At any given speed and flow combination, there is an associated head and torque. Any given tur-
bomachine must operate on these surfaces of points defined by head-speed-flow and torque-
speed-flow in steady-state.

Figure 2: Relationship of head to flow and speed over all four quadrants

Such a surface is usually presented as a contour plot, with curves of constant head and torque 
drawn on a 2 dimensional speed-flow diagram.
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Figure 3: Contour plot showing lines of constant head. Same data as Figure 2.

Similar data for torque can be presented on the same plot, commonly referred to as a Karman-
Knapp Circle Diagram.
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Figure 4: Constant contours of torque and head for a particular turbomachine. This is the same 
pump as Figures 2 & 3, but with different contours included.

This is the data required to model a turbomachine under reverse flow and speed. But how do we 
apply it? And what simplifications can be made?

Simplifying the Data with the Affinity Laws

A real turbomachine has characteristics unique to certain operating speeds or flows. For 
example, a very high flow or speed may induce transient cavitation, severely impacting head gen-
erated. On the other end of operation, a very low speed will be more impacted by friction of the 
various rotating components. If the flow is low enough, it will become laminar, changing the beha-
vior of the fluid dramatically.

To fully account for these real effects, a simulation would need actual data for every possible situ-
ation. In other words, a set of curves such as that shown in Figure 4 would be the minimum data 
entry. Clearly, this would be an enormous amount of data to enter, if it was even possible to 
acquire. Fortunately, these effects - although real - do not need to be considered for the vast 
majority of pump studies.
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To greatly simplify the data required, the pump can be considered as completely homologous - 
meaning that the affinity laws apply for all speeds, flows, heads, and torques. This means that 
instead of a large collection of curves, only a handful of curves are required, as the others can be 
appropriately "scaled" from the source curve.

In fact, the curves shown in the figures above represent exactly this scaling - they do not rep-
resent raw measurements for each combination of speed and flow. Instead, most of the contours 
were generated using the relationships defined by the affinity laws, with only full speed (positive 
and negative) values being measured, as represented by the bold contours.

Applying the Data in Numerical Simulation

It would be possible to use the raw data defined by a set of curves such as that shown above dir-
ectly in a numerical simulation. One approach used in the early days was to store many curves in 
familiar forms such as head vs flow and torque vs flow at a variety of speeds. This approach, 
while valid, can pose great difficultly in computational analysis because every parameter - head, 
torque, speed, and flow - can become zero at any point during the simulation. Determining which 
curves to use and handling zero values dynamically is difficult.

An alternative method, proposed by Suter, 1966, involves transforming the data into a different 
coordinate system such that the values of numerical interest never become zero. This method, 
used by AFT Impulse, is commonly referred to as the "Suter Method."    

Before proceeding with the transformation, the measured data from a particular turbomachine is 
made dimensionless by dividing through by a Dimensional Reference Point. It should be noted 
that these rated values are traditionally considered to be the rated values at the Best Efficiency 
Point. However, alternative references can be used in some situations.

Because there are four parameters, four reference values are required to make the data dimen-
sionless, like the data presented in Figure 4 above.

where

h = Dimensionless head

H = Dimensional head

β = Dimensionless torque

T = Dimensional torque

α = Dimensionless speed (note that α is commonly used to denote angular acceleration. To 
maintain consistency with the literature, this represents the dimensionless speed here)

N = Dimensional speed

ν = Dimensionless flow

Q = Dimensional flow
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The data can now be transformed into a more useful coordinate system. For any given point on 
one of the head curves (as an example), there is a specific value of speed, flow, and head. Draw-
ing a line from the origin to this point creates an angle to the exiting axis.

Figure 5: Transforming the data

The angle is simply defined with trigonometry:

or in some definitions:

To define the point itself, the following equations are used for head and torque, respectively:

- 377 -



Defining Junction Transients

For the point shown in Figure 5, FH evaluates to 0.5, with a Θ of 45 degrees. Applying this trans-
formation to all of the data in the speed-flow plane, we can construct values of FH and FB for all 
Θ. In other words, FH and FB are continuous functions of Θ.

Figure 6: FH and FB values for all Θ. This is still representing the same data as all previous Figures.

By reversing the transformation, data in a standard form such as head vs flow can be recovered 
fully.

Note: All of the above example Figures represent the NS = 0.66 (1800 gpm units) data set, 
available in AFT Impulse. For this reason Figures 2 - 4 do not show divergence from the 
affinity laws (it is not raw data, but back-calculated from the data shown in Figure 6).

Related Topics

Four Quadrant Zones of Operation 378
Four Quadrant Data Sets 381
Four Quadrant Dimensional Reference Point 386
Four Quadrant Data Set Selection 390
Four Quadrant Waterhammer Theory 393
Specific Speed 371

Four Quadrant Zones of Operation
While a turbomachine can operate anywhere in the four quadrants of the speed-flow plane, it will 
only act as a pump in certain areas. It can also act as a turbine, or be in an "energy dissipation" 
zone.

- 378 -



The behavior of a pump changes significantly depending on its design - a radial (low specific 
speed) pump has different characteristics than an axial (high specific speed) pump.

Zones of Operation

 l Zone A - Normal Pumping - This is the region represented by a Standard Pump Curve, 
generally available from the manufacturer. Energy is transferred from the driver to the 
fluid, imposing flow and positive head.

 l Zone B - Energy Dissipation - Region exceeding maximum pump flow (or runout flow). 
Head is lost across the pump.

 l Zone C - Reverse Turbine - Flow and speed are in the positive direction, driving the 
shaft. This is termed "reverse" because it is typical for turbines to run in the opposite dir-
ection.

 l Zone D - Energy Dissipation - Energy entering the system is actively opposing the nat-
ural flow direction.

 l Zone E - Reverse Pump - The impeller is rotating backwards, but pumping action is still 
taking place. Energy is transferred from the driver to the fluid, imposing flow and head. 
The behavior of this zone varies based on design - radial designs can still pump in the nor-
mal direction when rotating backwards, whereas axial machines can force the flow in the 
reverse direction.

 l Zone F - Energy Dissipation - The impeller is rotating backwards, with negative flow. 
However, head is increased. This zone is similar to Zone B.

 l Zone G - Normal Turbine - Flow and speed are in the reverse direction, driving the 
shaft, causing the machine to generate power.

 l Zone H - Energy Dissipation - Energy entering the system is actively opposing the nat-
ural flow direction. This zone is similar to Zone D.

Table 1: Characteristics of Zones
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Transient Behavior

The operation of a pump must move continuously from one point on the speed-flow plane to 
another. It can never "jump" to an entirely different zone.

For example, consider a pump lifting fluid over a hill under a trip event.

The pump will initially be operating in Zone A, but under loss of driver torque will immediately 
begin to change speed and flow.

The inertia of the device will maintain forward speed while flow reverses - in other words, the 
Zone will change from A to H. The energy dissipation Zone H is unstable - the act of reverse flow 
on the forward rotating impeller with no applied torque will slow the impeller down and eventually 
reverse its direction.

Once speed direction changes, the pump is now operating in Zone G. Energy could theoretically 
be extracted in this turbine zone, however, there is no connected driver. The energy from the still 
positive torque must go somewhere - into speeding up the impeller.

At some point, the impeller will speed up enough that operation crosses into Zone F. In Zone F, 
the torque changes sign - causing the impeller to slow down and return to Zone G. The device 
will oscillate around the zero torque line, eventually coming to a new steady-state - runaway con-
ditions.
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Figure 2: Zones of operation for a radial design pump, from data set NS = 1800 gpm (34.9 m3/s)
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Four Quadrant Data Sets
Four Quadrant data for a specific pump is rarely available. Manufacturers generally will only test 
pumps in the Normal Pumping Zone - positive flow, speed, head, and torque. Testing a pump out-
side of this range is expensive, and often requires testing apparatus beyond what is required for 
the standard range.
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Even though four quadrant data specifically related to a certain pump may not be available, it is 
still important to account for the effects of reverse flow and speed when they occur. Making an 
estimation with a Standard Pump Curve is not sufficient in most cases, so another approach 
must be taken.

This approach - also an estimation - is to utilize four quadrant data from a similar pump. It is not 
unreasonable to assume that two pumps of similar construction would behave similarly under 
any given flow condition. It may be that the specific pump of interest may have only been tested 
in the Normal Pumping Zone, whereas the very similar pump may have been tested in all four 
quadrants. The test data may be used as a basis for the simulation of the pump of interest, with 
some adjustments.

What Makes a Similar Pump?

Accepting that data from a similar pump can be used for the simulation, we can proceed with 
selecting some data from an appropriate pump with all of the required data. However, how do we 
know what data is appropriate? It is highly unlikely that a physical comparison between the two 
pumps can be made. It is even unlikely that the rated parameters for the similar pump will be 
available, as the data is almost always stored in a dimensionless form as described in Four 
Quadrant Model Overview.

Fortunately, there is one convenient parameter that is traditionally used to characterize pumps of 
similar operation - specific speed. Specific speed attempts to describe the overall characteristics 
of a pump by relating its discharge and head. Pumps of an identical specific speed can generally 
be assumed to behave the same, even if they are of different design or size.

This means that if a set of four quadrant data has a specific speed similar to the pump being ana-
lyzed, this data can be applied without needing to know anything further about the pump that was 
actually tested.

Potential Issues Using Specific Speed to Measure Similarity

Turbomachines are complex devices with many components that affect their behavior. Breaking 
down this behavior into a single number - specific speed - necessarily has some drawbacks. Two 
pumps of identical specific speed may not show exactly the same behavior at all flows and 
speeds. Some references (Brown and Rogers, 1980) indicate that the correlation between over-
all behavior and specific speed is less than may be expected, especially for low specific speed 
(radial) devices.    

It could be the case that a four quadrant data set developed for a pump of a different specific 
speed may be more appropriate in a given simulation, as it may better reflect the behavior of the 
pump in question.

Using Existing Data is an Estimation

When applying existing data to simulation, it is critical to remember that this method is 
an estimation. For accurate results, test data from the actual pump should be used. Experience 
shows that this estimation, when properly applied, is acceptable within the normal bounds of fluid 
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transient analysis. The accuracy of the estimation depends heavily on the specific pump, the 
data set used, the system, and how the estimation is applied.

Furthermore, because the four quadrant data sets are stored in a dimensionless form, to be used 
in simulation they must be made dimensional. The dimensional data can be forced to match in 
certain conditions, which will force the data not to match in other conditions. Because the data 
sources represent two different pumps, a perfect match under all conditions is impossible.

The data is made dimensional with a given reference point based on the Standard Pump Curve. 
This choice can have dramatic impacts on the simulation, as described in Four Quadrant Dimen-
sional Reference Point.

Four Quadrant Data Sets Available in AFT Impulse

There are many four quadrant data sets available for use in AFT Impulse, from a variety of 
sources. Many of these data sets appear in multiple references throughout the technical lit-
erature on four quadrant methods. The available data sets are listed in Table 1 below.

Notice that each data set is labeled as Preferred, Average, or Use With Caution. By default only 
preferred and average data sets will be shown. These recommendations are based on Walters, 
Dahl & Rogers (2020) which uses a comparison of the four quadrant data sets to the stepanoff 
curves to evaluate the quality of the test data and the accuracy of the reported specific speed for 
each data set. Figure 1 which was adapted from Walters, Dahl & Rogers (2020) shows several of 
the four quadrant data sets used in Impulse compared to the stepanoff curves. The 13500(262) 
and 1800(34.9) curves, shown in red and blue on the figures, are listed as preferred in Impulse, 
while the 7600(147) curve, shown in yellow, is listed as average.    
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Table 1: Four Quadrant Data Sets Available
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Figure 1: Comparison of head curves from several four quadrant data sets to Stepanoff curves

Figure 2: Comparison of power curves from several four quadrant data sets to Stepanoff curves

Related Topics
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Four Quadrant Data Set Selection 390
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Four Quadrant Waterhammer Theory 393
Specific Speed 371

Four Quadrant Dimensional Reference Point
As described in Four Quadrant Data Sets, data specific to a given pump is rarely available. 
Instead, four quadrant test data from a different pump with similar specific speed is commonly 
used as an estimation. Because the Suter method stores the four quadrant data in dimen-
sionless form, the data must be made dimensional.

As described in Four Quadrant Model Overview, the data is made dimensionless by dividing 
each parameter by some reference value:

To obtain the original values, the dimensionless parameters can simply be multiplied by the ori-
ginal reference values. This only works to recreate the values for the original pump - the pump of 
interest (the "similar" pump) - may be of a similar specific speed, but of different size. In this 
case, different values will be used in dimensionalizing the data. These four reference values are 
referred to as the Four Quadrant Dimensional Reference Point.

Multiple Choices for a Dimensional Reference Point (DRP)

Traditionally, the Dimensional Reference Point used to create the dimensionless data will be the 
rated conditions at the pump's Best Efficiency Point. Applying these same rated conditions to the 
dimensionless data will fully recover the original data. Due to the nature of using similar four 
quadrant data sets to estimate behavior, the DRP used to "unpack" the data will almost certainly 
be different than the DRP originally used in its creation. There are a couple of reasons for this.

First, the tested pump may have identical specific speed - and perhaps even identical behavior - 
to the pump under analysis, yet still have a different pump curve. This is because a pumps of dif-
ferent size but identical construction will behave in a similar way. This is at the root of the homo-
logous pump laws, which are used to derive the affinity laws. The data from one pump can be 
made dimensionless with that pump's DRP, and made dimensional for the other pump with the 
other pump's DRP. If these two pumps are truly homologous, then the actual, dimensional beha-
vior of the second pump will be fully and accurately represented. Of course, two pumps are very 
unlikely to be truly homologous and therefore this process will introduce some error.

Second, it is not necessarily required to use the same "type" of DRP for unpacking the data. By 
default, AFT Impulse uses the rated conditions at Best Efficiency Point. Also available is the 
option to use the Steady-State Operating Point. Both of these options are estimations, and 
both have certain advantages and disadvantages.
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Note: The choice of Dimensional Reference Point should not be taken lightly. The 
choice can have significant impacts on the results of a transient simulation, potentially 
indicating a system is safe when significant transient cavitation could occur, or perhaps 
indicating that cavitation will occur when it may in fact be unlikely. (Walters, Lang, and 
Miller, 2018)             

Figure 1: Specification of DRP in AFT Impulse.

Using Best Efficiency Point as the DRP

AFT Impulse can calculate the pump's rated parameters at the Best Efficiency Point (BEP) when 
the Standard Pump Curve is defined with the required efficiency/power data and a rated speed. 
With this option selected, these parameters become the DRP.

As mentioned, the Four Quadrant Data Set in use was likely created with the BEP of the test 
pump as the DRP. If the two pumps are similar, it is therefore reasonable to use the BEP of the 
new pump as the DRP. If the Four Quadrant Data Set is well matched, the resulting Four Quad-
rant Curves will closely match the Standard Pump Curve. If the curves appear to be well 
matched in the Normal Pumping Zone - having similar shape, shutoff, and runout head - it is 
likely, although not guaranteed, that the Four Quadrant Curve is reasonably accurate under 
reverse flow and speed conditions as well.

Because the BEP of the pump is an unchanging value, the same Four Quadrant Curve 
will always be generated regardless of where the pump is running on its curve. This 
means that if the pump is not running exactly at BEP, even a well matched Four Quadrant Data 
Set will likely not agree exactly with the Standard Pump Curve. A "jump" from one curve to 
another can not be allowed during a transient simulation as this would induce an Artificial Tran-
sient. To avoid this, the Standard Pump Curve is not used in simulation when BEP is 
selected as the DRP. The Standard Pump Curve is only used for the purpose of generating the 
required DRP.

This means that the steady-state results will not agree with the the Standard Pump Curve 
unless the data was perfectly matched. This is an area where the estimation begins to have an 
impact. If the steady-state results are of critical importance in the transient simulation this may be 
unacceptable. Typically, variations in steady-state behavior are acceptable when analyzing a 
transient event, as the magnitude of pressure and velocity changes from transient events far out-
weigh small steady-state differences.
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Figure 2: Using Best Efficiency Point as the DRP. The Four Quadrant Curve is static and disagrees 
in some areas with the Standard Pump Curve. However, the curve matches reasonably, especially 

near BEP.

Using Steady-State Operating Point as the DRP

If the decrease in accuracy of the steady-state results is unacceptable, it is possible to use the 
Standard Pump Curve in the steady-state simulation to obtain accurate results. If this is done, 
another approach must be taken to avoid "jumping" curves and inducing an Artificial Transient. 
Instead of using the BEP, it is possible to use the Steady-State Operating Point as determined 
directly with the Standard Pump Curve during the steady-state simulation.

When dimensionalizing the Four Quadrant Data Set with the DRP, the resulting Four Quadrant 
Curves will be forced to pass through the DRP. In other words, the Standard Pump Curve and 
the Four Quadrant Curve will be made to intersect exactly where the pump is operating. This has 
the effect of eliminating any Artificial Transient, while allowing the steady-state simulation to use 
one curve (the Standard Pump Curve) and the transient simulation to use a different curve (the 
Four Quadrant Curve).

Keep in mind that the method itself is identical - only the DRP used to carry it out has changed. 
In fact, if the pump happened to be operating exactly at BEP, the two methods would be com-
pletely identical.
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Unlike the BEP option, the generated Four Quadrant Curve will change based on where 
the pump is running on its curve. In effect, the original Four Quadrant Data Set is being dis-
torted to match at the steady-state condition. This means that despite the increase in steady-
state accuracy we are not able to get away from the fact that this is still an estimation. By redu-
cing error in one area, it has been amplified in another.

What does it mean to say the curve has been distorted? Because the Four Quadrant Data Set 
represents a certain "character" of pump, the overall shape and trends of the data cannot be 
changed. By using a different DRP, the data is instead "shifted" as necessary in the appropriate 
directions. For example, if the Steady-State Operating Point is calculated to have lower 
flow and higher head than the BEP, the entire Four Quadrant data set will be com-
pressed in the "flow direction" and stretched in the "head direction" to force the original 
reference point to meet the new reference point.

If the pump is operating far from BEP, this can potentially result in severe distortion of the Four 
Quadrant Pump Curve. In such cases, the pump behavior is accurate during the steady-state 
simulation, but may differ wildly from the Standard Pump Curve under different flow conditions.

Figure 3: Using a Sample Steady-State Operating Point as the DRP for the same Standard Pump 
Curve shown in Figure 2. The point is near BEP so the curve still matches reasonably well.

Figure 4: Using a Sample Steady-State Operating Point far from BEP introduces significant dis-
tortion. The curves still match at the DRP, but the differences are severe at other flows.
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Which DRP should I use?

The question of which point should be used may be obvious, but the answer is not. The best 
approach is to try and ensure that the Four Quadrant Curve reasonable matches the Standard 
Pump Curve for the expected range of operation.

If it is not clear which option is better, it is recommended to do a sensitivity analysis and run 
cases of the model with both options. Note that because both methods are estimations, this does 
not "bound" the possible solutions. Instead, it will give some idea of how impactful the choice is. 
Large differences in simulation results should encourage close attention and high safety factors. 
See the Four Quadrant Data Set Selection topic for more details.

Related Topics
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Four Quadrant Data Set Selection 390
Four Quadrant Waterhammer Theory 393
Specific Speed 371

Four Quadrant Data Set Selection
As discussed in the Four Quadrant Model Overview, four quadrant data sets are measured data 
sets intended to approximate the pump behavior outside of the Normal Pumping Zone (i.e. pump 
operating at positive speed and positive head with forwards rotation). In cases where the pump 
operates beyond these boundaries, four quadrant data may be used as a tool to predict the head 
and flow at the pump when measured data is not available. Thus, when the pump is operating in 
the first quadrant, results generated using the pump performance data provided by the man-
ufacturer (the manufacturer curve) will provide the most accurate results. Once the pump begins 
operating beyond this region, such as when reverse flow begins, the dimensionalized four quad-
rant data set (four quadrant curve) will likely provide more accurate results than the man-
ufacturer curve. However, different four quadrant sets can provide widely varied results. Caution 
should be used to ensure that the chosen four quadrant data set provides reasonable results.

In Impulse, a four quadrant curve can either be selected automatically, or may be selected dir-
ectly by the user.

Automatically Selected Four Quadrant Curve

When the Four Quadrant Curve option is first selected, a four quadrant curve will automatically 
be selected by Impulse. Impulse selects a four quadrant curve by doing the following:

1) The specific speed for the pump is estimated using the BEP calculated from the user-spe-
cified pump curve, and assuming that the pump includes only a single stage and the impeller is 
untrimmed.
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2) Using the estimated specific speed from step 1, the four quadrant data set with the nearest 
specific speed is selected. By default Impulse will only choose a Preferred or Average data set.

3) The BEP, which is either specified directly by the user in the Pump Configuration window or 
calculated based on the user-specified pump curve, is used as the Dimensional Reference Point 
to dimensionalize the four quadrant curve

This automatically selected four quadrant curve will provide a reasonable estimate for most 
cases. However, it is advised that the user check the validity of Impulse's selection by using the 
considerations and procedure described below.

Considerations for Selecting a Four Quadrant Curve

The following recommendations from section 6.2 of Walters, Dahl, and Rogers, 2020 should be 
considered when selecting a four quadrant data set for the waterhammer analysis.             

1) Comparison to the Manufacturer Curve

The manufacturer curve is measured data from the actual pump being used in the system, and 
thus will provide the most accurate prediction for the pump behavior. Though it cannot be used to 
predict behavior beyond the range of the measured data, it can be used for comparison to the 
four quadrant curve(s) for the steady state simulation. In some systems, the transient results can 
be highly sensitive to the steady state of the system, thus accuracy of the pump curve used in the 
steady state can be an indicator of accuracy during the transient. In addition, the final steady 
state for the system once the transient response has concluded can be compared as an indicator 
of how close the four quadrant curve will behave to the manufacturer curve during the transient.

2) Pump Specific Speed 

As discussed in a previous topic on Four Quadrant Data Sets, it is typically a good practice to 
select a four quadrant data set based on the specific speed of the pump, as pumps with similar 
specific speeds will typically be constructed similarly. However, this does not always hold true. 
Thus, comparing multiple data sets at specific speeds close to the specific speed specified by 
the pump manufacturer is advised.

3) Dimensional Reference Point

As was previously discussed, the Four Quadrant Dimensional Reference Point can be defined 
as either the Best Efficiency Point (BEP) or the steady state operating point (SSOP) from the 
manufacturer's curve. Using the BEP will result in a different operating point during the steady 
state, but may provide a closer match for the final steady state using the manufacturer's curve. 
Using the SSOP will allow the steady state operating point to exactly match the manufacturer's 
curve, but may diverge widely from the final steady state operating point predicted by the man-
ufacturer's curve due to distortions in the dimensionalized curve.

Procedure for Four Quadrant Data Set Selection

A generic procedure for creating a model and analyzing the results when using four quadrant 
data is given below:
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 1. Create a child scenario of the scenario that is defined using the manufacturer's curve
 2. Open the Pump Properties window and select Four Quadrant Curve as the Performance 

Curve Used in Simulation
 3. Choose User Selected and click Specify Model to launch the Specify Four Quadrant 

Model window
 4. Choose the desired four quadrant data set from the drop-down list at the top of the win-

dow, and select Best Efficiency Point as the Dimensional Reference Point. 
 5. Select Ok to accept the changes
 6. Clone the current scenario and change the Dimensional Reference Point to the Steady-

State Operating Point in the cloned scenario
 7. Repeat steps 1 - 6 for each data set to be analyzed
 8. Run all of the newly created scenarios and compare the transient results. Note that fre-

quently results will not differ greatly among scenarios. In that case, results are not very 
sensitive to the specific choice of four quadrant curve. In order to be most conservative, 
use the worst case predictions from among the various four quadrant scenarios for design 
purposes. 

 9. If the worst case predictions lead to excessive and/or expensive implications in design 
and/or operations, take a closer look at results. Compare each four quadrant pump curve 
to the manufacturer’s curve at the initial steady state and, if applicable, the final steady 
state operating points to determine which scenario(s) appears to give the most accurate 
results. Criteria used to decide the most reliable four quadrant curve(s) include:

 1. Similarity of specific speed, NS – when making this comparison, be sure you have 
an accurate NS value for your pump

 2. Overall agreement between the manufacturer’s curve (Standard Pump Curve) and 
dimensionalized four quadrant curve for head and power vs. flow rate in the normal 
zone of pump operation (Impulse compares these curves for you – review the com-
parisons)

 3. Give more weight the four quadrant curves which show closer agreement within 
the range of flow rates that the manufacturer tested the pump at (i.e. the range of 
flow rates that the pump curve is graphed for on the specification sheet)

 4. Give more weight to four quadrant curves which generate transient results similar 
to the Standard Pump Curve during time frames when the pump is operating in the 
normal zone of operation (positive flow, head and rotation)

 5. Give more weight to four quadrant curves Impulse categorizes as Preferred
 6. Good agreement in initial steady-state flow rates between SPC and four quadrant 

curve
 7. Good agreement in final steady-state flow rates between SPC and four quadrant 

curve – this not as important as agreement in initial steady-state flow rates, but 
should be considered

Note that there are several reasons why the engineer may choose to skip step 9 above. One 
reason would be if the transient results for the different scenarios show only minor differences as 
noted in Step 8. In that case it would be unnecessary to determine which scenario is most accur-
ate, as any scenario will produce similar results. Another reason would be if the engineer’s ana-
lysis involves a project where highly conservative results are desired, such as for a nuclear 
system, or another such instance where less accurate results would be costly (e.g., force install-
ation of an expensive surge relief system that may not truly be needed). In that case the engineer 
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could choose to simply use the most extreme results for the analysis for their design purposes. 
Note this means that if different scenarios produce the worst-case pressures in different areas of 
the model, then the engineer may want to use the most extreme results (e.g., highest or lowest 
pressure) regardless of scenario, rather than only using the results from one scenario.

Four Quadrant Data Set Selection Example

Several walk-through examples describing the basics of four quadrant modeling can be found in 
AFT Impulse's walkthrough examples.             

For a basic introduction to using four quadrant curves see the "Pump Trip With Backflow - Four 
Quadrant Modeling" example. 

An advanced example on performing a sensitivity study to select a four quadrant curve is also 
available, titled "Selecting a Pump Four Quadrant Curve".

Related Topics

Four Quadrant Model Overview 372
Four Quadrant Zones of Operation 378
Four Quadrant Data Sets 381
Four Quadrant Dimensional Reference Point 386
Four Quadrant Waterhammer Theory 393
Specific Speed 371

Four Quadrant Waterhammer Theory
The waterhammer theory when using four quadrant data in SuterSuter form follows a similar 
approach to the Standard Pump Curve Waterhammer Theory.             

First, we know from the compatibility equations that the pressure change across the pump is 
related to the mass flow:

We also know that the dimensionless four quadrant parameters are related to the values used 
for the Dimensional Reference Point:

From the definition of h we have a relationship between the curve FH (Θ), speed and flow.
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Multiplying through by ρg we can attain a similar expression in pressure terms:

Similarly, there is a relationship for volumetric flow that can be converted to mass flow by mul-
tiplying by density:

The previous equations can be combined with the compatibility equation for the pump:

This equation contains three potential unknowns - speed (α), flow (ν), and FH (Θ). FH and Θ are 
related via tabulated data. The value of Θ is related to the speed and flow, bringing the unknown 
variables down to just speed and flow:

As with the Standard Pump Curve, for a fixed speed there is only one unknown - flow. The equa-
tions and tabulated data can be iterated on to find a solution for flow and therefore pressure rise 
across the pump.

During a pump trip or startup, when neither speed nor flow are known, additional equations are 
required. The necessary torque balance terms are described in Transient - Inertial Models res-
ulting in the below equation for speed change:

It is helpful to modify this equation so that it is directly applicable in four quadrant terms. The fol-
lowing relations are required:

resulting in the following:
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This equation represents the full torque balance with unknown driver torque, pump torque, and 
pump speed in four quadrant form. For a pump trip, the driver torque is zero leaving only two 
unknowns. For a startup, the driver torque vs speed must be specified. Like the head term 
above, the dimensionless torque β can be solved for in terms of speed (α), flow (ν), and FB (Θ).

These equations can then be solved for speed, flow, torque and head.

Related Topics

Nomenclature 683
Method of Characteristics 701
Four Quadrant Model Overview 372
Four Quadrant Zones of Operation 378
Four Quadrant Data Sets 381
Four Quadrant Dimensional Reference Point 386
Four Quadrant Data Set Selection 390
Specific Speed 371

Viscosity Correction
Most pump curves are developed with pure water, however, pumping a fluid more viscous than 
water will result in a reduction of pump performance - even if the fluid reference density is the 
same as water. The Viscosity Correction feature employs the methods described in ANSI/HI 
9.6.7-2021 Rotodynamic Pumps - Guideline for Effects of Liquid Viscosity on Performance to cor-
rect for losses in performance due to viscosity.

Viscosity Corrections should only be used if the pump curve entered into the Pump 
Properties window is a water curve, since this is the only situation covered by ANSI/HI 
9.6.7-2021. Viscosity Corrections will effectively transform a water pump curve into a viscous 
pump curve. If the manufacturer provides a pump curve for your working fluid at your desired vis-
cosity, then it should be entered directly and the Viscosity Correction feature should remain dis-
abled, otherwise the effects would be double counted. If the manufacturer provides a pump 
curve based on your same working fluid, but at a different viscosity, then the Viscosity Correction 
feature should still remain disabled because unfortunately that case falls outside the scope of the 
ANSI/HI 9.6.7-2021 standard.

Correction factors referred to as CH (for head rise), CQ (for volumetric flow), and CE (for effi-
ciency) are defined and can be displayed in the Pump Summary section of the Output:
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To calculate the correction factors, the water BEP (head and flow at BEP) and rated pump 
speed are required.

 l Assume Pump is Operating at BEP - This option is useful when the pump is in Sizing 
mode, and will assume that the head rise and flowrate calculated by the model are at 
BEP. This option is also useful when a water pump curve is entered but no efficiency data 
is present.

 l Use Water BEP
 l From Pump Configuration - The water BEP flowrate can be determined from the 

pump curve data entered on the Pump Configuration window. This option will be 
disabled if efficiency data is not present.

 l User Specified - Alternatively, the user can directly specify the water BEP 
flowrate.

Scope of Correction

It is important to keep in mind that, like all mathematical models, this standard is not universally 
applicable. Below are the primary requirements:

 l Single or multistage centrifugal pump
 l Essentially radial discharge with specific speed under 3000 (US units)
 l Newtonian Fluid
 l Kinematic viscosity between 1 and 4000 cSt

For detailed information regarding these limitations and the application of the standard, please 
consult ANSI/HI 9.6.7-2021.

Related Topics

Centrifugal Pump Overview 356
Centrifugal Pump Configuration 359
Multiple Configurations 364
Standard Pump Curve Waterhammer Theory 368
Four Quadrant Model Overview 372

Positive Displacement Pump
The Positive Displacement pump option allows users to model the behavior (either steady or peri-
odic flow) of a reciprocating positive displacement pump. 
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Parameter

 l Volumetric Flow Rate - Fix the volumetric flow rate through the pump.
 l Mass Flow Rate - Fix the mass flow rate through the pump.

Flowrate

There are three ways to define the flowrate:

 l Steady - The flowrate will be fixed at the specified value throughout the transient. This is a 
good approximation for many Positive Displacement Pumps.

 l Periodic (simple) - Some Positive Displacement Pumps have a distinct pulsing behavior 
depending on the number of Heads and speed of the pump. This can be defined here, 
with a preview of the imposed flow being shown on the right of the tab.

 l Periodic (detailed) - If detailed information is known about the positive displacement 
pump, a more accurate periodic behavior can be defined by providing the bore diameter, 
pump stroke length, and connecting rod length of pump slider crank.

Figure 1: Simple Periodic Positive Displacement Pump
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Figure 2: Detailed Periodic Positive Displacement Pump

Submerged Pump

Represents a pump with a fixed head or pressure at suction. See Submerged Pump.

Pump as Turbine Overview
Running a pump as a turbine allows the pump to produce electrical power when the pump sees 
reverse flow. During reverse flow, the motor coupled to the Pump as Turbine (PAT) spins in 
reverse, causing the magnetic rotor to induce a current in the motor coils, turning the motor into a 
generator. 

Note: The positive flow direction for the pipes connected to the PAT should be the direction in 
which flow will travel when the pump is operating as a turbine, rather than the direction 
in which flow will travel when the pump is operating as a pump. Thus, while the physical 
pump equipment will see reverse flow while operating as a turbine, the pump as a PAT 
will see positive flow.

Standard Turbine Curve

A Standard Turbine Curve is required to model a PAT and must include both head and power 
data. The head loss vs flow curve defines the head loss seen at the PAT while coupled to the 
motor and generating power. The power versus flow curve defines the power generated by the 
PAT while coupled to the motor and generating power. 

To enter these curves, click Enter Curve Data. Previews of the applied curves can be viewed in 
the Standard Turbine Curve frame once the data has been defined. 
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Figure 1: Standard Turbine Curve

Flow Directional Behavior

A visual representation of the modeled PAT is presented in the lower right of the properties win-
dow to provide immediate feedback on what the various options represent. In the PAT depicted 
in Figure 2, head loss and power information have been defined, and the PAT is in normal oper-
ation, with reverse flow seen at the pump. 

Figure 2: Flow Directional Behavior image for an example PAT. 

Related Topics
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Pump As Turbine Configuration 400
PAT Operation as a Turbine 402
PAT Operation While Decoupled 404
PAT Operation During Decoupling 407
Full Load Rejection 422

Related Blogs

It's a Pump! It's a Turbine! It's a Pump as Turbine!

Pump As Turbine Configuration
The Pump as Turbine Configuration window is used to define the specific operation of a Pump as 
Turbine. It is opened by clicking Enter Curve Data from the Pump Properties window on the 
Pump Model tab when Pump as Turbine is selected. 

Figure 1: Enter Curve Data

Turbine Data

The first tab of the PAT configuration defines the PAT's most fundamental behavior - the turbine 
curves.             
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Figure 2: PAT Data

A PAT can have two curves defined: 

 l Head or Pressure vs. Flow: Required. This curve is commonly referred to as the “tur-
bine curve” and defines the head loss across the PAT at any given flowrate. 

 l Power vs. Flow: Required. The power curve is used for two purposes for the PAT. First, 
it is used to determine the power generated while the pump is operating as a turbine. 
Second, it is used to determine if or when the pump and motor decouple. 

Graphs

The following tabs display the curves that have been fit to the given data. 

 l Composite Graph: Shows the curve-fit PAT Performance and Power curves. 
 l Performance Graph: Shows the curve-fit PAT Performance curve overlaid on the raw 

data points. The solver will ignore the raw data points and operate on the curve fit. 
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 l Power Graph: Shows the curve-fit Power curve overlaid on the raw data points. The 
solver will ignore the raw data points and operate on the curve fit. 

Related Topics

Pump as Turbine Overview 398
PAT Operation as a Turbine 402
PAT Operation While Decoupled 404
PAT Operation During Decoupling 407
Full Load Rejection 422

Related Blogs

It's a Pump! It's a Turbine! It's a Pump as Turbine!

PAT Operation as a Turbine
The main function of the PAT model is to allow a pump to operate as a turbine. In this mode of 
operation, the PAT generates power by removing energy in the form of a head loss across the 
pump, compared to normal centrifugal pump operation where the pump adds energy in the form 
of a head rise across the pump.     

The turbine operating point is determined using the Turbine Performance Curve defined by the 
user. This curve relates head loss to flow rate similar to how the Pump Curve relates head rise to 
flow rate. Note that the PAT uses the turbine’s frame of reference for this data rather than the 
pump’s. Head loss and flow rate should be entered as positive values for the PAT. The Turbine 
Performance Curve will likely see a head loss greater than zero at zero flow and should see 
increasing head loss with increasing flow. An example Turbine Performance Curve is shown in 
Figure 1 below.    

- 402 -

https://www.aft.com/support/product-tips/pump-as-turbine


Figure 1: Example Turbine Performance Curve

The power generated by the PAT is determined by the user-defined Turbine Power Curve. This 
curve relates power generated to flow rate, similar to how the Pump Curve relates pump power 
to flow rate. Note the PAT uses the turbine’s frame of reference for this data rather than the 
pump’s. The Turbine Power curve should have zero power generated at some non-zero flow rate 
and should see increasing power output with increasing flow. An example Turbine Power Curve 
is shown in Figure 2 below. 

Figure 2: Example Turbine Power Curve

The flow rate at which the PAT generates zero power is called the ‘no load’ point. At this flow 
rate, the pump impeller is spinning with the fluid, neither adding nor removing energy from the 
fluid. At higher flow rates, the impeller’s speed is resisted by the motor, removing energy from 
the fluid and generating electricity. At lower flow rates, the impeller’s speed is resisted by the 
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fluid, requiring energy to be added via the motor. These operating conditions are shown in Figure 
3 below. 

Figure 3: General turbine operating conditions

Related Topics

Pump as Turbine Overview 398
Pump As Turbine Configuration 400
PAT Operation While Decoupled 404
PAT Operation During Decoupling 407
Full Load Rejection 422

Related Blogs

It's a Pump! It's a Turbine! It's a Pump as Turbine!

PAT Operation While Decoupled
Operation as a Turbine means the PAT is coupled to the motor, but the PAT can also operate 
while decoupled from the motor, meaning the pump’s impeller is spinning freely in the fluid 
stream. The PAT will be decoupled from the motor when it is operating below the No Load point 
(the flow rate with zero power generation) on the Turbine Curve, since below that flow rate the 
motor would be required to input power to the system. 

Figure 1 below shows these operating conditions. Since the PAT is decoupled from the motor, 
the generator does not impart a torque on the pump impeller to counteract the torque applied by 
the fluid, and the pump impeller becomes free-spinning. When the free-spinning impeller 
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reaches a steady-state speed, no torque is imparted on the impeller by the fluid. This speed is 
called the runaway speed. 

Figure 1: General Turbine Operating Conditions

The pressure loss of a free-spinning PAT is determined by the Turbine Performance curve, 
adjusted by the pump Affinity Laws. The user-defined Rated Turbine Speed is considered 100% 
speed, and the Affinity Laws are used to adjust the curve based on speed. The Affinity Laws 
adjust the Turbine Performance curve in the same direction they adjust a Pump Performance 
curve (i.e., head loss and power increase with impeller speed). 

The speed of a free-spinning impeller is determined by the following equation. Here time step i is 
the current time step, i+1 is the next time step, N is the impeller speed (in RPM), P is the power 
imparted on the impeller by the fluid, and I is the total rotating inertia of the PAT impeller and 
shaft. 

The power term is always dictated by the Turbine Power Curve, adjusted using the Affinity Laws 
for speed. When the decoupled PAT nears runaway speed, the PAT approaches the No Load 
point (flow rate where the power curve is equal to zero) and power approaches zero. Thus, the 
speed does not change from time step to time step.
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No Load Curve

Each runaway speed of the PAT has a different No Load point, meaning a No Load curve can be 
created to describe how head loss is related to flow across the range of potential runaway 
speeds. Each point on the curve represents a different runaway speed and different steady 
state. Figure 2 below shows an example No Load curve overlaid with a Turbine Performance 
Curve and a Turbine Power Curve. Notice how the No Load curve intersects the Turbine Per-
formance Curve at the point where the Turbine Power Curve has zero power. 

This No Load curve can be created by plotting the head loss for multiple Turbine Performance 
Curves (adjusted for speed) at the flow where their corresponding Turbine Power Curves cross 
the zero power line. Note that Impulse does not calculate, use, or require the No Load curve for 
its calculations. Rather, the No Load curve is merely an observable consequence of the physics 
the PAT follows. 

Figure 2: Example No Load Curve showing general turbine operating conditions.

Related Topics

Pump as Turbine Overview 398
Pump As Turbine Configuration 400
PAT Operation as a Turbine 402
PAT Operation During Decoupling 407
Full Load Rejection 422
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It's a Pump! It's a Turbine! It's a Pump as Turbine!

PAT Operation During Decoupling
The PAT transitions between the turbine and decoupled operating conditions in two situations: 
when manually decoupled or whenever the power generated is equal to zero. In Impulse, the 
PAT can never recouple after becoming decoupled. 

The first transition from coupled to decoupled is referred to as Full Load Rejection and can be set 
as a transient event in the Transient tab of the Pump Properties window. 

Figure 1: Transient tab of the Pump Properties window for a PAT showing the Full Load Rejection 
option. 

When this transient event is initiated, the PAT is immediately uncoupled from its motor, the 
speed is allowed to change as dictated by the fluid, and the PAT speed is determined for each 
time step using the below equation. Here time step i  is the current time step, i+1 is the next time 
step, N is the impeller speed (in RPM), P is the power imparted on the impeller by the fluid, and I 
is the total rotating inertia of the PAT impeller and shaft.
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This equation is the same equation used to predict PAT speed when decoupled. 

During a full load rejection, the PAT will rapidly spin up as the generator is no longer resisting the 
torque applied on the impeller by the fluid. The flow rate through the PAT also slows down as the 
PAT shifts from operating in the Turbine Zone to operating at the No Load point. 

The second transition from coupled to decoupled occurs when the PAT reaches the No Load 
point due to other transient events in the system. This transient event is always ready to occur 
regardless of the transients defined for the PAT. When the flow rate through the PAT becomes 
low enough such that zero power is generated by the pump, the pump will immediately become 
uncoupled from the motor and become free-spinning with its speed determined by the equation 
described above. 

Related Topics

Pump as Turbine Overview 398
Pump As Turbine Configuration 400
PAT Operation as a Turbine 402
PAT Operation While Decoupled 404
Full Load Rejection 422

Related Blogs

It's a Pump! It's a Turbine! It's a Pump as Turbine!

Affinity Laws
Pumps can operate at variable speeds during either steady operation or a transient event. Affin-
ity laws (also called homologous laws) allow an estimation of the pump performance at speeds 
other than the design speed. For the Centrifugal (Rotodynamic) Pump model, these Affinity laws 
are used to model a variable speed pump during steady operation and to model the performance 
of a pump during any of the available transient models. For the Pump as Turbine model, these 
affinity laws are used to determine power generation or head loss while decoupled. 

To a somewhat lesser degree, impeller diameter changes follow the same laws as speed 
changes. Substituting impeller changes for speed changes below can be used to see the effect 
of an impeller change or for a small impeller trim (larger trims deviate significantly from this estim-
ation).

Before discussing the affinity laws, it should be noted that the affinity laws are an approximation. 
In many cases, pump manufacturers will have performance data for a number of speeds. This 

- 408 -

https://www.aft.com/support/product-tips/pump-as-turbine


data should be used if available. When not available, the affinity laws can be used with an under-
standing that an approximation is being made.

Pump curves can generally be curve fit to a polynomial:

The speed ratio is defined in terms of the design impeller speed, N1 and the desired operating 
speed N2  as:

Affinity Laws

For the following ratios, subscript 1 represents the parameter from the defined curve (assumed 
to be at 100% speed). Subscript 2 represents the given parameter at the desired operating 
speed N2.

 l Flow rate - 

 l Pump head - 

Note: By default NPSHr will follow the same relationship as pump head rise. The speed ratio 
exponent used for NPSHr can be changed on the Configuration Data tab in the Pump 
Configuration window.

 l Power consumption - 
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 l Efficiency - 

Application to Transients

During a transient event, the speed of the pump may change. In such cases, the affinity laws are 
used to adjust the head and power curves appropriately for the new speed. This is a process that 
often requires additional iteration.

Related Topics

Pumps 353
Submerged Pump 410
Pump Transients 412
Speed vs. Time 412
Setpoint vs. Time 413
Defining Junction Transients 287

Related Blogs

To Affinity and Beyond!

Submerged Pump
A pump junction can be defined as Submerged, meaning the process fluid directly enters the 
pump without any entrance piping. This definition is convenient to avoid the need of modeling 
suction piping when the suction HGL or pressure is a known and fixed value. The submerged 
pump feature is only available for the Centrifugal and Positive Displacement models.    

There are three options to choose from to define a submerged pump: Head (HGL), Pressure, 
and Surface Conditions.    
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Head (HGL)    

With the Heat (HGL) option selected, the only required value is Liquid Surface HGL. This value 
refers to the liquid surface elevation relative to the reference elevation, as can be seen in Figure 
1. This is important when the elevation of the pump is a non-zero value. The specified elevation 
for the pump is then used to determine the depth of the submerged pump.    

Figure 1: Diagram of Submerged Pump, Liquid Surface HGL input

Pressure

With the Pressure option selected, the only required value is Suction Pressure. This value refers 
to the fluid pressure at the inlet of the submerged pump.

Figure 2: Diagram of Submerged Pump, Pressure input

Surface Conditions

With the Surface Conditions option selected, there are two required values: Surface Pressure 
and Liquid Depth. Similar to how a reservoir junction is defined, the Surface Pressure is the pres-
sure of the fluid at the surface, which is helpful when the liquid surface is not at atmospheric pres-
sure. The Liquid Depth is the distance between the liquid surface and the inlet of the submerged 
pump.
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Figure 3: Diagram of a Submerged Pump, Surface Conditions input

Related Topics

Pumps 353
Affinity Laws 408
Pump Transients 412

Related Blogs

Back to the Basics: Calculating and Defining Head

What Does “Head (HGL)” Mean for Submerged Pumps and Exit Pressures?

Pump Transients
The Pump junction offers several transient event options on the Transient tab of the Pipe Prop-
erties window. Depending on the pump configuration, the available transient events will change. 
Each transient event is described below including: the situation in which it is available, the 
required inputs, and how to define the transient.   

Related Blogs

Where to Start with Pump Startups

Start your engines! Modeling an Inertial Pump Startup

Speed vs. Time
Pump configurations other than pumps defined with a fixed setpoint allow the direct specification 
of Speed vs. Time. This is not an Inertial Model - it is possible to specify a speed change that 
would be unrealistic without an external force on the Motor or Pump. 
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Transient Data

The Speed vs. Time data must be directly defined in Transient Data. The speed of the pump will 
be forced to meet this data at each time step of the transient simulation, with the pump curves 
being adjusted every time step according to the affinity laws.

Figure 1: A Speed vs. Time transient

Related Topics

Setpoint vs. Time 413
Affinity Laws 408
Defining Junction Transients 287

Related Blogs

Where to Start with Pump Startups

Start your engines! Modeling an Inertial Pump Startup

Setpoint vs. Time
If modeling a Controlled Pump (Variable Speed) or a Positive Displacement Pump with a steady 
setpoint, users can define a transient setpoint vs time profile. This replaces the Speed vs. Time 
option, as defining both the speed and the setpoint would over constrain the system. 
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Transient Data

The Setpoint vs. Time data must be directly defined in Transient Data. The selected parameter 
will be forced to meet this data at each time step of the transient simulation, with the pump 
curves being adjusted every time step following the affinity laws. The resulting speed variation 
over time will be visible in the output.

Figure 1: A Setpoint vs. Time transient

Related Topics

Speed vs. Time 412
Affinity Laws 408
Defining Junction Transients 287

Startup with Inertia
The Startup with Inertia transient is the first of two inertial transients that can be defined for the 
Centrifugal (Rotodynamic) Pump. Modeling an inertial pump startup simulates a pump which is 
connected to a motor that is initially supplying no torque, and is suddenly switched on. The iner-
tial startup is an uncontrolled start - meaning the torque characteristics of the motor alone will 
drive the speed change behavior. The inertial startup does not capture a controlled start, where 
there may be complex equipment such as a PID-controlled VFD slowing down the startup of the 
pump, and cannot be used in combination with the Variable Speed Controlled Setpoint options 
for a pump.

Inertial Characteristics

The total rotating inertia of the pump/motor system must be available. This must include all 
rotating components - the motor rotor, shaft, impeller, entrained liquid, and any other 
connected components. This value can be estimated or directly specified.

- 414 -



Transient Data

To solve the torque balance equations, the torque on the shaft at any given speed must be 
known. The torque exerted by the pump on the shaft (that is, from the fluid) can be determined 
with the Standard Pump Curve power curve. The torque characteristics of the device driving the 
pump must be defined by the user. Typically, this is an induction motor. It could also be a syn-
chronous motor, a DC motor, or another device entirely such as a shaft-connected turbine or 
diesel engine.

Induction motors generally follow one of a few standard torque vs speed profiles. Shown below is 
torque profile of a motor showing typical NEMA Design B characteristics. Also shown is the 
torque behavior of the pump, as determined with the affinity laws.

Note: The pump torque characteristics can be considered ideal for the user defined power 
curve. A real pump will have higher torque during startup due to friction and other star-
tup effects. These are not represented here, as including them would make the model 
and required input much more complicated for little benefit.

Figure 1: A typical NEMA Design B motor torque curve and ideal pump torque curve.

AFT Impulse allows the definition of the Motor or Driver Torque curve vs. relative or absolute 
speeds.
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Figure 2: Motor or Driver Torque curve entered as Percent of Rated Pump Speed vs Torque.

It is important to note that Rated Pump Speed, Rated Motor Speed, and Synchronous 
Motor Speed are different values. If the motor is perfectly matched to the pump, the two rated 
speeds may be the same. If entering the data as Shaft Speed (rpm), then no concern over a 
rated speed is required. However, they are important for relative (%) data entry.

To clarify the difference between these options consider the following values (which correspond 
to Figure 1):

 l Rated Pump Speed - 3500 rpm - Rated by the pump manufacturer
 l Rated Motor Speed - 3540 rpm - Rated by the motor manufacturer, the speed at which 

the motor is designed to handle its rated torque
 l Synchronous Motor Speed - 3600 rpm - A characteristic of most electric motors - the 

speed at which the electrical field rotates. Available from the motor manufacturer, and 
often the torque characteristics are plotted against percent of synchronous speed.
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Figure 3: Various speeds for the Figure 1 characteristics. Note that the corresponding torque value 
for 100% Synchronous and 100% Rated Pump are different.

Of interest in Figure 3 is that not only are there three different commonly referenced speed ref-
erences, when placed into a system the actual operating speed is not any of these values! Why 
is this? The actual operating point depends on how well matched the motor is to the pump and its 
operating point. In this instance, the motor is providing enough torque that the rated pump speed 
is exceeded. Additionally, the system is configured in such a way that the resistive torque is 
lower than the motor's rated torque at rated motor speed. This causes the motor to speed up fur-
ther until the pump torque and motor torque match.

Special Condition

The pump will need to have its special condition set to Pump Off With Flow Through to model a 
Startup.

Related Topics

Inertial Models Detailed Theory 418
Trip with Inertia 418
Defining Junction Transients 287

Related Blogs

Where to Start with Pump Startups

Start your engines! Modeling an Inertial Pump Startup
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Trip with Inertia
The Trip with Inertia transient is the second of two inertial transients that can be defined for the 
Centrifugal (Rotodynamic) Pump. Modeling an inertial pump trip allows the representation of a 
situation where a pump is operating normally, but all motor or driver torque is instantaneously 
lost. This trip is uncontrolled - meaning that the torque characteristics of the pump alone will drive 
the speed change behavior.

Inertial Characteristics

The total rotating inertia of the pump/motor system must be available. This must include all 
rotating components - the motor rotor, shaft, impeller, entrained liquid, and any other 
connected components. This value can be estimated or directly specified.

Transient Data

No further data is required from the user to define a trip.

To solve the torque balance equations, the torque on the shaft at any given speed must be 
known. The torque exerted by the pump on the shaft (that is, from the fluid) can be determined 
with the Standard Pump Curve, which is already defined. The torque of the motor or driver is 
assumed to instantly fall to zero.

Related Topics

Startup with Inertia 414
Inertial Models Detailed Theory 418
Defining Junction Transients 287

Inertial Models Detailed Theory
Any device has an inertial resistance to change in motion. Pumps are no different - in order to 
change their speed, a torque must be applied. Instantaneous speed change would require infin-
ite torque. When modeling fluid transients, a more realistic expectation of pressures and flows 
can be determined when taking this into account. As expected, accounting for inertia requires 
some additional information.

Inertial Model Theory

Pumps in AFT Impulse are considered completely homologous. This means that the pump 
curves used are considered to be scalable to any speed with the affinity laws - real pumps will 
deviate somewhat from this behavior. Accounting for this behavior would require much more 
data for little benefit. Fortunately, this simplification makes approaching something like an inertial 
model much more straightforward.
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Due to the above simplification we can use standard relationships for power, torque, rotational 
speed, and rotational acceleration.

where

Pshaft = power required to drive the shaft at a given torque and speed
Tshaft = the torque applied to the impeller shaft.
ω = the angular speed of the shaft, in rad/s

Itotal = the total rotational inertia of the assembly. This must include the inertia of the pump 
impeller, entrained fluid, the shaft, and the motor rotor - all of the connected rotating com-
ponents.

The shaft is acted on by the driver (typically a motor), and the pump (the impeller). Positive 
torque and speed are defined to be in the same direction, with positive relating to normal pump-
ing conditions.

Under steady conditions, there is no torque imbalance meaning that Tshaft and angular accel-
eration are zero.

There are a couple of common ways the torque becomes imbalanced - when starting up a pump 
a large torque is applied by the driver, while the pump torque is initially zero. When tripping a 
pump, the driver torque drops to zero. In both cases the shaft torque is not zero, meaning the 
speed must change.

We can integrate the torque balance equation over a time step to get a form that is useable in 
numerical simulation. Torque is a function of time, so we consider the average torque over the 
time step.

Solving for the new speed:
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There are three unknowns in this equation: ωnew, Tdriver,new, and Tpump,new. We need two 
more equations for a solution.

To represent the driver, we need raw data relating speed ω and torque Tdriver.
This leaves two unknowns: ωnew and Tpump,new. A function (curve fit) relating power and flow 
is required input - with the affinity laws, this is further a function of speed.

We know that the torque is related to power by a factor of speed from the first equation above, 
which means torque is also a function of speed and flow.

We have a relationship for ωnew and Tpump,new, but have introduced one more variable - 
flow. This is solved for with the pump head curve and the Method of Characteristics, as its mag-
nitude depends on the system as well.

With iteration, we can now determine a new speed and new torque for the new time step. The 
only additional input required is the behavior of Tdriver and the value of Itotal. A pump trip is 
defined as an event where all driver torque is immediately set to zero. A pump startup is rep-
resented as an "uncontrolled" start - driver speed vs torque provides the information required.

Total Rotating Inertia

To model an inertial startup or trip, the total inertia of the rotating system must be known. This 
must include all rotating components - the motor rotor, shaft, impeller, entrained liquid, 
and any other connected components.

Obtaining this information is often quite difficult. Determining the rotational inertia of a single 
material component with a complex shape like an impeller is challenging enough on its own, and 
this is only part of the puzzle. Instead of calculating a value analytically, it is possible to use test 
data to determine a value for inertia. The best test data will come directly from the pump/motor 
assembly of interest, but again, this can be difficult to get.

An alternative method is to use statistical analysis of industry pumps and motor to determine a 
likely inertia value for a given pump and motor. Thorley (2004) presents just such analysis of 
pumps and motors across industries, and AFT Impulse employs this estimate when the appro-
priate option is selected.             
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Figure 1: Estimated Total Rotating Inertia

For pumps, Thorley presents the following correlation derived from a linear regression of 284 
data points (the formula has been adjusted to use rpm instead of 1,000's of rpm):

where

Ipump = The rotational inertia of only the pump in kg-m2

P = shaft power at rated conditions and BEP in kW. To determine the power at rated conditions, 
the system fluid must be defined and a Standard Pump Curve with Power/Efficiency data must 
be available.

N = shaft speed in rpm

Thorley notes that this correlation has a very good correlation coefficient of 0.96. However, he 
further notes that the actual values of inertia range from +100 to -50% from the predicted value.

Note: Thorley presents two correlations - the one above is applicable to most pumps, how-
ever, one type of pump from a particular manufacturer in the study followed a slightly dif-
ferent trend. This is not presented here, and AFT Impulse uses the above correlation in 
its estimate.

For motors, Thorley presents the following, from 272 data points (the formula has been adjusted 
to use rpm instead of 1,000's of rpm):

where

Imotor = The rotational inertia of only the motor in kg-m2

P = shaft power at rated conditions and BEP in kW

N = shaft speed in rpm

Similar to pumps, this has a good correlation of 0.97 with a similar spread.

The total rotational inertia is then considered to be the combination of the two estimates:
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Note: Remember that this value is only an estimate. As Thorley notes, there is significant 
spread in the statistical data. If pump speed change is a critical parameter, total rota-
tional inertia is also a critical parameter. In such cases, a sensitivity study should 
be completed by doubling and halving the estimated inertia value.

Related Topics

Startup with Inertia 414
Trip with Inertia 418
Defining Junction Transients 287

Full Load Rejection
The Pump as Turbine (PAT) model has one unique transient definition: a Full Load Rejection. 
This option is shown in the Transient tab of the Pump Properties window.
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Figure 1: Transient tab of the Pump Properties window for a PAT showing the Full Load Rejection 
option.

During this event, the PAT is decoupled from its motor at the specified Transient Initiator, and the 
PAT undergoes decoupling. The PAT then spins with the fluid until it reaches runaway speed. 

Related Topics

Pump as Turbine Overview 398
Pump As Turbine Configuration 400
PAT Operation as a Turbine 402
PAT Operation While Decoupled 404
PAT Operation During Decoupling 407

Relief Valve
The Relief Valve junction allows users to model a valve that opens at a specified pressure in the 
system. Depending on how the relief valve operates, that pressure could either be the pressure 
at the relief valve inlet or the pressure at some remote point in the system. The differences 
between those valves are discussed below. 
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The Relief Valve Properties window follows the first of the two basic Properties Window formats, 
displaying the connected pipes in a fixed format. The Relief Valve junction adopts a flow dir-
ection from the connecting pipes. 

There are three types of relief valves available:

 l Internal Relief Valve - Contains two connecting pipes and relieves into the downstream 
pipe. This type of relief valve acts like a regular valve that is closed until the specified pres-
sure is reached. 

 l Exit Valve - Contains one connecting pipe and relieves to an external ambient pressure 
when the specified pressure is reached. 

 l Inline Exit - Contains two connecting pipes and relieves to an external ambient pressure 
when a specified pressure is reached. This type of relief valve acts as a lossless con-
nection when closed and allows flow between the connecting pipes. 

Opening and Closing Profiles

The Relief Valve junction has four different methods for the valve to open or close. There are 
also four preset valve profiles with a fixed combination of these methods that the user can 
choose from. These options are listed below. 

The four methods by which the valve can open or close are:

 l Instant - The relief valve opens fully or closes fully from one time step to the next as the 
opening or closing conditions are met. 

 l Time - The valve opens or closes according to a Cv vs. Time profile as the opening or 
closing conditions are met. The Cv vs. Time profiles are entered on the Transient tab, as 
needed. 

 l Pressure - The valve passively opens or closes according to a Cv vs. Pressure profile as 
the opening or closing conditions are met. The Cv vs. Pressure profiles are based on the 
Valve Setpoints and the data entered in the Loss Model tab. Maximum Cv vs. Time rate 
limits can be applied.

 l Never - The valve never closes. This method cannot be applied to the valve opening.

The four preset valve profiles are:

 l Passive - The valve is set to open and close based on pressure setpoints. 
 l Pilot Operated - The valve is set to open based on time and close based on pressure set-

points. Users must define an Opening Transient in the Transient tab. 
 l Rupture Disk - The valve is set to open instantly when the set pressure is exceeded and 

never close. 
 l Surge Anticipator - The valve is set to open and close based on pressure setpoints. This 
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profile also sets the valve to use remote sensing with high and low pressure setpoints and 
with opening and closing Cv vs. Time rate limits. 

The relief valve also has a General profile. This profile allows the user to customize the method 
by which the valve opens and closes. The only restriction placed on combinations of opening 
and closing methods is that if the valve opens based on pressure, it can only close based on 
pressure. 

Finally, it is important to note that if the valve opens based on time and closes based on pres-
sure, the valve cannot open faster than pressure at the valve allows. If the opening transient 
were to open the valve to a Cv larger than what the pressure at the relief valve dictates, the valve 
would immediately start to close. Thus, a time opening transient is effectively rate limited to what 
the relief valve inlet pressure dictates.  

Balanced vs Unbalanced Valves

Relief valves can either be hydraulically balanced (constant backpressure) or non-hydraulically 
balanced. This characteristic of the valve is determined by how the dome of the relief valve is 
pressurized. 

For an unbalanced valve, the dome of the valve is pressurized via the fluid downstream of the 
valve. Since the downstream pressure can change during the transient, the valve position is 
based on a pressure differential between the upstream and downstream pipes rather than based 
solely on the upstream pressure. 

For the balanced valve, the dome of the valve is pressurized to a constant pressure, often by 
attaching some type of bellows device. With this system, the valve position is based only on the 
actual upstream pressure. 

Valve Setpoints

The valve setpoints determine when the relief valve will open and when it will be closed. These 
setpoints can be defined using either pressure or head. 

There are four possible valve setpoints the user needs to define:

 l Exit Pressure - The ambient pressure downstream of the relief valve for the Exit or Inline 
Exit valve types. This pressure will only be used to determine when the valve opens and 
closes when the relief valve is unbalanced.

 l Overpressure - The upstream pressure at which the valve is fully open. This input is only 
needed when the valve opens or closes based on pressure. 

 l Set Pressure - The upstream pressure at which the valve opens. This input must be spe-
cified for all valve profiles and is replaced by the High and Low Pressure Setpoints when 
Remote Sensing is enabled. 

 l Blowdown Pressure - The upstream pressure at which the valve is fully closed. All 
options for valve opening and closing require this input, with the exception of the Never 
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profile. If the relief valve closes at the same pressure where it opens, the Set Pressure 
and the Blowdown Pressure should be set to the same value. 

Note: The Relief Valve junction operates exclusively using stagnation pressure. All setpoints 
are defined as stagnation pressure and all calculations are based on stagnation pres-
sure. In most cases, the assumption that stagnation pressure is equal to static pressure 
is valid. 

Pilot Operation, Remote Sensing, and Surge Anticipation

The Relief Valve junction gives users the ability to model Pilot Operated Relief Valves (PORVs), 
Remote Sensing Relief valves, and Surge Anticipation Relief Valves. The PORV is enabled with 
the Pilot Operated preset profile, while the other options are available anytime the valve oper-
ates as a Passive pressure/pressure valve. 

A PORV is a relief valve that can more rapidly respond to pressure surges. This rapid response 
is accomplished with two changes from a passive pressure relief valve. First, the pressure on 
both sides of the PORV’s plug is maintained at the upstream pressure via a pressure sense line 
(see Figure 1). Since the area above the plug is larger than the area below the plug, the net force 
on the plug acts to keep the valve closed regardless of pressure. Second, the valve is controlled 
by a Pilot. When the set pressure is reached upstream, the pilot acts to vent the dome of the 
valve (above the plug), rapidly changing the net force on the plug and opening the relief valve. 

Figure 1: Pilot Operated Relief Valve Schematic

A Remote Sensing Relief Valve is a relief valve that opens based on the pressure at a specified 
location in the system other than the upstream side of the valve. This design allows the relief 
valve to be more responsive to surge events by opening the valve before the pressure surge 
arrives at the valve itself. The degree to which the relief valve is open is still determined by the 
pressure at the valve, but the pressure wave will be immediately relieved by the valve instead of 
first having to open the valve. 
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A surge Anticipation Relief Valve is a relief valve that opens when the pressure at a specified 
remote location in the system drops below a low pressure set point. These valves are typically 
paired with a pump and help mitigate high-pressure surges that are preceded by a low-pressure 
front. When the remote location’s pressure falls below the Low Pressure setpoint, the low-pres-
sure pilot partially vents the dome of the valve above the plug. Then, if the remote location’s pres-
sure rises above the High Pressure setpoint, the Surge Anticipation Relief Valve will behave the 
same as the PORV, opening based on the pressure at the relief valve inlet.

For the Surge Anticipation Relief Valve, the valve will only close when one of two conditions is 
met. The first condition is when the pressure at the valve falls back below the blowdown pressure 
and the valve is reset. The second condition is when the pressure rises above the High Pressure 
setpoint, the valve opens based on pressure, and then the pressure falls again, closing and reset-
ting the valve. Effectively, if the remote pressure rises above the High Pressure Setpoint, the 
valve will behave as if it is a PORV and will not return to Surge Anticipation until the valve closes 
again.

Loss Model

The Relief Valve loss information is entered on the Loss Model tab. The available options 
change depending on how the valve opening and closing are defined. For all options, the Base 
Area for Loss Model can be specified, with the upstream pipe being used by default. 

The following loss model options are available depending on which profiles are selected:

 l Instant/Time Profiles
 l Cv (Constant) - The relief valve instantly changes from closed to a fixed Cv.
 l Kv (Constant) - The relief valve instantly changes from closed to a fixed Kv.
 l CdA (Constant) - The relief valve instantly changes from closed to a fixed CdA. 

This CdA is defined as the product of an Orifice Effective Area (A) and a Discharge 
Coefficient (Cd).

 l The Orifice Effective Area can come from an API 526 letter designation or it 
can be User Specified. 

 l The Discharge Coefficient must always be specified by the user. The value 
is typically specified by the manufacturer. 

 l K Factor - The relief valve instantly changes from closed to a fixed K Factor. 
 l Pressure Profiles

 l Cv (Variable) - The relief valve moves between the closed and open states with 
the Cv varying between 0 and the Fully Open Cv value. 

 l Kv (Variable) - The relief valve moves between the closed and open states with 
the Kv varying between 0 and the Fully Open Kv value. 

The Variable Data option for the Relief Valve Loss Model allows users to model the valve losses 
based on where the valve is between fully open and fully closed. The Linear based on setpoints 
option has Impulse determine those losses solely based on the setpoints the user has specified. 
If the user knows enough about the valve to describe a detailed loss profile, they can select the 
Non-linear option. The first data point must have a loss value of 0 at the Blowdown pressure. The 
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final data point must have a loss value equal to the Fully Open loss value, at the Overpresure. 
The entered data is interpolated during the transient simulation. 

Users can also define Rate Limits for valves that open or close based on pressure. These limits 
allow the user to restrict how fast the valve can change position. Some relief valves may have 
hardware in place to limit valve movement, other relief valves may have enough mass that their 
inertia prevents them from immediately responding to pressure changes. 

Transient Data

Transient Cv, Kv, or K Factor vs. Time data can be entered on the Transient tab when the valve 
opens or closes based on time. 

For a valve that opens and closes based on time, the transient data will be used exclusively to 
determine the valve’s position. If the valve opens based on time but closes based on pressure, 
the valve position will be limited by the pressure at the valve during the opening transient. The 
valve will switch to passive pressure control and remain at passive pressure control if the Loss 
Factor vs. Time data would cause the valve to open past what the pressure conditions dictate. 

For more information about how to create Loss Factor vs. Time tables based on Open Percent 
data, please see the Valve Properties Window page. 

Special Conditions

The relief valve has two Special Conditions:

 l Failed Open - The valve is forced to remain open regardless of pressure conditions.
 l Ignore Relief Valve - The valve is forced to remain closed regardless of pressure con-

ditions.

For more information see Special Conditions.

Related Topics

Junctions 267
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Junction Loss Models 281
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Relief Valve Waterhammer Theory 429
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Related Blogs

Looking to relieve pressure? Let's talk about Relief Valves in AFT Impulse

Relief Valve Waterhammer Theory
Relief Valve junction models a valve that opens at a specified pressure in the system. The valve 
can relieve either to an outside ambient pressure or into another pipe in the system. The Relief 
Valve junction has three different types. 

Internal Relief Valve

An internal relief valve behaves similarly to a regular valve. When it is closed it behaves identic-
ally to a closed Valve junction. When it is open, the loss factor at the valve is first determined 
based on the pressure conditions at the valve. Then, the pressure loss and flowrate at the valve 
are determined as if the relief valve is a regular valve junction with the loss factor assigned for 
that time step. 

Exit Relief Valve

An exit relief valve behaves similarly to a regular exit valve. When it is closed it behaves identic-
ally to a closed exit valve. When the valve is open, it relieves to the user-specified Exit Pressure.

where SC and SB are given by Equations 2 and 3.The pressure drop across the exit is 

or,

Substituting
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This is a quadratic equation in which ṁexit,new can be obtained from the quadratic formula.    

Inline Relief Valve

An inline relief valve behaves similarly to a Branch or Spray Discharge junction, depending on if 
it is closed or open. When the valve is closed, it acts like a lossless Branch junction with two 
pipes. When the valve is open, it acts like a Spray Discharge junction with two connected pipes. 

Relief Valve Vapor Cavitation Theory

Cavitation at a relief valve can be complicated to model and understand. If cavitation is present 
while the valve is closed, the valve will behave as described below. If cavitation is present while 
the valve is open, the user should closely examine the results to ensure the results are accurate 
and reasonable. 

When the relief valve is closed, cavitation is modeled differently for each type of relief valve:

 l Internal Relief Valve: the cavitation at the valve is identical to that of a regular valve. 
Note that for this type of relief valve, cavitation is modeled like a regular valve even when 
open. 

 l Exit Relief Valves: the cavitation at the valve is identical to that of a dead end junction. 
 l Inline Relief Valves: the cavitation at the valve is identical to a branch junction con-

nected to two pipes. 

Related Topics

Nomenclature 683
Method of Characteristics 701
Relief Valve 423

Related Blogs

Looking to relieve pressure? Let's talk about Relief Valves in AFT Impulse
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Reservoir
The Reservoir junction type allows you to connect up to twenty-five pipes. One connecting pipe 
is required.

The Reservoir Properties window follows the second of the two basic Properties window 
formats. A table on the Loss Coefficients tab displays the connecting pipe information. This table 
grows to accommodate up to twenty-five pipes. After you add a fifth connecting pipe, a scroll bar 
appears, allowing you to review and enter loss factors for all pipes in the table. The pipe table dis-
plays the reference positive flow direction of each connecting pipe. To enter loss factors, select 
the cell in the table and edit the value. Each pipe can use a different loss model or custom value.

Tank Model

There are two possible Tank Models available in the Reservoir junction, Infinite Reservoir and 
Finite Open Tank.

 l Infinite Reservoir - Infinite reservoirs refer to a massive body of fluid whose surface level 
does not change appreciably as a result of liquid inflow or outflow during the time frame of 
the simulation. An example is a large lake or the ocean. The Infinite Reservoir model is 
convenient for specifying a fixed pressure in your system. This tank model applies a 
defined pressure at the junction location in the model. When solving a pipe flow system, 
an Infinite Reservoir causes the rest of the system to distribute the flow in a manner con-
sistent with the defined pressure.

 l Finite Open Tank - Finite reservoirs (also called finite tanks) refer to a body of fluid which 
is small enough that its surface level changes significantly during the time frame of the 
simulation as a result of liquid inflow or outflow. An example is a tank which drains as the 
simulation progresses. Finite open reservoirs are open to the atmosphere or some other 
fixed surface pressure. Finite reservoirs require specification of tank geometry. Typically, 
the liquid level and surface pressure are defined initially, and then calculated over time 
based on the tank geometry.

For both models the Liquid Surface Elevation, Liquid Surface Pressure, and Pipe Depth/El-
evation will be required to be defined by default.

If the Finite Open Tank model is chosen, additional information for the Cross-Sectional Area, 
Tank Height, and Tank Bottom Elevation will be required. The cross-sectional area can be 
defined as a constant area if it is a standard cylinder, or can be modeled as variable. If the vari-
able option is chosen, an additional Tank Geometry input will be required on the Pipe Depth & 
Loss Coefficients tab to enter the Accumulated Volume in the Tank vs the Liquid Height.

Known Parameters Initially

For the Finite Open Tank option, the options become active to specify whether some parameters 
are defined by the user for the steady state. In some cases, the initial liquid level or pressure may 
not be known, and it is desired to have this calculated based on a mass balance in the system. 
This can be selected using the check box options provided. Impulse will only allow one of these 
parameters to be left unknown at a time.
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Specifying Pipe Connectivity

If there is a single pipe connected to the junction, its elevation can be directly specified on the 
Reservoir Model tab. The elevation can be specified either as an absolute Elevation, or as a 
depth below the liquid surface. This means there are two ways to define the same pipe elevation.

If multiple pipes are connected, they can each have a unique elevation. This is displayed on the 
Pipe Depth and Loss Coefficients tab. In this table, all elevations must be specified as either 
depth or elevation. Additionally, losses such as re-entrant losses can be added to the pipe con-
nections in this table. Loss factors can optionally be specified for flow into and flow out of the 
pipe. 

Tip:   Since transient models allow the liquid level to change, and the user may desire to run 
different scenarios with different initial liquid levels, it is better to specify reservoir pipe 
connections based on elevation and not depth.

Pipes Connected Above Liquid Surface

A pipe elevation can be specified higher than that of the liquid surface. Pipes that empty into the 
Reservoir above the liquid surface are assumed to have liquid free fall to the liquid surface. AFT 
Impulse applies the proper boundary condition for above the liquid surface.

If the pipe is above the liquid surface, the only appropriate condition is for the fluid to be flowing 
from the pipe into the reservoir. Fluid cannot flow from the reservoir into the pipe as the pipe is 
above the liquid surface. However, AFT Impulse will assume the fluid flowing into the pipe is the 
same as the reservoir fluid, solve the system, then issue a warning to the user in the output that 
this is unrealistic.

Finite Tank Overflow/Drain

When a finite tank liquid level reaches the top, it is assumed that the liquid spills over the top. 
Hence the liquid height is maintained at the top of the tank. Note that this causes a loss of mass 
from the system model.

When a tank drains to the bottom, it cannot supply any more liquid to the connected pipes. The 
system behavior after a tank has drained cannot be accurately modeled by AFT Impulse. In a 
real system, and in the absence of a valve to stop the flow, a drained tank which continues to 
flow would result in the connected pipes themselves draining and a gas/liquid interface moving 
down the pipes. AFT Impulse assumes all pipes are liquid full, and cannot model draining pipes. 
A warning will be displayed in the output tab if this occurs.

Since it is not desirable in most applications to have the pipes drain, this limitation is not a sig-
nificant issue. The user can, for example, use a valve in the pipe which closes when the tank 
drains. This would use an event transient.    
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Transient Data

On the transient data tab the surface elevation can be changed with time. For more information 
on transient data, including event transients, see Junction Transient Data.

Graphing Reservoir Data

You can graph various parameters such as tank liquid height and total mass or volume inflow by 
selecting to save the transient output for these junctions in the Output Junctions panel of the 
Pipe Sectioning and Output group. These parameters can be graphed or reviewed in the Output 
window.    

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Reservoir Waterhammer Theory 433
Role of Pressure Junctions and How They Work 117

Reservoir Waterhammer Theory
A reservoir is similar to an assigned pressure. With the known reservoir height, the pressure can 
be obtained at the junction and the flow can be solved directly (Wylie 1993, pp. 43):    

Then the flow rate is obtained by employing the compatibility equations.

If the pressure is known at the upstream end of the pipe, the negative compatibility equation is 
used (Equation 2).

Conversely, if the pressure is known at the downstream end, the positive compatibility equation 
is used (Equation 1).
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If the reservoir height changes with time, then a current height is obtained for the current time 
step and used in the equations.

Reservoir Vapor Cavitation Theory

Infinite Reservoir junctions cannot reach vapor pressure because the pressure is specified and 
is therefore always above vapor pressure. 

Any short-lived vapor cavities that develop at a Finite Open Tank junction are assumed to have a 
negligible effect compared to the tank itself. Conceptually, vapor bubbles would rise by buoy-
ancy to the open tank surface and evaporate at the surface.

Therefore, vapor cavitation is ignored at finite open tanks.

Related Topics

Nomenclature 683
Method of Characteristics 701
Reservoir 431
Role of Pressure Junctions and How They Work 117

Screen
The Screen junction type requires two connecting pipes. This junction type allows you to model 
the irrecoverable loss that occurs through a screen, mesh, or filter flow restriction. It also allows 
you to specify loss factors as a function of a flow parameter.

The Screen Properties Window follows the first of the two basic Properties Window formats, dis-
playing the connecting pipes in a fixed format. The Screen junction does not have an explicit flow 
direction; it adopts a flow direction from the connecting pipes.

AFT Impulse provides four standard screen types for your use:

 l Sharp-edged perforated plate
 l Round-edged perforated plate
 l Circular wire screen
 l Silk thread screen

The loss factors for these screens are taken from handbook values. In addition to the standard 
screens that AFT Impulse provides, you may enter your own custom screen loss factor that is 
consistent with the application.
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When you select Resistance Curve in the Loss Model section on the Loss Model tab, the Screen 
Properties window makes additional features available. Using these features, you can input pres-
sure drops that vary with flow. To enter this information, you can specify polynomial constants, fit 
a curve to available data, or use interpolated x-y data.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Resistance Curve Loss Model 284
Troubleshooting Resistance Curves 793
Screen Loss Model 435

Screen Loss Model
The screen loss factors have much in common with orifice loss factors. In fact, the sharp-edged 
perforated plate and round-edged perforated plate screen losses are the same as for orifices 
with similar area ratios and equal upstream and downstream areas. Refer to the orifice loss 
factor equations for these relationships. The relationships are good for screen area Reynolds 
numbers above 100,000.

The circular metal wire screen, shown in Figure 1, is given by the following equation for screen 
area Reynolds numbers above 1000 (Idelchik 2007, 598):

Figure 1: Circular metal wire screen

The silk thread screen, shown in Figure 2, is given by the following equation for screen area 
Reynolds numbers above 500 (Idelchik 2007, 577):
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For other screen configurations, see Chapter 8 of Idelchik's Handbook of Hydraulic Resistance 
(2007).

Figure 2: Silk thread screen

Related Topics

K Factor Loss Model 282
Screen 434

Spray Discharge
The Spray Discharge junction must have at least one connecting pipe, and it allows up to four. 
This junction offers a flexible way of modeling a flow exiting the system through a nozzle or spray 
device. The flow occurs across a user specified hydraulic loss such as a discharge coefficient. 
This can be varied with time to open or close the Spray Discharge junction.

The Spray Discharge Properties window follows the second of the two basic Properties window 
formats. A table displays the connecting pipe information. The pipe table grows in size to accom-
modate up to four connecting pipes. 

The exit pressure to which the Spray Discharge junction discharges must be entered. 

Two geometries can be modeled. The first is a normal, one hole spray, where the discharge flow 
area of the hole is entered. The second is a sparger which, in principle, works in the same way as 
a spray. For the sparger, the flow area of a single hole and the number of holes are entered. This 
assumes that the holes are hydraulically close in proximity and are the same area.

For each connecting pipe, the pipe table on the Pipe Losses tab lists the reference flow direction 
and up to two loss factors. The first loss factor is for physical flow out of the pipe and into the junc-
tion, the second is for physical flow into the pipe and out of the junction. The loss factors can be 
specified independently or left as zero. To edit within the pipe table, click in the appropriate 
column and row.

The distance of each connecting pipe (if any difference exists) from the elevation can be entered 
in the pipe table.
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Loss Model

The discharge coefficient for the junction is entered under the Loss Model tab in the box near the 
bottom of the window. The physical area of the exit flow can also be entered under the discharge 
coefficient input box. These two parameters are used to calculate the discharge flow rate, which 
depends on the difference between the internal pressure in the system and the specified exit 
pressure.

The K Fire Sprinkler model uses the K value as defined by the fire sprinkler industry. Whereas 
the standard K loss value is dimensionless, the K Fire Sprinkler has units associated with it. You 
can adjust these units according to your data.

Transient Data

On the transient data tab the discharge flow area or K data can be varied with time to simulate 
the opening or closing of the junction. For more information on transient data, including event 
transients, see Junction Transient Data.

Graphing Spray Discharge Data

You can track the discharge flowrate and total mass or volume discharged at the spray dis-
charge junction by selecting to save the transient output for these junctions in the Output Junc-
tions panel of the Pipe Sectioning and Output group. These parameters can be graphed or 
reviewed in the Output window.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Spray Discharge Fire Sprinklers 437
Spray Discharge Waterhammer Theory 438

Spray Discharge Fire Sprinklers
The definition of the K value for fire sprinklers is:
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where Q and ΔP can be in the units of your choice. The preference in the USA is gpm for flowrate 
and psid for pressure. In Europe it is frequently liter/min for flow rate and bar for pressure. Note 
that Ksprinkler is not dimensionless, but has units associated with it. Also, note that sprinkler 
vendor values for Ksprinkler implicitly assume that water is the fluid, so there is a built-in density 
of 62.3 lbm/ft3 or 1000 kg/m3. If this sprinkler is used for something other than water, the Ksprink-
ler value will need to be adjusted.

Also note that if the spray is into the atmosphere, as is typical, the ΔP is the same thing as the 
gage pressure. That is why the previous equation is stated by some vendors as just P in the 
denominator, rather than ΔP. When stated as just P, the pressure is gage.

Finally, note that the Exit Pressure, as defined by AFT Impulse, is different than the concept of 
Discharge Pressure, an often used parameter in the Fire Protection industry. AFT software 
defines Exit Pressure as the pressure of the ambient surroundings, which in an unpressurised 
location at sea-level, is 1 atm.

Note: The fire sprinkler K is not the same as the dimensionless K value as given by Equation 
1 in the K Factor Loss Model section and used extensively throughout AFT Impulse.

The Ksprinkler is related to the discharge coefficient. It can be shown that the relationship is 
given by

Related Topics

Spray Discharge 436
Spray Discharge Waterhammer Theory 438

Spray Discharge Waterhammer Theory
Spray discharge junctions (shown in Figure 1) model spray locations in a system. The spray junc-
tion discharges to a known pressure through an orifice or nozzle of some kind.
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Figure 1: Spray discharge schematic

The relationship for pressure drop across the nozzle is as follows

where, for clarity,  is defined positive flowing out of the system.

In addition, the spray junction is similar to a branch junction, so the following equation applies 
with the flowrate defined positive out.

where SC and SB are given by Equations 2 and 3 and .Combining the preceding equations and 
eliminating flow rate,

or
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This is a quadratic equation, and the mass flowrate can be obtained by use of the quadratic for-
mula.

Note: If the spray junction pressure falls below the exit pressure, reverse flow will occur. If the 
exit pressure is the atmosphere, the reverse flow will be air. However, Impulse assumes 
the inflow is at the pipe system density. This can lead to erroneous results if ignored. 
Reverse flow can be determined by graphing the flow at the spray junction or looking at 
the summary of maximum and minimum flows in the Output window.

Spray Discharge Vapor Cavitation Theory

When the calculated pressure at a Spray Discharge junction drops below vapor pressure, a 
vapor cavity forms at the junction. This is similar to a Branch junction.The vapor volume cal-
culation is as follows:

where ṁspray is the spray outflow term. The ṁin terms are obtained from the positive com-
patibility equation, while the ṁout terms are obtained from the negative equation.

Similar to a pipe interior node, when the vapor volume is negative, the cavity collapses and the 
fluid pressure then rises above the vapor pressure.

Related Topics

Nomenclature 683
Method of Characteristics 701
Spray Discharge 436
Spray Discharge Fire Sprinklers 437

Surge Tank
The Surge Tank junction allows up to twenty-five connecting pipes. This junction type is useful 
for modeling a small open tank vessel designed as a surge protection device (see Figure 1). The 
Surge Tank may be integral with the pipe system, separated by an orifice, or by a short con-
nector pipe.

The Surge Tank Properties window follows the second of the two basic Properties window 
formats. A table on the Pipes tab displays the connecting pipe information, including flow dir-
ection and loss values. The table grows in size to accommodate up to twenty-five connecting 
pipes. 
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Figure 1: Surge Tank Properties Window

Tank Geometry

The Tank Height is the physical top of the tank in relation to the elevation. If there is a Connector 
Pipe, then the Tank Height is relative to the top of the Connector Pipe. This height is used in the 
case of overflow. If the surge tank overflows, spillage will occur and the liquid will exit the pipe 
system not to be recovered. If you do not want to model the overflow, specify a very tall tank or 
do not enter a Tank Height.

If the Tank Cross-Sectional Area is specified as Constant, the surge tank is assumed to be a ver-
tical tank with constant cross-sectional area. If the tank cross-sectional area changes with 
height, this can be entered by selecting the variable option and entering the cross-sectional vari-
ation in the table.

The Tank Cross-Sectional Area is used for the purpose of determining the liquid volume. It will 
determine how high the liquid will rise or drop, since a given volume of liquid will flow into the tank 
during a time step.
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Initial State of Liquid Height

The Initial State of Liquid Height must be defined based on the application of the surge tank. 
There are three available options.

 l Liquid Height Unknown (Calculated by Impulse) - This is the default option which 
allows Impulse to calculate the liquid height based on the static head at the junction, and 
is typical for most applications. During the transient, flow will go in and out of the tank, and 
the liquid level will change.

 l Liquid Height Known (Zero Inflow/Outflow) - This option allows the surge tank to act 
as a pressurizer, similar to a reservoir junction. In this case it is assumed that the surge 
tank is acting as a reference pressure for a closed loop, in which no inflow/outflow is pos-
sible in the steady state. The defined initial liquid height in the tank will be converted to a 
reference pressure. During the transient, flow will go in and out of the tank, and the liquid 
level will change.

 l Liquid Height Known (Possible Inflow/Outflow) - This option again allows the surge 
tank to act as a pressurizer. In this case it is assumed that the surge tank is providing a ref-
erence pressure for an open system, in which steady state inflow/outflow would be pos-
sible. The defined initial liquid height in the tank will be converted to a reference pressure. 
During the transient, flow will go in and out of the tank, and the liquid level will change. 
This option is similar to using the Finite Open tank model in the Reservoir junction.

Interface with Pipe System

The Surge Tank can connect into the pipe system in three ways: it can be integral with the pipe, it 
can be separated by an orifice, or it can be connected by a short pipe.

These options are provided in the Flow Restrictor and Connector Pipe areas. If neither option is 
used, the surge tank is assumed to be attached directly to the pipe with no hydraulic loss.

If the Flow Restrictor is used, the surge tank is assumed to be separated from the pipe system by 
an orifice, which causes an hydraulic loss as the liquid flows in and out of the surge tank. The 
loss is specified by entering a flow area and discharge coefficient. Further, this loss can be dif-
ferent for inflow vs. outflow.

Lastly, the surge tank can be connected by a short pipe which is considered to be short in rela-
tion to the other pipes in the system after they are sectioned. If the pipe is short, it can be 
assumed to react instantaneously with the surge tank. The short pipe accounts for liquid inertia 
and friction. If a connector pipe exists which cannot be considered short, it should be modeled as 
an actual AFT Impulse pipe.

The Flow Restrictor and Connector Pipe can both exist in the same surge tank. That is, a flow 
restrictor can be modeled at the top of a connector pipe, and the effect of both will be included.
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One-Way Surge Tank

One drawback of surge tanks is that they must be located in low pressure parts of the system 
because high pressure locations require a very tall surge tank (a water surge tank located where 
the pipe system is at 100 psig must have a liquid surface at least 230 feet higher than the pipe), 
unless there is a check valve connecting the surge tank to the pipe. Since the tank can only flow 
out, it is only useful to limit low transient pressures by flowing liquid into the system when the 
pressure drops. However, when the pressure rises, the check valve closes and the tank cannot 
accept any fluid and thus decrease the system pressure.

Such a design is called a One-Way Surge Tank, and it can be modeled by clicking the check box 
next to One-Way Surge Tank on the Tank Model Tab, then defining the check valve char-
acteristics and initial liquid height which subsequently become active.

Model as Dipping Tube Vessel

A dipping tube vessel is a combination surge tank and gas accumulator (see Figure 2). As long 
as the liquid level remains below the Height at Tube Bottom as shown in Figure 2, it acts like a 
conventional surge tank. If the liquid level rises above the bottom of the tube,gas gets trapped in 
the upper region and the device acts like a gas accumulator.

The dipper tube capability can be enabled by checking the box on the Tank Model tab, which will 
update the window with the required additional inputs of polytropic constant, height at tube bot-
tom, and tank height.
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Figure 2: Dipping tube vessel geometric representation. When the liquid level rises above the height 
of the tube bottom, it acts like a gas accumulator

Transient Data

On the transient data tab the surface pressure can be varied with time to simulate a tank pres-
surization. For more information on transient data, including event transients, see Junction Tran-
sient Data.

Special Condition

The special condition for the Surge Tank on the optional tab allows the user to set Impulse to 
ignore the surge tank. See Special Conditions for more information.

Graphing Surge Tank Data

You can track the surge tank flowrate, total mass or volume, and liquid surface level pressure by 
selecting these options in the Output Junctions panel of the Pipe Sectioning and Output group. 
These parameters can be graphed or reviewed in the Output window.

Related Topics
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Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Lumped Inertia Pipe with Orifice Waterhammer Theory 278
Typical Approaches to Reducing Transient Pressures 75
Surge Tank Waterhammer Theory 445

Surge Tank Waterhammer Theory
A surge tank is an open tank to the atmosphere (Figure 1) and is used as a surge suppression 
device (Wylie 1993, pp. 128-129).The flow balance on the surge tank junction is similar to a 
branch junction, with the deficit equaling the flow out of the surge tank, ṁT

Similar to a branch, it can be shown that for all connecting pipes to the junction

where SC and SB are given by Equations 2 and 3 from Branch Waterhammer Theory.

Figure 1: Surge tank schematic

The optional connector pipe and orifice effect is incorporated by the lumped inertia relationship 
as follows:

where C1 and C2  are defined in conjunction with lumped inertia. Refer to Equations 1 and 2 for 
lumped pipe inertia. The new tank liquid height can be related to the old height by the following:
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Substitution yields

Solving for 

This flow rate can be back substituted to obtain the junction pressure and surge tank liquid 
height.

Surge Tank Vapor Cavitation Theory

Any short-lived vapor cavities that develop at a Surge Tank junction are assumed to have a neg-
ligible effect compared to the surge tank itself. Conceptually, vapor bubbles would rise by buoy-
ancy to the surge tank surface and evaporate at the surface.

Therefore, vapor cavitation is ignored at surge tanks.

Related Topics

Nomenclature 683
Method of Characteristics 701
Surge Tank 440

Tee/Wye
The Tee/Wye junction type requires three connecting pipes.
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Loss Model

There are two Loss Models available for Tee/Wye junctions: Simple and Detailed. If you choose 
the Simple type of Tee/Wye, no loss factors will be calculated. This is equivalent to a Branch with 
no loss factors entered for the connecting pipes. In some systems the losses associated with a 
Tee/Wye are small compared to the overall loss in the system. To avoid unnecessary cal-
culations you should choose the Simple type of Tee/Wye unless you need the actual losses.

If the Detailed loss model is chosen, additional features will become available to define the 
arrangement of the pipes connected to the tee/wye, as well as information on the tee/wye geo-
metry. By default, Impulse will automatically define the straight and branch run pipes based off of 
the arrangement in the Workspace. If Impulse cannot determine an arrangement, the user will be 
required to define the pipe arrangement in the Tee/Wye Properties window. The arrangement 
defined in this window will affect the calculated loss factors.

The Detailed type of Tee/Wye will calculate the loss factors as they depend on the flow split as 
well as the geometry. Because of the dependence on the flow split, loss factors usually cannot 
be calculated before performing an analysis. AFT Impulse incorporates the best available mod-
els to calculate tee and wye loss factors during the actual solution. These calculations account 
for the developed flow pattern, requiring additional iteration. See Tee/Wye Loss Model and 
Tee/Wye Junction Complexity for an  in-depth discussion of Detailed Tees.

If you have specific loss factors that you want to use for a tee/wye junction, you should use a 
Branch junction instead and enter the appropriate K factors on the Optional tab.

The Tee/Wye junction functions the same during the steady-state and transient.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Tee/Wye Loss Model 448
Tee/Wye Waterhammer Theory 450
Tee/Wye Junction Complexity 795

Related Blogs

Having model convergence problems? Start here!

Give me some details about Detailed Tees!
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Tee/Wye Loss Model
The loss factors calculated for tee and wye junctions involve complicated correlations that 
depend on the flow split, the ratio of flow areas, and the angle of the connecting pipes. The mod-
els used by AFT Impulse are taken mostly from Chapter 7 of Idelchik's Handbook of Hydraulic 
Resistance, 2007. The equations will not be shown in this topic, but the references are given in 
the table below.    

All tees and wyes have either diverging or converging flow streams. Two sets of equations are 
required for each configuration.

In the following discussion, the parameter Kc,s represents the loss factor based on the combined 
flow, stream flow area, and velocity for the side branch. Similarly, Kc,st is for the straight-through 
pipe (the run). 

Figure 1 depicts the nomenclature. K factor subscripts refer to base area reference and location 
in the Tee. For example, Kc,s represents the K factor for the side branch (s) referenced to the 
combined (c) pipe flow area.

Figure 1: Idelchik’s nomenclature for diverging and converging flow through Tee/Wye junction

In the AFT Impulse Tee/Wye window, a simpler and more general nomenclature is used. AFT 
Impulse refers to the a, b and c pipes. This allows AFT Impulse to cover all the possibilities in 
Table 3 without specifying exactly which pipe is combined flow pipe. In some cases, you may not 
know all the flow directions in a system, and might not be able to specify which is the combined 
flow pipe. 

AFT Impulse's input method allows you to specify which pipe is the branch pipe. Idelchik calls 
this the "s" pipe for "side branch". AFT Impulse calls it the c pipe. If the tee angle is 90 degrees, it 
is not important which pipe you call the a pipe and which the b pipe. The distinction between a 
and b takes on more importance for non-90 degree pipes. In this case, AFT Impulse allows you 
to specify the angle of the branch pipe.

For tees/wyes the correlations used to calculate loss assume that the angle between the side 
branch and straight through flow pipes (labeled as As and Ast in Figure 2 above) can be at max-
imum 90 degrees. If the angle entered in the tee/wye junction exceeds 90 degrees between the 
side branch and straight through flow pipe, then the loss factor will be assumed to be equivalent 
to the loss with a 90 degree angle.

Figure 2 shows the Tee/Wye Properties window, with the Arrangement information at the bottom 
of the window.. The α angle itself is specified on the Tee/Wye Model tab, where there are other 
options for how to model the tee.
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Figure 2: Tee/Wye Properties window allows you to specify the a, b and c pipes. The c pipe is always 
the branch pipe. This general method means you do not need to know the flow direction ahead of 

time.
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Table 3: References for Tee/Wye junction correlations

Related Topics

K Factor Loss Model 282
Tee/Wye 446
Tee/Wye Waterhammer Theory 450
Tee/Wye Junction Complexity 795

Related Blogs

Give me some details about Detailed Tees!

Tee/Wye Waterhammer Theory
The Tee/Wye junction is a static element, and its solution method is essentially the same as the 
Branch junction. The only difference is that the loss factors are updated dynamically similar to 
steady flow if the Detailed model is in full use during the transient.

Generally it is not recommended to use the detailed loss model during the transient run for mul-
tiple reasons. One is that the complexity of iterations required for the detailed tee can increase 
the run time. The iterations can also easily become unstable, especially in cases where the dir-
ection of the flow is changing or oscillating at the tee/wye. Additionally, the detailed tee model 
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was not developed with the intention of calculating transient loss, so this model should be 
applied in the transient run with care.

In most cases, the loss at the tee is small enough that there will not be much difference between 
the simple and detailed models in the steady state, making it wise to just use the simple model. 
However, in some cases it may be required to use the detailed tee model. In that case, there are 
several options available on the Optional tab in the Transient K Factor section.

 l Calculated - This is the default option, which dynamically updates the loss factors 
throughout the transient.

 l Calculated but Limited - This option allows the K factor to be dynamically updated, but 
defines a Maximum K factor for the calculations, which may be useful in the case of large 
oscillations in the transient run

 l Keep Steady State Values - This option allows the loss to be calculated normally in the 
steady state, then behaves like a branch junction with static K factors during the transient. 
This may be a good assumption in the case of small changes at the tee junction.

Related Topics

Nomenclature 683
Method of Characteristics 701
Tee/Wye 446
Tee/Wye Loss Model 448
Tee/Wye Junction Complexity 795

Related Blogs

Give me some details about Detailed Tees!

Turbine
The Turbine Properties window follows the first of the two basic Properties window formats, dis-
playing the connecting pipes in a fixed format. A flow direction through the junction is adopted 
from the defined directions of the connecting pipes.

The AFT Impulse turbine junction is intended to model a hydroelectric turbine, in which hydraulic 
power is converted to shaft power, which drives an electric generator. There are many different 
hydro-turbine designs, but they are generally placed into one of two categories: 

 l Impulse-Type Turbine (e.g. Pelton Wheel)
 l Reaction-Type Turbine (e.g. Francis or Kaplan)

AFT Impulse models only the reaction-type turbine; specifically, the Francis turbine. 

The conventional method for modeling Francis turbine behavior employs four quadrant char-
acteristic data. Four quadrant data relates flow, head loss, torque, and speed in a format which is 
convenient for digital computers.  Similar four quadrant data is used to model pump behavior; 
however, the turbine does not generally involve reverse flow or reverse rotation. 
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Typical turbine head loss data will look something like Figure 1:

Figure 1: Typical turbine head loss data

Notice in Figure 1 that the turbine head loss data is represented by an array of curves, one for 
each wicket gate position. A similar array of curves is used to describe turbine net-torque (see 
Figure 2):

Figure 2: Turbine net-torque curve
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The user must specify how many wicket gate positions are to be modeled, and how many four 
quadrant angles are to be modeled. With these parameters given, complete FH and FB data can 
be entered in the Turbine Four Quadrant Data table, as seen in Figure 3.

Figure 3: Sample FH data entered in the Turbine Four Quadrant Data table

The turbine four quadrant data relies on having a complete set of rated turbine performance para-
meters. Examples of these parameters entered in the properties window are shown in Figure 4. 
The importance and use of these parameters can be seen in the Turbine Waterhammer Theory 
help topic.

Figure 4: Sample turbine rated conditions
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Turbine Transients

Generally speaking, there are three kinds of turbine transients which can be modeled in AFT 
Impulse. 

 l Turbine Trip - Gates Initially Open, Closing During Transient Simulation
 l Turbine Startup - Gates Initially Closed, Opening During Transient Simulation
 l No Transient - Reactive Only, No Transient Gate Behavior

Turbine Trip

The turbine trip assumes the generator torque drops out instantly, between steady state and the 
first time step of the transient solution. Generator torque is not specified. Instead, the initial 
speed and four quadrant torque data provide an initial torque imbalance The initial torque imbal-
ance is immediately resolved by an appropriate speed change (damped by inertia) when the tran-
sient simulation begins. 

Turbine Startup

The turbine initial conditions may be specified as zero speed and zero flow. When this is the 
case, the Steady State Special Condition, in the Optional tab, must be set to “Closed”. The tur-
bine will have zero flow in steady state, and will remain at zero flow until the gates are opened, 
according to the Transient Data, specified in the Transient tab. See Figure 5 for an example of 
this data entered in the Transient Data tab.

Figure 5: Sample input for a turbine startup

As the wicket gates open, flow and speed will increase accordingly. 
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No Transient

No transient data is required to simulate turbine behavior, as it reacts to circumstances. Specify 
only the parameters required in the Turbine Model tab. The turbine speed and flow will con-
tinuously adjust to changes in supply pressure and or discharge pressure.  Keep in mind; this is 
essentially the same as a turbine trip, but without commanding the gates to close. The turbine 
speed will immediately find equilibrium with the specified initial conditions. It can be seen in the 
torque data that there is a crossover point, where the torque ratio goes from positive to negative. 
If the initial specified conditions produce an initial Theta which lies in the region of this crossover 
point, the turbine will be initially stable. However, if the initial torque ratio, as determined by the 
initial speed and flow, is NOT in the region of the crossover point, the turbine will have to resolve 
the non-zero net-torque with a speed change, until equilibrium is established. This speed change 
will occur as soon as the transient simulation begins. 

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Turbine Waterhammer Theory 455

Turbine Waterhammer Theory
Four quadrant data is defined by the following dimensionless parameters (“R” subscript refers to 
rated values). Reference .

 l Head Loss Ratio:

(1)

 l Torque Ratio (unbalanced torque):

(2)
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 l Flow Ratio:

(3)

 l Speed Ratio:                     

(4)

 l Function Relating Head Loss to Flow and Speed:

(5)

 l Function Relating Torque to Flow and Speed:

(6)

 l Four Quadrant Data Angle:

(7)

 l Integer function for Fh and Fb indices:

(8)
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For the Speed change related to net torque, we start with Eq. 7 - 47 from Wylie (similar to Eq. 7 - 
20, without the negative sign)

(9)

(10)                         

(11)

(12)

(13)

(14)

(15)
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(16)

(17)

(18)

(19)

This is a modified version Eq 7-22 from Wylie. Wylie integrates over two time steps, to be con-
sistent with the “staggered grid” solution of the Method of Characteristics grid. The above result 
is based on integration over only one time step for use in the “complete grid”.

It’s convenient, at this point, to lump constants together and simplify.

(20)

(21)
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(22)

(23)

(24)

(25)

(26)

(27)

(28)

(29)

(30)

Eq. 30 is a modified version of Wylie's Eq. 7-26. Wylie uses Eq. 7-20 (for pumps) but Equation 30 
above uses Eq. 7-47 (for turbines).

Head loss can be described using a similar procedure, along with the characteristic equations.
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(31)

(32)

(33)

(34)

(35)

(36)

(37)

(38)

(39)

(40)
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(41)

(42)

(43)

(44)

Eq. 44 comes from Wylie Eq. 7-19. Wylie includes a valve loss term in Eq. 44, which is not 
included here. Also, signs are reversed to be consistent with turbine head loss, as opposed to 
pump head rise.

At this point, FH and FT can be solved using Newton Raphson, in 2x2 matrix form.

Related Topics

Nomenclature 683
Method of Characteristics 701
Turbine 451

Valve
The Valve junction type requires two connecting pipes, unless you specify it as an exit valve, in 
which case only one connecting pipe is allowed. This junction type allows you to model the irre-
coverable loss that occurs through a flow control component. The Valve Properties window fol-
lows the first of the two basic Properties window formats, displaying the connecting pipes in a 
fixed format. A flow direction through the junction is adopted from the defined directions of the 
connecting pipes. You also have the ability to change the loss with time to open or close the 
valve in full or in part.

Loss Source

In order to completely define a valve junction, you must specify the valve loss source by clicking 
on the appropriate radio button under Loss Source:

 l User Specified -  This is the best option if manufacturer data is known. Manually input the 
loss information using one of the Loss Models listed in the next section.
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 l From Characteristic - This option is useful if no information about the valve is known 
aside from the type, and an estimate needs to be made. Automatically calculate Cv based 
on the selection of a common valve geometry type and a Full Open Cv value. With the 
exception of the User Defined characteristic from the dropdown, the window will auto-
matically populate an Open Percent vs Cv data table by scaling the shape of the char-
acteristic curve to fit the provided Full Open Cv. Then, choose an Open Percentage under 
the Loss Parameters area to automatically calculate a Cv. The data for the characteristic 
shapes comes from Val-Matic 2009.

 l Handbook - Uses standard valve loss models from Idelchik, Miller, and Crane.

Loss Model

Depending on the selection of the Loss Source, various loss models will be displayed:

 l Flow Coefficient - Cv for English units or Kv for Metric units
 l K Factor
 l Resistance Curve

A special Reduced Port configuration is available when using the Handbook loss source, and 
requires the selection of a valve type and several geometric inputs. Once specified, a K Factor 
from the Handbook source will be calculated.

Exit Valves

Valves that are used as exit flow control mechanisms are specified as Exit Valves. These valves 
require an associated ambient pressure definition (also called a back pressure). Exit Valves can 
only be connected to a single upstream pipe. To specify an Exit Valve, select the Exit Valve 
checkbox, and input the required Exit Pressure.

Restricted Area & Optional Losses

The Restricted Area is optional input available for the User Specified and Handbook loss 
sources which describes the effective area restriction in the valve for the purpose of assessing 
cavitation. By default, Impulse will check for cavitation in pipes since an area is specified as part 
of the required pipe properties. Cavitation in a junction can only be checked if a Restricted Area 
is provided. In most cases, information on the size of the restricted area must be obtained from 
the manufacturer or test data.

The Basis Area is available for the K Factor, Resistance Curve, and Reduced Port loss models 
and describes the area from which loss factors are referenced from.
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Open Percentage Data

Optional data may be entered for special valve characteristics. Specifically, the Open Per-
centage vs Cv and Flow Area can be specified. This data does not affect the Solver’s flow solu-
tion; however, engineers frequently desire to know the valve’s open percentage during operation 
to ensure it meets design requirements. The Valve Summary in the Output window always dis-
plays the valve Cv, and if data is specified for open percentage and flow area it will also display 
open percentage and flow area at the operating point. A graph of the open percentage, Cv, and 
flow area data can be displayed by selecting the Characteristic Graph tab below the table.

The Characteristic Source parameters can be used to create an Open Percent vs Cv curve that 
follows the shape of several common valve types including Ball, Butterfly, Equal Percentage, 
Globe, Linear, Plug, and Quick Opening.

Transient Data

On the Transient tab, a transient Cv or K Factor vs time table can be entered to simulate the 
opening or closing of the valve.  If the optional open percentage table is entered, it can also be 
used to specify an open percent vs time transient. For a closed valve, the K Factor is infinite. To 
account for this, a K Factor of -1 (negative one) can be used in the transient data table. For more 
information on transient data, including event transients, see the Junction Transient Data topic.

Special Conditions

The Special Condition on the Optional tab allows the valve to be specified as Closed, which is 
useful to turn off a valve while retaining the input data for future use.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Kv and Cv Loss Model 283
Modeling Valve Closures using K Factors 464
Valve Waterhammer Theory 464

Related Blogs

That Valve’s Got Character – Applying Pre-defined Characteristic Curves
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A Clever Way to Mitigate Waterhammer During a Valve Closure

Modeling Valve Closures using K Factors
A closed valve would have an infinite K-factor. Since infinity is not a possible input, AFT Impulse 
uses the convention of K = -1 (negative one) to represent a closed valve. 

This input is only valid when defining a valve transient. To represent a valve that is closed in 
steady state, use the valve Special Conditions in the Optional tab. 

Related Topics

K Factor Loss Model 282
Valve 461
Valve Waterhammer Theory 464

Related Blogs

That Valve’s Got Character – Applying Pre-defined Characteristic Curves

A Clever Way to Mitigate Waterhammer During a Valve Closure

Valve Waterhammer Theory
A valve junction has a pressure loss across the valve. When the valve closes this loss becomes 
infinite (Wylie 1993, pp. 57). With two connecting pipes, the upstream and downstream pipe pres-
sures are obtained from Compatibility Equations 1 and 2:

From a mass balance:

The pressure drop is related to the flow rate according to the following:

where
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Rvalve = Valve Resistance

Substituting the compatibility equations (Equations 1, 2) in and eliminating the pressures

Rearranging terms,

Using the quadratic equation, the solution for positive flow through the valve is

For negative flow, the solution is

After solving for flow rate, ṁvalve, the upstream and downstream pressures can be obtained from 
the compatibility equations.    

If the valve closes then 1/Rvalve = 0 and ṁvalve=0.

Exit Valves

If the valve is an exit valve, then the downstream pressure is known and

Valve Vapor Cavitation Theory

When the calculated pressure at the upstream or downstream side of a valve junction drops 
below vapor pressure, a vapor cavity forms on that side of the junction.

Vapor cavities can form on either side of the valve or on both sides.
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As an example, when a vapor cavity forms downstream of a valve, the downstream pressure 
become fixed at the vapor pressure. The calculation then is similar to an exit valve, which also 
flows to a fixed pressure.

When a vapor cavity occurs on both sides of the valve, the pressure is at vapor pressure on both 
sides and thus there is no pressure drop across the valve. Accordingly, the flow rate goes to 
zero.

Similar to a pipe interior node, when the vapor volume is negative, the cavity collapses and the 
fluid pressure then rises above the vapor pressure.

Related Topics

Nomenclature 683
Method of Characteristics 701
Valve 461
Modeling Valve Closures using K Factors 464

Related Blogs

That Valve’s Got Character – Applying Pre-defined Characteristic Curves

A Clever Way to Mitigate Waterhammer During a Valve Closure

Venturi
The Venturi junction type requires two connecting pipes. This junction type allows you to model 
the irrecoverable loss that occurs through a venturi area change, which is frequently used in con-
junction with pressure taps in flow measurement devices. It also allows you to specify loss 
factors as a function of a flow parameter.

The Venturi Properties window follows the first of the two basic Properties Window formats, dis-
playing the connecting pipes in a fixed format. The Venturi junction does not have an explicit flow 
direction, but adopts a flow direction from the connecting pipes.
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Loss Models

AFT Impulse does not provide any standard venturi loss models. Venturi flow characteristics 
vary from vendor to vendor, so it is difficult to find generally applicable models. You must enter 
your own custom venturi loss factor that is consistent with the application. This information 
should be obtained from the manufacturer or from test data.

For convenience, you can specify constant loss characteristics of a venturi as a discharge coef-
ficient (Cd) or a loss factor (K).

If you would like to model the pressure loss through the Venturi as varying with the flow rate, 
select the radio button next to Resistance Curve under the Loss Model tab of the Venturi Prop-
erties window. Once Resistance Curve is selected, additional features appear that allow you to 
input pressure drops versus flow data. To enter this data, you can specify polynomial constants, 
fit a curve to available data, or use interpolated x-y data.

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
Resistance Curve Loss Model 284
Troubleshooting Resistance Curves 793

Volume Balance

Note: The Volume Balance junction must be used with great caution. It is only intended to 
model specific situations and when used incorrectly will give incorrect results. When 
modeling mixing fluids with varying fluid properties, the Output may show a Caution 
message about the density change. This does not necessarily mean that a Volume Bal-
ance should be used at the mentioned location.

The Volume Balance junction type is internal to the system and requires two connecting pipes.

The Volume Balance Properties window follows the first of the two basic Properties window 
formats, displaying the connecting pipes in a fixed format. The flow direction through the junction 
is determined by the defined directions of the connecting pipes.

The Volume Balance junction is useful for modeling pipelines with a moving interface between 
fluids of different density. Such a scenario is in reality a transient application, because the mass 
in the system is not steady with time.  Impulse is designed to balance mass at all branches, 
except for the Volume Balance junction. For the Volume Balance, the volume is balanced 
between the upstream and downstream pipes. This is consistent with the fact that an equal velo-
city exists at the interface, resulting in a volume balance at the interface. AFT Impulse assumes 
the interface does not move during the transient.
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Volume Balance junctions should be used in conjunction with the Variable Fluids feature and 
with variable density (see the Variable Fluids panel).

The usage of a Volume Balance junction is illustrated with the example below.  Figure 1 below 
provides a summary of the four snapshots in time that occur in the example. In reality, injecting 
slurry into a pipeline where there are two separate fluids with an interface between is a transient 
situation with a moving interface. In Impulse, this junction can be used to represent an interface 
which does not move rapidly in the transient. There is no option to define transient data for this 
junction.

Figure 1: Four snapshots in time and when to use the volume balance junction is shown for slurries 
and variable fluid properties systems

Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
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Note: The Weir junction must be used with great caution. A weir inherently is for open-chan-
nel flow. However, Impulse always assumes flow is in a pipe, and that the pipe is liquid 
full. The loss models for the Weir junction will give a good estimate of losses associated 
with a weir in a system, but does not truly model open-channel flow.

The Weir junction type requires one or two connecting pipes. The Weir Properties window fol-
lows the first of the two basic Properties window formats, displaying the connecting pipes in a 
fixed format. A flow direction through the junction is adopted from the defined directions of the 
connecting pipes.

Weir Types

There are three weir configurations available. The following input data is required for each.

 l Rectangular Sharp Crested - 
 l Surface Pressure
 l Notch Elevation (Zn)
 l Notch Width (L)
 l Channel Width (B)
 l Number of contractions
 l Cross-Sectional Area for Upstream and Downstream Area

Figure 1: Rectangular Sharp Crested Weir Model
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 l V-Notch Sharp Crested - 
 l Surface Pressure
 l Notch Elevation (Zn)
 l Notch Angle (theta)
 l Channel Width (B)
 l Cross-Sectional Area for Upstream and Downstream Area

Figure 2: V-Notch Sharp Crested Weir Model

 l Cipolletti, where the vertical angle is a 1:4 ratio - 
 l Surface Pressure
 l Notch Elevation (Zn)
 l Notch Width (L)
 l Channel Width (B)
 l Cross-Sectional Area for Upstream and Downstream Area
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Figure 3: Cipolletti (1:4 ratio) Weir Model

Notch elevation (Zn)

The absolute elevation of the bottom of the notch using the same reference frame as the pipe 
elevation.

Elevation of the Upstream and Downstream Areas (Zu and Zd)

The absolute elevation of the bottom of the the upstream (Zu) tank area and downstream (Zd) 
tank area using the same reference frame as the pipe elevation.

Number of Contractions

For a Rectangular Sharp Crested weir the notch area can be contracted from the sides of the 
weir. This can be from one side (1 contraction) or both (2 contractions). If the weir notch extends 
the full length of the channel then there are no contractions.

Upstream and Downstream Area Geometry

If the Cross-Sectional Area is specified as Constant, the weir area is assumed to be a vertical 
tank with constant cross-sectional area. If the cross-sectional area changes with height, this can 
be entered by selecting the variable option and entering the cross-sectional variation in the table.

The Tank Cross-Sectional Area is used for the purpose of determining the liquid volume. It will 
determine how high the liquid will rise or drop, since a given volume of liquid will flow into the weir 
during a time step.
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Related Topics

Junctions 267
General Junction Information 267
Junction Loss Models 281
Common Junction Input Parameters 271
Defining Junction Transients 287
Initiation of Transients 290
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Interface and User Options
This section focuses on the how the items within the various menus and tabs that comprise 
AFT Impulse can be used to customize the user's experience within the software. Topics dis-
cussed include the options present in each of the AFT Impulse drop-down menus, the tools avail-
able in the Primary Window tabs, and descriptions of the customizable parameters in the User 
Options menu. 

Contents

Menus and Toolbars 473

Printing 484

Primary Window Overview 486

Status Bar 487

Quick Access Panel 488

Model Status Light 499

Solution Progress Window 499

Waterhammer Assistant 500

Workspace Window 500

Model Data Window 524

Output Window 528

Graph Results Window 541

User Options Overview 562

Menus and Toolbars
Many of the actions required to set up an AFT Impulse model can be completed from the various 
menus located at the top of the window. Additionally, these menus can provide helpful features 
such as saving, importing and exporting files, and accessing various help documents such as 
the product help files and examples. These menus include
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 l The File menu
 l The Edit menu
 l The Analysis menu
 l The Tools menu
 l The Library menu
 l The Arrange menu
 l The Window menu
 l The Help menu

This topic also gives a high level overview of Toolbars, including the Main Toolbar as well as 
each Primary Windows toolbar.

File Menu
 l New - Opens new model.
 l Open - Calls Open file common dialog window so a pre-existing model can be selected 

for opening.
 l Save - Saves input model to disk using current model file name.
 l Save As - Opens Save As common dialog so you can specify a file name to save model 

to disk.
 l Save Graph As - (Graph Results Only) - Opens Save Graph As common dialog so user 

can specify a file name to save a graph as a graphics image file to disk.
 l Save Graph Data As - (Graph Results Only) - Opens Save Graph Data As common dia-

log so user can specify a file name to save graph x-y data to text file on disk.
 l Import Graph Data - (Graph Results Only) - Allows for data as .txt and .dat to be impor-

ted for creating graphs
 l Export Model Data - (Model Data Only) - Opens formatting window and Save As dialog 

where you can specify data from the Model Data window to be saved to a delimited file 
appropriate for spreadsheet use. Available in Model Data window.

 l Export Output - (Output Only) - Opens formatting window and Save As dialog where you 
can specify data from the Output window to be saved to a delimited file appropriate for 
spreadsheet use.

 l Export Force File - (Output Only) - Opens Export Force File window for the selected file 
type from those shown below.

 l CAESAR II Force File
 l TRIFLEX Force File
 l ROHR2 Force File

 l Import Excel Change Data - (Workspace and Model Data Only) - Imports data from 
Excel file which modifies certain input data.

 l Excel Export Manager - Opens the Excel Export Manager.
 l Merge - (Workspace Only) - Opens a Merge dialog where you can specify another model 

file to merge into the current model.
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 l Print Preview - Opens Print Preview which allows you to specify special formatting for 
printed graphics and text, as well as preview printed content before sending it to the 
printer.

 l Start Batch Run - The Start Batch Run button on the File Menu opens a Batch Run dia-
log where you can select a different scenarios or models and initiates a process whereby 
Impulse runs the multiple scenarios/models automatically. This tool can also be used to 
export output to Excel using the settings already configured in the Excel Export Manager.

 l Load Background Picture - (Workspace Only) - Loads a background picture into the 
Workspace. Formats supported include bitmap, windows metafile, enhanced metafile, 
JPEG, GIF and RLE. Available in Workspace window.

 l Import Piping Layout From
 l Piping Component File (PCF) - Import a Piping Component File
 l Caesar Neutral File (CII) - Import a Caesar Neutral File
 l GIS Shapefile (SHP) - Allows for Importing GIS Shapefile (geospatial maps) as 

.shp file.
 l EPANET File (INP) - Import an EPANET File

 l Export Piping Layout To
 l EPANET File (INP) - Export an EPANET File

 l Exit - Exits AFT Impulse.

Related Topics

Workspace Window 500
Model Data Window 524
Output Window 528
Graph Results Window 541
Menus and Toolbars 473

Edit Menu
 l Undo - (Workspace Only) - Undoes the previous workspace manipulation action. Impulse 

will keep track of a historical list of changes, and users can revert the workspace back to 
any of those previous states.

 l Redo - (Workspace Only) - Reverts the workspace following Undo actions. Impulse will 
keep track of undo actions, and users can redo any changes that have been undone.

 l Cut - (Workspace Only) - Cuts the selected pipes and junctions on the Workspace and 
places them on the clipboard.

 l Copy - (Workspace, Model Data, and Graph Results Only) - Copies the selected window 
contents to the clipboard.

 l Copy Graphics - (Workspace Only) - Copies selected Workspace content to the Win-
dows clipboard. Formats supported include bitmap, windows metafile, and enhanced 
metafile.
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 l Copy X-Y Data - (Graph Results Only) - Copies numerical data from graph to the Win-
dows clipboard. Available in the Graph Results window.

 l Paste - (Workspace Only) - Pastes clipboard pipes and junction contents (from previous 
cut or copy operation) into the Workspace model. Paste preview mode allows the pasted 
pipes and junctions to be moved and specifically placed where desired and will indicate 
interference with other junction by changing color. A green box indicates that there is no 
interference and a red box indicates that the junctions will be overlapping and are not in a 
proper location. Available in the Workspace window.

 l Delete - (Workspace Only) - Deletes the selected pipes and junctions on the Workspace.
 l Duplicate - (Workspace Only) - Duplicates the selected pipes and junctions on the Work-

space.
 l Duplicate Special - (Workspace Only) - Opens Duplicate Special dialog window where 

you can specify the increment by which all pipes and junction numbers will be increased 
when the model is duplicated, the creation of a new group from the duplicated objects, 
and whether to hide the duplicated objects in the output.

 l Select All - (Workspace Only) - Selects all pipes and junctions on the Workspace.
 l Select Last Selection - (Workspace Only) - The most recent pipes and/or junctions 

selected may be reselected by selecting Select Last Selection from the Edit menu.
 l Select Special - (Workspace Only) - Opens Select Special window where group of pipes 

and junctions can be built up.
 l Select Flow Path - (Workspace Only) - Selects the sequence of pipes and/or junctions in 

the flow path connected to the selected pipe(s) on the Workspace.
 l Select Shortest Path - (Workspace Only) - Selects the sequence of pipes and junctions 

that create the shortest path between any two junctions selected on the Workspace.
 l Customize Icon - (Workspace Only) - Allows user to change junction icon color, ori-

entation, and icon image.
 l Special Conditions - (Workspace Only) - Sets or clears Special Conditions for selected 

pipes and junctions on the Workspace.
 l Groups - (Workspace Only) - Allows you to create and manage groups of pipes and junc-

tions.
 l Renumber - (Workspace Only) - Allows renumbering pipes and junctions on the Work-

space using one of the Renumbering methods.
 l Join Selected Pipes/Junctions - (Workspace Only) - A continuous series of connected 

pipes and junctions can be combined into a single pipe object to simplify the Workspace. 
See Joining and Splitting Pipes.

 l Split Pipe at Intermediate Elevations - (Workspace Only) - A pipe with intermediate 
elevations can be split into separate pipes at the intermediate elevation points. See Join-
ing and Splitting Pipes.

 l Global Pipe Edit - (Workspace and Model Data Only) - Opens Global Pipe Edit window 
where editing of multiple pipes can be performed.

 l Global Junction Edit - (Workspace and Model Data Only) - Opens Global Junction Edit 
window where editing of multiple junctions can be performed.
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 l Transfer Results to Initial Guesses - Copies solution results into initial guesses for 
pipes and junctions.

 l Make Selection Same As Parent - (Workspace Only) - Replaces all input data for the 
selected pipes/junctions with data from the pipes/junctions in the current scenario's par-
ent.

 l Clear Initial Guesses - Clears all initial guesses in pipes and junctions.

Related Topics

Workspace Window 500
Model Data Window 524
Output Window 528
Graph Results Window 541
Menus and Toolbars 473

View Menu
 l Last View - (Workspace Only) - Switches to the most recent Workspace view. The view is 

changed by scrolling, zooming or using the Workspace Find. The Last View in the View 
Menu will take you back to the previous view of the Workspace. You can toggle between 
two views by continuously clicking Last View.

 l Select Objects - (Workspace Only) - Changes cursor to selection tool to select junctions, 
pipes, etc.

 l Overview Map - (Workspace Only) - Opens overview map in the Quick Access Panel.
 l Workspace Pan - (Workspace Only) - Changes cursor to pan tool to move around work-

space.
 l Show Object Status - (Workspace Only) - Toggles Show Object Status, which checks 

status of all pipes and junctions in model.
 l List Undefined Objects - (Workspace Only) - Opens Undefined Objects window which 

displays undefined pipes and junctions and their properties.
 l Extended Model Check - Performs and exhaustive check of model consistency and com-

pleteness.
 l Highlight in Pipe and Jct Windows - (Workspace Only) - Toggles Highlight feature for 

pipe and junction Properties Windows.
 l Bookmarks - (Workspace Only) - Allows creation and management of bookmarks.
 l Find - (Workspace Only) - Opens window whereby specific pipes and junctions can be 

found.

Related Topics

Workspace Window 500
Model Data Window 524
Output Window 528
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Graph Results Window 541
Menus and Toolbars 473

Analysis Menu
 l Time Simulation - Allows selection of either steady-state run or transient run.
 l Slurry Modeling - (SSL Module Only) - Allows selection of whether to use normal fluid 

calculation or settling slurry calculation in the current run.
 l Pulsation Frequency Analysis - (PFA Module Only) - Allows pulsation analysis settings 

to be ignored or used in the model.
 l System Properties - Opens the Fluid panel in Analysis Setup.
 l Pulsation Setup - (PFA Module Only) - Opens the Pulse Setup panel in Analysis Setup.
 l Section Pipes - Opens the Sectioning panel in Analysis Setup.
 l Transient Control - Opens the Simulation Mode/Duration panel in Analysis Setup.
 l Run Model - When the model is complete (as determined by the Analysis Setup window), 

the Run Model selection sends the model to the Solver for solution.

Related Topics

Workspace Window 500
Model Data Window 524
Output Window 528
Graph Results Window 541
Menus and Toolbars 473

Tools Menu
 l Scenario Manager - Opens the Scenario Manager window.
 l Last Scenario - Switches back to the previously loaded scenario.
 l Compare Scenarios - Quickly sets up a comparison between the current scenario and a 

related scenario.
 l Scenario Comparison Tool - Opens the Scenario Comparison Tool window, allowing 

users to compare differences between any two or more scenarios in a model.
 l Integration Query - Opens the Integration Query window, allowing users to have 

Impulse perform a numerical integration of results over specified time frames.
 l Output Control - Opens the Output Control window.
 l Output Print Content - (Output Only) - Configures what content can be printed from the 

Output window.
 l Output Language - Selects the display language for certain phrases in the Output win-

dow, Graph Results window, and the labels in Workspace Layers.
 l Model Data Control - (Model Data Only) - Opens the Model Data Control window.
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 l Model Data Print Content - (Model Data Only) - Configures what content can be printed 
from the Model Data window.

 l Select Graph Parameters - (Graph Results Only) - Opens window to allow user to select 
which parameters to graph.

 l Quick Graph Formatting - (Graph Results Only) - Opens window to allow user to 
change quick graph title and axis names, fonts, and scale values.

 l Design Alerts - Opens the Design Alerts window.
 l Multi-Condition Events - Opens the Event Manager window which allows users to make 

transients that are triggered by more than one parameter condition in the model.
 l Fluid Property Viewers - Gives options to open either the SteamCalc Viewer or 

Chempak Viewer. These are separate executables bundled with the software. Chempak 
Viewer requires a license.

 l Activate Modules - Opens the Modules panel in Analysis Setup where optional add-on 
modules can be activated or deactivated.

 l eLicense Information - Visible if AFT Impulse was opened using an eLicense - shows 
general information about the eLicense.

 l Keep Network eLicense Checked Out - If a network eLicense is used, it can be kept 
Checked Out to this machine. This will prevent it from being lost when going offline, and 
prevent it from being accessible by other users. The license will be good for the Checkout 
Period - generally one week  but depends on the specific company license.

 l Model Diagnostics - Opens the Model Diagnostics window which provides troubleshoot-
ing information.

 l Custom Units - Allows custom unit names to be enabled or disabled. Custom unit names 
can be defined in the User Options under the Unit System section.

 l User Options - Opens the User Options window.

Related Topics

Workspace Window 500
Model Data Window 524
Output Window 528
Graph Results Window 541
Menus and Toolbars 473

Library Menu
 l Add Junction to Library - (Workspace Only) - Prompts you to enter the name to be used 

in the Junction Library for the currently selected junction. After naming, adds junction to 
the library.

 l Edit Junctions - Opens Edit Junctions panel where you can delete or rename entries in 
the Component Library.

 l Edit Fluids - Opens Edit Fluids panel where you can add, delete, modify or review cus-
tom fluids.

- 479 -

https://docs.aft.com/steamcalc/Content/What_Does.html
https://docs.aft.com/chempakviewer3/Content/What_Chempak_Viewer_Does.html


Interface and User Options

 l Edit Pipe Materials - Opens Edit Pipe Materials panel where you can add, delete, modify 
or review custom pipe materials.

 l Edit Fittings & Losses - Opens Edit Pipe Fittings & Losses panel where you can add, 
delete, modify or review custom pipe fittings and losses.

 l Edit Solids - (SSL Module Only ) - Opens the Edit Solids panel where you can add, 
delete, modify or review solids properties for slurry modeling.

 l Library Manager - Opens the Library Manager window.

Related Topics

Workspace Window 500
Model Data Window 524
Output Window 528
Graph Results Window 541
Menus and Toolbars 473

Arrange Menu
 l Primary Windows - Allows you to configure the Primary windows in two panes in a hori-

zontal or vertical orientation. The primary windows can be further rearranged by dragging 
the tabs into the center of the screen and adjusted by moving the tab into the desired pos-
ition in the docking guide (see Figure 1).

Figure 1: The Docking Guide can be used to view multiple primary window tabs at the same time

 l Sort Table By -(Output Only) - Allows user to order tables in order of any variable and in 
ascending or descending order. Available in theOutput window.                     

 l Rotate Icon Right or Left - (Workspace Only) - Rotates icons for all selected junctions 
on the Workspace. Available in the Workspace window.      

 l Rotate Selection Right or Left - (Workspace Only) - Rotates selected pipes and junc-
tions as a group. Available in the Workspace window.                     
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 l Auto-rotate Icon - (Workspace Only) - Rotates selected junction to line up with the con-
nected pipes in the workspace. Available in the Workspace window.                     

 l Align - (Workspace Only) - Aligns selected pipes and/or junctions on the Workspace. 
You can choose to align pipes and junctions, just pipes, or just junctions horizontally or 
vertically on the workspace. Available in Workspace window.                     

 l Pipe Drawing Mode - (Workspace Only) - Select the type of grid layout that the model 
will use.                     

 l 2D Freeform - Junctions can be placed anywhere on the Workspace.
 l 2D Orthogonal - Toggles orthogonal drawing capability on the Workspace. This 

toggle is a shortcut to enabling the feature in User Options window. See Ortho-
gonal Drawing Overview for more information.

 l Isometric - Uses an isometric grid.                     
 l Snap to Grid - (Workspace Only) - Toggles Snap to Grid feature on the Workspace. 

When ON, all Workspace pipes, junctions and annotations snap to an grid specified in 
User Options window. Available in the Workspace window.                     

 l Show Grid - (Workspace Only) - Toggles Show Grid feature on the Workspace. Shows 
or hides grid that is specified inUser Options window. Available in the Workspace window. 

 l Make Selected Pipes and Jcts Orthogonal - (Workspace Only) - Makes all selected 
pipes and pipes connected to selected junctions on the Workspace orthogonal. Available 
in theWorkspace window.

 l Flip Vertex - (Workspace Only) - Available when orthogonal drawing is enabled. This will 
flip the vertex of all selected pipes on the Workspace. Available in theWorkspace window.

 l Scale/Flip Workspace - (Workspace Only) - Scales (shrinks or expands) or flips either 
selected or all pipes and junctions on the Workspace. Available in the Workspace 
window.

 l Set Pipe and Junction Locations to Parent - (Workspace Only) - Sets locations of pipe 
and junction labels to the same position as the parentscenario. Available in the Work-
space window.

 l Reset Label Locations - (Workspace Only) - Sets locations of pipe and junction labels to 
their default locations. Available in theWorkspace window.

 l Disable Pipes Snapping to Isometric Grid - (Workspace Only) - Toggles Snap to Grid 
feature on the Workspace for the selected pipe. When Snap to Grid is disabled for that 
pipe, the pipe end point no longer snaps to grid points and pipe segments do not follow 
the Isometric lines. Available in the Workspace window.

 l Add/Remove Segments - (Workspace Only) - Allows user to Add Segment (split single 
into two pipes), Add Segment at Right Angle, Add Multiple Segments, Remove Segment, 
or Remove all Segments. Available in the Workspace window.

 l Lock Object - (Workspace Only) - Locks selected pipes and junctions on the Workspace 
so they cannot be moved. A lock symbol appears next to locked pipes or junctions when 
an attempt is made to move the pipe or junction. Available in the Workspace window.

 l Reverse Direction - (Workspace Only) - Reverses the reference positive flow direction 
of all selected pipes on the Workspace. Available in the Workspace window.

Related Topics
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Workspace Window 500
Model Data Window 524
Output Window 528
Graph Results Window 541
Menus and Toolbars 473

Related Blogs

AFT Responds to 2020 Customer Survey Feedback

Window Menu
 l Workspace - Makes the Workspace window active.                     
 l Model Data - Makes the Model Data window active.                     
 l Output - Makes the Output window active.                     
 l Graph Results - Makes the Graph Results window active.                     

Related Topics

Workspace Window 500
Model Data Window 524
Output Window 528
Graph Results Window 541
Menus and Toolbars 473

Help Menu
 l Help File - Opens the help site home page                     
 l Use Offline Help - Indicates that the PDF help file will be used instead of the Online AFT 

Help site when the help buttons in interface windows are clicked. Note that the PDF help 
file must be downloaded from the PDF Downloads page on the online help site prior to 
using this option.      

 l Quick Start Guide - Opens quick start guide on aft.com in English or metric units 
 l Quick Start Video - Opens ~15 minute quick start video on aft.com in English or metric 

units
 l Waterhammer Assistant - Opens the Waterhammer Assistant window, which displays 

tips to increase the efficiency of the model
 l Keyboard Shortcuts - Opens keyboard shortcut help page in local help system
 l Show Examples - Opens help system with links to various example problems
 l Video Tutorials - Opens video tutorials on aft.com in English or metric units and English 

or Spanish language
 l Technical Seminars - Opens information on training courses on aft.com
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 l Flow Expert Package - Opens information on aft.com for individualized help from AFT 
engineers for training, modeling, consulting, and more

 l Online Learning Center - Opens learning center on AFT website with links to resources 
such as blogs, video tutorials, webinars, etc.

 l AFT Home Page - Opens home page on aft.com
 l AFT Blog - Opens blog home page on aft.com
 l Send Email to Support  - Links to AFT support in your default email program
 l Latest Release - Opens page on aft.com to download the newest AFT Impulse release
 l AFT Notifications - Opens page on aft.com where you can sign up for email notifications 

for new software updates and releases
 l About AFT Impulse - Opens window in AFT Impulse with information on current AFT 

Impulse version, license number, etc.

Related Topics

Workspace Window 500
Model Data Window 524
Output Window 528
Graph Results Window 541
Menus and Toolbars 473

Toolbars
The Toolbars offer quick access to the features used most frequently in AFT Impulse. There are 
actually several Toolbars in all. One is the Common Toolbar, and it is always shown. Its features 
are common to all five Primary windows. In addition, there is one Toolbar for each Primary win-
dow, offering features appropriate for work in that window. You only see two Toolbars at a time in 
AFT Impulse. The function of each icon in a given Toolbar appears when you pass the mouse 
over the icon button without clicking on the button.  Each of the functions on the Toolbar is also 
available through the menu system.

Figure 1: Common Toolbar

Figure 2: Workspace Toolbar

Figure 3: Model Data Toolbar

- 483 -



Interface and User Options

Figure 4: Output Toolbar

Figure 5: Graph Results Toolbar

Related Topics

Workspace Window 500
Model Data Window 524
Output Window 528
Graph Results Window 541
Menus and Toolbars 473

Printing

Printer Page Layout

The Printer Page Layout tool enables users to control how a model on the Workspace will be 
split across pages in the Print Preview window. To access this tool click the printer icon in the bot-
tom-right of the Workspace. The Printer Page Layout options should appear.
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Figure 1: The Printer Page Layout options control how the model is split between pages on the Print 
Preview

 l Show Page Boarders - When checked, a dotted yellow outline will appear around sec-
tions of the model. If the dotted yellow lines form a single box around the model, this 
means the entire model will fit on a single page. If the dotted yellow lines form multiple 
boxes, regardless of the size of the boxes, the model will be divided such that everything 
in a box will appear on its own page once the Print Preview is used.

 l User Defined Print Area - When checked, a purple box will be drawn around the entire 
model. Clicking on this box will cause sizing handles to appear. Using these sizing 
handles along with the "Show Page Boarders" enables users to customize more precisely 
what appears on each page. Additionally, a user can shift the model on the Workspace in 
order to place specific sections of the model on specific pages.

 l Paper Size - The paper size is a drop down with a selection of page dimensions based on 
the page sizes. The list of page sizes is determined by  whatever printer page sizes are 
supported by your printer. Selecting one of these sizes will affect the size of the paper the 
model will be printed on. As such, the size of the boxes formed by the dotted yellow lines 
from the "Show Page Boarders" will adjust in size.

 l Orientation - The portrait setting will flip the page such that the longest side from the 
paper size will align vertically on the page. The Landscape setting will flip the page such 
that the longest side from the paper size will align horizontally. As such the boxes created 
from the "Show Page Borders" option will follow suit.

 l Contents Scaling - This feature determines how large the model will appear on each 
page. As the slider moves, it will appear as though the boxes from the "Show Page 
Borders" are shrinking or growing. This does not affect the dimensions of the pages. 
Instead, when the Print Preview is used the page size will remain the same, but the 
objects in each box will fit to the pages as displayed on the Workspace.

- 485 -



Interface and User Options

Print Preview

The Print Preview window allows you to access special print features such as Print Preview and 
Fit to One Page. It is accessed from the File menu or using the shortcut CTRL + P.

The Print Preview window also offers you a preview of the print content and format for all Primary 
Windows. By clicking the Print Preview button you can review your printed material at several 
zoom states. Individual pages can be printed.

The "Fit To Page(s)" feature causes the graphic image generated from the Workspace window 
to be compressed onto the specified number of pages. This is a convenient feature for creating 
reports of your model. The Print Preview supports whatever printer page sizes are supported by 
your printer, so the use of legal paper or larger may allow you to get more visible details. The 
graphics can also be centered vertically and/or horizontally. You also can fit your content onto 
multiple pages.

The Page Setup option in the Print Preview window allows you to set the page orientation, paper 
size/type, and margins.

Additional special printing features affect the Workspace. The "Selected on Workspace" option 
works with Workspace printing by selectively printing the pipes and junctions currently selected 
on the Workspace.

By default, the junction icons on the Workspace will be printed with the same colors as displayed 
on the screen. It also prints the background color as specified in the User Options > Workspace 
> Colors and Fonts. You can also specify that the junction icons be printed in black and white 
(still with the color background) or that the entire printout be black and white.

If you added a background picture from the File menu, this picture will be included in the printout.

Finally, if you have a grid displayed on the Workspace, the grid will be included in the printout.

Page options allow the use of a company logo, user comments, titles, and different options for 
borders.

Related Topics

User Options Overview 562

Primary Window Overview
AFT Impulse has several Primary Windows that work in an integrated fashion. Each is located on 
a separate, moveable tab. You work exclusively from one of these windows at all times. For this 
reason, they are referred to as Primary Windows.

You can change between the Primary Windows by selecting them from the Window menu or by 
clicking the appropriate tab within the AFT Impulse window.

 l Workspace
The Workspace Primary Window is where the user creates the graphical representation 
of the system. Engineering data is input on pipe and junction property windows which are 
opened by double-clicking the objects.
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The Workspace Layers are also located on this Primary Window and allow the user to dis-
play both input and output data superimposed on the pipe system schematic.

 l Model Data
The Model Data Primary Window summarizes the engineering input data from the Work-
space into categorized tables. This allows for easy review of the system inputs, and 
double clicking cells will open the pipe or junction properties for quick editing.

 l Output
The Output Primary Window offers a powerful and diverse range of features for reviewing 
analysis results which are organized into categorized tables and lists. The Output allows 
the user to easily compare multiple design scenarios with color coded rows, details errors 
or design requirement violations, and prepare the results for documentation.

 l Graph Results
The Graph Results Primary Window allows the user to create a wide array of graphs with 
various parameters which are integral to gaining a deeper understanding of the pipe sys-
tem’s behavior. The user can adjust various formatting settings such as axis ranges, 
labels, colors, and create dual y-axis or stacked graphs. The settings can be saved into 
templates called Graph List Items so that the graphs can be easily reproduced.

Primary Win-
dow

Can Dis-
play Input

Can Dis-
play Out-

put

Workspace ✓ ✓

Model Data ✓  

Output  ✓

Graph Res-
ults  ✓

Related Topics

User Options Overview 562

Status Bar
AFT Impulse's Status Bar displays contextual information about the current scenario or oper-
ation.
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Figure 1: Current scenario displayed in the Status Bar

The Status Bar indicates the status of certain operations - for example, when opening a model 
the progress of loading the pipes, junctions, and scenarios is displayed.

Figure 2: Status Bar displaying progress when opening a model

Related Topics

User Options Overview 562

Quick Access Panel
The Quick Access Panel, as shown in Figure 1, contains several useful features:

 l Scenario Manager - Configure the scenarios and variations of the model
 l Properties tab - Review pipe/junction inputs or output, and edit annotations
 l Workspace Layers - Superimpose input and output parameters on top of the Workspace 

model
 l Overview Map - Easily navigate large models
 l Activate Add-on Modules - Shortcut to the Add-on Modules group in the Analysis Setup
 l Model Status Light - Green/red light indicating if all required input is present and if the 

Solver is ready to run
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Figure 1: The Quick Access Panel

Scenario Manager

By clicking on the Scenario tab in Figure 2 below, you have the full scenario customization ability 
as you would with the Scenario Manager. You can create child scenarios, expand or collapse 
various families of scenarios, and use the many other Scenario Manager features here as well.
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Figure 2: The Scenario Manager

Properties Tab

As seen in Figure 1 or 2, there is a "Properties" tab in the Quick Access Panel.  When pipes and 
junctions are drawn on the Workspace, you can quickly view the Pipe or Junction Properties by 
first selecting a pipe or junction on the Workspace, then clicking on the "Properties" tab. The 
tab's name will dynamically update depending on which pipe/junction is selected. This will dis-
play the Object Property data as well as any Output data if the model has been run.  Figure 3 
below shows an example of what the Properties tab would look like when clicking on a pipe on 
the Workspace after it has been defined and output was created.
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Figure 3: Viewing the Pipe/Junction Properties and Output Data from the Quick Access Panel

Annotations can be edited by selecting an annotation on the Workspace which will bring up their 
properties in this tab where they can then be edited.
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Figure 4: Annotation view for the Properties in the Quick Access Panel

Workspace Layers Tab

The Workspace Layers tab contains settings relating to object visibility, labels, superimposing 
input/output data, and color maps.

Figure 5: View of the Workspace Layers panel structure
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Overview Map

When a model is very large in size, it can be troublesome to have to constantly drag the model 
around on the Workspace to get to a specific area of the model you want to view.  By clicking on 
the Workspace Overview Map button in the red box in Figure 6, you will bring up a map that is a 
bird's eye view of the model.  Drag the small square in the Workspace Overview Map over vari-
ous parts of the model, then zoom in and out of the model.  You can also click the "Fit" button to 
see the full model zoomed out on the Workspace. You can also zoom in and out using the mouse 
wheel.
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Figure 6: Workspace Overview Map

Activate Add-on Modules

Clicking the Modules button in the bottom right of the Quick Access Panel in Figure 7 launches 
Analysis Setup to the Modules panel to activate or deactivate add-on modules.
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Figure 7: Activating the Modules from the Quick Access Panel

Model Status Light

The Model Status Light is located in the bottom-right of the Quick Access Panel (Figure 8). Click-
ing the Status Light will open Analysis Setup. When each item in Analysis Setup is fully defined, 
it will have a green check mark.  When all necessary items in Analysis Setup are completed, the 
Status Light will turn from red to green, indicating that the model can be run.
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Figure 8: The Model Status Light is located at the bottom-right of the Quick Access Panel

Minimizing the Quick Access Panel

By default, AFT Impulse opens with the Quick Access Panel automatically expanded.  The Quick 
Access Panel can be easily collapsed and pinned to the side of the Workspace to allow for a lar-
ger usage area of the Workspace.  Figure 9 shows the AFT Impulse window with the Quick 
Access Panel initially expanded.  By clicking on the thumbtack pin button (highlighted below with 
the red box), the Quick Access Panel will then become collapsed as shown in Figure 10.  After 
the Quick Access Panel is collapsed, it can be temporarily expanded again simply by hovering 
over the "Scenario" sidebar with the mouse.
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Figure 9: The Workspace with the Quick Access Panel expanded
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Figure 10: The Workspace with the Quick Access Panel collapsed

Related Topics

User Options Overview 562

Model Status Light
The light at the right of the Status Bar located at the bottom of the AFT Impulse window, which 
indicates whether or not the model can be run.

Clicking on the Model Status Light will show the Analysis Setup window.

Related Topics

User Options Overview 562

Solution Progress Window
Solution Progress indicates the current state of the steady-state solution iterations and the tran-
sient simulation.

The most out of tolerance junction or pipe is listed for the appropriate tolerances, along with gen-
eral information about the solution method and related settings.

Note: Both absolute and relative criteria are always displayed. This can be helpful for select-
ing the appropriate tolerance criteria on difficult to converge models.

The Solution Progress Bar shows how far the transient simulation has progressed.
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The area in the bottom of the window will give important feedback on the model solution. It is 
important not to dismiss messages in this area, as they could have an impact on results.

When the simulation is complete, options to view the Output, Graph Results, or Workspace 
become available.

Other Actions - Pausing the simulation allows for modification of certain Steady Solution Con-
trol parameters during the run, as well as viewing the iteration history if it was enabled via the 
Keep Track of Iteration History setting on the Iterations panel.

Retain Partial Transient Output - Canceling the run allows for output data to be kept up to the 
point at which the run was canceled. The Output File will be finalized and the partial output can 
be viewed. A caution will be shown in the Output stating the last valid time step. This can be used 
in combination with Transient Checkpoint Files to continue the run later.

Related Topics

User Options Overview 562
Iterations Panel 204
Review the Iteration History 797

Waterhammer Assistant
AFT Impulse checks the model with the Waterhammer Assistant before a transient simulation to 
see if it has any advice. If it does, the Waterhammer Assistant is displayed. The user then has 
the option of canceling the run to take the suggested actions or ignoring the advice and con-
tinuing. If you do not want the Waterhammer Assistant to be consulted before each run, you can 
specify this choice in the User Options window on the Tools menu. The Waterhammer Assistant 
can also be opened from the Help menu.             

An example of something the Waterhammer Assistant will check for is if there are any pipes that 
could be combined to reduce runtimes using the Combine Pipes tool.             

Related Topics

Pipe Sectioning and Output Group 184
Transient Control Group 191
Junction Transient Data 287
Infinite Pipe 289
Initiation of Transients 290
Multi-Condition Events 295
User Options Overview 562

Workspace Window
The Workspace window is the sole area where you specify the model layout and connectivity. 
The Workspace window has two separate functional areas: the Toolbox on the far left and the 
Workspace itself encompassing the rest of the screen (see Figure 1). 
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Figure 1: The Workspace window

Display and Printing Features

The Workspace image can be:

 l Copied to the clipboard
 l Saved to a picture file
 l Saved directly to an Adobe PDF file
 l Sent to the printer

The Print Preview window allows the above outputs to be applied to all or certain selected Work-
space objects.

Related Topics

User Options Overview 562
Menus and Toolbars 473
Workspace Layers 502
Merging Models 511
Renumbering Workspace Objects 512
Scale/Flip Workspace 513
Magnifier Tool 513
Annotations 514
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Extended Model Check 519
Keyboard Shortcuts for Workspace 519
Undefined Objects Window 522
Raw Data Changes 523
Duplicate Special 524

Workspace Layers
Fundamentally, Workspace Layers are used to control the visibility of Workspace objects and 
labels.  Layers allow custom views to be created in which results can be displayed without need-
ing to leave the Workspace window.  A group of layers functions like a stack of transparencies, 
with each layer displaying specific, customizable information.  The view on the Workspace is a 
composite of the information presented by all visible layers, but all objects exist regardless of vis-
ibility for the purposes of calculations and object connections.

Figure 1: Information from all currently visible layers combines to form the view displayed on the 
Workspace

Layers can be shown or hidden to create different views of the Workspace.  The visibility of 
objects on the Workspace depends on the layers that are shown, as objects on hidden layers are 
not shown on the Workspace unless present on another layer. If an object exists on multiple lay-
ers, only the top-most representation is visible. The order of the layers is controlled by the order 
in which they are listed in the Workspace Layers panel.

Workspace Layers Panel

The Workspace Layers panel is accessed via the Workspace Layers tab in the Quick Access 
Panel. There are two areas within the Workspace Layers panel to control Layer Presets and Lay-
ers.

- 502 -



Interface and User Options

In the Layers area, new layers can be created, and any selected layers can be renamed, duplic-
ated, and toggled in visibility. The Global Layers Settings menu is accessed here, and the 
column of visibility icons on the right shows the current visibility of each layer and can be clicked 
to toggle visibility. Hovering over a layer, a gear icon appears that links to the layer’s Layer Set-
tings options for customization.

Figure 2: View of the Workspace Layers panel structure

Standard layers control pipe and junction styles, labels, and visibility, along with the visibility of 
any annotations in the model. Among the standard layers is the All Objects Layer. The All 
Objects Layer exists in all models and contains all pipes, junctions, and annotations in the 
model. This serves as the primary layer, provides a central location for users to quickly see all 
objects in the model, and is always the bottommost layer.  When creating a view where some 
objects are hidden, the All Objects Layer can be toggled in visibility so that only objects visible in 
other layers are shown on the Workspace.
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Other standard layers can be reordered up or down the layer stack using the areas at the top of 
the Layers area. For pipe and junction labels, the order of displayed text items is affected by the 
order of the layers containing label text.

Standard layers can be created from the New Layer drop-down as a Blank Layer or From Work-
space Selections. Layers created from Workspace selections have the selected objects and 
their labels visible in the new layer.

By default, new objects are visible only on the All Objects Layer.  However, if layers are set as Act-
ive Layers, then any new objects that are created and their labels will be visible within all Active 
Layers. Active Layers are set by hovering over a layer and clicking the pencil icon and any cur-
rently Active Layers are denoted by the pencil icon.

Layer Presets

Layer Presets allow customized Workspace views to be retained by saving the status (visibility) 
of each layer. There are four columns in the Layer Preset area. One shows the name of the pre-
set, the Load Preset option allows the previously saved layer states to be loaded onto the Work-
space, the Update Preset option saves the current layer states to that Layer Preset, and the Link 
Preset option links that preset to the currently active scenario.

By linking a preset to a scenario, it will automatically load whenever that scenario is loaded in the 
future. Individual layers, by contrast, are not tied to a specific scenario and are defined globally 
and immediately available in all scenarios. A layer can only show objects that exist in the active 
scenario, and changes to the style of an object in a layer will affect all scenarios.

Global Layer Settings

Figure 3: Global Layer Settings window

The Global Layer Settings are accessed from the double gear icon on the Layers Toolbar in the 
Quick Access Panel. The properties that are controlled by Global Layer Settings are not defined 
for individual layers – changes to these settings affect all layers globally.
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Text and Graphics Options allow the analysis title, input filename, scenario name, and units in 
the legend to be toggled.

Note: The analysis title is set in the general tab of Output Control.

The Fonts setting controls the fonts for Data/Text (e.g. labels), the Title text (the analysis title, 
input filename, and scenario title if visible) and the text in the legend.

The Numerical Formats option determines the minimum number of digits shown for input and out-
put data displayed within label text.

Layer Settings - Pipes & Junctions

The Layer Settings window can be accessed by double-clicking the layer, from the single gear 
icon on the right of each layer, or by selecting the layer and clicking the single gear icon on the 
Layers Toolbar.

The layout of the Layer Settings window is similar to Analysis Setup, with a number of groups lis-
ted on the left side of the window. Each group contains items that when selected change the con-
tent of the main panel area on the right.

Figure 4: The Show/Hide & Style panel allows the appearance and visibility of pipes and junctions to 
be managed

The Pipes & Junctions group of the Layer Settings window allows the pipe and junction color and 
size/thickness to be defined for a given layer, along with which pipes and junctions are visible. 
Note that changes to this panel are made live in real time, and no Apply button is needed to apply 
the changes that you make. Pipes and junctions are shown in two separate lists, which can be 
filtered.
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Multiple pipes or junctions can be edited at a time using the Color, Size, and Thickness modifiers 
at the top of each table, or set to default options with the Defaults buttons towards the bottom. 
The usual tools for selecting pipes and junctions, including Workspace select and Select 
Special, are available here. Pipes and junctions may also be edited individually with the visibility, 
color, and size options in each row.

The appearance of new pipes and junctions is layer specific, and can be set to default options 
with the top Defaults button or modified with the New Pipe Color, New Pipe Thickness, and New 
Junction Size options. Note that color and icon style for new junctions are set via the Toolbox as 
they are specific to each type of junction.

List Pipes & Junctions from All Scenarios is toggled off by default to reduce unintended changes 
to items in other scenarios, but this can be toggled on to include objects from all scenarios in the 
lists.

Layer Settings - Label Control

A label is text that is associated with a pipe or junction on the Workspace. Labels include both 
input and output parameters along with object names, numbers, and workspace symbols. While 
there is no separate output mode, output parameters are only displayed when the current scen-
ario has output data available. If no output is present, the parameter in the list to the right will 
appear grayed out. Input parameters will always be shown when added to the list on the right. 
The label shown for an object on the Workspace is a combination of defined label items from 
each visible layer, and the order of the items is determined by both the layer order and the order 
that parameters are listed within each layer.

Figure 5: The Junction Parameters panel within the Label Control group of Layer Settings
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Within the Label Control group, the Pipe Parameters and Junction Parameters items allow for 
the parameters associated with a layer to be customized. When there is no output available, out-
put parameters will be grayed out within the list, but their list position and units may still be 
edited.

Label locations are defined globally, so the Reset Label Locations option will apply to all labels in 
all layers and all scenarios.

Figure 6: The Show/Hide Labels panel determines which objects will have visible labels for a given 
layer

The Show/Hide Labels panel can be used to toggle the visibility of labels for each pipe and junc-
tion within a layer. This allows a user to create a layer that shows only the relevant parameters 
for the relevant objects in the model. Visibility can be modified for one or several objects at a time 
via the same methods as pipe and junction visibility.

The Force Shown Labels to Match Shown Objects option forces the visibility of each label to 
match its object visibility as defined in the Pipes & Junctions group of the Layer Settings. The 
Defaults options at the bottom of the tables simply toggle this option on if it had been previously 
unselected.
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Layer Settings - Annotations

Figure 7: The Show/Hide Annotations panel shows all annotations that exist in the model file and 
allows their visibility to be controlled on a per-layer basis

The Show/Hide Annotations panel allows the visibility of annotations to be defined for the current 
layer and displays the visibility of each annotation in the current layer. While annotations exist 
globally, in concert with Layer Presets this menu allows annotations to be controlled so that they 
are only visible in the relevant scenarios. Annotations can be edited from this list view by double-
clicking them in the list to open the annotation in the Annotation Editor.

Color Maps and Animations

A Color Map layer allows you to visualize magnitudes of various parameters by coloring the 
pipes. Color Maps are a special layer type, and are shown in a separate group on the Layers 
panel. There can be only one special layer visible at a time, and they override the behavior of 
standard layers in the model - in this case superseding any colors assigned to pipes by other lay-
ers.

Example use cases for Color Maps includes visualizing hot/cold loops, locations of high velo-
city/reverse flows, or pipe diameters/lengths.

To create a Color Map layer, click the new layer icon on the Layers Toolbar, select a Color Map 
layer type, and name the new layer. To edit the layer, go to its Layer Settings menu, accessed in 
the same manner as a standard layer.
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Figure 8: Layer Settings window for a Color Map

In the Color Map Layer Settings window, choose a parameter and units for which all pipes will be 
categorized. Then choose the Number of Conditions (number of colors) and click Generate. The 
operators (i.e. >, >=, =, <=, <) and values can be modified. Values may be categorized on an 
absolute value basis by selecting the Use Absolute Value checkbox. The Show Value on Work-
space Label option shows the evaluated parameter next to each visible pipe in the model, and 
combines with any other label text items from other layers.

The order of entry is not important. Impulse will sort the entries first by value and then by the oper-
ator, with the greater than (>) operator being above the less than (<) operator. The pipes will be 
colored using the first match found in the map, starting from the top of the map. If no match is 
found, the pipe will be the Workspace pipe color. Be careful to avoid overlapping operators and 
values. If, for example, the map defined four colors using the following inequalities,

 l >=60
 l <60
 l >=20
 l <20

then there is no way colors 3 and 4 will be used because any pipe less than 20 is also less than 
60. Since <60 is before <20 in the map, the pipe will be colored using color 2. 

To avoid overlapping colors, only use less than (<) as the last entry. A better map would be the 
following:

 l >=60
 l >=20
 l <20

To delete a map value, select the row from the Color Map Grid and  click the Remove Row but-
ton. Instead of coloring the pipes, it is possible to color just the pipe numbers. This is done by 
choosing the Color Pipe Labels radio button in the Color Options area. Alternatively, the Color 
Pipes and Labels radio button allows both to be colored.
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Color choices from the Color Map Grid will appear in a legend without units shown by default. 
The legend may be repositioned by dragging it to any location on the Workspace. Units may be 
displayed in the legend using the Show Units in Legend setting within Global Layer Settings.

If there is no output for the current scenario, any Color Map layer that displays an output para-
meter will have a red exclamation mark next to it on the Layers panel to warn the user that there 
is no output. The model must run before such Color Map layers can be displayed.

Color Maps can be animated for transient data using Animation Layers. The interface for anim-
ating a color map layer is shown in Figure 9.

Figure 9: Layer Settings window for an animated color map layer

Workspace Layers Import Assistant

The Workspace Layers Import Assistant can be used when importing a model from Impulse 9 or 
earlier. By default, when opening a model from these previous versions, layers are created as 
applicable for object numbers, workspace symbols, and object names. This is done regardless 
of whether or not the  Workspace Layers Import Assistant is run.

The purpose of the Workspace Layers Import Assistant is to import visual styles of pipes and 
junctions and to import labels from the deprecated Visual Report Window as Workspace Layers 
so that previous Visual Reports can be recreated. This is a step by step guided procedure that 
will attempt to bring these elements into Workspace Layers while creating as few new layers as 
possible. These layers are created on a per-scenario basis.

If a model has a high number of scenarios with similar Visual Reports, it may be preferable to 
recreate the Visual Report manually as a new layer that can be used with any scenario. If the 
chosen scenarios for the Import Assistant share many of the same visual settings, the Import 
Assistant will create all relevant layers for each, even if those layers are identical to each other.

The  Workspace Layers Import Assistant will allow you to select which scenarios to use to create 
the new layers. Once these are selected, the next page of the Import Assistant will allow you to 
see how many layers and Layer Presets will be generated. Once satisfied with the proposed 
Workspace Layers and Layer Presets, click Import Layers to complete the import process.

Related Topics
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Workspace Window 500
Merging Models 511
Renumbering Workspace Objects 512
Scale/Flip Workspace 513
Magnifier Tool 513
Annotations 514
Extended Model Check 519
Keyboard Shortcuts for Workspace 519
Undefined Objects Window 522
Raw Data Changes 523
Duplicate Special 524
Animation Layers 96

Merging Models
Two models can be merged together using the command on the File menu. Here's how:             

 l Open the first model                     
 l Choose Merge on the File menu
 l From the file list, select the model to be merged                     

If there are duplicate numbers, the objects in the second model will be changed. The second 
model will be selected (highlighted) so that you can move it into position (be careful not to click 
off the selected portions or the second model may be deselected).

Note that annotations, layers, and layer presets are not imported from the second model.

Tip: To move a selected group of objects, use a junction icon, instead of a pipe, to drag the 
group. This will avoid missing the pipe and clicking on an empty area of the Workspace 
which will deselect your group.

Merging Models with Multiple Scenarios

If the model you are merging from has multiple scenarios, only the base scenario can be 
merged. If you want to merge one of the children of that model, do the following:

 1. Open the model which you want to merge.
 2. Open the Scenario Manager.
 3. Select the child scenario you want to merge.
 4. On the Other Actions button, choose the Save Scenario to File Without Children.
 5. Enter a name and click OK. This process creates a new Impulse model with the desired 

scenario as the base scenario. 
 6. Open the original model and merge in the new model file created in Step 5.

Related Topics
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Workspace Window 500
Workspace Layers 502
Renumbering Workspace Objects 512
Scale/Flip Workspace 513
Magnifier Tool 513
Annotations 514
Extended Model Check 519
Keyboard Shortcuts for Workspace 519
Undefined Objects Window 522
Raw Data Changes 523
Duplicate Special 524

Renumbering Workspace Objects
Objects on the Workspace can be renumbered by choosing Renumber from the Edit menu. 
There are several ways that Renumbering can proceed.

Renumber Wizard

The Renumber Wizard allows you to renumber pipes and/or junctions by simply clicking on them 
on the Workspace. Normal Workspace functions are suspended when the Renumber Wizard is 
active. The Renumber Wizard is activated on the Edit menu. 

When the Renumber Wizard is active the settings can be modified in the Quick Access Panel. 
Click Done Renumbering in the Quick Access Panel to finish renumbering and exit the wizard.

Renumber Automatic

Selected pipes and/or junctions can be renumbered starting at the lowest selected number or at 
a specified number. If a pipe or junction which is not selected to be renumbered already has the 
next number in sequence, it will only be changed if the Force Sequential checkbox is checked.

Impulse will start at the beginning of the flow path containing the lowest numbered selected pipe 
and will attempt to march down the pipes in the direction of flow. It is recommended that renum-
bering be performed after the model has been completed so that the junctions and pipes are 
completely connected.

Tip: If you want certain sections of the model to be numbered in sequence, then use the 
Renumber feature on the selected sections only. It is also preferable in the case of large 
or complicated models to renumber small sections at a time.

Renumber Increment

Renumber Increment is on the Edit menu and allows you to increment or decrement all selected 
pipes and junctions by a specified value.
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Related Topics

Workspace Window 500
Workspace Layers 502
Merging Models 511
Scale/Flip Workspace 513
Magnifier Tool 513
Annotations 514
Extended Model Check 519
Keyboard Shortcuts for Workspace 519
Undefined Objects Window 522
Raw Data Changes 523
Duplicate Special 524

Scale/Flip Workspace
The Workspace can be scaled horizontally and/or vertically by choosing Scale/Flip Workspace 
on the Arrange menu. Scaling will move the junctions and will stretch or shrink the pipes so that 
the area the model covers is changed by the percentage specified.

Flipping the Workspace horizontally and/or vertically will move the pipes and junctions to their 
mirror image locations. This is useful when you are building a system which has symmetrical or 
mirrored sections. For example, you could select the section, duplicate it, and then flip it hori-
zontally, vertically, or both with Scale/Flip Selected Objects Only checked.

Related Topics

Workspace Window 500
Workspace Layers 502
Merging Models 511
Renumbering Workspace Objects 512
Magnifier Tool 513
Annotations 514
Extended Model Check 519
Keyboard Shortcuts for Workspace 519
Undefined Objects Window 522
Raw Data Changes 523
Duplicate Special 524

Magnifier Tool
The Magnifier tool can be used to provide a magnified view of any area on the Workspace. This 
is useful for navigating and viewing details of a large model without needing to zoom in on that 
area. The Magnifier tool can be accessed from the Workspace Toolbar, as can be seen in Figure 
1 below. The magnifier tool can be enabled/disabled by clicking the button on the Toolbar.
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There are two options available to adjust the Magnifier view:

 l Zoom Level - Adjusts the level of magnification used
 l Magnifier Size - Adjusts the size of the magnifier circle

Figure 1: Magnifier tool on the Toolbar

Related Topics

Workspace Window 500
Workspace Layers 502
Merging Models 511
Renumbering Workspace Objects 512
Scale/Flip Workspace 513
Annotations 514
Extended Model Check 519
Keyboard Shortcuts for Workspace 519
Undefined Objects Window 522
Raw Data Changes 523
Duplicate Special 524

Annotations
Annotations are objects that can be placed on the Workspace to display customized text, 
express ideas via shapes or lines, or even to insert pictures into the Workspace. These are 
purely visual and do not affect results; their purpose is to communicate conceptual information 
about a system. They appear both in the Workspace and when printing from the Workspace.

New annotations are created using the Annotation Tool in the Toolbox. The Annotation Tool is 
located to the right of the Pipe Drawing Tool. With this tool, the user can draw a line or a shape 
on the Workspace. Shapes can display an image or text on the Workspace or can be used 
without text to display boundaries around various regions of the model.
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Figure 1: After clicking the Annotation Tool, select the shape for the new annotation
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Properties
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Figure 2: Annotation view for the Properties in the Quick Access Panel

After an annotation is placed on the Workspace, the properties of the annotation will be dis-
played in the Properties tab of the Quick Access Panel where they can be edited. For existing 
annotations, it can be accessed quickly by double-clicking on the annotation in the Workspace. 
Annotation styles can be set as default or restored to default settings using the Defaults drop-
down menu in the upper right of the Annotation properties area.

 l Annotations - The name of the annotation, its text content, text style, and text visibility 
can be edited within the Annotations section. The name of the annotation is not displayed 
on the Workspace but is shown within the Layers Settings where it can be used to com-
municate the purpose of an annotation.

 l Behavior - The Behavior section allows the behavior of the annotation to be customized. 
Annotations can be attached to the Workspace, a pipe, or a junction. When attached to 
the Workspace, the annotation always remains in the same location until you move it. 
When attached to a pipe or junction, the annotation will move when the pipe or junction is 
moved.

Note: Whether an annotation appears behind or in front of another object is usually determ-
ined by the order of the Workspace Layers in which they are visible, but the toggle Work-
space Keep in Back forces the annotation to appear below pipes and junctions 
regardless of layer order.

 l Format - The Format section controls the shape as well as the shape's style and visibility.
 l Image - The Image section allows an image to be displayed within the annotation and con-

trols its appearance.
 l Line - The Line section controls the appearance of lines and only applies when the shape 

is set to be a line in the Format section. Similarly, the shape color and border properties 
from the Format section are not used for lines.

Interaction with Scenarios and Layers

Annotations are not scenario-specific and exist globally within a model. Their visibility is asso-
ciated with layers and can be controlled for each layer in the Layer Settings. While annotations 
exist globally, their visibility for a given scenario can be controlled using Layer Presets.

Related Topics

Workspace Window 500
Workspace Layers 502
Merging Models 511
Renumbering Workspace Objects 512
Scale/Flip Workspace 513
Magnifier Tool 513
Extended Model Check 519
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Keyboard Shortcuts for Workspace 519
Undefined Objects Window 522
Raw Data Changes 523
Duplicate Special 524

Extended Model Check
The connections and settings of each pipe and junction are exhaustively checked using the 
Extended Model Check item on the View menu. This is also helpful if the model seems to not be 
connected correctly.             

Related Topics

Workspace Window 500
Workspace Layers 502
Merging Models 511
Renumbering Workspace Objects 512
Scale/Flip Workspace 513
Magnifier Tool 513
Annotations 514
Keyboard Shortcuts for Workspace 519
Undefined Objects Window 522
Raw Data Changes 523
Duplicate Special 524

Keyboard Shortcuts for Workspace

Selection Box

 l Select all objects completely inside box by dragging cursor from left to right
 l Select all object completely or partially inside box by dragging cursor from right to left

Pipe Drawing Tool 

 l If you double-click the pipe drawing tool, it will allow you to draw multiple pipes at a time. 
Clicking Esc or clicking the pipe drawing tool again will deactivate the tool.

 l When orthogonal drawing is off and you hold down the SHIFT key while drawing pipes on 
the Workspace, you can draw pipes that are perfectly horizontal or vertical. When the 
orthogonal drawing is on and you hold down the SHIFT key down while drawing new 
pipes on the Workspace the pipe vertex will flip. If you move an existing pipe and hold the 
shift key while selecting a handle at one of the pipe endpoints a new vertex will be inser-
ted at that point endpoint.
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 l If you hold down the CTRL key when completing the pipe drawing (just before releasing 
the mouse button), the Pipe Drawing Tool remains active, and you can draw a series of 
pipes without returning to the Toolbox each time.

 l To add pipe segments, use CTRL+SHIFT+Y 
 l To remove all pipe segments, use CTRL+SHIFT+N

Junctions

 l If you double-click any junction in the Toolbox, you will be able to place multiple of that 
junction on the Workspace by clicking the Workspace where you would like to place each 
junction. Clicking Esc or clicking the junction icon in the Toolbox again will deactivate the 
tool.

 l If you hold down CTRL key and select a junction from the Toolbox and drop it onto an 
existing Workspace junction, the old junction will "morph" into the new one. The junction 
type will change to the new junction type, and data that can be kept will be copied into the 
new junction.

 l If you hold down the CTRL key then drag a junction on the Workspace which has pipes 
connected to it, the junction will move but the pipes will not move with it

 l If you hold down the SHIFT key while selecting a junction from the Toolbox and then drop 
the junction onto an existing pipe, the pipe will split into two pipes. You will specify the 
length of the first pipe and the second pipe will be automatically set to the remaining 
length from the original pipe. Thus the sum of the two pipe lengths will equal the length of 
the original pipe. You can also choose which pipe contains any Fittings & Losses that 
were specified within the original pipe.

Figure 1: Split pipe keyboard shortcut
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Pipe and junction Properties window

 l When in a pipe or junction Properties Window you can toggle the highlight feature by 
pressing the F2 function key. You can also toggle this from the View menu.

 l When in a Pipe Properties Window, if you press the F5 function key, you will jump to the 
next highest numbered pipe. If you press the CTRL key while pressing the F5 function 
key, you will jump to the next lowest numbered pipe. The F5 function key also behaves 
this way for junction Properties Windows.

Pan and Zoom

 l The Workspace position can be moved with CTRL + arrow keys.
 l The Zoom level can be adjusted with CTRL + (+/-)
 l The Zoom level can be reset to default with CTRL + 0
 l Mouses with scroll wheels can be used to zoom by scrolling, or to pan by clicking and hold-

ing the scroll wheel

Switching Primary Windows

 l Go to the Workspace window using CTRL + W
 l Go to the Model Data window using CTRL + M
 l Go to the Output window using CTRL + U
 l Go to the Graph Results window using CTRL + G
 l Go to the Visual Report window using CTRL + I

Other

 l Open the Keyboard Shortcuts Help Page (this page!): CTRL + Q
 l Run the model: CTRL + R
 l Save the model: CTRL + S
 l Open a file: CTRL + O
 l Undo the last action: CTRL + Z
 l Cut: CTRL + X
 l Copy: CTRL + C
 l Paste: CTRL + V
 l Duplicate: CTRL + D
 l Delete selected pipes and junctions: DEL
 l Reverse pipe direction: F3
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 l Lock Object: CTRL + L
 l Toggle special condition of pipes/junctions between open and closed: F4
 l Show object status: CTRL + H
 l Other available shortcuts can be seen listed by their command on the menus

Related Topics

Toolbox 226
Creating Pipes - the Pipe Drawing Tool 228
Creating Junctions 233
Workspace Window 500
Workspace Layers 502
Merging Models 511
Renumbering Workspace Objects 512
Scale/Flip Workspace 513
Magnifier Tool 513
Annotations 514
Extended Model Check 519
Undefined Objects Window 522
Raw Data Changes 523
Duplicate Special 524

Undefined Objects Window
This window is launched from the View menu by selecting List Undefined Objects, or can be 
viewed in the Pipes and Junctions panel.    

This window displays all undefined pipes or junctions in the model. Clicking on the undefined 
object will display the undefined properties in the list below. All undefined data for all objects can 
be saved to the file or copied to the clipboard.    

Any undefined object's Properties window can be launched by double-clicking the object's name 
in the list to finish defining the object.    

Related Topics

Workspace Window 500
Workspace Layers 502
Merging Models 511
Renumbering Workspace Objects 512
Scale/Flip Workspace 513
Magnifier Tool 513
Annotations 514
Extended Model Check 519
Keyboard Shortcuts for Workspace 519
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Raw Data Changes 523
Duplicate Special 524

Raw Data Changes
When other objects in the model use the same base raw data as the current object and the data 
is changed, you can decide whether to use the new data on the other model objects.

This frequently happens when you have multiple junctions based on the same x-y data for pump 
curves or junctions resistance curves, and later change that x-y data. The question is whether 
you want to have the current junction you are working on updated, or all junctions that use that 
same base data.

Figure 1: Raw Data Change Options

Related Topics

Workspace Window 500
Workspace Layers 502
Merging Models 511
Renumbering Workspace Objects 512
Scale/Flip Workspace 513
Magnifier Tool 513
Annotations 514
Extended Model Check 519
Keyboard Shortcuts for Workspace 519
Undefined Objects Window 522
Duplicate Special 524
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Duplicate Special
Duplicate Special allows pieces of the model to be copy & pasted, while simultaneously applying 
other helpful settings as explained below.

 l Increment All Pipe and Junction Numbers By - Adds the specified number to all 
pipe/junction numbers for the created object duplicates. Useful for maintaining consistent 
numbering

 l Create Group - Adds the duplicates to a group.
 l Hide in Output - Automatically hides the pipe and junction duplicates in the Output win-

dow so only the original pipes and junctions will be seen.
 l Copy Layer Style Settings From Original Objects - Duplicates Workspace Layers 

style settings (visibility, thickness, color, label parameters, etc.) for selected objects.

Related Topics

Workspace Window 500
Workspace Layers 502
Merging Models 511
Renumbering Workspace Objects 512
Scale/Flip Workspace 513
Magnifier Tool 513
Annotations 514
Extended Model Check 519
Keyboard Shortcuts for Workspace 519
Undefined Objects Window 522
Raw Data Changes 523

Model Data Window
The Model Data window offers a text-based perspective on all engineering information in the 
pipe flow model. This window is useful for obtaining a global view of the model and rapidly check-
ing the input. 

The Model Data window does not offer any tools to build or add to a model; all model assembly 
must happen in the Workspace. 

The Model Data window allows you to manipulate existing elements from the Workspace. There-
fore, a complete model can be assembled in the Workspace window without ever opening the 
Model Data window. In fact, for small models this may be the preferred approach.

General, Pipe, and Junction section display sizes can be changed by the user by clicking and 
dragging the bars between each section to resize them. Each section can also be hidden by click-
ing the arrow in the upper left of each section.

You can use the zoom feature in the lower right hand corner of the Model Data window to resize 
the text displayed on screen.
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Figure 1: The Model Data window displays input in text form

Editing Features

The Pipe table allows display of all input data for all pipes in the model. Details of Fittings & 
Losses are displayed in the Pipe Loss Data table, accessed with an adjacent tab. The Pipe Loss 
Data table displays all fittings with K factors grouped into columns.

The other display tab in the pipe area is the Pipe Detail Summary, which assembles a list of 
details about each pipe in another format useful to some engineers.

The junction data area is below the pipe data area. Here the junction data is separated into 
tables for each junction type. Click the tabs to see the data for any type of junction. All transient 
data entered for the junctions can be seen in the Transient Data tab on the far right. 

To edit information in the Model Data window, you can open the Properties Window for the pipe 
or junction. This can be done by double-clicking anywhere in the row for the pipe or junction to be 
edited. Alternatively, you can use the Global Edit windows opened from the Edit menu. 

Display and Printing Features

Model Data Control lets you specify the combination of pipe, junction, and general information 
you want to see in the Model Data Window.
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The Model Data Print Content window lets you specify the content to include in the printed Model 
Data report and select the font to be used for printing. This window is opened from the Tools 
menu (or Toolbar).

The Model Data window contents can be:

 l Copied to the clipboard
 l Saved to a formatted text file
 l Exported to a delimited file suitable for direct importing into spreadsheet software
 l Saved directly to an Adobe PDF file
 l Sent to the printer

Related Topics

User Options Overview 562
Menus and Toolbars 473
Model Data Control Window 526

Related Blogs

Having model convergence problems? Start here!

Model Data Control Window
The Model Data Control allows you to customize what data to show for the pipes and for each 
junction type and also which pipes and junctions to show (see Figure 1). It can be opened from 
the Tools menu (or Toolbar).

Pipe Data Display

The data to be shown for the pipes is selected on the left side of the Model Data Control window. 
Only the items with check marks will be shown in the Model Data window. All pipes shown will 
report the selected items.

Junction Data Display

The data to be shown for the junctions is selected on the right side of the Model Data Control win-
dow. The data is grouped by junction type. However, some data is general and applied to each of 
the junction types. Select the junction type from the list and then select the data for that junction 
type. Each type also includes the general data which may be selected/deselected.  

You can select/deselect the general data for all junction types simultaneously by clicking Set 
Common.
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Figure 1: The Model Data Control window allows selection of the parameters to show in the Model 
Data window

Model Data Format

The Model Data Control format can be saved to a file so that the format can be quickly applied to 
other model files. There are multiple ways to do this. The Model Data Control format can be 
saved to the internal User library by clicking the Set As Default button, then choosing User 
Default in a new model file to apply the settings.

The Model Data format can also be saved to an external file, which can then be shared with dif-
ferent users. The external file can be generated by clicking the Save Control Format button at the 
bottom of the window. The format can then be applied to other model files by clicking the Load 
Control Format button.

Show Selected Pipes and Junctions

Specific pipes and junctions can be shown in Model Data. Click the Show Selected Pipes/Jct tab, 
then click the items in the lists to select the pipe(s) and junction(s) to be shown.
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Other Data

When pipes with intermediate elevations are specified, you can specify which pipe data is to be 
displayed in the Model Data window:

 l Show only pipes with intermediate elevations
 l Show only non-horizontal pipes
 l Show all pipes

In addition, you can specify whether junction curve data is to be displayed with the Model Data, 
whether to display Design Alerts, and whether to display Force Sets.

Scenario Format

A powerful Model Data feature when using scenarios is to show all direct ancestor data in the 
Model Data along with data from the current scenario. The Scenario Format features allow you 
to do this, and to highlight where data changes occur. Note that the scenario name is appended 
to the pipe and junction number in the left columns. This tab only appears when multiple scen-
arios exist.

Library Connections

In the lower left of the Model Data Control window there is a Library checkbox. If this box is 
checked, your Model Data Control parameters are setup as determined by the library to which 
you are connected. This is referred to as an active library. To make it inactive, uncheck the box 
or change one of the Model Data Control settings controlled by the library.

If the check box is unchecked, but enabled, you are connected to a library but the settings are 
not being passed to the Model Data Control window. The library is thus inactive. To make it act-
ive, check the box then click the OK button.

If the check box is disabled, there is no connected library.

Related Topics

Model Data Window 524

Output Window
The Output window is the primary vehicle for communicating the results of an analysis in text 
form (see Figure 1). The Output window follows the same general window organization as the 
Model Data window. 

When a model is run, the Solution Progress window appears. After the solution is obtained, you 
can view the results in the Output window by clicking the View Output button.             

- 528 -



Interface and User Options

If the information in the Output window is not in the desired format, you can choose Output Con-
trol from the Tools menu (or Toolbar) to modify the format. The Output Control window lets you 
specify the parameters, their units, and the order of their display in the Output window.             

The Output Print Content window available on the Tools menu (or Toolbar) lets you specify the 
content to include in the printed Output report and select the font to be used. 

The Sort window opened from the Arrange menu (or toolbar) offers the ability to sort the steady-
state Pipe Results or Junction Results tables according to the values in any of the columns. Tran-
sient results in the Transient Max/Min tables can be sorted using the right-click context menu.

The Transfer Results to Initial Guess feature on the Edit menu (and Toolbar) sets all pipe and 
junction initial steady-state flows and pressures equal to the converged results, which causes 
future runs to converge much faster.

You can view the input data for individual pipes or junctions directly from the Output window in 
one of two ways. First, if you press down the right mouse button on the pipe or junction number in 
the far left column of the table you will see the Inspection window. Second, if you double-click the 
pipe or junction number you will open the Properties window in read-only form where you can 
review input in detail.

General, Pipe, and Junction section display sizes can be changed by the user by clicking and 
dragging the bars between each section to resize them. Each section can also be hidden by click-
ing the arrow in the upper left of each section.

You can use the zoom feature in the lower right hand corner of the Output window to resize the 
text displayed on screen

Figure 1: The Output window displays output in text form

Right-click Context Menu Actions

There are several options available when right-clicking on a cell, row header, column header, or 
entire table in the Output window:
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 l Column Header
 l Change Units -  Quickly redisplay the selected column in a different unit.
 l Sort - Sort the table in Ascending or Descending order on the selected column.
 l Add "Parameter" for all Table Objects to Excel Export Manager - Add this 

column to the Excel Export Manager.
 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Copy Selected Cell Data - Copies all of the values in the column to the clipboard.

 l Row Header
 l Add all Object Parameters to Excel Export Manager - Add this row to the Excel 

Export Manager.
 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Find on Workspace - Quickly locate an object on the Workspace.
 l Copy Selected Cell Data - Copies all of the values in the row to the clipboard.
 l Open Properties Window - Opens the properties window for the associated pipe 

or junction.
 l Table (upper left cell)

 l Add Object Table to Excel Export Manager - Add the entire table to the Excel 
Export Manager.

 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Copy Selected Cell Data - Copies all of the values in the table to the clipboard.

 l Cell
 l Add Object "Parameter" to Excel Export Manager - Add this cell to the Excel 

Export Manager.
 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Create Design Alert - Create a Design Alert related to the selected object and 

value.
 l Copy Selected Cell Data - Copies the value of the cell to the clipboard.

Output Window Updates

Whenever you change the input model, all output windows are erased. This prevents you from 
changing your input model, forgetting to rerun it, and mistaking the previous Output window for 
the current model's results.

Steady Flow Results

Figure 2 shows the steady flow results in tables for pipes and junctions as specified in the Output 
Control window.
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Figure 2: The Output window shows steady flow results in the Pipes table and the various junction 
tables. Transient data is shown on the transient tabs.

Transient Flow Results for Pipes

You can review the transient results for any pipe station for any time which was saved to file as 
specified in the Output Pipe Stations panel. These results are shown in the Output window Tran-
sient Output table (Figure 3)

Figure 3 shows the transient flow results at the initial time step (which is equal to zero here). The 
columns of data shown in Figure 3 are specified in the Output Control window. Using the Time 
Slider will change what time step results are displayed.

Note that the pipe stations shown are those saved to the output file.

Figure 3: The Transient Output table in the Output window shows output results for pipe stations 
and at specified times.
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Transient Max/Min Results    

The Transient Max/Min table in the Pipe Output section shows the maximum and minimum val-
ues for each parameter in each pipe, the time it occurred at, and the station it occurred at. Thus, 
for each transient parameter added in the Output Control window, 6 columns will be shown in the 
Transient Max/Min table. Figure 4 below shows an example. 

The default format of the Transient Max/Min table is the summary version, showing the max-
imum and minimum values for the whole pipe, as described above. A detailed format is also avail-
able, where the maximum and minimum values for each parameter at each station are shown, 
along with the time they occurred at. Thus, for each transient parameter added in the Output Con-
trol window, 4 columns will be shown in the Detailed Transient Max/Min table. Figure 5 below 
shows an example. 

The Output Control window, under the Format & Action tab can be used to switch between the 
detailed and summary views. 

The information shown in the Transient Max/Min tables is not dependent upon what pipe station 
and time step output is saved for a given simulation.     

Figure 4: Summary version of the Transient Max/Min table     

Figure 5: Detailed version of the Transient Max/Min table     
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Transient Event Messages     

When events occur at junctions during the transient simulation, a log of all events is displayed in 
the two Event Message lists. In the first list events are sorted by junction number. In the second 
list they are sorted by time. The list includes when check valves close (and re-open), relief valves 
open (and re-close), control valves lose control (and regain it), as well as all standard event tran-
sients.      

Results Diagram     

Results diagrams are available for steady state pump results (see Figure 6). These diagrams 
allow you display the information in a more intuitive manner, copy the image of the diagram to 
your clipboard, or print the diagram. The option to show the results diagram can be found in the 
pump summary tab.     

Figure 6: Pump Results Diagram     
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Printing and Exporting

Data in the Output window can be:

 l Copied to the clipboard
 l Saved to a formatted text file
 l Exported to a delimited file suitable for direct importing into spreadsheet software
 l Exported directly to Excel
 l Saved directly to an Adobe PDF file
 l Sent to the printer

The printed and Adobe PDF output follows the same flexible, organized, and accessible format 
as the Output window itself. 

Related Topics

User Options Overview 562
Menus and Toolbars 473
Output Control 534
Applied Standards 539
Output Parameters 540
Use the Output Window Sort Feature 794
Design Alerts From Output 612

Output Control
Output Control  (see Figure 1) allows you to customize the parameters shown on the Output Win-
dow.             
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Figure 1: The Output Control window selects parameters for the Output window. Here the Pipe Out-
put parameters are shown. The other output parameters function the same way

Display Parameters

The Display Parameters tab controls the parameters to be shown for the pipes, junctions and 
summary reports. The output type is selected from the group of buttons at the top. For each out-
put type, the list on the left side shows all available parameters for the selected report. For the 
pipe and junction output, this list can be viewed in alphabetized or categorized mode, which 
makes it easier to find a parameter.

Choose a parameter to be shown by selecting it on the left-hand list and clicking the Add button, 
or double-clicking the parameter name. The selected item will appear in the list on the right either 
at the bottom or at the previously selected location. The list on the right shows the order of the 
parameters to be displayed in the output and the units (if any) in which to display the results.

You can change the order of the output by selecting a parameter on the right-hand list, then click-
ing the Reorder scroll bar on the far right or by clicking and dragging the row using the handle on 
the left. The list will be reordered accordingly. The output is presented from left to right in the 
order defined in this list.

The units used for a parameter can be changed by selecting the parameter then choosing the 
desired units from the adjacent dropdown list. By selecting the units of interest, you can obtain 
your results in whatever units you find most convenient and meaningful. This means that you can 
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enter all your input parameters in one set of units (or a variety of units, for that matter), and have 
all your output parameters in a completely different set of units. 

To set selected units for both pipes, junctions and summary reports to the preferred units (set in 
the User Options window), click the Use Preferred Units button. If you change the units of a para-
meter and you would like that unit to be used for all similar parameters in the list or entire output, 
select the Same Units button.

You will note that some output parameters do not offer the ability to specify output units. These 
parameters either do not have units associated with them (such as Reynolds Number or friction 
factor), or are in fact echoes of input parameters (such as Pipe Nominal Size). 

Several Special Summary Reports can be displayed in the Output window. These include the fol-
lowing:

 l Pump Summary
 l Valve Summary
 l Pipe Transient Summary
 l Forces Summary

In addition, if you are using theSSL module, there will be a slurry report available.

General

The General Section is the text area located at the top of the Output window. The project title, ref-
erence information and solution balance display are controlled here. 

You can enter a descriptive Analysis Title which will be used in the Model Data, Output 
and Workspace windows. A title is required and can have up to 100 characters.    

You can keep a lengthy explanation or any other documentation about your model in the Refer-
ence Information section. Names of projects, individuals, and assumptions can all be kept with 
the model. This information can then be included in your reports to improve tracking.

There is an option "Show Solution Balance Summary" that is defaulted to off. This option toggles 
the display of a general output tab showing the total flow entering and exiting each junction, as 
well as the sum of those flows. This can be helpful in verifying the results as well as in some 
troubleshooting cases.

Format & Action

The results can be automatically sent to the printer or saved to a file when the model has 
reached convergence. Additionally, the results can be automatically saved as initial conditions 
when the model is run. By saving the results as initial guesses, the iteration time for AFT Impulse 
to arrive at a converged solution is reduced. The initial guess can also be transferred manually 
by selecting Transfer Results to Initial Guesses on the Edit menu or Toolbar. The model can also 
be automatically saved after the initial conditions are transferred. The valve state (open, closed 
or failed) can also be saved along with the initial conditions.
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When enabled, the Wrap Table Column headers option makes the output tables wrap the 
column headers an extra line if the header is wider than usual.

There are four formatting methods for the pipe and junction output data:

 l Always Align Decimal Point on Output - allows magnitude of the data to be easily com-
pared as the data is read down the column. However, a number whose magnitude is 
small may force larger numbers to show many digits. For example, assume that the min-
imum number of digits is set to four, and there are two output values: 1234.5 and .09876. 
These two values will be displayed in the output as:

 l 1234.50000
 l       0.09876

 l Show Only Number of Digits (not aligned) - forces the data to use exactly the number 
of digits specified, which may result in the decimal point location changing from value to 
value. Using this method with the above example and four digits, the output will be dis-
played as:

 l     1235.
 l 0.09876
 l Align Only When Max/Min < Limit- aligns the data on the decimal point only if the max-

imum value in the column divided by the minimum value is less than a limiting order of 
magnitude that you set. If this ratio is greater than the limit, then each value in the column 
will be exactly the number of digits specified. Using the above example with a limit set to 4 
then 1234.5/.09876 = 12500 or an order of magnitude of 5. This is greater than the limit. 
The entire column will not be aligned and will be displayed as:

 l     1235.
 l 0.09876

 l Use Exponential When Max/Min>Limit -  similar to the above method except that if the 
ratio is greater than the limit then the entire column will be shown in exponential format. 
Using the above example, the column would be shown as

 l 1.235E+03
 l 9.876E-02

These formatting options are for the entire Output window; however, the last two are calculated 
and applied on a column basis. In other words, if you choose the third option one column may be 
aligned but another may not be. 

The output can be forced to always display in exponential notation by choosing the checkbox.

The Limit Event Options box can be checked to set maximum number of events which will be dis-
played in the Event Messages tabs that appear for cases such as valve transients. This can be 
useful in cases such as valve chatter.

For transient results, the maximum and minimum values for all selected parameters are shown 
in the Output window. The results can show the max/min values for all pipe stations, or only the 
max/min values for anywhere in the pipe. You can choose which type of report you want by 
selecting Detailed or Summary in the Max/Min Transient Table Contents area. For models with a 
large number of pipe sections, the Summary report is generally preferable because of the time 
required to display the Detailed table.
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The Grid Headers and Design Alert highlight colors can be configured to create a visually appeal-
ing output for ease of reading.

The box next to Show Results Diagram Column can be unchecked to hide the column which 
allows easy access to the Pump Diagram for Steady State pump output.

Show Pipes/Jcts

You can choose which pipes and junctions are to be displayed in the Output window. Clicking a 
selected item in the list on the Show Pipes/Jcts folder tab will deselect it. Clicking a deselected 
item will select it. This feature is especially useful when you are interested only in a certain area 
of the model.

You can quickly define the output you want by doing the following:

 1. Select the pipes and junctions on the Workspace
 2. Open the Output Control window and select the Show Pipes/Jcts folder tab
 3. Click the Workspace button for both the pipes and junctions
 4. Click the Show button

Library Connections

In the lower left of the Output Control window there is a Library checkbox. If this box is checked, 
your Output Control parameters are setup as determined by the library to which you are con-
nected. This is referred to as an active library. To make it inactive, uncheck the box or change 
one of the Output Control settings controlled by the library.

If the check box is unchecked, but enabled, you are connected to a library but the settings are 
not being passed to the Output Control window. The library is thus inactive. To make it active, 
check the box then click the OK button.

If the check box is disabled, there is no connected library.

Command Buttons

There are eight buttons at the bottom of the Output Control window. Impulse has built-in default 
parameters, units and settings which you can choose by clicking the Impulse Default button. You 
can also develop your own settings, tailored to your project or industry, and have these used by 
default (instead of Impulse’s defaults). To make your own default, first select the output para-
meters, units and settings you would like to use then click the Set As Default button. Your set-
tings will be saved and will be used each time any new project is initiated. If you make changes to 
the settings, and want to get back to your defaults, click the User Default button. The saved set-
tings are updated only when you click Set As Default.

You can save the output settings (except for the selected pipes/junctions) to a file by pressing 
the Save Control Format button and entering a file name. These settings are loaded again by 
pressing the Load Control Format button and choosing the file name. For example, you may 
have a final report format that is always desired. You can load this format before generating final 
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results. If you have another format you use for reviewing model accuracy, you may want a larger 
number of parameters in the output.

The format files you create can be placed on a network for sharing among a group or company, 
or incorporated into a company-wide library, allowing standardized reporting.

If you have made changes you don’t want to keep, click the Cancel button. Click OK to use the 
setting you have specified.

Related Topics

Output Window 528
Applied Standards 539
Output Parameters 540
Use the Output Window Sort Feature 794
Design Alerts From Output 612

Related Blogs

Quick Guide to Custom Output

Back to the Basics: Calculating and Defining Head

AFT Responds to 2020 Customer Survey Feedback

Applied Standards
When an applicable standard is used in a calculation, an additional tab appears in the general 
area of the Output Window. This tab indicates what standard(s) were used for what calculations 
in the model.

Figure 1: Applied Standards when applied for Relief Valve Orifice Area

Related Topics

Output Window 528
Output Control 534
Output Parameters 540
Use the Output Window Sort Feature 794
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Design Alerts From Output 612

Output Parameters
A variety of parameters are available to display in the Output window depending on the junctions 
and loss models used in the model.

A description of each parameter may be seen by double-clicking the header in the Output Win-
dow table, and is also displayed below the Output Parameters table when that parameter is 
selected in the Output Control window (Figure 1).

Additional information can be found below for some of the output parameters.

Figure 1: A description is provided at the bottom of Output Control for the selected parameter

Mass Flow Rate Net At Junction

Displays the total mass flow rate exiting the system through the junction, which is useful to dis-
play the flow exiting through junctions such as a spray discharge. In other words, the Mass Flow 
Rate Net At Junction is equal to the flow rate into the junction from the pipes minus the flow rate 
out of the junction into the pipes.

Mass Flow Rate Through Junction

Displays the total mass flow rate through the junction for junctions connected to only two pipes. If 
the junction is connected to more than two pipes this parameter will be displayed as N/A. When 
more than two pipes are connected the user should refer to the output for the pipes connected to 
the junction in order to view the flow rate through the pipes. The user can add the "Mass Flow 
Rate Net At Junction" to view flow exiting the system rather than flowing out of the junction into a 
pipe.

Pressure Loss Static Friction Component

Static pressure drop due to the Fittings & Losses entered in the Pipe Properties window. 
Excludes pressure drop due to pipe wall friction.

Pressure Loss Static Friction Total

Static pressure drop due to friction from the wall and the Fittings & Losses entered in the pipe. 
This value will be equivalent to the stagnation pressure drop due to friction because the velocity 
along the pipe is constant.
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Pressure Loss Static Friction Wall

Static pressure drop due to friction from the wall. Excludes static pressure drop due to friction 
from Fittings & Losses in the pipe. This value will be equivalent to the stagnation pressure drop 
due to wall friction because the velocity along the pipe is constant.

Volumetric Flow Rate Net At Junction

Displays the total volumetric flow rate exiting the system through the junction, which is useful to 
display the flow exiting through junctions such as a spray discharge. In other words, the Volu-
metric Flow Rate Net At Junction is equal to the flow rate into the junction from the pipes minus 
the flow rate out of the junction into the pipes.

Volumetric Flow Rate Through Junction

Displays the total volumetric flow rate through the junction for junctions connected to only two 
pipes. If the junction is connected to more than two pipes this parameter will be displayed as N/A. 
When more than two pipes are connected the user should refer to the output for the pipes con-
nected to the junction in order to view the flow rate through the pipes. The user can add the "Volu-
metric Flow Rate Net At Junction" to view flow exiting the system rather than flowing out of the 
junction into a pipe.

Related Topics

Output Window 528
Output Control 534
Applied Standards 539
Use the Output Window Sort Feature 794
Design Alerts From Output 612

Graph Results Window
The Graph Results window, shown in Figure 1, allows users to generate high quality printed 
graphs.

The Graphing Panel offers several types of standard graphs for transient pipe or junction, profile, 
and force information. Users can also control graph content, plotting information for multiple para-
meters, junctions, pipes, paths, or scenarios simultaneously. 

Results can be graphed as linear or log versus linear. 
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Figure 1: The Graph Results window offers full-featured plot generation

Graph List Manager

Allows the user to create, update, and even replace unique graphs that can be regenerated with 
new data. Multiple graphs can be displayed at the same time and organized into separate 
Folders. The default folder is named “My Graphs” and more folders can be created using the 
“New Folder…” icon on the Graph List Manager Toolbar or by right clicking on “My Graphs” and 
selecting “New Folder…”

Once a folder is created and selected, a Graph can be added to its list by selecting the “Add 
Graph to List” icon found on the Graph Results Toolbar. This can also be done by right-clicking 
anywhere on the graph. Once Graphs are in Folder individual Graphs can be generated in 
unique tabs or each Graph in a Folder can be displayed in a single tab by right clicking on the 
Folder and selecting “Load Current Folder Graphs in New Tabs” or “Load Current Folder Graphs 
in Same Tabs”. These options are available in the Graph List Manager toolbar as well. Other 
options that can be found by right clicking on a Folder or Graph in the Graph List Manager or on 
the toolbar are:

 l Load Graph in Current Tab – Regenerates the graph in the currently active tab.
 l Load Graph in New Tab – Creates a new tab and regenerates the graph there.
 l Load Current Folder Graphs in New Tabs - Regenerates all the Graphs in a Folder in 

separate tabs.
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 l Load Current Folder Graphs in Same Tab – Regenerates all the Graphs in a Folder in 
a single tab

 l New Folder – Creates a new Folder where more Graphs can be saved to.
 l Move Graph Up – Moves the selected Graph up one level. 
 l Move Graph Down - Moves the selected Graph down one level. 
 l Rename Graph… - Changes the name of the Graph
 l Duplicate Graph – Creates a copy of the selected Graph with a new name.
 l Delete Graph – Removes Graph from the Graph List Manager
 l Move To Folder – Moves the selected Graph to a previously existing Folder or a new 

Folder.

Graph Results Toolbar

The Graph Results Toolbar also has many options that are available by right clicking on the 
Graph Results space at any point. These options are:

 l Select Graph Parameters – Select the type of Graph to create and its parameters.
 l Add Graph To List – Saves the Graph to the currently active list allowing it to be regen-

erated in the future.
 l Update Current Graph In List – Saves any changes to the current graph that have been 

made. (e.g. Changing the Graph Title or Line Style). Note that it is preferred to use the 
Replace Graph in List option if changes to the parameters or objects/paths being shown 
have been made. 

 l Replace Graph In List – Replaces the graph highlighted in the Graph List with the cur-
rent graph that is shown. 

 l Copy Graph Image – Copies a .jpeg of the Graph to the clipboard
 l Copy X-Y Data – Copies the X-Y used by the Graph to the clipboard
 l Show Data – Displays the X-Y data used to generate the graph in a column to the right of 

the graph
 l Right-clicking on the x-y data set provides further options to find the maximum or 

minimum in the data set, create an annotation on the graph for a data point, or to 
copy an individual data point

 l Create Annotation – Add an annotation to the graph that can be formatted and saved to 
be reloaded with the Graph in the future.

 l Show Legend – Toggles the legend off and on.
 l Show Check Boxes in Legend – Adds a check box in the legend that allows the user to 

selectively turn off and on certain curves in a Graph without having to recreate a new 
Graph.

 l Show Cross Hair – Displays and cross hair that shows the cursors X-Y values along the 
X and Y axis. This also displays the nearest data point X-Y values in a tooltip. If this fea-
ture is used at the same time as "Show Data" the Cross Hair will focus on that highlighted 
data point and display its values in a tooltip. The user can also change what data point is 

- 543 -



Interface and User Options

highlighted with the arrow keys and the Cross Hair and tooltip will move to that datapoint.
 l Show Range Finder – Adds a toolbar at the bottom of the graph that displays the entire X 

axis, but allows the user to zoom in to a specific range by clicking and dragging the 
handles on either side of the range finder.

 l Show Junction Locations – Add a vertical line with the number of the junction labeled at 
the location of the junction along the flow length.

 l Manage Junction Locations - Allows junction labels on the graph to be shown/hidden 
individually.

 l Zoom to 100% - Resets the focus of the graph to 100%
 l Format – Allows the user to change the Graph’s format. Including

 l Header, Axis, and Legend names and fonts.
 l X and Y scaling
 l Line color and thickness

Graph Outline Colors

The active graph will always have an outline which indicates what state it is in.

 l Orange – Graph not added to list
 l Dark Green – Graph added to list
 l Light Green – Graph added to list, but changes have occurred. These can be saved and 

make they graph dark green by selecting “Update Current Graph in List”.

Graph Tab Icons

Each Graph Type has a specific color associated with it. This color will display in the box on the 
tab for the Graph. The colors are below:

 l Transient Pipe – Dark Red
 l Transient Junction - Dark Gray
 l Profile – Purple
 l Forces – Yellow
 l Frequency - Light Brown
 l Blank Graph – Light Gray

These tabs also display if the Graph in the tab is not saved or has been changed from the original 
Graph List item by showing a small yellow square over the tab's icon. If the current graph has 
been saved, there will be no yellow square.
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Graph Tab Actions

 l New Tab – Creates a blank tab in which a new type of Graph can be generate and added 
to the Graph List Manager

 l Tab Actions
 l Close Active Tab
 l Close All Tabs
 l Close All But The Active Tab
 l Two Vertical Tab Groups
 l Two Horizontal Tab Groups
 l Reset to Single Tab Group
 l Tabs on…. – Selects the location of tabs (defaults to the bottom of the Graph)

 l Graph Tab Selection – Selects a Graph for the Graphs currently in the tabs based on 
name. 

Printing and Exporting

The Graph Results image can be:

 l Copied to the clipboard
 l Saved to a picture file
 l Saved directly to an Adobe PDF file
 l Sent to the printer

The x-y data in the Graph Results graph can be:

 l Copied to the clipboard
 l Exported to a delimited file suitable for direct importing into spreadsheet software

Animations of graphs can be saved as .wmv or .mp4 files.

Data Point Limitations

By default, the maximum number of data points Impulse will plot for an individual graph is 
500,000, though users can change this limit under the General -> Other section of the User 
Options window. This limit is in place to help ensure users do not encounter memory issues 
related to plotting large numbers of data points. The allowed range of data points plotted is 
10,000 - 1,000,000. The data point limit is applied to an individual graph. Two parameters plotted 
as stacked graphs count as two separate graphs. Two parameters plotted with one as a sec-
ondary y-axis graph count as one graph. One parameter plotted for two scenarios on the same 
graph counts as two graphs (i.e. the data point limit is essentially doubled from a single-scenario 
graph to a two-scenario plot graph). 
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When a user attempts to generate a graph that exceeds the maximum number of data points, 
Impulse will skip data points in order to remain under that limit. The frequency of skipped data 
points is proportional to the amount by which the generated graph exceeds the maximum num-
ber of data points. When data points are skipped, there is the potential for important data points 
to be excluded from the graph such as maximum or minimum values. 

Users can take the following steps to avoid running into this issue, and to double-check that the 
graph gives an accurate representation of the results and does not skip any maximum or min-
imum data points:

 l Increase the limit in the User Options window (the time required to load a graph will 
increase)

 l Plot fewer curves in the graph
 l Graph data for limited amounts of time rather than the entire simulation time
 l Save fewer output data points from the Simulation Mode/Duration panel
 l Double check results shown in the graph with transient output shown in the Output win-

dow. Users can either reference the Transient Output, showing output values for every 
time step and pipe section data is saved for, or examine the Transient Min/Max values 
shown for the parameters selected in the Output Control window.

Related Topics

Output Pipe Stations Panel 189
Animating Graph Results 91
Animation Layers 96
Output Junctions Panel 190
Graph Types 547
User Options Overview 562
Menus and Toolbars 473
Quick Graph Formatting Window 547
Basic Graph Tutorial 551
SSL in Graph Results 661

Related Blogs

Quick Guide to Custom Output
SSL Module 
Settling Slurry Module
An optional add-on module to AFT 
Impulse which allows users to sim-
ulate settling slurries.
PFA Module 
Pulsation Frequency Analysis 
Module
An optional add-on module to AFT 
Impulse which allows users to 
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determine resonant frequencies in 
their system.

Quick Graph Formatting Window
The Quick Graph Formatting is accessed by clicking the Formatting button in the Quick Access 
Panel, or from the Tools menu.    

The Quick Graph Formatting window allows you to customize the plot by giving you control over 
the many aspects including:             

 l Axis titles and font sizes      
 l Legend text and font size      
 l Line thickness and basic color sets      
 l Axis min and max values      

You can save the settings you set up by clicking the Save button. If you make changes to the set-
tings, and want to get back to previous settings, click the Load button.             

Related Topics

Graph Results Window 541
Graph Types 547
Basic Graph Tutorial 551
Animating Graph Results 91
SSL in Graph Results 661

Graph Types
AFT Impulse offers several types of graphs to help users better understand and interpret their 
data. Each type of graph is given a brief description below. Starting with AFT Impulse 8, users 
are also able to plot output for multiple scenarios in a single graph, which is also discussed 
below. 

Transient Pipe

Transient pipe results can be plotted against time for any pipe station that is saved to the output 
file. By default, only the inlet and outlet stations for each pipe will be saved to the output file. The 
Output Pipe Stations panel allows the user to specify which pipe station data will be saved. Each 
pipe is shown in an expandable list. When a pipe is expanded, the pipe stations for which data 
was saved are shown. These pipe stations can be added to the list on the right to be included in 
the graph by either double clicking the parameter, or highlighting the parameter and using the 
right arrow button.

The user can plot the data for the entire simulation, or for a user specified time frame. 

One or more parameters can be graphed by using the Add button with the green plus sign. The 
Remove button can be used to eliminate extra parameters.  Parameters can either be plotted in 
stacked graphs, or two parameters can be plotted on the same graph using the secondary axis. 
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To move a parameter to the secondary access, add it below the parameter that will be on the 
primary access, then click the right blue arrow button, or double-click on the gray square to the 
left of the parameter. This will cause the parameter to be indented, as shown in Figure 2.

Further, if Design Alerts are specified for the pipe (e.g., max/min operating pressures), these can 
be cross-plotted against the transient data by selecting the check box under "DA".

Figure 1: Creating a graph with a parameter on the secondary axis.

Transient Junction

Similar to transient pipe results, transient junction results can be plotted vs. time for any junction 
that is saved to the output file. Junction data includes items such as pump speed and accu-
mulator volume. These are specified in the Output Junctions panel.

Profile

This graph category allows users to plot the selected parameter(s) along a flow path. In order to 
generate this graph, the specified pipes in the Select Graph Parameters window that comprise 
the path must form a single, continuous path. If they do not, an error message will appear listing 
the pipes which are preventing the path from being continuous. The independent variable in 
these graphs is the length along the flowpath.

A path of pipes can be specified in one of two ways. First, the user can select the pipes in the dis-
played list. Additionally, you can select the path on the workspace, and then use the Workspace 
button on the Select Graph Parameters window to automatically select all pipes currently selec-
ted on the Workspace. These methods permit that only a single path to be specified. 

One or more flow paths can be specified using groups. Only those groups that consist of a con-
tinuous pipe sequence will be displayed as an option in the Select Graph Parameters window. 

The results can be the values at a particular point in time, or the overall maximum and/or min-
imum values. You can also cross-plot the max/min values, the steady-state results, and Design 
Alerts. This is done clicking the check boxes underneath "Mx" for maximum, "Mn" for minimum, 
"SS" for steady-state, and "DA" for design alerts. 

All profile graph types support animation. There are two animation options: Animate Using Out-
put File, and Animate Using Solver. These are discussed in Animating Transient Results.
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Forces

If transient force sets have been defined in the Force Definitions panel, the resulting force data 
can be plotted vs. time. Force sets selected from the list of defined force sets will be plotted. The 
unbalanced transient force data can be plotted for the entire transient simulation, or the user has 
the option of selecting a specific time frame to display. 

This force data can also be exported for analysis in pipe stress analysis software. 

Frequency

(PFA module only) As part of the pulsation frequency analysis, the tab will appear to plot the fre-
quencies identified for the system. More information on this can be seen in Pump RPM Evalu-
ation in the PFA Module.

Multi-Scenario Graphing Features

Starting with AFT Impulse 8, users can plot information from multiple scenarios in the same plot. 
In the Select Graph Parameters window, the button for 'Multiple Scenarios' allows users to select 
the scenarios in the model they wish to plot for a particular graph. The scenarios being plotted in 
the graph must have the same pipe layout for all scenarios, but can have different sectioning in 
AFT Impulse 9. In AFT Impulse 8, all scenarios must have the same Analysis Setup settings 
including sectioning, start time, stop time, and number of data points saved for all scenarios 
being plotted in a graph. 

The active scenario must be included in a multi-scenario graph. When creating a new graph, 
users are not able to deselect the current scenario. When a user loads a saved Graph List Item 
that does not include the active scenario, Impulse will add the active scenario into the Graph List 
Item, but will not save the active scenario into it. 

Scenarios can be selected using the Multi-scenario... button as shown in Figure 2 below. 
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Figure 2: Graph Parameters window showing Multi-scenario selection options

Related Topics

Output Junctions Panel 190
Graph Results Window 541
Quick Graph Formatting Window 547
Basic Graph Tutorial 551
Animating Graph Results 91
SSL in Graph Results 661

Related Blogs

Five Fantastic New Features for Fast Fluid Transients: Impulse 8
PFA Module 
Pulsation Frequency Analysis 
Module
An optional add-on module to AFT 
Impulse which allows users to 
determine resonant frequencies in 
their system.
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Basic Graph Tutorial
Generating Graphs is a powerful tool for analysis. Below are step by step instructions about how 
to make and manage graphs from one of the example models. Many of the graphs created in this 
example will be multi-scenario graphs. However, the information discussed within is the same 
regardless of which scenarios are selected. 

For this example, the “US - Ammonia Transfer with Cavitation.imp” file was used. The file should 
be at this location by default C:\AFT Products\AFT Impulse 10\Examples\US - Ammonia Trans-
fer with Cavitation.imp. It is recommended to “Save As” the file under a different name and loc-
ation to prevent altering the example files.

Open the model and run all the 0.5 Second Closure, 1 Second Closure, and 2 Second Closure 
children scenarios. Return to the "0.5 Second Closure" scenario. 

To skip to different sections of this tutorial, use the links below:

 l Transient Junctions and Saving Graphs
 l Transient Profiles and Animations
 l Displaying multiple graphs simultaneously
 l Creating graphs from the Workspace

Transient Junctions and Saving Graphs (return to top)

Figure 1: Valve Closure Example

Go to the Graph Results Primary Window and determine what type of graph you want to gen-
erate. The first graph created in this example will be a Transient Junction Graph. The Transient 
Junction is one of several different types of Graphs that can be made. This graph is created by 
first selecting the Transient Jct tab and selecting the desired parameters. The only junction with 
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saved transient data will be the valve J3. Add this junction to the “Graph These Junctions:” 
column by double-clicking the junction ID number, or selecting the “>” symbol. Select “Cv” as the 
parameter. Select the three scenarios using the Multi-scenario... button, and then select “Gen-
erate”. This creates a plot of “Cv vs. Time” for all three scenarios on the left. 

Note that the Graph Guide, accessed by clicking on the "What Would You Like to Do?" icon on 
the upper right of the graph, can help guide you through the process of creating a graph

Figure 2: Valve Cv vs. Time

The Graph has been created, but has not yet been added to the list under “My Graphs”. To add 
this Graph to the list, first select the “Add Graph to List” icon on the Graph Results toolbar (this 
option and many others can be accessed by right-clicking on the Graph at any time). Name the 
Graph “Valve Cv vs. Time”. The Graph has now been saved and will be easily regenerated with 
the same format if the output changes. The name of the saved Graph can be seen in the Graph 
List Manager, with two small squares in the icon associated with it indicating it is a multi-scenario 
graph. The border of the Graph has also changed to dark green along with borders of the para-
meters and the name of the Graph in the Graph List Manager, indicating the Graph is current, 
saved, and that the displayed parameters are the ones used to generate the Graph. 
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Figure 3: Adding a Graph to My Graphs

Formatting options are available by selecting “Formatting” above the different graph types. 
When formatting changes occur the border of a Graph will change from dark green to light green, 
indicating a change has been made to a graph in the Graph List. Another indicator that the Graph 
is not saved is the small yellow square over the icon on the tab. Here, the title has been changed 
from “Cv vs. Time” to  “Valve Cv vs. Time”. Once the formatting settings have been changed, This 
change and other formatting changes are not retained to the Graph unless “Update Current 
Graph in List” is selected. 

Figure 4: Update Formatting Changes to Graphs

After selecting “Update Current Graph in List” the border has changed back to dark green and 
the yellow square has disappeared. This indicates that this is the current formatting of this graph, 
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and that regenerating this graph will generate the same graph (according to the current model 
output).

Figure 5: Valve Cv graph with updated formatting changes

Transient Profiles and Animations (return to top)

The next step in the example is to make a new Graph in a separate tab. This is done by selecting 
the “New Tab” icon in the lower right. This Graph will be a “Profile” Graph that displays Static 
Pressure along the length of the flow path. Select pipes 1, 2, and 3 in the system and change the 
parameter to “Pressure Static” with units of length in feet and units of pressure in psig. Make sure 
that the Mx and Mn boxes are checked to display the maximum and minimum stagnation pres-
sures. 

Note: An easy way to select the pipes in a longer path would be to select them in the Work-
space, then click the Workspace button under Pipes to automatically select the desired 
path. This method is discussed further below.
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Figure 6: Generating a Profile plot with Min and Max Pressure Stagnation

The graph shows the minimum and maximum static pressures during the transient simulation for 
each pipe station along the path. This Graph is the same as the saved "Min/Max Static Pressure 
Profile" Graph List Item. We could have generated the same graph by loading that graph 
instead. Save this new graph to replace the saved Graph List Item, or create a new entry. The 
graphs we have made can be switched quickly between by either selecting the Graph from the 
list, by clicking on the corresponding tab, or using Graph Tab Selection.

Figure 7: Pressure Stagnation vs. Flow Length Profile added to Graph List

This is a useful graph, but animating the pressure profile over time can provide even more inform-
ation. There are two animation options available. Animating from the Output file requires that all 
data for the pipe stations being animated to be saved to the Transient Output File using the Out-
put Pipe Stations panel. This gives more flexibility to move the animation forwards and 
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backwards in time, but makes the run-time longer. Animating using the Solver option does not 
require output for all stations, but instead reruns the solver. This takes longer to graph and has 
less accuracy, but allows for a shorter model run-time. This model was set to only save data for 
pipe inlet and outlet stations, so we will use the "Solver" option. To use the Animate via Output 
option, return to the Output Pipe Stations panel and change which Pipe Station output is being 
saved. 

After selecting generate the Graph will now allow for animation with options to Play, Record, 
Stop, and manipulate the animation in other ways. The recorded animation can be exported to a 
video file for convenience.

Figure 8: Max/Min Profile Graph with Animation

Displaying Multiple Graphs Simultaneously (return to top)

Another option that is available is to add another parameter to the graph. This is called gen-
erating stacked graphs. To do this select “Add” next to “Select Parameter”. This will graph an 
additional parameter that shares the same X-Axis as the original parameter. For this example, 
select “Pressure Static” as the parameter, but with units in barG rather than psig.
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Figure 9: Stacked Pressure Profile with different units

We now have the same plot twice, which is not the most efficient way to view this data. A better 
way would be to have the secondary parameter (which could be any of the available options for a 
profile plot) on a secondary Y-Axis. This can be done by double clicking on the arrow to the left of 
“Pressure Stagnation: bar” or by selecting the blue right arrow on the “Select Parameter Row”. 
This will visibly indent the secondary parameter. When the Graph is regenerated it will now only 
be one plot of Pressure Static vs. Length, but it will have units displayed in psig on the primary Y-
axis and units of barG on the secondary y-axis.

Figure 10: A Single Graph with Alternate Units on a Secondary Y-Axis

Update Current Graph in List button. The Graph is now complete and can be easily regenerated 
if input data is changed on the Workspace and the model reran. It can also be used to generate 
the same graph for data from other scenarios. 
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Figure 11: The Resulting Graph when it is Updated

It is now possible to close the Graphs and regenerate them either in their own tabs or all graphs 
in a folder in the same tab. To test this out, close both Graph tabs and then select the “My 
Graphs” folder.  Right-click on the "My Graphs" folder and then choose “Load Folder Items” and 
then “Same Tab”. After the Graphs have been loaded in the same tab, the tab icon changes to an 
orange square, indicating that multiple Graphs are being displayed on one tab. All graphs will 
now be animated, with a vertical red line appearing on the graphs with a time axis. This red line 
will move over the animation time to compare values more readily. 

Depending on the monitor display being used, or the number of graphs being displayed, this 
view may be easy to view or difficult to see data. For the sake of this example, we've kept the dis-
play size relatively small, meaning it is more difficult to view the data on all the graphs. However, 
with larger monitors available, it is likely easier to view this data. 

Figure 12: All graphs loaded into the same tab
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Other ways to view multiple graphs simultaneously are to plot them as stacked graphs, as we did 
previously for our pressure profile in psig and barG, or to plot saved graph items in two tabs 
either stacked or side-by-side. Right-clicking on a Graph-Tab at the bottom of the window shows 
the options for displaying two separate tabs. 

Since we have two Time graphs with the same X-axis, we can display them in a single, stacked 
graph. This approach to viewing graphs can be especially helpful in examining how a junction 
transient is affecting output parameters nearby. To create a stacked graph of multiple Graph List 
Items, first make sure both items have the same time scale. Both of our example graphs do. 
Then, move them into their own folder. Here, we've created a new "Profile" folder, and moved 
our Max/Min Static Pressure Profile graph into it. Finally, right-click the My Graphs folder, select 
"Load Folder Items", and then the "Stack Common X-Axis in Same Tab" option. 

Figure 13: Load Current Folder Graphs in Same Tab - Stack Same X-Axis

As we just saw with the Profile Graph Folder, it is possible to create more Graph Folders other 
than “My Graphs”. Saved Graph List Items can then be organized into different folders and can 
independently be generated into their own tabs or a whole folder of Graphs can be generated 
into one tab. Using multiple folders will allow the user to create many unique variations of anim-
ations or other Graphs that can be used to convey transient output in a meaningful and intuitive 
manner.

Creating Graphs from the Workspace (return to top)

Some graphs can also be generated directly from the Workspace after running the model. To cre-
ate a graph for the valve inlet and outlet stagnation pressures from the Workspace right click on 
the valve J3, choose “Create Transient Graph for connected pipes (Inlet/Outlet)”, and select 
“Pressure Static”.
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Figure 14: Creating Transient Graphs of the Inlet/Outlet Pipes Connected to a Junction

This will automatically generate the requested Graph with default units. Add the graph to the “My 
Graphs” folder using the Add Graph To List button and name it "Valve Inlet/Outlet Pressures". 
This is a quick and easy way to see the pressure difference across the valve. Notice that this 
graph will be a Transient Pipe graph, since the pipe inlet/outlet stations are being used to graph 
the equivalent valve inlet/outlet values.

Figure 15: The Pressure Stagnation vs. Time of the Two Pipes Connected to Valve J3

Make one more Graph from the Workspace by right-clicking pipe 3, selecting “Create Transient 
Pipe Graph”, “Volumetric Flowrate Downstream”, and then “Outlet Only”. 
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Figure 16: Graph the Changes to Volumetric Flowrate vs. Time from the Workspace

This will add a Graph of the Volumetric Flowrate at the Outlet Station of pipe 1. Add the graph to 
the Graph list and name it "Pipe 1 - Outlet Volumetric Flowrate".

Figure 17: Volumetric Flowrate Downstream vs. Time at the Outlet of pipe P1

Related Topics

Graph Results Window 541
Quick Graph Formatting Window 547
Graph Types 547
Animating Graph Results 91
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SSL in Graph Results 661

User Options Overview
An array of User Options are provided in a single window that can be found in the Tools menu.

The General section of the User Options window allows you to adjust:

 l Choose to show the Startup Options window at startup
 l Choose to show the New Version Welcome window at startup
 l Enabling orthogonal drawing tips
 l Whether to confirm before clearing output results
 l Enabling Highlighting Required Data on Property windows
 l Options for opening models with scenarios
 l Allowing messages for Force Set Calculation Time
 l Visual Themes and Styles
 l The default location of the Quick Access Panel
 l Number of data points to show in input tables
 l Maximum Number of Data Points per Graph 
 l Setting parameters for "button flashing" for curve fit buttons on Junction Property win-

dows

User Option Defaults

There are several buttons at the bottom of the User Options window. There are built-in AFT 
Default parameters, units, and settings which you can choose by clicking the Reset to Impulse 
Defaults button. You can also develop your own settings, tailored to your project or industry, and 
have these used by default. To make your own default, first select the parameters, units, and set-
tings you would like to use, then click the Save All As New User Defaults button. Your settings 
will be saved and will be used each time any new project is initiated. If you make changes to the 
settings, and want to get back to your defaults, click the Load All User Defaults button. The 
default settings are updated only when you click Set All As New User Defaults.

If you have made changes which you don’t want to keep, click the Cancel button. Click Save and 
Close to use the settings you have defined.

Related Topics

Menus and Toolbars 473
Unit System 563
Workspace 565
Parameters 568
Files 570
Waterhammer 571
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Unit System
You can set the units you prefer to use in AFT Impulse in the Unit System section. Once selected 
as the preferred units, these units appear as the default units in all instances in which empty 
fields exist in the model input. Any model input existing prior to changing the Preferred Units will 
maintain the units used when the data was input, regardless of changes made to unit pref-
erences. After saving your preferred units, a window appears asking if you would like the output 
parameters to be displayed in your preferred units. Choose Yes if you do want the output para-
meters to be displayed in the preferred units, or No if you want the output parameters to be dis-
played in the units previously used. 

Preferred Units

To customize the units used by AFT Impulse, first select Preferred Units under the Unit System 
section in the User Options window under the Tools menu.

AFT Impulse allows you to specify certain units from a large selection to be displayed in the main 
interface.

The primary selection is the Unit System: 

 l US - Only US units will be available
 l Metric - Only Metric units will be available
 l Both with US Defaults - All Units will be available, but US units will be chosen by default
 l Both with Metric Defaults - All Units will be available, but Metric units will be chosen by 

default

Additionally, a filter can be applied to limit the selection:

 l All Units - all units for the Unit System will be displayed
 l Common Only - only "common" units will be displayed
 l Common Plus Selected Industries - Units particular to certain industries can be 

included with the common units

If the selection has been limited to Common Only, there may units common for certain industries 
no longer present. The Additional Units for Industry section allows the user to append additional 
sets of units to the Common unit set. For example, barrels/day is a common unit in the petroleum 
industry but not many others. Checking the Petroleum box adds these units to the main inter-
face.

Preferred Units allows fine grain control over what unit in the above selection is displayed as the 
default when defining model input. For example, it may be desired to have a particular parameter 
such as pipe diameter default to inches, while keeping other parameters metric. This area allows 
the user to define such defaults.
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Show/Hide Unit Items

For additional control of the available units, select Show/Hide Unit Items under the Unit System 
section. From here, you can select which units for each Unit Family Type you would like to be 
available for the model input and output by checking the box next to each unit you would like to 
be used. Removing units that you do not wish to use as input or view as output can simplify your 
modeling and reduce errors associated with incorrect units.

Edit Custom Unit Names

A custom unit name can be assigned to display different names in the interface for units. For 
example "feet/min2" could be changed to display as "ft/min2".

To assign a custom unit name choose the appropriate Unit Type from the drop-down and enter 
the Custom Unit Name in the table.

To speed up the process of entering custom unit names the units can be exported to csv and re-
imported as follows:

 1. Click "Save Units to CSV" and save the file where it will be easy to locate
 2. Open the *.csv file in a spreadsheet editing software like Excel, and fill in the desired cus-

tom unit names in the Custom Name column
 3. Save the *.csv file
 4. In the User Options window click "Load Units from CSV" and select the edited *.csv file

Note: To use units with superscripts, make sure the *.csv file is saved with UTF-8 encoding. 
This can be done in Excel by choosing save as and selecting "CSV UTF-8" as the file 
type.

Note: Regions outside the United States that use commas as the decimal separator may 
have *.csv files that are delimited with semicolons (this was a change made by 
Microsoft). AFT software requires true comma delimited files. A workaround for such 
regional users in Excel is listed below.

Workaround for regional users with alternate decimal separators (e.g. Europe):

 1. In Excel go to File > Options > Advanced
 2. Under the Editing Options heading, uncheck the box for "Use system separators"
 3. Change the "Decimal separator" to a period symbol (.)
 4. Change the "Thousands separator" to a comma (,)
 5. Save the *.csv file
 6. Re-check the "Use system separators" option to revert to the default Excel settings

Related Topics
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User Options Overview 562
Workspace 565
Parameters 568
Files 570
Waterhammer 571

Workspace
In the Workspace group of the User Options window, you can change the symbols used, default 
text content, and location of the text on the Workspace. Note that all display changes are made 
only for the user's convenience/preference and do not affect the model calculations. Additionally, 
many display options available in the User Options window are also available in individual pipes 
and junctions.

Grid 

A traditional 2-D grid or an Isometric grid can be displayed on the workspace for modeling con-
venience based on the Pipe Drawing Mode that is selected. The number of lines in the grid can 
be adjusted to create a grid that is fine, medium, or coarse. The grid can be hidden or shown by 
checking or unchecking the Show Grid box accordingly. If the grid is shown, the grid line pattern 
can be solid or dashed. The pipes and junctions can also be snapped to the grid, which moves 
junctions and pipe end points to the closest intersection of grid lines.

The Pipe Drawing Mode and the toggle to Show Grid can also be found on the Arrange menu.

Pipes

The display of pipe lines, closed pipes, pipe endpoints, and pipe direction arrows can be adjus-
ted according to your preferences here.

The default pipe line thickness for new layers can be adjusted by selecting the desired pixel 
value in the box next to New Layer Default Pipe Line Thickness (pixels).

You can close a pipe using the Special Conditions feature which closes the pipe to flow at both 
ends. From the User Options window, you can select how you would like a closed pipe to be dis-
played on the Workspace. The options include a solid line, dashed line, a dotted line, and 
dashed-dotted combinations. The color of the line is still determined by the visibleWorkspace 
Layers.

When building a model, Impulse automatically adjusts pipe endpoints to the centers of junctions 
for user convenience. If you would like to disable this feature, uncheck the box next to Auto-
matically Adjust Pipe Endpoints to Junction Centers.

Under the Pipe Direction Arrows section you can select the size of arrow you would like to be dis-
played as a percentage of the pipe thickness. Additionally, you can opt to not show a pipe dir-
ection arrow by checking the option Do Not Show Arrow.
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Note: The pipe direction arrow is used as a reference positive flow direction and does not 
change direction on the Workspace if the calculated flow is in the opposite direction 
indicated by the arrow. Instead, the flow is reported as a negative flow in the Output.

Junctions

The junction icon style displayed on the Workspace can be chosen in Junctions underneath the 
Workspace section in the User Options window. The two available icon styles include classic 
icons and transparent icon. Classic icons are the icons used in earlier versions of Impulse ending 
at Version 4 in which each junction is surrounded by a box, and transparent icons are updated 
icons not surrounded by boxes.

You can also select the icon size and label location for junctions. To adjust the size, click on the 
box below Icon Size in the Junctions panel and choose the percentage of the default size that 
you would like the junction icons to be sized. For the junction label location, you can select from 
any of the eight locations shown by clicking on the selection circle that corresponds to the 
desired location.

Using the default transparent icon style, the appearance and color of icons for new junctions can 
be set in the Toolbox, and icon size and color for existing junctions can be set inLayer Settings. 
Junction icon and rotation can be edited for existing junctions by right clicking the junction on the 
Workspace and selecting Customize Icon.

Note: Junction and pipe labels can be moved individually on the Workspace by using the 
mouse to drag and drop the label according to your preferences.

The final option is to enable or disable a dotted outline around a closed junction. If this option is 
enabled, a dotted box will appear around the junction when it is closed with Special Conditions. If 
this option is disabled, no dotted box will appear.

Labels

When a pipe or junction is inserted onto the Workspace, the next whole number available at the 
increment specified in this panel is automatically assigned to the new pipe and/or junction. 
Impulse's default is to increment pipe and junction numbers by one. Therefore, the first pipe you 
place on the Workspace will automatically be labeled as Pipe 1 (P1 for brevity), the second will 
automatically be labeled P2, etc. Junctions are labeled in a similar fashion with a "J" in front of 
the number to indicate it is a junction. However, if you choose a different increment in the User 
Options window for pipes and/or junctions, the automatic numbering will increment pipes and/or 
junctions according to the specified number. You can renumber any pipe or junction individually 
as long as the number is not already used in any scenario of the model. If a number at the incre-
ment is already in use, Impulse will skip to the next available whole number. Pipe and Junction 
label numbers are limited to integers between 0 and 99,999.

Note: A unique label must exist for each pipe and junction on the Workspace. Therefore, 
there cannot be more than one P1 in the model, but a P1 and J1 can exist sim-
ultaneously because the leading letter is different.
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Whether pipe/junction names and/or numbers are displayed is controlled ultimately by Work-
space Layers, but the Pipe/Junction Default Display setting allows the user to set their preferred 
default behavior.

Users can also choose whether the pipe and junction labels should be moveable at all times, or if 
they should only be moveable when the user is holding down the shift key with the Allowable 
Workspace Label Movements setting. Restricting the movement of labels can be especially help-
ful to users with complicated or dense models, as it is possible to inadvertently grab a label when 
attempting to reposition or select an icon on the Workspace.

Colors and Fonts

The Colors and Fonts item located under the Workspace section in the User Options window 
allows you to change the colors of the following parameters seen on the Workspace:

 l Pipe and Junction Symbols 
 l Junction Labels
 l Pipe Labels
 l New Layer Default Pipe Color
 l Selected Items 
 l Undefined Numbers 
 l Workspace Background Base Scenario 
 l Workspace Background Children  
 l Workspace Background of Grandchildren
 l Workspace Background 3rd Generation
 l Workspace Background 4th Generation +
 l Grid

The currently selected color for each parameter is shown to the right of the parameter. To 
change the color for any parameter, either select the box containing the parameter's color and 
then click on the Set Color box under the list, double click on the box containing the color you 
would like to change, or click the "..." button next to the color of the parameter you would like to 
change. A color window pops up that allows you to choose from 48 basic colors, or to create a 
custom color by clicking anywhere in the color box and adjusting the slider at the right of the box 
to create the color of your choice. If you would like to save the custom color for use in other areas 
of the model, click on any empty box underneath Custom colors: and then click on the Add to 
Custom Colors box below the color box. When finished with selecting a color, click OK on the bot-
tom left of the Color window.

To have the background color of the children and grandchildren scenarios maintain the same 
color as the base scenario, click on the Set All Background Colors to Base Color button under 
the Parameter/Color list.
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Other

Workspace Symbols representing pipe or junction special conditions and inflow or outflow are lis-
ted in the Other item within the Workspace group in the User Options window. These symbols 
can be disabled by unchecking the box on the left of the list. Users can also change what symbol 
will be used by clicking in the Symbol box on the right and typing the new desired symbol.

If there is a background image in a model, the image size can be controlled from this panel. To 
scale a background picture, enter a Scale Multiplier in the box underneath Background Picture 
Scaling.

Related Topics

User Options Overview 562
Unit System 563
Parameters 568
Files 570
Waterhammer 571

Parameters
The Parameters section of the User Options window allows you to specify some default para-
meters and model input when a new pipe or junction is added to the Workspace. Changing any 
of the parameters in this window adjusts the specified default pipe and/or junction input para-
meters and/or values to simplify the modeling process and to prevent the user from having to 
enter repetitive data.

Pipes and Junctions

Pipe and Junctions, located within the Parameters section of the User Options window, allows 
you to specify default pipe and junction input information. 

Under the Default Pipe Data box in this window, you can enable or disable the option Use Most 
Recent Pipe Size Data. If you enable Use Most Recent Pipe Size Data, the pipe property win-
dows of new pipes added to the Workspace will automatically contain pipe diameter, material, 
and friction information from the most recently entered pipe. This option avoids you having to re-
enter that data in the case that several pipes require this same input. Disabling this feature 
leaves the information for each new pipe added to the Workspace as the default specified in the 
User Options window. 

The Default Junction Elevation box allows you to select the default junction elevation for all new 
junctions added to the Workspace. If you select Unspecified in this box, the junction elevation 
field in the Junction Properties window remains empty until you specify each junction elevation 
individually. If you select Use Most Recent, the junction elevation of a new junction added to the 
Workspace is shown as the elevation of the most recently specified junction. If you select Spe-
cified,  an elevation of your choice will automatically be input into each new junction added to the 
Workspace.
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The Default Reservoir Pipe Specification box allows you to specify the default option selected for 
how the height at which a pipe connected to a reservoir is specified. Selecting Pipe Elevation 
requires you to input the pipe elevation with respect to the reference elevation. Therefore, if a 
pipe is located 100 feet (30.5 m) from the reference elevation, or elevation= 0 ft (0 m), then you 
would input 100 ft as the pipe elevation when Pipe Elevation is selected in the Reservoir Prop-
erties window. Selecting Pipe Depth requires you to input the pipe elevation with respect to the 
level of fluid in the tank. Here, if a pipe is located 10 feet from the top of the fluid level in the tank, 
you would input 10 ft. Note that the same results will be calculated regardless of whether you spe-
cify Pipe Elevation or Pipe Depth as long as the height of the pipe is defined at the same height 
with respect to the system in both cases.

The Default Control Valve Setpoint  box allows you to specify if all new control valves should be 
set to Always Control (Never Fail) by default in the Control Valve Properties window. This setting 
can be useful as a troubleshooting tool to see how far your control valves were from being able to 
control in the system.

The Default Design Factors box allows you to add a default Design Factor to each pipe and/or 
junction shown in the list on the Pipes and Junctions window Optional tab. Setting a default 
design factor for pipes and junctions can be especially useful when applying safety factors on 
given equipment.

Graphs from Workspace

Various parameters can be graphed quickly by right-clicking on a continuous selection of pipes 
from the Workspace and choosing the Generate Profile Graph for Pipes option. The graph para-
meters that are available from the right-click menu can be customized.

Parameter Type             

Parameter Types, located within the Parameters section of the User Options window, allows you 
to specify the flow rate type, head/pressure type, and/or efficiency/power type you would like as 
the default option wherever flow rate, head/pressure, and/or efficiency/power is defined in the 
model. The default flow rate type can be set to either mass flow or volumetric flow, the default 
head/pressure type can be set to either head or pressure, and the efficiency/power type can be 
set to either efficiency or power.

Related Topics

User Options Overview 562
Unit System 563
Workspace 565
Files 570
Waterhammer 571
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Files
The Files section of the User Options window allows you to specify file locations for saving mod-
els, library folders, user settings, and model backup files. You can also customize the model 
backup file settings here.

File Locations

Under File Locations in the Files section of the User Options window, you have the option to 
select the default folder in which to save your model. If a default model folder is specified, this loc-
ation will be the default location to save the model. To specify the default location, click Add 
below the Default Model Folder box and browse to the location you want to set as the default 
folder. Once you have selected the folder, click OK. The location of the default model folder will 
then show in the Default Model Folder box. You can add more than one default folder, but only 
the folder selected in blue will be the active default folder.

To specify locations for Impulse to search for library files, click Add under the Library Search 
Locations box. Browse to the file location that contains the library, select the location, and click 
OK. You can add multiple folders to be searched. To add additional folders, repeat the process 
for each folder.

The User File consists of all saved settings and preferences. In order to backup these user set-
tings in a *.ini file, click Add under User File Backup Locations. Browse to the file location in 
which you would like to save these settings. Once you have selected the desired file location, 
click OK. Note that the User File can be saved in multiple locations. To add additional locations, 
repeat the process for each folder that you would like to save the settings.

Backup Files & Auto Save

A Backup File is a copy of a previously saved version of your model file (*.imp) that can function 
as a complete, standalone model. These files are used as a safety measure to provide you with 
one or more previous versions of the model in the case that the current model is deleted or dam-
aged.

The Number of Backup Files (i.e. the number of previously saved versions of the model) and the 
frequency that the model is saved can be adjusted. You can opt to save no Backup Files by 
choosing "0" in the Number of Backup Files Created dropdown.

After the model has been saved initially, subsequent instances of saving the model will create a 
new Backup File until the specified maximum has been reached. The most recent Backup File 
will always contain the file extension *.bakI-001. Larger numbers appended to the file name indic-
ate older backups:

 l Model File.imp - Current and most recent version of the model file
 l Model File.bakI-001 - Latest backup (the second most recent version of the model file)
 l Model File.bakI-002 - Older backup
 l Model File.bakI-003 - Oldest backup
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If you need to revert to a Backup File and convert it back into a standalone model, add the exten-
sion .imp to the Backup File (the file name should now appear as Model File.bakI-001.imp), and 
open the file in Impulse. From there you can re-save the file or overwrite your existing model file.

The model file can be saved periodically by enabling the checkbox for Automatically Save Model 
and specifying a frequency in the dropdown box.

Create Recovery File

A Recovery File (*.Recv-IMP) is similar to a Backup File but is saved periodically at the specified 
interval. It allows the user to recover unsaved changes in the model file prior to the application 
crashing or closing abnormally. The Recovery File is written to the same location as the model 
file, and each time the specified interval passes it will be overwritten to contain the most recent 
state of the model. If the application is closed normally the Recovery File will be deleted. A 
Recovery File can only be generated for existing model files that are opened.

If a Recovery File exists, the next time the model file is opened a prompt will be shown asking if 
you want to use the Recovery File:

"A recovery file for this model was found which may indicate that the application closed unex-
pectedly. Would you like to open this recovery file?"

 l Yes - This will copy the previously saved model file to a new file with "(Original)" appen-
ded to the front, and the Recovery File containing the latest unsaved changes will be 
opened.

 l No - The Recovery File will be deleted, and the previously saved model file will be 
opened. This will open the model file in its last saved state, which may not include the 
latest unsaved changes if any are stored in the Recovery File.

Encoding

The File Encoding option can be set to "Unicode" in order to use characters outside of the stand-
ard English keyboard such as diacritics, cyrillic, etc for text fields such as the pipe/junction name, 
notes, etc.

Related Topics

User Options Overview 562
Unit System 563
Workspace 565
Parameters 568
Waterhammer 571

Waterhammer
The Waterhammer section of the User Options window allows you to:
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 l Require a check of the Waterhammer Assistant before running models
 l Specify how AFT Impulse handles the situation where transient data for a junction does 

not go to the end of the transient simulation. Impulse can either use the last data point in 
the table or extrapolate using the last two data points. Using the last data point is the 
default option.

 l Define if transient cavitation should be based on stagnation (recommended) or static pres-
sure

 l Enable or disable the Variable G feature for use in the Environmental Properties panel. By 
default this option is disabled. 

Related Topics

User Options Overview 562
Unit System 563
Workspace 565
Parameters 568
Files 570
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File Import and Export
This section focuses on the various file types that can be imported and exported from AFT 
Impulse. Topics included discuss importing piping layouts from various sources, importing and 
exporting between AFT products, and importing and exporting data with Excel.

Contents

Importing Piping Component Files 573

Importing GIS Shapefiles 578

Importing Caesar II Netral Files 580

Importing and Exporting EPANET Files 583

Importing and Exporting from Other AFT Products 587

Exporting to Excel 588

Importing From Excel 594

Related Blogs

Meet the Import Piping Layout Wizard

Now it’s Super Easy! Changing Input Data in AFT Models using Excel Change Data

That was EASY! Quickly Change Pipe and Junction Input Data into AFT models using Excel 
Change Data

Importing Piping Component Files
AFT Impulse includes the ability to import Piping Component Files (.pcf), which can be gen-
erated by a wide range of software, and provide a quick way to get started with the hydraulic mod-
eling portion of a project. Files can be imported into existing models.

Selecting File > Import Piping Layout From > Piping Component File (.pcf) brings up the Import 
Piping Layout Wizard in the Quick Access Panel, as shown below in Figure 1.
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Figure 1: Piping Component File Import

The Import Piping Layout Wizard is organized into sections that help guide the import process:

 l Folder Browser - After browsing to a folder, all .pcf files within the folder will be listed 
here. Simply clicking a file in the list will show a preview of the import in the Workspace. 
The location of the preview can be moved by dragging the icon in the upper-left of the 
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selection area. 
 l Object List - When a file is selected, the objects to be created will be listed here. Each 

individual object can be reassigned to a certain Junction, if the automatic assignment is 
not correct. For example, the originating software may have only had a "valve" while this 
could be a Relief Valve or a Control Valve. Changing the AFT Object type will change the 
preview in the Workspace. Right-clicking on an object shows a menu for converting object 
types.

 l Property Window - This button opens an additional panel that shows the raw prop-
erties for the currently selected object.

 l Link Materials - Opens the File Object Link window, where groups of pipes from 
the .pcf file can be associated with a pipe material, size, and type in the AFT Pipe 
Material library. Pipes can be grouped by file schedules (i.e. item codes) or dia-
meters, and are sorted by length within each group. The selection from the AFT 
Pipe Material library will overwrite any diameter information from the .pcf file. Selec-
tions made for a .pcf material will be applied to all pipes that reference that .pcf 
material. Pipes associated with each material can be seen by clicking the arrow on 
the left expand the group (Figure 2) and can be edited individually or as a group.

 l Show Ignored Objects - Certain types of objects are ignored on import - these 
can be objects such as flanges, or additional file components such as materials or 
bolt specifications.

 l Options
 l Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and 

longest pipe in the list of pipes to be imported.
 l Ignore Pipes of Length Less Than - Do not import pipes shorter than this 

amount.
 l Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this dia-

meter.
 l Ignored Pipes - How many pipes will be ignored based on the above settings. 

Ignoring pipes can be helpful in keeping a model clean and free of unnecessary 
components. For example, a pipe stress software may require many short pipe 
segments in between welds or flanges. However, these types of connections are 
almost always ignored for hydraulic analysis. By ignoring short pipes, the amount 
of "import clean up" required can be reduced.

 l Preferred Scale - The wizard will Auto Scale the import by default. If a different 
scale is desired, this option can be disabled and a custom scale entered.

 l Show Pipes in Preview - Display the pipes in the Workspace preview.
 l Show Junctions in Preview - Display the junctions in the Workspace preview.
 l Combine Pipes When Possible - It is required that all pipes in the Workspace be 

connected by two junctions. However, this is not a requirement in all software. 
Therefore, some .pcf files may be generated with several pipes "end to end." If the 
pipes were imported this way, either junctions would need to be added, or the 
pipes would need to be manually combined, before the model could be solved.

 l Import Bends as Pipes - Pipe bends can be imported as junctions, or as a visual 
change in direction of the pipe. Importing bends as pipes is identical to using 
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segments with assigned fittings and losses to show piping layout. To account for 
losses, bends will be matched to smooth flanged bends in the AFT Internal Fittings 
& Losses Library if an exact match for angle and r/D ratio is available and assigned 
to the pipe automatically. Losses that are not assigned automatically can be set up 
manually using junctions or fittings & losses. This option is helpful to reduce unne-
cessary model clutter and input if bend losses are negligible.

Note: In most cases, it is recommended to import bends as bends rather than pipes. Bends 
imported as bends will always use smooth bends with r/D and/or angle imported from 
the .pcf file and basis area inherited from the upstream pipe.

 l Ignore Fitting Lengths - Neglects additional length added to pipes that accounts 
for the equivalent length of fittings and losses, and is not actually part of the phys-
ical pipe length.

 l Import Data to Pipe or Junction Notes Field - Add the raw data from the ori-
ginating file to the Notes tab of the corresponding object.

Figure 2: File Object Link window for Piping Component File Import

General Recommendations

Importing piping layouts from external file types such as Piping Component Files is intended to 
save time by allowing a means to quickly achieve a foundational layout. A .pcf file does not 
provide all information needed to create a working hydraulic model of a system and the import 
process will not produce a completed model or a perfectly accurate representation of the .pcf 
model. There will be missing data that must be assigned prior to analysis, such as fluid prop-
erties and boundary conditions. However, there are import practices and preparations that can 
be made to the .pcf file that will make creating model from an imported piping layout go more 
smoothly.

 l Workspace - Piping Component Files are a three-dimensional file format, whereas model 
layouts in the AFT Workspace are a two-dimensional representation of a system. 
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Because the Workspace is a purely visual tool  independent of actual system dimensions, 
the Scale/Flip Workspace feature can be useful for achieving a readable model when 
working with imported piping layouts.

 l Object Positioning - It is recommended to have some distance between most objects 
(this is not relevant to welds, branch/tap connections, gaskets, and supports). This aids in 
pipe connections, as objects that are very close together may have trouble connecting 
automatically. This is especially true of non-isometric models. Spacing between objects 
also streamlines the process of scaling objects on the Workspace after import.

 l Bends - By default, Import Bends as Pipes is unchecked, and importing bends as bends 
is recommended for the sake of model readability and a more flexible approach to incor-
porating bend losses. Bends that have common angles and r/D ratios present in the 
internal AFT library can be imported as Fittings & Losses automatically when importing 
bends as pipes, but other bends will need to be added manually as junctions, or have their 
losses specified using the Additional K Factor option in the Pipe Fittings & Losses window 
or as user-specified fittings & losses using the Fittings & Losses Library. When bends are 
imported as bends, they will be treated as smooth bends, the upstream pipe determines 
the cross-sectional flow area, and the r/D ratio and/or angle is imported from the Piping 
Component File. If only the r/D ratio or angle is specified, the other parameter will be cal-
culated using the endpoint coordinates.

Note: Bends modeled explicitly can be joined with adjacent pipes as using Join Pipes/Junc-
tions later if desired. Modeling bends as explicit junctions is advised for models con-
taining bends that are not smooth flanged or have an uncommon angle or r/D ratio. In 
Impulse, it is usually best to model bends explicitly to capture their interactions with 
waves, and it's always advised when calculating forces between elbow pairs.

 l Pipes - While the AFT Pipe Material Library contains many piping materials specified by 
ASME and ANSI, the Piping Component File format does not always contain these mater-
ials and  material attributes can be defined within .pcf files in a number of drastically dif-
ferent ways. Because of this, materials, nominal sizes and schedules are not assigned 
automatically and can be assigned using Link Materials (shown above in Figure 2). Pipes 
can be grouped by file schedules (i.e. item codes) if they exist or by diameter so that pipe 
size and material can be applied to a group of pipes quickly. Pipe inner diameter is 
assigned from the nominal diameter defined in the pipe's coordinates within the .pcf file as 
a starting point, but any sizes assigned in Link Materials will override these inner dia-
meters within the AFT model. Alternatively, pipes can be defined after import using Global 
Pipe Edit.
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Related Blogs

Meet the Import Piping Layout Wizard

Importing GIS Shapefiles

Import GIS Shapefile

GIS Shapefiles that adhere to the ESRI standard can be imported into Impulse for ease of model 
creation. These files have the extension .shp, but there are two other supporting file types that 
need to be in the same folder as the .shp in order for the import to work correctly. These are .shx 
and .dbf file types. The option is located under File > Import Piping Layout From > GIS Shapefile 
(.shp). This opens the "Import Piping Layout Wizard" in the Quick Access Panel that allows the 
importing of one line .shp that is of pipes and multiple point .shp files for branches, valves, 
pumps, and reservoirs. Once the .shp files have been added to this window the object type, scal-
ing, and mapping can be selected. 

Type

Any .shp files that are of lines are automatically set to the object type of "Pipes". Only one .shp 
file containing lines can be imported at a time. Any .shp file that is of points can be set to 
Branches, Valves, Pumps, or Reservoirs.

Scaling

Scaling only applies when no length is mapped to the AFT "length" field or when no length data 
exists in the shapefile. Scaling does not alter the Workpace layout or visual length of the pipe. It 
only adjusts the pipe length property that is calculated by the coordinates being imported from 
the shapefile.

The default scaling is 1 grid point to 1 foot. This can be adjusted by selecting the "..." button in the 
Scaling column. This button opens a new window in which a new scale is applied to the auto-
matic calculation of the pipe length property. This window does not change the visual length of 
the pipe drawn on the workspace. This window also allows the viewing of the coordinates of spe-
cific points and parts of different shapes within the shapefile.

Mapping

The Data Mapping window allows the user to select what data fields have relevant data for 
Impulse to import. 
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 l Pipes can map:
 l Labels - Names
 l Length - Mapping this field will utilize included user shapefile data and override the 

automatic calculation of pipe length. The scaling window settings will have no 
effect when this field is mapped.

 l Friction - Absolute Roughness, Relative Roughness, Hazen-Willams Factor, Expli-
cit Friction Factor, Weymouth, and Panhandle friction models are available.

 l Inner Diameter
 l Branches can map:

 l Labels - Names
 l Elevation

 l Pumps can map:
 l Labels - Names
 l Elevation
 l Assigned Flow - Imports as a Fixed Flowrate pump

 l Reservoirs can map:
 l Labels - Names
 l Elevation - To the base of the reservoir
 l Liquid Elevation - Height from base to liquid surface elevation. Liquid elevation 

and elevation are summed and input as liquid surface elevation in the generate 
reservoir junctions.

 l Valves can map:        
 l Labels - Names
 l Elevation

Related Topics

File Import and Export 573
Importing Piping Component Files 573
Importing Caesar II Netral Files 580
Importing and Exporting EPANET Files 583
Importing and Exporting from Other AFT Products 587
Importing From Excel 594
Exporting to Excel 588

Related Blogs

Meet the Import Piping Layout Wizard

- 579 -

https://www.aft.com/support/product-tips/meet-the-piping-layout-wizard


Interface and User Options

Importing Caesar II Netral Files
AFT Impulse includes the ability to import CAESAR II Neutral Files (.cii), providing a quick way to 
get started with the hydraulic modeling portion of a project. Files can be imported into existing 
models.

Selecting File > Import Piping Layout From > CAESAR II Neutral File (.cii) brings up the Import 
Piping Layout Wizard in the Quick Access Panel, as shown below in Figure 1.

The Import Piping Layout Wizard is organized into sections that help guide the import process:

 l Folder Browser - After browsing to a folder, all .cii files within the folder will be listed 
here. Simply clicking a file in the list will show a preview of the import in the Workspace. 
The location of the preview can be moved by dragging the icon in the upper-left of the 
selection area. 

 l Object List - When a file is selected, the objects to be created will be listed here. Each 
individual object can be reassigned to a certain Junction, if the automatic assignment is 
not correct. For example, the originating software may have only had a "valve" while this 
could be a Relief Valve or a Control Valve. Changing the AFT Object type will change the 
preview in the Workspace. Right-clicking on an object shows a menu for converting object 
types.

 l  Property Window -This button opens an additional panel that shows the raw 
properties for the currently selected object.

 l Link Materials - Opens the File Object Link window, where the pipes can be asso-
ciated with a pipe material, size, and type in the AFT Pipe Material library. The 
selection from the AFT Pipe Material library will overwrite any diameter information 
from the CII file, and will be applied to all of the pipes. Pipes are grouped by dia-
meter by default and can also be grouped by schedule.

 l Show Ignored Objects - Certain types of objects are ignored on import - these 
can be objects such as flanges, or additional file components such as materials or 
bolt specifications.

 l Options
 l Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and 

longest pipe in the list of pipes to be imported.
 l Ignore Pipes of Length Less Than - Do not import pipes shorter than this 

amount.
 l Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this dia-

meter.
 l Ignored Pipes - How many pipes will be ignored based on the above settings. 

Ignoring pipes can be helpful in keeping a model clean and free of unnecessary 
components. For example, a pipe stress software may require many short pipe 
segments in between welds or flanges. However, these types of connections are 
almost always ignored for hydraulic analysis. By ignoring short pipes, the amount 
of "import clean up" required can be reduced.

 l Preferred Scale - The wizard will Auto Scale the import by default. If a different 
scale is desired, this option can be disabled and a custom scale entered.

 l Show Pipes in Preview - Display the pipes in the Workspace preview.
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 l Show Junctions in Preview - Display the junctions in the Workspace preview.
 l Show Labels In Preview - Show the corresponding label from the .cii file in the 

Workspace preview. This is only shown in the preview and will not be imported into 
the model itself.

 l Combine Pipes When Possible - It is required that all pipes in the Workspace be 
connected by two junctions. However, this is not a requirement in all software. 
Therefore, some .cii files may be generated with several pipes "end to end." If the 
pipes were imported this way, either junctions would need to be added, or the 
pipes would need to be manually combined, before the model could be solved.

 l Import Bends as Pipes - Pipe bends can be considered as junctions or simply a 
visual change in direction of the pipe. This is identical to using segments to show 
piping layout. Note that these bends are visual only and have no losses associated 
with them - to account for losses, either junctions or fittings & losses must be used. 
This option is helpful to reduce unnecessary model clutter.

 l Ignore Fitting Lengths - Neglects additional length added to pipes that accounts 
for the equivalent length of fittings and losses, and is not actually part of the phys-
ical pipe length.

 l Import Data to Pipe or Junction Notes Field - Add the raw data from the ori-
ginating file to the Notes tab of the corresponding object.
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Figure 1: CAESAR II Neutral File Import
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Importing and Exporting EPANET Files
AFT Impulse includes the ability to import and export EPANET Files (*.INP). EPANET is public 
domain modeling software developed by the US Environmental Protection Agency. Many dif-
ferent applications support the file format, so it can therefore provide a quick way to get started 
with the hydraulic modeling portion of a project.

Import Piping Layout Wizard

Selecting File > Import Piping Layout From > EPANET File (.inp) brings up the Import Piping Lay-
out Wizard in the Quick Access Panel, as shown below in Figure 1. Note that importing from 
EPANET requires that the Workspace be empty.    

Selecting File > Export Piping Layout To  > EPANET File (.inp) brings up the EPANET Export win-
dow, as shown below in Figure 2. 

The Import Piping Layout Wizard is organized into sections that help guide the import process:

 l Folder Browser - After browsing to a folder, all .inp files within the folder will be listed 
here. Simply clicking a file in the list will show a preview of the import in the Workspace. 
The location of the preview can be moved by dragging the icon in the upper-left of the 
selection area. 

 l Object List - When a file is selected, the objects to be created will be listed here. Each 
individual object can be reassigned to a certain Junction, if the automatic assignment is 
not correct. For example, the originating software may have only had a "valve" while this 
could be a Relief Valve or a Control Valve. Changing the AFT Object type will change the 
preview in the Workspace. Clicking on an object in the workspace highlights it in the wiz-
ard.

 l Property Window - This button opens an additional panel that shows the raw prop-
erties for the currently selected object.

 l Link Materials - Opens the File Object Link window, where the pipes can be asso-
ciated with a pipe material, size, and type in the AFT Pipe Material library. The 
selection from the AFT Pipe Material library will overwrite any diameter information 
from the EPANET file, and will be applied to all of the pipes.

 l Options
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 l Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and 
longest pipe in the list of pipes to be imported.

 l Ignore Pipes of Length Less Than - Do not import pipes shorter than this 
amount.

 l Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this dia-
meter.

 l Ignored Pipes - How many pipes will be ignored based on the above settings. 
Ignoring pipes can be helpful in keeping a model clean and free of unnecessary 
components. For example, a pipe stress software may require many short pipe 
segments in between welds or flanges. However, these types of connections are 
almost always ignored for hydraulic analysis. By ignoring short pipes, the amount 
of "import clean up" required can be reduced.

 l Preferred Scale - The wizard will Auto Scale the import by default. If a different 
scale is desired, this option can be disabled and a custom scale entered.

 l Show Pipes in Preview - Display the pipes in the Workspace preview.
 l Show Junctions in Preview - Display the junctions in the Workspace preview.
 l Import Data to Notes Field - Add the raw data from the originating file to the 

Notes tab of the corresponding object.
 l Auto-Zoom Preview - This option can be enabled to automatically zoom out so 

that the whole model can be seen in the workspace, which can be convenient for 
large systems.
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Figure 1: Import Piping Layout Wizard for EPANET files
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Pipes and Junctions

All pipes and junctions get imported with user-specified names from EPANET. All junctions 
below that have flow, elevation, length or other parameters will be imported with the same units if 
possible.

 l Pumps - The available points on the pump curve are imported into the pump data and 
used with the curve fit type set to interpolated X-Y data. If desired, polynomial curve fits 
can be set up within pump configuration using this data after the import process is com-
plete.

Note: If only one or two data points exist for the pump curve, the curve will still need to be 
user-specified.

 l Tanks - Finite-volume tanks will imported as reservoirs with a tank model of Finite Open 
Tank.

 l Reservoirs - EPANET reservoirs are imported as a reservoir with a surface pressure of 1 
atm with liquid elevation imported from EPANET.

 l Pipes - These will use roughness, length, and inner diameter from EPANET model.
 l Junctions - (Just called Junctions in EPANET) 

 l If one connecting pipe - If it has a demand, it becomes an Assigned Flow with rel-
evant inflow/outflow. Otherwise, it becomes a dead end.

 l If multiple connecting pipes - If it has a demand, it becomes a branch using the 
Flow Source or Sink optional property with the relevant inflow/outflow imported 
from the EPANET junction demand. Otherwise, it is imported as a normal branch.

 l Valves - The K factor of a valve is assigned with the value specified in the EPANET 
model. Valves can be imported as normal valves, control valves, relief valves, or check 
valves depending on how they are defined within EPANET:

 l Normal valves come from GPV and TCV in EPANET.
 l Control valves come from FCV, PBV, and PSV in EPANET.
 l Relief valves come from PRV in EPANET.
 l Check valves come from CV in EPANET.

 l Heat Exchangers - While Heat Exchangers are not an explicitly defined object type in 
EPANET, EPANET junctions with "Heat Exchanger" in their user-defined name are impor-
ted as Heat Exchangers in AFT software.

 l Emitters - Emitters in EPANET are defined as a junction with a base demand and an emit-
ter coefficient. These are imported as Spray Discharge junctions with the emitter coef-
ficient imported as a K Fire Sprinkler value with the flow units defined by the base demand 
units and the pressure component defined by the emitter coefficient units (e.g. flow unit 
per square root of psi in EPANET). The number of sprinklers per emitter are set to 1 and 
the exit pressure is set to the atmospheric pressure (zero gauge pressure). The correct 
atmospheric pressure for the imported system should be set in Environmental Settings in 
Analysis Setup.
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Exporting EPANET Files

AFT models can be exported to an EPANET file by using the File -> Export Piping Layout To -> 
EPANET File (.inp)... option from the Workspace window. The EPANET Export window shown in 
Figure 2 below allows the user to specify the desired destination to export the file to.

Figure 2: EPANET Export Dialog
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Importing and Exporting from Other AFT Products
Models made in other AFT products such as AFT Fathom can be opened directly in AFT Impulse 
and vice versa. This can be a useful starting point when it is desired to perform additional ana-
lysis on a model that has already been built in another AFT product, such as if it is desired to per-
form transient analysis for a model originally built in Fathom.

To convert a model from one AFT product to another just browse to the model you would like to 
convert and open it in the software you are converting the model to. This can be done by chan-
ging the file extension selected, as is shown below in Figure 1. Note that though AFT Arrow and 
AFT xStream are not explicitly listed, models from Arrow and xStream can also be converted by 
selecting "All" and browsing to the model file.
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When the model is opened in AFT Impulse a backup copy of the original model will be created 
from which the original model can be restored if needed. See the Backup Settings explanation 
for more information on backup files.

The conversion process will automatically change junction types not included in AFT Impulse to 
either a General Component or Branch junction. In addition, Impulse will provide the option to 
merge junctions with static losses into the connected pipes using the Join Pipes/Junctions fea-
ture. Combining pipes when a model is imported to Impulse typically results in a small decrease 
in accuracy for a large decrease in run time, as is discussed here.

Be aware that some features available for use in other AFT products are not available for use in 
AFT Impulse. If a junction is defined using a feature not available in AFT Impulse, the non-applic-
able information will be removed, and the user may be required to input additional information to 
fully define the model. It is advised to fully review the model after import.

Figure 1: File extensions options for Open File window
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Exporting to Excel
AFT Impulse includes a powerful ability to export any Output data to any specific cell(s) in an 
Excel spreadsheet. Specific values from the model can be exported, as well as columns, rows, 
or entire output tables as defined in Output Control. These items are controlled with the Excel 
Export Manager, available from the File menu.
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Figure 1: The Excel Export Manager

Adding Items to the Excel Export Manager

Data from the Output can be added to the Excel Export by clicking New, or by selecting an exist-
ing item and clicking Duplicate. Items can also be created directly from the Output Window by 
right-clicking on a cell or header.

Figure 2: Adding items directly from the Output

Each row in the Excel Export Manager corresponds to a cell, column, row, or table of data to be 
added to the spreadsheet. Each column helps define what data will be transferred where. The 
grid below the entries shows a preview of where the data will be added to help prevent inter-
secting data by showing where there are overlapping regions. Note that graph items can vary in 
size and do not show a complete region here.

 l Apply to Export - Items can be optionally included or excluded from the export.
 l Export Type - What type of data is being exported. This affects other settings, and will 

affect how much room is required on the target Excel sheet.
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 l Single Value - The value of a single parameter for a single pipe or junction object.
 l Column - Values of a single parameter for all of the displayed objects.
 l Row - Values of all displayed parameters for a single object.
 l Table - Values of all displayed parameters for all displayed objects.
 l Graph - The graph points from a specified Graph List Item.
 l Other - Additional information not available in a standard Output table, such as 

Fluid definition, Model Title, or Scenario Names.
 l Source - Where the data is coming from.

 l Pipe - From the steady-state Pipe section of the output.
 l Junction - From the Junction section of the output.
 l General Output Summary - From one of the available output Summary sections. 

For example, if there is a pump junction in the model, Pump Summary is available.
 l Transient Max/Min - From the Transient Max/Min tab in the Pipes section of the 

output.
 l Forces - 
 l Graph - From a specified Graph List Item.

 l Object - The object in particular that is desired. If Column or Table are selected for Export 
Type, this selection will be fixed to ALL.

 l Parameter - The parameter in particular that is desired. If Row, Table or Graph are selec-
ted for Export Type, this selection will be fixed to ALL.

 l Units - The units of the exported value. This is available only for Single Value and Column 
Export Types. Some parameters do not have units and this will display N/A.

 l Excel Sheet - Which Excel Sheet to export to. This value can be edited by the user - if it is 
desired to export to a named sheet this can be entered here.

 l Excel Starting Cell - The upper-left cell to export the data to.
 l Excel Ending Cell - The automatically calculated lower-right cell of the data, which 

depends on the Export Type, export options, and the number of parameters or objects in 
the model. It is important to recognize that the Excel Starting Cells can be defined in a 
way that data gets overwritten. The Ending Cell column is a handy reference to help 
avoid this.

 l Header - Optionally export the name of the Parameter(s) related to the item.
 l Units - Optionally export the name of the Unit(s) related to the item.
 l Add Excel Comments - Optionally adds an Excel comment to the value cell that con-

tains the Parameter name and unit.
 l Show Example - Displays an example of how the exported cells will appear.
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Figure 3: Example Export

Figure 4: Result of the above example. Color added for emphasis.

Excel Export Location

After all of the desired data has been added to the Excel Export Manager, the next step is to actu-
ally export the data. There are three options available for the export:

 l Create New Workbook - A new Excel Workbook will be opened with the exported data.
 l Previously Saved Workbook - Browse to a Workbook saved to file. The Workbook will 

be opened and the modifications made to the sheets as specified.
 l Currently Opened Workbook - Select a Workbook that is currently open in Excel. The 

already open Workbook will be modified.

Note: The Excel Export Manager does not save Excel files for non-batch run exports. Any 
changes made need to be manually saved by the user in Excel.

There are two options available for exporting:

 l Clear Sheet Data - All of the existing data on the sheets specified in the Excel Sheet 
column will be cleared. This is especially useful for setting up a new export when many 
changes are being made.

 l Automatically Export After Running Model - After the model is run, the Export will be 
carried out automatically, per the settings defined by the user in the Excel Export Man-
ager.
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Advanced Options

Items can be added directly from the Output instead of adding custom items with the New button. 
There are two behavioral options that can be modified for this action:

 l Open Excel Export Manager - If enabled, the Excel Export Manager will be opened 
every time an item is added from the Output. This is useful for double checking the 

 l For Existing Items -
 l Add New Item - The item selected will be added to the Excel Export Manager 

even if it already exists.
 l Select Existing - If the item already exists, do not add a duplicate item and 

instead select the existing item.
 l Ask - If the item already exists, prompt the user on the action to take.

 l Create an Export Guide - When exporting, an Export Guide can optionally be included 
in the export. The Export Guide contains information about the model and the generation 
of the export, to help keep the connection between the data and the model clear for future 
reference.

Exporting Data From Multiple Scenarios

The Excel Export Manager can be employed with Batch Runs with a couple of important dis-
tinctions.

First, if multiple sheets are specified in the Excel Export Manager, the only way to export multiple 
scenarios is to export every scenario to its own Workbook. To keep data from multiple scen-
arios in one Workbook, there can only be one sheet specified in the Excel Export Manager.

Second, the Excel File will be saved after each scenario. In normal single-scenario exports 
the file is never saved, but in batch mode it is required.

In the Batch Run tool, users are also able to use Excel Export without having to run the scenarios 
again. Note that if any of the scenarios in the Batch Run do not have output, the batch Export 
Only will not export any data for that scenario, as it will not run those scenarios to get output. 

- 592 -



File Import and Export

Figure 5: Saving Results From Multiple Scenarios
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Importing From Excel
A Microsoft Excel spreadsheet can be used to make changes to objects in an AFT Impulse 
model. The values in the Excel file are located in specific locations as described in the Setting Up 
Excel section.             

Setting Up Excel             

When reading an Excel file, AFT Impulse will search for a worksheet named AFT Transfer. 
There can be other worksheets in the workbook but Impulse will only look for a sheet with this 
name. The file structure looks like the following:             

The changes are entered on a worksheet named "AFT Transfer". There can be other worksheets 
in the workbook but Impulse will only look for a sheet with this name. The first data is entered in 
cell B2. Column A and row 1 are not read and are available for user comments. The file structure 
looks like the following:             

Figure 1: Sample AFT Transfer Excel Sheet                 

Row 1 and column A are not read by AFT Impulse - these cells can have any value in them, 
though it is recommended to enter the values above for the header row.             

Each column has certain accepted values, which can depend on the values in neighboring 
columns.             

Note: A template spreadsheet containing validation rules for the required layout is included in 
the AFT Impulse installation, or can be downloaded here. By default the file path is: 
C:\AFT Products\AFT Impulse\AFT Impulse Excel Import Workbook.xlsx.           

Apply Column             

This column accepts Yes or No. Only changes marked as Yes will be imported into the model.             

Object Type             

This column must be a junction name or Pipe. Valid choices can be seen below in Table 1.             
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Object Number             

This corresponds to the junction or pipe number of the object being changed.             

Parameter             

The specific parameter to be changed. These parameters vary based on the Object Name selec-
ted. Each parameter has a type (C/S/I) associated with it, as is explained in the next section.             

- 595 -



Interface and User Options

Table 1 - Object Types, Associated Parameters, and Change Codes                 

   Pipe

S Additional 
K Factor

S Design 
Factor - Pipe 
Fittings & 
Losses

S Design 
Factor - Pipe 
Friction

S  ID Reduc-
tion (Scaling)

S Initial Flow 
Guess

S Inner Dia-
meter (for 
unspecified, 
cylindirical 
pipes)

S Length

S Modulus of 
Elasticity (for 
unspecified, 
cylindrical 
pipes)

I Nominal 
Size Incre-
ment

C Nominal 
Size Set 
(must match 
text in Pipe 
Property Win-
dow)

C Nominal 
Type Set 
(must match 
text in Pipe 
Property Win-

   Area 
Change

S Design 
Factor

S Initial Guess 
Pressure

S Inlet Elev-
ation

C Junction 
Name

S Outlet Elev-
ation

S User Spe-
cified K

   Assigned 
Flow

S  Design 
Factor

S  Elevation

S  Flow Rate

S  Flow Tem-
perature

S  Initial 
Guess Pres-
sure

C  Junction 
Name

I  Special 
Condition

   Assigned 
Pressure

S  Design 
Factor

S  Elevation

C  Junction 
Name

S  Pressure

   Bend

S  Design 
Factor

S  Initial Guess 
Pressure

S  Inlet Elev-
ation

C  Junction 
Name

S  Loss Model

S  Outlet Elev-
ation

I  Special 
Condition

S User Spe-
cified K
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dow)

C Pipe Name

S Poisson 
Ratio

S Roughness 
Value

I Special 
Condition

S User Spe-
cified 
Wavespeed

S Wall Thick-
ness (for 
unspecified, 
cylindrical 
pipes)

   Branch

S Design 
Factor

S Initial 
Guess Pres-
sure

S Inlet Elev-
ation

C Junction 
Name

S Outlet Elev-
ation

S 
Source/Sink 
Flow

   Check 
Valve

S  Decel-
eration Cal-
culation 
Interval (Estim-
ated Fluid 
Velocity)

S  Delta Pres-
sure/Head to 
Reopen (User 
Specified)

S  Design 
Factor

S  Disk/Plug 
Area (Force 
Balance)

S  Disk/Plug 
Submerged 
Weight (Force 
Balance)

S  Disk 
Distance to 
CG (Force Bal-
ance)

   Control 
Valve

S  Design 
Factor

S  Initial 
Guess Pres-
sure

S  Inlet Elev-
ation

C  Junction 
Name

S  Loss When 
Fully Open

S  Outlet Elev-
ation

S Setpoint

I  Special 
Condition

   Dead End

S  Initial Guess 
Pressure

S  Elevation

C  Junction 
Name

   General 
Component

S  Design 
Factor

S  Initial Guess 
Pressure

S  Inlet Elev-
ation

C  Junction 
Name

S  K Factor

S  Outlet Elev-
ation

I  Special 
Condition

- 597 -



Interface and User Options

S Disk Inertia 
(Force Bal-
ance)

S  Forward 
Velocity to 
Close Valve 
(User Spe-
cified)

S  Full Open 
Loss Value

S  Initial Guess 
Pressure

S  Inlet Elev-
ation

C  Junction 
Name

S  Min Velocity 
Required to 
Fully Open 
(Vo) (Estim-
ated Fluid 
Velocity)

S  Outlet Elev-
ation

S  Plug Max 
Travel Length 
(Force Bal-
ance)

I  Special 
Condition

S  Spring Con-
stant (Force 
Balance)

S  Spring 
Force with 
Valve Closed 
(Force Bal-
ance, Trans-
lating)

S  Spring 
Torque with 

- 598 -



File Import and Export

Valve Closed 
(Force Bal-
ance, Spring)

   Gas Accu-
mulator

S  Design 
Factor

S  Initial Gas 
Volume

S  Initial 
Guess Pres-
sure

S  Junction 
Elevation

C  Junction 
Name

S Maximum 
Gas Volume

S Minimum 
Gas Volume

S  Polytropic 
Constant in 
Transient

S Precharge 
Gas Pres-
sure

S Precharge 
Gas Tem-
perature

S Precharge 
Gas Volume

I  Special 
Condition

S Tank Dia-
meter

S Tank 
Height

S Tank 
Length

   Liquid Accu-
mulator

S  Elasticity

S  Elevation

S  Initial Guess 
Pressure

S  Initial 
Volume

C  Junction 
Name

I  Special 
Condition

   Orifice

S  Area/Dia-
meter

S  Design 
Factor 

S  Exit Pres-
sure

S  Initial 
Guess Pres-
sure

S  Inlet Elev-
ation

C  Junction 
Name

S  Loss Value

S  Outlet Elev-
ation

   Pump

S  Control Set-
point

S  Delta Pres-
sure to Re-
Open Com-
bined Check 
Valve

S  Design 
Factor 

S  Fixed Speed 
(%)

S  Forward Velo-
city to Close 
Combined 
Check Valve

S  Initial Guess 
Pressure

S  Inlet Elev-
ation

C  Junction 
Name

I  Number of 
Heads (pos-
itive dis-
placement)

S  Operating 
Speed (pos-
itive dis-
placement)

S  Outlet Elev-
ation

S  Rated Pump 
Speed (rpm)

I  Special Condi-
tion

   Relief Valve

S  Blowdown 
Pressure

S  Design 
Factor

S  Exit Pres-
sure/Head

S  Initial Guess 
Pressure

S  Initial Elev-
ation

C  Junction 
Name

S  Loss Value

S  Outlet Elev-
ation

S  Remote 
High Pressure

S  Remote Low 
Pressure

S  Set Pres-
sure

I  Special 
Condition
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S Tank 
Volume

S Steady/Aver-
age Flow Rate 
(positive dis-
placement)

S  Submerged 
Suction Pres-
sure

S Trimmed 
Impeller Ratio 
as Percent

   Reservoir

S Cross-sec-
tional Area

S  Design 
Factor

C  Junction 
Name

S  Liquid Sur-
face Elev-
ation

S  Liquid Sur-
face Pres-
sure

I  Surface 
Elevation 
Type

S  Tank Bot-
tom Elev-
ation

   Screen

S  Design 
Factor

S  Initial Guess 
Pressure

S  Inlet Elev-
ation

C  Junction 
Name

S K Factor

S  Outlet Elev-
ation

   Spray Dis-
charge

S  Design 
Factor

S  Discharge 
Flow Area

S  Elevation

S  Exit Pres-
sure

S  Initial 
Guess Pres-
sure

C  Junction 
Name

S  Loss Value

I  Number of 
Holes

I  Special 
Condition

   Surge Tank

S  Cross-Sec-
tional Area 

S  Initial Guess 
Pressure

C  Junction 
Name

I  Special Condi-
tion

S  Surface Pres-
sure

   Tee or Wye

S  Design 
Factor

S  Initial Guess 
Pressure

S  Elevation

C  Junction 
Name

   Turbine

S  Design 
Factor

S  Initial 
Guess Pres-
sure

S  Inlet Elev-
ation

C  Junction 

   Air Valve

S  Inlet Crack-
ing Pressure

S  Gas 
External Pres-
sure

S  Initial Gas 
Mass In Sys-
tem

   Valve

S  Design 
Factor 

S  Exit Pres-
sure

S  Initial 
Guess Pres-
sure

S  Inlet Elev-

   Venturi

S  Design 
Factor

S  Initial Guess 
Pressure

S  Inlet Elev-
ation

C  Junction 
Name

   Volume Bal-
ance

S  Initial Guess 
Pressure

S  Elevation

C Junction 
Name
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Name

S  Outlet Elev-
ation

I  Special 
Condition

S  Inter-
mediate Ori-
fice Activation 
Value

S  Elevation

S  Initial Guess 
Pressure

C  Junction 
Name

S  Outlet Elev-
ation

S  Full Open 
Orifice CdA 
Inflow

S  Full Open 
Orifice CdA 
Outflow

S  Full Open 
Orifice CdA 
Intermediate 
Outflow

I  Special 
Condition

ation

C  Junction 
Name

S  Open Per-
centage

S  Outlet Elev-
ation

I  Special 
Condition

S  Loss Value

S  Outlet Elev-
ation

   Weir

S  Channel 
Width

S  Down-
stream Bot-
tom 
Elevation

S  Down-
stream 
Cross-Sec-
tional Area

S  Initial 
Guess Pres-
sure

S  Inlet Elev-
ation
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C  Junction 
Name

S  Notch 
Width 

S  Outlet Elev-
ation

I  Special 
Condition

S  Surface 
Pressure

S  Upstream 
Bottom Elev-
ation

S  Upstream 
Cross-Sec-
tional Area

S  Height of 
Weir

I  Weir Type

Change Code             

Each Parameter has restrictions on how it can be changed. All of the Parameters are decimal 
numbers, integers, or strings.             

Table 2: Valid Change Codes for each type of Parameter                 

Decimal 
Number 
(S)

Integer 
Number (I)

String 
(C)

Set equal 
to value

Set equal 
to value

Set equal 
to value

Change by 
value (+/-)

Change by 
value (+/-)

Add 
string to 
list

Change by 
percent 
(+/-)

Delete 
string 
from list
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Value             

The actual value to change the Parameter to or by.             

For special conditions there are specific values assigned to each special condition option, as are 
listed in the table below.             
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Table 3: Values used to import special conditions                 

Junc-
tion

Special 
Condi-
tion

Val-
ue

Assigne-
d Flow

None

Closed

0

1

Check 
Valve

None

Closed

Open

0

1

2

Control 
Valve

None

Closed

Fully 
Open - 
No Con-
trol

0

1

2

Gas 
Accu-
mulator

None

Ignore 
Accu-
mulator

0

5

General 
Com-
ponent

None

Closed

0

1

Liquid 
Accu-
mulator

None

Ignore 
Accu-
mulator

0

5

Pump None

Pump 
Off No 
Flow

Pump 
Off With 
Flow 
Through

0

1

2

Relief 
Valve

None 0
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Junc-
tion

Special 
Condi-
tion

Val-
ue

Failed 
Open

Ignore 
Relief 
Valve

2

5

Surge 
Tank

None

Ignore 
Surge 
Tank

0

5

Spray 
Dis-
charge

None

Closed

0

1

Turbine None

Closed

0

1

Air Valve None

Ignore 
Air Valve

0

5

Valve None

Closed

0

1

Weir None

Ignore 
Weir

0

5

Scenario Path Name             

The Scenario that the changes are intended to apply to. If no scenario is present, the changes 
will be applied to the current scenario.             

It is important that the Scenario name is uniquely qualified - if there are multiple scenarios with 
the same name, the full Scenario Path Name can be used. Scenario Path Names can easily be 
copied from AFT Impulse by right-clicking the scenario name and selecting "Copy Scenario Path 
Name."             
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Importing the File             

When the sheet has been completely filled out, it can be imported from File -> Import Excel 
Change Data. When importing the data, the Object Change Log will appear, listing the changes 
that were made and any errors that occurred during the import.             
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Table 4: Excel Importing Error Messages                 

Error Description

Scenario name 
is not unique in 
the model (use 
full scenario path 
name)

There are mul-
tiple scenarios 
with this name. 
Use the fully qual-
ified path name 
(e.g. Base Scen-
ario\US Unit-
s\Pump A).

Invalid change 
type

The Change 
Code is not valid 
for the Para-
meter. For 
example, trying to 
change a string 
type with Change 
by Value (+/-).

Invalid para-
meter ID

The parameter 
given does not 
match the object 
type (e.g. Length 
for a junction).

Invalid para-
meter value

The value cannot 
be changed 
because the 
value is not valie. 
For example, a 
pump speed can-
not be negative.

Object not found A pipe or junction 
with the given ID 
was not found.

Parameter con-
flict

The value cannot 
be changed 
because it con-
flicts with another 
setting. For 
example, the loss 
value cannot be 
set when the junc-
tion is using a res-
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istance curve.

Scenario not 
found in the 
model

No scenario by 
the given name 
was found in the 
model.

Note: In order for the junction to accept the changes, some fields must already contain data. 
For example, if the control setpoint for a control valve is being changed, there must 
already be a setpoint and units entered into the control valve junction object. This is to 
ensure that the correct set of units are being used. These values can be set using 
Global Edit to an arbitrary value before the changes are made from Excel.             
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Design Alerts
Design Alerts are a powerful feature that can help speed up the modeling process and help verify 
that the model is behaving as expected. The creation of a Design Alert does not constrain or 
affect the operation of the model in any way. However, it automatically creates an output alert 
any time the design limit is violated. One common use case might be defining a maximum allow-
able pressure for the pipes in the model. While the output can be reviewed manually for these 
violations, this quickly becomes tedious as the model grows in size. Creating a Design Alert 
instead allows the engineer to spend less time reviewing output tables as any violation will be 
immediately identified. 

The Design Alert Manager allows the user to create or modify Design Alerts. It can be accessed 
from the Tools Menu or in the Design Alerts tab in pipe and junction properties windows.

Design Alerts can also be created directly from the output, or can be imported/exported for use in 
other models. 

Figure 1: Design Alert Manager

Creating and Applying Design Alerts

Click the green plus sign (New Design Alert) to add a new Design Alert to the model.

A Name, Object Type, and Parameter Type and Value can be specified. Depending on the 
Object Type, a different selection of Parameters are available, as shown below. To add a Para-
meter:
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 1. Give the Design Alert a distinct and descriptive name.
 2. Select the Object Type the alert will be applied to.
 3. Select the Parameter Type the alter will monitor.
 4. Specify a value, unit if applicable, and companion.

 1. Use >= when the value shouldn't rise above the specified value (i.e. temperature 
shouldn't exceed a maximum value)

 2. Use <= when the value shouldn't fall below the specified value (i.e. pressure 
shouldn't drop below a minimum value)

 5. Select which Objects from the Workspace the Design Alert will be applied to.
 6. Click "OK" to save changes.

Several Parameter limits can be added to one Design Alert. For example, an alert can be created 
that requires a pressure within a range by adding both the maximum and minimum pressure lim-
its.

To update a Parameter, simply create it again and click Add to List - the old value will be 
replaced with the new one.

Figure 2: Creating a Design Alert
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Figure 3: Available Design Alerts

When running the model, the selected object's output values will be checked against the con-
ditions that have been defined. If any of the Design Alert conditions are met, the user will receive 
a Design Alert warning and the violating parameters will be highlighted in the output tables. 
Design Alert warnings can be double-clicked to take you to that object in the Workspace.

Figure 4: Design Alert Violations in Output

Design Alerts can be cross-plotted in the Graph Results window vs. the actual results. One good 
example where this is useful is for cross-plots of maximum and minimum allowed operating pres-
sures.

Design alerts are visible in every scenario in a model, but can be turned off or on for specific 
scenarios. When creating a design alert for the first time it will be active in that scenario and all its 
child scenarios. For more information about scenarios, please read the Scenario Manager topic.
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Related Topics

Design Alerts From Output 612
Design Alert Importing And Exporting 613
Output Window 528

Design Alerts From Output
Right-clicking on a cell in the Output Window brings up a context menu. One of these options is 
Create Design Alert...

Figure 1: Output Context Menu

Create Design Alert automatically defines a Design Alert based on the selected value and quant-
ity:

Figure 2: Automatically defined Design Alert
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The Design Alert needs to have a name defined to be added. The specific value of the alert can 
be modified, and whether it is a maximum or minimum can be selected. The associated object is 
automatically selected as part of the Design Alert, but this is not required and additional objects 
can be selected now.

After the Design Alert has been created it can be further modified in the Design Alert Manager.

Related Topics

Design Alerts 609
Design Alert Importing And Exporting 613
Output Window 528

Design Alert Importing And Exporting
Design Alerts can be saved to a text file to be imported into other model files. This allows the 
user to quickly load commonly used design alerts into multiple model files.

Export a Design Alert

To export a Design Alert:

 1. Fully define a Design Alert for any parameter in the Design Alert Manager. For this 
example, we are using a velocity design alert.
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Figure 1: A design alert for velocity to be exported

 2. Select "Save All Alerts To File..." and give the file a descriptive name.

Import a Design Alert

 1. Open the Design Alert Manager from the Tools menu.
 2. Select "Load Alerts From File...", then browse to and select the saved design alert file.
 3. The Design Alert should now be added to the Existing Design Alerts list, and can be 

applied to objects in the model.

Related Topics

Design Alerts 609
Design Alerts From Output 612
Output Window 528
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Scenario Manager (in the Quick Access Panel) is a powerful tool for managing variations of a 
model, referred to as scenarios. It lets you to quickly test the same model with selected dif-
ferences (such as pump size, pipe diameter, system location, units, etc.) to find the system 
which works best. The Scenario Manager allows you to:

 l Create, name, and organize scenarios
 l Select the scenario to appear in the Workspace (the ‘current’ scenario)
 l Delete, copy, and rename scenarios
 l Duplicate scenarios and save them as separate models
 l Review the source of a scenario’s properties
 l Pass changes from a scenario to its variants
 l See what scenarios have output by automatically changing the text color to blue if they 

have output

All scenarios are saved within the model file.

Scenario

A variant case of a model that is created in the Scenario Manager.

Base Scenario

The Base Scenario is the root scenario at the top of the scenario tree. As the highest level 
ancestor, It does not inherit from any other scenario. A new scenario can be inserted above the 
base scenario, at which point the new scenario would behave as the base scenario, and the ori-
ginal base scenario would behave as a child scenario. "Base Scenario" is the default name given 
in a new, single scenario model.

The Scenario Manager

Illustrated in Figure 1, the top of the Scenario Manager displays the scenario tree, showing the 
names of the currently defined scenarios, their relationship to other scenarios, and which is the 
current Workspace scenario (the current scenario is identified both as the scenario with a green 
check mark next to it and in AFT Impulse's Status Bar). At the bottom, there is a place where you 
can record notes related to that scenario (propagates to children).

Those attributes whose value comes from a different scenario are linked, while those values 
coming from the selected scenario are not linked. Linked attributes will inherit changes made in 
the same object and attribute of the linked ancestor. This inheritance will occur over as many 
generations as the link exists.
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Figure 1: Scenario Manager on Quick Access Panel

Related Topics

Creating, Organizing, and Editing Scenarios 616
Scenario Inheritance 619
Running Models in Batch Mode 624
Open Model Using Last Scenario 625
Scenario Comparison Tool Overview 625

Creating, Organizing, and Editing Scenarios
Scenarios are referred to as either a parent or child, plus the Base Scenario, which may be 
thought of as the root scenario. Upon opening a new model file, only a Base Scenario will be 
present.  To create a new scenario below the Base Scenario, right-click the Base Scenario and 
select Create Child.

Any scenario can be made current by double-clicking on it.

Figure 1 illustrates a model with a Base Scenario with three children: "Two Pump Start", "One 
Pump Start", and "One Pump Start with One Running". Each of these have two children: "One 
Process Tank" and "Two Process Tanks", representing the different operating cases where the 
process fluid could be fed to either one or two storage tanks.
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Figure 1: Scenario Manager Window

The "Two Pump Start", "One Pump Start", and "One Pump Start with One Running" scenarios 
were created by first selecting the Base Scenario and clicking 'Create Child'. Each of the "One 
Process Tank" and "Two Process Tanks" scenarios were created by choosing 'Create Child' for 
each of the three different pump configuration scenarios.

Note: Alternatively, one could have made the "Two Pump Start" scenario current and created 
the "One Process Tank" and "Two Process Tanks" scenarios below it. Then, with "Two 
Pump Start" still selected, select 'Clone With Children' twice, then rename the new 
clones "One Pump Start" and "One Pump Start with One Running".

The "One Process Tank" and "Two Process Tanks" scenarios may be thought of as grand chil-
dren of the Base Scenario. This concept of scenario ancestry is helpful in keeping track of the dif-
ferences and similarities between scenarios discussed later.

A box with a plus sign next to a scenario indicates it may be expanded to reveal children scen-
arios while a box with a minus sign indicates the level is fully expanded with all children scen-
arios shown, if any.  No box indicates there are no children.  Levels may be expanded by clicking 
on the plus sign and condensed by clicking on the minus sign.

Right-clicking a scenario provides the following choices:
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 l Create Child with No Output - create child scenarios without results saving duplication 
and load time

 l Rename - renames the selected scenario
 l Delete Scenario - deletes the selected scenario
 l Delete All Children - deletes all children of the selected scenario                     
 l Clone Without Children - creates a copy of the selected scenario at the same level (a 

sibling). Cloning a scenario prompts the user for a name for the new scenario.
 l Clone With Children - creates a copy of the selected along with its children. Cloning a 

scenario prompts the user for a name for the new scenario.
 l Insert Scenario Above Selected... - creates a new scenario where the selected scen-

ario is and shifts the selected scenario and its children down a level. This can be used to 
create a new base scenario. If this is done the user will be prompted to rename the pre-
vious base scenario.

 l Promote - raises a scenario one level, i.e. from a child to a sibling, active only for scen-
arios more than one level below the base scenario

 l Copy/Save Scenario Names
 l Copy Scenario Path Name - copy the fully-qualified name of the scenario to the 

Windows clipboard ("Base Scenario/Case 1/Child 3")
 l Copy Scenario Path Name With File Name - copy the fully-qualified scenario 

name along with the model name ("Model.imp :: Base Scenario/Case 1/Child 3")
 l Save Scenario Names Only to File... - copy all scenario names on separate 

lines, with indents to show child/parent relations
 l Save Full Scenario Paths to File... - copy all scenario names on separate lines, 

with the full path name used for each scenario
 l Save Scenario to File Without Children - saves the selected to scenario to a separate 

file without its children
 l Save Scenario to File With Children - saves the selected scenario and its children to a 

separate file
 l Compare to Active Scenario - compares all parameters for all objects between the 

selected scenario and active scenario and displays the Comparison Grid showing the res-
ults

 l Scenario Comparison Tool - opens the Scenario Comparison tool to create a custom 
scenario comparison

Note: It is important to remember that AFT Impulse’s Edit menu Undo does not apply to Scen-
ario Manager operations. To undo a Rename scenario operation, you can rename the 
scenario again to the old name. To undo a Clone or Save Scenario operation, you can 
delete the clone or file created. Once a scenario is deleted or promoted, there is no way 
to un-delete or un-promote the scenario.

Viewing Scenario Differences

A scenario’s data and that for all of its direct ancestors can be viewed in the Model Data window. 
This functionality can be enabled in the Model Data Control window.
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Fast Scenario Changes

AFT Impulse remembers the most recent scenario you had open, and allows you to quickly 
change back to that scenario by using the Last Scenario feature. The Last Scenario feature is 
found on the View menu and Common Toolbar.

Related Topics

Scenario Manager 615
Scenario Inheritance 619
Running Models in Batch Mode 624
Open Model Using Last Scenario 625
Scenario Comparison Tool Overview 625

Modifying Individual Scenarios
When first created, a scenario is identical to its parent. To modify or run a scenario, it must first 
be made in the current Workspace scenario by selecting it within the Scenario Manager window, 
then clicking on the Load As Current Scenario button.  (The name of the current scenario is dis-
played in both the Scenario Manager window and in AFT Impulse’s Status Bar.)  Once a scen-
ario is the current scenario, changes may be made to differentiate it from its parent using any of 
AFT Impulse’s editing tools and functions. When an attribute is changed within a scenario it 
breaks the link for this attribute. Subsequent changes in the scenario’s ancestors will no longer 
affect this attribute.

Properties of a scenario that may differ from its ancestors include:

 l Presence and location of objects - one may add or delete pipes and junctions within a 
scenario and the workspace locations may vary from scenario to scenario

 l Pipe and junction properties - all values set in the Properties windows
 l Fluid properties - fluid selected, temperature of fluid, viscosity model, system data
 l Steady Solution Control - solution method, tolerances, relaxation
 l Output Control - Output window content and formatting
 l Transient Control - The transient settings can be varied between scenarios
 l Library Manager - The connected library content can be varied between scenarios

Model Data Control and User Options apply to all scenarios.             

Scenario Inheritance
Scenario Manager will pass changes made in a scenario to linked attributes of its descendants, 
allowing multiple scenarios to be modified in one operation and maintain similarity between scen-
arios where desired.
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Any attribute whose value is the same as that of the scenario’s parent is linked to the parent. In 
turn, if the parent’s attribute value is the same as that of its parent, then the child’s attribute is 
linked to its grandparent. This ancestral linking of attributes can exist across any number of gen-
erations. A change made to a scenario will be passed downward to its children, grandchildren, 
etc., as far as the link exists. Changes are NOT passed upward from child to parent.

Once an attribute is changed within a scenario, the link is broken to that individual attribute. Sub-
sequent changes in the scenario’s ancestors, parent, grandparent, etc., will no longer affect that 
attribute, but all other attributes within the scenario will remain linked. The Model Data window 
with Scenarios enabled shows how the data changes between scenarios.

Scenario Logic Examples

For many users, it is easiest to grasp Scenario Manager when it is explained how the coding 
logic is actually implemented. Blank fields for children, grandchildren, etc., mean to look to 
the parent for the data. The Base Scenario never has blank fields (Table 1). Data only passes 
downwards, never upwards.

Table 1: Blank fields for Child #1 and Grandchild #1 mean that the data is to come from the parent. If 
the Base scenario data is changed, all descendants are changed.

If a child scenario does not have a blank field, then data for that property is initiated at that scen-
ario level (see Table 2).

Table 2: Child #1 does not have a blank field, so its Diameter would be 2, not 3, as would Grandchild 
#1.

If a scenario is changed, and its child has different data, then the change will not pass down-
wards (see Table 3). 
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Table 3: Changing the Base Scenario Diameter from 3 to 6 would not impact Child #1 or any des-
cendants in that line. Changing the Length from 25 to 40 would also change the length in Child #1, 

Grandchild #1, and any descendants of Grandchild #1.

If a child scenario has data that is different than the parent, its children cannot relink to the parent 
(see Table 4).

Table 4: Even if the Grandchild #1 has the same Diameter as the Base, it is not linked to the Base 
because it and its parent are not blank.

If a child scenario’s data, which was previously changed and is thus different from the parent, is 
changed back to the same vale as the parent, the inheritance link is re-established (see Table 5). 
Its descendant’s link is also re-established.

Table 5: If the Diameter in Child #1 is changed to be the same as the Base, it will be "blanked out" 
the next time the scenario is loaded and the link re-established. And so will Grandchild #1, if it’s Dia-

meter is also the same.
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Table 6 shows data for two pipe properties across three scenarios. The data that would be used 
when each scenario is loaded is as follows:

 l Base scenario
 l Diameter = 3
 l Length = 25
 l Changes to Diameter will not pass downwards
 l Changes to Length will affect only Child #1.

 l Child #1 scenario
 l Diameter = 2
 l Length = 25
 l Changes to Base Diameter will not affect Diameter
 l Changes to Base Length will affect Length

 l Grandchild #1 scenario
 l Diameter = 2
 l Length = 15
 l Changes to Base Diameter will not affect Diameter
 l Changes to Child #1 Diameter will affect Diameter
 l Changes to Base Length or Child #1 Length will not affect Length

Table 6: Input data for these properties explained in the text.

Re-Establishing Broken Scenario Links

A link may be re-established by returning the attribute to the same value as that of its parent. 
This can be done manually by entering the value or selecting the Copy Data From Pipe list and 
selecting the Parent Pipe Data option. Within other data windows, it is done by selecting the 
Same As Parent option in Analysis Setup, Output Control, or Library Manager.

Since links are identified by comparing attribute values of pipes or junctions with the same Work-
space ID number, renumbering a scenario will break the links of all pipes and junctions 
renumbered. Since numbers must be unique, once a link has been broken by renumbering, it 
may not be re-established.

Related Topics

Scenario Manager 615
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Creating, Organizing, and Editing Scenarios 616
Running Models in Batch Mode 624
Open Model Using Last Scenario 625
Scenario Comparison Tool Overview 625
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Running Models in Batch Mode
AFT Impulse scenarios or models can be run in batch mode, a feature that is especially useful for 
running a group of scenarios or models during lunch or overnight.

To run models in batch mode, follow these steps:    

 1. Click "Start Batch Run" on the File menu.
 2. Select the Batch Run Type. This is where you select if you want to run scenarios from the 

current model or different model files. If the current model does not have any scenarios, 
then only the second option will be available.

 3. If the Batch Run Type is "Scenarios in Current Model", then choose the Add Scenarios 
button and select the scenarios you wish to run.

 4. If the Batch Run Type is "Models from Different Files", then the models can be selected 
individually using the "Add Model Files" button, or loaded from a Batch File (by Choosing 
the "Load Existing Batch File" button). A Batch File is a text file listing all models you 
would like to run. At any time, a selected model file can be removed by clicking the 
"Remove Selections". The current list of models can be saved to a Batch File for use in 
the future by clicking the "Save List to File" button.

 5. Use the Output Options in the lower left to save the output data to a file and/or send it to a 
printer or Adobe PDF file. All reports will use the specified font. 

 6. Alternatively, the option can be chosen to Save Using Excel Export Manager by either sav-
ing to separate sheets, or saving the scenarios to separate workbooks. The Excel Export 
option can only be chosen if the batch run type is for Scenarios in Current Model. Addi-
tionally, the desired output must first be configured in the Excel Export Manager under the 
File menu for any data to be exported.

 7. Check the box to Run Batch in Background if you wish for all selected scenarios to run 
without showing the Solution Progress window. AFT Impulse will run the simulations in 
the background and will not interrupt any work being done in other programs.      

 8. Click the Start Run button to begin the batch run.

AFT Impulse then opens each scenario or model file in sequence, automatically runs each scen-
ario/model that has a completed Analysis Setup window, and sends results to the specified des-
tination. All pertinent information that is generated during the batch run (such as error messages) 
are automatically displayed when the final scenario/model is finished. Output files generated 
from each scenario or model run is automatically saved before moving to the next run.    

The entire batch run can be canceled at any time by clicking the Cancel button in the Solution 
Progress window. Output from scenarios that have already been run is still retained when the 
Batch Run is canceled.             

Note: You can plot output from multiple scenarios using Multi-Scenario Graphs.             

Related Topics

Scenario Manager 615
Creating, Organizing, and Editing Scenarios 616
Scenario Inheritance 619
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Open Model Using Last Scenario 625
Scenario Comparison Tool Overview 625

Open Model Using Last Scenario
When the model is saved, the current scenario is remembered, and by default, reloaded when 
the model is opened again. Your preference of whether to always open the model to the most 
recent scenario or to the base scenario can be specified in the User Options window.

Related Topics

Scenario Manager 615
Creating, Organizing, and Editing Scenarios 616
Scenario Inheritance 619
Running Models in Batch Mode 624
Scenario Comparison Tool Overview 625

Scenario Comparison Tool Overview
Scenario Comparison Tool (accessed via the Tools menu) is a powerful tool that allows users to 
compare model parameters between scenarios in a given model. It lets users quickly identify dif-
ferences between two or more scenarios without needing to search through the model data for 
each scenario or inspect each element of the model. This tool can be especially powerful for 
users reviewing others' models, or for users returning to models after a period of time. It can also 
be powerful for troubleshooting purposes. The Scenario Comparison Tool lets you: 

 l Compare any two or more scenarios
 l Compare selected Pipes and Junctions between selected scenarios
 l Compare selected Pipe and Junction parameters between selected scenarios
 l Compare selected General Properties between selected scenarios

Related Topics

Accessing Scenario Comparison Tool 626
Modify Comparison 627
Scenario Comparison Grid 629

Related Blogs

Five Fantastic New Features for Fast Fluid Transients: Impulse 8

New Feature Highlight - Scenario Comparison Tool
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Accessing Scenario Comparison Tool
The Scenario Comparison tool can be accessed from the Scenario Manager, the Workspace, 
and the Tools menu. 

From the Scenario Manager

To set up a comparison from the Scenario Manager, first select the pipes and junctions to com-
pare in the workspace. Then, select the desired scenario to compare the current scenario to in 
the Scenario Manager. Note the current scenario is indicated  by the green check-mark symbol. 
Right-click the desired scenario, and select Compare Selected Scenarios.... This will bring users 
to the Scenario Comparison window and display a grid of the differences between the selected 
objects in the two scenarios.

To modify the comparison use the Modify Comparison button at the bottom of the window.

From the Workspace

From the workspace, users can quickly select desired pipes and junctions in the scenario and 
compare them to those found in any other scenario. 

First, select the desired pipe(s) and/or junction(s) in the workspace. Then, right-click the Work-
space, choose Compare Scenarios, and select the desired comparison. This will bring users to 
the Scenario Comparison window and display a grid of the differences between the selected 
objects in the two scenarios.

To modify the comparison use the Modify Comparison button at the bottom of the window.

From the Tools Menu

From the Tools menu, there are multiple options to generate the Scenario Comparison Report.

A comparison grid can be directly generated by selecting the desired objects to compare in the 
Workspace, then selecting the scenarios to be compared from the Compare Scenarios menu 
option.

Alternatively, the Scenario Comparison Tool menu option can be selected to build a custom 
scenario comparison by directly selecting the scenarios, objects, and parameters to be included 
in the comparison. See Modify Comparison for more information on the available options.

Click the Show Comparison button at the bottom of the window to view the comparison. To make 
additional changes, use the Modify Comparison button at the bottom of the window.

Related Topics

Scenario Comparison Tool Overview 625
Modify Comparison 627
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Scenario Comparison Grid 629

Related Blogs

New Feature Highlight - Scenario Comparison Tool

Modify Comparison
Several Options are available to customize the Scenario Comparison Grid. These options are 
available from the Modify Comparison button at the bottom of the scenario comparison report, or 
by selecting Scenario Comparison Tool from the Tools menu. The Modify Comparison window is 
shown in Figure 1 below.

Figure 1: Scenario Comparison window options to Modify Comparison

Select Scenarios to Compare

The Scenario Comparison Tool has four pre-set templates for comparing scenarios, plus the abil-
ity to set up a custom comparison. These are:

 l Parent: This template compares the current scenario with that scenario's parent.
 l Ancestors: This template compares the current scenario with all of that scenario's direct 

ancestors. This setting would be similar to the comparison available in the Model Data 
window, though it does provide a more comprehensive comparison. 

 l Siblings: This template compares the current scenario with all of that scenario's siblings. 
 l Exhaustive: This template compares all of the scenarios in the model with each other. 
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 l Custom: This option allows users to compare any two or more scenarios throughout the 
model. 

Select Pipe and Junction Properties

This section sets what parameters will be compared such as length, diameter, roughness, etc.

Users can choose to compare a set of specified properties, or all pipe and junction properties by 
selecting the desired properties under Select Pipe and Junction Properties. Only properties 
selected in this section will be considered when the comparison is run.

A helpful option to filter the parameters to be displayed in the comparison is to display the para-
meters shown in the Model Data window. This can simplify the comparison, but might hide some 
differences between scenarios. Use the Model Data Control window to further define what para-
meters are shown with this option.

Select General Properties

This section sets what General Properties will be compared such as fluid properties, tolerances, 
cavitation models, pipe sectioning, etc.

Users can choose to compare all or a select set of general properties for the scenarios including 
options that are located in the Steady Solution Control, Fluid Properties, Pipe Sectioning, and 
Transient Control groups of the Analysis Setup window.

Select Pipes and Junctions

This section sets which pipes and junctions will be compared for the model.

Users can choose to compare all objects in the model, or a selected set of pipes and junctions. 
Users can manually select the desired objects, select those highlighted in the workspace, or use 
the Select Special tool to select desired groups or other sets of objects. 

Related Topics

Scenario Comparison Tool Overview 625
Accessing Scenario Comparison Tool 626
Scenario Comparison Grid 629

Related Blogs

New Feature Highlight - Scenario Comparison Tool
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Scenario Comparison Grid
Choosing the Compare Selected Scenarios menu item from the right-click or Tools menu will 
bring the user directly to the Scenario Comparison Grid based on any selected Workspace 
objects and scenarios. The settings for the scenario comparison can be seen/modified by click-
ing Modify Comparison at the bottom of the window.

The tabular data from the report can be copied to and pasted to a separate file or worksheet 
using the Copy button at the bottom of the window.

Figure 1: Default Scenario Comparison Report view

Filtering Options

When a large comparison is run, typically many of the objects/parameters in the model will be 
unchanged across scenarios, which may result in a large number of items with no differences. 
To help condense the Scenario Comparison Grid, several toggles are available at the top of the 
Item and Parameter columns which allow the user to show/hide rows in the report. Switching the 
toggle to All will show all items or parameters being compared. If the toggle is set to differences, 
then only Items/Parameters that have a different value in at least one scenario will be shown. 
Thus, if both toggles are set to All, then all parameters will be displayed for all items. If both 
toggles are set to Differences, then only items that have parameters with different values will be 
shown, and only the parameters that differ will be displayed.

Color Coding

The cells in the Item and Parameter columns will be colored either yellow or green to indicate 
whether that item/parameter has differences between the scenarios being compared. Yellow 
indicates differences, while green indicates that no differences exist. Parameters will be colored 
yellow if the value of that parameter is different in at least one scenario that is being compared. 
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Items will be colored yellow if at least one parameter that is being compared for that item has a 
different value in one or more scenarios.

The Highlight Unique Values toggle is used to color the values to visually link identical values. All 
values under the currently active scenario will remain grey, while values that have differences 
will be colored This is powerful to quickly see differences when more than two scenarios are 
being compared. If two scenarios have the same value for a parameter, the values will have the 
same shading. See Figure 2 below for an example.

Figure 2: Scenario comparison showing differences only. Each unique value is highlighted with a dif-
ferent color to indicate which scenarios have differences from the currently active scenario, which is 

the first Two Process Tanks scenario for this example.

Related Topics

Scenario Comparison Tool Overview 625
Accessing Scenario Comparison Tool 626
Modify Comparison 627

Related Blogs

New Feature Highlight - Scenario Comparison Tool
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AFT Impulse has two optional add-on modules which extend its modeling capabilities into other 
areas. The modules allow pulsation frequency and settling slurry modeling. The Modules panel 
withing the Modules group in Analysis Setup allows you to activate and enable either of the 
AFT Impulse add-on modules. An additional license to the base AFT Impulse license is required 
to use a module. These modules include:

 l PFA (Pulsation Frequency Analysis) - Helps identify and avoid resonant frequencies in 
systems, especially in those caused by positive displacement pumps.

 l SSL (Settling Slurries) - Models the effects of pumping fluids containing settling solids 
using the Wilson/GIW method.

Related Topics

Modules Group 129
Modules Panel 129

PFA - Pulsation Frequency Analysis

What is the PFA Module?

(PFA Module Only) Steady state pressure and flow dynamics, henceforth referred to simply as 
“pulsation”, is a common problem in PD pump systems, which can cause high vibration, fatigue 
failures, frequent maintenance outages, and flow uniformity or product quality problems. 

The PFA module helps engineers identify and avoid resonant frequencies in systems, especially 
in those caused by positive displacement pumps. Problems can arise when the frequencies that 
are excited by pulsation are at or near the acoustic resonant frequencies of a fluid system. The 
module is used to calculate the acoustic resonance frequencies that could damage system 
equipment.

How Does the PFA Module Work?

The Pulsation Frequency Analysis (PFA) module is used to determine resonant frequencies that 
could damage system equipment by calculating the acoustic resonance.

The general steps of pulsation analysis involve the following:

 1. The piping and process equipment system is first modeled.
 2. A pulse is generated to determine excitation frequencies, then a Low Pass Filter is 

applied to the pulse in order to determine the forcing function. This forcing function is then 
placed in the transient data of the junction at which the pulse is applied.
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 3. The model is run with the forcing function to generate the Excitation Frequency Analysis 
graph, and the user selects frequencies for analysis from the graph. If the pulsation 
source is specified to be a PD pump, the PFA module calculates the PD pump speeds 
(RPM) that will excite the chosen frequencies, and a table of PD pump speeds that abide 
by the specifications in the Pulsation Setup group in Analysis Setup will be populated.

 4. The pump speeds of interest to be analyzed are selected by the user, and the PFA mod-
ule automatically generates read-only child scenarios that model the pump operating at 
the selected speeds.

 5. The system can be modified accordingly and reanalyzed if desired.

The PFA module will also provide a warning in the Output if the maximum peak-to-peak pres-
sure limit has been exceeded at any location in the system, according to the API-674 standard.

Using the PFA Module

The user has the option of activating or not activating the PFA module when AFT Impulse first 
loads. After AFT Impulse is loaded, the PFA module can be activated or deactivated for use 
from the Modules panel in the Analysis Setup window or the Tools menu. Whether or not PFA is 
activated impacts the Analysis Setup window, Analysis menu, Output window, and Graph Res-
ults window as discussed in the Modules panel topic.

If the PFA module is active, the user can still run models without pulsation. This is selected 
under Pulsation Frequency Analysis on the Analysis menu. Hence there are three possibilities 
for the PFA module. 

 l PFA is not active
 l PFA is active and pulsation is disabled
 l PFA is active and pulsation frequency analysis is performed

Related Topics

Pulse Setup Panel 196
PD Pump Settings Panel 197
Sectioning Panel with PFA Module 187
Steady-State Pulsation Tolerance 640
PFA Pump RPM Evaluation 632
PFA Module Glossary 640
API 674 Evaluation 638

PFA Pump RPM Evaluation
The various pump speeds that excite frequencies of interest selected by the user are auto-
matically calculated. These speeds are displayed in the Pump RPM Evaluation Panel labeled 
"Excitation Frequencies and Pump Speeds" that will appear in the Quick Access Panel when the 
Graph Results window is active and frequencies of interest have been specified. Instructions to 
evaluate excitation frequencies using AFT Impulse PFA are available when clicking on the ques-
tion mark icon in the Pump RPM Evaluation Panel. The corresponding pump speeds that will 

PFA Module 
Pulsation Frequency Analysis Module
An optional add-on module to AFT Impulse 
which allows users to determine resonant fre-
quencies in their system.

- 632 -



Add-on Modules

excite the frequencies being evaluated are displayed on this panel, and speeds of interest can 
be selected automatically to create child scenarios using those pump speeds. Optionally, a User 
Specified Speed can be entered and used for the analysis. Figure 1 below shows the location of 
the Pump RPM Evaluation Panel that allows you to specify pump speeds you would like to eval-
uate after generating an Excitation Frequency Analysis graph.

Figure 1: The Graph Results window with the Quick Access Panel and the Pump RPM Evaluation 
Panel

Note that the Frequency vs. Magnitude graph can also be displayed with the magnitude on a log-
arithmic scale. To change this graph to display the magnitude on a logarithmic axis, right-click on 
either axis and check the box under Logarithmic.
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Figure 2: The Magnitude vs. Frequency Graph with the magnitude on the y-axis displayed on a log-
arithmic scale

After the steps needed to generate an Excitation Frequency Analysis graph have been taken, 
you can analyze frequencies of interest. Large peaks on Excitation Frequency graphs cor-
respond to natural acoustic frequencies of the system. The numerical “hammer” provided by the 
initial pulse has helped to identify the response of the system. By clicking and dragging from one 
side to the other over particularly high peaks and releasing the mouse button, the frequency in 
this area with the largest magnitude will be selected. Right-clicking on the label that appears 
enables you to add the frequency to the excitation frequencies being evaluated by selecting 
"Evaluate Excitation Frequency", as shown in Figure 3.
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Figure 3: Right-click on the flag of the selected frequency to evaluate it

It is important to identify these natural frequencies to make informed decisions about operation. 
Operating at pump speeds that will excite these natural frequencies for extended periods of time 
can cause system fatigue and structural issues attributed to vibrations. These are commonly 
referred to as ‘worst-case’ pump speeds because they match up with the harmonic frequency of 
the system and cause the most vibrations when operating at that frequency. Figure 4 shows the 
instructions which can be accessed by clicking on the question mark icon on the top right of the 
Pump RPM Panel of the Quick Access Panel, which is indicated in Figure 1.
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Figure 4: Detailed Instructions to evaluate excitation frequencies and determine problematic pump 
operating speeds

In order to determine what pump speeds will excite the natural frequencies that are selected, 
Equations 1 and 2 are used (Blanding & Walters, pp. 7-8).

(1)

Equation 1 identifies the various pump speeds for which integer multiples align with the natural 
frequencies.

 l , corresponding pump speed that will excite the given natural frequency
 l , selected natural frequency that is being evaluated

 l
, run-speed multiple, referred as the harmonic multiple
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Equation 2 is used to calculate the harmonic multiple where:

 l , the number of plunges per revolution, equal to the number of PD 
pump heads 

 l  integer harmonic multiplier

The integer harmonic multiple corresponds to harmonic numbers of the selected natural fre-
quency. Note, the Nij decreases hyperbolically as s increases. Figure 5 shows the 'worst-case' 
pump speeds that correspond to the natural frequency (32.6 Hz) being evaluated.

Figure 5: The Pump RPM Evaluation Panel with the pump speeds determined to excite evaluated fre-
quencies

After the PD pump speeds are calculated, read-only scenarios are created by clicking the 
"Create Scenarios Based On Selected Pump Speeds" button. You can specify which pump 
speed(s) you want to make into a child scenario by clicking on any speeds you want to exclude.  
AFT Impulse PFA will then create and populate child scenarios to evaluate the selected pump 
speeds. For each child scenario Impulse PFA will calculate and define transients in the specified 
pulsation source junction that are based on the pump speeds displayed in Figure 5. Running the 
scenarios will determine the actual pressure response of the system at these frequencies, which 
can be evaluated with API-674. The API-674 Limit will be graphed alongside the selected pipe 
ends, as shown in Figure 6.
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Figure 6: API-674 Limit included in the Frequency Analysis Graph

References
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API 674 Evaluation
After the Pump RPM Evaluation is finished in the base scenario, child scenarios are created to 
evaluate the identified pump operating speeds. In each pump operating speed scenario API-674 
evaluations are performed as follows: 
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 1. For each pipe station Impulse performs a Fast Fourier Transform (FFT) on the static pres-
sure results at that pipe station to find the frequency response 

 2. The pressure limit is calculated for each harmonic using equation C.2 from API-674 as is 
shown here: 

Where d is the inner diameter of the pipe, and f is the pulsation frequency which is defined 
as

Where N is the pump speed in rpm and j is the harmonic multiple.
 3. The FFT results are compared to the pressure limit results, and any pressures that 

exceed the pressure limits are reported in the Pulsation Summary in the Output window.

Related Topics

PFA - Pulsation Frequency Analysis 631
Pulse Setup Panel 196
PD Pump Settings Panel 197
Sectioning Panel with PFA Module 187
Steady-State Pulsation Tolerance 640
PFA Pump RPM Evaluation 632
PFA Module Glossary 640
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Steady-State Pulsation Tolerance
(PFA module only) When the PFA module is enabled, an additional tolerance must be specified 
in the Tolerance panel in the Analysis Setup window.

This is the Steady-State Pulsation Tolerance. This has a default value of 1.0E-05 which should 
be acceptable for the majority of pulsation studies.

"Steady-State Pulsation" means that the pulsation itself is repeating in a regular fashion. That is, 
the mean value, amplitude, and frequency of the pulsation are not changing over time, even 
though an individual property such as pressure might be rapidly changing. As the "start up" of a 
pulsation event is generally not of interest, this is accounted for by finding the steady state of 
pulsation.

The Relative Tolerance controls how tightly the Pulsation is considered "steady" - a loose tol-
erance may include some additional transient effects that are not desired.

Related Topics

PFA - Pulsation Frequency Analysis 631
Pulse Setup Panel 196
PD Pump Settings Panel 197
Sectioning Panel with PFA Module 187
PFA Pump RPM Evaluation 632
PFA Module Glossary 640
API 674 Evaluation 638

PFA Module Glossary
Much of the terminology associated with pulsation analysis is specific to time-frequency analysis 
and/or to vibrational analysis. The following words have been defined for ease of comprehension 
when working with the PFA module. Note that most of the defined words include page numbers 
and, occasionally, equation numbers. All of these references can be found in the document ref-
erenced at the end of this page.

 l Block Size - The number of samples in a set amount of time that are frequently cal-
culated in powers of 2 (Page 14, Equation 26)

 l Low-Pass Filter (LPF) - A mathematical filter that permits all frequencies at and below 
the specified frequency (termed the cutoff frequency) for analysis, and rejects all fre-
quencies above the cutoff frequency (Page 7)

 l Sample Rate - The inverse of the time step (Page 14)
 l Harmonic Frequencies - Multiples of the base frequencies that excite the system 
 l Forcing Function - This is the function that will be used to “ring” the system. This func-

tion can be the pulse in a non-low-pass-filtered system, or can be determined by the cutoff 
frequency that is determined by using FFT and LPF functions (Page 7)

 l Pulse - The near-instantaneous increase, then normalization, of flow 
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 l Fast Fourier Transform (FFT) - A method used to transpose the time-domain (flow vs. 
time) into the frequency-domain (magnitude vs. frequency)

 l dta - The initial time step, calculated by 1/2fc (Page 4, Equation 7)
 l dtb - The selected time step, filling the criteria that dtb is less than or equal to dta/3 (Page 

5)
 l Cutoff frequency (fc) - This is the frequency that is the maximum frequency that will be 

analyzed in the system. Calculated by nN/10, where n is the maximum pump speed (with 
buffer) and N is the number of pump heads in the pump (Page 4, Equation 6)

References 

 1. Blanding, James M., Ph.D., and Trey Walters, PE. Pulsation Analysis in Positive Dis-
placement Pump Systems Using Waterhammer, Modal, and Animation Software. Hou-
ston, TX: 45th Turbomachinery & 32nd Pump Symposia, Sept. 2016. 
http://www.aft.com/documents/TechnicalPapers/2016/TPS2016-PulsationAnalysis.pdf
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SSL - Settling Slurry

What Is the SSL module?             

An optional add-on module to AFT Impulse which allows users to simulate settling slurries.

Settling slurries are fluids which carry solids of relatively large size which cannot be suspended 
in the liquid under all conditions. At sufficiently low velocities the solid particles will settle to the 
bottom of the pipe and may ultimately plug the pipe completely. It is important to predict the beha-
vior of such flows to avoid settling conditions and economically move the fluid and solids through 
the pipe.             

The SSL module allows users to predict the behavior of settling slurries within the framework of 
the powerful AFT Impulse software. The SSL module allows users to specify solid particle prop-
erties, distribution and concentration. State-of-the-art correlations are then used to predict the 
flow, pressure drop and reduced pump performance when pumping solids.

Special output reports and additional graphing parameters are available to assist the user with 
understanding the hydraulic behavior of the slurry.

- 641 -

http://www.aft.com/documents/TechnicalPapers/2016/TPS2016-PulsationAnalysis.pdf


Add-on Modules

How Does the SSL Module Work?

The SSL module offers additional input windows where users can enter the properties of the 
solid particles. The SSL module takes the properties of the solid particles and carrier fluid (which 
is often water but can be another fluid) and calculates the hydraulics of the piping and pumps 
using widely accepted correlations.

Predicting the flow of settling slurries depends heavily on correlations based on experiment. 
Such predictions are inherently less accurate than standard clear fluid pipe flow.

Using the SSL Module             

The user has the option of activating or not activating the SSL module when AFT Impulse first 
loads. After AFT Impulse is loaded, the SSL module can be activated or deactivated for use from 
the Tools menu. Whether or not SSL is activated impacts the Analysis menu, Library menu, and 
Output window.             

If the SSL module is active, the user can still run models with normal pure liquids. This is selec-
ted under Slurry Modeling on the Analysis menu. Hence there are three possibilities for the SSL 
module. 

 l SSL is not active
 l SSL is active and slurry calculation is disabled
 l SSL is active and settling slurry calculation is performed

Enabling SSL Use

When the SSL module is active, two new menu items appear - one on the Analysis menu and the 
other on the Library menu. On the Analysis menu is the Slurry Modeling menu, from which the 
user can select “Disable” or “Settling”.

The SSL module settling slurry calculation is enabled by selecting Slurry Modeling -> Settling 
from the Analysis menu (Figure 1). This can be selected before or after a model is built. If selec-
ted after, then additional input will be required for solids data. Pre-existing models built with 
standard AFT Impulse can be opened with SSL and settling slurry data added.

Settling slurry calculation can be turned off at any time by selecting Disable from the same menu. 
The Disable mode causes the SSL module to function like standard AFT Impulse. If the model is 
opened in standard AFT Impulse, this data will be lost. Table 1 relates the differences between 
not using SSL and using it in Disable mode. 

The purpose of Disable mode is that it allows standard clear fluid calculations to be performed 
without having to deactivate the SSL module. This will cause the loss of the slurry input data for 
the active scenario.
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Figure 1: Select “Settling” from the Slurry Module menu item on the Analysis menu to instruct AFT 
Impulse to perform settling slurry calculations when it runs. 

Related Topics

SSL Module Fluid Properties Group 174
Carrier Fluid Panel 174
Solids Definition Panel 176
Slurry Definition Panel 179
SSL Nomenclature 651
SSL Engineering Assumptions 652

Slurry Calculation Method Overview
(SSL Module Only) The methodology for slurry pipe calculations is taken from Wilson 2006. 
There are three Slurry Calculation Methods – Minimal, Simplified, and Detailed. These require 
an increasing level of knowledge and data about the slurry being modeled. Each of the methods 
are described with repeated information as there are many calculations that are common among 
the three.    

 l Minimal Slurry Calculation Method
 l Simplified Slurry Calculation Method
 l Detailed Slurry Calculation Method

Related Topics

SSL Engineering Assumptions 652
SSL Nomenclature 651

SSL Module Settling Slurry 
ModuleAn optional add-on module to 
AFT Impulse which allows users to sim-
ulate settling slurries.

SSL Module 
Settling Slurry Module
An optional add-on module to AFT Impulse 
which allows users to simulate settling slur-
ries.
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Minimal Slurry Calculation Method
(SSL Module Only) The following data are required for the Minimal Calculation Method

 l Temperature
 l Solids concentration
 l Density
 l Sliding friction coefficient, μs

Horizontal Pipes

The pressure drop in a given by the relationship given by Wilson 2006, on page 116. The coef-
ficient 0.55 is based on sand or gravel sliding in steel pipe which has a coefficient of sliding fric-
tion, μs of 0.40. The equation then is modified with the ratio of the value entered in the Solids 
Definition panel and becomes the following:    

(1)

Note that when the Minimal Input option is selected in the Solids Definition panel there is no 
value entered for the d50 or d85 particle sizes and therefore the M exponent, V50 and other para-
meters cannot be determined.

Related Topics

Slurry Calculation Method Overview 643
Sloped Pipe Theory For Slurries 650
Vertical Pipe Theory For Slurries 649
SSL Engineering Assumptions 652
SSL Nomenclature 651

Simplified Slurry Calculation Method
(SSL Module Only) The Simplified Slurry Calculation Method was developed for two-layer het-
erogeneous slurry flow with a newtonian carrier fluid. This method is similar to the Detailed Slurry 
Calculation Method, but uses a simpler method to estimate V50. The following data is required 
for the Simplified Calculation Method:

 l Temperature
 l Solids concentration
 l Density

SSL Module 
Settling Slurry Module
An optional add-on module to AFT Impulse 
which allows users to simulate settling slur-
ries.
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 l d50 particle size
 l M exponent value

Horizontal Pipes             

The correlation for additional pressure loss in horizontal pipes due to the slurry is given by 
Wilson 2006, on page 130

(1)

Where im is the dimensionless head gradient and Vm is the mean velocity based on the full dia-
meter regardless of whether any solids collection in the bottom of the pipe has reduced the effect-
ive diameter. By adding in the base fluid pressure loss the full head gradient is given by Wilson, 
et al, 2006, on page 134 (note that Wilson, et al, assume the fluid is water where here the fluid is 
generalized)

(2)

Noting that:

we get the following solution for the total head gradient:

(3)

Calculating the V50 value             

Equation 3 above needs the velocity at which 50% of the solids are suspended by the fluid, V50. 
An estimation shown in Wilson, et al, 2006, on page 141, is used.
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(4)

The relative viscosity νr is the ratio of the actual fluid viscosity to that of water at 20 degrees C 
(i.e. 1.0016 centipoise).

Related Topics

Slurry Calculation Method Overview 643
Sloped Pipe Theory For Slurries 650
Vertical Pipe Theory For Slurries 649
SSL Engineering Assumptions 652
SSL Nomenclature 651

Detailed Slurry Calculation Method
(SSL Module Only) The Detailed Slurry Calculation Method was developed for two-layer het-
erogeneous slurry flow with a newtonian carrier fluid. This method is similar to the Simplified 
Slurry Calculation Method, but includes more sophisticated methods to calculate M and V50, as 
is discussed below. The following data is required for the Detailed Calculation Method:

 l Temperature
 l Solids concentration
 l Density
 l d50 particle size
 l d85 particle size if the M exponent it so be calculated
 l M exponent value if no d85 particle size is available
 l Terminal velocity parameter, using either the Shape Factor (K) or Vt / Vts

Horizontal Pipes             

The correlation for additional pressure loss in horizontal pipes due to the slurry is given by 
Wilson 2006, on page 130.             

(1)
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Where im is the dimensionless head gradient and Vm is the mean velocity based on the full dia-
meter regardless of whether any solids collection in the bottom of the pipe has reduced the effect-
ive diameter. By adding in the base fluid pressure loss the full head gradient is given by Wilson, 
et al, 2006, on page 134 (note that Wilson, et al, assume the fluid is water where here the fluid is 
generalized)

(2)

Noting that:

We get the following solution for the total head gradient:

(3)

Calculating the V50 Value

Equations 2 and 3 above needs the velocity at which 50% of the solids are suspended by the 
fluid, V50. This is discussed by Wilson, et al, 2006, with a functional relationship given on page 
130.

(4)

Where:

 l w50 is the particle associated velocity
 l  d50 is the particle diameter
 l D is the pipe inner diameter

W50 used in Equation 4 above, is the particle associated velocity for the median particle size, 
and is defined in equation 5 below. The 3rd edition of Wilson (Wilson, et al, 2006, from which the 
equations for the rest of this discussion are taken) defines w using Figure 6.5 on page 136 of the 
text. The plot of w vs. particle size is based on an empirically-derived equation in the 2nd edition 
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of the text (Wilson, et al, 1996), equation 6.12 found on page 134. The SSL module uses that 
equation (Equation 5 below) in its solution methodology.

(5)

Where:

 l Vt is the particle settling velocity for the particle size in question
 l ρs is the slurry density
 l ρf is the fluid density 

Calculating the M Exponent Value

If both the d50 and d85 values are entered, the M exponent value can be calculated using the 
method shown in Wilson, et al, 2006, on page 140.

(6)

Where:

(7)

When using these calculations M is limited to between 0.25 and 1.7.

Related Topics

Slurry Calculation Method Overview 643
Sloped Pipe Theory For Slurries 650
Vertical Pipe Theory For Slurries 649
SSL Engineering Assumptions 652
SSL Nomenclature 651

- 648 -



Add-on Modules

Vertical Pipe Theory For Slurries
(SSL Module Only) Flow in vertical pipes offers a special-case flow regime. The basic equation 
for flow rising in a vertical pipe is given in Wilson 2006, on page 178.             

(1)

It is important to note that this is the total pressure drop per unit length whereas in the horizontal 
pipe equations above have components for the pure fluid and the solids separately.

Noting that for water, for which equation 1 is based, we can substitute:

and we obtain the following basic relationship:

(2)

Wilson, et al, states that for particles smaller than 150 microns, the density in the final term 
should be the mixture density:

Substituting this in to equation 2 we obtain:

(3)

The friction factor f could be found with homogenous methods, but it is often reasonable to use 
the friction factor for a water flow fw with the same mean velocity. For larger particles Wilson, et 
al, suggests that the density term should be that of water which, when substituted in to equation 
2 yields:
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(4)

Related Topics

SSL Engineering Assumptions 652
SSL Nomenclature 651

Sloped Pipe Theory For Slurries
(SSL Module Only) Sloped pipe calculations are a combination of horizontal head loss and a ver-
tical component. A widely used formula is given in Wilson 2006, on page 183.             

(1)

Where Δi(θ) is simply the excess pressure gradient (im – iw) for a pipe at an angle θ.

The term Δi(θ) is the solids effect for a horizontal pipe and is calculated using the equations 
described in the section above. It is modified by cos(θ) to reflect the pipe inclination from hori-
zontal.

The Deposition Velocity, Vsm, is also modified based on pipe angle. The following is added to the 
value calculated for horizontal pipes.

(2)

Where ΔD is determined from the graph in Wilson, et al, 2006, on page 181.

Related Topics

SSL Engineering Assumptions 652
SSL Nomenclature 651
Pipe Slope 664

Wavespeed Calculations For Slurries
When performing transient slurry calculations, the wavespeed for fluids must be adjusted to 
account for solids suspended in the fluid.

SSL Module 
Settling Slurry Module
An optional add-on module to AFT Impulse 
which allows users to simulate settling slur-
ries.
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The adjusted equation includes the addition of the bulk modulus and density of the solids, 
denoted with the 's' subscript, as well as the volumetric concentration of solids, Cv. Equation 21 
from Jacobs 1991 can be rearranged as follows.

SSL Nomenclature
(SSL Module Only)

CE derated pump multiplier on efficiency

CH derated pump multiplier on head

Cm mass concentration of solids

Cvd volume concentration of solids, delivered

Cvi volume concentration of solids, in situ

Cvb volume concentration of solids in sliding bed (bed concentration)

d50 mass-median particle diameter

d85 diameter for which 85% by mass of the particles are finer

D inner diameter of pipe

f friction factor

ff friction factor when calculating ifg

fturb turbulent friction factor

fw friction factor of water

g acceleration due to gravity

i head gradient

if head gradient contribution from fluid

im value of i for flow in terms of water density

is head gradient contribution from solids

iw head gradient contribution from fluid when fluid is water
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jm head gradient in terms of slurry density

K loss factor

K Power Law constant

L pipe length

Leq equivalent pipe length of fittings

M an exponent in the stratification ratio equation

ρw density of water

Ss relative density of solids in slurry

Sf relative density of fluids in slurry

Sm relative density of slurry

V50 value of Vm at which 50% of the solids are suspended in the fluid

Vm mean velocity of mixture

Vsm deposition velocity, velocity at which particles have all settled out

Vt terminal velocity of a solid particle in the slurry carrier fluid

Vts terminal velocity of a perfectly spherical solid particle in the slurry carrier fluid

SSL Engineering Assumptions
(SSL Module Only)             

Calculations done with the SSL module are based on the following assumptions:    

 l Solid particles are moving with the fluid. Stationary beds cannot be modeled. Sliding beds 
can be modeled with caution.                     

 l Base liquid behaves in a Newtonian viscosity manner                     
 l Slurry viscosity is equivalent to the viscosity of the carrier fluid      

SSL Flow Rates
(SSL Module Only) When specifying or referring to slurry flow rate, three different meanings of 
flow rate are possible and two are commonly used. The definitions for flow rate are as follows:

 l Slurry - Combined flow rate of the fluid and solids. This is the most common flow rate 
definition.

 l  Solids - Flow rate of just the solids in the slurry. This is often used because the purpose 
of the slurry is frequently to convey solids and this flowrate is of the greatest importance to 
the engineer.

 l Clear Liquid - Flow rate of the carrier fluid. This is not commonly used.

SSL Module 
Settling Slurry Module
An optional add-on module to AFT Impulse 
which allows users to simulate settling slur-
ries.

SSL Module 
Settling Slurry Module
An optional add-on module to AFT Impulse 
which allows users to simulate settling slur-
ries.
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The three flowrate definitions are of course interrelated. The slurry flowrate is the sum of the 
other two. As will be shown in the next section, all three flowrates can be displayed in the Output 
window.

The three flowrate definitions can be specified in three places in AFT Impulse. Two are on the 
Pump Properties Window and one is on the Assigned Flow Properties window.

An example of one of the three locations is shown in Figure 1 in the Pump Properties Window. 
When the SSL module is in use there is a dropdown list adjacent to the flowrate specification 
fields (as shown in Figure 1) that allows one to choose one of the three. The default selection is 
the flowrate of slurry.

Note that anywhere in AFT Impulse that specifies or displays flowrate information and does not 
offer the qualifier of slurry/solids/clear liquid, the flowrate of slurry is assumed.

Figure 1: Pump Properties Window with fixed mass flowrate specified

Related Topics

Assigned Flow 309
SSL Engineering Assumptions 652
SSL Nomenclature 651

Estimating M From Recorded Data
(SSL Module Only) There is an option in the Solids Definition panel in Analysis Setup and Solids 
Library to estimate M from recorded data. Choose the button for M Curve Fit. This is based on 
discussion in Wilson 2006, on page 135.             

Figure 1 shows the M Parameter Curve Fit window. Data for velocity and relative excess pres-
sure gradient are entered and a linear curve fit is generated on a log-log plot. The M factor is dis-
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played at the top. Data that does not fit the curve can be disregarded by the user by deselecting 
the checkbox in the table.             

M values are not allowed to be greater than 1.7 or less than 0.25 based on recommendations in 
Wilson, et al.             

Figure 1: M curve fit window based on recorded data.

Related Topics

SSL Engineering Assumptions 652
SSL Nomenclature 651

Solids Library
(SSL Module Only) Users can create Solids Library entries which retain data for specific solids 
profiles. The Solids Library window (Figure 1) can be accessed from the Library menu or from 
the Fluid Properties group Solids Definition panel or Slurry Definition panel.

This allows you to view, add, edit and delete solids in the library. The physical properties are 
entered in the Change Solids Physical Properties window. Enter the name of the solids data and 
the temperature units.

Often the physical properties of the solids do not vary appreciably with temperature or the vari-
ation is unknown. In this case select Use Constant Properties (Figure 2). The temperature units 
are ignored but one must still be selected.

If one wants to have one or more properties vary with temperature, uncheck the Use Constant 
Properties box. The property values as a function of temperature are then entered in the table on 

SSL Module 
Settling Slurry Module
An optional add-on module to AFT Impulse 
which allows users to simulate settling slur-
ries.
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the Solids Property Data tab (Figure 2). If a property does not vary with temperature, simply 
enter the same value for each temperature listed in the table. 

 
Figure 1: Solids Library showing example of user-entered solids data.

 
Figure 2: Change Solids Physical Properties window when defining constant physical properties.
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Other Solids Parameters

The Terminal Velocity Parameter and the M exponent are entered on the Other Solids Para-
meters tab (Figure 2). The particle size distribution is also entered on this tab.

Similar to direct entry in the Solids Definition panel, the user can allow AFT Impulse to estimate 
the M factor from recorded data or can input an M value directly. If M is calculated, values for 
both d50 and d85 must be entered.

The Terminal Velocity Parameter can be entered as either a Shape Factor (K) or the ratio of the 
particle’s terminal velocity (Vt) to that of a sphere (Vts). This ratio is designated by z or Xi.

Typical shape factors are given in Wilson, et al, 2006, on page 46 where K = 0.26 for sand. To 
ignore this effect then select Vt / Vts = 1.             

Particle Size Distribution

The particle size parameters d50 and d85 can be entered directly or statistically calculated based 
on particle size distribution data.

With the Use Particle Size Distribution option checked, you can enter the percent of the solids 
that remained on the mesh as observed from test data for each Tyler Mesh Size. The d50 and 
d85 parameters will automatically be calculated (Figure 3).

Figure 3: Solids Library showing the definition of particle size distribution.
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Related Topics

Library Browser 666
Network Library Overview 675
SSL Engineering Assumptions 652
SSL Nomenclature 651

SSL Pump De-rating
(SSL Module Only) When centrifugal pumps are pumping slurries the solids in the slurry can 
cause decreased pump performance. This is known as de-rating, as the process involves redu-
cing the pump head curves provided by manufacturers which are based on clear water.

The SSL module offers three methods to estimate pump de-rating. The first is based on a stand-
ard published by the Hydraulic Institute in 2016. In AFT Impulse it is called the ANSI/HI Standard 
12.1-12.6-2016 method. The second is based on the Warman method. The third allows the user 
to define the De-Rating Factors CH, CQ and CE rather than having them calculated.             

When the SSL module is used, a new tab appears on the Pump Properties window called Slurry 
De-Rating (Figure 1). Here the user can choose the de-rating method. The de-rating factors are 
shown in the Output window Pump Summary as CH (for head correction) and CE (for efficiency 
correction). Figure 2 shows the Pump Summary with correction factors displayed. If you do not 
see them in your Output you can add them to the Pump Summary in the Output Control window 
opened from the Tools menu.

Figure 1: Slurry De-Rating tab on Pump Properties Window lets user estimate reduced pump per-
formance due to solids.
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Figure 2: Pump de-rating factors CH and CE are shown in Output window Pump Summary.

Theory of Pump De-Rating

The head reduction for slurry pumps is based on ANSI/HI Standard 12.1-12.6-2016, page 52, 
Figure 12.3.2.7 (not shown here). Correction factors for solids density, solids concentration and 
percent of fine particles are applied per the standard. This figure and methodology is the same 
as found in Wilson 2006, 2006 on page 243.             

The Warman method is in use in industry but is not widely available. The method used in AFT 
Impulse is based on Walker, C.I page 2, and uses a correction factor for impeller size. Cm is the 
solids mass concentration of the slurry in terms of percent mass.             

The 4-Component Model option is a modified form of ANSI/HI Standard 12.1-12.6-2016 by GIW 
Industries Inc. intended for use with the 4-Component Slurry Model. The head reduction is given 
by the following equation.

Where rh is the total percent head reduction factor (i.e. 1 percent de-rate is 1.0) and rh,f, rh,p, rh,h, 
and rh,s are the contributions of the carrier fluid viscosity, pseudo-homogeneous fraction, het-
erogeneous fraction, and fully stratified fraction, respectively.

For viscosity below 20 centipoise, GIW guidelines state that rh,f can be assumed to be zero. 
Above 20 centipoise, ANSI/HI 9.6.7-2021 should be used to calculate this term.

Note: The Viscosity Correction term rh,f is not automatically applied when pump slurry de-rat-
ing is in use. To incorporate this term, Use Viscosity Correction must be enabled in the 
Optional tab. That option alone determines whether rh,f is calculated and the recom-
mended 20 centipoise threshold is not used.

The equations for the other components take the following general form where D2 is pump dia-
meter in meters, DREF is 1.0 m, SS is the solid specific gravity, Sx is the mixture specific gravity 
for each component, Cv is the volumetric concentration of solids, and Xx is the fraction of solids 
associated with each component. S1 is equal to 0.5 times D2/DREF and S2 is 0.4.
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This results in the following three equations:

Where A”, B”, and C” are empirical parameters and d50p, d50h, and d50s are the average particle 
sizes in mm of the pseudo-homogenous, heterogeneous, and fully stratified fractions, respect-
ively. CH is determined from rh with the following expression.

Related Topics

SSL Engineering Assumptions 652
SSL Nomenclature 651

SSL in Output
(SSL Module Only)

Selecting Slurry Output Data

The specific slurry data to be shown in the Output window is specified in the Output Control win-
dow. Select the Slurry button on the Display Parameters tab to see the available parameters for 
the steady state (Figure 1). Slurry parameters can be selected for the transient under the Pipe 
Transient tab.
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Figure 1: The Output Control window has a slurry button to allow choice of Output table parameters.

Viewing Slurry Output

The steady-state output slurry data is shown on a separate Slurry tab in the Pipes section of the 
Output window. The transient output data is shown in the pipe Transient Output and pipe Tran-
sient Max/Min tabs with the other transient data for the pipe (See Figure 2). The transient data 
can also be graphed.
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Figure 2: Output window showing Pipes section of Output window with Slurry tab for steady state 
output and Transient Max/Min tab with Velocity Ratio for slurry.

Related Topics

Exporting to Excel 588
Exporting Force Data 83
SSL Engineering Assumptions 652
SSL Nomenclature 651

SSL in Graph Results
(SSL Module Only) The transient slurry parameters are shown along side the regular pipe tran-
sient parameters in the Graph Control tab on the Quick Access panel (Figure 1). The resulting 
graph of the velocity ratio is shown in Figure 2.

SSL Module 
Settling Slurry Module
An optional add-on module to AFT Impulse 
which allows users to simulate settling slur-
ries.
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Figure 1: Transient slurry parameters are selected on the Quick Access panel

Figure 2: Graph Results window showing the Velocity Ratio over time for selected locations when 
using the SSL module.
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Related Topics

SSL Engineering Assumptions 652
SSL Nomenclature 651

SSL Intital Guesses for Pipe Velocity
(SSL Module Only) AFT Impulse uses iterative methods to solve for the equations of pipe flow. 
This requires initial guesses for pipe flowrate. Such guesses are optional for the user and can be 
entered on the Pipe Properties Window Optional tab. If the user does not provide an initial guess 
then AFT Impulse makes an initial guess itself.

Typical settling slurry applications operate at a higher velocity than non-slurry flows and AFT 
Impulse will converge more reliably on a result if the initial guess at velocity reflects this higher 
velocity. 

By default the initial guess flowrate for all pipes is based on a velocity of two times Vsm. This can 
be modified by the user in the Advanced Parameters panel or overridden directly by entering an 
initial guess for the pipes manually.             

Related Topics

SSL Engineering Assumptions 652
SSL Nomenclature 651

SSL Troubleshooting
(SSL Module Only)

One of the distinct aspects of settling slurry behavior is the minimum point of the system curve. 
This means that for a given jm (or, in general, head difference) there are two potential flowrates, 
as is shown in Figure 1 below. This has the potential for unstable numerical results. 

It is recommended that the system operate with a velocity ratio (Vm/Vsm) somewhat greater than 
1.0 in all pipes so that solids will not settle out of the carrier fluid and form a stationary bed (which 
is not modeled using the SSL module) or plugging the pipe. 

Often it is common practice to operate at or above the minimum im/jm point to achieve a desir-
able velocity ratio, and to avoid higher head losses that can occur to the left of the im/jm min-
imum. For example, in the below figure the minimum im occurs at about 5.25 m/s, so a mean 
velocity of 5.25 m/s or greater would be favorable. Model convergence may be difficult the closer 
the velocity ratio is to 1.0. Note that head loss curves like the one shown below will vary at dif-
ferent values of pipe diameter and solids concentration.

SSL Module 
Settling Slurry Module
An optional add-on module to AFT Impulse 
which allows users to simulate settling slur-
ries.

SSL Module 
Settling Slurry Module
An optional add-on module to AFT Impulse 
which allows users to simulate settling slur-
ries.
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Figure 1: im vs mean velocity for a slurry system at a specific slurry concentration and pipe dia-
meter.

Related Topics

SSL Engineering Assumptions 652
SSL Nomenclature 651

Pipe Slope
(SSL Module Only) Pipes with different slopes will have different pressure drops for slurry flow 
because of the way solids are carried horizontally, vertically or in between. AFT Impulse determ-
ines the pipe slope based on the pipe length and connected junction elevations.

The pipe angle can be added to the Slurry output in the Output Control table.

Related Topics

Sloped Pipe Theory For Slurries 650

SSL Module 
Settling Slurry Module
An optional add-on module to AFT Impulse 
which allows users to simulate settling slur-
ries.
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Powerful customization capabilities are provided through the ability to create libraries which can 
store custom fluid properties, pipe materials, and all junction types except the Volume Balance. 
There are several categories of libraries which are discussed below.

AFT Internal Library

 l Purpose - Stores AFT-provided library data that is always available with the default install-
ation.

 l Filename - Impulse#.dat (where # is the corresponding version number).
 l Location - Impulse installation folder, default is C:\AFT Products\AFT Impulse #.
 l Limitations - Cannot be transferred to other users, local use only.

Local User Library

 l Purpose - Stores user-specified data for most component types.
 l Filename - Imp_User#.DAT (where # is the corresponding version number).
 l Location - C:\Users\username\AppData\Roaming\Applied Flow Technology\AFT 

Impulse\#.
 l Limitations - Cannot be transferred to other users, local use only.

External Library

 l Purpose - Stores user-specified data of any type: fluids, pipe materials, junctions, and fit-
tings & losses. Multiple network or local custom libraries can be created via the Library 
Manager on the Library menu. External libraries can be shared to multiple users from a 
network location as is discussed in Creating an Enterprise-wide Network Library System.

 l Filename - User-specified filename.
 l Location - User-specified location.
 l Limitations - Must be connected via the Library Manager prior to use, and consideration 

should be given to version control or user permissions to edit.

Related Topics

Library Manager 666
Network Library Overview 675
Library Verification 679
Library Locations in General Preferences 681
Pipe Material Library References 739
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Library Manager
Accessed from the Library Menu, the Library Manager allows you to:

 l Connect to and disconnect from libraries
 l Create and delete libraries
 l Add content to libraries
 l Review the content of libraries
 l Move contents between libraries

Related Topics

Libraries 665
Network Library Overview 675
Library Verification 679
Library Locations in General Preferences 681
Pipe Material Library References 739

Library Browser
The first panel of the Library Manager is the Library Browser. Use the Library Browser to create a 
new library, add an existing library, view contents of an added library, and connect or disconnect 
libraries to the model.

Adding and Removing Existing Libraries

To work with a library you must first make it available to AFT Impulse. Referring to Figure 1, click-
ing on the Add Existing Library button will open a standard file dialog box with which you may 
browse to and select a library. A library may be removed from the list of available libraries by 
right-clicking on the library and selecting Remove Library from List.  A summary of the library con-
tents can be seen in the section on the right when a library, library section, or component is selec-
ted in the list of available libraries.

The AFT DEFAULT INTERNAL LIBRARY and the AFT IMPULSE LOCAL USER LIBRARY may 
not be removed and will always appear in the list of available libraries.  External shared libraries 
will also always appear in the available library list.
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Figure 1: Library Browser in the Library Manager

Connecting and Disconnecting Libraries

In order to use the components from a library in the model the library must be connected. A lib-
rary is connected to the model when it is shown with a check mark in the Library Browser. All lib-
raries are automatically connected when they are first added to the Library Manager.

Sections or components in a library can also be connected/disconnected on an individual basis if 
the library as a whole is connected.

It may be desired to disconnect a library if you do not want the components from that library to be 
available for use in the current model, but you do want the library to be available for use in other 
models.

Clicking on Set As Default will establish the list of connected libraries as the default list, while 
clicking on User Default will set the connections to the default list.

AFT Internal Pipe Material libraries can be connected or disconnected as a group from the Other 
Actions button under the available libraries list.

Editing Library Contents

Existing content can be moved to/from, copied to/from, or deleted from available libraries in the 
Library Browser.

To edit an item right-click on the item in the Library Browser, then click the desired action from 
the right-click menu. Note that moving, copying, and deleting can be done to a library as a whole, 
or can be done for just a section or single component in a library. Individuals components can 
also be edited by choosing Edit Component, which will take you directly to the Edit section for the 
component type.
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Figure 2: Library contents can be transferred or deleted from the right-click menu

Creating External Libraries

By default library items are stored in the AFT Default Internal Library or Local User Library, both 
of which cannot be shared with other users. Library items can be moved or copied to an external 
library which can be shared with multiple users.

To create an external library click the Create New Library button underneath the available lib-
raries list. You will be prompted to provide a name for the file, and a library description (Figure 3). 
The provided description will be displayed as the library's name in the Library Manager.

To add content to an external library copy or move content from an existing library as described 
in the Editing Library Contents section. Junction components can also be directly added to 
external libraries as is described in the Junction Libraries topic.

For more details on creating and sharing external libraries see Creating an Enterprise-wide Net-
work Library.

Figure 3: After specifying a library file name, you will be prompted for a description which will then 
appear in the Library Manager when this library is selected
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Related Topics

Junction Library 669
Fluid Library 669
Pipe Material Library 670
Fittings & Losses Library 672
Solids Library 654
Network Library Overview 675

Junction Library

Adding Custom Junction Data to the Component Library

To simplify modeling and eliminate repetitive data entry, AFT Impulse allows you to save fre-
quently-used junction data to a custom library. Once saved, the custom equipment can be selec-
ted from the Library List in the Properties window at any later time for immediate recall of the 
data. Using this tool, you can easily build your own library of pumps, valves, or other components 
supplied by specific manufacturers.

To save a custom junction to the library - open the junction Properties Window and enter all 
required data. Close the window and choose Add Component to Library from the Library menu. 
You will be prompted to enter a name for the custom component. Enter a descriptive name and 
click OK. If you open the junction again, the custom name will be selected in the Library Jct drop-
down.

AFT Impulse accepts custom data for all junction types except Volume Balance.

Editing the Component Library

You can delete or rename any existing library component in the Edit Junctions panel of the 
Library Manager, accessed from the Library menu. To edit an existing library entry, select the 
item in the list and click the Edit Data button. This opens the data into a Properties Window 
where the data can be modified.

Related Topics

Library Browser 666
Network Library Overview 675

Fluid Library
AFT Impulse provides an AFT Standard fluid library for numerous common fluids. If the working 
fluid you wish to model is not in this library, you may elect to enter the fluid properties in a custom 
library for later recall using the Edit Fluids panel in the Library Manager.
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You can open the Edit Fluids panel from the Library menu or from the Edit Fluid list button in the 
Fluid panel in Analysis Setup. The Edit Fluids panel allows you to review currently defined AFT 
Standard and custom fluids, to change the data for custom fluids, and to enter new fluids. All 
AFT Standard fluid properties are assumed to be a function of temperature. Custom fluids can 
be a function of temperature or solids concentration.

Once you have entered a custom fluid, it will appear in the Fluids Available in Library list of the 
Fluid panel when User Library Fluid is selected.

Adding a Custom Fluid

You can add new fluids by clicking the Add New Fluid button on the Edit Fluids panel of the 
Library Manager. Raw data can be provided for the variation of density, dynamic viscosity, vapor 
pressure, and bulk modulus as they depend on temperature or solids concentration. This win-
dow provides the tools to perform polynomial curve fits of fluid data, or the raw data can be inter-
polated.

Required Data:

 l Density
 l Dynamic Viscosity
 l Bulk Modulus

Optional Data:

 l Vapor Pressure (required if checks and warnings for cavitation are desired)

The Fluid Library window also allows you to open the Change Fluid Data window which is essen-
tially the same window as the Add New Fluid window. For easy editing, data for the fluid you wish 
to change is entered for you in the appropriate areas. The original curve fit data you entered is 
also displayed.

The Add New Fluid/Change Fluid Data windows offer cross-plotting of your custom curves 
against the curve fit data points. You can also import data from text files into these windows.

Related Topics

Library Browser 666
Network Library Overview 675

Pipe Material Library

Adding Custom Pipe Materials to the Pipe Materials Library

You can open the Edit Pipe Materials panel from the Library menu. Using this panel, you can eas-
ily add to the user library the geometric information for any pipe material in the length units of 
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your choice. Custom pipe materials can be selected for use in the Pipe Properties window, min-
imizing the data entry required by the user.

Pipe materials typically have a range of nominal sizes and a specific type, class, or schedule that 
describes the actual dimension. AFT Impulse works with the inner diameter of the pipe, since 
that is the parameter that directly affects the fluid mechanics.

To add custom pipe materials to the user library, choose the entry location you desire in the 
list on the left (Pipe Materials, Sizes and Types), then click the New button below. For example, 
to add an entirely new material, click the Pipe Materials item at the top of the list then click the 
New Material button. To add a new size for an existing material (say Steel), click Steel in the list 
then click the New Size button. To add a new type to the Steel 1 inch size, click 1 inch under the 
Steel material in the list then click the New Type button.

When adding a new material, you also will be asked to specify a geometry, enter a nominal size, 
type of material, diameter, wall thickness, friction data set, and friction value to define the first 
data. Optionally you can add in a wall thickness. From then on you can enter additional nominal 
sizes and types. The name descriptors you choose for the material, size, and type are at your dis-
cretion. They can contain text mixed with relevant numbers if you desire.

You can also add multiple Friction Data Sets for each pipe material. This allows you to keep, for 
example, different friction values that may apply to the same pipe under different conditions. 
These conditions could be related to the age of the pipe or the type of fluid being carried. See the 
Friction Data Sets section below for more information.

In addition to manual entry of the custom pipe materials, you also can import pipe material data 
from a file. When you click the Import From File button, a dialog box will appear explaining the 
necessary import file format. By choosing to import from a file, you will be able to have a sep-
arate copy of the data for later access.

Friction Data Sets

Friction Data Sets are pipe friction values for a particular pipe condition.

To create a new Friction Data Set select a Pipe Material, Size, or Schedule to associate the data 
set with, then click New Data Set from the Friction Data Set tab on the right (Figure 1). Modify the 
Friction Data Set description to provide a name, then enter the Friction Model and Value.

A Friction Data Set can be associated with the entire pipe material, or with specific sizes or 
types. For instance, a friction data set associated with Steel (i.e., the top level) might be called 
"25 year usage" and have a roughness value of 0.005 inches. This data set is then available to 
all sizes and types of steel. However, if "25 year usage" is associated only with the 1 inch of 
Steel, it will apply only to the pipe schedules that are 1 inch.

You can also associate friction data sets with a specific type (i.e., schedule). For instance, you 
can make a "25 year usage" and associate it only with 1 inch schedule 40 Steel pipe and assign 
its roughness value as 0.006 inches. Then all Steel pipe would use 0.005 inches for "25 year 
usage" friction while the different value for 1 inch schedule 40 of 0.006 inches would supersede 
the value of 0.005 inches associated with all Steel pipe.

Finally, among multiple friction data sets you can specify a default data set.
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Multiple friction data sets can be created for each type of pipe material. For example, there may 
be separate friction data sets for Steel pipe such as: New Pipe, 10 Year Use, 20 Year Use and 
30 Year Use. Typically, the older pipes will have higher friction.

Figure 1: Friction Data Set tab on the Edit Pipe Materials panel

Pipe Physical Properties

The Pipe Material Library window allows you to assign physical properties of the pipe. The dens-
ity and Poisson ratio of the pipe can be entered as constants, and the modulus of elasticity as a 
function of temperature.

Related Topics

Library Browser 666
Network Library Overview 675
Pipe Material Library References 739

Fittings & Losses Library
The Edit Fittings & Losses panel can be accessed from the Library Menu and allows the user to 
review the Fittings & Losses data provided by default in Impulse, and to add, edit or delete user 
defined Fitting & Losses in the AFT Default Internal Library. 

Fittings & Losses can either be added by using the entry form in the window, or by importing a 
text file as described below. To enter a new Fitting/Loss item in the Edit Fittings & Losses panel 
click Create New Loss Item. Define the applicable category, type, geometry and loss model 
information then click Accept. The user-defined item will appear in the Fittings & Losses on the 
left under the relevant category/type with the source shown in parentheses as "U".

- 672 -



Libraries

Custom fittings & losses are saved to the local user library. From there the user can move them 
to other libraries (see Library Manager).

Import From File

Fittings & Losses can be imported from a *.CSV type file, which can be created from any spread-
sheet-type software, such as Excel.

The entries in the file should be in the order as shown in Figure 1, but with no headers in the work-
book. If a header row or a blank row is used, Impulse will present a warning, but give the user the 
option to still import the valid rows.

Figure 1: Example of import file setup for a custom elbow/bend. Headers should not be present in 
the file to import.

Valid options for each of the columns are listed below, with detailed options given in Table 1. 

 l Category - Must match one of the values from Table 1. "Other" may be used if none of the 
specific fitting/loss categories fit.

 l Type - This field is required, any name/value may be entered. Types already existing in the 
library are shown in Table 1, and may be used if desired.

 l Sub Type - This field is optional. A sub-type may be chosen from Table 1, or any other 
name/value may be entered.

 l Geometry - This field is optional. A geometry type from Table 1 must be used if a geometry 
is entered. If the Geometry field is left blank, the Geometry Value will be ignored.

 l Geometry Value - This field is only required if a Geometry type has been entered. Any pos-
itive numerical value may be entered.

 l Loss Model - This field is required. The Loss Model must be either "K (constant)" or "K / fT 
(Crane)".

 l Loss Value - This field is required. Any positive numerical value may be entered for the loss 
value.

 l Reference/Notes - This field is optional. Any information may be entered here as needed.
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Table 1: Valid Entries for each field. The Geometry Value and Loss Value fields will accept any 
numerical entry. The Reference/Notes field will accept any entry.

Related Topics

Fittings & Losses 253
Library Browser 666
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Network Library Overview 675

Network Library Overview
Custom libraries contain custom data generated by the user, including fluid properties, pipe 
materials, and data for junctions types such as pumps and valves.

All custom data created by the user is kept on the local computer in a file called IMP_
USER9.DAT in the local user directory. This data is not shared and is always available to the 
local user for access or for editing.

In addition to the local user library, you can create multiple network or local custom libraries. The 
Library Manager window on the Library menu simplifies this process. See Creating an Enter-
prise-wide Network Library System for details on how to do this.

Related Topics

Libraries 665
Library Manager 666
Library Verification 679
Library Locations in General Preferences 681
Pipe Material Library References 739
Library Browser 666
Benefits of Shared Libraries 675
Creating an enterprise-wide, network library system 676

Benefits of Shared Libraries
When the Impulse libraries are placed on a network, powerful data management procedures can 
be implemented. Specific, quality-checked data can be entered into libraries located on a local or 
wide area network of PC's. This data is not accessible to the end users through AFT Impulse 
itself, so it is guarded data.

Once the data is placed on a network, users can connect to any library listed in the Library Man-
ager. Users can connect to as many libraries as they want.

If the user connects to a library with these files and selects to be connected to any of these con-
trol files, the model will inherit the control formatting specified in the control files. This means that 
special report layouts, special graphical representations and colors, and other special controls 
can be decided upon by the library constructor, and those control features can be loaded into 
local models by end users. This is highly useful for creating customized reports for certain cus-
tomers or project requirements.

By way of example, assume the Output Control content was specified as coming from the "Wood-
land Park Office Library" library.

If you uncheck the Library checkbox or change certain data in the Output Control window, the lib-
rary will remain connected but change to an inactive state. When the library is inactive, none of 
its data flows through to the model. To bring the Output Control data back into sync with the con-
nected library, recheck the Library check box in Output Control.
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This entire custom library concept lends itself naturally to the idea of specific project libraries. 
Each project has differing requirements that depend on the nature of the project and the end cus-
tomer. Data for each project can be assembled into separate libraries, allowing faster and more 
accurate transmission of the controlled data and desired reporting formats to engineers.

Maintaining a network library allows commonly-used data to be controlled, which may be helpful 
in instances where quality control is strict.

Related Topics

Network Library Overview 675
Creating an enterprise-wide, network library system 676

Creating an enterprise-wide, network library system

Overview

Users of AFT Impulse on a network can access common libraries to simplify model verification, 
improve analysis and reporting consistency, and eliminate redundant work.

To accomplish this there is some initial setup that must be done. First, the data for components, 
materials, formats, etc., needs to be created and saved to various data files. Secondly, these 
files must be made available to the users of AFT Impulse by creating a file named 
DATABASE.LIB in the Impulse folder. Thirdly, the users need to connect to the new libraries lis-
ted and select the sections to use. Each of these broad steps is discussed below. To maintain 
control and integrity of the data, it would be advised that one person is given the responsibility to 
create and maintain the network libraries. The discussion below will be given from the viewpoint 
of this person.

Table 1 shows the relationship between Internal Libraries and External Libraries as well as the 
library file listing that AFT Impulse uses to find these libraries. An External Library is any library 
file that is created by the user and listed in the IMP_DBUSER.LIB residing in the user’s local user 
directory. The user can make these available and unavailable, and connect and disconnect from 
these libraries using Library Manager. The library files themselves may be located on any local 
or mapped drive. These library files are also distinguished by being under the local user’s com-
plete control. External Shared Libraries, on the other hand, are common to all AFT Impulse users 
on the network, therefore the local user cannot remove them from the list of available libraries. 
However, the user can choose to connect or disconnect from these libraries using Library Man-
ager. Finally, to complete the discussion, there are two special libraries, the Default Internal 
Library and the Local User Library. These files are AFT Impulse Internal Libraries which cannot 
be disconnected or made unavailable.
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Table 1: Summary of the types of libraries used for the example below, note the difference between 
External and External Shared libraries is just which *.LIB file their file path is listed in

Library Groups & 
Filenames Library Titles Library Loca-

tions

Impulse Internal 
Libraries   

IMPULSE10.DAT

IMP_USER10.DAT

AFT Default Internal Library

AFT Impulse Local User Library

AFT Impulse 10 
folder

AppData folder

External Shared 
Libraries 
(DATABASE.LIB)

  

VailMaterials.dat Vail Resort Materials
Network Location, 
with path listed in 
DATABASE.LIB

External Libraries 
(IMP_DBUSER.LIB)   

VailMaterials.dat Vail Resort Materials
Network Location, 
with path listed in 
IMP_DBUSER.LIB

Creating Library Files

The first thing to do is create the files that contain the information to be shared. These files will be 
referred to as library files and can contain information about pipe materials, components (e.g. 
pumps, valves, etc.), fluids, etc. The following are several ways to create library files:

 l Use the Create New Library button in the Library Manager, as described previously. Data 
can be taken from the current model or other libraries.

 l Copy and paste sections from one file into another file using a text editor.

This discussion will focus on the first and second methods. Let’s assume that the person 
responsible for the network library has already created a new pipe material. Also, assume that 
the goal is to create a network-wide library to contain this material.

The information for the material is copied from the Local User Library (Imp_User#.DAT, where # 
is the corresponding version number) to a new file using the Library Broswer in the Library Man-
ager. For the source library choose Local User Library and then select Pipe Materials. Then click 
Create New Library and enter a file name, VailMaterials.dat, for this example. Enter a description 
of the library - this description is how AFT Impulse users will refer to the library and should con-
cisely describe what is in the library (for this example we’ll use "Vail Resort Materials"). Right-
click the pipe materials section from the Local User Library and choose Copy Content to copy the 
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pipe materials to this new library file. The pipe material library file has now been created and is 
ready to be used.

Sharing Library Files Using DATABASE.LIB

Now that the library file for the Pipe Materials has been created, it needs to be made available to 
the users of AFT Impulse. Depending on the scope of use, library files can be placed into one of 
two groups. If the library is to be used locally by one user, it is put in the External Library group. 
On the other hand, if the library is to be common among many users and shared over a network it 
is put into the External Shared Library group.

Continuing the above example, the goal is to share the library file, so it will need to be an 
External Shared Library listed in the DATABASE.LIB file in the Impulse directory on the network. 
However, since Impulse does not write directly to the network files for security reasons, it is easi-
est to temporarily treat these files as local External Library files which will be listed in the IMP_
DBUSER.LIB file located in the local user directory of the local machine.

It is recommended that External Shared Library files be copied to the network server and placed 
in a subfolder of the AFT Impulse folder (e.g. AFT Products\AFT Impulse 10\Libraries). The files 
may, however, be located anywhere on the network that is accessible to the users. For our 
example, we are going to put the pipe material library on the network in a subfolder called Librar-
ies. It is easier to copy the file to the Libraries folder before they are made available in AFT 
Impulse. This will help establish the correct paths to the files as the files are made available 
using the Library Manager.

Once the library file is in the network location, open the Library Manager in AFT Impulse to the 
Library Browser. Each of the new library files we have created needs to be added to the Avail-
able Libraries list by clicking Add Existing Library and browsing to the file. Once you click OK, the 
description of the library you just added appears in the Available Libraries list. Once you have 
added the new library, click Close and the External Library listing file (IMP_DBUSER.LIB) in your 
local user directory is automatically updated.

Now we need to discuss how the paths should be setup. When you add a library, AFT Impulse 
will write the full path of the library to the External Library listing  (IMP_DBUSER.LIB). That 
means that if you browsed to the library file using a mapped drive letter then the path will include 
that drive letter. However, if other users try to access the libraries but have the AFT Impulse 
folder mapped to a different drive letter they will not be able to locate the library files. Other 
options include using either relative paths or the computer name in the path (e.g. \\Network 
Server\Eng Apps\AFT Products\AFT Impulse 10\Libraries\filename.dat). You can automatically 
have AFT Impulse use the computer name when you add the file by choosing Network Neigh-
borhood, then the computer and then browse to the library file. If you would rather use relative 
paths, you can manually edit them in the library listing file. All library files must be relative to the 
AFT Impulse folder where the executable is located.

When the pipe materials library was added it became an External Library listed in IMP_
DBUSER.LIB. Now we need to move this listing from the local machine to the AFT Impulse folder 
on the network so that all users can access the library files. Once the listing file is moved to the 
network, it must be renamed DATABASE.LIB. Once this is done, all users can now access the 
library file we have created.
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Connecting to the External Shared Libraries

Now that the libraries have been placed on the network and made available to all AFT Impulse 
users, each user must now connect to the libraries and make the sections active as needed. 
When a user opens the Library Manager, the External Shared Libraries are listed in the Library 
Browser. Make sure the checkbox is checked to make those libraries connected for use. Also 
ensure that the sections within the library are checked for use. A library can be connected 
without having any sections selected and active. Finally, to have these connections in place 
every time you start AFT Impulse, click Set As Default. To apply these settings to a model made 
previously, open the model, go to Library Manager, click User Default and, if you have set the 
default, the connections and setting will now be applied to the model.

Sharing Model Formats/Preferences

Note that the Library Manager used to provide the option to include formats/preference settings 
such as the Output Control or layouts into shared libraries. These type of files can still be shared, 
but are no longer shared through the Library Manager. Instead these type of format files must be 
loaded directly through their control windows, such as loading the Output Control format being 
loaded in the Output Control window.

Related Topics

Network Library Overview 675
Benefits of Shared Libraries 675

Library Verification
The Library Verification window is displayed when you open a model or new scenario which con-
tains connected library items that have some inconsistency.

1. Library Item Not Found

You may have a library item that is not found in any currently connected library. For example, a 
pump may be connected to a library, and derive its data from that library. However, when the 
model is loaded, the source library is not available. This could be for several reasons that will be 
discussed shortly.

The pump in the model does in fact have all of the required data needed to run the model. But 
when it is not found in the library, you will be offered several options:

 l Disconnect it from the source library - This means that the model will forget the library 
the pump came from and make it a standalone pump not connected to any library.

 l Add it to a library - This means that the pump can be added to a custom library.
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 l Leave the library connection - This means that the pump will remember what library to 
which it was originally connected and connect to that library again when it is made avail-
able to AFT Impulse. If, however, you try to open the pump Properties window, AFT 
Impulse will disconnect the pump from the library and warn you.

The pump might have lost its library connection for one of these reasons:

 l The library is no longer available because it was removed either through the Library Man-
ager or because your libraries have been changed on the network.

 l The model is being run on a different PC than where it was created, and the original lib-
raries are no longer available. This could be, for example, because you have moved the 
model onto a laptop computer to take it on travel. Or it could happen because the model 
was developed by another company which had developed libraries of its own but which 
are not available to you.

Whatever choice you make, the model will retain all its engineering data and yield the same res-
ults as it did originally.

2. Item in Model is Different from Library

You may have a library item in the model that is connected to a external library, but for some 
reason the data is not the same. For example, you may have a pump curve for the Rocky Moun-
tain Pump Company's Model 100A in your model, but it does not match the pump curve for this 
model in your library. Here you have three choices:

 l Update the items in the model to match the library - This will actually change the 
model's input data, and it might yield different results than originally.

 l Update the library (if it is local) to match the model's items - This will change the lib-
rary, but will leave the model's input data as it was. It will yield the same results as it did 
previously.

 l Disconnect it from the source library - This will leave the model as it was, and it will 
yield the same results.

The pump in the model might have a different pump curve than the one in the library for one of 
these reasons:

 l When the model was built, the pump was connected to the Rocky Mountain Pump Com-
pany (i.e., RMPC) Model 100A. But since that time, the RMPC library has changed. Per-
haps there was an input error in the original data, or better data has since become 
available and the library was updated. If this were the case, it would be best to update all 
your pumps to the library values.

 l The library may have been changed by an unauthorized individual, and while it was accur-
ate originally, now the data is no longer valid. In this case, it would be best to not update 
the pump in your model, and to inquire into the cause of the inaccurate data within your 
organization.

Related Topics
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Library Locations in General Preferences
When performing an engineering analysis with or even without cost estimating, there may be 
many engineering libraries that underlie the model. These libraries need to be connected in the 
Library Manager in order to be accessible by the model. However, to know what libraries are 
actually needed, one needs to first load the model. This creates a dilemma. 

To help alleviate the dilemma, users can create "Library Search Locations" in the User Options 
window. Figure 1 shows an example. Once specified, you can set these as your default locations 
by clicking the Set As Default button. When AFT Impulse tries to open a model that requires cer-
tain libraries, and those libraries have not been connected already, AFT Impulse looks for them 
in the locations specified in the User Options. In addition, AFT Impulse looks in the model's 
folder. If AFT Impulse finds the libraries in one of these locations, it automatically adds it to the 
list of connected libraries in the Library Manager. If it cannot find a library, it informs you once the 
model is loaded.

Figure 1: Library Search Locations can be defined in the User Options window

Related Topics
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Theory and References
This section focuses on the fundamental theories that are used in AFT Impulse's solution 
method. Additionally, this chapter gives information on the source material for the theories used. 
Topics include discussions on the theories that comprise the network solution, waterhammer the-
ory, and information on references used in the development of AFT Impulse.

Content

Nomenclature 683

Steady-State Network Solution Methodology 685

Nomenclature

a wavespeed

A cross-sectional flow area of a pipe

BM compatibility equations parameter for method of characteristics 

BP compatibility equations parameter for method of characteristics

CD discharge coefficient

CM compatibility equations parameter for method of characteristics

CP compatibility equations parameter for method of characteristics 

CV valve coefficient

CHW Hazen-Williams factor

D diameter of a pipe

E  modulus of elasticity

e  pipe wall thickness

f friction factor

fT turbulent friction factor (used by Crane, 1988)

fL laminar friction factor

fTr transition friction factor

F  error value in mass balance

FB  Dimensionless pump torque parameter (see Four Quadrant Model Overview)

FH  Dimensionless pump head parameter (see Four Quadrant Model Overview)
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g  gravitational constant

H  head

HGL  hydraulic gradeline (piezometric head)

I  moment of inertia of pump and entrained liquid

J  Jacobian matrix

K loss factor

K  constant for Power Law fluid

KB liquid bulk modulus of elasticity

Ksprinkler  fire sprinkler loss factor

L  length of a pipe

mass flow rate

n  general constant

n  constant for Power Law fluid

N pump synchronous speed (rpm)

P pressure, static

Po pressure, stagnation

Pw  wetted perimeter

P power

Q volumetric flow rate

r  radius

r relaxation

R, R’  resistance or gas constant

Rc   coefficient of rigidity

Re  Reynolds Number

s pump speed

SB parameter as derived from conservation of mass

SC  parameter as derived from conservation of mass

Sy  yield stress

t  time

T  torque on pump
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v pump flow ratio to reference

V velocity

V  volumex        distance along pipe centerline

z  elevation

α, μ, θ angle

α pump speed ratio

β diameter ratio

β torque ratio

λ method of characteristics multiplier

η  efficiency

ν  kinematic viscosity

ε roughness

ω pump speed

ρ density

μ dynamic viscosity

Subscripts             

i junction or pipe station at which solution is sought

j junctions with pipes connecting to junction i

R rated conditions for a pump, usually BEP

o stagnation

∞  infinity, far away, ambient

new  current time for computation

old  most recent time for computation

Steady-State Network Solution Methodology
AFT Impulse makes use of standard matrix solution techniques when solving for a steady-state 
solution (Jeppson 1976). The method is known as the H-Equation method, where H, the piezo-
metric head, is solved for at each junction by forcing continuity of flow through each connecting 
pipe. Simultaneously, the head loss across each pipe is updated based on the flow balance 
information. The flow rate and head are solved in an inner-outer loop algorithm, where the flow is 
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guessed, the head loss is calculated consistent with that guess, and the flow is updated accord-
ing to the new pressure drop information. The Newton-Raphson method is employed to refine 
each successive solution, resulting in a sparse square matrix that is solved during each solution 
pass.

The concepts of pressure and hydraulic grade line (HGL, also called piezometric head) are 
related but use different frameworks for considering pipe system behavior. The HGL includes 
both the static and elevational effects of pressure. The relationship between the two is given by 
Equation 1:

(1)

where z is the elevation. Each concept offers certain advantages.

The solution technique makes use of the continuity and one dimensional momentum equations. 
AFT Impulse uses pressure and mass flow rate as the unknown parameters because they are 
more fundamental in nature than the head and volumetric flow rate used by Jeppson and thus 
extend more naturally to mechanical and chemical systems.

In the following discussion, subscripts denote values at junctions. Thus, Pi  represents the pres-
sure at junction i. Double subscripts denote values along pipes connecting two junctions. Thus, 
ṁij represents the mass flow rate in the pipe connecting junctions i and j.

Application of the law of mass conservation to each junction yields:

(2)

where n is the number of pipes connected to junction i. Equation 2 states that the net mass flow 
rate into each junction must sum to zero.

The basic equation for pipe pressure drop due to friction can be expressed with the Darcy-Weis-
bach equation:

(3)

where ΔPf  is the frictional pressure loss. The total pressure change between junctions is given 
by the momentum equation in the form of the Bernoulli equation:
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(4)

The static and stagnation pressure are related as follows:

(5)

Substituting Equation 5 into 4

Solving for the frictional pressure drop for a constant area pipes yields:

(6)

where i and j denote upstream and downstream junction values.

The definition of mass flow rate is:

(7)

Combining Equations 3 and 6 and substituting for velocity, V, using Equation 7 gives the mass 
flow for each pipe:

(8)

where R'ij  is the effective flow resistance in the pipe and the subscript ij refers to the pipe con-
necting junctions i and j.

(9)
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Note that R' is not the same as R, which is the resistance used in the Output Control window and 
is expressed by the following equation:

Substituting Equation 8 into Equation 2 results in the equation to be applied to each junction i:

(10)

where n is the number of pipes connected to junction i.

To be completely general, Equation 10 should be written for junction i:

 

(11)

to allow for application of boundary condition flow rates to a boundary junction node.

Equation 11 as applied to each junction in the network represents the system of equations that 
need to be solved to determine the stagnation pressure at each junction. To solve this system, 
the Newton-Raphson method is employed. In the Newton-Raphson method, new values for 
each unknown are calculated based on the previous value and a correction that uses the first 
derivative of the function.

In this instance the function that Newton-Raphson is applied to would be of the form:

(12)

The method involves finding all the junction stagnation pressures, Po,i, that cause all of the Fi  to 
go to zero, thus satisfying Equation 11 at all junctions.

When applied to a system of equations, the Jacobian matrix contains all the required derivative 
information to employ the Newton-Raphson technique. The Jacobian, JF, is given by:
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The column matrix  contains the stagnation pressure at each junction, and column matrix  

contains the F values (Equation 12) at each junction. The updated solutions for  are obtained 
from the following Newton-Raphson equation:

(13)

Traditional implementations of the Newton-Raphson method require initial guesses at the solu-
tion before the Solver can begin. This often results in the situation where you have to know the 
solution ahead of time in order to solve for it. To avoid placing this burden on the user, AFT 
Impulse uses a proprietary method for generating first guesses. This method is usually sufficient 
to get the solution going in the right direction, especially for systems that don't have highly non-
linear features.

However, there are times when AFT Impulse's first guess does not lead to a converged solution. 
In these cases, AFT Impulse provides you with the option of specifying your own initial guesses 
of flow and pressure in the Optional tab of the pipe/junction properties window.

Related Topics

Nomenclature 683

Continuity Equation at a Branch
By applying the continuity equation at branch i, we loop over all connecting pipes and get
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(1)

where  is the flow rate in the pipe connecting junctions i and j.

Verifying Network Solutions
As discussed on the Network Solution Methodology page, AFT Impulse uses a Newton-Raph-
son matrix method to obtain a system level mass balance for the steady-state solution. When the 
Solver is finished, the continuity equation is satisfied at all branching sections. Once solved, it is 
a simple matter to go back and sum up all mass flows at each branch to verify that these equa-
tions are satisfied. In fact, AFT Impulse does just that. 

After the Solver converges, AFT Impulse loops over each junction and adds up the inflow and 
outflow of mass and compares the sum to the solution tolerances. If it appears that any junction 
is out of tolerance, a warning is given in the output.

In the Solution Balance Summary table AFT Impulse provides additional information on the bal-
ance at each junction. This table can be displayed by selecting the option in the Output Control 
window General tab. Figure 1 shows an example of the Solution Balance Summary table.

Figure 1: Solution Balance Summary table shown in the Output window offers a balance report of all 
junctions in the window.
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Transient Theory
AFT Impulse simulates transient systems using fundamental equations based on conservation 
of mass and momentum. These fundamental equations are solved using the Method of Char-
acteristics, which simplifies a set of two partial differential equations into four ordinary differential 
equations.    

AFT Impulse also includes two cavitation models which are designed to capture limited transient 
cavitation in an otherwise liquid-full system.    

The math and calculations needed to support AFT Impulse's transient simulations can be com-
plex at times. The topics in this section attempt to clearly detail the theory behind AFT Impulse. 
Please reach out to AFT Support if you have further questions, or consider attending one of our 
AFT Impulse training seminars.    

Wavespeed - Detailed Discussion
As described in Wavespeed and Communication Time, the speed at which a wave can travel 
through a fluid is limited by its bulk modulus of elasticity and density. When constrained to a pipe, 
the wavespeed is further reduced as some of the wave energy is lost to deforming the pipe. An in 
depth derivation of wavespeed is presented here, along with discussion of the meaning of the 
Pipe Support constant.

Derivation Including Pipe Effects

Consider again an instantaneous valve closure. When a valve at the end of a pipe closes, a num-
ber of things happen. As we have seen, a wave is propagated upstream as discussed in the Con-
ceptual Example. However, what happens to the pipe itself?

Fluid continues to flow into the pipe, but not out of it. This causes both radial and axial strain - the 
pipe may be deformed in both directions, depending on how it is supported. This increase in fluid 
mass continues until the wave is reflected, or in other words, for a time equal to the time required 
for the wave to travel the pipe:

During the entirety of this period, the pipe is being deformed. If we consider the pipe to be sup-
ported only at the upstream end, it is free to expand lengthwise. The total axial increase in length 
occurs at the end of the period.

Further, this means that the closed valve has a certain velocity - it moves the distance Δx over 
the time period L/a.
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The fluid velocity at the face of the valve decreases from the initial steady value V0 to this Vvalve, 
making the change in fluid velocity:

The total fluid mass in the pipe increases during this period as well, by the steady rate.

Combining the previous two equations:

There are three mechanisms that allow the mass to increase in the pipe - the pipe strains axially, 
strains radially, and the fluid compresses.

Simplifying and reorganizing:

With the instantaneous waterhammer relationship,

the velocity change term can be eliminated, and the result can be solved for a2:
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The bulk modulus of a fluid relates the change in volume (or density) to an applied change in 
pressure:

Multiplying the a2 equation through by K/ΔP:

The area/pressure term is a measure of the elastic response of the pipe - its value will depend on 
how the pipe is constrained. For convenience, common terms that show up in this analysis are 
separated, and a new constant c1 is defined.

Pipe Support Constants

The value of c1 varies based on how the pipe is constrained. As an example, a thin-walled pipe 
fully anchored at the upstream end is discussed here, with other values of c1 listed below.

The change in internal area of the pipe A, is equal to the change in radius multiplied by the cir-
cumference. The change in diameter is equal to the radial strain multiplied by the diameter.
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Dividing by area:

The radial strain is affected both by axial and circumferential strain, which are related to one 
another via Poisson's Ratio ν:

Further, strain is related to stress with Young's Modulus E:

Combining the above and introducing the ΔP term:

The two stresses are related to their respective forces and areas:

Adding these to the previous equation and simplifying:

Which is able to give an expression for c1:
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Note: The above value of c1 is only valid for a pipe anchored only at the upstream end. See 
below for other values of c1 for differing constraints.

 l Thin-Walled Anchored Upstream (detailed above)

 l Thin-Walled Anchored Throughout

 l Thin-Walled With Expansion Joints

 l Thick-Walled Anchored Upstream

 l Thick-Walled Anchored Throughout

 l Thick-Walled With Expansion Joints
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 l Circular Tunnel (unlined)

 l Circular Tunnel (lined) / Buried Pipe (known soil properties)

 l  Buried Pipe (correlation estimate)
The default value for the percentage listed in the equation below is 7% and comes from 
Jeppson, et al, 1972 and represents the average wavespeed increase for buried PVC 
pipe after multiple tests were conducted which loosened the soil. A 12% increase was 
observed when the soil was first compacted. Other pipe materials may differ which is why 
the user can adjust the value accordingly. Note that the wavespeed adjustment occurs 
before the Impulse sectioning algorithm is run.

Related Topics

Nomenclature 683

Transient Flow Equations
To begin with any rigorous fluid dynamics solution, you must start with the most fundamental 
laws of physics. For isothermal flow of a liquid, there are two core equations - conservation of 
mass and Newton's second law of motion. We will consider the below control volume in a pipe. 
The control surfaces 1 and 2 are permitted to move relative to one another, and the unlabeled 
control surface on the pipe wall must remain fixed to the wall. For the purposes of analyzing a 
fluid transient, it is safe to consider the system one dimensional in x. Note that there is one radial 
effect that is important to consider - the change in cross-sectional area of the pipe.
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The resulting equations nonlinear hyperbolic partial differential equations, requiring a numeric 
solution such as the Method of Characteristics.

For a complete development of the equations please see one of the many excellent references 
(Wylie, 1993, Chaudry, 1987, and Swaffield, 1993.             

Figure 1: Control volume

Continuity Equation

First we apply conservation of mass to the control volume via Reynold's Transport Theorem:

Simplifying to one dimension:

According to the Leibniz integral rule:
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Applying this relationship and canceling terms:

Considering a mean value of the integral:

Divide by δx

Expand and group terms:

This is a generally applicable equation, we have not made any significant assumptions on the 
nature of the fluid itself.

Next, we will apply the definition of bulk modulus of elasticity. This step carries with it additional 
assumptions - because we are effectively dropping thermodynamic effects with this substitution, 
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the equation will only be able to be applied to "slightly compressible" fluids. This is not an issue in 
waterhammer applications - where the fluid is commonly referred to as "incompressible."

Rearranging the above equation, we can find the definition of wavespeed.

Expanding the pressure term, we get a convective term that is typically ignored in waterhammer 
analysis due to its relatively very small magnitude.

Finally, we arrive at what is termed the continuity equation.
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Momentum Equation

The application of Newton's second law follows from the same control volume above. Again 
applying Reynold's Transport Theorem we begin with the following relationship:

Very similar to the continuity equation, we can apply a one dimensional simplification, the Leibniz 
integral rule, and consider the resulting integral as a mean over the interval. These steps are 
extremely similar to the above and are not shown for brevity.

Summing the forces on the body:

To find the shear term, we consider a steady force balance with only two terms - the pressure 
across a section, and the shear term. We can find the pressure across the section with the 
Darcy-Weisbach relationship.

Incorporating this, dividing through by δx, and assuming that the areas on the pressure terms 
can be considered constant, we arrive at the following combined equation:
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Expanding the partial derivatives, and dividing through by ρA, we find the continuity equation 
and can drop those terms. We also again have a convective term which is normally ignored.

Gathering the remaining terms, we arrive at the momentum equation:

Related Topics

Nomenclature 683

Method of Characteristics
The Method of Characteristics is a general approach for solving a partial differential equation by 
reducing it to a system of ordinary differential equations.

We see here how it is applied to the transient flow equations. The continuity equation and 
momentum conservation equation are both partial differential equations. Together, they have 
two unknowns P and V, and two independent variables x and t. Application of the Method of 
Characteristics will generate four ordinary differential equations.

Characteristic Equations

The equations are represented below as L1 and L2 .
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Linearly combining the equations with the introduction of a constant factor λ

Rearranging terms from the linear combination above

We define a relationship for λ:

Where:

This relationship between wavespeed, time step, and length step must be enforced for this 
method to work as expected. This is discussed in detail in Pipe Sectioning - Introduction to 
Method of Characteristics.

Substituting into the above equation:

The terms in the parantheses are simply the total derivatives for P and V.
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Simplifying the expression to:

This represents the four characteristic equations that we are searching for, paired as positive 
(C+) and negative (C-) sets of equations:

Note: There have not been any simplifying assumptions made in the development of these 
ordinary differential equations - they represent the original partial differential equations 
exactly.

Numerical Method

We can simplify the equations further into a form that is convenient for simulation.

For the positive characteristic multiply the top equation by a dt, which is equal to dx 

- 703 -



Transient Theory

Recognizing that sin(α) is simply dz/dx:

 
It is more convenient to use mass flow instead of velocity, and multiplying through by ρ.

This equation can be integrated along the positive characteristic.

It is useful at this stage to consider a graphical representation of the characteristic grid. Some 
point P is affected by the positive characteristic from point A, and by the negative characteristic 
from point B.

Figure 1: Characteristic grid. The point P sees effects from points A and B after some time dt, which 
has equal magnitude of dx/a

Setting up the integral, along the positive characteristic line:
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Most of the terms are straightforward. However, the third term contains mass flow which varies 
with respect to x. This term is approximated with the trapezoidal rule, which is second order 
accurate.

Defining impedance:

and resistance:

and solving for pressure at the point of interest:

we can repeat the above process for the negative characteristic and arrive at:

We have finally arrived a system of two equations with only two unknowns - mass flow and pres-
sure at the point P. These equations can be further arranged into a convenient form known as 
the compatibility equations.

Related Topics

Nomenclature 683

- 705 -



Transient Theory

Compatibility Equations
From the characteristic equations (repeated below), we can construct two convenient equations 
known as the compatibility equations.

The only unknown terms in these equations are the pressure and mass flow at point P. The other 
terms are known either from a previous time step, or from the initial conditions as determined 
from a steady state simulation.

Rearranging terms:

and defining four new constants (constant for this time step):

We have our simplest equations yet:

(1)
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(2)

Which can be solved directly for pressure or mass flow:

(3)

(4)

Note: The compatibility equations allow a solution of all interior points in a pipe. However, the 
pipe endpoints are solved by applying specific boundary conditions. The boundary con-
dition relationships build on the previous methods, and offer the final needed inform-
ation to generate a complete solution.

Related Topics

Nomenclature 683

Transient Cavitation Models
AFT Impulse has two cavitation models available to capture transient cavitation in pipes: the Dis-
crete Vapor Cavity Model (DVCM) and the Discrete Gas Cavity Model (DGCM).

Any cavitation in a system inherently violates AFT Impulse’s fundamental assumption that all 
pipes are 100% liquid-full. The cavitation models attempt to work around that assumption by 
modeling cavitation only at pipe computation stations, with the intervening pipe remaining liquid-
full.

In a real system, vapor pockets can form continuously in the liquid. However, Impulse lumps all 
vapor formed into discrete pockets fixed at the grid points determined by the Method of Char-
acteristics (MOC). Vapor volume is tracked at each station, and the MOC equations are applied 
to the pipe between each station following the liquid-full assumption.
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Figure 1: While observed cavitation occurs over a given pipe volume, AFT Impulse calculates vapor 
volumes at pipe stations

Both models, DVCM and DGCM, are based on the methodology described in Wylie 1993, pg 66-
69 (DVCM) and pg 184-187 (DGCM), and supplemented by other literature sources. These mod-
els are considered industry standard, and are considered good models for transient cavitation. 
However, their accuracy is inherently limited by the liquid-full assumption behind AFT Impulse 
and the MOC. See the Interpreting Transient Cavitation Predictions page.

Discrete Vapor Cavity Model (DVCM)

DVCM evaluates transient cavitation by assuming one of two conditions exists. Either the pres-
sure at the pipe computation station is greater than Pvapor and the MOC equations can be 
applied as normal, or the pressure at the pipe computation station is equal to Pvapor and cavit-
ation is present.

When the MOC equations calculate that the pressure at a station reaches (or falls below) Pvapor, 
the pressure at that station is fixed exactly at Pvapor. The MOC equations are then evaluated 
treating the station as a boundary condition, simplifying the compatibility equations for the 
flowrate upstream and downstream of the station to:

Asserting a fixed pressure boundary of Pvapor creates a mass flow discontinuity across the sta-
tion. Impulse assumes this mass flow discontinuity is caused by vapor pockets forming and 
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tracks it as the total vapor volume. The actual mass flowrate as a function of time is unknown, so 
an average of the mass flowrate at the old time step and new time step is used:

When the vapor volume tracked at a station reaches (or falls below) zero, the station returns to 
the normal MOC equations.

Discrete Gas Cavity Model (DGCM)

DGCM builds on DVCM by introducing a small amount of free gas into the system. Most liquid 
systems contain some small amount of gas flowing with the liquid or dissolved in the liquid. This 
gas expands as system pressure approaches vapor pressure and can be considered a pre-
cursor to the cavitation which exists when the liquid is at vapor pressure.

Similar to DVCM, DGCM evaluates transient cavitation by assuming one of two conditions 
exists: either the station stagnation pressure is above Pvapor, or the system pressure is equal to 
Pvapor.

Calculations when Pstag > Pvapor:
When the station stagnation pressure is above Pvapor, DGCM uses the Ideal Gas Law to determ-
ine the free gas volume:

Specifically, nRT are lumped together as a constant value determined by the Initial Void Fraction 
and Initial Void Fraction Reference Pressure parameters on the Transient Cavitation Panel such 
that:

Impulse then couples the above equation with the MOC compatibility equations to sim-
ultaneously solve for the pressure, upstream mass flow rate, and downstream mass flowrate at 
each station for each time step. These calculations are always performed regardless of how 
close the system is to Pvap, adding additional computational complexity. As a result, a sim-
ulation using DGCM will take longer to run than a simulation using DVCM.

The free gas volume calculated at each station allows DGCM to improve on DVCM. Specifically, 
it allows DGCM to capture the effect that gas or vapor in a liquid system has on wavespeed. 
Wavespeed depends on how compressible a fluid is, with gas being more compressible than a 
liquid. At low pressures, gas volume will increase relative to the liquid, lowering the wavespeed 
in the fluid. This effect can become more pronounced as the fluid approaches the vapor pressure 
of the liquid, and is an important effect to capture.
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The Method of Characteristics solution requires wavespeed to be fixed prior to the simulation, 
meaning wavespeed can’t be directly modified. However, DGCM forces a pressure wave to 
expend some energy compressing the gas volume at a station as the wave travels along the 
pipe, effectively slowing wave motion as gas volume increases at low pressures.

The small gas volume at each station also helps avoid some of the numerical noise associated 
with DVCM, effectively dampening high-frequency waves as they move through the system.

Note that the free gas in the system can be set using the Initial Void Fraction and Reference Pres-
sure settings in the Transient Cavitation Panel. Default values are 1E-7 and 1 atm, respectively. 
Literature discussing DGCM, and AFT’s internal tests show that these values are meant to be 
constants rather than measured system values. AFT does not recommend changing these val-
ues from the default.

Calculations when Pstag = Pvapor:
When the station stagnation pressure is equal to Pvapor, DGCM simplifies to DVCM. The pres-
sure at the station is fixed exactly at Pvapor, the MOC equations are evaluated treating that sta-
tion as a boundary condition, and vapor volume is tracked as the mass flow discontinuity across 
the station.

DGCM contains one further difference from DVCM, seen in the equation used to integrate the 
mass flow discontinuity. DVCM integrates the total change in vapor volume from one time step to 
the next by averaging the mass flow evenly between the old time step and the new time step. 
DGCM instead uses rectangular integration and a weighting factor, ψ, with a value of 0.95, as 
shown in the equation below.

Using a value of ψ=0.95 weights the equation towards the new time step, adding numerical sta-
bility to the results, and providing a better match between Impulse results and available ref-
erence data. AFT does not recommend changing this value from the default.

Related Topics

Cavitation 69
Transient Cavitation Panel 193
Interpreting Cavitation Results 100
Nomenclature 683

Infinite Pipe Transient Theory
An infinite pipe is a representation of an interior pipe station - this is not the end of the pipe, but is 
identical to the same interior station in an equivalent system were the pipe is explicitly modeled. 
Therefore, all of the Method of Characteristics solution will apply to the infinite pipe boundary as 
well. However, by not explicitly modeling the entire pipe, there is some information we lose.

To determine the properties at the infinite boundary, we must know the properties of the adja-
cent stations from the previous time step. This is the case for any interior station. But this 
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poses an immediate problem - there is only one "adjacent station" - we have removed the other 
by not modeling the pipe.

Figure 1: Downstream properties are required to calculate the negative characteristic

We can overcome this restriction by creating a "virtual" station one section past the end of the 
modeled pipe. Again, note that this virtual station represents a real interior pipe point, it is only 
"virtual" in the sense that no pipe is included in the model. With the virtual station, we then have 
stations adjacent to the boundary, and can proceed with the compatibility equations.

Figure 2: Create a "virtual" station to allow calculation of the negative characteristic

However, we have introduced a new problem. We need to know the pressure and flow at the vir-
tual station to implement the compatibility equations for the subsequent time step. To proceed, 
we must estimate these values. This can be accomplished with the data we do know - adjoining 
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stations and previous time steps. Without transient effects, we can make a very good approx-
imation with a second order extrapolation.

This estimation requires data from the 3 adjoining stations, and 3 time steps previous.

Figure 3: Estimate the properties at the virtual station with the 3 previous time steps and stations

This introduces yet another obstacle to overcome - if we require 3 stations and time steps for 
estimating the virtual station in the time step 3 (3 time steps after 0), we are not able to utilize the 
compatibility equations to calculate the properties at the boundary until time step 4. Fortunately, 
there is an easy solution.

The properties at the boundary can be considered constant until a transient from the system 
affects it. Any transient change requires 1 time step to travel 1 section. We can state that the 
properties at the boundary remain unchanged for the first 3 time steps if we keep the boundary at 
least 3 stations away from any potential transient perturbation. In other words, we need to 
require a minimum number of sections in the pipe. This minimum value is only two sections. This 
is because the initial transient time step  (time step 1 in the diagram) can be considered the 
second fixed data point available to us - the first (time step 0) being the steady state initial con-
ditions. The properties at station 1 cannot change until time step 2.
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With a minimum of two sections, we can state that the pressure and flow at the boundary do in 
fact remain fixed for the first 3 time steps (4 including steady state).

Figure 4: The estimation forces a certain minimum number of sections. Note that the properties can-
not change at station 1 until time step 2 - one time step is required for any defined transient to 

impact the local solution.

See Wylie, et al, 1993, pp. 121-122 for more information.

Infinite Pipe Vapor Cavitation Theory

The Infinite Pipe junction is designed to only pass pressure waves out through the junction, and 
never to allow any reflections. If the junction drops to vapor pressure, a cavity would occur, which 
would cause reflections. Therefore, vapor cavities at these junctions are ignored and the pres-
sure is allowed to fall below the vapor pressure. This maintains the function of the junction. If this 
occurs the model should be updated.

Related Topics

Method of Characteristics 701
Infinite Pipe 289

- 713 -



Transient Theory

References

 1. Adamkowski, A. and Lewandowski M., "Experimental Examination of Unsteady Friction 
Models for Transient Pipe Flow Simulation", Journal of Fluids Engineering, Vol. 128, pp. 
1351-1363, November 2006.

 2. American Petroleum Institute. 2010. API Standard 674 with Errata (May 2014) 3rd Edi-
tion. Positive Displacement Pumps-Reciprocating. Annex C, sections A.1 and A.2, pages 
67-68 

 3. ANSI/API 610 11th Edition - Centrifugal Pumps for Petroleum, Petrochemical and Natural 
Gas Industries, 2010, published by American Petroleum Institute, 1220 L Street, NW, 
Washington DC, USA

 4. ANSI/HI Standard 9.6.3-2017, Rotodynamic Pumps - Guidelines for Operating Regions, 
2017, published by Hydraulic Institute, 6 Campus Drive, Parsippany, New Jersey, USA

 5. ANSI/HI Standard 9.6.7-2021, Rotodynamic Pumps - Guideline for Effects of Liquid Vis-
cosity on Performance, 2021, published by Hydraulic Institute, 300 Interpace Parkway, 
Building A, 3rd Floor, Parsippany, New Jersey, USA.

 6. ANSI/HI Standard 12.1-12.6-2016, Rotodynamic (Centrifugal) Slurry Pumps, 2016,  pub-
lished by Hydraulic Institute, 6 Campus Drive, Parsippany, New Jersey, USA.

 7. ANSI/HI Standard 14.3-2019, American National Standard for Rotodynamic Pumps - for 
Design and Application, 2019, published by Hydraulic Institute, New Jersey, USA   

 8. ANSI/API 526 7th Edition - Flanged Steel Pressure-relief Valves, 2017, published by 
American Petroleum Institute, 1220 L Street, NW, Washington DC, USA   

 9. ASME Press, ASME International Steam Tables for Industrial Use (CRTD-Vol. 58), pub-
lished by the American Society of Mechanical Engineers, Three Park Avenue, New York, 
NY 10016.

 10. Ballun, John V., "A Methodology for Predicting Check Valve Slam", Journal AWWA, 
Vol.99, No. 3, pp. 60-65, March 2007.   

 11. Blanding, James M., Ph.D., and Trey Walters, PE. Pulsation Analysis in Positive Dis-
placement Pump Systems Using Waterhammer, Modal, and Animation Software. Hou-
ston, TX: 45th Turbomachinery & 32nd Pump Symposia, Sept. 2016.

 12. Brown R.J. , and D.C. Rogers, Development of Pump Characteristics from Field Tests, 
Journal of Mechanical Design, ASME, vol. 102, pp. 807-817, Oct., 1980.   

 13. Carthew, G.A., Goehring, C.A., van Teylingen, J.E., Development of dynamic head loss 
criteria for raw sludge pumping, Journal Water Pollution Control Federation (WPCF), 
Volume 55, Number 5, (May 1983).

 14. Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410, 
Crane Co., Joliet, IL, 1988.

 15. Darby, R., Chemical Engineering Fluid Mechanics. 2nd edition. New York, NY, 2001
 16. Donsky, B., Complete Pump Characteristics and the Effects of Specific Speeds on 

Hydraulic Transients, ASME Journal of Basic Engineering, pp. 685-699, Dec. 1961.
 17. Fox, R. W. and A.T. McDonald, Introduction to Fluid Mechanics, 3rd edition, Wiley & 

Sons, New York, NY, 1985.
 18. Garcia, E. and Steffe, J., "Comparison of Friction Factor Equations for Non-Newtonian 

Fluids in Pipe Flow," Journal of Food Process Engineering, Vol. 9, pp. 93-120, April 1986. 
[Online]. Available: https://doi.org/10.1111/j.1745-4530.1986.tb00120.x

- 714 -



 19. Idelchik, I. E., Handbook of Hydraulic Resistance, 4th edition, Begell House, Redding, 
CT, 2007.

 20. Ingersoll-Dresser Pumps, Cameron Hydraulic Data, Liberty Corner, NJ, 1995.
 21. Jacobs, B.E.A., Design of Slurry Transport Systems, ELSEVIER SCIENCE 

PUBLISHERS LTD, New York, NY, 1991.
 22. Jeppson, R. W., Analysis of Flow in Pipe Networks, Ann Arbor Science Publishers, Ann 

Arbor, MI, 1976.
 23. Jeppson, Roland W.; Flammer, Gordon H.; and Watters, Gary Z., “Experimental study of 

water hammer in buried PVC and Permastran pipes” from the Utah Water Research Lab-
oratory, Utah State University, 1972. Reports. Paper 293. https://di-
gitalcommons.usu.edu/water_rep/293/

 24. Karassik, I.J., J.P. Messina, P. Cooper and C.C. Heald, Pump Handbook, 3rd Edition, 
McGraw Hill, New York, NY, 2001.

 25. Karney, B.W., and D. McInnis, Efficient Calculation of Transient Flow in Simple Pipe Net-
works, ASCE Journal of Hydraulic Engineering, Vol. 118, No. 7, July, 1992.

 26. Kittredge, C.P., Hydraulic Transients in Centrifugal Pump Systems, ASME Journal of 
Basic Engineering, Vol. 78, No. 6, pp. 1307-1322, Aug. 1956.

 27. Lyons, J. L., Lyons' Valve Designers' Handbook, Van Nostrand Reinhold, New York, NY, 
1982.

 28. Miller, D. S., Internal Flow Systems, 2nd edition, Gulf Publishing Company, Houston, TX, 
1990.

 29. Suter, P., Representation of Pump Characteristics for Calculation of Waterhammer, 
Sultzer Technical Review Research Issue, pp. 45-48, 1966.   

 30. TAPPI, Generalized method for determining the pipe friction loss of flowing pulp sus-
pensions, TAPPI, TIS 0410-14, Atlanta, GA, 1988.         

 31. Tilton, J. N., Perry's Chemical Engineer's Handbook, Seventh Edition, Chapter 6, 
McGraw-Hill, New York, NY, 1997.

 32. Thorley, A.R.D., Fluid Transients in Pipeline Systems, 2nd Ed., D&L George, Ltd. 2004
 33. Thorley, A.R.D., and A. Chaudry, Pump Characteristics for Transient Flow, Pressure 

Surges and Fluid Transients, BHR Group, 1996.
 34. Val-Matic Valve and Manufacturing Corp., "Surge Control in Pumping Systems," Val-

Matic Valve and Manufacturing Corp., Elmhurst, IL, 2009.
 35. Vazquez, J.A., C.H. Cloud, and R.J Eizember, 2012, “Simplified Modal Analysis for the 

Plant Machinery Engineer,” Proceedings of the 41st Turbomachinery Symposium.
 36. Visintainer, Robert. “GIW 4-Component Model Summary 2022-09-03.” GIW Industries 

Inc., 2022. [Online]. Available: https://www.ksb.com/en-us/services/service-for-slurry-
pumps/hydraulic-lab

 37. Walters, T.W., Analytical Approaches to Modeling Transient Vaporous Cavitation in Multi-
Pipe Fluid Systems, ASME FED-Vol. 116, New York, NY, 1991.

 38. Walters, T., Dahl, T. and Rogers, D.C., "Pump Specific Speed and Four Quadrant Data in 
Waterhammer Simulation - Taking Another Look", Proceedings of the ASME 2020 Pres-
sure Vessels and Piping Conference, PVP 2020, Minneapolis, MN, USA, July 19-24 
2020.   

 39. Walters, T. W., Lang S. A., and Miller D. O., "Unappreciated Challenges in Applying Four 
Quadrant Pump Data to Waterhammer Simulation, Part 1: Fundamentals", Proc. 13th 

- 715 -



Transient Theory

International Conference on Pressure Surges, BHR Group, Bordeaux, France, November 
2018.   

 40. Watters, G.Z, Modern Analysis and Control of Unsteady Flow in Pipelines, Ann Arbor 
Science, Ann Arbor, MI, 1979.

 41. White, F. M., Fluid Mechanics, McGraw Hill, New York, NY, 1979.
 42. Wilson, K.C., “Effect of Solids Concentration on Deposit Velocity”, Journal of Pipelines, 5, 

1986, pp. 251-257.
 43. Wilson, K.C., G.R. Addie, A. Sellgren and R. Clift, Slurry Transport Using Centrifugal 

Pumps, 3rd Ed., published by Springer, 2006.
 44. D. Wood, T.W Walters, "Operational problems in pumping non-settling slurries resolved 

using an improved laminar pipe fitting loss model" in 28th Intern. Pump Users Symp., Hou-
ston Texas, Turbomachinery Laboratory, Texas A&M University, 2012

 45. Wylie, E.B., V.L. Streeter & L. Suo, Fluid Transients in Systems, Prentice Hall, Englewood 
Hills, New Jersey, 1993.

Chempak Technical Information - Detailed Discussion
© Copyright 1998 Madison Technical Software Inc. Used with permission.

Note: The information in this Appendix was taken from Section 8 of the Chempak Operating & 
Reference Manual, Version 4, Windows Edition, Issue: January 1998. Section num-
bering was left unchanged, and some sections that were judged not relevant were not 
included so the numbering is not sequential. Notation and references in this Appendix 
apply only to this Appendix, and are referenced at the end.

8.1 General 

This section sets out the data sources, correlations and estimation methods used in the 
CHEMPAK database. In putting together the database, the methods and sources were selected 
in the following order of preference. 

·        Published experimental data 

·        Published correlations based on experimental data 

·        Specific category correlations 

·        General estimation methods 

Madison Technical Software has followed the general recommendations in Reid and in Danner 
and Daubert as far as selection of specific category correlations and general estimation methods 
are concerned. In selecting specific compound data, a combination of sources has been used 
wherever possible. Important sources of specific compound data used by CHEMPAK are: 

·        Reid et al 

·        Perry et al 

·        J Chem Eng Data 

·        Daubert & Danner 
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·        ESDU publications 

·        API Technical Data Book - Petroleum Refining 

·        International Critical Tables 

·        CRC Handbook 

·        Vargaftik 

In many cases, the compound property values are a combination of published data, published 
correlations and general estimation methods. Several properties in certain compound categories 
have been estimated or adjusted by Madison Technical Software. It has been our policy to adopt 
and maintain a critical approach to available data sources and correlation methods.

The following sections set out details of the correlations and estimation methods used. In certain 
cases, the user is directed to the original references, particularly where the method is complex.

Data sources for Aqueous Solutions/Heat Transfer Liquids are published experimental data and 
correlations based on experimental data.

8.2 Physical Constants 

8.2.1 Critical Temperature 

The great majority of values are believed to be experimental. Where values had to be estimated, 
the Joback method was used. 

8.2.2 Critical Pressure 

Most of the values are experimental. In cases where experimental data were not available, the 
critical pressure was derived from the Joback method.

8.2.3 Critical Volume 

A majority of the values are experimental. A great majority of the remaining compounds for which 
experimental values were not available had accurate boiling-point volumes available from which 
critical volume estimates were derived using the Tyn and Calus correlation. For a few sub-
stances, estimates of the critical volume were derived from the Joback method. 

8.2.4 Normal Boiling Points 

All values are believed to be experimental. In some cases, the values were slightly adjusted for 
vapor pressure.

8.2.5 Freezing Points 

Where possible, quoted freezing points are experimental. No accurate method of estimation of  
compound  freezing point  is available.  In the absence of experimental data, a rough estimate 
was derived from the Joback method.

8.2.6 Acentric Factors

The acentric factor is defined as 

 w = -log10(Pvr at Tr = 0.7) - 1 

In all cases the acentric factor was derived from the vapor pressure correlation ( see section 8.8) 

8.2.7 Joback Group Contribution Method 
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The Joback method is used to derive values of Tc, Pc, Vc and Tf where no experimental data or 
other predictive method was available. 

Tc = Tb/(0.584 + 0.965 Sum(Dt) - Sum(Dt)2)

Pc = 1/(0.113 + 0.0032 na - Sum(Dp))2

Vc = 17.5 + Sum(Dv)

Tf = 122 + Sum(Df)

where na is the number of atoms in the molecule and the D contributions are given by Joback 
and by Reid et al (1987). Error magnitudes for the Joback method are as follows: 

·        Critical Temperature: average error about 1%

·        Critical Pressure: average error about 5%

·        Critical Volume: average error about 2%

·        Freezing Point: average error about 11% 

8.2.8 Tyn & Calus Relation 

Tyn & Calus showed a close (< 3% error) relation between molar volume at normal boiling point 
and the critical molar volume of the form, 

Vb = a Vcn 

a = 0.285 

n = 1.048 

8.3 Liquid Specific Volume 

Liquid specific volume rises slowly and approximately linearly with rise in temperature to about 
Tr  =  0.8. At higher temperatures, the values rise more rapidly to the critical point. 

Experimental data or correlations derived from experimental data are available for most com-
pounds. 

8.3.1 Hankinson-Brobst-Thompson Equation 

The saturated specific volume is given by, 

Vs/V* = Vr(O)(1 - wsrkVr(1))

Vr(O) = Sum{an(1 - Trn/3)}             0.25 < Tr < 0.95 

Vr(1) = Sum{bnTrn/(Tr - 1.00001)}      0.25 < Tr < 1.0

aO = 1 

a1 = -1.52816 

a2 = 1.43907 

a3 = -0.81446 

a4 = 0.190454 

bO = -0.296123 

b1 = 0.386914 
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b2 = -0.0427258 

b3 = -.0480645 

V*, wsrk and Tc are tabulated property constants. The user is referred to Hankinson, Thompson 
and to Reid et al (1987). Errors are typically about 1% with most being less than 2%. 

8.3.2 Rackett Equation 

If a reference volume (Vref at Tref) is available then  

Zra = (PcVref / RTc)n 

n = 1/(1 + (1 - Tref / Tc)m) 

m = 2/7 or other empirical constant 

The saturated specific volume is given by, 

Vs = VrefZrax

with 

x = -(1 - Tref / Tc)m + (1 - T/Tc)m 

In most cases, an experimental value of reference density was available.  Where such a value 
was not available, values were derived from the group contribution method of Le Bas or derived 
from the critical volume using the Tyn & Calus relation. Tests by Madison Technical Software on 
over 80 liquids showed  that these two methods were significantly more accurate than the Spen-
cer and Danner method for Zra.  The reader is referred to Reid et al for further  details on  these 
methods. With one or more experimental points, the Rackett equation gives errors of about 1% 
with most values less than 3%. If the reference volumes are estimated, typical errors are 3%. 

8.3.4 The Effect of Pressure on Liquid Specific Volume 

The effect of pressure on liquid specific volume is calculated when  

P > Ps + 0.1 Pc 

The correction is derived from the equation of state as follows, 

VL = VLs - VLs,es + VL,es 

VL = specific volume at T and P 

VLs = VL at T and Ps from methods of this section 

VLs,es = VL at T and Ps from the equation of state 

VL,es = VL at T and P from the equation of state

Liquid specific heat can in principle be derived from the equation of state but in practise, direct 
analytical or group contributions are preferred where experimental data are not available. 

8.4 Liquid Specific Heat 

8.4.1 Rowlinson-Bondi Method 

(CpL - Cpo)/R = 1.45 + 0.45/X + 0.25w(17.11 + 25.2X0.333/Tr + 1.742/X)

X = 1 - Tr

w = acentric factor 
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This method is generally applicable to the range from Tf to values approaching Tc. Note that CpL 
approaches infinity as T approaches Tc. 

Errors are generally less  than 5% except in the case of hydrogen-bonding polar compounds 
(e.g.   alcohols) at low temperatures. For these compounds, the Missenard group contribution 
method is preferred.

8.4.2 Missenard Method 

The Missenard group contribution method yields values of coefficients in  

CpL = a + bT + cT2 

The accuracy is usually better than 5%.  The method cannot deal with double bonds and is not 
applicable for Tr > 0.75 

a = Sum{an} 

b = Sum{bn} 

c = Sum{cn} 

The group contributions are available in Missenard. See also Reid at al.

8.4.3 The Effect of Pressure on Liquid Specific Heat

As noted above, the equations of state can be employed to estimate liquid specific heat, but the 
methods presented in 8.4.1 and 8.4.2 are more reliable. The equations of state however can be 
used to estimate the effect of pressure on liquid specific heat.   

CpLs = CpL at Ts and Ps determined by the methods of this section. 

Cpo = ideal gas specific heat at Ts 

CpL = CpL at Ts and P > Ps

The equations of state give estimates of

Ds = (CpLs - Cpo)es at Ts and Ps 

D = (CpL - Cpo)es at Ts and P 

The corrected value of the liquid specific heat is 

CpL = CpLs + D - Ds 

The correction is not applied when T is close to Tc

8.5 Liquid Viscosity 

Liquid viscosity typically varies in magnitude by a factor of 100 or more between the freezing and 
critical temperatures. No generalized method is available to estimate or represent liquid viscosity 
adequately over the entire temperature range. Corresponding states methods are applicable 
above Tr = 0.76.  From the freezing point to the boiling point, the influence of structure is strong.            

 

8.5.1 Method of Van Velzen 

The method of Van Velzen et  al is a group contribution method of some  complexity and  range  
of applicability. It is the most frequently used group contribution method. The accuracy of the 
estimation averages about 10% and most estimates are better than 20%.  Some of the lim-
itations of the method are: 

·        Larger errors found with the  first  members of  a homologous series
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·        Only normal and iso substitutions on alkyl chains can be treated    

·        Heterocyclic compounds cannot be treated 

·        Application only in the range Tf to Tb

The method is complex and the reader is directed to the original references for full details. 

8.5.2 Method of Morris 

The method of Morris is a group contribution method.  This method is useful as a comparison 
and substitute for the Van Velzen method in cases where the Van Velzen method is not applic-
able. The accuracy of estimation is of the same order as Van Velzen. The limitations of the 
method are, 

·        The method is less detailed than the Van Velzen method 

·        Applicable only in the range Tf to Tb

·        No explicit treatment  for  heterocyclics  or  esters  (apart from acetates).    

The Morris method takes the following form 

ln(v/v*) = 2.3026 J(1/Tr - 1) 

J = (0.577 + Sum(Di))0.5 

The values of v* are given for various categories of compounds. The constants v* and the group 
contributions D are given in Morris.

8.5.3 Method of Letsou and Stiel 

This is a corresponding states method with applicability over 0.76 < Tr < 1.  The method also pre-
dicts the viscosity at the critical point  (Tr =  1). The accuracy is normally better than 5% up to Tr = 
0.92 with higher errors encountered as the critical point is approached. Overall this is an excel-
lent estimation method for high-temperature liquid viscosity. The only serious limitation is the 
restricted range of applicability. 

The form of the relation is  

v = (f0 + w.f1)/A 

with 

w = acentric factor 

f0 = a0 + b0Tr + c0Tr2 

f1 = a1 + b1Tr + c1Tr2 

A = 0.176x106 Tc0.1667/M0.5Pc0.667 

a0 = 2.648               a1 = 7.425 

b0 = -3.725              b1 = -13.39 

c0 = 1.309               c1 = 5.933 

In the above relations Pc is in bar and the viscosity is in units of Pa-sec. 

8.5.4 Method of Przezdziecki & Sridhar 

In this method, the viscosity is related to changes in the specific volume. 

v = V0/E(V - V0) centipoise 

V = liquid molar volume in cc/mol 
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E = -1.12 + Vc/D 

D = 12.94 + 0.1 M - 0.23 Pc + 0.0424 Tf - 11.58 Tf/Tc

V0 = 0.0085 wTc - 2.02 + Vf / {0.342(Tf / Tc) + 0.894} 

with 

Tc = critical temperature, K 

Pc = critical pressure, bar 

Vc = critical volume, cc/mol 

M = molecular weight 

Tf = freezing point, K 

w = acentric factor 

Vf = specific volume at Tf 

The authors recommend that the volumes be estimated from the Gunn and Yamada equation.   
The reader is referred to Reid for a discussion on this method. The method is less accurate 
below reduced temperatures of about 0.55.   Errors vary widely but will normally be less than 
20% for Tr greater than 0.55. 

This method is used in CHEMPAK only where necessary. An error analysis by Reid et al indic-
ates a higher level of error associated with this method than with the Van Velzen method for 
instance.  

8.5.5 Interpolation and Extrapolation 

Two regions are typically covered well by available experimental data, experimental correlations 
and by the above relations: 

273 <  T < 0.6 Tc:  this region is normally  covered by published data or by one of the 
methods 8.5.1, 8.5.2, 8.5.4 

0.76 Tc <  T < Tc: this  region is well covered by  the method of Letsou and Stiel (section 
8.5.3) 

This leaves two regions which are often not covered by the above methods 

Tf < T  < 273: this region may be covered by extrapolation using ln(v)  versus   1/T  extra-
polation. The error due to the extrapolation in practise will not normally exceed 10% with a pos-
sible 20% error in the immediate vicinity of the freezing point. 

0.6 Tc < T < 0.76 Tc: this region may be covered by interpolation between the 273 < T  < 
0.6 Tc region and the 0.76 Tc < T  < Tc region using ln(v) versus 1/T interpolation. The errors due 
to interpolation in this case rarely exceed 5%. 

8.5.6 The Effect of Pressure on Liquid Viscosity 

The method of Lucas is applied: 

vL/vsL = (1 + B.FA)/(1 + w.C.F) 

vL = viscosity at pressure P 

vsL = viscosity at saturation pressure Ps

F = (P - Ps)/Pc

w = acentric factor 
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A = 0.9991 - 0.0004674/(1.0523/Tr0.03877 - 1.0513) 

B = 0.3257/(1.0039 - Tr2.573)0.2906 - 0.2086 

C = -0.07921 + 2.1616 Tr - 13.404 Tr2 + 44.1706 Tr3  -84.8291 Tr4 + 96.1209 Tr5 - 
59.8127 Tr6 + 15.6719 Tr7 

8.6 Liquid Thermal Conductivity 

8.6.1 Method of Latini at al 

For specified categories of compounds, the method of Latini et al gives correlations for liquid con-
ductivity for the range Tr = 0.3 to 0.8 

The correlations are in the form 

k = A(1 - Tr)0.38/Tr0.167 

A = A0TbnMmTcp 

Category                                A0             n        m          p 

Alkanes                                 0.0035       1.2    -0.5    -0.167  

Alkenes                                0.0361       1.2    -1.0    -0.167 

Cycloalkanes                         0.0310       1.2    -1.0    -0.167 

Aromatics                              0.0346       1.2    -1.0    -0.167 

Alcohols/Phenols                   0.00339     1.2    -0.5    -0.167 

Acids                                     0.00319     1.2    -0.5    -0.167 

Ketones                                 0.00383     1.2    -1.0    -0.167 

Esters                                    0.0415        1.2   -1.0    -0.167 

Ethers                                    0.0385        1.2    -1.0   -0.167 

Halides                                  0.494          0.0    -0.5     0.167  

R20,R21,R22,R23                 0.562          0.0    -0.5     0.167

Errors may be large for Diols and Glycols. The Acids equation is not applicable to Formic acid.  
The reader is referred to Reid for a discussion of the method. 

8.6.3 Method of Sato-Riedel 

This method gives the following relation: 

k = (1.11/M0.5)f(Tr)/f(Tbr) 

with 

f(X) = 3 + 20(1 - X)0.667 

This method gives poor results for low molecular weight or branched hydrocarbons.   Errors oth-
erwise are likely to be less than 15%. The method should not be applied for Tr > 0.8  

8.6.4 Method of Ely and Hanley 

The method of Ely and Hanley has application to the high-temperature liquid region (Tr > 0.8). 
There are few data available for high temperature liquid conductivities. The method of Ely and 
Hanley is probably the best method available. Error estimates are unknown. 
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This method is used in CHEMPAK for Tr  > 0.8 with caution.  It appears to give reasonable res-
ults for non-polar compounds. Errors with polar compounds can be large. 

8.6.5 The Effect of Pressure on Liquid Conductivity

The procedure derived from Missenard as presented in Danner and Daubert is employed: 

k/ks = 0.98 + 0.0079 PrTr1.4 + 0.63 Tr1.2Pr/(30 + Pr)

k = conductivity at P 

ks = conductivity at Ps

8.8 Vapor Pressure 

The vapor pressure is expressed in its reduced form 

Pvr = Pv/Pc

Reduced vapor pressure varies from very low values at freezing point to unity at the critical point. 

8.8.1 Published Correlations 

The experimental correlations are commonly given in the following formats: 

Wagner Equation 

ln(Pvr) = (aX + bX1.5 + cX3 + dX6)/Tr

with 

X = 1 - Tr

FKT Equation 

ln(Pv) = a + b/T + cln(T) + dPv /T2 

Antoine Equation 

ln(Pv) = a + b/(T + c) 

8.8.2 Gomez-Thodos Vapor Pressure Equation 

Gomez-Nieto and Thodos give the following equation: 

ln(Pvr) = B(1/Trm - 1) + G(Tr7 - 1) 

G = aH + bB 

a = (1 - 1/Tbr)/(Tbr7 - 1) 

b = (1 - 1/Tbrm)/(Tbr7 - 1) 

H = Tbrln(Pc/Pb)/(1 - Tbr) 

For non-polar compounds, 

B = -4.267 - 221.79/(H2.5exp(0.038 H2.5)) + 3.8126/exp(2272.33/H3) + D 

m = 0.78425 exp(0.089315 H) - 8.5217/exp(0.74826 H) 

D = 0

except D = 0.41815 for He, 0.19904 for H2, 0.02319 for Ne 

For polar non-hydrogen-bonding compounds (e.g. ammonia and acetic acid), 
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m = 0.466 Tc0.1667 

G = 0.08594 exp(0.0007462 Tc) 

B = (G - aH)/b

8.8.2 Gomez-Thodos Vapor Pressure Equations 

For polar hydrogen-bonding compounds (water, alcohols), 

m = 0.0052 M0.29Tc0.72 

G = (2.464.M) exp(0.0000098 MTc) 

B = (G - aH)/b 

The advantages of this method are, 

·        fit guaranteed at T = Tb and T = Tc 

·        good performance with polar compounds 

·        good performance over Tr = 0.5 to 1 

In addition, tests carried out by Madison Technical Software show the clear superiority of this 
method especially at low temperatures over the Lee-Kesler method. 

8.8.3 Lee-Kesler Vapor Pressure Equation 

Lee and Kesler give the following vapor pressure equation: 

ln(Pvr) = f(0) + wf(1) 

w = acentric factor 

f(0) = 5.92714 - 6.09648/Tr - 1.28862 ln(Tr) + 0.169347 Tr6 

f(1) = 15.2518 - 15.6875/Tr - 13.4721 ln(Tr) +0.43577 Tr6 

The characteristics of this equation are, 

·        guaranteed fit at Tr = 1 and 0.7 

·        accurate for non-polar compounds 

This equation is used in the Lee-Kesler and Wu & Stiel equations of state. 

8.8.4 Interpolation and Extrapolation 

In many cases an accurate empirical equation is known which does not extend to the critical 
point or to the freezing point. The approach taken here is to fit the Wagner equation by least 
squares to the empirical equation and use the Wagner equation to extrapolate to the freezing 
point and to the critical point. 

Extrapolation by this method to the critical method is a very accurate procedure. Extrapolation to 
the freezing point is less accurate but it does provide reasonable values. 

In CHEMPAK, the vapor pressure correlations set out in this section are used to provide the 
basic data. Empirical relations are used wherever possible. 

8.14 Notation 

C Specific Heat 

e Expansion Coefficient 
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h Enthalpy 

log Logarithm to base 10 

ln Natural Logarithm 

m Dipole Moment 

M Molecular Weight 

P Pressure 

R Gas Constant 

r Riedel Parameter 

s Entropy 

T Temperature 

v Viscosity 

V Specific Volume 

w Acentric Factor 

x Mole Fraction 

Y Wu & Stiel Polarity Factor 

Z Compressibility 

Subscripts 

b Boiling 

c Critical 

es Equation of State 

f Freezing 

ig Ideal Gas 

L Liquid 

m Mixture 

0 Low Pressure 

p Constant Pressure 

ra Rackett 

ref Reference 

r Reduced 

s Saturated 

v Vapor 

v Constant Volume 

Superscripts 

(o) Simple Fluid 
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(r) Reference Fluid 

(p) Polar Fluid 
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Role of Pressure Junctions - Detailed Discussion (Long)
In modeling a generalized pipe network, it is possible to construct models that do not have a 
unique solution. A common occurrence of this is when a model contains one or more sections 
which are completely bounded by known flow rates. A series of examples with accompanying 
explanation will clarify situations where this occurs. The length of this topic is proportional to the 
frequency with which engineers get confused over the issue. It became apparent that an exhaust-
ive, lengthy discussion was necessary for some engineers. Do not dismiss this topic too quickly 
because of its length.

Before beginning it will be helpful to consider an aspect of the philosophy of computer modeling. 
At the risk of stating the obvious, it must be recognized by the user that a computer model cannot 
calculate anything that cannot in principle be calculated by hand. All the computer does is accel-
erate the calculation process. Some users expect the model to generate independent inform-
ation and become frustrated when the software requests additional information from them. But if 
the user was doing the calculation by hand that same information would still be required. The dif-
ference is that in the case of the hand calculation, the engineer would be forced to think through 
why the information is needed.

However, when the engineer interacts with AFT Impulse, they do not need to think at the same 
depth as in the hand calculation. So when AFT Impulse asks for the additional information, it is 
not as apparent why it is required. This disconnect in thinking can cause frustration for the user. 
Fully understanding the concepts in this topic will greatly reduce the frustration for some users, 
and will improve the quality of models for all users.

Examples

The simplest example is the system shown in Figure 1. In AFT Impulse terms, the system has 
two assigned flow junctions.
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Figure 1: Model with two assigned flows. This model does not have a unique solution.

Obviously, the flow in the pipe is known. But what is the pressure at the inlet? At the outlet? It can-
not be determined because there is no reference pressure. The reference pressure is that pres-
sure from which other pressures in the system are derived. There can be one or more reference 
pressures, but there always has to be at least one.

The model in Figure 1 can be built with AFT Impulse and if you try and run this model, AFT 
Impulse will inform you that it cannot run it because of the lack of a reference pressure. In AFT 
Impulse there are nine junctions that can act as a reference pressure: the reservoir, assigned 
pressure, spray discharge, pump with submerged option, and valve and relief valve after crack-
ing (with the exit valve option) behave as reference pressures because that is their nature. Three 
other junction types, surge tank, gas accumulator, and assigned flow (when the steady-state 
flow is zero) have a special feature that allows them to act as reference pressures. This feature is 
found on each junction's Optional tab.

There are a couple other things worth noting about Figure 1. First is that the model in Figure 1 
has redundant boundary conditions. When one flow is specified in a single pipe, the other end 
must have the same flow. Thus the second known flow does not offer any new information. 
Because the conditions are redundant, there is no unique solution to the model in Figure 1. In 
any AFT Impulse model, there is always at least one unknown for each junction in the model – 
either pressure or flow rate. Sometimes there are two unknowns such as a Pump. It is possible 
the user may not know either the flow or the pressure at the pump. In such cases the user is 
required to specify the relationship between flow and pressure. This relationship is called a pump 
curve, and by specifying the relationship between the two, effectively one of the two unknowns 
can be eliminated. Thus we always end up with one unknown for each junction.

Second, if the user was allowed to specify two flows as in Figure 1, they could specify them with 
different flow rates. Clearly they must have the same flow, so an inconsistency occurs. The basic 
reason the inconsistency is possible is because Figure 1 does not have a unique solution.

Figure 2 a-c shows three other model configuration possibilities. It is not possible to specify 
inconsistent conditions for any of the Figure 2 models, and they always have a unique solution 
no matter what input is specified by the user.
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Figure 2: Top two models with one pressure and one assigned flow, bottom model with two pres-
sures. All of these models have a unique solution.

The four models in Figures 1 and 2 a-c contain all logical possibilities. In all four cases there are 
four things we want to know. The pressure and flow at the inlet, and the pressure and flow in the 
outlet. In each case we know two of these four. The problem is that in the Figure 1 model the lack 
of a reference pressure makes it impossible to determine the inlet and outlet pressures, even 
though we know the flow. The three models in Figure 2 a-c all have at least one pressure and 
thus all four of the desired parameters can be determined. Table 1 summarizes this. Also note in 
Table 1 that in the Figure 2c case the flow can be determined, but it is by iteration.

Table 1: Four logical possibilities of boundary conditions for single pipe systems

As we consider multi-pipe systems, there are a host of other possibilities that present them-
selves. All other configuration possibilities which lack a reference pressure ultimately boil down 
to the same problem that exists in Figure 1.

The pipe lengths, diameters and friction factors are not included in the remaining models 
because they do not influence the main point of this topic. It is assumed that these parameters 
can be obtained for each pipe and the resulting pressure drop calculated with standard rela-
tionships.

Consider the model in Figure 3. With three boundaries having a known flow, this clearly has the 
same problem as the model in Figure 1. No unique pressures at any location can be calculated.
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A pressure at any one of the three boundaries in Figure 3 would be sufficient to allow a unique 
solution of the system. It is also possible that there could be two pressures and one flow, or three 
pressures. As long as there is one pressure a unique solution exists.

Figure 3: Three known flows at boundaries lack a reference pressure, similar to the model in Figure 
1. This model does not have a unique solution.

Now consider the models in Figure 4. The Figure 4a model does have one reference pressure, 
but in this case there is still a problem. The Flow Control Valve (FCV) is controlling the flow to 10 
gpm, and the downstream flow is demanding 10 gpm. The section of the system before the FCV 
can be solved (because there is a pressure upstream), but the section after the FCV does not 
have a unique solution. Why? In order to obtain a unique solution, the pressure drop across the 
FCV must be known. But any pressure drop could exist and satisfy the conditions of this model. 
It is thus not possible to determine the pressure at the outlet flow demand because it depends on 
the FCV pressure drop which is not known. The model in 4b does have a pressure downstream 
of the FCV, and thus there is a unique pressure drop across the FCV and a unique solution 
exists for the model in Figure 4b.

If you input the remaining data for the Figure 4a model and run it in AFT Impulse, you will get the 
message shown in Figure 5. AFT Impulse identifies the part(s) of the model where a known pres-
sure is needed.
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Figure 4a-b.: The model at the top does not have a reference pressure after the Flow Control Valve 
so the pressure drop across the FCV cannot be determined. The top model does not have a unique 
solution. The bottom model has a pressure upstream and downstream, and a unique solution exists.

Figure 5: AFT Impulse message when you try to run the model shown in Figure 4a.

Sizing Pumps with Flow Control Valves

An analogous situation to Figure 4a is when the user is trying to size a pump using the Pump with 
an assigned flow. The Pump with an assigned flow is really just a reverse FCV. It controls the 
flow by adding pressure, rather than reducing it. Figure 6 shows this case and is another 

- 732 -



example of a model without a unique solution, requiring more than one pressure junction. If the 
user instead entered a pump curve for this model, it could be solved.

Figure 6: A pump modeled as a fixed flow behaves identically to the FCV model in Figure 4a, for 
which no unique solution exists

Increasing in model complexity, Figure 7 shows some additional examples of models without a 
unique solution. In particular, Figure 7b has a pump with an assigned flow that can add as much 
pressure as it wants, and the downstream FCV can then take out as much as it wants. There are 
an infinite number of possible solutions. 

While it would be highly unusual for a system to have two FCVs in series, it is worth considering 
the model in Figure 7b further. It is common to have an FCV in series with a pump. How does 
one size the pump in such a case? There are several ways to do this, one of which is to change 
the pump from an assigned flow to an actual pump curve. Trying multiple pump curves will guide 
you to the best pump.

But there is a better way. Consider for a moment the pressure drop across the FCV in Figure 7b. 
In the installed system, is any pressure drop acceptable? Usually not. It is typical to have pres-
sure drop limits based on the system design and the FCV itself. A common requirement is a min-
imum pressure drop across the FCV. If no minimum pressure drop exists, let’s say we choose a 
pump that results in the pressure drop across the FCV being 0.01 psid. If the system is built and 
the pump slightly underperforms its published curve, the FCV will not be able to control to its 
flow control point. Even if the pump does operate exactly on the published curve, eventually foul-
ing in the pipes will result in increased pipe resistance (and pressure drop) and again the FCV 
will not be able to control to its flow control point. 

Figure 7: Neither model above has a unique solution. The top model has two flow control valves in 
series. The bottom model has a pump modeled as an assigned flow in series with an FCV. In both 

cases either a third pressure junction is needed between the two middle junctions, or one of the junc-
tions must be changed from a flow controlling device.
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To avoid these kinds of problems in installed systems, a minimum pressure drop across the 
FCV is typically required. This minimum pressure drop provides the key to sizing the pump in 
Figure 7b. Rather than model the FCV as a flow control valve, instead model it as a pressure 
drop control valve (PDCV) set to the minimum pressure drop requirement. Then a unique solu-
tion exists, the model will run and the pump can be sized. Once the pump is sized and an actual 
pump curve exists, the pump curve can be entered for the pump and the valve can be switched 
back to an FCV. Remember that when we use the PDCV, we are still getting the flow we want 
for the true FCV, because the pump is now providing the control.

Think for a moment what we just did. We went through a thought process that many engineers 
have gone through during their hand calculations. Specifically, we size the pump such that the 
FCV pressure drop is minimized. If the FCV has a larger pressure drop than the minimum, the 
pump must pump harder to overcome this excess pressure drop. In short, it must use more 
energy and is thus less efficient. Figure 8 depicts this process.

Figure 8a-c: The model at the top is the same as Figure 7b and does not have a unique solution. To 
size the pump, change the model to the second one shown above, which uses a pressure drop con-
trol valve (PDCV) rather than an FCV. Once the second model is run, the pump is sized, a pump 

curve exists, and the model at the bottom can be run using an FCV.

Let’s make a slight addition in complexity to the model in Figure 8. In this case we have two flow 
control valves in parallel (see Figure 9). To size this pump, we apply the process described in Fig-
ure 8. We choose one of the FCVs, make it a PDCV, size the pump, choose a pump with an 
actual pump curve and enter it into the model, then return the PDCV to an FCV. 
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Figure 9: A pump with an assigned flow in series with two parallel FCVs. The model in its current 
form does not have a unique solution. To size the pump, first change the FCV at J7 to a PDCV. 

This brings up the question, which FCV should one choose to turn into a PDCV? When FCVs 
are put in parallel, frequently the pipe design has one of the FCVs further away from the pump 
that the others. Because of the additional piping leading to this FCV, it will be the weakest link in 
the chain of parallel FCVs by virtue of having the lowest pressure drop across it. The most 
remote FCV should be chosen as the PDCV. If the most remote FCV is chosen, when the min-
imum pressure drop required is applied to the PDCV all other FCVs in the parallel system will 
have greater than the minimum pressure drop - thus satisfying the pressure drop requirement for 
those FCVs as well.

What if you do not know which FCV is the most remote? In this case make your best guess, 
change it to a PDCV at the minimum required pressure drop, run the model, then verify whether 
all other FCVs have a pressure drop that meets or exceeds the requirement. If not, then the 
FCV with the smallest pressure drop as determined by the first run is in reality the weakest FCV. 
Choose this FCV, change it to a PDCV, and then change the original PDCV back to an FCV 
since it is not the weak link. If the pipe system leading to each FCV is truly identical and all FCVs 
have identical pressure drops, any of the FCVs will serve as the PDCV.

The preceding process can be extended to cases where there are three or more FCVs in par-
allel, and also cases with more than one pump in parallel supplying the FCVs.

In Figure 9 the most remote valve is J7, the one on the right. If the minimum pressure drop is 5 
psid, change J7 to a PDCV with a 5 psi drop. This results in the output shown in Figure 10a. 
Notice how the pressure drop across the other FCV at J6 (6.837 psid) is greater than 5 psid 
because it is closer to the pump. Also notice how the flow through J7 is still 100 pgm even though 
it is not controlling flow. Once again, the reason for this is that the pump is controlling the flow to 
200 gpm, and with the J6 FCV controlling to 100 gpm, the excess must go through J7. The pump 
is thus sized and its pump pressure rise is shown in Figure 10b (113.5 ft.). 
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Figure 10a-b: Results from changing J7 in Figure 9 to pressure drop control valve

Pressure Control Valves

The problem of non-unique solutions can also occur when a Pressure Reducing Valve (PRV) or 
Pressure Sustaining Valve (PSV) is used. A PRV is used to control pressure downstream of the 
valve, while a PSV controls pressure at the valve inlet. One thing that PRVs and PSVs have in 
common with FCVs is that the pressure drop cannot be known ahead of time. The pressure drop 
depends on the balance of the pipe system.

Consider the simple system shown in Figure 11. With the pressure controlled downstream of the 
PRV, the pressure upstream is not known. Without knowledge of the PRV's pressure drop, the 
pressure upstream of the PRV cannot be determined and thus no unique solution exists. 

Figure 11: If a PRV is downstream of a known flow the PRV pressure drop cannot be calculated. 
This model does not have a unique solution.

Figure 12 shows the possible cases with PRVs and PSVs, while Table 2 comments on the six 
cases. In summary, at least one known pressure is always needed on the side of a pressure con-
trol valve opposite of the controlled side. 
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Figure 12a-f.: Six possibilities for PRV and PSV configurations. Cases A and E do not have unique 
solutions. See Table 2 for comments.

Table 2: Summary of six possibilities for PRV and PSV configurations.

If a pump is being sized in series with a PRV or PSV, modeling the pump as an assigned flow 
will not permit a unique solution if the pump is upstream of a PRV or downstream of a PSV. The 
reasons for this are the same as those in the previous section on FCVs.
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In combination with the previous examples, it should be apparent how the non-unique solution 
problem can occur in more complicated systems. In all such cases, the reasoning will boil down 
to the same problems already discussed.

Closing Parts of a System

A model may be built which has sufficient information to obtain a unique solution. Then a user 
closes a junction and all of a sudden the problem of no unique solution occurs. This is shown in 
Figure 13. The top model has a unique solution and will run fine. In the bottom model the valve is 
turned off and the section of the system downstream of the valve has only known flows. No ref-
erence pressure exists in this section because it is isolated from the known pressures in the sec-
tion on the left.

Figure 13: Top model has reference pressures at J1 and J2. Bottom model has closed valve at J4 
which isolates the J5 and J6 assigned flows. There is no reference pressure for J5 and J6 and no 

unique solution exists for the bottom model.

Steady State Considerations

There may be some situations - in particular for closed loop systems - where system com-
ponents can act as a pressurizer and fix the pressure in the system during steady state when 
there is no flow. In this situation, it may not make sense to provide a reference pressure for the 
system using a traditional pressure junction. An example for this behavior would be a gas accu-
mulator that pressurizes the system while there is no flow in steady state and then allow space to 
accommodate thermal expansion in the system.

In order to allow users to model that behavior, three different junctions have the ability to act as 
pressure reference points in steady state. These are the Assigned Flow junction, the Gas 
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Accumulator junction, and the Surge Tank junction. The Properties Window pages for each of 
these junctions give a better description on how to properly define and use this feature.

For the Gas Accumulator and Surge Tank junctions, the ability to fix a zero-flow pressure is inten-
ded to allow users to better model a pressurizer component. During the transient simulation 
these junctions work to mitigate surge events by compressing or expanding the gas inside them 
as pressure waves travel through the system. During steady state, the initial conditions are fixed 
such that the pressure is a known, flow is zero, and the gas volume inside the junction is defined 
by the user as normal.

For the Assigned Flow junction, the ability to fix a zero-flow pressure is intended to allow users to 
model a situation where no flow is present in a pipeline and as a valve opens flow is introduced to 
the system. It is possible that during steady state, the reference pressure is known downstream 
of the closed valve, isolating the rest of the pipeline from a reference pressure. Defining this 
zero-flow reference pressure would allow the user to model a system that might not otherwise 
have a valid reference pressure.

It should be noted that while normal pressure junctions are typically capable of acting as an infin-
ite fluid source, these three zero-flow reference pressure options will not. As the option implies, 
these features can only be used in a situation where zero flow is present. During the transient 
simulation, these junctions no longer act as reference pressures, do not have the potential to act 
as infinite fluid sources at constant pressure, and the pressure in the system is determined solely 
through the Method of Characteristics equations.

Summary

AFT Impulse models always require one reference pressure, and may require more if the engin-
eer uses control valves, pumps with assigned flows, or closes pipes or junctions. The actual num-
ber of reference pressures needed depends on the model, but AFT Impulse always checks to be 
sure sufficient reference pressures exist and stops to warn the user when they do not.

This capability is a powerful diagnostic feature that will help guide the user in building meaningful 
models.

Related Topics

Role of Pressure Junctions and How They Work 117
Nomenclature 683

Related Blogs

Reference Pressure Needed: Where It Comes from and How to Address it

Pipe Material Library References
Prior to AFT Impulse 6, pipe material properties were compiled from a variety of unofficial 
sources. Many of the original sources are now obsolete. Beginning in AFT Impulse 6, pipe mater-
ial properties are taken directly from national/international standards such as: ASTM, ANSI, 
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AWWA, and ASME. Several new material standards are being added. For example: DIN and 
JIS. With the addition of a significant number of new pipe material standards, the increased 
volume and scope necessitate splitting the pipe material library into several smaller independent 
libraries. All of the pipe material found in AFT Impulse 5 is still available, but is now called "AFT 
Customary". 

Maintaining several independent pipe libraries facilitates including or excluding specific stand-
ards. For example: a pipe engineer in Germany may prefer to use only ISO and DIN standards. 
The Library Manager can be used to "Connect" or Disconnect" each of the pipe material libraries. 
A list of available pipe libraries can be found below.

Note that while AFT attempts to provide this standard information to make defining pipe inform-
ation easier for the user, the prudent engineer will always verify this information against man-
ufacturer specifications. ASTM and ANSI standards exist for the thickness and diameter 
specifications for some of these materials. Furthermore, AFT attempts to source reference 
information from reputable and authoritative sources. However, data for pipe roughness and ther-
mophysical properties including density, thermal conductivity, modulus of elasticity, and Pois-
son's ratio have no single standard to follow. Thus, the user should always check that the pipe 
material inputs match the actual pipe material data for their system.    

 l Copper Pipe - ASTM - 
 l Source = ASTM B42-10
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2; Perry's chem eng Handbook, 7th ed. Table 10-33
 l Copper Tubing - ASTM - 

 l Source = ASTM B88-09
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2; Perry's chem eng Handbook, 7th ed. Table 10-31; 
www.cranecopper.com.au/sizes/astmb88.asp

 l Ductile Iron - ANSI - 
 l Source = ANSI-AWWA C150-A21.50-08
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2
 l Fiberglass - Green Thread -

 l Source = Fiber Glass Systems product data, http://www.nov.-
com/Segments/Completion_and_Production_Solutions/Fiber_Glass_Sys-
tems/Chemical_Industrial/Green_Thread.aspx 

 l Roughness References = Fiber Glass Systems product data
 l Density References = Average value calculated based on ID, OD and Weight in 

Fiber Glass Systems product data
 l Thermal Conductivity References = Fiber Glass Systems product data
 l Modulus of Elasticity References = Fiber Glass Systems product data
 l Poisson's Ratio References = Fiber Glass Systems product data
 l Additional References = ASTM D2996 - 17

 l HDPE - AFT Customary - 
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 l Source = Applied Flow Technology
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2
 l PVC - ASTM - 

 l Source = ASTM D1785-06
 l Additional References = Thermal data from: Materials Science and Engineering, 

Callister, Table C.4
 l PVDF - AFT Customary - 

 l Source = George Fischer Engineering handbook page 425
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2
 l Rectangular Duct - AFT Customary - 

 l Source = Applied Flow Technology
 l Stainless Steel - ANSI - 

 l Source = ASME-B36_19M_2004
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conduct References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Type 304
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ration Referenecs = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for Type 304 @ 20oC
 l Stainless Tubing - AFT Customary - 

 l Source = Applied Flow Technology
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2
 l Steel - AFT Customary - 

 l Source = Applied Flow Technology
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

 l Steel - ANSI - 
 l Source = ASME B36.10-2004
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
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 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 
A3.3

 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 
for Wrought Carbon Steel, 0.23 C, 0.635 Mn

 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - DIN 2391-1 - 
 l Source = DIN 2391-1-1994
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - DIN 2458 -
 l Source = DIN 2458-1981
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10216-1 (s1) - 
 l Source = BS EN 10216-1-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

- 742 -



 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 
1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC

 l Additional References = ANSI 36.10, CRANE Technical Paper 410
 l Steel - EN 10216-2 (s1) - 

 l Source = BS EN 10216-2-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-1 (s1) - 
 l Source = BS EN 10217-1-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-2 (s1) - 
 l Source = BS EN 10217-2-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-4 (s1) - 
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 l Source = BS EN 10217-4-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-5 (s1) - 
 l Source = BS EN 10217-5-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-6 (s1) - 
 l Source = BS EN 10217-6-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

Related Topics

Libraries 665
Library Manager 666
Network Library Overview 675
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Library Locations in General Preferences 681
Pipe Material Library 670
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Output Messages & Warnings
Various types of messages may be given in the output when you run a model. These messages 
are intended to alert you about problems with the model or solution. There are different message 
classifications depending on the severity, but all message types should be reviewed when they 
are displayed in the output.

The links below will take you to a message list for the corresponding message type with a brief 
explanation given for each.

 1. CRITICAL WARNING - Very High Severity - The model is not accurately predicting beha-
vior, and the solution may violate the engineering assumptions of the software. These 
issues must be resolved for the model to be trustworthy, and the output should only be 
used for error resolution or troubleshooting purposes and never for engineering 
decisions.

 2. WARNING - High Severity - A serious issue with the model or results exists. For example, 
the solution has exceeded a valid data range, or potentially unrealistic behavior is occur-
ring. A real system may encounter operational problems under the conditions.

 3. CAUTION - Moderate/Low Severity - Something may be wrong with the model or of 
interest for the user to double check. Depending on the application, the results may or 
may not be affected. If results are affected, it would be to a lower degree compared to a 
Warning.

 4. INFORMATION - An Information message is intended to make the user aware that an 
advanced feature is being used in the model, or to provide comments or suggestions relat-
ing to an advanced feature. Following suggestions may achieve higher accuracy results if 
the right conditions apply, but can also cause incorrect results if not applied properly. If 
the user understands the feature then no action is required.

Any message that directly lists a pipe/junction can be double-clicked  to take you directly to the 
object on the Workspace. Whenever a Warning or Critical Warning message type is displayed, 
the General Results section will display red text.

Related Topics

Troubleshooting 777

Critical Warnings
The model is not accurately predicting behavior, and the solution may violate the engineering 
assumptions of the software. These issues must be resolved for the model to be trustworthy, and 
the output should only be used for error resolution or troubleshooting purposes and never for 
engineering decisions.

CRITICAL WARNINGS
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Artificial Transient - Initial pressure/flow conditions at Pipe X 
Station Y are not steady (Error = Z%)

A Critical Warning message in AFT Impulse.

Full Message Text

There are several variations of this message:

 l Artificial Transient - Initial pressure conditions at Pipe X Station Y are not steady (Error = 
Z%)

 l Artificial Transient - Initial flow conditions at Pipe X Station Y are not steady (Error = Z%)

Explanation

AFT Impulse detected an Artificial Transient in the model. A full explanation of Artificial Tran-
sients is found on the topic linked in the previous sentence, but in summary, it is a mismatch 
between the steady-state results and the "zero time step" of the transient simulation. The steady-
state results are used to initialize the Method of Characteristics transient solution methodology. 
There will always be a mismatch due to the nature of the different solution methodologies; how-
ever, it should be within a small tolerance. In the case of this Critical Warning, the tolerance was 
exceeded. In general, Artificial Transients will affect your results, and you should be careful to 
understand what is happening.

Required Action

Read the Troubleshooting Artificial Transients topic and follow the steps in an effort to eliminate 
the Artificial Transient. Use engineering judgment to determine if the magnitude of error is 
acceptable.

Related Topics

Artificial Transient Detection Panel 207
Troubleshooting Artificial Transients 107

FCV/PRV/PSV could not control pressure - Pressure was 
added to achieve control flow/pressure

A Critical Warning message in AFT Impulse.

Full message is:

FCV/PRV/PSV could not control pressure/flow at Junction X. Pressure was added to achieve 
control flow. See Valve Summary for more information.
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A flow or pressure control valve could not control pressure/flow and the setting is to Always Con-
trol (Never Fail). In order to achieve the control flow or pressure, the valve must add pressure 
and act like a pump.

This warning is useful for resolving operational problems in your system.

Junction X cavitates - Infinite pipe junctions do not support 
cavitation

A Critical Warning message in AFT Impulse.

An infinite pipe boundary on an Assigned Pressure or Assigned Flow junction is designed to 
have zero reflections. Transient cavitation that occurs at the junction is a sure sign of reflections. 
The infinite pipe model is not appropriate.

Furthermore, any cavitation that would occur in the real pipe past the infinite pipe boundary but 
does not occur because that part of pipe is being neglected also means that the infinite pipe 
model is not appropriate.

Related Topics

Interpreting Cavitation Results 100
Cavitation 69
Transient Cavitation Models 707

Junction X Had Reverse Flow Pump Head Could Not Be Pre-
dicted

A Critical Warning message in AFT Impulse.

This message displays for centrifugal pumps when the flowrate goes backwards through the 
pump and the Manufacturer's Curve is being used for calculations, rather than defining a Four 
Quadrant Data Set. The pump head rise under such conditions is unknown. The dead head 
value is used.

Pipe sequences of zero friction exist, flow rate cannot be cal-
culated

A Critical Warning message in AFT Impulse

This message is displayed if all of the pipes in a flow path are defined as frictionless by using the 
zero-length connector option, or the "frictionless" friction model.

At least one pipe in every flow path needs to include frictional losses in order to perform flow cal-
culations.
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Setting relaxation lower than relative pressure flow tolerance 
gives unreliable results 

A Critical Warning message in AFT Impulse.

Setting the relaxation to a value close to or lower than relative tolerance can lead to false con-
vergence and invalid results. AFT Impulse alerts the user to this when inputting data in the Iter-
ations Panel, and also alerts the user once the solution has been obtained.

The air volume entering through Junction X exceeds the 
volume of a connected pipe

A Critical Warning message in AFT Impulse

The air volume entering through Junction X exceeds the volume of a connected pipe. The air 
valve can only model air in a connected pipe. Results with more than 100% air volume are unre-
liable.

If there are two connected pipes this warning will always apply to the pipe with the smaller 
volume.

Impulse's solution method assumes that the pipes are liquid full. If the volume of air in the system 
has not exceeded the volume of a single pipe station, then the liquid full assumption only has a 
minor impact on accuracy. However, if the volume of air entering the system exceeds the volume 
of a computational section then the liquid full assumption will cause a larger decrease in accur-
acy.  Impulse uses an adjusted solution method to account for the air entering at the air valve, but 
does not account for air traveling past the pipes connected to the air valve. Any calculations past 
the point that the air volume exceeds the connected pipe volume will be invalid.

It is recommended to review the model inputs. Depending on how the air valve and physical sys-
tem is configured it may be useful to consider changes such as modeling the air valve inline (with 
two pipes connected), resizing the valve, or moving the valve to a different location.

Modeling the air valve as inline helps to eliminate the potentially short connecting pipe, which will 
improve model run times and allow the air valve to be attached to longer pipes. Resizing or relo-
cating the air valve can help to reduce the amount of air let into the system and can help reduce 
operational issues due to entrapped air.

Related Topics

Air Valve 299
Air Valve Waterhammer Theory 301

The Following Pipes Have Vapor Volumes in Computing Sta-
tions Greather Than 100% of the Liquid Computing Volume

A Critical Warning message in AFT Impulse
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Full Message Text

The following pipes have vapor volumes in computing stations greater than 100% of the liquid 
computing volume:

Pipe X (Name), Stations: Y (Z%)

Explanation

This Critical Warning is part of a series of Output Messages meant to convey increasing uncer-
tainty in results as Percent Vapor Volume increases.

 l Caution - greater than 0.1% but less than 10%
 l Warning - greater than 10% but less than 100%
 l Critical Warning - greater than 100%

A detailed explanation about the Percent Vapor Volume parameter, section volume, and 
assumptions can be found on the Interpreting Cavitation Predictions topic. In summary, 
Impulse's solution methodology assumes that pipe sections are 100% liquid-full. This warning is 
stating that for the listed pipe stations, the Percent Vapor Volume was greater than 100% of the 
section volume at some point during the transient, which is fully violating the 100% liquid-full 
assumption.

Vapor volumes larger than the total volume in the pipe section are physically unrealistic and indic-
ate that full column separation and extensive transient cavitation are likely occurring in 
the system at that point. In this situation, the cavitation models are no longer physically mean-
ingful, and the conditions in the model may be outside of the single-phase assumption that 
Impulse is based on.

Required Action

Users should explore the various cavitation topics - and in particular the Interpreting Cavitation 
Predictions topic - to better understand what is causing these results, why they are possible, and 
how to interpret results in scenarios with this critical warning. If all else fails, users should treat 
systems with these results with extreme caution.

Related Topics

Interpreting Cavitation Results 100
Cavitation 69
Transient Cavitation Models 707

These results do not represent a converged solution
A Critical Warning message in AFT Impulse
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This message alerts you to the fact that you chose to have results displayed for an unconverged 
solution. You should only use the displayed results for purposes of determining the reasons for 
nonconvergence. Under no circumstances should you actually use any of the results for engin-
eering purposes.

Weir Liquid Level Convergence Problem
A Critical Warning message in AFT Impulse

This message indicates that the flow required at the weir to maintain flow continuity in the system 
is higher than the maximum flow the weir can deliver. It is recommended to review the system 
and weir inputs to resolve the issue.

Zero-Length Connector Experienced Cavitation
A Critical Warning message in AFT Impulse

Full message text is:

The following Zero-Length Connectors experienced cavitation during the simulation, results are 
not valid

A Zero-Length Connector is a pipe model option which allows the user to define the pipe with no 
length associated with it. This tool is meant to help simplify a model with many short connections 
between system components and is not meant to capture some complex transient events includ-
ing cavitation. Results shown with this message should not be used to make engineering 
decisions.

The user should assign lengths to the listed pipes and re-run the model to avoid cavitation in the 
Zero-Length Connector. Note that Zero-Length Connectors are commonly used to avoid run 
time concerns associated with having short pipes in a model, and replacing the Zero-Length Con-
nector with a pipe of negligible length may cause unnecessarily long run times due to the sec-
tioning process.

Warnings
A Warning is of High Severity, and should always be reviewed before considering the results to 
be meaningful for the system.

A serious issue with the model or results exists. For example, the solution has exceeded a valid 
data range, or potentially unrealistic behavior is occurring. A real system may encounter oper-
ational problems under the conditions.

WARNINGS
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Air Valve Junction X steady state pressure Y is below cracking 
pressure Z

A Warning message in AFT Impulse

Air Valves must be closed during steady-state, but if the steady-state pressure (shown as Y) is 
below the cracking pressure (shown as Z) they will open when the transient begins. This will 
cause an artificial transient in the system.

Related Topics

Air Valve 299
Air Valve Waterhammer Theory 301

Chempak temperature and or pressure is out of range for the 
following

A Warning message in AFT Impulse.

The final solution had temperature and/or pressure conditions in the specified pipes obtained 
with Chempak physical property data which were outside Chempak’s valid range. The range 
value is also displayed. This indicates that the results are probably not valid. It also may indicate 
an input error in the model because of the extreme temperature or pressure state.

FCV at Junction X could not control flow
A Warning message in AFT Impulse

This warning alerts you that the Flow Control Valve at junction X was not able to control the flow, 
and backflow may have occurred.

Flow at Junction X may not be balanced total Y
A Warning message in AFT Impulse

This warning alerts you to the fact that the converged results may be incorrect. Once a con-
verged solution is obtained, AFT Impulse checks all junctions to ensure a flow balance exists. It 
compares the imbalance to the flow tolerance you specified, and when it appears to exceed the 
tolerance, it gives you this warning.

If the magnitude of the out of balance flow is close to the tolerance you specified, then it is gen-
erally safe to ignore this warning, although you may want to reduce your tolerances further and 
rerun the model.

If the magnitude of the flow out of balance is large, then you have a converged solution that is 
incorrect. This can occur in rare circumstances. When this happens, then it is usually an indic-
ator that your model is not realistic.

You should always review each of these warnings in detail, and perform hand calculations on the 
flow balance at the affected junctions to verify whether an acceptable solution exists.
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Flow is into system at Reservoir Junction X 
A Warning message in AFT Impulse

Full message is:

Flow is into system at Reservoir Junction X. Pipe intake elevation above the surface will supply 
gas, not liquid.

When a pipe exits above a reservoir junction liquid level it is only meaningful if it is discharging 
into the reservoir. If the pipe becomes an intake, it will not supply liquid, but instead supplies 
whatever vapor is above the reservoir liquid. This warning alerts you to the fact that the reservoir 
had a pipe above liquid level. AFT Impulse assumes the intake fluid is the same as the reservoir 
fluid, but that is likely not the case. Results are probably invalid.

HGL EGL and head loss results may not be meaningful for vari-
able density systems 

A Warning message in AFT Impulse

The concepts of HGL (Hydraulic Gradeline) and EGL (Energy Gradeline) are only valid for con-
stant density systems. This warning is given when HGL, EGL or head loss results are displayed 
in the output and the system has variable density. It alerts the user that HGL/EGL and head loss 
output may not be meaningful. Unless otherwise noted, all other output is valid.

Junction X cavitates. Cavitation at air valve junctions can 
cause anomalous results which may be incorrect.

A Warning message in AFT Impulse

Full message is:

Junction X cavitates. Cavitation at Air Valve junctions can cause anomalous results which may 
be incorrect.

An Air Valve junction is designed to allow air into the pipe but cannot keep track of vapor forming 
at the junction due to low pressure. If cavitation is predicted at the junction, the valve is likely 
undersized and is not preventing vacuum conditions.

Related Topics

Interpreting Cavitation Results 100
Cavitation 69
Transient Cavitation Models 707
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Junction X Exceeded Runout Flow Rate
A Warning message in AFT Impulse

Centrifugal pump curves typically have a point at which they no longer operate on the curve. This 
may be called end of curve or runout. Data defining runout for a particular pump is given by the 
manufacturer. Such data has been defined for this pump in the Pump Configuration window, and 
the system is operating past the runout flow rate. Thus the results are likely invalid, as the real 
pump may not be able to operate at that point.

Junction X Has Insufficient Pump NPSH
A Warning message in AFT Impulse

The available pump NPSH (or NPSP) is less than that required. Thus the real pump will likely 
cavitate. Note that AFT Impulse does not model cavitation events inside junctions, including 
NPSH issues.

Maximum peak to peak pressure limit has been exceeded
A Warning message in AFT Impulse (PFA Module Only)

Full message is:

The maximum peak-to-peak pressure limit has been exceeded at X location(s).

The maximum peak-to-peak pressure occurred at Pipe Y - Station Z (dP=A, maximum dP=B)

In the PFA module, resonant frequencies are calculated for the modeled system. If these fre-
quencies are caused by a positive displacement pump, the PFA module will automatically gen-
erate scenarios that evaluate problematic pump speeds. As part of the calculations when 
modeling these pump speeds, the PFA module will compare the peak-to-peak pressures gen-
erated with that pump speed, and it will produce a warning if these pressures violate the stand-
ards described in American Petroleum Institute 2010 Anex C sections A.1 and A.2, pages 67-68.

Note that the peak-to-peak pressure is defined as the difference between the maximum and min-
imum pressures.

Negative added pressure by pump at Junction X
A Warning message in AFT Impulse

Full message text is:

Positive Displacement Pump J2 Added Negative Pressure

A pump junction with an assigned flow rate had a pressure loss across the pump junction either 
in the steady state or transient system. This warning is meant to alert the user that the pump is 
not adding pressure as they may be expecting.
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Pipe force calculations are not reliable when cavitation occurs 
during the simulation

A Warning message in AFT Impulse

Full Message Text

Pipe force calculations are not reliable when cavitation occurs during the simulation

Explanation

A key component of AFT Impulse's transient hydraulic force calculations is the pressure dif-
ferential across the force set. Specifically, the pressure differential caused by transient pressure 
waves in the system will cause a transient force to act on the system. Thus, the transient forces 
reported by AFT Impulse are only as accurate as the pressure waves predicted in the system.

Cavitation events including vapor volume formation, growth, and collapse all generate transient 
waves in the system, meaning they all cause transient forces to act on the system. Furthermore, 
cavitation inherently violates AFT Impulse's assumption that all pipes are 100% liquid full. Thus, 
the transient forces reported during and after cavitation events are only as reliable as the pre-
dicted cavitation events themselves.

If limited cavitation is predicted and determined to be accurate, the associated transient force res-
ults are likely also accurate. However, if cavitation is predicted to extend throughout large por-
tions of the system or cause large vapor volumes to form, those results and associated transient 
forces may not be accurate, and should be used with caution.

Required Action

Read the Interpreting Cavitation Results topic and reference the Detailed Decision Tree section. 
Use engineering judgment to determine if the results are reliable.

Pipe X completely drained at Y seconds
A Warning message in AFT Impulse

If pipes use the partially full feature, it is possible they will completely drain. AFT Impulse cannot 
properly model the pipes after this point, and subsequent results may not be valid. This warning 
alerts you that the specified pipes drained during the transient.

Pipe X pressure is below 10% vapor pressure
A Warning message in AFT Impulse (PFA Module Only)
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Full message is:

Pipe X - Station Y pressure is below 10% vapor pressure margin. Pressure = Z. Note: There are 
also N other locations.

In the PFA module, resonant frequencies are calculated for the modeled system. If these fre-
quencies are caused by a positive displacement pump, the PFA module will automatically gen-
erate scenarios that evaluate problematic pump speeds. As part of the calculations when 
modeling these pump speeds, the PFA module will calculate the lowest pressure margin above 
vapor pressure. If the relationship between the lowest pressure and vapor pressure shown in 
Equation 1 below (from American Petroleum Institute,  2010 Equation A.3) is not satisfied, this 
warning is displayed.

(1)

PRV at Junction X could not control pressure
A Warning message in AFT Impulse

This warning alerts you that the Pressure Reducing Valve at junction X was not able to control 
pressure, and backflow may have occurred.

PSV at Junction X could not control pressure
A Warning message in AFT Impulse

This warning alerts you that the Pressure Sustaining Valve at junction X was not able to control 
pressure, and backflow may have occurred.

Pump X had efficiency greater than 100%
A Warning message in AFT Impulse

Full message is:

Pump X had efficiency greater than 100%. This may be due to a density sufficiently greater than 
the basis of the power input data or an error in the power input data. For non-inertial models, only 
the output values for efficiency and power are affected. For inertial models, all pump results will 
be impacted.

This warning message could be caused by incorrect input data, or could be a result of using Four 
Quadrant pump curves:

 1. Check that the efficiency/power data is entered correctly in the Pump Configuration win-
dow, and that the correct selection is made for either efficiency or power in the dropdown 
header of the column.  If power data is being used, a reference density may need to be 
entered to correct the data, see the Reference Density topic for more information.
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 2. For a pump defined using a Trip with Inertia or Startup with Inertia transient, check that 
the Total Rotating Inertia is entered correctly. The power data and reference density 
should still be checked as discussed above.

 3. For a pump startup, verify that the provided torque data is the motor torque, and not the 
pump torque data, as is discussed in the Startup with Inertia topic.

 4. If a Four Quadrant pump curve model is being used, check if the Four Quadrant efficiency 
curve is at or above 100% for any of the flowrates experienced in the transient.

Pump X is using a Standard Pump Curve and...
A series of Warning messages in AFT Impulse

There are several different versions of this warning message that may occur when using a Stand-
ard Pump Curve (SPC) rather than a Four Quadrant Pump Curve (4QC). These include:

 l Pump X is using a Standard Pump Curve and had reverse flow. Head rise and 
power for negative flowrates were estimated using zero flow values. Predictions 
after reverse flow may not be reliable. A four quadrant model may be appropriate - 
see the Help Topic "Four Quadrant Data Set Selection" for details. This warning indic-
ates that the pump junction is using a SPC and saw reverse flow. In that case the pump 
performance was estimated using the values entered for zero flowrate. This estimate may 
be acceptable when small amounts of reverse flow are seen through the pump. When 
reverse flow is present for longer durations or with larger magnitudes, the user should 
strongly consider using a 4QC to model their pump.

 l Pump X is using a Standard Pump Curve and head rise was negative. A four quad-
rant model may be appropriate - see the Help Topic "Four Quadrant Data Set Selec-
tion" for details. This warning indicates that the head rise across the pump junction was 
negative, either in the Steady-State solution or during the Transient Simulation. This beha-
vior might have happened due either to the upstream and downstream pressures being 
set incorrectly, or to the pump operating far enough to the right on its curve that the head 
rise was negative. For centrifugal pumps, this behavior is only allowed if the "Allow Neg-
ative dP" Advanced Parameter in the Advanced Parameters Panel has been set to "Yes".

 l Pump X is using a Standard Pump Curve and head rise was predicted as negative 
and set to zero. A four quadrant model may be appropriate - see the Help Topic 
"Four Quadrant Data Set Selection" for details. This warning indicates that the head rise 
across the pump junction was predicted to be negative, but set to zero either in the 
Steady-State solution or during the Transient Simulation. This behavior could have 
happened due either to the upstream and downstream pressures being set incorrectly, or 
to the pump operating far enough to the right on its curve that the head rise was negative. 
Users should examine their pump input including pump curve data, pump curve fit, and 
pump curve reference density to ensure correct pump performance calculations. Fixing 
the head rise to zero in this situation is the default behavior of AFT Impulse. Users can 
allow the head rise to go negative by setting the "Allow Negative dP" Advanced Para-
meter in the Advanced Parameters Panel to "Yes". Positive Displacement Pumps will 
never see a negative head rise set to zero.

 l Pump X is using a Standard Pump Curve and power was negative.  A four quad-
rant model may be appropriate - see the Help Topic "Four Quadrant Data Set 

- 758 -



Output Messages & Warnings

Selection" for details. This warning indicates that the power requirements for the pump 
were estimated as negative. Users should examine their pump input including pump 
curve data, pump curve fit, and pump curve reference density to ensure correct pump per-
formance calculations, and consider using a Four Quadrant Pump Curve if possible.

 l Pump X is using a Standard Pump Curve and flow exceeded End of Curve. If no 
End of Curve was specified, this is the largest entered flow. (Y gal/min, Z 
seconds) The head or power curve does not close the quadrant. Check the curve 
data at the calculated flows. A four quadrant model may be appropriate - see the 
Help Topic "Four Quadrant Data Set Selection" for details. This warning indicates that 
not only is the flow through the pump past either the End of Curve setpoint or the last data 
point for the curve that the user has entered, but that the curves increase unbounded as 
flow increases rather than crossing the zero head axis (x-axis) and staying there. In the 
transient simulation, the time listed is the first time that this End of Curve value is 
exceeded. The pump may operate past this point later in the simulation as well. Note that 
if the pump is operating at a speed other than 100%, Impulse will apply the Affinity Laws 
to the End of Curve or last data point entered for the pump at 100% speed. Thus, this 
warning can be generated at flowrates lower than the specified End of Curve if the pump 
is running at low speeds. Users should check the pump performance both during steady 
state and the transient simulation to ensure that the pump is only operating on the portion 
of the curve prior to the flowrate where head and power begin to increase again. Altern-
atively, users could return to the Pump Configuration window and update their entered 
data or curve fit such that the head or power curves close the quadrant.

Static pressure lower than vapor pressure at inlet outlet of 
pipe/junction X

A Warning message in AFT Impulse

This warning alerts the users that the steady-state static pressure is lower than the vapor pres-
sure in the specified pipe or junction and that cavitation may occur. This warning is only shown if 
cavitation is not being modeled. If cavitation modeling is enabled (which is true by default), and 
cavitation exists in the steady-state, the transient simulation will not proceed.

Related Topics

Interpreting Cavitation Results 100
Cavitation 69
Transient Cavitation Models 707

Surge Tank Junction X began overflowing at Y seconds
A Warning message in AFT Impulse

The total volume of fluid entering the surge tank junction has exceeded the volume of the tank.
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Surge Tank Junction X completely drained at Y seconds
A Warning message in AFT Impulse

If a surge tank completely drains, AFT Impulse cannot properly model the surge tank after this 
point.This warning alerts you that this happened during the transient.

AFT Impulse will continue to supply liquid to the system from the drained surge tank.

Tank Junction X began overflowing at Y seconds
A Warning message in AFT Impulse

The total volume of fluid entering the tank junction has exceeded the volume of the tank.

Tank Junction X completely drained at Y seconds
A Warning message in AFT Impulse

If a Finite Tank completely drains, AFT Impulse cannot properly model the tank after this point, 
and results are unreliable. This warning alerts you that this happened during the transient.

AFT Impulse will continue to supply liquid to the system from the drained finite tank at the surface 
pressure specified for the junction.

The following pipes have vapor volumes in computing stations 
greater than 10% but less than 100% of the liquid computing 
volume

A Warning message in AFT Impulse

Full Message Text

The following pipes have vapor volumes in computing stations greater than 10% but less than 
100% of the liquid computing volume:

Pipe X (Name), Stations: Y (Z%)

Explanation

This Warning is part of a series of Output Messages meant to convey increasing uncertainty in 
results as Percent Vapor Volume increases.
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 l Caution - greater than 0.1% but less than 10%
 l Warning - greater than 10% but less than 100%
 l Critical Warning - greater than 100%

A detailed explanation about the Percent Vapor Volume parameter, section volume, and 
assumptions can be found on the Interpreting Cavitation Predictions topic. In summary, 
Impulse's solution methodology assumes that pipe sections are 100% liquid-full. This warning is 
stating that for the listed pipe stations, the Percent Vapor Volume was greater than 10% but less 
than 100% of the section volume at some point during the transient, which is violating the 100% 
liquid-full assumption to a substantial degree.

Vapor volumes between 10 and 100% of the section volume indicate that major transient cavit-
ation is occurring at that point in the system. Impulse's cavitation models are meant to capture 
limited transient cavitation in a system, and have limited accuracy as vapor volume increases. 
Depending on the system, this amount of transient cavitation may be a cause for concern since it 
can lead to additional waterhammer effects.

Required Action

Users should explore the various cavitation topics - and in particular the Interpreting Cavitation 
Predictions topic - to better understand what is causing these results, why they are possible, and 
how to interpret results in scenarios seeing this warning. If all else fails, users should treat sys-
tems with these results with caution, and incorporate large safety factors into their designs.

Related Topics

Interpreting Cavitation Results 100
Cavitation 69
Transient Cavitation Models 707

Transient data was extrapolated at Junction X
A Warning message in AFT Impulse.

The transient data at Junction X does not have time data that covers the entire time frame of the 
simulation as defined on the Simulation Duration panel. The final two data points will be used to 
linearly extrapolate the results for the remaining time steps of the simulation. You can enter addi-
tional time data points at Junction X to avoid this message.

Linear extrapolation may cause undesired results for certain parameters such as pump speed or 
valve Cv, where in reality the final value would not change, but the linear extrapolation will con-
tinue changing the value for the remainder of the simulation.

This extrapolation behavior can be changed in the User Options window on the Tools menu, 
under the Waterhammer Options.
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Transient static pressure lower than vapor pressure at Pipe X 
Station Y

A Warning message in AFT Impulse.

This warning alerts the users that the transient static pressure is lower than the vapor pressure in 
the specified pipe and that transient cavitation may occur. This warning is only generated when 
cavitation is not being modeled.

Related Topics

Interpreting Cavitation Results 100
Cavitation 69
Transient Cavitation Models 707

Unique Solution Not Possible Relief Valve Cycles
A Warning message in AFT Impulse

The relief valve cycles between its open and closed state. When closed, the pressure exceeds 
its cracking pressure and causes it to open. When open, the pressure drop resulting from flow 
causes the pressure to fall below the cracking pressure and so it closes.

Velocity in pipe X is less than the deposition velocity
A Warning message in AFT Impulse

(SSL Module Only)

Full Message Text

Steady-State:

Velocity in pipe W is less than the deposition velocity. Results may be inaccurate. (Velocity: Y, 
Vsm: Z)

Transient:

Velocity in pipe W is less than the deposition velocity at time X. Results may be inaccurate past 
this time step. (Velocity: Y, Vsm: Z)

Explanation

Engineers often want to avoid operating settling slurry systems in such a way that the bulk slurry 
velocity (Vm) is less than the deposition/settling velocity (Vsm). This warning indicates that the 
velocity is in fact less than the deposition velocity which can cause operational problems includ-
ing stationary beds or plugging of pipes. The methods available in the SSL Module cannot model 
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stationary beds, and thus the results may not be accurate under these conditions. The farther the 
velocity drops below Vsm the more uncertainty in the results.

Some types of transient analyses such as pump trips or full valve closures will inherently result in 
the bulk velocity of the fluid reducing to zero. When this warning is triggered from such cir-
cumstances, all results past the reported time step should be treated with caution since they may 
be inaccurate. Results prior to the reported time step can be used assuming no other warnings 
or critical warnings are present.

Required Action

Adjust the model such that the velocity is higher than the deposition velocity. If this is not pos-
sible, then it may indicate operational problems in the real system, or you must accept that the 
results will be incorrect.

Potential adjustments:

 l Decrease the pipe size
 l Increase the flowrate
 l Reduce the slope of the pipe

Cautions
Something may be wrong with the model or of interest for the user to double check. Depending 
on the application, the results may or may not be affected. If results are affected, it would be to a 
lower degree compared to a Warning. While some Caution messages may be left unresolved 
without affecting model results, they should never be ignored by the user.

CAUTIONS

Assigned Flow at Junction X has a constant flow rate during 
the transient

A Caution message in AFT Impulse

Full message is:

Assigned Flow at Junction X has a constant flow rate during the transient. During a transient the 
flow usually changes. This may not be an appropriate use of the junction.

An Assigned Flow junction fixes the flow at a boundary. When a transient occurs in the system, it 
is common to see all flows affected by the transient. This is a reminder that this junction may not 
be the appropriate junction to model a transient boundary condition. In general it is better to use 
Assigned Pressure or Reservoir junctions at boundaries.

If there is a specific reason for using a fixed flowrate then the Assigned Flow junction may be 
appropriate. For example, representing a PD Pump as an Assigned Flow when using the PFA 
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module is necessary to apply a forcing function at the system boundary to effectively "ring" the 
system.

Check Valve closed at Junction X
A Caution message in AFT Impulse

This is a cautionary notice that a check valve closed.

Constant Friction Factors Were Used for the Transient Ana-
lysis

A Caution message in AFT Impulse

Full message is:

Constant friction factors from the steady-state calculations were used during the transient ana-
lysis. The pipes listed below appear to have a wide range of actual friction factors and the pre-
dicted results may not be reliable. If a pipe is listed as closed, then the friction factor was 
estimated using a velocity of 5 feet/sec (1.52 meters/sec). It is recommended to use a Time Vary-
ing friction model which is defined in the Transient Friction panel.

This caution message is intended to alert users that the model results may not be reliable, as the 
transient analysis is using the initial steady-state friction factors. In some cases, this estimate 
may be appropriate, while in others it may not. Below the text of the caution, the steady-state fric-
tion factor being used and the potential maximum transient friction factor are listed. This can help 
give users an idea of how well this transient friction model fits their system. In the case that a 
pipe is closed or has no flow through it in the steady-state, the friction factor is estimated using a 
velocity of 5 feet/sec (1.52 meters/sec).

When this message is shown, it is recommended that a Time Varying friction model is used for 
the transient simulation. This option can be specified in the Transient Friction Panel.

Flow through Junction X is negative. Loss factors may be in 
error.

A Caution message in AFT Impulse

This warning alerts you to flow in junctions which is in the opposite direction from the connecting 
pipes' reference directions. Any loss information you specified for junctions may be in error 
because it was defined assuming flow in the other direction.

Head loss, head rise, hydraulic gradeline, and energy 
gradeline output does not have meaning for zero g systems

A Caution message in AFT Impulse
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Full message is:

Head loss, head rise, hydraulic gradeline, and energy gradeline output does not have meaning 
for zero g systems.

If the user sets the gravity to zero, presumably for a space application, then the concept of head 
and gradeline lose meaning. This can be set in the Environmental Properties Panel. For example 
see Equation 1 in Network Solution Methodology and see that zero g leads to a meaningless 
HGL (hydraulic gradeline).

Users should ignore all head loss, head rise, and gradelines displayed in the output and focus on 
pressure results.

Head rise across fixed flow pumps is referenced to system g 
level

A Caution message in AFT Impulse

Full message is:

Head rise across fixed flow pumps is referenced to system g level. To obtain standard head rise, 
divide the displayed head rise by the g level.

If the user sets the gravity to something other than standard earth gravity in the Environmental 
Properties Panel then the head rise at a pump is referenced to that g level on not 1 g.

Junction X exceeded maximum event messages
A Caution message in AFT Impulse

To limit how much data is displayed in the output, there is a maximum number of event mes-
sages that can be displayed for a junction. This limit was reached. This means that there are 
some events that happened but no event message is displayed. The maximum event messages 
setting can be changed in the Output Control window on the Format & Action tab.

Junction X has a density change across it
A Caution message in AFT Impulse

Full Message Text

Junction X has a density change across it. If this is due to a moving interface and not heat input 
or output then a Volume Balance junction is recommended.

Explanation

This warning is shown when the user has selected Variable Fluid properties on the Variable Flu-
ids panel, and the density of the fluid is changing between pipes. The Solver performs a mass 
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balance at junctions, and fluids of different densities on either side of the junction may violate the 
mass conservation at a junction.

Required Action

If the change in density is due to a change in temperature across the junction, the caution mes-
sage can likely be ignored. A density change at a junction due to temperature change means the 
real system likely still has a mass balance at the junction.

If the change in density is due to a change in fluid type or moving interface, the caution message 
likely should not be ignored. An example of a change in fluid or moving interface is a pipeline car-
rying fluids of different properties such as oils of different density, or a system is being flushed 
with water. In this example, the volumetric flowrate is likely conserved across a junction in the 
real system even if mass is not conserved. The Volume Balance junction can be used at the fluid 
interface to capture this situation. However, the Volume Balance is limited in that it cannot cap-
ture the interface location changing with time, and is only applicable to steady-state or a very 
short transient in a long pipeline.

Junction X uses the Dimensional Check Valve Type Y which 
has a diameter of Z

A Caution message in AFT Impulse

Full message is:

Junction X uses the Dimensional Check Valve Type of Y which has a diameter of Z. The down-
stream Pipe A has a diameter of B. A Dimensional Valve Type with a diameter of B or a Non-
Dimensional Valve Type is recommended.

The Dimensional Check Valve options are based on actual valves for which empirical data is 
available. These dimensional options should only be used when they match the actual size of the 
valve in the real system. If the dimensional option does not match the actual valve size, the user 
should choose a more appropriate dimensional option or use the non-dimensional options.

Losses at one or more pipes or junctions may be significantly 
impacted (>25%) by laminar or non-Newtonian conditions, but 
no correction was made

A Caution message in AFT Impulse

Full Message Text

Losses at one or more pipes or junctions may be significantly impacted (>25%) by laminar or 
non-Newtonian conditions, but no correction was made. Checking the 'Laminar/Non-New-
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tonian Correction Strength' output parameter is recommended. If the loss model source was 
from testing under turbulent conditions, applying a correction is recommended.

Explanation

Flow through one or more pipes or junctions was found to be in the laminar flow regime (Reyn-
olds Number < 2300), but the "Apply Corrections" setting is disabled on the Laminar and Non-
Newtonian Corrections panel in Analysis Setup. The "Laminar and Non-Newtonian Correction 
Strength" output parameter under either the Pipes or Junctions sections of Output Control was 
calculated to be larger than 1.25 for one or more pipes or junctions. This means that if cor-
rections were applied, the resulting equivalent K factors and pressure losses would be sig-
nificantly modified (>25%) compared to if no corrections were made.

Required Action

If the loss information used in the model was based on manufacturer data that came from tur-
bulent tests, then the user should review the documentation for the Laminar and Non-Newtonian 
Corrections panel in Analysis Setup, consider enabling the setting for "Apply Corrections", and 
review the settings for which the corrections apply. Two scenarios can be compared, one with 
corrections and one without, to help determine the exact magnitude and location of the impacts. 
It is also recommended to review the documentation for the ATKF Method.

There is ambiguity in literature about if laminar corrections are required for fittings. A comparison 
of literature sources is provided, and it is up to the user to decide when/how to apply the cor-
rections.

If the loss information used in the model was based on true laminar data, then the caution mes-
sage can be disregarded.

Pipe X length is shorter than the elevation change between 
Junction Y and Z 

A Caution message in AFT Impulse

This caution alerts you to an inconsistency with the input data due to a pipe being defined with a 
length that is shorter than the elevation change between its connecting junctions. This may be an 
input error or a result of a junction which itself has an elevation change. If it is due to the junction 
having an elevation change, you can use different inlet and outlet elevations at the junction to 
resolve this.

In this situation, pressure loss along the pipe due to friction is calculated using the pipe length the 
user has defined while static head loss is determined using the elevation change the user has 
defined.

Pipe X segment length Y is shorter than the elevation change 
A Caution message in AFT Impulse
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The pipe has intermediate elevations and the length along one of them is less than the elevation 
change of that segment. In this situation, pressure loss along the pipe due to friction is calculated 
using the pipe length the user has defined while static head loss is determined using the elev-
ation change the user has defined. This can be corrected by adjusting the intermediate elev-
ations input.

Related Topics

Optional Input for Pipes 255

Pipe X steady state Reynold’s Number is less than 100. Minor 
Losses may be significantly lower than expected.

A Caution message in AFT Impulse

When Reynolds Numbers fall to extremely low values (i.e. less than 100) the fluid enters a flow 
regime in which the system losses behave in an unintuitive fashion. Based on relationships 
depicted by the moody diagram, as the Reynolds Number decreases when below 2000, the fric-
tion factor and resulting pressure loss increases. In practice, this relationship breaks down and 
system losses will begin to decrease somewhere between a Reynolds Number of 10 and 100. 
Due to limited academic knowledge on this subject, and since the Solver is not currently able to 
model this regime, a caution message is given.

Pump X is using a Standard Pump Curve and flow exceeded 
End of Curve

A Caution message in AFT Impulse.

Full message is:

Pump X is using a Standard Pump Curve and flow exceeded End of Curve. If no End of Curve 
was specified, this is the largest entered flow. (Y gal/min at Z% Pump Speed = α gal/min, β 
seconds) A four quadrant model may be appropriate - see the Help Topic Four Quadrant Data 
Set Selection for details.

This caution indicates that the flow through the pump found to be past either the End of Curve 
setpoint or the last data point for the curve that the user has entered. In the transient simulation, 
the time listed is the first time that this End of Curve value is exceeded. The pump may operate 
past this point later in the simulation as well.

Users should ensure the pump curve and curve fit being used are still valid at this flowrate, and 
past this flowrate if the pump operates at higher flowrates later in the transient. Note that if the 
pump is operating at a speed other than 100%, Impulse will apply the Affinity Laws to the End of 
Curve or last data point entered for the pump at 100% speed.

There are several similar Warning messages that may occur when using a Standard Pump 
Curve (SPC). Users can read more about those warning messages here.
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Pump with Check Valve closed at Junction X
A Caution message in AFT Impulse.

Pump junction X was specified with an internal check valve which closed during the simulation.

Some four quadrant data was based on estimated not meas-
ured data

A Caution message in AFT Impulse

Some of the source data for four quadrant curves does not complete the four quadrants. In such 
cases data was estimated/interpolated in the missing quadrants. If this message is encountered 
the user may want to run with another four quadrant source to see if results change.

The air volume entering through Junction X exceeds 100% of a 
pipe station's computing volume

A Caution message in AFT Impulse

The air volume entering through Junction X exceeds 100% of a connected pipe station's com-
puting volume.

The pipe station's computing volume is determined by the section length calculated in the Sec-
tioning panel and the cross-sectional area of the connected pipe. If two pipes are connected the 
average of the pipe station volumes of each of the connected pipes is used.

Impulse's solution method assumes that the pipes are liquid full. If the volume of air in the system 
has not exceeded the volume of a single pipe station, then the liquid full assumption only has a 
minor impact on accuracy. However, if the volume of air entering the system exceeds the volume 
of a computational section then the liquid full assumption will cause a larger decrease in accur-
acy. Impulse uses an adjusted solution method to account for the air entering at the air valve, but 
caution should be used when making decisions based on these results.

Related Topics

Air Valve 299
Air Valve Waterhammer Theory 301

The following Detailed Tee/Wye junctions have a different auto-
matic orientation than defined on the Workspace

A Caution message in AFT Impulse
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Full Message Text

The following Detailed Tee/Wye junctions have a different automatic orientation than defined on 
the Workspace:

Tee/Wye: J1, J2, J3, J4, J5, J6, J7, J8, J9, J10 and X more junctions. See the Model Dia-
gnostics window for more information.

Explanation

The listed Tee/Wye junctions are using the Detailed Loss Model with the Arrangement Type set 
to "Auto", however, the automatic pipe orientation saved for the Tee/Wye Properties window is 
not consistent with the current orientation on the Workspace. For the K factors to be calculated 
correctly, the connections for pipes A, B, and C must be defined correctly. For example, on a 90 
degree Tee, the branching flow pipe (C) in the Tee/Wye Properties window must match the inten-
ded branching pipe on the Workspace. If the branching pipe C was switched with the straight run 
pipe B, then the K factors would be switched. This can give incorrect results which may propag-
ate through the model and compound with other Tee/Wye junctions since the Detailed Loss 
Model is dependent on flows and pressures.

A full list of the affected junctions can be found on the Model Diagnostics window (Tools menu > 
Model Diagnostics > Junctions > Tee/Wye > "Tee orientation inconsistent to workspace?").

Required Action

First, it is recommended to align the pipes on the Workspace in a way that resembles the true 
geometric orientation of the junction as depicted by either the 2D or Isometric grid. If there is a 90 
degree angle, draw the pipes in a way that depicts this in the proper way. Furthermore, point the 
pipe Reference Positive Flow Direction towards the expected flow direction. The Auto Arrange-
ment Type will utilize the directions and angles between each pipe when attempting to auto-
matically configure the pipe connections. Therefore, following these modeling practices can 
increase the success rate of properly identifying and applying the K factors to the correct pipes. 
The tips below can be used to help quickly apply these principles:

 l The pipe direction can be switched by using the Reverse Pipe Direction icon on the Work-
space Toolbar or using the F3 keyboard shortcut.

 l Display the Workspace Grid and enable Snap to Grid from the Arrange menu.
 l Rotate the Tee/Wye junction icon such that it is consistent with the pipes by right-clicking 

the icon and selecting either "Auto-rotate Icon" or "Customize Icon".

Next, open each Tee/Wye Properties window listed in the Caution message or in the Model Dia-
gnostics window, configure and verify the proper pipe connections, click OK, and re-run the 
model. If needed, the Arrangement Type can be switched to "User" to guarantee that the junction 
retains the proper configuration.
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If the losses due to the Tees/Wyes are negligible compared to the total system pressure drop, 
the user can consider switching to the Simple Loss Model which assumes the junction is 
lossless. This would be equivalent to morphing the junction into a Branch.

The following pipes have vapor volumes in computing stations 
greater than 0.1% but less than 10% of the liquid computing 
volume

A Caution message in AFT Impulse

Full Message Text

The following pipes have vapor volumes in computing stations greater than 0.1% but less than 
10% of the liquid computing volume:

Pipe X (Name), Stations: Y (Z%)

Explanation

This Caution is part of a series of Output Messages meant to convey increasing uncertainty in 
results as Percent Vapor Volume increases.

 l Caution - greater than 0.1% but less than 10%
 l Warning - greater than 10% but less than 100%
 l Critical Warning - greater than 100%

A detailed explanation about the Percent Vapor Volume parameter, section volume, and 
assumptions can be found on the Interpreting Cavitation Predictions topic. In summary, 
Impulse's solution methodology assumes that pipe sections are 100% liquid-full. This warning is 
stating that for the listed pipe stations, the Percent Vapor Volume was greater than 0.1% but less 
than 10% of the section volume at some point during the transient, which is violating the 100% 
liquid-full assumption to a minor degree.

Vapor volumes between 0.1 and 10% of the section volume indicate that limited transient cavit-
ation is occurring at that point in the system. Impulse's cavitation models are meant to capture 
limited transient cavitation in a system, and have limited accuracy as vapor volume increases. 
Depending on the system, this amount of transient cavitation may be a cause for concern since it 
can lead to additional waterhammer effects.

Required Action

Users should explore the various cavitation topics - and in particular the Interpreting Cavitation 
Predictions topic - to better understand what is causing these results, why they are possible, and 
how to interpret results in scenarios seeing this caution. If all else fails, users should treat 
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systems with these results with caution, and incorporate additional safety factors into their 
designs.

Related Topics

Interpreting Cavitation Results 100
Cavitation 69
Transient Cavitation Models 707

The performance of Pump Junction X may be affected by the 
fluid viscosity

A Caution message in AFT Impulse

Full message is:

The performance of Pump Junction X may be affected by the fluid viscosity. Apply the Viscosity 
Correction on the Pump Property window and rerun the model to assess the impact of the fluid 
viscosity.

This caution is shown if the fluid used in the model is not water, and the pump viscosity cor-
rection factors would be less than one based on ANSI/HI 9.6.7-2015. If the pump and fluid used 
in the model is in the scope of the ANSI standard it may improve accuracy to use viscosity cor-
rections at the pump.

See the Pump Viscosity Correction topic for more information.

Transient data did not extend to Stop Time at Junction X
A Caution message in AFT Impulse

The transient data at Junction X does not have time data that covers the entire time frame of the 
simulation as defined on the Simulation Mode/Duration panel of Analysis Setup. The final data 
point will be used for the remaining time steps of the simulation. You can enter additional time 
data points at Junction X to avoid this message.

Information
An Information message is intended to make the user aware that an advanced feature is being 
used in the model, or to provide comments or suggestions relating to an advanced feature. Fol-
lowing suggestions may achieve higher accuracy results if the right conditions apply, but can 
also cause incorrect results if not applied properly. If the user understands the feature then no 
action is required.

INFORMATION
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Losses at one or more pipes or junctions were significantly 
modified (>25%) with a Laminar or Non-Newtonian correction

An Information message in AFT Impulse

Full Message Text

Losses at one or more pipes or junctions were significantly modified (>25%) with a Laminar 
or Non-Newtonian correction. The strength of the correction can be seen by checking the Lam-
inar/Non-Newtonian Correction Strength output parameter. If the loss model source was from 
testing under laminar conditions, applying a correction is NOT recommended.

Explanation

This Information message appears when flow through one or more pipes or junctions was found 
to be in the laminar flow regime, the "Apply Corrections" setting is enabled on the Laminar and 
Non-Newtonian Corrections panel in Analysis Setup, and the resulting K factor (and pressure 
loss) was modified by more than 25% compared to uncorrected turbulent flow. Flow is con-
sidered laminar when the Reynolds Number is below 2300, and this can be checked in each pipe 
by adding the "Reynolds Number" output parameter from the Pipes section of the Output 
Control. When corrections are applied from the Analysis Setup, the equivalent K factor for the 
pipe or junction is adjusted which typically results in a larger pressure drop. Generally, this is 
intended to be more accurate compared to using a turbulent K factor in laminar flow.

This message indicates that the applied correction was fairly significant (>25%).  The "Laminar 
and Non-Newtonian Correction Strength" output parameter can be added from both the Pipes 
section and Junctions section of the Output Control. A correction strength larger than 1.0 acts as 
a multiplier that increases the equivalent K factor and pressure loss for the pipe or junction.

Required Action

If the corrections are intended, then no action is required since Information messages are simply 
courtesy notifications of advanced features being used in the model.

If the correction are NOT intended, then the user should review the Laminar and Non-Newtonian 
Corrections panel in Analysis Setup.

The following pumps are defined with a Four Quadrant Curve...
A series of Information messages in AFT Impulse

There are several versions of this information message that may appear when using a Four 
Quadrant Pump Curve. Each message is intended to remind the user that using a Four Quadrant 
Curve introduces inherent uncertainty to the model even if it allows Impulse to better capture 
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centrifugal pump behavior outside of standard pump operating zones. The user should always 
check to ensure that the Four Quadrant Curve used in the model is a good choice for their pump.

These information messages include:

 l The following pumps are using an estimated Four Quadrant data set. Sensitivity 
studies are recommended for a thorough understanding of possible transient 
behavior. See Help topic "Four Quadrant Data Set Selection" for more inform-
ation.
This information message is generated when the four quadrant data set is selected by the 
user. Each data set will give slightly different results, and it is important the user evaluate 
multiple data sets to understand the range of possible pump behavior.

 l The following pumps are using an Automatically Selected Four Quadrant data set. 
The automatically selected data set should be confirmed as reasonable for this 
simulation. Sensitivity studies are recommended for a thorough understanding of 
possible transient behavior. See Help topic "Four Quadrant Data Set Selection" 
for more information.
This information message is generated when the four quadrant data set is selected auto-
matically by Impulse. The selection is based on which data set has the closest specific 
speed to the original pump curve defined by the user. This selection process is generally 
regarded as the best way to select a four quadrant data set, but the user should evaluate 
multiple data sets to understand the range of possible pump behavior.

 l The following pumps are defined with a Four Quadrant Curve based on the Best 
Efficiency Point. While this is the recommended setting for most simulations, the 
steady conditions will likely vary from the Standard Pump Curve. See Help topic 
"Four Quadrant Dimensional Reference Point" for more information.
This information message is generated when the four quadrant curve is dimensionalized 
using the pump's Best Efficiency Point (BEP). This dimensionalization means the Stand-
ard Pump Curve and the Four Quadrant Curve will intersect exactly at BEP. Impulse uses 
the Four Quadrant Curve for the steady-state and transient solutions, so the steady-state 
results will likely not fall exactly on the original Standard Pump Curve. This behavior is 
expected, and using BEP as the dimensional reference point is recommended, but the 
user should be aware of how it impacts the steady-state results.

 l The following pumps are defined with a Four Quadrant Curve based on the 
Steady-State Operating Point. If the initial operating flow is far from BEP, sig-
nificant distortion in the resulting pump curves is possible, potentially impacting 
transient results. Check the fit of the Four Quadrant curves. See Help topic "Four 
Quadrant Dimensional Reference Point" for more information.
This information message is generated when the four quadrant curve is dimensionalized 
using the operating point of the system during steady-state. The Standard Pump Curve is 
used for the steady-state simulation, and the Four Quadrant Curve is dimensionalized 
based on those results. This approach allows the pump to operate on the original Stand-
ard Pump Curve in steady-state. However, if the Four Quadrant Curve is dimensionalized 
at the extreme ends of the Standard Pump Curve, away from BEP, the Four Quadrant 
Curve may not match well with the Standard Pump Curve, The user should check to 
ensure a good Four Quadrant Curve is used.

 l The following pumps are defined with a Four Quadrant Curve based on the 
Steady-State Operating Point, but the initial speed or flow was zero. The 
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Dimensional Reference Point was automatically changed to Best Efficiency Point. 
See Help topic "Four Quadrant Dimensional Reference Point" for more inform-
ation.
This information message is generated when the four quadrant curve is dimensionalized 
using the operating point of the system during steady-state, but the pump is at zero flow or 
zero speed. In this situation, the steady-state operating point cannot be used to generate 
a valid for quadrant curve, so the Best Efficiency Point was used instead.
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This section discusses methods of troubleshooting models that are having difficulty converging. 
Topics include discussions of common issues, ideas to simplify overly complex models, and 
methods for adapting the solution methodology through either tolerance or flow relaxation.
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Identifying and Restoring Corrupted Model Files 798

Related Blogs

Having model convergence problems? Start here!

Reducing Run Time
The below topics discuss several common model configurations that can cause Impulse model 
run times to be longer than expected. Select a topic below for information on why each con-
figuration increases the run time, and suggestions on how each configuration can be avoided.

If one of the below configurations is detected by Impulse and the run time is relatively long, 
Impulse will present a message to the user showing which of the below configurations may be 
applicable.

Note that the configurations listed here as causing long run times may not be inaccurate for the 
system being modeled. However, they are all likely inefficient modeling choices for transient ana-
lysis - especially for preliminary iterations.

The configurations discussed below are not meant to capture every possible model configuration 
which can cause long model run times in Impulse. Many other factors can also cause long run 
times. Following the suggestions listed below may help reduce run time in any model, though it 
may not be practical to implement the listed suggestions for all models.

Related Topics

Troubleshooting 777

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

You Should Combine Your Pipes

The model has both very long and very short pipes
A model with both long and short pipes requires a larger number of pipe sections in order to per-
form calculations. The more pipe sections in a model, the more computations the solver needs to 
perform, which results in a longer run time.

How are short and long pipe lengths contributing to long run times?

To run a transient simulation, AFT Impulse sections pipes to apply the Method of Characteristics 
solution to the waterhammer equations. In any system there will be a single controlling pipe. The 
controlling pipe is the pipe with the fewest sections - generally one. AFT Impulse uses the length 
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of a section in the controlling pipe to divide all pipes in the model into sections and determine a 
uniform time step for the transient simulation.   

When a model has both very long and very short pipes, the short pipes determine the controlling 
pipe length, and the long pipes must be divided into many sections to properly apply the Method 
of Characteristics. The run time is proportional to the square of the number of sections, meaning 
many sections in a model will often cause extremely long run times.

Consider a model that consists of two pipes: a very short pipe, such as 1 meter, and a very long 
pipe, such as 10,000 meters. The 1 meter pipe will be the controlling pipe, and the 10,000 meter 
pipe must be broken into 10,000 sections. The model thus requires 10,001 sections in order to 
perform the calculations, which results in a long run time. Increasing the short pipe’s length arti-
ficially from 1 to 10 meters decreases the number of sections required by a factor of 10, reducing 
run time by a factor of 100. While the length increase may also increase the error in the short 
pipe, experience shows that the error is usually negligible in a liquid transient context.

What can the user do?

Several different approaches are available to reduce run time. These approaches can work in 
parallel, and it is up to the engineer to make appropriate judgments as to which is best for the 
model.

Consider using the zero-length connector for very short pipes. Oftentimes two fittings in a 
system are connected with a very short pipe or  are welded together directly. In AFT Impulse, it is 
common for users to attempt to model these connections using pipes with very short defined 
lengths. These short pipes offer little accuracy improvement and result in a large number of sec-
tions for the solver to calculate. This also causes significant time for the model to run. The zero-
length connector option allows AFT Impulse to exclude the pipe from the sectioning process 
since it represents a lossless connection between two junctions. Zero-length connectors can be 
used in up to two sequential pipes, but intermediate branching flow is not allowed between two 
zero-length connector pipes.

Consider modeling fittings and losses in pipes and combining multiple short pipes. In 
the Pipe Properties window, use the Fittings & Losses tab to add in fittings to the pipe instead of 
using junctions on the workspace. This is useful to account for pressure losses without modeling 
large numbers of elbows or similar fittings. For example, a user can add valves and bends to a 
pipe, and the solver will still apply the losses directly to the pipe during the calculations. By 
removing these junctions and combining pipes in the workspace, many short pipes between 
these fittings are eliminated. Reducing and combing short pipes reduces the number of sections 
in the model and the overall run time.

Consider adding artificial length to short pipes. Adding length to short pipes increases the 
length of the controlling pipe, which results in fewer sections for the other pipes in the model. 
Reducing the overall number of sections in the model improves run time. Using pipe lengths that 
are common multiples, such as 5 feet, 10 feet, 15 feet, etc. provides improved sectioning since 
short pipes can be perfectly divided into longer pipes.

Do not include extremely long pipes unless you are directly analyzing the transient 
behavior in those pipes. Consider using the Infinite Pipe feature in the Assigned Pressure and 
Assigned Flow junctions. The infinite pipe feature prevents the junction from reflecting pressure 
waves, which can be useful in modeling the part of a pipe system which is so long that its com-
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munication time prevents wave reflection interactions with the rest of the system during the sim-
ulation.

Related Topics

Pipe Sectioning - Introduction to Method of Characteristics 66

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

The model has many pipes that can be combined
Users often model losses in AFT Impulse  using junctions with no transient behavior, such as a 
bend, static valve, or orifice, between two pipes of identical diameter. While this may help show 
where these losses are occurring in the overall pipe system, it can result in extra pipes which can 
have a detrimental effect on pipe sectioning and run time. Joining pipes and modeling the losses 
within the pipe itself can improve sectioning and run time while maintaining accuracy.

How are pipes that can be combined contributing to long run times?

To run a transient simulation, AFT Impulse sections pipes to apply the Method of Characteristics 
solution to the waterhammer equations. In any system there will be a single controlling pipe. The 
controlling pipe is the pipe with the fewest sections - generally one. AFT Impulse uses the length 
of a section in the controlling pipe to divide all pipes in the model into sections and determine a 
uniform time step for the transient simulation.   

Each pipe in a model must be sectioned individually, meaning section count must increase with 
pipe count. The run time is proportional to the square of the number of sections, meaning many 
sections in a model will often cause extremely long run times. Reducing the number of pipes in a 
model is often an effective way to reduce run time.

Consider a model that includes a pipeline that is 100 meters long, and has 9 bends in it. If those 9 
bends are modeled as unique junctions, the pipeline must be modeled as 10 individual pipes. 
Each pipe must have at least 1 section, meaning the pipeline requires at least 10 sections. If the 
pipeline is modeled as a single pipe, and the 9 bends are modeled as additional pipe friction 
using  the Fittings & Losses tab in the Pipe Properties window, the number of sections in the 
pipeline could be reduced from 10 to 1, in turn reducing the run time by a factor of 100.

What can the user do?

The Fittings & Losses tab in the Pipe Properties window can be used to add losses directly to 
pipes to replace individual junctions on the workspace. This process can be done manually, or 
automatically using tools provided by AFT Impulse.
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Select the pipes to be combined and the junctions between those pipes on the Workspace, and 
choose the Join Pipes/Junctions from the Edit menu. This option will combine the selected pipes 
into one pipe, add the losses from the junctions into the Fittings & Losses tab, and use the junc-
tion elevation and previous pipe lengths to fill out the Intermediate Pipe Elevations table on the 
Optional tab of the Pipe Properties window.

A similar tool can be found in the Sectioning panel in Analysis Setup to the right of the Select Sec-
tioning interface. This tool shows the number of pipes that could be combined and by clicking the 
Combine Pipes button, you can select which pipes to include or exclude in the combine process. 
After clicking OK, the pipes are combined and you can immediately click the Update Results but-
ton on the Sectioning panel to resection the pipes in the model.

Related Topics

Pipe Sectioning - Introduction to Method of Characteristics 66

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

You Should Combine Your Pipes

The model has many unique pipe lengths
A model with many unique pipe lengths often require a large number of sections in order to cor-
rectly use the Method of Characteristics. A large number of pipe sections in a model results in 
long run times and typically offers little improvement in accuracy.

How are unique pipe lengths contributing to long run times?

To run a transient simulation, AFT Impulse sections pipes to apply the Method of Characteristics 
solution to the waterhammer equations. In any system there will be a single controlling pipe. The 
controlling pipe is the pipe with the fewest sections - generally one. AFT Impulse uses the length 
of a section in the controlling pipe to divide all pipes in the model into sections and determine a 
uniform time step for the transient simulation.   

A model with many unique pipe lengths often requires the controlling pipe to be broken into mul-
tiple sections in order to divide all pipes into uniform sections and uniform time steps. The run 
time is proportional to the square of the number of sections, meaning many sections in a model 
will often cause extremely long run times. 

What can the user do?

Consider adjusting the lengths of the pipes in the model such that  short pipes share a common 
pipe length and that longer pipes can be perfectly divided by the controlling pipe. Using exact 
pipe lengths can enhance calculation accuracy in many applications. However, transient 
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simulations have many inherent uncertainties, and precise modeling of pipe lengths may not 
offer a noticeable improvement. Rounding short pipe lengths such that the lengths are perfectly 
divisible by the controlling pipe length, introduces minimal inaccuracy while significantly reducing 
the number of sections in the model and resulting run time. Be sure to perform sensitivity studies 
and confirm the steady-state results with these modifications.

For instance, consider a model with five pipes of lengths 1.01, 2.31, 3.75, 6.00, and 1000 meters. 
All pipes have unique lengths and none are perfectly divisible into another. To section these 
pipes within the acceptable variance limits, the controlling pipes needs to be split into two sec-
tions, and over 2100 total sections are required to perform the calculations. Rounding the four 
shortest pipes to 5  meters increases the total pipe length of the model by only 0.7%. In return, 
the number of pipe sections is reduced by a factor of 10 and the run time is reduced by a factor of 
100! This 0.7% change in total pipe length can be considered negligible for any reasonable tran-
sient simulation - there are greater uncertainties than this in almost all studies.

Related Topics

Pipe Sectioning - Introduction to Method of Characteristics 66

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

The controlling pipe has a large number of sections
The controlling pipe is the shortest pipe in the model and is used to determine the number of com-
putational sections needed in all other pipes in the model. If the controlling pipe has a large num-
ber of sections the other pipes will also require more sections, which results in more calculations 
needed and a longer run time.

How is controlling pipe sectioning contributing to long run times?

To run a transient simulation, AFT Impulse sections pipes to apply the Method of Characteristics 
solution to the waterhammer equations. In any system there will be a single controlling pipe. The 
controlling pipe is the pipe with the fewest sections - generally one. AFT Impulse uses the length 
of a section in the controlling pipe to divide all pipes in the model into sections and determine a 
uniform time step for the transient simulation.   

When the controlling pipe is broken into more than one section, the section length in all pipes is 
shortened, and all pipes must contain more sections as well. The run time is proportional to the 
square of the number of sections, meaning many sections in a model will often cause extremely 
long run times. 

Consider a model that takes 10 minutes to run with one section in the controlling pipe. With 2 sec-
tions in the controlling pipe the model will take about 40 minutes, and with 3 sections in the con-
trolling pipe the model will take about 90 minutes.
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What can the user do?

There are multiple ways to decrease the number of sections in the controlling pipe.

Consider using the minimum number of sections within the suggested maximum vari-
ance. The maximum wavespeed variance for a given number of sections in the controlling pipe 
is shown in the tables on the Sectioning panel and is just referred to as "Variance". AFT Impulse 
will automatically recommend the smallest number of sections which limit the wavespeed vari-
ance to 10% or less. The user should generally choose Impulse's automatic sectioning selection 
since the Method of Characteristics used in AFT Impulse has little increase in accuracy when 
more sections are used. Some exceptions include when the wavespeed variance is greater than 
10% for a given sectioning scheme, when transient cavitation occurs during the transient sim-
ulation, or when the partially full pipe feature is used.  Engineering judgement should be used to 
determine if more sections are needed in the controlling pipe.

Consider reducing the number of unique pipe lengths. Models with numerous unique pipe 
lengths will often require the controlling pipe to be broken into multiple sections to satisfy the sec-
tioning requirements for the Method of Characteristics. Artificially adjusting those pipe lengths 
such that all are divisible by the controlling pipe length can reduce the number of sections in the 
controlling pipe, and thus reduce the total number of sections in the model along with the model 
run time. For more information, see the topic discussing Models with many unique pipe lengths. 

Related Topics

Pipe Sectioning - Introduction to Method of Characteristics 66

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

The model has an unusually short pipe
A model with a very short pipe requires a larger number of pipe sections in order to perform cal-
culations. The more pipe sections in a model, the more computations there are that need to be 
performed, which results in a longer run time.

How are pipe lengths contributing to long run times?

To run a transient simulation, AFT Impulse sections pipes to apply the Method of Characteristics 
solution to the waterhammer equations. In any system there will be a single controlling pipe. The 
controlling pipe is the pipe with the fewest sections - generally one. AFT Impulse uses the length 
of a section in the controlling pipe to divide all pipes in the model into sections and determine a 
uniform time step for the transient simulation.   

When the controlling pipe is unusually short, the other pipes in the model must be divided into 
many sections to apply the Method of Characteristics.  The run time is proportional to the square 
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of the number of sections, meaning many sections in a model will often cause extremely long run 
times.

Consider a model that has one 0.05 ft long pipe and 100 pipes that are each 10 ft long. Each 10 ft 
pipe would require 200 sections, requiring 20,000 sections overall. Modeling the very short pipe 
as 0.1 ft would reduce the number of sections by a factor of 2, which would potentially decrease 
the run time by a factor of 4. Alternatively if the very short pipe is not considered in the sectioning 
using one of the methods discussed below then the controlling pipe length would become 10 ft. 
With one section in each pipe this would decrease the number of sections from 20,000 to 100, 
decreasing the run time by a factor of 40,000.

What can the user do?

There are several different approaches to reduce run time. These approaches can work in par-
allel, and it is up to the engineer to make appropriate judgments as to which approach is best for 
the model. 

Consider using the zero-length connector for very short pipes. Oftentimes two fittings in a 
system are connected with a very short pipe or  are welded together directly. In AFT Impulse, it is 
common for users to attempt to model these connections using pipes with very short defined 
lengths. These short pipes offer little accuracy improvement and result in a large number of sec-
tions for the solver to calculate. This also causes significant time for the model to run. The zero-
length connector option allows AFT Impulse to exclude the pipe from the sectioning process 
since it represents a lossless connection between two junctions. Zero-length connectors can be 
used in up to two sequential pipes, but intermediate branching flow is not allowed between two 
zero-length connector pipes.

Consider modeling fittings and losses in pipes and combining multiple short pipes. In 
the Pipe Properties window, use the Fittings & Losses tab to add in fittings to the pipe instead of 
using junctions on the workspace. This is useful to account for pressure losses without modeling 
large numbers of elbows or similar fittings. For example, a user can add valves and bends to a 
pipe, and the solver will still apply the losses directly to the pipe during the calculations. By 
removing these junctions and combining pipes in the workspace, many short pipes between 
these fittings are eliminated. Reducing and combing short pipes reduces the number of sections 
in the model and the overall run time.

Consider adding artificial length to short pipes. Adding length to short pipes increases the 
length of the controlling pipe, which results in fewer sections for the other pipes in the model. 
Reducing the overall number of sections in the model improves run time. Using pipe lengths that 
are common multiples, such as 5 feet, 10 feet, 15 feet, etc. provides improved sectioning since 
short pipes can be perfectly divided into longer pipes.

Related Topics

Pipe Sectioning - Introduction to Method of Characteristics 66
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Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

The simulation has a large number of time steps
A model with a large number of time steps will require a large number of calculations. The more 
calculations that need to be performed, the longer the run time.

How are the time steps contributing to long run times?

Impulse sections pipe to apply the Method of Characteristics solution method. The Method of 
Characteristics requires a uniform time step to be used for all pipes in the model, which is determ-
ined during the sectioning process using the section length and adjusted wavespeed. On aver-
age the wavespeed is typically on the magnitude of 103, producing a time step on the magnitude 
of 10-3.   

A time step of 0.001 seconds means that a transient simulation of 1 minute will have 60,000 total 
time steps. Similarly, a transient simulation of 1 hour will have 3.6 million time steps. Run time is 
roughly proportional to the number of time steps, and models with large numbers of time steps 
will generally have long run times. In addition, models with higher wavespeed may require 
shorter time steps, increasing the number of time steps required.  

What can the user do?

There are several different approaches to reduce run time when the number of time steps is lar-
ger than expected.

Consider reducing the simulation duration. The simulation duration is defined on the Sim-
ulation Mode/Duration panel. For a simple system, the full effect of the waterhammer cycle  
occurs over twice the communication time, where the communication time is the time it takes a 
pressure wave to travel the length of the system and back (length of system / wavespeed). 
Determining the communication time can become more complex for systems with branching 
paths or major reflection points in the path. However, limiting the simulation duration to 2 times 
the communication time may be a good starting point. If multiple transient events occur the sim-
ulation duration should be extended to end after the waterhammer cycle has completed for the 
last transient event.

In addition, for a piping network attached to a very long pipe it may not be necessary to include 
the length of the very long pipe in the communication time calculation. Use your engineering 
judgement on whether the reflections from the pipeline will be important to consider.

Consider reducing the number of unique pipe lengths. Models with numerous unique pipe 
lengths will often require the controlling pipe to be broken into multiple sections to satisfy the sec-
tioning requirements for the Method of Characteristics. Artificially adjusting those pipe lengths 
such that all are divisible by the controlling pipe length can reduce the number of sections in the 
controlling pipe, increase the length of each time step, and reduce the total number of time steps 
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required for the simulation. For more information, see the topic discussing Models with many 
unique pipe lengths. 

Consider lengthening the controlling pipe. The controlling pipe length is used to determine 
the time step for the simulation, setting the time step equal to the section length divided by the 
wavespeed. Artificially lengthening the controlling pipe means the time step for the simulation 
can be longer, and fewer time steps are required for the simulation. 

Related Topics

Pipe Sectioning - Introduction to Method of Characteristics 66

Related Blogs

Analyzing Transients Faster - a Hacker's Guide to Pipe Sectioning

More time-consuming calculations are being used
Many transient simulations model systems which are relatively simple at the beginning of the sim-
ulation. Pipes are liquid full, pumps are running at full speed, and relief and check valves are in 
their steady-state conditions. However, as transient events occur in the system, transient cavit-
ation, changes in pump speed, and relief valve or check valve chattering can occur. These and 
other similar phenomenon can require additional calculations which slow down the solver and 
increase the run time. Events such as cavitation cannot be viewed while the model is running, 
but can be observed in the output.

In many cases, these events are indicative of the behavior that would occur in the actual system. 
It is therefore important to run the model with some potentially time intensive calculation meth-
ods to gain an understanding of the real system. If you determine that the previously mentioned 
phenomenon are unrealistic to the physical system, then steps should be taken to review the 
model inputs to prevent the phenomenon from occurring during the transient, which will in turn 
reduce the run time of the AFT Impulse scenario.

Related Topics

Transient Cavitation Panel 193
Relief Valve 423
Check Valve 319
Air Valve 299

Transient Solver Errors
A transient solver error will be shown during the transient solution if Impulse encounters a cal-
culation error which would invalidate the calculation results for the rest of the transient. Transient 
solver errors halt the transient solution and must be resolved for the full simulation to be run.
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The below topics offer descriptions of the more common solver errors and tips for common res-
olutions. Reach out to AFT Support for further assistance.

TRANSIENT SOLVER ERRORS

Fluid deceleration is outside the valid range
A Transient Solver Error in AFT Impulse

Full Message is: 

Error occurred while running Transient Solver. Fluid deceleration is outside the valid range for 
the check valve type selected

This transient solver error message can occur if the model has a check valve defined using the 
Estimate from Fluid Deceleration valve model. The error message indicates that the fluid decel-
eration calculated for the check valve exceeds the maximum deceleration for the current valve 
type. If the deceleration exceeds the known deceleration vs maximum reverse velocity data the 
reverse velocity to close the check valve can't be calculated and the transient calculations can't 
proceed. See the Check Valve topic for more information on how the Estimate from Fluid Decel-
eration option is modeled.

The user will need to consider using the User Specified option to directly define the reverse velo-
city to close for the check valve, or should consider using a different check valve type if appro-
priate for the system.

One or more pipes did not have a valid steady-state solution
A Transient Solver Error in AFT Impulse

Full Message is: 

Error occurred while running Transient Solver. One or more pipes did not have a valid steady-
state solution

This transient solver error message can occur if the model has a closed pipe such that a pres-
sure can't be determined. This can be resolved with the following steps.

 1. Run the model as Steady-State Only and check for pipes with 'No Solution'.
 2. Define a “Stagnant Region Steady-State Pressure” (on the Optional tab of the Pipe Prop-

erties window) for ONLY ONE of the pipes in each continuous section of pipes with “No 
solution”.

This resolves the error by providing a pressure to the entire group of pipes that are cut off from 
determined pressure sources. If this group of pipes becomes open to other sections of the model 
during transients, the pressure is needed and would be used to determine transient results. 
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Improper use of partially full pipe feature
A Transient Solver Error in AFT Impulse

Full Message is:

Error occurred while running Solver. Improper use of partially full pipe feature.

This error occurs when the user presses Cancel on the "Problems With Partially Full Pipe 
Feature" pop-up that may be displayed after the Waterhammer Assistant as a pre-run check on 
the Solution Progress window. This action cancels the transient run.

One of the pipes in the model is using the Partially Full Pipe feature and is incorrectly defined 
according to the requirements. For example, the "Problems With Partially Full Pipe Feature" 
pop-up may list a pipe number and the following messages:

 l Pipe X - Pipe is horizontal.
 l Pipe X - Outlet is below inlet and inlet is connected to a Valve junction (Y).

To resolve the issue, the affected pipe should be compared against the requirements listed for 
the Partially Full Pipe feature.

Diagnostics Window
The Model Diagnostics window is a feature introduced in AFT Impulse 8. It is intended to help 
users check on a number of settings that may have been changed during the model-building pro-
cess and that may affect the model results.

The Model Diagnostics window can be accessed from the Tools menu.

When the Model Diagnostics window is opened all input will be checked, and the results will be 
displayed in a tabular format. Items of note will be highlighted based on the impact each iden-
tified item may have on the results. It should be noted that not all items identified by this win-
dow will have a negative impact on results. Rather, the identified items are settings that have 
frequently been incorrectly applied by other users. This is not an exhaustive list of troubleshoot-
ing items, though the most common issues are all included.

Data in the Model Diagnostics is organized by the Data Source, which is the window where that 
setting/input is defined. Any item that may negatively impact the model will be highlighted based 
on its potential to affect the model, as shown in the Potential Impact column. For pipe and junc-
tion diagnostic items, the pipe(s)/junction(s) that were identified will be listed below the dia-
gnostic item. For an example, see Figure 1 below. The Diagnostic window indicates that pipes 
P1, P2, and P3 have unusual pipe dimensions, and should be reviewed.
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Figure 1: Example of the Model Diagnostics window

Related Topics

Troubleshooting 777

Use the Model Data Window
Besides its usefulness for documentation purposes, the Model Data window is a powerful tool for 
finding input errors in your model.

Look at the model in Figure 1. If you suspected an input error in one of the pipes, the task of look-
ing for the error in each individual pipe input window would be tedious. 

Now look at the Model Data window for the pipes in Figure 2. Here it is much easier to scan down 
columns of data looking for input errors. In this case, one of the pipe lengths was accidentally 
entered in meters rather than feet.
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Figure 1: Workspace layout of a pipe system with an input error in one of the pipes (error not 
shown).
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Figure 2: Model Data window display for the model in Figure 1. From this perspective it is much 
easier to see that one of the pipes (#2) has length data entered in meters rather than feet. This is not 

automatically an input error, as AFT Impulse accepts pipe input with mixed engineering units. 
However, more frequently than not the user intends to use consistent units, so this probably is an 

error.

Related Topics

Troubleshooting 777

Related Blogs

Having model convergence problems? Start here!

Transfer Results to Initial Guesses
AFT Impulse’s iterative steady-state solver takes initial guesses (also called initial conditions) 
and applies the principles of mass and momentum balance to improve the guesses. This is 
called iteration. It continues to refine the solutions until agreement with the governing equations 
is obtained.             

After a converged steady-state answer is obtained, you can choose to take these results and use 
them as the initial guesses for a subsequent run. This causes much faster convergence in sub-

- 791 -

https://www.aft.com/support/product-tips/common-convergence-tips-tricks


Troubleshooting

sequent steady-state runs because you are starting the solver at or very close to the actual solu-
tion.

Note: This will not increase the speed of the transient solution progress.

This feature is called Transfer Results to Initial Guess, and it is on the Output window, Edit menu 
and toolbar.

Related Topics

Optional Input for Junctions 273
Optional Input for Pipes 255
Make Initial Flow Rate Guesses for Pipes 796
Troubleshooting 777

Poor Pump Curve Fits
The Pump Properties window allows curve fits of pump data up to fourth order. Depending on the 
number of data points entered, pump curves fits similar to the orange curve in Figure 1 below. 

AFT Impulse interprets flow rates past the inflection point around 80 as acceptable operating 
points, which can lead to unusual results or non-convergence. Users should always ensure that 
their pump curves cross the flow rate axis as shown in the blue curve in Figure 1.

AFT Impulse will attempt to warn the user when a model containing a pump curve fit as seen in 
Figure 1 is run. The user can choose to run the model with this curve fit anyways, but they should 
take care that the pump is not operating to the right of the inflection point. 
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Figure 1: A good pump performance curve fit in blue and a poor pump performance curve fit in 
orange. All pump curve fits should include sufficient data such that the curve crosses the zero pres-

sure rise axis as shown in the blue curve.

Related Topics

Troubleshooting 777

Troubleshooting Resistance Curves
Common issues with resistance curves include curves where losses do not increase with flow, 
and curves with a non-zero loss at zero flow. Figure 1 below shows examples of curves with 
potential issues compared to a correctly defined curve.
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Figure 1: Example resistance curves showing correct and incorrect curve types

These common issues create two potential problems in a model:

 1. If the system sees a constant pressure drop even at low flowrates, the iterative Solver can 
encounter difficulty converging on a solution since the system flow and pressure drop are 
no longer dependent on each other.

 2. Real equipment in a system will typically cause a higher pressure drop at larger flowrates, 
and will not provide any loss to the system at zero flow. Users should capture a single 
known pressure loss data point by defining a curve which passes through two points: the 
known pressure drop at the tested flowrate, and zero pressure drop at zero flow. The 
Resistance Curve topic gives more information on defining this type of curve.

Related Topics

Resistance Curve Loss Model 284
Troubleshooting 777

Use the Output Window Sort Feature
If a model runs but the results look incorrect, use the Sort feature on the toolbar in the Output 
Window to look for extremes in velocity, pressure drop or other parameters. An input error (like 
incorrect diameter) may be easier to see by looking at its effect on the results.             

Related Topics

Output Window 528
Output Control 534
Applied Standards 539
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Output Parameters 540
Design Alerts From Output 612
Troubleshooting 777

Tee/Wye Junction Complexity
Tee/wye junctions contain powerful and sophisticated models for determining the pressure 
losses at flow splits and converging flow streams. This power comes at the cost of additional 
model complexity. The complexity can lead to convergence problems in models with numerous 
tees. Here are a couple of recommendations.

Tee/Wye junctions have two loss options: Simple and Detailed. The Simple loss model ignores 
losses at the tee. The Detailed model uses the correlation summarized in the Tee/Wye Loss 
topic. The potential convergence problems occur when using the Detailed loss model.

The potential problem is not with the Detailed tee model itself. Rather, it is due to multiple tees 
coupling together in such a way that AFT Impulse cannot converge on all of the flow splits. A 
common issue with detailed tees is having the pipes connected in the Properties window dif-
ferently than how connections are set up in the workspace. Make sure to double check those con-
nections before running the models. 

You can quickly and easily check if a convergence problem is being caused by tees. Using the 
Global Junction Edit window, you can change all tees to the Simple loss model and rerun the 
model. If it now converges then the problem was likely due to the use of Detailed tee modeling.

Experience has shown that this problem can frequently be resolved by using absolute tolerance 
criteria in the Tolerance panel rather than relative tolerance if the issue only involves the steady-
state convergence.

You also have the option of just using the Simple (lossless) tee model for all tees. In many sys-
tems the loss due to tees/wyes is negligible, especially for systems which see significant loss 
from other components that dominate the system.

Additional configurations for calculation of the Detailed model can be set on the Optional tab to 
help with convergence using the detailed tee model in the transient. See Tee/Wye Water-
hammer Theory for more information.

Related Topics

Tee/Wye 446
Tee/Wye Loss Model 448
Tee/Wye Waterhammer Theory 450
Troubleshooting 777

Related Blogs

Having model convergence problems? Start here!

Give me some details about Detailed Tees!
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Lower the Flow Rate Relaxation
The Iterations Panel allows you to change the Numerical Relaxation parameter for both flow rate 
and pressure. It is recommended that you use only 0.5 or 1.0 for pressure relaxation. But lower 
values of flow rate relaxation can be very helpful.             

A good first step is to lower the flow rate relaxation to 0.05 or 0.1. By lowering the flow rate relax-
ation you improve AFT Impulse's ability to obtain convergence. The cost is slower steady-state 
run times. In some cases accepting the slower run times that come with flow rate relaxation is the 
only means of obtaining convergence. You can lower the relaxation values as low as you want, 
but it is recommended it not be lowered below 0.01.

Related Topics

Troubleshooting 777

Related Blogs

Having model convergence problems? Start here!

Try Absolute Tolerance
Most models converge more reliably with relative tolerances, which is the default in AFT 
Impulse’s Tolerance Panel. But some models converge much better with absolute tolerance. 
This usually means that there is at least one element of the model that is close to the real answer 
in absolute terms but does not lock in on a relative (percentage) basis.    

If a model will not converge with relative tolerance, you can try changing to absolute tolerance. 
Even better, try the option to converge on either absolute or relative, which will offer the most flex-
ibility.

Related Topics

Troubleshooting 777

Related Blogs

Having model convergence problems? Start here!

Make Initial Flow Rate Guesses for Pipes
If you do not provide any initial guesses, AFT Impulse will make its own guesses. On occasion 
the AFT Impulse guesses are far away from reality. For some models providing a crude initial 
guess for all the pipe flow rates in the system can help the model converge for the steady state.
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The crude guesses can be as simple as selecting all the pipes and initializing all of them to 1 
lbm/sec, even though some operate at 0.1 lbm/sec and others at 10 lbm/sec. However, note that 
initial guesses that are too far from the final solution can also interfere further with convergence.

Related Topics

Optional Input for Junctions 273
Optional Input for Pipes 255
Transfer Results to Initial Guesses 791
Troubleshooting 777

Review the Iteration History
The Iteration History window can be opened from the Solution Progress window. You can use 
this to see which pipes or junctions are farthest out of tolerance, which may direct your 
troubleshooting efforts towards these elements.             

Related Topics

Solution Progress Window 499
Iterations Panel 204
Troubleshooting 777

Change Boundary Conditions
Changing the boundary pressures or flow rates can sometimes give you insight into what is giv-
ing the model trouble. 

For example, if convergence can only be achieved within a narrow range of fixed flowrates, there 
may be an issue with curve fit data being unrealistic outside of that range of flowrates.             

Related Topics

Troubleshooting 777

Turn Off Parts of the Model
Using the Special Conditions feature, you can turn off elements in your model and in effect shut-
down entire sections. If the model runs when certain sections are closed, this could indicate a 
problem with one of the components in the closed section.

Related Topics

Special Conditions 244
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Optional Input for Pipes 255
Optional Input for Junctions 273
Troubleshooting 777

Break a Large Model Into Submodels
AFT Impulse provides convenient features for deleting parts of your model and merging parts 
back in. A section of your model can be quickly deleted by selecting it on the Workspace and 
choosing Delete from the Edit menu. If the section is instead Cut, it can be Pasted into a new 
model of its own for testing or holding. At a later time the removed sections can be added back in 
to the current model by using the Merge feature on the File menu.    

The advantage of breaking your model into sub-models is that you can investigate the con-
vergence characteristics of each part of your model independently. If you can get each sub-
model to converge, you should be able to get the original model to converge also. If one of your 
sub-models will not converge, it is doubtful your original model will converge either.             

Related Topics

Troubleshooting 777

Zero-Length Connector Configurations
Pipes defined as zero-length connectors are only allowed to be used in limited cases. If the zero-
length connector is used for a restricted case Impulse will show the following message: "Zero-
Length Connector configurations that are not allowed for transient simulation exist."

To resolve the above error navigate to all pipes/junctions indicated by Impulse and disable the 
zero-length connector feature so that the restricted configuration no longer exists at those 
pipes/junctions. For a full list of restricted configurations see the discussion of zero-length con-
nectors in the Pipe Model topic.

When changing the zero-length connector pipes to short pipes be careful to choose a reas-
onable pipe length to help avoid significantly long run times. See the topic on the affects of using 
unusually short pipes for suggestions on alternate ways to configure the model.

Identifying and Restoring Corrupted Model Files
The most common way to tell if a model file is "corrupted" is an error message that says "An error 
occurred reading the file into AFT Impulse. Can't find [TOOLBOX PREFERENCES] heading."

You may see multiple of these messages after pressing OK, and the part between the brackets [ 
] may say something else each time. This is indicating that the software is trying to read different 
sections of the file, and it is finding that there is either no data, or corrupted data. It is then show-
ing you an error for each section of the file that the software tries to read when loading the model, 
similar to Figure 1.
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Figure 1: Error message indicating that some portion of the model file cannot be found

Another indicator is if the model's file size has been reduced to 0 or 1 KB. This indicates the data 
inside the file has been lost. This can be seen in the file size in the Windows File Explorer (Figure 
2).

Figure 2: Very low file sizes can be an indication of model file corruption

What are the backup files (.bak extensions)?

AFT software will automatically generate backup versions of your model file each time you save. 
By default, these files will be located in the same directory where you have saved your model. 
These files have a specific naming convention, but generally the file extension will start with 
"*.bak" and end with three numbers. Newer versions of AFT software will have a fourth letter 
after the .bak, and it signifies which application the backup is for.

 l AFT Fathom.bakF-001
 l AFT Arrow.bakA-001
 l AFT Impulse.bakI-001
 l AFT xStream.bakX-001

The numbers signify previous versions of the model, with the 001 extension being the most 
recent backup. Of course, if your current model file is corrupted and you need to restore a 
backup, the 001 backup won't contain the most recent updates you made to the model, but it will 
be better than losing everything! The backups named 002 and 003 are the second and third most 
recent backups, respectively. Generally, you won't need to use these files unless you want to 
revert to even earlier state of the model file, or there is an issue with the 001 backup.
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When you save a model file, the application will copy the previous version of the file into .bak001, 
the previous .bak001 will be copied into .bak002, and so on, creating a cascading effect. This 
way .bak001 is always the most up to date backup version of the model.

How to Restore a Backup File

 1. Close the AFT application if it is still open.
 2. In the same location as your model file, locate the file with the extension *.bak-001.
 3. Create a copy of *.bak-001. This is useful in case something goes wrong, and you need to 

try again.
 4. Rename the copied file and change the file extension to the appropriate application file 

extension below. Windows will prompt you to confirm the extension change; click Yes.
 l Fathom: *.fth
 l Arrow: *.aro
 l Impulse: *.imp
 l xStream: *.xtr

 5. Try opening the restored file. If this didn't solve the problem, you can try the same steps 
with an earlier backup file, using .bak-002 or .bak-003 if they exist. However, note that 
doing so will revert even more changes because these are even earlier versions of the 
model from multiple saves prior.

Figure 3: The newest backup file, identifiable by file extension numbering and date modified

Figure 4: Changing file name extension to restore the backup file

Tips to Prevent File Corruption

The best way to prevent file corruption is to open, edit, and save the file locally on your PC. It is 
not recommended to edit and save files directly to a shared server, network drive, or cloud stor-
age platform like Dropbox or OneDrive.
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If the connection to the network location is interrupted or cuts out while saving the model file, it 
could corrupt the file or cause data loss. This can be especially common on VPNs. If you need to 
have the file in a shared location for colleagues to access, it is recommended that you download 
the file to your local PC, edit/save the file locally on your machine, then upload the file after-
wards.

Customize Your User Settings Related to Backups

By default, only a maximum of three backups will be kept at a time. If desired, you can change 
this number in Number of Backup Files Created, which can be accessed in User Options as 
shown in Figure 5. Here, you can also choose to check the box that will automatically save your 
model in a specified time interval.

Figure 5: The number of backup files created and options to save automatically can be customized 
in User Options

Related Topics

Troubleshooting 777
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This section focuses on the technical support options for AFT Products. Topics include descrip-
tions of the various support options, contact information for the AFT Support team, and links to 
external sites to assist with installation issues related to AFT Impulse.

Contents

Technical Support Options 803

Contacting AFT 804

Information on Software Installation 805

Chempak Database Installation 805

Output Files 807

Updated Fluids Library 808

Special File Control Features 809

Converting Models from Earlier Versions 810

Related Blogs

Having model convergence problems? Start here!

Technical Support Options

Support, Upgrade, and Maintenance (SUM)

This primary level of support is for assistance with specific features within the software, or resolv-
ing issues with a model such as difficult to converge models. AFT is limited in the ability to inter-
pret model results and cannot recommend specific changes in a system.

One full year of SUM is provided with the purchase of a full license. Leases have SUM coverage 
during the period of the lease. Further support after the first year requires SUM renewal.

For technical support questions falling in this category, contact AFT.
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Flow Expert Package (FEP)

The FEP is a higher level of consulting assistance for a particular project. This service will assign 
a qualified AFT engineer to assist in not only modeling your system, but also with providing oper-
ational suggestions and interpretation of results.

The intention of this service is to provide assistance to active users of AFT software and address 
questions on the appropriate use of the software for specific system requirements.

Please visit our website at: https://www.aft.com/products/aft-flow-expert-package for more 
information on our FEP services.

Flow Modeling Consulting Services

AFT's sister company, Purple Mountain Technology Group (PMTG), provides comprehensive 
consulting services utilizing experienced consulting engineers and AFT tools. PMTG offers a 
solution to a wide variety of system analysis by building and investigating the models and provid-
ing direction on system changes and appropriate operation. Visit PMTG on the web: 
https://www.pmtechgroup.com/, or call at (719) 687-9145 for more information.

Related Topics

Technical Support 803
Contacting AFT 804
Information on Software Installation 805
Chempak Database Installation 805
Special File Control Features 809
Converting Models from Earlier Versions 810

Contacting AFT
 l Telephone - (719) 686-1000
 l Fax - (719) 686-1001
 l Online - https://www.aft.com/ download the latest maintenance releases, find out what is 

happening at AFT, and get all the latest information.
 l E-mail Support - support@aft.com
 l Mail - 2955 Professional Place (Suite 301), Colorado Springs, CO 80904, USA

Related Topics

Technical Support 803
Technical Support Options 803
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Information on Software Installation 805
Chempak Database Installation 805
Special File Control Features 809
Converting Models from Earlier Versions 810

Information on Software Installation
For information on Local and Server installations of AFT software, please visit our website at 
https://www.aft.com/support/installation.

Related Topics

Technical Support 803
Technical Support Options 803
Contacting AFT 804
Chempak Database Installation 805
Special File Control Features 809
Converting Models from Earlier Versions 810

Chempak Database Installation
AFT Impulse does not include the Chempak Fluid Library by default. Chempak Data is a sep-
arate product that must be downloaded and installed as an addition to AFT Impulse to access 
the Chempak Fluid Library in the software.

Chempak File Location

The Chempak Data is installed in C:\AFT Products\Chempak Data\ by default. If both AFT 
Impulse and Chempak Data are installed to their default locations, no further configuration is 
necessary. However, if AFT Impulse or the Chempak Data are not installed in a default location, 
AFT Impulse will need to know where to look for the Chempak Data. This is specified in the con-
trol.aft file, located in the same folder as the Impulse.exe. If the files cannot be found the fol-
lowing message is displayed:
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Figure 1: Error message when Chempak data cannot be found in default location

Control.aft can be edited with a text editor, and by default looks like:

Figure 2: Default control.aft file

If the Chempak Data was installed to a location other than the default, the line 
"ChempakDataPath = " will need to be edited to include the directory it was installed to. For 
example: "ChempakDataPath = C:\My AFT Files\Chempak Data"

Upgrading Chempak Data Version

When upgrading to a new version of AFT Impulse, you may receive a message that Chempak is 
out of date.
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Figure 3: Outdated Chempak data

To fix this issue, download the newest version of the Chempak Data from the AFT website. Be 
sure to install to the same location as the existing Chempak Data, and double check the con-
trol.aft file if necessary.

Related Topics

Technical Support 803
Technical Support Options 803
Contacting AFT 804
Information on Software Installation 805
Special File Control Features 809
Converting Models from Earlier Versions 810

Output Files
Numerical results and output from the Solver are saved in Output Files (*.out file extension). Out-
put Files are stored in the same location as the model file, and a unique file will exist for each 
scenario that is run, differentiated by numbers appended to the file name. The General section of 
the Output window will list which Output File is used for the current scenario.

The Output File will only remain on disk if the model file is saved after it has been run.

Changing various input data parameters for the model will invalidate the previous results, and a 
prompt will appear stating: "This action will clear all results and delete the output file for the cur-
rent scenario and any children. Do you want to continue the action?"

Renaming the model file in the Windows File Explorer will unlink the model file from any existing 
Output Files. Instead, open the model file and choose File > Save As which will rename and copy 
all Output Files. Alternatively, the Save Scenario to File options can be used from the Scenario 
Manager.

The file size will be heavily dictated by the simulation duration and amount of time steps saved 
as specified on the Simulation Duration panel in Analysis Setup. The Sectioning Panel will also 
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have an impact and will increase the file size if the Output Pipe Stations are set to All Stations or 
if Output Junctions are specified to be saved.

Updated Fluids Library
If the data in a shared fluid library is changed outside of the model you are opening, the following 
informational message will appear when opening the file:

The following fluid(s) used in the scenario have different property data than what is currently in 
the library:

Figure 1: Update Fluids dialog window which appears if the fluid properties for the model have 
changed since it was last opened

There are a few reasons that the fluid data may have been changed:

 1. The model was defined in a previous version of Impulse using a fluid from the AFT Stand-
ard fluid library. The AFT Standard fluid library was updated in AFT Impulse 9 in order to 
standardize the reference data. If the model uses the same fluid properties for all scen-
arios, it is recommended to use the "Change to Base Scenario and update..." option to 
update the fluid properties throughout the model. If different scenarios use different fluid 
properties then it is recommended to use the "Update fluid(s) from library in the scenario" 
option to update each scenario individually.

 2. The model is defined with a custom fluid in the Fluid Library and the custom fluid was mod-
ified outside of this model. If the fluid was changed in error, then choose the "Keep using 
the fluids defined in the scenario" option or cancel loading the model and change the fluid. 
If the changes were intended then update the fluid data used in the model using the 
"Change to Base Scenario and update..." option.

- 808 -



Technical Support

Special File Control Features

What Is the Control.aft File?

Conrol.aft is read as AFT Impulse begins to load and instructs AFT Impulse where certain key 
files and copy protection tokens are located. Typically there is little need to change the settings, 
however this file can be used to override the internal defaults and customize your working envir-
onment.

Control.aft is typically located in the application folder. However, on networks, it may be neces-
sary to locate it in the Windows\System folder of each client. If AFT Impulse finds the file in the 
Windows\System folder it will use it and ignore any file in the application folder.

Control.aft can be edited using any text-based editor. Notepad, supplied as part of the Windows 
installation, is a good choice. Be careful to avoid changing any of the headings or key words. If 
these are changed AFT Impulse will not find the important data.

Specifying Where Chempak is Located

Before AFT Impulse can use the Chempak Fluid Library it needs to know where both the data is 
located. These paths are specified in the control.aft file.

When Chempak is installed the setup procedure automatically updates any control.aft file spe-
cified with the path to the data.

You can manually edit the file by opening it in Notepad (or any text editor) and adding the fol-
lowing line to the [SEARCH PATHS] section (replace C:\AFT Products\Chempak Data with the 
path information based on your system):

ChempakDataPath = C:\AFT Products\Chempak Data

This will instruct AFT Impulse to look in the C:\AFT Products\Chempak Data directory for the 
data.

Also see Chempak Data Installation.

Related Topics

Technical Support 803
Technical Support Options 803
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Converting Models from Earlier Versions
Models from earlier versions of AFT Impulse can be used with this version. In most cases, the 
model file can be opened in the newer version and automatically converted to the updated 
format. It is considered good practice to do a complete check on the model to ensure the con-
version process was complete and accurate. In some cases, especially with older models (two or 
more versions behind), the automatic conversion is not successful. If this occurs, please contact 
our support team with a copy of the original model file.

Other files such as libraries (previously called "databases") or preference files can also be con-
verted.

The Workspace Layers Import Assistant can be used for models created in versions prior to the 
existence of Workspace Layers. This tool allows views from Visual Report (which is now deprec-
ated) and customized Workspace appearance to be preserved.
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